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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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Chapter 1
About This Guide

1  About This Guide

Audience and Scope  
Welcome to the Oracle Fusion Cloud Sales Automation: Implementation Reference guide.

Note:  To learn how to start you implementation and how to implement a sales force automation solution, start with
the Implementing Sales guide. The Implementing Sales guide covers key setups in both CX Sales and Digital Sales, the
next generation of Oracle's sales application (Next Gen Sales).

Use this guide to learn about additional features and options:

• How to implement application functionality that's not covered in the Implementing Sales guide.

• How to configure sales application behavior with profile options and lookup types.

• How to administer the application. How to run scheduled processes to complete a data refresh, and how to set
up auditing, for example.

• How to configure the pages of your CX Sales and CX Sales Mobile applications. How to add tabs and fields that
are hidden by default, for example.

• How to manually perform some of the tasks automated by the Setup Assistant. The Implementing Sales guide
assumes that you speed up your initial implementation using Setup Assistant. This guide covers the equivalent
manual steps. For example, while the Setup Assistant sets up the root of your sales catalog with one entry, this
guide provides the manual tasks to accomplish the same task.

This reference guide doesn’t cover advanced configuration and extensibility tasks for either CX Sales or Digital Sales.

For information on creating and securing custom objects, modifying user interface pages, creating object workflows
and custom subject areas, and writing Groovy scripts in CX Sales, see the Oracle Fusion Cloud Applications: Configuring
Applications Using Application Composer guide.

For information on how to extend and configure Digital Sales features and UIs, see the Oracle Fusion Cloud Sales
Automation Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

For an overview of which features are available in CX Sales, which features are available in Digital Sales, and which
features are available in both, see the topic CX Sales and Digital Sales Features in the Sales Solution in the Implementing
Sales guide.

Look at the Related Guides topic in this chapter for other guides that you can consult as you implement, configure, and
use the sales application.

Note:  In previous releases, this guide was named Implementing Sales. In 22D, this guide is renamed the
Implementation Reference guide and the Implementing Digital Sales (Next Gen Sales) guide is renamed to
Implementing Sales guide.

1

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACEX
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACEX
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=u30231429
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Chapter 1
About This Guide

Related Guides  
Implementing and configuring the sales applications may mean that you need to consult other guides in addition to this
guide. All of these guides are on Oracle Help Center.

Implementation, Import, and Security Guides
Here are some implementation, import, and security guides you may want to consult:

Guide Description

Oracle Fusion Cloud Sales Automation:
Implementing Sales

Covers the implementation of Digital Sales (Next Gen Sales) application and contains concepts and
procedures you need to implement a sales force automation solution using key sales features.

Oracle Fusion Cloud Sales Automation:
Getting Started with Your Partner
Relationship Management Implementation
 

Describes how to set up partner features to support common use cases.
 

Oracle Fusion Cloud Customer
Experience: Implementing Customer Data
Management
 

Contains information to help implementors define the setup for managing customer information and
the configuration for customer hub deployment.
 

Oracle Fusion Cloud Sales Automation:
Implementing Enterprise Contracts
 

Contains conceptual information and procedures needed to implement contract management
features.
 

Oracle Fusion Cloud Sales Automation:
Implementing Incentive Compensation
 

Contains information on implementing sales compensation and payment plans.
 

Oracle Fusion Cloud Sales Automation:
Implementation Reference
 

(This guide) Contains conceptual information and procedures needed to implement components and
features of the sales applications. Meant to be used after your setups in the Oracle Fusion Cloud Sales
Automation: Implementing Sales guide.
 

Oracle Fusion Cloud Customer Experience:
Understanding Import and Export
Management for CX Sales and Fusion
Service
 

Intended for anyone involved in importing and exporting business data into and from the Oracle CX
Sales and Oracle Fusion Service applications.
 

Oracle Fusion Cloud Customer Experience:
Securing Sales and Fusion Service
 

Contains information to help setup users and sales administrators configure access to sales
functionality and data.
 

Oracle Fusion Cloud Customer Experience:
Security Reference for Sales and Fusion
Service
 

Lists the predefined security data that is included in the Oracle CX Sales and Oracle Fusion Service
applications.
 

Oracle Fusion Cloud Fusion Service:
Implementing Digital Customer Service
 

Describes how to set up the digital customer service functionality.
 

2

http://docs.oracle.com
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACDM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACDM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACDM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACTS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACTS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAWIC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAWIC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OASAL
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OASAL
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIEM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIEM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIEM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIEM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIDS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAIDS


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 1
About This Guide

Guide Description

Oracle Fusion Cloud Fusion Service:
Implementing Fusion Service
 

Contains conceptual information and procedures needed to implement the service request
components and features of Oracle Fusion Cloud Fusion Service Service.
 

Oracle Fusion Cloud Sales: Understanding
Scheduled Processes
 

Describes the scheduled processes for Oracle Fusion Cloud Sales and contains guidance on how to use
them.
 

Oracle Fusion Cloud Customer Experience:
Integrating Sales with B2C Service
 

Describes the implementation and configuration steps required to integrate the sales and B2C service
processes.
 

Oracle Fusion Cloud Customer Experience:
Integrating Sales with Oracle Eloqua
 

Describes the implementation and configuration steps required to integrate the sales applications with
Oracle Eloqua.
 

User Guides
These user guides can help end users as they work with the applications:

Guide Description

Oracle Fusion Cloud Sales Automation:
Using Sales
 

Aimed at salespeople, sales managers, and other sales users. Contains information about performing
day-to-day tasks in the CX Sales applications.
 

Oracle Fusion Cloud Sales Automation:
Using Digital Sales (Next Gen Sales)

Provides an introduction to the new Oracle Digital Sales application. It explains the principles of using
the new interface and provides instructions on basic tasks. The guide doesn't explain the underlying
CX Sales functionality. It focuses on what's new in Digital Sales.

Oracle Fusion Cloud Sales Automation:
Using Customer Contracts
 

Contains information about creating and managing customer contracts.
 

Oracle Fusion Cloud Sales Automation:
Using Customer Data Management for
Sales and Fusion Service
 

Contains information about managing customer information and customer data quality.
 

Oracle Fusion Cloud Sales Automation:
Using Incentive Compensation
 

Contains information on administering and maintaining sales compensation and payment plans.
 

Oracle Fusion Cloud Fusion Service: Using
Fusion Service
 

Contains information about creating service requests and managing service request queues.
 

Analytics Guides
These are the Oracle Fusion Cloud Sales Automation analytics guides for administrators:
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Guide Description

Oracle Fusion Cloud Customer Experience:
Creating and Administering Analytics for
Sales and Fusion Service
 

Contains information for administrators as they access and build analytics and make them available to
salespeople.
 

Oracle Fusion Cloud Customer Experience:
Subject Areas for Transactional Business
Intelligence in Sales and Fusion Service
 

Provides descriptions, business questions, and security roles for the subject areas in the Oracle CX
Sales and Oracle Fusion Service applications.
 

Configuration Guides
Use these configuration guides as you modify the applications:

Guide Description

Oracle Fusion Cloud Applications:
Configuring Applications Using Application
Composer
 

Describes how to create and modify objects and to configure the user interfaces and navigation
menus.
 

Oracle Fusion Cloud Applications:
Configuring and Extending Applications
 

Describes the tools and concepts for configuring applications.
 

Oracle Fusion Cloud Applications: Groovy
Scripting Reference
 

Explains the basics of how you to use the Groovy scripting language to enhance the sales applications.
 

Common Applications Guides
You may want to consult these guides for common features:

Guide Description

Oracle Cloud: Getting Started with Oracle
Cloud Applications
 

Outlines the basics of getting started with your Oracle cloud service.
 

Oracle Fusion Cloud Applications: Using
Functional Setup Manager
 

Describes how to use Oracle Functional Setup Manager (also known as the Setup and Maintenance
work area) to implement the applications.
 

Oracle Fusion Cloud Applications:
Understanding Enterprise Structures
 

Explains how to use the Oracle Fusion Applications enterprise structures to meet your company's legal
and management objectives.
 

Oracle Fusion Cloud Applications: Using
Common Features
 

Provides an overview of the application functionality that is common across the applications.
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2  Before You Begin

Implementation Starting Point  

Getting Started with Your Implementation  
As mentioned earlier in this guide, we strongly recommend you start your implementation following the procedures in
the Implementing Sales guide.

After you have implemented the applications following the Implementing Sales guide, use this guide for other, not-so-
common setups, for core concepts around CX Sales functionality, for CX Sales exensibility procedures, and for reference
material.

Enter Your Company Information and Corporate Currency  
If you're setting up sales as a stand-alone application and you aren't using Setup Assistant, then use these steps to
enter basic information about your company.

Note:  To understand the what the Setup Assistant does for you in your implementation, see the What Setup Assistant
Completes for You topic.

After you complete the steps in this topic, the data entry pages become read-only, and the application automatically
takes care of two required setups for you:

• Creates the rudimentary enterprise structures required for sales.
The structure is for internal application use only. None of the information is visible to the sales organization.

• Creates a set of role-provisioning rules that provision users with the standard security roles they need for their
jobs.

This is a one-time setup. After you enter the information on the Create Company Information page, the page becomes
read-only and the title changes to Review Company Information.

You must follow different steps if you're setting up your sales applications together with other Oracle applications,
such as Oracle Human Resources, Oracle Procurement, or Oracle Financials. See the instructions provided in the
implementation guide for each application, in this case.

1. In the Setup and Maintenance work area, use the Quick Setup page for the Company Profile functional area:

◦ Offering: Sales

◦ Functional Area: Company Profile

2. In the Create Company Information page, enter your company name in the Enterprise Name field.
3. Enter the country where your company is located.
4. Enter your company street address. Don't enter city or state and other information.
5. The first and last name fields list the name of the user who's signed in to the sales application. You can edit the

entries.
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6. When you're satisfied that the information is correct, click Submit.

The application runs a background process to create the enterprise structure and create the role-provisioning
rules.

7. Click Refresh to monitor the progress of the process.

When the process completes, the Review Company Information page displays both the information that you
entered and the information that the process created for you. You can't edit any of the fields except Corporate
Currency.

Note:  None of the names you see are visible to salespeople, so they don't have to correspond to any actual
entities in your organization.

Field Description

Enterprise Name
 

The name you entered.
 

Address
 

The street address you entered.
 

Legal Entity
 

The enterprise name followed by the letters LE.
 

Business Unit
 

The enterprise name followed by the letters LE BU.
 

Initial User
 

Name of the user who's signed in.
 

Corporate Currency
 

By default, the corporate currency is US Dollar. You can select a different corporate currency.
 

8. If your company uses a different currency than the US Dollar for your sales transactions, then select the
currency from the Corporate Currency list.

9. Jot down the Legal Entity and Business Unit names. You must enter these names when importing users.
10. Click Save and Close.

Computer Requirements  

Computer and Other System Requirements  
Before using Oracle cloud applications in browsers and on your mobile devices, check the operating systems, supported
browsers, and other computer requirements.

For information about system requirements, see the Related Topics. For previous releases, scroll to the end of the
System Requirements for Oracle Applications Cloud page and find the system requirements link for the applicable
previous release.

6



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 2
Before You Begin

Related Topics
• System Requirements for Oracle Applications Cloud

Data Migration Between Environments  

Considerations for Migrating Data Between Environments  
When you implement and maintain your Oracle Cloud applications, you almost always need to migrate data from one
environment to another during the application life cycle.

For example, one typical use case in any enterprise application implementation is to first implement the applications in
a development or test application environment and then deploy it to a production application instance after thorough
testing. You use various methods or tools to accomplish the migration of data.

Note:  When you migrate data to a new environment, the application doesn't retain all user-set values for various
parameters. You need to add these values manually. For example, you need to set some profile option values again,
even if they were previously set.

For more information on migrating data between environments, see the Overview of Setup Data Export and Import
topic in the Oracle Applications Cloud Using Functional Setup Manager guide.

Related Topics
• Implementation Process

• How Copying Setup Configuration Helps

Help  

Find Guides, Readiness Material, and Other Resources  
The Oracle Help Center (https://docs.oracle.com) has guides, videos, readiness material, and other resources for Oracle
Fusion Cloud Applications.

Watch video
 

Here are a couple examples of what you'll find in the Help Center:

• Guides give you cumulative information about all features in each cloud service, for example how to use, set up,
and extend them.

• Readiness documents tell you what's new or changed in a particular release update. This material is published
before the update happens, to help you prepare for it.
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In the application, when you click links in help windows, most of the time you open a specific guide in the Help Center.
From there, you can search or browse to find other content. Or, if you're on the oracle.com site, open the Resources
menu and select Oracle Help Center to get to the Help Center. It's a good idea to bookmark the Help Center.

Let's take a look at how you can move around and find what you're looking for in the Help Center.

Browse for Cumulative Content About a Cloud Service
Here's how you find guides, videos, and other resources:

1. From anywhere in the Oracle Help Center, open the main menu and select Fusion Applications Suite under
Cloud Applications. Or, click Fusion Applications Suite on the Help Center home page.

2. On the Oracle Fusion Cloud Applications Suite page, browse the cloud services which are organized in
categories.

3. Click the name of your cloud service.
4. On the main page for the cloud service, select a release update if you don't want to see the latest content.
5. Use the navigation pane to get to a specific guide, video, or other resource. Here are some examples of where

you might go:

◦ All Books or Videos: Get all the videos or guides for the cloud service.

- On the Videos or All Books page, you can use the View list to filter by category.
- Most guides are available in multiple formats, for example HTML and PDF.

◦ Top Tasks: Click a task category and then a specific, common task to go straight to information that will
help you with that task.

◦ APIs & Schema: Get reference information about APIs and schema details.

Tip:  Use the breadcrumbs to get to other parts of the Help Center.

Search Within or Across Guides
The scope of the search in the global header of the Oracle Help Center depends on the page you're on. For example, on
the Oracle Fusion Cloud Applications Suite page, you search across all guides for Fusion Applications. On the pages for
a specific cloud service, you search only within that service, which gives you more targeted results. If you want to search
within one guide, use the Search tab in the guide.

Let's take a look what we can do with the search results. In this case, the first result is a guide, but you might also see
other types of resources, such as videos, reference architecture and solution playbooks, or readiness material. And
they might come from places other than the Help Center, for example My Oracle Support (https://support.oracle.com),
oracle.com, or YouTube.
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Callout Number What You Can Do

1
 

Remove a filter from the search to get more results.
 

2
 

Apply more filters to narrow down your choices, for example based on publication date.
 

3
 

Open the main page page for a product that has many results that match your search.
 

4
 

See search results from this product.
 

5
 

Open the title page for a guide with content that matches your search terms.
 

6
 

See when this guide was published.
 

7
 

Open a specific chapter in this guide.
 

8
 

See more chapters in this guide.
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Review Readiness Documents
Let's find the readiness material that can help you prepare for your next quarterly update:

1. On a page in the Oracle Help Center for your cloud service, click Cloud Readiness / What's New in the
navigation pane.

2. On the main page in Oracle Cloud Readiness for your service, find the What's New subsection in the Essential
Content section.

3. Click HTML to open a What's New document in a new browser tab.
4. Click the release update you want to review.
5. In the table of contents, click Feature Summary to see which features are enabled or disabled by default. You

need to take action to make disabled features available to your users.
6. If you see an Opt In Expiration tab, click it to see when disabled features will become enabled by default.
7. Click the tab for your release update to go back and see the details about specific features.
8. Return to the browser tab with the main page for your cloud service to explore other readiness content. From

there you can also jump over to other cloud services.

Related Topics
• Get Help in the Application

Set Up Help  
You don't have to set anything up for help to work. But you can do optional setup, for example to give people access to
add help content. First enable help features, then perform tasks in the Application Extensions functional area.

Enable Features
In the Offerings work area, review these features at the offering level.

• Local Installation of Help: Make sure to leave this enabled.

• Access to Internet-Based Help Features: This feature isn't used, so it doesn't matter if you enable it or not.

• Help Content Management: Enable this feature if you want some people to be able to add company-specific
help to help windows or the Getting Started work area.

• Security for Added Help: Enable this feature if you want certain help to be available only to a restricted set of
user roles.

CAUTION:  Enable this feature only if you have this requirement, because the feature can affect performance.

Related Topics
• How You Manage Different Types of Help

• Configure Offerings

• Hide or Show Help Icons

• Give People Access to Create and Edit Help

• Create Groups to Limit Access to Added Help
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How You Manage Different Types of Help  
You can edit the help content that comes with the application. You can also add your own help to help windows, for
example to provide company policies. Let's look at the different types of help that you can manage.

Help Type How You See This Help How You Edit or Add to It

Fields and other UI elements
 

Help text appears when you hover over or click
certain UI elements on the page.
 

You can edit this text using the User Interface
Text tool, or add your own help text to buttons
using Page Composer.
 

Help windows
 

Many pages have help icons. Click these icons
to open help windows that contain help text,
 links, or both.
 

You can use the User Interface Text tool to edit
the help text. You can add or remove links by
clicking the Manage Help Content link in the
help window. But you can't create new help
windows to put on the page.
 
In some cases, the same help window appears
on more than one page. So whatever you do
to the help window on one page applies to the
same help window in other places.
 

Getting Started work area
 

Select Getting Started from the Navigator to
open this work area and review the videos and
other information for new users.
 

You can edit or add to this content by clicking
the Edit Getting Started link on these pages.
 

What Else You Can Do
Here's what you can do with all the help that you or other people added to help windows and the Getting Started work
area:

• If you add a lot of links in help windows, you might want to manage your help in a central place. You can use
the Manage Help Content task in the Setup and Maintenance work area to view and edit all of the help that
anyone added.

• If you create help in a test environment, you can migrate all added help by exporting and then importing a
configuration package.

Related Topics
• Manage Help for Fields and Other UI Elements

• Add Your Content to a Help Window

• Modify Text Using User Interface Text Tool

• Manage Getting Started Content
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Manage Guided Learning for Onboarding and Training  
After you create content in Oracle Guided Learning, you need to apply it to the application so that you can test things
out. Then, make your Guided Learning content available to your users.

If you have Oracle Guided Learning, you can create interactive guides and more for onboarding and training, to help
people learn how to use Oracle Fusion Cloud Applications. For example, a guide takes users through each step of a task
while they're in the application, down to which buttons to click and which fields to fill out. Most importantly, they get
through the task in a way that fits your own business processes and practices.

Here's what you do after you create or update Guided Learning content:

1. Set the Guided Learning Enabled (FND_GUIDED_LEARNING_ENABLED) profile option to Yes at the Site level.

◦ Use the Manage Applications Core Administrator Profile Values task in the Application Extensions
functional area.

◦ You only need to do this once.

2. Activate a sandbox with the Guided Learning tool selected.
3. Define some settings to make sure that your Guided Learning content shows up in the application the way you

want it.

a. In the Setup and Maintenance work area, go to the Configure Guided Learning task in the Application
Extensions functional area.

b. On the Configure Guided Learning page, enter the application ID that was given to you when you first got
Oracle Guided Learning.

c. Leave the default value in the OGL Server field unless you need to replace it with a different server, for
example a test server.

d. Click Save and Close.
4. Test your Guided Learning content while you're in the sandbox.
5. Go back to Guided Learning to make any changes to your guides, including changing content from draft to

published.
6. When you're ready, publish the sandbox to make your content available to users.

Next time you have new or changed Guided Learning content, start from step 2 again.

Related Topics
• Oracle Guided Learning User Guide

• Update Existing Setup Data

• Set Profile Option Values

• Create and Activate Sandboxes

• Publish Sandboxes
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Navigation  

Overview of the Main Navigation Components  
Sales personnel use sales application work areas to perform their daily tasks. After signing in to the application,
they land on the home page and use the home page springboard and global header icons to access the areas of the
application where they do their work.

Note:  The user interface described in this topic applies only to CX Sales, not to Digital Sales.

There are some main navigation and other components you should be aware of, such as:

• Home Page

• Springboard

• Navigator

• Global Header

• Settings and Actions Menu

• Infolets

Home Page
The home page provides access to available work areas. Users can quickly pick from the available icon groups and then
navigate to a specific work area to perform their tasks. A single click on the Home icon or the logo in the global header
quickly returns users back to the home page with its springboard and infolets. You can select your default home page
layout as panel, banner, or news feed. You can also create, edit, or delete company announcements for the home page.

From the Sales tab on the home page, you can quickly create sales records from just one page. Use the quick actions
feature to create your opportunities, leads, contacts, and activities, including tasks, appointments, and call reports, from
a single location.

Springboard
The grid of icons on the home page is called the springboard. When you see a strip of icons above a page, that's also
called the springboard. Whether or not a springboard displays at the top of the page depends on how the application is
configured.

Sales users click the springboard icons to open the work areas and dashboards used in their main tasks.

If a user has access to more than 16 work areas, the application automatically groups the work areas under a parent icon
(or folder).

Here are the conditions for work-area grouping and springboard icon display. This behavior applies to all sales user
roles.

User Access Icon Display

User can access only one page entry or
work area within a specific folder

The icon for the page entry/work area is displayed at the top level. For example, a sales representative
with access to only leads, sees just the Leads icon at the top level on the home page.
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User Access Icon Display

  

User can access multiple page entries, up
to 16
 

All page entry icons display at the top level.
 

User can access more than 16 page entries
 

Page entries are grouped under a parent icon (folder). For example, the Sales icon displays with work
areas for accounts, opportunities, and leads.
 

User can access 15 or fewer page entries
outside the Tools folder
 

These icons appear at the top level, and only the icons under Tools remain in a folder.
 

Navigator
The Navigator is the main menu, found in the global header.

Users access the Navigator to get to their work areas and dashboards. Note that the Navigator might have more page
entry points than the springboard.

Configuring the Springboard and Navigator
You can modify the springboard and Navigator using the Structure tool available to setup users. For example, you can:

• Specify whether certain Navigator menu items, springboard, and home page features display.

• Modify the structure, grouping, and ordering of the navigation menu items and the springboard icons.

To understand how to configure the springboard and home page to fit your unique business needs, see these guides:

• Configuring Applications Using Application Composer

• Configuring and Extending Applications

• Using Common Features

Global Header
The global header is the area across the top of the UI. It is persistent across pages for all users. By default, the global
header icons and links let users access:

• Home: Returns the user to the default home/landing page.

• User settings and actions: Among other actions, users can access personalization features, user preferences,
and configuration tools (if allowed) by clicking on their user image or name in the global header. For more
information on this menu, see the Settings and Actions Menu section later in this topic.

• Global search: If enabled, users can search key fields across multiple objects.

• Favorites and Recent items: Users can access links to pages that they have bookmarked or have opened
recently.

• Watchlist: Users can access a list of transaction-related items that pertain to them.

• Notifications: Contains a user's appointment and task notifications.

You can modify the global header template. For more information, see the topics on modifying the global page template
in the Configuring and Extending Applications guide.
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Settings and Actions Menu
All users can click their user image or name in the global header to open the Settings and Actions menu. In addition to
letting you explicitly sign out, this menu lets you:

• Personalize the applications and set preferences, including changing password, setting the language, and
adding a photo. The applications also support accessibility settings like font size, color contrast, and screen
readers.

• Display the help icons on pages where they're available. Not all pages have help icons. The help icons give
access to additional content in a separate window.

• Use the application as someone else if proxy users are enabled.

• Access configuration tools such a sandboxes, as well as the Setup and Maintenance work area. This access is
only for administrators and setup users.

Infolets
Infolets are configurable portals on the UI that show sales data summaries. Infolets show up as a row of dots on the
home page, above the springboard.

You can create new infolets, and add or remove them as needed. For more information, see the Overview of Infolets
topic in the Creating and Administering Analytics guide.

Related Topics
• Overview of Configuring Home Page and Navigation

• Define Home Page Appearance

• Set a Banner Message in the Global Header

Optimize Browser Space in Work Area and Detail Pages  
Optimize browser space in the application by enabling the profile option, Advanced Responsive UI features. Optimizing
browser space is especially helpful when salespeople use tablets or other small screens to view the application.

Note:  The user interface described in this topic applies only to CX Sales, not to Digital Sales.

When the profile option is enabled, the application displays the most allowable amount of content on the screen. For
example, it shows items near the edge of the screen on devices like tablets and phones.

Here's how to set the profile option:

1. Navigate to the Manage Administrator Profile Values task in Setup and Maintenance.
2. Search for the profile option, Advanced Responsive UI features (ZCA_ADVANCED_RESPONSIVE_UI).
3. Set the profile option to Yes at Site level.

Related Topics
• Set Profile Option Values
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Troubleshoot Performance Issues  
An issue qualifies as a performance issue when a user's response time is slow when navigating to various objects or
specific fields, such as dynamic choice lists or custom fields, or if there's a process that's taking a long time to complete.

This topic is a checklist you can use to troubleshoot the issue at user's end first. If the issue continues, we recommend
that you contact Oracle Support to investigate the issue further.

Performance Checklist
Use this checklist to help troubleshoot performance issues:

Issue Type Description More Information

Is the user using the correct URL?
 

Confirm that the user is working in the unified
home page URL. Here's an example of the URL
construction:
 
If the pod name is abcd-test for your
application, and your data center is located in
Amsterdam, the data center code will be EM2.
Thus, the unified URL will be https://abcd-
test.fa.em2.oraclecloud.com/fscmUI/
faces/FuseWelcome
 

If not, be sure to use the correct construction to
provide better and faster navigation.
 

What's the user's internet speed?
 

Ask the user to go to https://fast.com/
and capture the screen shot of the internet
speed test results.
 
Ask the user to click Show more info in the
speed test page. Check the latency and speed.
If speed is low and latency is high, you might
need to switch to a network with better speed
and less latency.
 
If that URL doesn't work, run these commands
from the command prompt to see if you're
getting a prompt response (attach the output to
your service request).
 
Command 1:
 

tracert <application URL>

For example:
 

tracert abcd-
test.fs.em4.oraclecloud.com

Command 2:
 

ping <application URL>

You will need all of this information to give
to Oracle Support if the performance issue
persists.
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Issue Type Description More Information

For example:
 

ping abcd-test.fs.em4.oraclecloud.com

Are the browser settings optimal?
 

Validate the browser settings at the user's end.
 
Also, use a different browser that doesn't have
add-ins installed. Or, use the same browser in
private window or incognito mode.
 

Review the article, Best Practices for Browser
Settings and Performance on Fusion
Applications (Doc ID 1385107.1), on My Oracle
Support. Have the user set up his browser
according to the recommendations there.
 

Is Oracle Social Network active?
 

Inactivate Oracle Social Network if the user isn't
using it. This will optimize performance.
 

Review the article, How To Hide/Show Social
Links in Cloud Apps UI (Doc ID 2055189.1), on
My Oracle Support.
 

Is a saved search using too broad of criteria?
 

If the performance issue is with saved searches,
 we recommend that the user apply saved
searches with selective filters instead of using
the default blank or all options.
 

Avoid using searches with leading wildcards.
Avoid using the "All Records I can See" in the
search. See the Personal Lists section in the
Search chapter in the Using Sales guide for
more details.
 

Have the search processes been run?
 

For performance issues from the Find box, be
sure to run the search scheduled processes:
 

• Synchronize CRM Search Indexes

• Optimize CRM Search Indexes

See the Work Area Search section in the Search
chapter in this guide.
 

Are you using dynamic choice lists?
 

If performance issues happen when the
user clicks on a dynamic choice list, go into
Application Composer and add a data filter to
the list.
 

See the Dynamic Choice Lists section in the
Add Objects and Fields in the Configuring
Applications Using Application Composer
guide.
 

Have the applications just been updated?
 

If performance issues are occurring after an
application update, have the user "warm up"
the browser; in other words, click around in the
application pages.
 

Try the same flow three times and see if the
issue is reproducible.
 

Have you just published sandboxes?
 

Warm ups are needed for the application clicks
after publishing sandboxes.
 

Usually, publishing a sandbox invalidates
caches and that requires warm ups.
 

Note:
In production environments, sandbox usage
should be minimal. You should always use
the Customization Set Migration tool to
migrate custom between environments.
 

Is the user on a VPN, proxy, or mobile line
connection?
 

The user may be on a VPN, proxy, or mobile line
connection (mobile modem or tethering).
 

Refrain from using VPN, proxy, or mobile line
connections (mobile modem or tethering).
Always use a hard LAN line or a wired
connection.
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Is the AF log set to finest?
 

The logging level may be set to finest. The log
level should only be Severe at User and Site
levels.
 

Here are the recommended settings:
 

• AF log enabled: Yes

• AF log level: Severe

• AF log module: %

Are you using formulas on landing pages?
 

Formula fields on landing (list) pages tend to
add performance degradation for list page
loading, and affect actions like search and
create.
 

Move these fields to edit pages in order to avoid
any performance issues.
 

Are you using println statements in Groovy
in your production instance?
 

Any Groovy code that's promoted to production
must be checked against println statements
to ensure that println statements are
commented or removed.
 

If your println statements haven't been
commented or removed, these might cause
performance degradation.
 

Related Topics
• Schedule Work Area Search Processes

• Create Your Personal List in a Work Area

• Overview of Sandboxes

• Data Filters for Dynamic Choice Lists
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3  Profile Options, Lookups, and Scheduled
Processes

What are Profile Options, Lookups, and Scheduled
Processes?  
Profile options, lookup types, and scheduled processes let you configure application behavior and process data.

Briefly, here's what profile options, lookup types, and scheduled processes do:

• Profile options: Let you configure the application behavior.

• Lookup types: Provide the lists of values in applications. Many lookup types can be modified to fit your
business needs.

• Scheduled processes: Act on data in the applications.

Get additional information on profile options, lookup types, and scheduled processes in this chapter and in the related
topics.

Related Topics
• How can I access predefined profile options?

• How can I access predefined lookups?

• Overview of Scheduled Processes

Profile Options  

Overview of Profile Options  
Profile options let you configure and control application data centrally. Administrators and setup users manage profile
options in the Setup and Maintenance work area.

Profile options store various kinds of information. This table lists some examples:

Type of Information Profile Option Setting Example

User preferences
 

Set preferences at the user level
 

Installation information
 

Identify the location of a portal
 

Configuration choices Change UI skins and actions
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Type of Information Profile Option Setting Example

  

Processing options
 

Determine how much information to log
 

Enabling the Activity Stream Enable agents to see the Activity Stream

Profile Option Hierarchy Levels
Profile options can be set at different levels, such as site level or user level. The application gives precedence to
certain levels over others, when multiple levels are set. The levels that are allowed to be set are preconfigured with the
application.

In the predefined profile option levels, the hierarchy levels and their precedence are:

1. Site: This level affects all applications for a given implementation. The application gives it the lowest
precedence when other levels are set. If no other levels are set, however, it's the highest level.

2. Product: This level affects a product or product family. The application gives it priority over Site level. However,
if the user level is set, the user level takes precedence.

3. User: This level affects only the current user. It has the highest precedence, over Site and Product.

As a best practice, set site-level profile option values before specifying values at any other level (where available). The
profile option values specified at the site-level work as the default until profile option values are specified at the other
levels.

This table shows an example of the predefined profile option hierarchy levels and their priorities.

Level Priority Example

Site
 

Lowest
 

Currency for a site is set to Euros.
 

Product
 

Supersedes Site
 

Currency for the product or set of products is
set to UK pound sterling.
 

User
 

Highest, supersedes Product
 

Currency for a user is set to US dollars.
 

You can find additional information about profile options in the related topics.

Related Topics
• How can I access predefined profile options?

• Set Profile Option Values

How can I access predefined profile options?  
Search for predefined profile options using the Manage Profile Options task.

1. In the Setup and Maintenance work area, go to the Manage Profile Options task.
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2. On the page, enter any of the search parameters and click Search. Search functionality is case-sensitive.
Tip:  If you don't know the profile option code or the display name, use the Application or Module fields to
filter search results.

3. In the results, click a profile option to view its details.

Import Profile Values  
Use the Import option on the Manage Administrator Profile Values page to import profile values in bulk and associate
them with a profile option.

Before you begin, make sure that the file containing the profile values is available in the document repository of Oracle
WebCenter Content.

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task.
2. In the Search: Profile Options section, search for the profile option for which you want to import the values.
3. In the Search Results: Profile Options section, select the profile option.
4. In the <Profile Option>: Profile Values section, click Actions > Import.
5. On the Import User Profile Values window, select the WebCenter Content account to which the file was

uploaded.
6. Enter the name of the file containing the profile values. The name here must match with the name of the file

uploaded to the selected account.
7. Click Upload. The profile values are imported.

Note:  If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of
failure.

Related Topics
• File Format for Importing Profile Values

• Import Flexfields, Lookups, or Profile Values Using Web Services

• How can I bulk update user preferences?

• Overview of Files for Import and Export

File Format for Importing Profile Values  
You can import profile option values to your application by creating separate text files containing values. You can then
upload these files to the Oracle WebCenter Content document repository.

Here are a few things that you need to keep in mind while creating these files:

• Use a vertical bar or pipe ( | ) as a delimiter between fields for both the header and the value rows.

• According to the Oracle WebCenter Content specification, set the file encoding to UTF-8 without the Byte Order
Mark (BOM).

• The first line in the file must be a header line, and the files must look exactly the same as shown in the sample
file.

To create a file containing the profile values, include the headers specified in this table:
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Header Description

ProfileOptionCode This value displays the profile option code.

LevelName This value displays the level name of the profile. It must be one of these level names:
• Site

• Product

• User

UserName This value must correspond to the registered user name in the application. Don't provide any other
shortened or coded name of the user.

ProfileOptionValue This value displays the profile value that you can import.

Here's a sample file with the header values at the beginning of the file, followed by line entries of the two profile values.
For importing several profile values, add more line entries in a similar format.

ProfileOptionCode|LevelName|UserName|ProfileOptionValue
AFLOG_BUFFER_MODE|USER|APP_IMPL_CONSULTANT|TEST
AFLOG_LEVEL|USER|APPLICATION_DEVELOPER|FINEST

Related Topics
• Import Profile Values

• Overview of Files for Import and Export

• Guidelines for File Import and Export

• Overview of Profile Options

Lookup Types  

Overview of Lookup Types  
Lookup types in the applications provide the lists of values in application fields that are drop-down lists.

For example, when closing an opportunity, salespeople can pick a reason that an opportunity was won or lost
from the Win/Loss Reason field, which is a drop-down list. The values in that list are derived from the lookup type,
MOO_WIN_LOSS_REASON, which has several potential values known as lookups, each with its own unique lookup code
and a meaning that displays in the UI.

Configuring Lookup Types
You can configure many lookup types to fit your business needs. The level at which a lookup type is extensible
determines whether the lookups in that lookup type can be edited. The levels are: User, Extensible, and System.

This table shows which lookup management tasks are allowed at each level:

Allowed Task User Extensible System

Deleting a lookup type Yes No No
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Allowed Task User Extensible System

    

Inserting new codes
 

Yes
 

Yes
 

No
 

Changing the wording that displays
on the page (Meaning field)
 

Yes
 

Yes
 

Yes
 

Updating start date, end date, and
enabled fields
 

Yes
 

Yes, only if the code isn't
predefined data
 

No
 

Deleting codes
 

Yes
 

Yes, only if the code isn't
predefined data
 

No
 

Updating tags
 

Yes
 

No
 

No
 

Updating module
 

Yes
 

No
 

No
 

If a product depends on a lookup type, the configuration level must be System or Extensible to prevent deletion. After
the configuration level is set for a lookup type, it can't be modified. The configuration level for lookup types created
using the Define Lookups page is by default set at User level.

Sales Lookup Types
You find lookup types by accessing the associated task in the Sales offering in the Setup and Maintenance work area.
Here are some of the common sales lookup tasks or task lists:

To access sales lookup types:

1. Sign in as a setup user and navigate to the Setup and Maintenance work area.
2. In Setup and Maintenance, go to the Sales offering.
3. In the list of functional areas, click the area where the lookup appears. See the list at the end of this procedure

for more information.

A list of tasks for the area is displayed.
4. In the list of tasks, click the lookups task.
5. In the lookup types page, modify the lookup type as needed.

Here are the Sales lookup type tasks and the functional areas where they appear:

• Sales Foundation functional area:

◦ Manage Geography Lookups

◦ Manage Applications Core Standard Lookups

◦ Manage Activity Standard Lookups

• Users and Security functional area:

◦ Manage Resource Role Lookups

◦ Manage Resource Lookups
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• Accounts and Contracts functional area

◦ Manage Group Lookups

◦ Manage Source System Lookups

◦ Manage Hierarchy Lookups

◦ Manage Trading Community Common Lookups

◦ Manage Party Usage Lookups

◦ Manage Relationship Lookups

◦ Manage Contact Point Lookups

◦ Manage Trading Community Organization Lookups

◦ Manage Trading Community Location Lookups

◦ Manage Trading Community Person Lookups

◦ Manage Contact Lookups

◦ Manage Customer Account Lookups

◦ Manage Customer Center Lookups

• Sales Catalog and Products functional area:

◦ Manage Product Group Lookups

• Sales Campaigns functional area:

◦ Manage Marketing Standard Lookups

• Leads functional area:

◦ Manage Sales Lead Standard Lookups

◦ Manage Set Enabled Lookups

• Opportunities functional area:

◦ Manage Set Enabled Lookups

• Territories functional area:

◦ Manage Territory Management Non-extensible Lookups

• Business Plans functional area:

◦ Manage Business Plan Non-extensible Lookups

◦ Manage Objectives Non-extensible Lookups

• Partners functional area:

◦ Manage Partner Lookups
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Set-Enabled Lookup Types
Several applications support lookup types at the reference set level, allowing you to present different lists of values for
different business units. You can find these in the Manage Set Enabled Lookups task within the functional area that
supports these lookup types.

Related Topics
• How can I access predefined lookups?

• Why can't I see my lookup types?

• Reference Data Sets

How can I access predefined lookups?  
Search for predefined lookups using any of the manage lookups tasks.

1. In the Setup and Maintenance work area, go to any of the following tasks that contains the lookups you're
looking for:

◦ Manage Standard Lookups

◦ Manage Common Lookups

◦ Manage Set-enabled Lookups

2. Enter any of the search parameters and click Search. If you don't know the lookup type or the meaning, use the
Module field to filter search results.

3. Click a lookup type to view its lookup codes.

Tip:  Click the Query By Example icon to filter the lookup codes.

Related Topics
• Use Query By Example

• Update Existing Setup Data

How can I edit lookups?  
On any of the Manage Lookups pages, you can edit the existing lookup codes of a lookup type or add new lookup
codes. You can edit lookups using the following tasks in the Setup and Maintenance work area:

• Manage Standard Lookups

• Manage Common Lookups

• Manage Set Enabled Lookups

Each task contains a predefined set of lookup types that are classified and stored. Open a task to search and edit the
required lookup. However, you may not be able to edit a lookup if its configuration level doesn't support editing.
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Why can't I see my lookup types?  
Lookup types are classified using tasks that involve a group of related lookups, such as Manage Geography Lookups.
Each task gives you access only to certain lookup types.

However, the generic tasks provide access to all lookups types of a kind, such as common lookups associated with the
Manage Common Lookups task. If the lookup types in an application are available in the standard, common, or set-
enabled lookups view, they're central to an application. However, lookup types defined for a specific application are
managed using the task for that application.

Import Lookups  
On each page pertaining to the tasks of managing the Standard, Common, and Set Enabled lookups, use the Import
option to import the lookup type and lookup code information.

Prerequisite
The separate files containing the lookup types and lookup codes are already available in the document repository of
Oracle WebCenter Content.

Importing Lookups
To import lookups:

1. In the Setup and Maintenance work area, go to the Manage Standard Lookups task. Depending on the lookup
you want to import, you may select the other lookup tasks.

2. In Search Results, from the Actions menu, select Import.
The Import Lookups dialog box appears.

3. Select the WebCenter Content account to which the files were uploaded.
4. Enter the names of the separate files containing the lookup type and lookup code information. The names here

must match with the names of the files uploaded to the selected account.
5. Click Upload. The lookup details are imported.

Note:  If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of
failure.

Related Topics
• File Format for Importing Lookups

• Import Flexfields, Lookups, or Profile Values Using Web Services

File Format for Importing Lookups  
You can import lookups to your application by creating separate text files containing lookup types and lookup codes.
You can then upload these files to the Oracle WebCenter Content document repository.
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Here are a few things that you need to keep in mind while creating these files:

• Use a vertical bar or pipe ( | ) as a delimiter between fields for both the header and the value rows.

• According to the Oracle WebCenter Content specification, set the file encoding to UTF-8 without the Byte Order
Mark (BOM).

• The first line in the file must be a header line, and the files must look exactly the same as shown in the sample
file.

The following sections contain details about the specific lookup types and codes.

Prerequisite
You must have worked with lookups in Oracle Fusion Cloud applications.

Standard and Common Lookups
The lookup types and codes are similar for standard and common lookups. To create a file containing the lookup types,
include the following headers:

Header Description Required or Optional

LookupType This value displays the lookup type. Required

Meaning This value displays the name of the lookup type. Required

Description This value displays the description of the lookup
type.

Optional

ModuleType This value displays the module associated with
the lookup type.

Required

ModuleKey This value displays the module code. Required

Here's a sample file with the header values at the beginning of the file, followed by line entries of the two lookup types.
For importing several lookup types, add more line entries in a similar format.

LookupType|Meaning|Description|ModuleType|ModuleKey
AFLOG_22APR_1|Log1|AFLOG_desc_1|APPLICATION|FND
PROD_22APR_2|Product1|PROD_desc_2|APPLICATION|FND

To create a file containing the lookup codes, include the headers specified in this table:

Header Description Required or Optional

LookupType This value displays the lookup type. Required

LookupCode This value displays the lookup code associated
with the lookup type.

Required

DisplaySequence This value displays the sequence in which the
lookup code appears in the list of values.

Required

EnabledFlag This value lets you enable or disable the display
status of the lookup code:

Required
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Header Description Required or Optional

• Y: Enable the display status of the lookup
code

• N: Disable the display status of the lookup
code

Meaning This value displays the name of the lookup code. Required

StartDateActive This value displays the beginning of the date
range during which the lookup code is active and
visible on the page. The format is dd/MM/yyyy.

Optional

EndDateActive This value displays the end of the date range
during which the lookup code is active and
visible on the page. The format is dd/MM/yyyy.

Optional

Description This value displays the description of the lookup
code.

Optional

Tag This value indicates any tag associated with
the lookup code that you can use for a quick
reference or retrieval of information.

Optional

Seg This value displays the API name used for a
global segment that you can define for the
descriptive flexfield associated with the lookup.

Optional

CONTEXT_ATTRIBUTE This value displays the context value specified in
the CSV file for a particular descriptive flexfield.

Optional

ctxSeg This value displays the name of the API for a
context-sensitive segment defined for a context
attribute.

Optional

Here's a sample file that contains two lookup codes:

LookupType|LookupCode|DisplaySequence|EnabledFlag|StartDateActive|EndDateActive|Meaning|Description|Tag|Seg|
CONTEXT_ATTRIBUTE|ctxSeg
TASK_22APR_1|Code1_1|1|Y|25/12/2014|25/5/2015|TASK_22apr_1|Task_desc_1|Tag1_1|testSeg1|TEST_CTX1|ctx1Seg1
TASK_22APR_1|Code1_2|2|N|25/1/2014|25/11/2015|TASK_22apr_2|Task_desc_2|Tag1_2|testSeg1TEST_CTX1|ctx1Seg1
TASK_22APR_2|code2_1|3|N|25/12/2012|25/7/2015|TASK_22qpr_2_1|Task_desc_2|tag2_1|testSeg2|TEST_CTX2|ctx2Seg2
TASK_22APR_2|code2_2|3|Y|25/12/2012|25/7/2015|TASK_22qpr_2_2|Task_desc_2_2|tag2_2|testSeg2|TEST_CTX2|
ctx2Seg2

Set Enabled Lookups
To create a file containing the set enabled lookup types, include the headers specified in this table:

Header Description Required or Optional

LookupType This value displays the lookup type. Required

Meaning This value displays the name of the lookup type. Required

Description This value displays the description of the lookup
type.

Optional

ModuleType This value displays the module associated with
the lookup type.

Required
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Header Description Required or Optional

ModuleKey This value displays the module code. Required

ReferenceGroupName This value displays the name of the reference
group that contains the reference data set.

Required

Here's a sample that contains two set enabled lookup types:

LookupType|Meaning|Description|ModuleType|ModuleKey|ReferenceGroupName
CODE_22APR_1|CODE_22apr_1|Code_desc_1|APPLICATION|FND|BU_APAC
CODE_22APR_2|CODE_22qpr_2|Code_desc_2|APPLICATION|FND|BU_APAC

To create a file containing the set enabled lookup codes, include the headers specified in this table:

Header Description Required or Optional

LookupType This value displays the lookup type. Required

LookupCode This value displays the lookup code associated
with the lookup type.

Required

DisplaySequence This value displays the sequence position at
which the lookup code appears in the list of
values.

Required

EnabledFlag This value lets you enable or disable the option
to view the display:

• Y: Enable the option to view the display

• N: Disable the option to not view the display

Required

Meaning This value displays the name of the lookup code. Required

SetName This value displays the name of the reference
data set.

Required

StartDateActive This value displays the beginning of the date
range during which the lookup code is active and
visible on the page. The format is dd/MM/yyyy.

Optional

EndDateActive This value displays the end of the date range
during which the lookup code is active and
visible on the page. The format is dd/MM/yyyy.

Optional

Description This value displays the description of the lookup
code.

Optional

Tag This value indicates any tag associated with
the lookup code that you can use for a quick
reference or retrieval of information.

Optional

Here's a sample file with the header values at the beginning and lists four set enabled lookup codes. For importing
several lookup codes, add more entries in the same format.

LookupType|LookupCode|DisplaySequence|EnabledFlag|StartDateActive|EndDateActive|Meaning|Description|Tag|
SetName
DATA_22APR_1|Code1_1|1|Y|25/12/2014|25/5/2015|DATA_22apr_1|Data_desc_1|Tag1_1|TEST SET CODE 2
DATA_22APR_1|Code1_2|2|N|25/1/2014|25/11/2015|DATA_22apr_2|Data_desc_2|Tag1_2|TEST SET CODE 3
DATA_22APR_2|code2_1|3|N|25/12/2012|25/7/2015|DATA_22qpr_2_1|Data_desc_2|tag2_1|TEST SET CODE 2
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DATA_22APR_2|code2_2|3|Y|25/12/2012|25/7/2015|DATA_22qpr_2_2|Data_desc_2_2|tag2_2|TEST SET_ERR_CODE_Z

Related Topics
• Import Lookups

• Overview of Files for Import and Export

• Guidelines for File Import and Export

• Overview of Lookups

Scheduled Processes  

Overview of Scheduled Processes  
Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or
updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how
the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you have access to and to manage submissions. If you
need access to this work area, ask your security administrator to assign you a role that gives you access, for example
a custom role with the the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege.
Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions
Each scheduled process that you run is based on a job. The job is the executable that controls what the process does.
Each job needs a job definition, which, for example, determines the parameters and other options you have for the
process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run
the reports as scheduled processes.

Process Sets
A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a
process set, you're running more than process.

Note:  When you submit certain scheduled processes, the job logic causes other processes to automatically run. But
in this case, you're not submitting a process set that includes those other processes.

Submission
When you submit a scheduled process, you can use its parameters to control how, and which records are processed.
For example, a process includes only the transactions that were edited by the person you select for a Last Updated By
parameter. Some scheduled processes don't have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two
months. Every time a process runs, there's a unique process ID.

30

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035715
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035716
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20030035


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 3
Profile Options, Lookups, and Scheduled Processes

Output
Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records
and also produce output with details about those records. There are many types of output, for example a tax document
or a list of transactions.

Related Topics
• Submit Scheduled Processes and Process Sets

• View Status and Other Details for Scheduled Processes

• Cancel or Make Changes to Scheduled Processes

• View Output from Scheduled Processes

• Create Job Definitions to Run Reports as Scheduled Processes

• Best Practices for Scheduled Processes in Fusion Applications

Where to Find Information About CX Sales Scheduled Processes  
Here are the scheduled processes that are available as part of Oracle CX Sales. The Oracle CX Understanding Scheduled
Processes guide describes many of these scheduled processes and contains guidance on how to use them.

However, some CX Sales scheduled processes are documented within the context of procedures that require them, in
the relevant implementation or administration guides.

Assignment
• Improve the Performance for Territory-Based Account Assignment

• Perform Object Sharing Rule Assignment Processing

• Refresh Access Control Data

• Request Account Assignment

• Request Opportunity Resource Assignment

• Request Revenue Territory Assignment

• Run Access Group Membership Rule

Forecasting
• Check Due Date

• Forecast Autopilot

• Refresh Forecast

Marketing Campaigns and Leads
• Populate Lead Latitude and Longitude Information

Partner Management
• Partner Program Enrollment Expiration Job
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• Refresh Partner Dimension Members

Quota Management
• Publish or Revise Hierarchy Quotas

• Synchronize Quotas

Sales Insights
• Generate Sales Insight Facts

• Generate Sales Insight Facts Using Signals

• Generate Sales Insight Facts Using Signals

• Generate Sales Insight Metrics

• Purge Redundant Sales Insight Facts

Sales Products
• Import Sales Products Process

Territories
• Delete Territory Proposal

• Delete Territory Proposal

• Refresh and Promote Dimension Members

• Refresh Territories from Resources

• Update Inheritance Recipients

You can find more information about scheduled processes in the Understanding Scheduled Processes guide.

View Details About Predefined Scheduled Processes  
To use web services to run predefined scheduled processes, you require details about the processes. View job
definitions that the processes are based on, for example to get information about parameters.

You might also need to find security requirements for running the scheduled process.

Job Definitions
A job definition contains the metadata that determines how a scheduled process works and what options are available
during submission.

To view job definitions:

1. Go to the Setup and Maintenance work area.
2. From the Application Extensions functional area, open any of these tasks as appropriate:

◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Financial, Supply Chain Management, and
Related Applications
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◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Human Capital Management and Related
Applications

◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Customer Relationship Management and
Related Applications

3. In the Manage Job Definitions tab, select your job definition and click Edit.

Note:  Predefined job definitions are marked with an asterisk.

4. Cancel after you get the information you need.

Security
Privileges provide the access required to run specific scheduled processes. Privileges are granted to duty roles, which
are granted to job roles. To see which job roles inherit the required privileges, use the Security Console or the security
reference manuals for the appropriate product family.
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4  Users and Security

Overview of Setting Up Users and Security  
Since you followed the Implementing Sales guide steps to set up your initial set of users, then you already know that
Oracle applications use a role-based access control security model to secure access to functionality and data.

In a role-based access control security model, users are assigned roles, and roles are assigned access privileges to
protected system resources.

Sales and Service users who access the transactional UI, for example sales representatives or service representatives
working in leads or service requests, are created as resources and are known as resources.

Default Preferences
To set up default preferences for users and roles, access the Security Console as a setup user or other user with the
IT Security Manager job role. Only setup users, or other users with the IT Security Manager job role, can access the
Security Console. See the Securing Fusion Sales and Service guide for more information.

User Identity Store
The Lightweight Directory Access Protocol (LDAP) identity store is a repository of user identity data. Your LDAP
directory stores definitions of LDAP user accounts. In general, changes you make to user accounts are automatically
synchronized between the sales application and your LDAP directory server. However, you must also run processes
on a daily basis to manage the information exchange between your application and the LDAP directory server. For
information, see the chapter about setting up application security in the Securing Fusion Sales and Service guide.

Setup Tasks in the UI and Other Setup Options
As a setup user, you use multiple different tasks in Setup and Maintenance to create and maintain users. You also have
additional setup options to consider. The following table describes these tasks and setup options.

Setup Task or Option and Navigation Description

Manage Job Roles Task
 
Navigation: Setup and Maintenance
> Sales Offering > Users and Security
functional area
 

Oracle provides many predefined job roles. The relevant sales roles are listed in the Implementing Sales
guide.
 
You perform the Manage Job Roles task to:
 

• Review the role hierarchy of a job or abstract role.

• Create custom job and abstract roles.

• View the roles assigned to a user and list the users who have a specific role.

This task opens the Roles tab of the Security Console.
 

Manage Duties Task
 
Manage Sales and Service Access
Management Task

You perform the Manage Duties task to:
 

• Review the duties of a job or abstract role.
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Setup Task or Option and Navigation Description

 
Navigation: Setup and Maintenance
> Sales Offering > Users and Security
functional area
 

• Manage the duties of a custom job or abstract role.

• Create custom duty roles.

This task opens the Roles tab of the Security Console.
 

Manage Data Security Policies Task
 
Manage Sales and Service Access Task
 
Navigation: Setup and Maintenance
> Sales Offering > Users and Security
functional area
 

You use the Manage Data Security Policies task to manage the data security policies that determine
grants of entitlement to a user or role on an object or attribute group. This task opens the Roles tab of
the Security Console.
 
You can also use the Manage Sales and Service Access task to review and configure data security. This
task opens the Sales and Service Access Management work area. For information, see the Securing
Fusion Sales and Service guide.
 

Manage Users Task
 
Navigation: Navigator > Users and Roles
item or Setup and Maintenance > Sales
Offering > Users and Security functional
area
 

You create application users in the UI using the Manage Users task. A user with the IT Security
Manager job role performs the Manage Users tasks.
 

Note:
You can also create sales users by importing users. For information on the user import options
available, see the Understanding Import and Export Management for Fusion Sales and Service and
Implementing Sales guides.
 

Manage HCM Role Provisioning Rules Task
 
Navigation: Setup and Maintenance Sales
Offering > Users and Security functional
area
 

Oracle provides predefined role mapping rules for provisioning many of the standard job roles included
with the application. However, using the Manage HCM Role Provisioning Rules task, you can create
any additional role mappings you need to, to control the provisioning of roles to application users. For
example, you can create a role mapping to provision the Channel Sales Manager role automatically to
specific sales managers.
 

Import and Export Management
 

You can import users in bulk using data files. For information on the user import options available, see
the Understanding Import and Export Management for Fusion Sales and Service and Implementing
Sales guides.
 

Import Partner Users Task
 

You can also import partner contact data using the Import Partner Users task. For more information,
 see the Getting Started with Your Partner Relationship Management Implementation guide.
 

Single Sign-On Authentication
 

Single sign-on authentication is optionally available for user authentication. If your enterprise has
moved from a traditional on-premises environment to an Oracle Cloud implementation, you might
want to use your existing identity management solution for authenticating your employees, and you
might also want to provide a single sign-on experience. Implementing federated single sign-on lets
you provide users with single sign-on access to applications and systems located across organizational
boundaries. For additional information, see Oracle Applications Cloud Service Entitlements (Doc ID
2004494.1) on My Oracle Support at https://support.oracle.com.
 

Resetting User Passwords
 

Setup users provisioned with the IT Security Manager job role can use the Users tab in the Security
Console work area to reset passwords for all application users. Users who can't access the Security
Console can reset only their own passwords using the Set Preferences link in the Settings and Actions
menu available by clicking their user name in the application or by using the Forgot Password link on
the sign-in page. See the Implementing Sales guide for more information.
 

Updating Email Addresses
 

Use the Users tab in the Security Console work area to change user email addresses. You can use the
procedure described in this topic to update addresses of both setup users and sales users. If you're
updating the email addresses of sales users, then you can also use the same import process you use to
create them. See the Implementing Sales guide for more information.
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Note:  Other data security tasks listed in the Users and Security functional area task list don't apply to the sales
applications. Follow the guidance in the Implementing Sales and Securing Fusion Sales and Service guides.

Related Topics
• Set General Preferences for All Users

• Subject Areas for Adoption and Usage Reporting

About the Sales Administrator  
A user with the Sales Administrator job role performs most setup tasks related to sales the sales applications.

Although he doesn't participate directly in the sales process, you create the sales administrator user as a sales resource
and employee in the organization hierarchy. For more information, see the Overview of Creating Sales Users topic in the
Implementing Sales guide.

Here are the tasks the sales administrator user typically performs:

• Download task lists and setup reports.

• Set sales profile options.

• Configure extensible lookups for sales.

• Run most of the scheduled processes for sales.

• Configure pages in Application Composer and Page Composer.

• Set up the sales calendar.

• Set up accounts and contacts options.

• Manage global search options.

• Function as a centralized territory administrator.

• Configure opportunities.

• Configure forecast criteria.

• Administer sales quotas.

• Configure work assignment.

• Manage price books.

• Create and manage sales products and promotions.

• Set up and administer the sales catalog.

• Set up mobile applications.

• Set up partner functionality.

• Perform configuration tasks.

• Perform data import and export.

• Add and configure sales infolet pages.

• Add analytics to application pages, such as accounts, leads, and opportunities.

• Add analytics to the Analytics page.
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• Create analytics in business intelligence (BI).

• Edit analytics in BI.

Note:  The sales administrator doesn't have the same setup permissions as a setup user. He has permissions required
to set up and administer sales features and components, but not the higher-level permissions required to implement
enterprise and security features.

You can find more information about user setup in the related topics.

Related Topics
• Enable Sales Administrators to Test Configurations in the Sandbox

• User Setup Options

Discard Domain Emails  
During an implementation, you set up users and test business flows that trigger automatic emails. During this stage of
setup, you probably don't want emails being sent to real users, so you can simply use discard email domains that Oracle
has made available.

Discard Email Domains
Oracle recommends that you don't use fictitious email addresses, because this causes email bounces. Fictitious emails
generally take three forms:

• An incorrect user identifier at a valid domain

• A random domain

• A domain that doesn't exist

Using fictitious email addresses can have numerous negative consequences, including unintentionally sending email to
a real person or damaging the reputation of the IP address that sends out the email, potentially flagging it as a sender
of spam. For example, you might send an email to tina.best@ssf.com, thinking that ssf is just a random alphabetic
sequence and not an actual domain. However, your email is actually sent to the Spruce Street Foods (ssf.com). The
Spruce Street Foods email server must then determine if there is a valid recipient and, if not, make a reputation decision
about the sender's IP address.

To avoid these undesirable conditions, Oracle has established email domains in each of its data centers that you can use
temporarily during setup. Any email sent from Oracle cloud applications to one of the discard domains doesn't leave the
data center. Instead, it's discarded by the mail servers during the send process. You can turn any recipient address into
a discard address by replacing the domain information with one of the discard domains. So, in the example presented
here, we might use tina.best@discard.mail.us1.cloud.oracle.com.

Here are the discard domains and the data centers that they're associated with:

Discard Domain Data Center

@discard.mail.us1.cloud.oracle.com Austin
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Discard Domain Data Center

  

@discard.mail.us2.cloud.oracle.com
 

Chicago
 

@discard.mail.us6.cloud.oracle.com
 

Ashburn
 

@discard.mail.ca2.cloud.oracle.com
 

Markham
 

@discard.mail.ca3.cloud.oracle.com
 

Calgary
 

@discard.mail.ap1.cloud.oracle.com
 

Sydney
 

@discard.mail.ap2.cloud.oracle.com
 

Singapore
 

@discard.mail.em1.cloud.oracle.com
 

Linlithgow
 

@discard.mail.em2.cloud.oracle.com
 

Amsterdam
 

@discard.mail.em3.cloud.oracle.com
 

Slough
 

@discard.mail.em4.cloud.oracle.com
 

Frankfurt
 

@discard.mail.em5.cloud.oracle.com
 

Munich
 

Discard domains cross data center boundaries. You can use any of them, no matter which data center supplies your
service. Oracle provides data center-specific domains in case you're concerned about geopolitical boundaries and want
to ensure that discard data remains in your data center region.

Discard domains are also available for government and defense data centers. For details on these restricted data
centers, log a service request for cloud operations through My Oracle Support.

If you're importing your users, you can use the discard domains in your import file and then go back later and re-import
the users with the real domain information. For more information on importing users, see the Overview of Sales User
Import topic in the Implementing Sales guide. guide.

Restricted Users  

Sales Restricted Users  
You can create sales application users who have extensive privileges to view sales data, but limited privileges to change
data, by provisioning users with the Sales Restricted User job role.
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Access Provided by the Sales Restricted User Job Role
To do their jobs effectively, users must be able to view all the data that's relevant to their role in the enterprise. But not
all users also require the ability to create, update, or delete that data. Users assigned the Sales Restricted User job role
can:

• View accounts, contacts, leads, and opportunities.

• Create and modify reports and analytics.

• Update, create, and manage service requests.

• Create, update, and delete notes, tasks and activities for the Activity object.

• Edit forecasts.

• Access content in Oracle Sales Lightbox.

Assigning the Sales Restricted User job role to the following types of users provides these users with the visibility into
sales data that they require, without assigning them excess privileges:

• Back-office users can view reports, edit forecasts, and view activities and interactions.

• Service representatives can view all the information available for a customer and can see leads and
opportunities.

• Seasonal or administrative users can view leads and opportunities.

For additional information about creating restricted sales users, see the topic, Create Sales Restricted Users.

Note:  Some users may require read-only access to application data but don't need any data update privileges. For
example, an auditor who reviews application data for regulatory reasons but isn't authorized to change anything. You
can assign read-only access to individual users using the Read Only Mode (FND_READ_ONLY_MODE) profile option.
For information on how to configure this access for a user, see the topic, Provide Read-Only Access for Individual
Users.

Create Sales Restricted Users  
You can create sales application users who have extensive privileges to view sales data, but limited privileges to create,
update, or delete that data, by assigning users the Sales Restricted User job role.

For example, you might want to assign the Sales Restricted User job role to accounting or legal users, to seasonal or
administrative users, or to users who are assigned an Essential User license. The Essential User license provides a user
with a read-only subscription to the cloud service.

Use these steps to create a sales restricted user.

1. Create the user who's to have restricted access to the application.

For information about this task, see the topic, Create Application Users.
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2. When creating the user, specify these values.

Field Value

Person Type
 

Employee
 

Resource Role
 

Sales Restricted User
 

3. In the Roles region, click Autoprovision Roles.

The user is automatically assigned the following roles:

◦ Sales Restricted User job role

◦ Resource abstract role

◦ Employee abstract role

A predefined rule automatically assigns the Employee abstract role to all active users who are created as
employees.

Records Transfer Between Users  

About Transferring Records Between Users  
Mass transfer of records lets you move records from one user to another. A record owner or any user higher than the
owner in the role or territory hierarchy can transfer records from one user to the other.

Before transferring records, you must understand:

• Record Types

• Record Filters

• Record Transfer Status

Record Types
Record types are broad categories of objects or information related to a user. For example, Deal Registrations associated
with a user. Currently, you can mass transfer Leads, Opportunities, Deal Registrations, and all custom objects excluding
the vertical custom object that belong to a user. You can't mass transfer Accounts and Contacts.

Record Filters
Record filters let you refine the list of records associated with the user for a record type. For example, you can transfer
only deal registrations that were created during a time period. You can't specify filters for all record type. The Transfer
Records: Define Filters page lets you view the record types that allow filtering, and specify the record filters.
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Record Transfer Status
Record transfer statuses appear in the Mass Transfer Status page and show the status of transfer jobs. The Mass
Transfer processes records to ensure data integrity before transferring the records from a user to the other.

A Record Transfer job can have one of these statuses:

• In Progress: Transfer job is currently in process.

• Completed: Transfer job has been completed without errors.

• Errors: Transfer job has resulted in an error.

You can click on the transfer job name to view the record types that were transferred, the status of each record type, and
the log file associated with a record type.

Transfer Records Between Users  
This procedure describes how you can transfer records from one user to the other using the Mass Transfer tool.

To transfer records from one user to another:

1. Navigate to Mass Transfer from the Tools menu.
2. In the Mass Transfer Status page, click Transfer Records.
3. In the Transfer Records: Select Owners and Records page, search for the current owner and the new owner of

the records. For example, if you're transferring from Adam Smith to Samantha Hayes, then select Adam Smith
as the current owner and Samantha Hayes as the new owner.

4. Select the types of records you want to transfer. For example, if you're transferring opportunities and leads,
then select Opportunities and Sales Leads.

The Transfer Details column lists the types of records that will be transferred.
5. Click Next.

In the Transfer Records: Define Filters page, you specify filters for record types you have selected. For example,
you can specify the start and close dates for opportunities to transfer the opportunities that were closed during
a specified period of time.

6. Select a record type to view the filters available, and specify the filters.
7. Click Submit.
8. Click Yes in the confirmation dialog box.

The Mass Transfer Status page lists the recent mass transfer jobs and their statuses.
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5  Sales Resources, Roles, and Organizations

Overview of Managing Resources  
Managing resources involves viewing and modifying a resource's profile, organization membership, role assignment,
skills, additional contact information, and salesperson information.

All the resources within the deploying company can view any resource's profile. However, only the administrator can
modify a resource's profile, organization and team membership, and role assignment. Managers can modify the skill
information of their direct and indirect reports. However, resources can only modify their own profiles, skills, and
additional contact information.

Manage Resource Profiles
Resource profile management involves managing a user's profile, including the resource's core skills, photo, time zone,
additional contact information, and so on. As part of managing a resource's profile, the administrator specifies the dates
between which the resource is available to the organization. The administrator also ensures that role assigned to the
resource is within the period mentioned in the profile.

Manage Organization Membership
At any point in time, a resource belongs to an organization, and the administrator can assign this resource to any other
organization within the deploying company.

Manage Resource Role Assignment
An administrator or an organization manager can assign or modify resource roles within an organization, with one
role assigned to a resource at a time. However, administrators can also assign multiple roles to resources outside an
organization.

Note:

• The dates of the resource role assignment must be within the date range during which the resource is active in
the deploying organization.

• An organization can have only one manager.

Configure Extensible Resource Pickers
Administrators can configure extensible resource pickers that let sales users search and associate users with business
objects relevant to their business flows. For more information about configuring the resource search, see the related
topics.
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Related Topics
• Overview of Configuring Resource Search

• Configure Resource Search

• Frequently Asked Questions (FAQs) for Resources

Resource Directory  
You can use the Resource Directory to view all the resources within your organization. You can also use the Resource
Directory to find and communicate with other resources, and to network and collaborate with them.

You can access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform
some of the functions of the resource directory using the Manage Resources setup task.

You use the Resource Directory to perform the following tasks:

• View and modify your profile

• View your organization information

• View information related to other organizations

• View the profiles of other resources

• Communicate with other resources

Note:  You can set the profile option HZ_RESOURCE_ALLOW_CUSTOMIZATION to Yes to enable desktop pages for
Resource Directory in Application Composer. The default value of this profile option is No.

Related Topics
• Frequently Asked Questions (FAQs) for Resources

Make an Employee a Sales Resource  
An employee must be a sales resource before they can be assigned to any role or be added to any organization.

After making an employee as a sales resource, you can manage the resource's organization membership, add or remove
skills of the resource, provide contact information, and so on. If you have an employee who needs to be a sales resource,
perform these steps:

1. Navigate to the Resource Directory.
2. Click Identify Resources in the Tasks region.
3. On the Identify Resources page, fill in the Person Name or Registry ID. You don't need to enter the complete

name. The application automatically searches for any characters entered, even if it's only a single character.
4. Select Employee as the Usage and click Search.
5. Select the employee and click Add as Resource.
6. Click OK on the confirmation message.

The employee is now also a sales resource.
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7. On the Add Resource Information page, in the Resource Details section, specify dates for the resource.
8. Select the Organization and the Role that you want to assign to the resource.
9. Optionally, in the Sales Person Information section, specify additional information about the resource.

10. Click Save and Close.

Related Topics
• About Transferring Records Between Users

• Designate Proxies

• Impersonation Audit

• Configure Impersonation Auditing

How to Enable the Skill and Qualification Tabs on
Resource Pages  
You can use the Skills and Qualifications tabs in the resource page to record the skills and qualifications of a resource.

By default, the Skills and Qualifications tabs aren't displayed in the resource pages. To display the tabs, you must set the
profile value of the Resource Detail Page Enabled (ORA_HZ_RES_ENABLE_SKILLS) profile option to Yes.

Here's how you set the profile option and then view the tabs:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search ORA_HZ_RES_ENABLE_SKILLS profile option code.
3. Change the Profile Value to Yes.
4. Click Save and Close.
5. Click Navigator >  Resource Directory.
6. Select a resource and click Actions >  View Resource Details.

The Skills and Qualifications tabs are enabled.

Examples of Updating Resource Skills and Qualifications 

This example illustrates the various contexts in which you can update your skills and qualifications in Oracle Resource
Management.

You can add a wide range of skills and qualifications into Oracle Resource Management. For the sake of convenience,
let's categorize these into core skills, achievements, and mandatory requirements.

Each of these skills must be used in specific contexts as described in the following scenarios.
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Update Core Skills
Skills that reflect your key abilities are categorized under the Core Skills head, such as competencies, degrees,
languages, licenses and certifications, skills, and problem codes.

• Use the Competencies option to record your key abilities as a resource. For instance, if you have the ability to
quickly internalize and analyze complex information, list it here.

• Use the Degrees option to record your educational degrees.

• Use the Languages option to record your proficiency with the various languages you know.

• Use the Licenses and Certifications option to record any educational licenses and certifications you may have
received. For instance, if you have a Six Sigma certification, list it here.

• Use the Skills option to list out any specific software or engineering skills you may have. You can search for
these skills by category, product, platform, or component.

• Use the Problem Codes option to record your ability to manage and remedy specific service-related problems
that may arise within your company. For instance, if you're skilled at troubleshooting hardware issues, list it
here.

Update Achievements
Skills that reflect your key achievements and uncommon abilities are categorized under the achievements head, such as
accomplishments, honors, awards.

• Use the Accomplishments option to record any major task you completed that reflects your abilities as an
individual. For instance, if you completed a rather difficult task in a short deadline, list it here.

• Use the Honors and Awards option to record any special honors or awards you may have received. For instance,
if you were the recipient of a certificate of merit award, list it here.

Update Mandatory Requirements
Skills that capture the mandatory requirements, which you have met for your employment, are categorized under the
mandatory requirements head. Thus, job requirements and work requirements are part of mandatory requirements.

• Use the Job Requirements option to update all job requirements you have met. For instance, many companies
require you to take a medical test before you join. If you took such a test before you joined the company, list it
here.

• Many roles have specific requirements that employees must fulfill before these roles can be assigned to them.
Such requirements can be listed out under the Work Requirements head. For instance, if you're willing to travel
overseas on duty, list it here.

Resource Roles  

About Resource Role Assignment  
Resource role assignment is the task of assigning roles to active resources within the deploying company.
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These roles are previously set up, and have associated security privileges. Thus, when you assign a specific role to
resources, they automatically receive access to specific business functions within the company. A resource can only
have one role associated to organization membership and additionally can be assigned more individual resource roles.
A resource can be part of any one organization at any given point of time during active resource assignment range
(start date and end date).

Define Resource Roles  
A resource role, such as salesperson, denotes the function of a resource in an enterprise.

Oracle Applications Cloud comes with some predefined resource roles. You may either use these predefined, out of the
box resource roles, or you may use the Manage Resource Roles task in the Setup and Maintenance work area to create
additional resource roles or to modify predefined resource roles. Note that you must map these newly created resource
roles to one or more job roles and abstract roles before you can use them. Access to business data and privileges to run
business flows comes through job roles and abstract roles.

Use Role Tags While Defining Resource Roles
You can set several tags while defining resource roles. Use these tags along with the organization hierarchy information
to define the reporting hierarchy of resources.

• Use the Manager tag to define a role as a supervisor role. You must assign a resource organization to a
manager resource, who will have visibility into all opportunities assigned to the members of that resource
organization.

• Use the Member tag to make a role a subordinate role in the resource hierarchy.

• Use the Administrator or Lead tag to indicate the nature of the tasks that resources who are assigned these
roles perform within the hierarchy.

Additionally, you can use these tags along with the resource organization hierarchy information to maintain
manager-to-manager relationships within the organization. For example, Resource A is a manager who heads a sales
organization and Resource B heads his own sales organization. Then, both Resource A and Resource B report into
Resource C, the Sales Vice President. Similarly, you can create resource organizations and manager resources, and relate
managers to higher-level managers, building the resource organization and reporting hierarchies of the company.

Assign Resource Role Types
Resource role types organize roles into logical groups. This simplifies role assignment and assignment tracking. For
example, the Partner resource role type defines a set of partner-specific roles, such as partner sales representative
and partner sales manager. Use the Sales resource role type and the Marketing resource role type to categorize the
appropriate sales and marketing roles for internal employees or contingent worker resources.

About Provisioning Roles  
This topic explains role provisioning, and the difference between resource roles and job roles.

Role provisioning automates the provisioning and deprovisioning of roles, based on resource role assignment. You use
job roles to provide access privileges. You can use Setup and Maintenance, Manage HCM Role Provisioning Rules task
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to map the job roles to the resource roles. Associating a resource role to a user enables the user to access the tasks and
data based on the job roles assigned to the resource role.

Difference between Resource Roles and Job Roles
Resource roles are used to filter resources, generate reporting hierarchies, and define security policies. A resource role
may be assigned to a resource without a user account, while a job role can only be provisioned to a resource who has a
user account. Job roles are used to define the security privileges for a user account.

Overview of HCM Job-to-Role Mapping  
A Human Capital Management (HCM) job indicates the designation of a person in the deploying company.

A job-to-role mapping associates HCM jobs with specific resource roles. You can establish job mapping for a resource
role in Setup and Maintenance, Manage Resource Roles task. This mapping simplifies the task of assigning resource
roles to new employees or contingent workers, resulting in time and cost efficiency.

For example, an employee joins the Sales department as a sales representative and the employee's job is already
mapped to the Salesperson resource role. In this case, the employee is automatically converted to a resource and
is assigned the mapped resource role. Thus, you can place new employees faster in organizational and reporting
hierarchies.

Here's how to map HCM jobs and roles:

1. Verify that the HZ_AUTOMATE_RESOURCE_CREATION profile option is set to Yes.

a. In the Setup and Maintenance work area, go to the following:

- Offering: Sales
- Functional Area: Sales Foundation
- Task: Manage Administrator Profile Values

b. Search HZ_AUTOMATE_RESOURCE_CREATION and ensure that it's profile value is set to Yes.
2. Define HCM jobs and their structures, as required. For more information about defining jobs, see Related Topics

section. You can also map existing jobs.
3. Map the HCM jobs to their roles.

a. In the Setup and Maintenance work area, go to the following:

- Offering: Customer Data Management
- Functional Area: Resources
- Task: Manage Resource Roles

b. You can create a role with the required details by clicking Actions >  Create or edit an existing role by
clicking Actions >  Edit.

c. Scroll down to Job Mapping and click Actions >  Add Row.
d. Search the HCM jobs defined in Step 2 in the Job column.
e. Click Save and Close.

Related Topics
• Jobs
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About Resource Members and Dates  
Every resource in the deploying company has start and end dates for a specific activity. When you assign resources to
organizations, you must ensure that their date of assignment is within the employment date range.

Resource Active Dates and Resource Assignment
When you identify internal or partner employees as resources, you can specify the time for which they're active within
the organization. By default, the date you identify a resource becomes the start date, but there is no end date listed.
Thus, an identified resource is active from the day of activation and you can assign the resource to any organization
for an infinite period. A resource can be part of any one organization at any given point of time during active resource
assignment range (start date and end date).

Resource Skills and Resource Assignment
To get the best out of resources, you may define their skills relevant to the organization within which you deployed
them. Determine whether a resource's skill set matches the requirements of an organization. Then, deploy the resource
as appropriate for a period of time that falls within the active dates specified for the concerned resource.

Restore Inactive Resource Roles  
You may want to delete custom seed data such as a custom resource role when the role is no longer used in your
organization.

If you have accidently deleted these roles, as a sales admin, you can restore them. You can temporarily hide certain
resource roles and also re-instate them back, if needed later. When you delete a role, it becomes inactive. You can
restore the role later by first searching for the inactive role and then restoring it in the Manage Resource Roles task.

1. 1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Resources

◦ Task: Manage Resource Roles

2. In the search section, select Inactive in the Status filter to search for inactive roles.
3. Select the required role and click the Restore button.

Note:  The Restore button is available only when there are inactive roles.

Results:
The inactive role is now active.
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Overview of Resource Roles, Job Roles, and Abstract Roles  
A resource role, such as salesperson, denotes the function of a resource in a resource organization. Job roles and
abstract roles provide users access to business data and privileges to run business flows.

Oracle follows the industry standard Role Based Access Control approach to security. In Oracle Applications, the
privileges are bundled in:

• Job roles, such as Sales Representative, which correspond to the jobs that the person is doing in your
organization.

• Abstract roles, such as Employee or Contingent Worker, which permit users to carry on tasks that are common
to all employees or resources.

For example, the Sales Manager job role makes it possible for a user to perform all of the sales manager duties, such
as reviewing sales team performance and approving forecasts. The Employee abstract role adds the ability to access
reports and manage personal profile information. The Resource abstract role makes it possible for a user to be assigned
as a sales resource to accounts and opportunities.

When you create a user as an employee with the Sales Manager resource role provided by Oracle, as shown in the
following figure, the application automatically provisions the Sales Manager job role and the Resource abstract
role. Because you're creating the user as an employee, the application also provisions the Employee abstract role.
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Resource Organizations  

Overview of Resource Organizations and Organization Usages  
You can assign organization usage information to resource organizations to classify them based on how you want to use
them. For instance, you can assign the Sales Organization usage to resource organizations engaged in sales activities.

This enables you to sort organizations based on their usage, simplifying your task of working with them.

How Resource Roles and Resource Organizations Work Together  
This topic explains how resource roles and resource organizations work together.

A single resource can belong to only one resource organization and be associated with only a single resource role,
during a given period. The organizations and organization hierarchies that a resource belongs to determine the
reporting relationships for that resource.

Resource Roles
A resource role, such as salesperson or sales manager, denotes the function of a resource in an enterprise from the
perspective of the deploying company. A resource role not only describes who a resource is in the enterprise, but also
specifies the role a resource performs within the context of an organization or team. A resource can have only one role
in a resource organization during a given period.

Note:  You can assign only one role to a resource at a time.

Resource Organizations
A resource organization represents the internal organization and structure of the deploying company. Resource
organizations are hierarchically structured, and the organization hierarchy helps to derive the reporting relationships. A
resource can be a part of different organizations within the deploying company, and can have separate roles in each.

About Primary Resource Organization by Usage  
A resource can belong to only a single resource organization during a given period.

For each organization, you can assign different resource roles to a resource. When you assign a resource to one
resource organization, the organization becomes the primary organization for the resource for a specific usage.

A resource organization becomes a primary resource organization by usage for a resource, if it meets the following
criteria:

• Resource must be a member of the concerned organization.

• Resource organization must be classified as an organization with the specific usage.
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For example, if you classify the resource organization as a marketing organization by usage, then the resource
organization becomes the primary resource organization for the resource for marketing.

Overview of Organization Memberships and Role Assignments  
When you assign a resource to an organization, you must also specify the role the resource is required to play in the
organization.

This helps ensure clarity on the tasks that you can assign to a resource and helps define where the resource is situated
within the organization's hierarchy.

Note:  An organization can have only one manager. A resource can have only one role in a resource organization
during a given period.

Associate Business Units with Resource Organizations  
You can associate resource organizations with multiple business units.

The first business unit that you associate with a resource organization is automatically listed as the primary unit.

Associating resource organizations with business units helps you to view the relevant transactional details associated
with the resource, such as opportunities, leads, and so on. By associating resource organizations with business units,
you can also control access to contracts that are based on business units.

Users are associated with a business unit through their resource organization membership. Resource organizations are
mapped to one or more business units. When a sales user is created, the user is assigned to a resource organization,
and gains access to each business unit that's mapped to the resource organization. For example, users can access
relevant transactional data associated with their primary business unit, but might also have access to relevant
transactional data in other business units through their resource organization.

For more information about data access and business units, see the topics in the Securing CX Sales and Fusion Service
guide.

You can associate a resource organization with multiple business units from the Resource Directory. For more
information, see the Associate Resource Organizations with Multiple Business Units topic.

Related Topics
• Multiple Business Units High-Level Setup Steps

• Associate Resource Organizations with Multiple Business Units

Associate Resource Organizations with Multiple Business Units  
By associating resource organizations with business units, you can control access to the transactional data available to
sales resources in business objects like opportunities and leads.
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Here's how to associate resource organizations with multiple business units:

1. In Setup and Maintenance go to:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Resource Organization Members

2. In the Manage Resource Organization Members page, search for and select the resource organization that you
want to associate with a business unit.

3. In the Organization page, click the Business Units tab.
4. In the table, click the add row icon.
5. Select a business unit from the Business Unit list.
6. Click Save. The first business unit you selected is set as the primary business unit.
7. Similarly, select additional business units from the Business Unit drop-down list.
8. Click Save and Close.

Related Topics
• Multiple Business Units High-Level Setup Steps

Example of Adding or Removing an Organization From an
Organization Hierarchy  
This example describes how you can add or remove a sales organization to or from a sales organization hierarchy.

As new sales organizations are created within your company, you need to add these organizations to your company's
sales organization hierarchy.

Similarly, you may want to remove organizations that no longer exist.

Creating a New Version
1. Navigate to the View Organization Hierarchies UI page as follows: Navigator > Resource Directory > Tasks >

View Organization Hierarchies.
2. Search and select the sales organization hierarchy you want to edit.
3. Click the Action menu. If you want to add the new organization to the sales organization hierarchy with

immediate effect, select the Edit This Hierarchy Version option. If you want the new organization to display
in the organization hierarchy only after a specific date, then select the Create Hierarchy Version option. If you
choose the latter option, then you must specify the date from which the new version of the sales organization
hierarchy must be active.

Adding or Removing an Organization From the Sales Organization Hierarchy
1. Navigate to the View Organization Hierarchies UI page as follows: Navigator > Resource Directory > Tasks >

View Organization Hierarchies.
2. Search and select the sales organization hierarchy to which you want to add a new organization.
3. On the Action menu, click either Edit This Hierarchy Version option or Create Hierarchy Version option.
4. In the Create or Edit Organization Hierarchy Version page, select the node in the sales organization hierarchy

where you want to add the new sales organization and click the Add button.
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Note:  To delete an organization, select the required node and click the Remove button on the Edit
Organization Hierarchy Version page. Click to confirm. If you don’t plan to add any organization, skip to step 7.

5. Search and select the new sales organization in the Add Tree Node screen. This adds the new organization to
the sales organization hierarchy.

6. Select the new organization in the hierarchy, and drag and drop it to the node where you want to place it. The
organization appears in the location you specified within the selected sales organization hierarchy.

7. Click Save and Close.

Example of Creating an Organization with Sales Usage  
This example demonstrates how to create a resource organization with sales usage.

There are two options to create resource organizations with sales usage:

• Create an organization from an existing department

• Create a new organization

Creating an Organization from an Existing Department
You must create an organization with sales usage from an existing department if the concerned department must be
reused as a sales organization. Use the following steps:

1. Navigate to the Manage Internal Resource Organizations UI page as follows: Navigator >  My Enterprise > 
Setup and Maintenance >  Tasks >  Search >  Search for Manage Internal Resource Organizations.

2. You can either search for the organization whose usage you want to modify or click the Create button,
select the Create from Existing Department option and specify the name of the organization in the Create
Organization: Select Creation Method screen and click Next.

3. Click Actions >  Add Row.
4. Specify Sales Organization as the Usage under the Organization Usages section of the screen.
5. Click Finish.

Creating a New Organization with Sales Usage
1. Navigate to the Manage Internal Resource Organizations UI page as follows: Navigator >  Setup and

Maintenance >  My Enterprise >  Tasks >  Search >  Search for Manage Internal Resource Organizations.
2. Click Actions >  Create.
3. Select the Create New Organization option on the Create Organization: Select Creation Method screen and

click Next.
4. Specify the name of the new organization and select Sales Organization as its usage.
5. Click Finish to save the new organization with sales usage.

Assign a Resource to an Organization  
Once you have identified a resource, you can assign the resource to organizations within the deploying company. This
example explains how you can assign resources to organizations.
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Scenario
You must assign a resource to an organization. A resource can belong to only one organization and can have only one
role in an organization during a given period.

To assign a resource to an organization, perform the following tasks.

1. Navigate to the View Resources UI page as follows: Navigator > Resource Directory > Tasks > View
Resources.

2. Search for a resource and select it.
3. Click the Organizations tab. This displays the list of organizations to which the resource belongs.
4. In the Actions drop-down list, click Create.
5. In the Create Organization Membership pop-up, search and select the organization you want from the

Organization drop-down list.
6. In the Actions drop-down list, click Add Row and select the role the resource must play in the organization.
7. Enter the From Date and To Date, and click OK.
8. Click Save and Close.

You can also assign resources to organizations by searching for organizations and adding members to the organization.
To assign resources to organizations by searching for organizations:

1. Navigate to the View Organizations UI page as follows: Navigator > Resource Directory > Tasks > View
Organizations.

2. Search for an organization and select it.
3. Click the organization's name to display its details.
4. Click the Members tab to edit the list of members assigned to the organization.
5. In the Actions drop-down list, click Create to assign a new resource to the organization.
6. In the Add Resource Member window, select a resource from the Resource drop-down list.
7. Click the Add Row button to add a role to the newly-added resource.
8. Click the Role drop-down list and select the role the resource is required to play in the organization.
9. Enter the From Date and To Date, and click OK.

10. Click Save and Close.

Note:
1. The date from which a resource is a member of an organization must be on or after the date which the resource

was hired.
2. You can't reassign the resource to the same organization, if a resource was already a member of the selected

organization with an end date later than the current date. You also can't reassign the resource to the same
organization, if the resource was removed from the organization before the end date.

How You Manage Resource Organization Hierarchy Changes  
Consider a resource who's assigned the role of a manager. This manager may be part of a hierarchy and contain direct
reports.

For example, a group of salespersons report to a sales manager and this sales manager reports to a sales director. The
sales director may have one or more sales managers reporting to him or her.
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A manager may leave the organization, transferred to another organization, maybe demoted from a resource manager
role to a salesperson role, and so on. In all such cases, the direct reports maybe left as orphaned resources within
the organization. To prevent such scenarios, by default it isn't allowed to change the manager having active child
organization or direct reports.

When you need to move the manager having direct reports, as an exception, you can use the Enable End Dating
Resource Manager Unconditionally (ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option. This allows the
movement of the manager resource without the need to move the child organizations and direct reports.

The Enable End Dating Resource Manager Unconditionally (ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option
is set to No by default. If the profile value is set to No and you try to end date the resource manager or end-date the
resource organization membership of the resource manager while there are active direct reports, an error message is
displayed. You must first move these direct reports to another organization and then end date the resource manager.

Complete these steps to set the value of the Enable End Dating Resource Manager Unconditionally
(ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option to Yes:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for ORA_HZ_RES_ENABLE_MGR_END_UNCOND and view or change the profile value.

Note:  This profile option setting impacts the handling of resources using the application UI, Import, and web
services. Changing this profile value to Yes leads to orphan resources and causing data integrity issues. We
recommend that you don't change the profile value to Yes. If you must change the value, you must be extremely
cautious specially while handling large volumes of resource organization data. You must provide a replacement of the
manager at the earliest.

FAQs for Sales Resources, Roles, and Organizations  

Frequently Asked Questions (FAQs) for Resources  
This section contains the some frequently asked questions (FAQs) when setting up and maintaining resources. Scroll or
search to find answers to common questions.

How do I define whether the user image, name, or initials display
in the global header?  
Set the User Image Display Enabled (FND_USER_PHOTO_ENABLED) profile option.

If you select:

• Yes, then the user image is displayed in the global header only if the user uploaded a photo. Otherwise, the
user's initials are displayed. By default, this profile option is set to Yes.
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• No, then only the user name is displayed in the global header.

Related Topics
• Change Your Photo

What's a duty role?  
Job and abstract roles permit users to carry out actions by virtue of the duty roles they include. Each predefined duty
role consists of a logical grouping of privileges that represents the individual duties that users perform as part of their
job. Duty roles are composed of security policies which grant access to work areas, dashboards, task flows, application
pages, reports, batch programs, and so on. You can create duty roles and can include predefined and custom duty roles
in custom job and abstract roles. You don't assign duty roles directly to users.

Note:  For information about security policies, see the Securing CX Sales and Fusion Service guide.

How can I identify a resource?  

To identify specific employees, contingent workers, or partner contacts as resources, you must search for them and
enable them as resources. You can use the Manage Resources task, Manage Users UI, and the Resource Directory to
search persons and identify them as resources. Once you have identified these resources, you can assign them to
organizations as required. Similarly, you can also identify newly added employees or contingent workers as resources.

Can I assign more than one resource role to a resource
organization member?  
No. One resource can only have one role within an organization.

Can I add more than one resource role to a resource?  
Yes. While a resource can have only one resource role within a resource organization, a resource can have multiple
individual roles.

Resource can't have multiple active roles with different organizations.
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What resource role is displayed on the Manage Users UI when a
user is assigned more than one role?  
The resource role displayed in the Resource Information section of the Create User or Edit User pages in the Manage
Users work area is the resource role that's associated with the user's organization. If none of a user's resource roles is
assigned to the user's organization, or an organization isn't specified for the user, then the first active resource role
assigned to the user is the role that's displayed.

What's a resource organization hierarchy?  
A resource organization hierarchy is a hierarchically structured representation of the way resources are grouped within
a resource organization. Resource organization hierarchies can contain other organizations within them. Thus, you can
include any resource organization within the deploying company to create a single global hierarchy that depicts the
operational structure of your company. We support up to 16 levels in the Resource Organization Hierarchy.

Can I create a new organization hierarchy version?  
Yes. To create a new hierarchy version, click Navigator > Resource Directory > Tasks > View Organization Hierarchies
and select the hierarchy whose new version you want to create. Click Action Create Hierarchy Version. Make the
changes to the hierarchy as required. Specify the dates between which the organization hierarchy must be active, and
click Save and Close to save your changes.

Can I create a new organization?  
Yes. You can create organizations using the Manage Internal Resource Organizations task in Setup and Maintenance or
in the Partner Management UI. You can also create resource organizations from the User Management UI. You can also
use the UI to manage user accounts and roles, and to create employee and partner-member users.

Can I create a new organization hierarchy?  
No. All organizations within your deploying company are part of a large overarching global hierarchy. Therefore, you
can't add new organization hierarchies. However, you can move existing organizations or attach new organizations to
the existing hierarchy and create a new version of the hierarchy.

Once you have created a new version, specify the date from which the new version must become active. On the
specified date, your new hierarchy version replaces the older hierarchy.
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Can I copy a resource organization hierarchy?  
No. You can only have one resource organization hierarchy active at a time within a deploying company. If you have to
create a hierarchy for an organization, you must specify the reporting structure within the concerned organization and
then make the organization a part of the existing hierarchy.

What happens if I delete a resource?  
When you delete a resource, the resource is deleted from the Resource Directory and from the organizations with
which the resource was associated. It's always best to check a resource's usage and remove the resource from all the
organizations before deleting a resource from the resource directory.

Can I create an employee or contingent worker resource?  
No. You can only identify existing employees and contingent workers as resources in the Manage Resources task.

What happens when a resource is end dated?  
When resources are end dated, the resource is removed from all organizations in the deploying company, and no new
work objects can be assigned to them. This also removes the resource from the organization hierarchy. The employee
associated with the resource isn't impacted. All non-transactional business objects such as accounts and contacts are
orphaned until you assign an owner. We recommend that you transfer all the assigned and owned entities or records to
another active resource.

How can I delete a resource from an organization?  
To delete a resource from an organization, you must delete the concerned resource's membership from the
organization.

To manage the membership of an organization, navigate to the Manage Resource Organization Members Setup and
Maintenance task and select the organization concerned. Once the organization's membership details are listed, you
can add, delete or edit them as required.
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What happens if I delete a resource from an organization?  
When you delete a resource from an organization, you effectively delete the concerned resource's membership with the
organization. This also removes the resource from the organization hierarchy. All transactions assigned to the resource
are no longer visible to the resource's managers.

How can I reactivate a deleted resource organization hierarchy?  
To reactivate the resource organization hierarchy that you deleted, navigate to the View Organization Hierarchies
page as follows: Navigator > Resource Directory > Tasks > View Organization Hierarchies. Search and select the
deleted resource organization hierarchy. From the Action menu, select Edit This Hierarchy Version and set the Status
to Active.

What happens if I add a resource to an organization?  
When you add a resource to an organization, the resource becomes a member of the organization and a part of the
organization hierarchy.

Organization membership information is part of the publicly visible details of a resource profile. This means that a
resource's organization membership and reporting structure are visible to all active resources within the organization.

How can I reuse a resource organization in multiple organization
hierarchies at the same time?  
A resource organization can have one resource organization hierarchy for each internal organization and one partner
organization hierarchy for each partner company. You can have one active version and multiple inactive versions of
resource organization hierarchies. You can include resource organizations into any of the active or inactive organization
hierarchies.

Can I create multiple resources as managers within a resource
organization?  
No. An organization can have only one manager.
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Why didn't the Manage Resource Organization Hierarchies task
open?  
The Manage Resource Organization Hierarchies task may not open or be unresponsive if the browser some plugins
installed. You can clear cookies or cache of the browser, use the browser's incognito mode, or use a different browser.

How can I search and view resource information from other
sources?  
You can search for resources and view their public profiles using the Resource Directory. You can search for resources
either by name or organization, or by the names of the teams to which they belong.

You can use the Resource Directory to view the following details of a resource's profile:

• Key profile information, including the resource's name, manager's name, job title, contact information, and so
on.

• Organization membership information

• Roles of the resource

• Key skills of the resource

• Additional contact information

• Salesperson details, if applicable.

You can search for organizations or teams, instead of searching for users. Then, you can view the list of resources that
belong to an organization or team, and view the profiles of any resource listed.

Why am I unable to view the resource hierarchy for my
organization?  
You must enable the reporting structure of your organization for a resource or reporting hierarchy to be visible. If there
is no manager defined for an organization, the reporting hierarchy of the organization can't be constructed. Verify if
your organization is assigned a manager in Resource Management.

Can I view a resource organization hierarchy version as of a
particular date?  
Yes. Unless otherwise specified, organization hierarchies are active since the date of their creation. Navigate to the
View Organization Hierarchies page from the Resource Directory to view the hierarchy of a resource organization at
a specific date. You can search and select the organization hierarchy to view its details. This displays the concerned
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organization's active hierarchy. A drop-down list displays the date from which the current organization hierarchy has
been active. You can select the required date from the drop-down list to view the organization hierarchy for a particular
date.

How can I sync resource organization hierarchy with HCM
department hierarchy? Is resource organization same as HCM
department ?  
Resource organization hierarchy isn't the same as HCM department hierarchy. Resource organization doesn't refer to
HCM department. Currently, resource organization hierarchy can't be synced with HCM department hierarchy.

How can I prevent the validation script of the contact object from
impacting other objects such as resources and suppliers?  
You must write your application code in such a way that the validation script of the contact object doesn't impact other
object flows such as resources or suppliers. Here's a sample Groovy code:

if (InternalFlag == 'N')
{
<your application code>
}

What happens if an employee or worker quits or is terminated?  
When an employee leaves your company, it's best practice to inactivate the employee's user account of an application.
Inactivating the user's account prevents the user from being able to log in to the application. After you inactivate a user
account, you must set end date the resource.
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6  Geographies

Overview of Geographies  

Import Geographies and Zones  

Set Up Geocoding  

FAQs for Loqate Support  

FAQs for Define Geographies  
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7  Common Components

Overview of Setting Up Common Components  
Several common components provide core functionality for the applications. Common components provide
functionality that spans multiple applications, such as the accounting calendar or application messages. This chapter
describes many of the common components.

Where appropriate, other common components have their own individual chapters or are described in other guides or
help topics.

Actionable Infolets  

Overview of Actionable Infolets  
Actionable infolets are transactional infolets that can co-exist on the same page as business intelligence (BI) infolets.
Actionable infolets give salespeople a quick overview of pending tasks in a single place.

Salespeople can quickly act from the infolets themselves, without having to navigate to different detail views. The
following actionable infolets are available by default:

• My Tasks

• My Appointments

• My Accounts

• My Leads

• My Opportunities

You can also view a graphical representation of the actionable infolets. The summary charts display data based on the
selected filters.

The predefined, actionable infolets let salespeople quickly navigate to relevant areas to perform quick actions on
individual records. The infolets can improve sales performance by prioritizing tasks and filtering data. Filtering reduces
the number of searches required to view any outstanding items that might require attention.

Salespeople can personalize actionable infolets, refresh data, and create and edit data as required. Built in configuration
features help salespeople effectively plan their day, thus saving valuable time. For example, they can choose to select
or hide predefined filters that they want to make available on the actionable infolets so that they see only the data they
need to see at any given time.

About the Sales Infolets Page  
The Sales Infolets page displays key sales information in containers called infolets. Some infolets provide you with an
overview, but others make it possible for you to take direct action.
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These actionable infolets summarize key sales data and let you take immediate action on the tasks presented. The Sales
Infolets page is enabled by default. Ensure that you have access to the job roles for which you're enabling the page.

To understand how to configure the springboard and home page to fit your unique business needs, see these guides on
Oracle Help Center:

• Oracle Applications Cloud Configuring Applications Using Application Composer

• Configuring and Extending Applications

Note:  Actionable infolets are secured through the "View Sales Homepage pagination dot one" and the "View Sales
Representative Dashboard" privileges. Ensure users have these two privilege. For more information, see the Securing
Sales and Fusion Service and Security Reference for Sales and Fusion Service guides on Oracle Help Center.

Related Topics
• Personalize Your Key Infolets

• Overview of Sandboxes

• How do I view the privileges or policies for a job role?

Set the Actionable Infolet Personalization Enabled Profile Option  
Sometimes salespeople want to modify the default settings and personalize their actionable infolets so that they can set
up their own filters and modify how they want to display the details of the records.

Here's how to enable users to personalize actionable infolets:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZBS_ENABLE_ACTIONABLE_INFOLET_PERSONALIZATION in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click on the profile option code link.
5. Set the profile option value to Yes.
6. Click Save and Close.

Related Topics
• Modify Actionable Infolets

• Personalize Your Key Infolets
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Modify Actionable Infolets  
As an administrator, you can choose to modify or remove existing predefined fields (attributes) or select additional
user-defined attributes to display on actionable infolets for salespeople. You can apply different setting for salespeople
by role or at the site level.

If you want to modify the My Tasks and My Appointments actionable infolets, then the Date, Time, and Subject
attributes must be noneditable. This means that the drill-down option isn't available on these fields.

Salespeople can improve their sales performance tasks by prioritizing tasks and using filters. Record-count filters
selected by salespeople take precedence over the record count setting that you specify. For example, if you set 10 as the
record count for the My Tasks actionable infolet, and if the salesperson selects the Overdue Tasks filter, then 10 records,
if applicable, are displayed.

Salespeople can also view a graphical representation of the actionable infolets. The summary charts display data based
on the selected filters.

Before You Modify the Infolets
Before modifying the predefined actionable infolets, do the following:

• Understand the typical workflows for working with runtime application changes.

• Ensure that you can modify the infolet by checking if the Edit Pages menu item is available in the Settings and
Actions menu available from the global header region. Click your user image or name in the global header to
open the Settings and Actions menu. If the menu item isn't available, then you can't modify the page.

Note:  Actionable infolets are secured through the "View Sales Homepage pagination dot one" and the "View
Sales Representative Dashboard" privileges. Ensure users have these two privilege. For more information, see
the Securing Sales and Fusion Service and Security Reference for Sales and Fusion Service guides on Oracle
Help Center.

• Confirm that your privilege is sufficient for modifying the page.

• Create or activate an existing sandbox.

When configuring actionable infolets, make sure the sandbox has only the Page Composer tool selected. If you
want to make changes in a context layer other than the default Site layer, you must create a separate sandbox
and use only Page Composer in it. You can then change the context layer from Site to other layers. For example,
to create or edit infolets for a user with a specific job role, you must select the Job Role context layer.

CAUTION:  If you delete an infolet, you can't easily retrieve it. Contact your help desk if you accidentally delete one.

Edit Actionable Infolet Visibility
Actionable infolets are available to predefined roles. However, you can set the availability of actionable infolets so that
they become visible to other user-defined roles by editing the visibility settings for the infolet:

1. Navigate to the actionable infolets page.
2. Click your user image or name in the global header region to open the Settings and Actions menu, and select

Edit Pages.
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3. Click the infolet repository (gears) icon and select the check box next to the actionable infolet you want to make
available.

4. Click the Actions icon on the top right corner of the infolet, and select Edit Visibility.
5. Select one of the following:

◦ Yes: The actionable infolet is available for selection in the infolet repository.

◦ No: The actionable infolet isn't available for selection in the infolet repository.

◦ EL expression: The evaluation of the EL expression decides whether the actionable
infolet is available from the infolet repository. The predefined expression is
#{securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB,ORA_ZBS_SALES_MANAGER_JOB,ORA_ZBS_SALES_VP_JOB,ORA_MKL_SALES_LEAD_QUALIFIER_JOB']}

6. Edit the EL expression to suit your requirements.
7. Click Save and Close when you have finished making the changes.
8. Verify your changes and publish the sandbox.

Modify Actionable Infolet Attributes
You can select and replace any of the predefined attributes that are displayed on the actionable infolets with alternate
available attributes of your choice.

Note:  If you want to hide one of the predefined attributes, enter a blank value, in which case nothing is displayed in
the corresponding drop-down list position you select.

This table shows the attributes that you can modify and represents the order as they appear on the UI.

Actionable Infolet Attributes

My Tasks
 

• Subject

• Activity Type

• Due Date

My Appointments
 

• Activity Time

• Subject

• Primary Address

My Accounts
 

• Name

• Primary Contact

• Primary Address

My Opportunities
 

• Sales Stage

• Name

• Close Date

• Amount

My Leads
 

• Rank

• Lead Name
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Here's how to modify the attributes of an actionable infolet:

1. Ensure that you're working in an active sandbox.
2. Navigate to the actionable infolet that you want to modify.
3. Click your user image or name in the global header region to open the Settings and Actions menu, and select

Edit Pages.
The Edit Pages window appears.

4. Select one of the following:
◦ Site to make your changes available to everyone.

◦ Job Role to target a specific job role you select from the list.
5. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the

Actions menu.
The My Opportunities actionable infolet screen is displayed with the predefined fields selected.

6. From the Layout tab, select the attributes that you want to edit from the respective drop-down lists.
7. Set and adjust the two-column table widths in percentage terms by sliding your mouse along the Column Width

ruler.
8. Make the changes that you want to the attribute and select another attribute to edit, if required.
9. In the Drill Down Field, select the item that you want to use for drilling down to the detail page of the

opportunity object.
Tip:  If dynamic choice list fields are added to actionable infolets, then the drill-down capability is
automatically enabled.

This table shows the field names and associated attribute names that you can select for drill-down for each of
the actionable infolets:

Actionable Infolet Drill Down Field Attribute

My Opportunities
 

Name
 

Amount
 
Close Date
 
Sales Stage
 

My Leads
 

Lead Name
 

Rank
 

My Accounts
 

Name
 

Primary Contact
 
Primary Address
 

My Appointments
 

Subject
 

Primary Contact Address
 

My Tasks
 

Subject
 
Primary Contact

Type
 
Due Date
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Actionable Infolet Drill Down Field Attribute

  

10. Click Save and Close when you have finished making the changes.
11. Verify your changes and publish the sandbox.

Modify Record Counts
You can also change the predefined number of records to display on the infolet. By default, 10 records display. You can
change the default to 10, 20, 25, or 30, as required.

Here's how to modify record counts for an actionable infolet:

1. Ensure that you're working in an active sandbox.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the

Actions menu.
The My Opportunities actionable infolet screen is displayed.

3. From the Record Count tab, select the number of records that you want to display on the infolet from the drop-
down list.

4. Click Save and Close.
5. Verify your changes and publish the sandbox.

Modify Filters
Filtering reduces the number of searches required to view any outstanding items that might require attention. For
example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.

You can show or hide filters, rearrange filters, and add custom filters. You can multiselect and double-click filters in the
Available list to move them to the Selected list. You must select at least one filter for the actionable infolet filter list.

You can include saved searches created in Workspace as filters to quickly access relevant records by selecting the
Include Workspace Saved Searches check box. It's deselected by default but when selected, all the Workspace saved
searches associated with the specified object appear as filters for your actionable infolet. For more information, see the
related topic Switch Actionable Infolets to Use Workspace Saved Searches as Filters available from the Getting Started
with Your Sales Implementation on Oracle Help Center.

To access a different set of data, create a new saved search in Workspace and then expose the relevant saved search in
the Actionable Infolets UI. Selecting available Workspace saved-search filters allows for a more dynamic, effective, and
targeted view of the records that salespeople want to update and take immediate action on.

Note:  Predefined saved searches are available for selection. However, any custom saved searches that you create
must include Record Set values selected for either any records that you own or for records where you're on the team.
In addition, when saving your saved search, you must select the Run Automatically check box to run the search
automatically when your saved search is loaded. Otherwise, the custom saved search won't display in the available
filters list in the Configure UI for your actionable infolet.

This table shows the filters that you can modify.

Actionable Infolet Filter Filter Description

My Tasks • Today's Tasks • Display all my tasks scheduled for today
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Actionable Infolet Filter Filter Description

 • Tomorrow's Tasks

• Overdue Tasks

• Beyond Tomorrow's Tasks

• All Tasks

• Open Tasks

• High Priority Open Tasks

• Display all my tasks scheduled for
tomorrow

• Display all my tasks that are now overdue

• Display all my tasks that are scheduled for
the day after next and beyond

• Display all my assigned tasks

• Display all my assigned tasks that are
currently open

• Display all my high priority tasks that are
currently open

My Appointments
 

• Today's Appointments

• Tomorrow's Appointments

• Display all my appointments scheduled for
today

• Display all my appointments scheduled for
tomorrow

My Accounts
 

• My Accounts

• My Favorite Accounts

• My Team Accounts

• Display only the accounts that I own

• Display my accounts that I've marked as
favorites

• Display all the accounts that I can view

My Opportunities
 

• Closing in Next 7 Days

• Closing This Month

• Closing This Quarter

• Closing Next Quarter

• Open opportunities where I am on the
team

• My Open Opportunities

• Display my open opportunities that are
due to close in the next 7 days

• Display my open opportunities that are
due to close this month

• Display my open opportunities that are
due to close within the current quarter

• Display my open opportunities that are
due to close within the next quarter

• Display my open opportunities where I'm
on the team

• Display only those open opportunities that
I own

My Leads
 

• Unaccepted Leads

• My Open Leads

• Recent Open Leads

• Open Leads where I am on the team

• Display a list of all unaccepted leads that
are assigned to me

• Display only those open leads that I own

• Display a list of my leads that have
recently been opened

• Display a list of open leads where I'm on
the team

Here's how to modify the filters of an actionable infolet:

1. Ensure that you're working in an active sandbox.
2. Navigate to the actionable infolet that you want to modify.

71



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 7
Common Components

3. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the
Actions menu.

The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
4. From the Filters tab, select the filters that you want to modify.
5. Click Save and Close when you have finished making the changes.
6. Verify your changes and publish the sandbox.

Modify Quick Actions
You can navigate to the relevant areas in your sales process where you can perform quick actions at the record level. For
example, you can easily complete or defer tasks without having to drill down to view the record, or you can accept or
reject new leads at the click of a button.

You can show or hide actions, rearrange actions, and add custom quick actions. You can multiselect and double-click
any quick actions in the Available list to move them to the Selected list. However, you must select at least one action for
the actionable infolet quick actions list.

This table shows the quick actions that you can modify and represents the order as they appear on the UI.

Actionable Infolet Quick Actions

My Tasks
 

• Mark as Complete

• Defer by 1 Day

• Defer by 2 Days

• Defer by 1 Week

• Create Note

My Appointments
 

• Create Note

• Create Call Report

My Accounts
 

• Create Lead

• Create Opportunity

• Create Appointment

• Create Task

• Create Note

• Create Call Report

• Log a Call

• Create Service Request

My Opportunities
 

• Create Task

• Create Appointment

• Create Note

My Leads
 

• Accept

• Reject
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Here's how to modify the quick actions of an actionable infolet:

1. Ensure that you're working in an active sandbox.
2. Navigate to the actionable infolet that you want to modify and make sure that the infolet displays in expanded

view.
3. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the

Actions menu.

The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
4. From the Quick Actions tab, select the quick actions that you want to modify.
5. Click Save and Close when you have finished making the changes.
6. Verify your changes and publish the sandbox.

Related Topics
• Personalize Your Key Infolets

• Quick Way to Get Key Sales Information and Take Action

Example of Creating Actionable Infolet Custom Actions  
You can create custom smart action for actionable infolets to update sales information but the actions can't open pages
or navigate to them.

For example, you can create a smart action to update the stage of an opportunity or postpone the opportunity close
date by one day, but you can't have the action open the edit opportunity page.

Here's how to create a custom smart action to postpone an opportunity close date by one day for My Opportunities
actionable infolet.

Note:  While you can create the action directly, this example has you create a server script first. That's because the
server script includes the Expression Palette to help you write and validate your EL Expression script.

1. Create and enter a sandbox with Application Composer and Page Composer as your tools.
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2. Create the Groovy script as an object function server script in Application Composer:

a. In Application Composer, open the object node in the left portion of the page, Standard Objects >
Opportunity in this example.

b. Click Server Scripts.
c. In the Server Scripts page, click Object Functions.
d. Enter a function name, no spaces permitted. For example: Defer_1_Day.
e. Enter the EL Expression script in the Edit Script box. You can use the Expression Palette to find the

technical names of fields and insert elements of your script. Here's how to find the technical name for the
opportunity Close Date field:

i. Click Show/Hide Expression Palette (the function icon highlighted in the screenshot).

ii. Click Fields.
iii. Select the object, Opportunity in this example, and scroll down.

iv. In Opportunity: Fields section, search for the technical field name by the display label: Close Date.

The technical name displays in the API Name column.
v. You can insert the technical name into your script by clicking Edit Script > Insert.
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To learn more about how to best use the features available in the expression builder when writing scripts,
see "Groovy Tips and Techniques" in the Groovy Scripting Reference guide.

3. When your script is complete, click Validate.

Here's an example of the script to postpone the due date by one day:
setAttribute("EffectiveDate",EffectiveDate + 1);

4. When your script validates without errors, click Save and Close.
5. In the object list in the left side of the Application Composer page, click Actions and Links.
6. In the Opportunity: Actions and Links page, click Create.
7. In the Create Action or Link page, Display Label field, enter the action name that users see in the infolet actions

list.
8. Select the After the Script: Save the record and return to the previous page option.
9. In the Script section, click Method Name and select the script name from the list.

10. Click Save.
11. While still in the sandbox, click Home to get back to the Welcome page.
12. From the sandbox Tools menu, select Page Composer. The Page Composer toolbar displays underneath the

sandbox toolbar.
13. Scroll down to the My Opportunities infolet.
14. Make sure you're in the Expanded View. This is the view of the infolet showing the different filters.
15. Click Actions (the triangular icon at the top right corner of the infolet) and select Configure.
16. Move the action you created, Defer 1 Day, to the Selected column.
17. Click Save and Close.
18. In the Page Composer toolbar, click Close to save your work.

The Page Composer toolbar disappears.
19. To see the new action you created, the infolet must display at least one opportunity. A setup user generally

can't access opportunities, so you must publish the sandbox without testing. From the sandbox Action menu,
select Publish.

20. After publishing is complete, sign out and sign in again as a salesperson or another user who owns an
opportunity.

21. With at least one opportunity displayed in the My Opportunities infolet, you can view the new action in the list.

Why are some fields missing when I include saved searches as my
filter?  
You must enable any missing fields in the saved searches to use those fields as filters in your actionable infolets.

Occasionally, some fields are exposed on an actionable infolet but if you select the Include Workspace Saved Searches
as your filter, the same fields may not be available in the applicable Workspace saved searches. For example, you can
edit the Workspace My Appointments filter to enable fields that are exposed in the Layout tab of the actionable infolet.
See the topic, Make a Field Searchable in the UI, in this guide, for more information.
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Application Toolkit  

Overview of Oracle Application Toolkit  
Oracle Application Toolkit is a foundation application that provides some features, including including the Oracle
Business Intelligence Reports and Analytics pane and the Watchlist in the global header.

In the Setup and Maintenance work area, you access the Define Application Toolkit Configuration task list to set up
these components.

Related Topics
• Overview of Common Implementation

Attachments  

Attachments  
You can use attachments to provide supplementary information to specific business objects. Attachments can be URLs,
desktop files, text, or repository folders.

For a business object you may view, create, delete, or edit attachments, depending on your role and granted privileges.

Repository
Attachments are stored in a content management repository provided by Oracle WebCenter Content Server. Users
managing attachments can't interact with the repository unless the repository mode is enabled. When enabled, users
can share attachments among objects, update attachments, and perform other tasks. Access to the attachment files is
controlled by a digital signing mechanism.

All attachments are scanned for viruses before they're stored on the content management repository. If a virus is
detected at the time of upload, the attachment request fails and the user is notified about it.

Security
Data security applicable to a specific business object also applies to its attachments For example, if a user has no access
to a specific expense report, then that user can't access its attachments. You can also use attachment categories to
control access and actions on attachments, based on roles associated with that category.

Related Topics
• Attachment Entities

• What's an attachment category?
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What's the size limit for attachment files in the sales applications?  
Users can attach files, such as PDFs and Word docs, to both standard and custom objects. By default, the file size limit
for an individual, attached file is 2G. You can decrease this limit, but you can't increase it.

There are no limits placed on the number of files. The size of the files is controlled centrally by the File Upload Maximum
Size (FND_FILE_UPLOAD_MAX_SIZE) profile option.

Also note:

• The only limit on the total file size that can be uploaded is the amount of available space that you have
purchased for the content server.

• There are no restrictions on the type of files you can attach.

Attachments Troubleshooting  
Attachments UIs are very user-friendly and easy to work with. You may encounter issues in certain cases such as you
modify the attachments, for example create additional attachment categories, or implement data security on them.

Issue: Can't View, Add, Update, or Delete Attachments
You may encounter the following issues when trying to view attachments or perform actions such as adding
attachments.

• You can no longer see specific attachments that were earlier visible.

• You can no longer update or delete attachments.

• You get an error stating that you don't have permission to add attachments.

Resolution
Use the Manage Attachment Entities page to ensure that attachment categories are associated to the relevant
attachment entity. You might need to check with your system administrator or help desk to determine the exact entity
used on the page with the expenses attachments or what categories to assign.

If data security is implemented on the categories for the attachment entity, verify that the Enable Security check box
is selected in the Manage Attachment Entities page for that entity. Also, make sure that users have a role that has the
necessary privileges. The following table lists the privileges required to view, add, update, or delete attachments with a
specific attachment category.

Action Privilege

View
 

Read Application Attachment (FND_READ_APPLICATION_ATTACHMENT_DATA)
 

Add or Update
 

Update Application Attachment (FND_UPDATE_APPLICATION_ATTACHMENT_DATA)
 

Delete
 

Delete Application Attachment (FND_DELETE_APPLICATION_ATTACHMENT_DATA)
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For example, if users have the Read Application Attachment privilege for all categories associated with the expense
report attachment entity, except the Receipts attachment category, then they can view all expense report attachments
except those created with the Receipts category. Likewise, if users don't have the Update Application Attachment
privilege for any attachment categories tied to the expense report attachment entity, then they can't create any
attachments for the expense reports.

Certain attachments UI have predefined restrictions for users on categories. Your developers can also introduce
additional filters to determine which document categories are available for a specific page. Check with your developers
or help desk.

Issue: Missing Attachment Category
You can view existing attachments but the attachments no longer have an attachment category associated with them.

Resolution
When the attachment was added, at least one category existed for the corresponding attachment entity. Since then, the
entity was edited so that it no longer has any assigned categories, so the user can't see the category associated with
that attachment.

Use the Manage Attachment Entities page to reassign attachment categories to the relevant attachment entity. For
example, if users can no longer see the Receipts attachment category for an attachment to an expense report, then
search for the expense report attachment entity and assign to it the Receipts category. You may need to check with your
system administrator or help desk to determine the exact entity used on the page with the expenses attachments or any
additional categories to assign.

Certain attachments UI have predefined restrictions for users on categories. Your developers can also introduce
additional filters to determine which document categories are available for a specific page. Check with your developers
or help desk.

Related Topics
• Attachment Entities

• How Attachment Entities and Attachment Categories Work Together

• What's an attachment category?

Calendar  

Create the Accounting Calendar  
You usually create a single accounting calendar as part of your implementation. The accounting calendar defines the
time periods used in the applications. When you create the calendar, you specify the exact dates for each period.

These defined periods, often called enterprise periods, are used for many purposes in the applications. Examples
include:

• Reports that provide amounts by enterprise period, such as a sales pipeline analysis

• Metrics calculations by period for territory analysis

• The ability to adjust forecast amounts by time period
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• Distribution of quota amounts by time period

Note:  If you used the Sales Assistant topics in the Implementing Sales guide to create your accounting calendar, then
you don't need to do the steps listed here. For more information, see What Setup Assistant Completes for You.

Here are the high-level steps:

1. Plan your calendar periods and start year. See the Implementation Considerations section in this topic for more
information.

2. Create the first-year calendar periods and generate the periods for each additional year. See the Create the
Calendar section in this topic for more information.

3. Set the accounting calendar profile option. See the Set the Calendar Profile Option section in this topic for more
information.

4. Run a scheduled process. See the Run the Time Dimension Process section in this topic for more information.

CAUTION:  After your calendar is being used in transaction, you can't change the calendar options. For example, after
you have generated forecasts, you can't change the calendar options.

Implementation Considerations
Since you can't change the calendar after it's in use, ahead of time, you need to:

• Plan which periods your calendar will use.

• Decide which year you want the calendar to start. consider setting the date to the first date that your company
was created. Then you can upload historical data later, if necessary.

Period frequency is an important decision for your calendar, because the period frequency set in your fiscal calendar is
the shortest period you can use. Here are some examples:

• Let's say you set the period frequency to yearly. Then, your reports and activities can be for each year, but can't
be broken down by month.

• If you set the period frequency to monthly, then you can break down activities and reports by month and
summarize by quarter and year.

• Say you want to set the period frequency to weekly. In this case, then you can perform activities and reports by
week, quarter, and year, but not by month because the number of weeks per month varies.

Create the Calendar
When you create the accounting calendar, you're establishing the exact start and end dates for each period, for each
year. Here's a procedure that uses the fictitious Vision Corporation to guide you through the steps:

1. In Setup and Maintenance, go to the following:.

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Accounting Calendars

2. On the Manage Accounting Calendars page, click Create.
3. In the Create Accounting Calendar: Calendar Options page:

a. Name your calendar, for example, Sales Calendar.
b. Leave the Adjusting Period Frequency set to None.
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c. For Start Date, Vision Corporation uses 1/1/10.
d. For Period Frequency, select the shortest time period you want to use for reports and activities. Vision

Corporation is using Monthly. The period starts on the first of the month and ends on the last day of the
month, regardless of the number of days or weeks in each month.

e. Vision Corporation selects None for the Separator.
f. Select the Format to use for period names.

4. Click Next. The Create Accounting Calendar: Period Details page appears, showing the generated periods. The
image shows multiple columns, including:

◦ Period name, which is month name, one for each month of the year

◦ Year, which is 2010

◦ Period number, one for each month

◦ Quarter number for each period, assuming four quarters in the year

◦ Start and end dates for the periods

◦ A check box used to indicate whether a period is an adjusting period
Here's an example of the Create Accounting Calendar: Period Details page:

5. If you need to, manually change the details for each period.
6. Click Save and Close.
7. Now you need to generate the periods for each additional year, including the current, or coming year. Open the

calendar.
8. Click Add Year.
9. Click Save and Close.

10. Repeat the last three steps for each year you want to add.
11. Click Done.
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Note:  You can't change your calendar options after you start using the calendar, such as by generating forecasts.

Set the Calendar Profile Option
After you finish creating your calendar, set the accounting calendar profile option. This profile option setting tells the
applications which calendar to use. Use these steps:

1. In Setup and Maintenance, go to the following:.

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Calendar Profile Option

◦ Option: Manage Calendar Profile Option

2. Select the Accounting Calendar Default profile option.
3. In the Profile Values table, click New.
4. For Profile Value, select Site.
5. Click the Profile Value list, and select the name of the calendar you created.
6. Click Save and Close.

Run the Time Dimension Process
You need to run the Refresh Denormalized Time Dimension Table for BI process to make calendar time periods available
for analytics and reports. Use these steps:

1. Click Navigator > Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, click the menu next to the Name field and click Search.
4. In the Search dialog box, enter %Refresh%, and click Search.
5. Select the Refresh Denormalized Time Dimension Table for BI process in the results that are returned and

click OK.
6. Click Ok again, if needed.
7. In the Process Details window, click Submit.

Related Topics
• Accounting Calendar Options

Click to Edit  

About Click to Edit  
The click-to-edit feature lets salespeople edit records directly from landing pages of work areas. By simplifying data
entry, the click-to-edit feature improves usability and efficiency when working with business transactions.

Salespeople can change attributes for records directly in the landing pages without navigating to the edit pages. This
feature is enabled through the Click-to-Edit on Landing Page Enabled (ZBS_ENABLE_CLICK_TO_EDIT) profile option.
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This profile option isn't enabled by default. Administrators must set the profile option to enable the click-to-edit feature
on the landing pages for the following sales objects:

• Accounts

• Contacts

• Opportunities

• Leads

• Activities

• Assets

• Territories

The click-to-edit feature is also available for company-defined objects.

Related Topics
• Enable Click to Edit

Enable Click to Edit  
Administrators enable the click-to-edit feature by setting the Click-to-Edit on Landing Page Enabled
(ZBS_ENABLE_CLICK_TO_EDIT) profile option. This profile option isn't enabled by default.

The click-to-edit feature is available from the Accounts, Contacts, Opportunities, Leads, Activities, and Assets landing
pages. The feature is also supported for custom objects.

Use the following procedure to enable click-to-edit functionality on the landing pages of supported sales objects:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZBS_ENABLE_CLICK_TO_EDIT in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click on the profile option code link.
5. Set the profile option value as needed.
6. Click Save and Close.

Related Topics
• About Click to Edit
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Favorites  

How Users Mark Favorite Records  
Salespeople can mark records as favorites so that they can find them more easily. To mark a favorite record,
salespeople:

• Click the favorite icon in the edit page of a record.

• In Workspace, click the favorite icon for the record in the list page of an object.

Note:  You must enable the favorites functionality in Workspace. See the related topic, Enable the Favorite
Field for Quick Access to Records.

To view a list of all their favorites, salespeople can click the Favorites and Recent Items icon in the global header.

Currently, salespeople can mark favorites for:

• Accounts and contacts

• Assets

• Activities

• Campaigns

• Deal registrations

• Leads

• Opportunities

• Partners and partner contacts

• Territories

• Custom objects

Favorites are also available in CX Sales Mobile and in Sales for Microsoft 365.

Related Topics
• Enable the Favorite Field for Quick Access to Records

• Mark Favorite Records

Languages  

Language Packs on Your Application  
A language pack contains artifacts that are translated to a specific language. Translated artifacts include UI text,
predefined data, messages, BI catalog data, and so on.
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Here are the supported languages other than American English:

• Arabic

• Chinese (Simplified)

• Chinese (Traditional)

• Croatian

• Czech

• Danish

• Dutch

• Finnish

• French (Canadian)

• French (European)

• German

• Greek

• Hebrew

• Hungarian

• Italian

• Japanese

• Korean

• Norwegian

• Portuguese (Brazilian)

• Polish

• Romanian

• Russian

• Slovak

• Spanish

• Swedish

• Thai

• Turkish

• Ukrainian

How to Install Language Packs
To install language packs on all your environments, contact your help desk. For more information about language
packs, see Oracle Applications Cloud Service Definition - Language Packs (2073202.1) on My Oracle Support at https://
support.oracle.com. There's no limit to the number of language packs you can ask for in one service request. But you
must only install the language packs you need to conduct your day-to-day business because of these reasons:

• Once you request a language pack, the installation will be scheduled for all your environments, including
production, staging, and test environments, so that they're all in sync.
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• It takes time and resources to install language packs. So you might get extended outages during updates,
especially if you have four or more language packs installed in your environments.

• Once you install any language, you can't uninstall it later.

You can view all available languages, whether they're already installed or available for installation and translation. In the
Setup and Maintenance work area, use the Manage Languages task in the Application Extensions functional area. Each
dialect is treated as a separate language. Generally, you don't need to edit any of the fields on the Manage Languages
page, unless absolutely necessary.

Related Topics
• Update Existing Setup Data

How to Set the Preferred Language  
Here's how to set the preferred language in the sales applications:

1. Navigate to the Manage Administrator Profile Values task in Setup and Maintenance.
2. Search for the Profile Option Code FND_LANGUAGE.
3. Modify the profile value at the site or user level to the preferred language.
4. Save your changes.

Note:  Keep in mind that user preferences set in the Preferences screens (located under the user name in the global
header) override any site-level setting.

Lightbox Content Library  

Considerations When Setting Up Sales Lightbox  
Sales Lightbox is a content library that you can use to store, access, and share files, such as slide decks, web-based
content, images, and .pdfs. Lightbox lets users store, access, and share content with individuals, accounts, and
opportunities.

You can find more information about Lightbox end user tasks and capabilities in the Using Sales guide.

Supported File Types
Sales Lightbox supports the following file types:

• Microsoft Powerpoint (.pptx): If you install the Microsoft Office Compatibility Pack, and save a presentation in
the Open XML format (.pptx 2007), then those presentations are fully compatible with Sales Lightbox.

• Portable Document Format (.pdf): Standard .pdf files are supported.

• HTML: HTML in the form of microsites: See the topic, Use Microsites in the Lightbox Content Library, for more
information.

• .jpg and .png: Image files in the .jpg and .png formats are supported.
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For information about the actions that can be performed on different content types, see the topic, Available Actions for
Different Content Types.

Upload File Size
The maximum file size for a presentation to be uploaded is 100 MB.

Salespeople Access
Salespeople can access Sales Lightbox without any setups required. All of the default sales user roles (for example, Sales
Representative, Sales Manager, and Sales VP) can access the feature using the Sales > Lightbox menu. In addition, the
Sales Administrator user has all of the same permissions that sales users do. For additional details on sales user tasks
for Sales Lightbox, see the Using Sales guide.

Lightbox Administrator Access
In addition to the sales user permissions, the supplied Application Implementation Consultant (a type of setup user) and
Customer Relationship Management Application Administrator job roles have additional privileges to:

• Access the All Content view: This view lets the administrator see all content in the application, not just his own.
Sales users can't see this view.

• Delete content: Only the administrator can delete content not owned by him.

Related Topics
• Overview of Sales Lightbox

• Use Microsites in the Lightbox Content Library

• Available Actions for Different Content Types

Add Lightbox Presentation Feedback Subtab  
The Lightbox presentation feedback resource is used to view, create, update, and delete the ratings and comments from
the attendees at a Lightbox presentation session.

The feedback can apply to an individual, Lightbox document page, or to an overall Lightbox document presented during
a presentation session.

Here's how to add a feedback subtab.

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects then expand Lightbox Presentation Feedback.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts section, select Default Layout and click the Edit icon.
7. In the Subtabs Region, click the Hide Show icon.

The Configure Subtabs shuttle window opens.
8. Move Feedback from the Available Fields window to the Selected Fields window.
9. Click OK, then click Done to exit the layout editor.

10. Verify the changes by viewing the subtab when drilling into a document.
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11. Publish the sandbox according to your company's business practices.

Mass Update of Records  

Enable Mass Update of Records  
Salespeople can use the mass update feature to update fields on multiple records at once.

For example, a salesperson can update the sales stage on multiple opportunities at the same time with just a few clicks.
Or, a salesperson can update rank and deal size on several leads at once.

Here's the setup flow:

1. Add the Update action to the landing pages of the work areas where you want to enable the feature. Landing
pages are the only pages that support the mass update feature.

2. Optionally, configure which fields salespeople can update. You can use the default fields already set if you want.
Or you can configure the list yourself.

3. Optionally, set profile options to specify how many records salespeople can update at once. You can use the
default value of 25 records if you want.

Supported Objects for Mass Update
These are the predefined, standard business objects that support mass update:

• Activities

• Accounts

• Assets

• Contacts

• Sales Leads

• Opportunities

Custom objects also support mass update.

Add the Update Action
Salespeople access the mass update feature using the Update action that you enable in the work area landing pages.
The action appears as Actions > Update on the landing page toolbar.

Remember, make all Application Composer changes in a sandbox and publish the sandbox according to your company's
processes.

These steps use the Opportunity object's landing page as an example. The basic steps are the same for all objects, but
the navigation can be different for different objects. See the Landing Page Names in Application Composer section in
this topic for the page names and navigation.

1. Navigate to Configuration > Application Composer.
2. Expand the Standard Objects tree and then expand the object you want to modify. For example, expand the

Opportunity object.
3. Within the object you're modifying, click the Pages node.
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4. Ensure that the Application Pages tab is selected.
5. In the Landing Page Layouts region (use the Activities region for the Activities object), select the Standard

layout, and then click the duplicate layout icon to duplicate and edit the resulting copy. Alternatively, you can
edit an existing, custom layout.

6. Now, edit the new layout. For example, to edit the Opportunities landing page, click the edit (pencil) icon on the
Fuse Opportunity Overview Table.

7. In edit mode for the landing page, navigate to the Configure Detail Form: Buttons and Actions region.
8. In the Available Actions window, double-click the Update action to move it to the Selected Actions window.
9. Click Save and Close, then Done.

10. Test the changes using the steps in the Test the Changes section later in this topic.

Set the Updatable Fields
Now that you have enabled the Update action, configure the fields salespeople can update using mass update. Each
object already has several fields enabled for the mass update feature. If you want, configure this list to include other
standard fields, or even custom fields. Keep in mind that if you're setting up the mass update feature for custom objects,
then you must configure the list of fields that can be updated by users -- it's not optional like with standard objects.

You configure the list of mass update fields using the same custom landing page layout where you manually displayed
the Update action:

1. In Application Composer, navigate to the Pages node for the object you're configuring.
2. Edit the same landing page layout where you manually displayed the Update action in the above procedure.
3. Navigate to the Configure Mass Update Fields region.
4. In the Available Fields box, double-click the fields that you want to make available for the mass update feature

at runtime. Or, use the arrows to move the items that you want to make available. See the Rules for Certain Field
Types below for some details on field types and limitations or behavior.

5. After you're done making changes, click Save and Close, then Done.

Rules for Certain Field Types

Consider these rules for certain field types as you set up the feature:

• You can use both standard and custom fields. However, read-only fields, such as formula fields, and fields that
can be conditionally updated, aren't included in the list.

• Some fixed-choice list fields are related in a parent-child relationship. This simply means that the values
displayed in the child field are dependent on whatever is selected in the parent field. If you want to make a child
fixed choice list field available for the mass update feature, then you must also include its parent field.

Configure the Number of Updatable Records
You can configure the maximum number of records that users can update at once by setting profile options.

Here's the behavior:

• The default value of the profile options is 25, meaning the maximum number of records that salespeople can
update at once for those objects is 25.

• The maximum number of records that can be updated at once is 500.

• If a profile option value has a null value, the application sets the number of records that can be updated at once
to 10.

• For custom objects, the threshold value is set at 25 and can't be changed using a profile option.
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Here are the mass update threshold profile options. The profile option codes are listed in parentheses.

Object Profile Option

Activity
 

Activity Mass Update Threshold Value (ZMM_MASS_UPDATE_THRESHOLD)
 

Account
 
Asset
 
Contact
 
Sales Lead
 
Opportunity
 
Custom objects
 

Mass Update Threshold Value (ZBS_MASS_UPDATE_THRESHOLD)
 

Set the Profile Options

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option name in the
Profile Display Name field. Or, enter the code in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click the profile option name link.
5. Set the profile option value as needed.
6. Save your changes.

Test the Changes
It's a good idea to test the changes. For example:

1. Sign in as a user who has access to the object you just modified, such as a sales representative or sales
manager.

2. Go to the landing page and click the Actions menu to verify that the Update action is available.
3. Go through the mass update flow with some records to be sure it's working as you expect. See the Related

Topics for the procedures.

Landing Page Names in Application Composer
As you modify the landing pages, it's helpful to know their names in Application Composer. Here are the pages, along
with the navigation steps to get to them:

Object in Application Composer Navigation to Landing Page Layout Name of the Landing Page You Need to Edit

Activity
 

Activity > Pages > Application Pages > Landing
Page Layouts > Activities region

My Activity Overview Table
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Object in Application Composer Navigation to Landing Page Layout Name of the Landing Page You Need to Edit

 

Account
 

Account > Pages > Application Pages > Landing
Page Layouts
 

FUSE Account View List Table
 

Asset
 

Asset > Pages > Application Pages > Landing
Page Layouts
 

Asset Overview Table
 

Contact
 

Contact > Pages > Application Pages > Landing
Page Layouts
 

Fuse Contact List Table
 

Sales Lead
 

Sales Lead > Pages > Application Pages >
Landing Page Layouts
 

Fuse Lead Overview Table
 

Opportunity
 

Opportunity > Pages > Application Pages >
Landing Page Layouts
 

Fuse Opportunity Overview Table
 

Related Topics
• Apply Mass Update of Fields to Leads

• Apply Mass Update to Accounts and Contacts

• How to Apply Mass Update to Opportunities

• Apply Mass Update to Activities

• Apply Mass Update to Assets

Configure Mass Update for Different User Roles  
You can show a different set of mass update fields to different users in the same work area, in cases where you want
users with different roles to be able update different fields.

You accomplish this by using separate custom page layouts for different user roles. If you want users with different job
roles to see a different set of fields in mass update, then create different custom landing page layouts for them. For each
landing page layout, you:

1. Manually display the Update action.
2. Configure a different set of mass update fields in each landing page layout that's intended for each role.
3. Assign a different role to each layout.

Here are the high-level steps add a role to a custom layout:

1. Follow the steps in the Enable Mass Update of Records topic to create the custom landing page layouts you
need.

2. Navigate to the landing page layouts table for the object in Application Composer.
3. Select your custom layout.
4. Click the Role Name arrow in the row.
5. In the Select: Roles window, select CRM - Job Roles in the Role Category Filter.
6. Click the Specific role radio button in the Role field.
7. Click the Show available predefined roles check box.
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8. Move the applicable role from the Available Roles shuttle region to the Selected Roles shuttle region.
9. Click OK.

10. Repeat for the other custom layouts you're using.
Example Use Case

Let's say that you don't want salespeople to be able to mass update the Sales Channel fields during mass update on a
partner opportunity. But you still want channel managers to be able to mass update those fields. So you remove the
Sales Channel field from the mass update list on your custom Sales Representative landing page layout. Then, add the
Sales Channel field to the mass update list on your custom Channel Manager landing page layout.

Messages  

Messages  
Messages provide users with information about business or application errors or warnings.

Typically, messages inform the users about the following:

• Missing or incorrect data

• Status of an application, page, or a business object

• Status of an ongoing process

• Result of a user action

Besides notifying users about the problem, messages provide guidance to users on taking corrective action. Messages
also warn users about the consequences of a certain action.

Oracle provides a set of predefined messages that are stored in a message dictionary. You can create additional
messages or modify the existing ones using the Manage Messages task in the Setup and Maintenance work area.

Note:  Don't delete predefined messages unless you're sure that they aren't used anywhere.

Message Dictionary
The message dictionary stores messages that the application requires at run time. Messages are predefined for specific
applications and modules, but a few are common messages that can be used in any application or module.

When you create messages, use the message text and the following components to cover additional details addressing
users and help desk personnel:

• User Details: A detailed explanation of the message short text meant for users.

• Administrator Details: Details of the identified problem meant for the help desk personnel. The end users don't
see this text.

• Cause: An end-user version of the cause of error.

• User Action: Instructions to users for addressing the identified problem. Where there is no guidance for end
users, they must approach the help desk.

• Administrator Action: Corrective action that help desk personnel must take to correct the problem. This
information isn't available to the end users.
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Related Topics
• Message Types

• Create and Edit Messages

Common Messages  
Message names that begin with FND_CMN are common messages. Each common message can appear in multiple
places in any product family across Oracle Applications Cloud.

For example, the FND_CMN_NEW_SRCH message can be used for any search to indicate that no results were found.
Common messages of type error or warning are part of the message dictionary.

Creating and Editing Common Messages
You can create common messages for use in multiple places. However, ensure that you follow the predefined naming
convention and numbering series associated with the application or module.

Note:  Don't use FND_CMN as the prefix for the messages you create because all the predefined common messages
begin with it.

Common messages can be used in any application. Therefore, consider the ramifications if you edit any aspect of the
message, including incident and logging settings. Changes would be reflected in all instances where the message is
used. For example, if you change the message text, ensure that the text is generic and applies to the entire site of Oracle
Applications Cloud implementation.

Notes  

Define Notes  
A note is a record attached to a business object, such as an opportunity or lead. Notes capture nonstandard information
received as you do business. Consider the following points when you set up notes for your application:

• Which new note types you want to add.

• How you want to map these new note types to business objects in your area.

Note Types
Note types are assigned to notes when they're created, to categorize them for future reference. During setup you
can add new note types, and use a process called note type mapping to restrict them by business object type. When
deciding which new note types you want to add, keep in mind how you want your users to search for, filter, and report
on these notes.
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Note Type Mappings
If you add new note types, you must map them to the business objects you use in your product area. Here are some
points to consider when mapping note types:

• When you select a business object other than Default Note Types, you only see the note types that apply to that
object.

• If no other note types appear, then note type mapping doesn't exist for that object and the default note types
are used. Select Default Note Types to see which default note types exist in the application.

• If you modify a default note type, it affects all the business objects that don't have a note type mapping.

Suppose you decide to add a new note type of Analysis for your product area of Sales-Opportunity Management. You
use note type mapping to map Analysis to the Opportunity business object. Now, every time you create or edit a note
for an opportunity, you see Analysis as an available note type option.

When deciding which note types to map to business objects, you should keep the same considerations in mind that you
did when you decided which note types to include.

Notes Character Limit
If you're using the source code editing mode, the limit for notes is 100,000 characters. If you're using the Rich Text
editing mode, HTML tags can cause the actual maximum character count to vary, as the HTML tags are also counted in
the character total.

Related Topics
• About Application Composer

Preferences  

Set Value Formats for Regional Preferences for All Users  
Use profile options to set the default formats of values for regional preferences, such as date, time, number, currency,
and time zone for all users.

You can set the values of specific profile options at the site layer using the Manage Administrator Profile Values page.
The formats you set here are displayed for all users in the fields for regional settings on the General Preferences:
Regional page. Your users can still set the value formats for themselves using the settings in the General Preferences:
Regional page. Once you set the value formats for all users, if specific users don't change their value formats, the
choices you have set for all users will apply to them.

To set value formats for profile options, do these steps:

1. Click Navigator >  My Enterprise >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task in the

Application Extensions functional area.
3. Set the value formats for the profile options, as required:

Note:  Check if the profile option already has a value set for the Site profile level. If so, just edit that value.
Otherwise, create a new row and select a value for the Site profile level so that your settings apply to all users.
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◦ To set the date format:

i. Search for the Default Date Format (FND_DATE_FORMAT) profile option.
ii. In the FND_DATE_FORMAT: Profile Values section, click the New icon.

iii. From the Profile Level list, select Site.
iv. From the Profile Value list, select the required date format. For example, 31-1-1999.

◦ To set the time format:

i. Search for the Default Time Format (FND_TIME_FORMAT) profile option.
ii. In the FND_TIME_FORMAT: Profile Values section, click the New icon.

iii. From the Profile Level list, select Site.
iv. From the Profile Value list, select the required time format. For example, 1:30 PM.

◦ To set the number format:

i. Search for the Default Number Format (FND_NUMBER_FORMAT) profile option.
ii. In the FND_NUMBER_FORMAT: Profile Values section, click the New icon.

iii. From the Profile Level list, select Site.
iv. From the Profile Value list, select the required time format. For example, -1,234.567.

◦ To set the default currency:

i. Search for the Default Currency (FND_CURRENCY) profile option.
ii. In the FND_CURRENCY: Profile Values section, click the New icon.

iii. From the Profile Level list, select Site.
iv. From the Profile Value list, select the required currency. For example, US Dollar.

◦ To set the default time zone:

i. Search for the Default User Time Zone (FND_TIMEZONE) profile option.
ii. In the FND_TIMEZONE: Profile Values section, click the New icon.

iii. From the Profile Level list, select Site.
iv. From the Profile Value list, select the required time zone. For example, US Pacific Time.

4. Click Save and Close.

Related Topics
• Set General Preferences for All Users

• Update Existing Setup Data

Set General Preferences for All Users  
Use the Global Admin Preferences page to set general preferences, such as language, currency, and time zone for all
users.

Use the Set User General Preferences task only if you want to update preferences for all users. Your users can still set
preferences for themselves using the settings in the General Preferences section on the Preferences page. Once you
set the general preferences for all users, if specific users don't change their preferences, the choices you have set for all
users will apply to them. You can also set the default value formats for date, time, and number in regional preferences
for all users.
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To set general preferences, do these steps:

1. Click Navigator >  My Enterprise >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to the Set User General Preferences task in the Application

Extensions functional area.
3. Set the required general preferences for your users.

Note:  You can also set the value formats for regional preferences, such as date, time, and number for your
users using profile options.

4. If you only want to set the preferences for new users whose preferences haven't been set by them yet, select the
Reset preferences for new users only check box. Selecting this option excludes all users whose preferences
were set at some point in time.

5. Click Save.

Related Topics
• Set Value Formats for Regional Preferences for All Users

• Set Your General Preferences

Privacy Statement  

Set Privacy Statement URL  
A privacy statement is legal content that tells you how a company collects and manages user data. You can add a link to
your company's statement in the About This Application dialog box.

1. In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values
task in the Application Extensions functional area.

2. Search for the Privacy Statement URL (PRIVACY_PAGE) profile option.
3. In the Profile Values section, update the Profile Value field with the full URL of the web page that has the

privacy content. By default, this profile value is N.

CAUTION:  Don't enter any other value, such as Y, because that causes a broken link.

4. Click Save and Close.
And that's it! Your users can now view the Privacy Statement link by clicking their user image or name in the global
header and selecting About This Application.

Public Unique IDs  

Overview of Public Unique IDs  
When users create records in the database, the applications use document sequencing as they generate unique IDs for
each business object record. These IDs are known as public unique IDs, or PUIDs. Understandably, these numbers aren't
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easy to read or use because of their length and complexity. To overcome the issue of long IDs, you can make these IDs
more user-friendly and readable during setup.

These PUID are used in:

• The data model

• Unique sequence generation when you use advanced setup

• Global search by PUID attributes

When you integrate your sales application and other, external applications, the sales application can "call" the
PUIDs from those other applications. Which application is calling depends on whether an application in the external
application is calling the sales application, or whether a person is using their PUIDs.

You specify PUIDs when you create objects. For example, Party_Number is the PUID for accounts and contacts. When a
new account is created, the PUID value can be automatically created by a central routine or supplied by the end user.

In this documentation, we talk about "advanced setup" for PUIDs. This means you set up the unique sequence
generation of PUIDs that's a specific prefix and radix configuration. You set these for each business object. In addition,
keep in mind that PUID specifications mandate that users can search for all supported business objects by PUID and
Party Number.

Many of the business objects support PUIDs, as shown in this table:

Top-Level Object Name Model Support (PUID
Attribute Name)

Object PUID Generation Global Search By PUID PUID Exposed in List
Management

Account
 

PartyNumber (RegistryID)
 

Supported
 

Supported
 

Supported
 

Action
 

ActionNumber
 

Supported
 

NA
 

NA
 

Action Plan
 

ActionPlanNumber
 

Supported
 

NA
 

NA
 

Activity
 

Activity_Number
 

Supported
 

Supported
 

Supported
 

Asset
 

AssetNumber
 

Supported
 

Supported
 

Supported
 

Business Plans
 

BusinessPlanNumber
 

Supported
 

Supported
 

Supported
 

Campaign
 

CampaignNumber
 

Supported
 

Supported
 

Supported
 

Competitor (called Sales
Competitor in Application
Composer)
 

PartyNumber
 

Supported
 

Supported
 

Supported
 

Contact
 

PartyNumber (RegistryID)
 

Supported
 

Supported
 

Supported
 

Custom Objects
 

Custom Attribute
 

Supported
 

Supported
 

Supported
 

Deal Registration
 

Deal Number
 

Supported
 

Supported
 

Supported
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Top-Level Object Name Model Support (PUID
Attribute Name)

Object PUID Generation Global Search By PUID PUID Exposed in List
Management

Interaction
 

InteractionNumber
 

Supported
 

Supported
 

Supported
 

Lead (called Sales Lead in
Application Composer)
 

Lead_Number
 

Supported
 

Supported
 

Supported
 

MDF Budget, MDF Claim,
 MDF Claim Settlement,
MDF Request
 

MDF Claim: Code
(ClaimCode)
 
MDF Request: Code
(FundRequestCode)
 
MDF Budget: Code
(BudgetCode)
 
MDF Claim
Settlement: Code
(ClaimSettlementCode)
 

Supported
 

Supported
 

Supported
 

Objective
 

ObjectiveNumber
 

Supported
 

NA
 

NA
 

Opportunity
 

Opty_Number
 

Supported
 

Supported
 

Supported
 

Partner
 

Company_Number
 

Supported
 

Supported
 

Supported
 

Quote (called Sales Orders
in Application Composer)
 

OrderHeaderNumber
 

Supported
 

Supported
 

Supported
 

Price Book
 

PriceBook_Code
 

Supported
 

Supported
 

Supported
 

Product
 

ItemNumber
 

Supported
 

Supported
 

Supported
 

Product Group
 

Reference_Number
 

Supported
 

Supported
 

NA
 

Program Enrollment
 

Enrollment Number
 

Supported
 

NA
 

Supported
 

Promotion
 

Sales Promotion Code
 

Supported
 

NA
 

Supported
 

Resource
 

Party Number
 

Supported
 

Supported
 

Supported
 

Service Request
 

SRNumber
 

Supported
 

Supported
 

Supported
 

Template Action Plan
 

TemplateNumber
 

Supported
 

NA
 

NA
 

Territory (called Sales
Territory in Application
Composer)

Supported (Unique
Territory Number)
 

Supported
 

NA
 

Supported
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Top-Level Object Name Model Support (PUID
Attribute Name)

Object PUID Generation Global Search By PUID PUID Exposed in List
Management

 

Territory Proposal (called
Sales Territory Proposal in
Application Composer)
 

Supported (Proposal
Number)
 

Supported
 

NA
 

Supported
 

Work Order
 

WO_NUMBER
 

Supported
 

Supported
 

Supported
 

Your Setup Options
You have these options for setup:

• Use the default setup, where no implementation steps are required.

• Use the basic setup, which is configurable to a certain degree. If you use this setup, the default setup isn't used.

• Use an advanced setup which is more complex and configurable. The default and basic setups apply to all
objects. Advanced setup is on a per-object basis.

Here's a list of setup options and where to find more information about the setup.

Setup Option Description Where to Find More Information

Default Setup
 

In this setup, no implementation steps are
required. The application automatically
generates a unique 15-digit numeric ID for each
record. The document sequencing begins with
a 1.
 

No additional documentation, other than this
introduction
 

Basic Setup
 

In this setup, you set two profile options where
you configure the radix (or base numbers and
characters) and prefix to use. The application
generates an alphanumeric public unique ID
instead of the default numeric public unique ID
for each record.
 

See the Public Unique ID Basic Setup section in
this topic
 

Advanced Setup
 

In this setup, you define a radix and prefix for
each object. It isn't required for the radix and
prefix to be different for each object.
 

See the Public Unique ID Advanced Setup
section in this topic
 

Public Unique ID Basic Setup
In the basic setup, you define a single prefix that's shared across all business objects in the implementation. In addition,
you have several different radix values that can be used. Together these values form the PUIDs.

To perform the basic setup, you set these profile options:

• CRM Public Unique ID String Encoding profile option: Controls the characters used in the encoding of the public
unique ID based on a radix, or base number.
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• CRM Public Unique ID Prefix profile option (ZCA_PUID_PREFIX): Defines the optional prefix value for the public
unique ID. If you use this profile option, define the prefix for the public unique ID at the site level. After you set
this profile option to the prefix you want, the application inserts the prefix before the public unique ID base
encoded document sequence value. For example, you may want the records for the pharmaceutical divisions of
your company to be denoted with public unique IDs and the prefix Pharma or Pharma1, Pharma2, and so on. By
default, the prefix has no value.

• CRM Public Unique ID String Encoding profile option (ZCA_PUID_RADIX): This profile option determines the set
of numbers and letters used in creating the public unique ID. The default value is null. After you set the radix,
the application converts the public unique ID into user-friendly IDs, using alphanumeric characters instead of
numeric digits.

These base values are available when constructing the PUIDs:

• Numbers 0-9, letters A-F

• Letters A-Z, upper case

• Numbers 2-9, letters BCDFGHJKLMNPQRSTVWXYZ

• Numbers 0-9, letters ABCDEFGHJKLMNPQRTUWXY

• Numbers 0-9, letters A-Z, upper case

• Numbers 0-9, letters A-Z, letters a-z

• No alphanumeric conversion

The values for the radix are stored in the lookup type, ZCA_PUID_ENCODING. This lookup type is accessible using the
Manage Standard Lookups task in Setup and Maintenance.

Keep these points in mind:

• If you enter a prefix value, then you must set a radix value. The length of a prefix value is 5. You can't use the
prefix setting by itself.

• If you require a delimiter, then include it as part of the prefix.

• The concatenated public unique ID and prefix must not exceed the defined field length, which is usually 30
characters.

Here's how to set the profile options.

1. Sign in as a setup user.
2. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Public Unique Identifier Profile Options

3. On the Manage Public Unique Identifier Profile Options page, click the ZCA_PUID_RADIX option.
4. In the ZCA_PUID_RADIX: Profile Values section of the page, click the Profile Option Values list of values and

select the base numbering value.
5. Click Save and Close.
6. Optionally, click the ZCA_PUID_PREFIX option.
7. In the ZCA_PUID_PREFIX: Profile Values section of the page, in the Profile Value box, enter the prefix and the

delimiter you want, if any. For example, enter CDRM_.
8. Click Save and Close.
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Public Unique ID Advanced Setup
In the advanced setup, you can define a different prefix and numbering radix for each business object, for example,
Accounts, Contacts, and Opportunities. Oracle recommends that you do this to avoid PUID clashes when populating
object records via import while also creating records in the UI or via REST.

Keep these points in mind:

• If you enter a prefix value, you must set a radix value. You can't use the prefix setting by itself. The length of a
prefix value is 5.

• If you require a delimiter, then include it as part of the prefix.

• The concatenated public unique ID and prefix must not exceed the defined field length, which is usually 30
characters.

Use these steps to configure the radix and optionally, the prefix in the advanced setup.

1. Sign in as a setup user.
2. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Public Unique Identifier Sequence Generation

3. On the Manage Public Unique Identifier Sequence Generation page, if you're configuring these values for the
first time, add a row to the table.

4. In the Object list of values, select the object for which you're configuring the public unique ID.
5. In the Radix list of values, select the base numbering to use. This list of possible radix values is the same list of

values that are provided in the ZCA_PUID_RADIX profile option.
6. In the Prefix box, enter the prefix you want to use for the object and unique ID.

◦ Enter a maximum of five characters.

◦ The allowed characters are: 0-9, A-Z, a-z, and these special characters: period, hyphen, comma, and
underscore.

7. Repeat for other objects.
8. Click Save and Close.

This table lists options for RADIX in the Manage Public Unique Identifier Sequence Generation task. For example, the
sequence looks as follows if a Lead Number is in the format of "LeadNumber":

• "CDRM_2452" if the advanced setup for the Lead object isn't set up.

• If the advanced setup for the Lead object is set up, then the LeadNumber is created in the form of
"LeadNumber" = "LEAD_106065",

• PREFIX is LEAD_ and RADIX is "106065", which is in the format of "No Alphanumeric Conversion".

• RADIX is in the format of "Letters A-Z, Upper Case". "LeadNumber": "LEAD_GAXM".

Prefix Radix

NULL
 

NULL
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Prefix Radix

NULL
 

Numbers 0-9, letters A-F
 

NULL
 

Numbers 0-9, letters A-F
 

A-
 

Numbers 0-9, letters A-F
 

A-
 

Numbers 0-9, letters A-F
 

Null
 

No alphanumeric conversion
 

A-
 

Numbers 0-9, letters A-Z, letters a-z
 

A-
 

Numbers 0-9, letters A-Z upper case
 

A-
 

Numbers 0-9, letters ABCDEFGHJKLMNPQRTUWXY
 

A-
 

Numbers 2-9, letters BCDFGHJKLMNPQRSTVWXYZ
 

A-
 

Letters A-Z, Upper Case
 

A-
 

Numbers 0-9, letters A-F
 

Related Topics
• Document Sequences

• Guidelines for Managing Document Sequences

• Custom Object Public Unique IDs

Migrate Public Unique ID Data  
You can migrate PUIDs from a test to production instance, or the other way around.

The migration is essentially exporting the data in one instance using the ready-to-use bulk export process in the sales
application and then importing the data into another instance using the import process.

Select a Migration Approach
Consider the following points before selecting a migration approach:

• If your organization frequently uses the bulk data load (migration) functionality, then use the document
sequence approach. For more information, see the related topics.

• If your organization doesn't use the bulk data load frequently, then use Oracle's standard import process to
import the data from one instance to another. When PUIDs are rejected in the process, manually define new
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PUIDs for the rejected PUID values and repeat the import process until all the data is imported. For more
information on how to import, see the Implementing Sales guide.

Note:  You can't migrate transactional data.

Manually Override PUID Values
You can manually override the PUID value during the import process. After a PUID is rejected in the import process, a
new PUID value should be defined. For example, let's say SMTTXT-002 is rejected because the record already exists in
the test instance. So, a new PUID value of SMTTXT-003 is defined and used in the import process.

Set Up Document Sequencing
Every object team defines a document sequence number for objects as part of PUID implementation. When a new PUID
is created in the database, the PUID functionality uptakes the value from the document sequence process. For example,
if the document sequence initial value is 0, when a PUID is created in the production instance, then the sequence
generation creates the PUID starting from 0. If the document sequence has a different initial value between the test
and production instances, then the possibility of PUID clashes between the test and production instance is removed
completely.

Organizations know how many objects are typically created in a test instance versus a production instance. Therefore,
defining an appropriate initial value for document sequence in the test and production instances should resolve the
PUID clashes. For more information about setting up document sequences, see Set Up Document Sequences in the
Oracle Fusion Applications Developer's guide.

Maintain Different Prefixes
You define the prefix information for specific objects in the Manage Public Unique Identifier Sequence Generation
task in Setup and Maintenance. You can enter a uniquely identifiable prefix in the test instance to signify that the PUID
values belong to the test instance. Similarly, while the same objects are defined in the same task flow in the production
instance, enter a prefix to signify the PUID values belong to a production instance. Therefore, the PUID value as a whole
never clashes when the migration occurs from the test to production instance or the other way around.

Related Topics
• Document Sequences

• Guidelines for Managing Document Sequences

Recent Items  

About Recent Items  
As they work in an application, salespeople see their most recent items in the Find search boxes, in the Recent Items list
(accessible from the favorites icon in the global header), and in other lists.

A salesperson's recently accessed or updated records is supplied by the Recent Items API.
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Scenarios for When Recent Item Relationships Occur
The application captures recent items any time a sales user interacts with a record, whether that be creating, updating,
or simply viewing the record. That record then shows up in the Find box for that object. Note that recent items don't
appear in other objects' Find lists. Say, for example, a salesperson creates an opportunity, that record's creation won't
show up in the Activities Find list. But, they can show up in lists of values within a record, such as an account recent item
showing up in the list of accounts in an opportunity.

Note:  By default, the application keeps recent items in the database for 30 days. You can configure this time frame,
however. See the Specify How Long to Keep Recent Items topic for more information.

These simple scenarios illustrate events that cause the Recent Item API to establish a recent items relationship with a
record or with the application itself:

• A user creates a record, such as a lead, an opportunity, or an activity like a task or appointment.

• A user drills into the edit page of a record that's not among the recent items, for example, the user opens a task.

• A user signs out of the application.

This scenario is a little more complex and illustrates how recent items can appear in other objects:

• An appointment has Opportunity 1 associated with it.

• The user edits Opportunity 2 and saves the opportunity.

• The user goes into the same appointment and removes Opportunity 1 and clicks on the drop-down list for
opportunities, to associate a different opportunity with the appointment.

• In the appointment's drop-down list for opportunities, the application shows the last opportunity (Opportunity
2) first in the list.

If a record is created, the CREATION_DATE and CREATED_BY attributes are captured accordingly. If a record is updated,
then the LAST_UPDATE_DATE and LAST_UPDATED_BY attributes are modified accordingly.

But, remember that users don't have to update a record for it to be recorded as a recent item. Whether the record is
updated or not, the application always records even the viewing of a record as a recent item.

Specify How Long to Keep Recent Items  
You can configure how long to keep recent items in the database. The default is 30 days, and you can change that time
by setting the profile option, Days to Keep Recent Items (ORA_ZCA_RECENT_ITEMS_PRESERVE_DAYS).

Use the Manage Administrator Profile Values task in Setup and Maintenance to access the profile option.

The process Purge Application Metrics runs weekly to automatically purge and optimize the list of recent items. You can
also schedule the process manually in the Scheduled Processes UI.

Note:  If recent items aren't deleted periodically, the application stores the data, and storing large amounts of recent
items data can impact performance.

103



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 7
Common Components

Service Request Management  

Overview of Service Request Management  
Service request management functionality lets you manage and deliver a streamlined service in response to service
requests. Delivering consistent answers to customer questions helps ensure that service requests are resolved
efficiently and effectively.

Service request management lets you:

• Create service requests

• Enter summary information into service requests

• Add products and product groups to service requests

• Organize service requests into queues

• Compose and send messages from service requests

• Add contacts to service requests

• Add team members to service requests

• Automatically or manually assign service requests to other users

• Create activities for service requests

• Share service request information

• Associate and view items in the knowledge base

• Integrate with the partners application to capture and resolve issues reported by your partner accounts

See the Using Fusion Service guide for more information about sales user tasks for service requests.

Summary of Setup Tasks
Here's a summary of the setup tasks:

• Enable the Service offering

• Understand the predefined service request job and duty roles

• Define service request assignment rules

• Enable the sales catalog for service requests

• Enable outbound email messages for service requests

• Configure service request categories

• Configure knowledge base settings for service requests

• Modify service request lookups

See the Implementing Fusion Service guide for more information about service requests setup tasks.
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Time Zone  

Specify Customer Time Zones  
You can use the Time Zone lookup type, ORA_HZ_TIMEZONE_CODES, to modify the list of time zones for account and
lead contacts.

After you enable the Time Zone field using Application Composer, the attribute is exposed in REST APIs and in the UI.
Salespeople can edit the attribute to adjust the time zone value from the initial value that was derived from the primary
address.

Time zone codes can be viewed and managed in Setup and Maintenance under Manage Standard Lookups by
searching for ORA_HZ_TIMEZONE_CODES.

The Time Zone lookup type supports 38 standard time zone values.

Related Topics
• Add the Time Zone Field to Contacts Pages

Watchlist  

Overview of the Watchlist  
The Watchlist is a portlet that displays a list of a user's transaction-related items, such as expenses. It's available using
the Watchlist icon in the global header.

For all users across the site, you can disable or enable predefined Watchlist categories and items, edit their names, and
determine how often item counts refresh.

For more information, see the related topics.

Related Topics
• Disable or Enable Watchlist Categories and Items

• Refresh Intervals for Watchlist Items

• Create Watchlist Items

• Show or Hide Watchlist Items
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8  Multiple Business Units

About Business Units  
As part of your enterprise structure in the applications, the business unit (BU) primarily serves as a container or
construct that can be used to separate or share setup and reference data.

A business unit typically performs one or many business functions and has a specific place in the organization
hierarchy. Usually, each business unit has a manager, strategic objectives, a level of autonomy, and responsibility for its
profit and loss.

A business unit can:

• Process transactions on behalf of many legal entities and post transactions to its own primary ledger.

• Segment transactional data from other business units. For example, if you run your Sales business separately
from your Marketing business, you segment the Sales business data to prevent access by the Marketing
employees.

• Report on transactions.

• Share sets of reference data across applications. Business units process transactions using reference data sets
that reflect your business rules and policies across the company. You can share reference data, such as payment
terms and transaction types, across business units, or you can choose to have each business unit manage its
own set, depending on the level at which you want to enforce common policies.

Business Unit Terminology
Be aware of the following terminology as you implement and work with multiple business units:

• Master data: Data that's managed globally and isn't specific to any BU. Examples include:

◦ Accounts: Customer accounts can't be segmented by BU.

◦ Users: Users can be associated to BUs through their resource organization membership, but in general
are managed globally.

◦ Products: While different BUs might sell different products, the definition of a product is global.

Note:  Access to master data, such as accounts and contacts, must be driven through territory-based
assignment. Master data can't be segregated by business unit.

• Reference data: This is data that's used by transactional objects like leads and opportunities. Reference data
can be different across BUs or common across BUs. Reference data is organized into reference data sets, also
called sets, each with a unique Set ID. Examples include:

◦ Lookup types, such as those that provide lists of values for several fields in opportunities and leads

◦ Opportunity sales methods, available for modification in the sales methods setup pages

• Transactional data: This is the sales user data, such as that associated with leads, opportunities, and contracts
that are created during a typical sales process.
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Overview of Multiple Business Units in Sales  
Setting up your enterprise structure with multiple business units (BUs) lets you have separate units that can perform
different business functions and that can be rolled up into the management hierarchy.

In the sales applications, these business objects support the use of multiple BUs:

• Contracts

• Leads

• Opportunities

• Resource Organizations

• Territories

Benefits of Using Multiple BUs
Before implementing a multiple-BU model, think about how your organization would benefit from implementing
multiple BUs. This evaluation is, of course, specific to each organization, but some of the considerations include:

• Access customer data across BUs: Realize a complete, single view of your customers and their interactions
across all BUs.

• Global reporting and forecasting: Get company-wide analytics for key stakeholders and executives. Forecasting
and pipeline management can be done globally.

• Standardize business processes: Use best practices and standardize sales processes across the enterprise.

• Improve collaboration: Sales teams across BUs can collaborate on deals with the same customer, avoiding
conflicts for similar products and improving cross-sell and upsell opportunities.

• Reduce integration costs and data duplication: Fewer integrations are needed between sales and ERP systems,
with improved data quality in the sales system.

• Reduce duplicate development: Lower ownership costs for implementation and consulting resources. Avoid
duplication of setups and company-defined development artifacts.

• Reduce subscription costs: Users supporting different BUs don't need to sign on to multiple systems that
require separate licenses.

Benefits of Multiple BUs
In the sales applications, depending upon your business needs, structuring your enterprise with multiple BUs can be
beneficial within the sales business objects that support multiple BUs.

This table lists some of the ways your implementation can benefit from using multiple BUs:

Business Object Usage or Benefit More Information

Contracts
 

• You can associate contracts with a BU,
 allowing them to be restricted by BU.

• You can specify some Contract Terms
Library components at the BU level. For

See the topics on setting up business units for
the contract terms library in the Implementing
Enterprise Contracts guide.
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Business Object Usage or Benefit More Information

example, you can enable clause and
template adoption at the BU level.

Leads
 

• You can associate leads with a BU,
allowing transactional data to be restricted
by BU.

• You can select which assignment rules
and assessment templates to use for your
leads.

• You can use set-ID-enabled lookups to
segregate lookup values by BU. This type
of configuration lets you present different
lookup values to users in different BUs.

See these topics in this chapter:
 

• Overview of Multiple Business Units in
Leads

• Set Leads Business Unit Properties

• Add the Business Unit Field to Leads

• Map the Lead Business Unit for Territory
Assignment

Opportunities
 

• You can associate opportunities with a BU,
allowing transactional data to be restricted
by BU.

• You can use set-ID-enabled lookups to
segregate lookup values by BU. This type
of configuration lets you present different
lookup values to users in different BUs.

• You can set profile options at the BU level,
 including the close opportunity required
fields, default sales method, and territory
assignment method.

• You can associate several opportunity
attributes with a set ID, allowing them to
be shared across reference data sets.

See these topics in this chapter:
 

• Overview of Multiple Business Units in
Opportunities

• Set Opportunity Business Unit Properties

• Add the Business Unit Field to
Opportunities

Resource Organizations
 

You can associate sales resources and resource
organizations with a BU, thereby limiting the
sets of data that the sales resources have
access to.
 

See these topics in this chapter:
 

• Overview of Sales Resources and Multiple
Business Units

• Associate Business Units with Resource
Organizations

Territories
 

You can define the coverage of a sales territory
by selecting a BU. Leads and opportunities
identified with your defined BU are assigned to
the territory.
 

See:
 

• Territories Defined with Business Units
topic in this chapter

• Territories chapter section on dimensions

Here's an illustration of the different data types associated with multiple business units. The diagram shows master
data, such as customer data, products, and users, independent of BU-striped data. The BU-striped data includes
reference data, transactional data, and resource organization and resource user data.
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Multiple BUs Use Case
The use case described here can help you understand the concepts associated with multiple BUs.

In the use case, Vision Enterprises is a global high-technology company with two divisions: Vision Corp., focused on
software, and Vision Systems, selling high-end servers and engineered systems that combine hardware and software
in a single stack. Both divisions operate globally across North America, Europe, and Asia Pacific regions, so they create
BUs for each of these areas.

This figure shows the use case. The diagram shows Vision Enterprises as encompassing its two
divisions, Vision Corp. and Vision Systems. The diagram shows the two divisions, Vision Corp.
and Vision Systems, as each encompassing three BUs: North America, Europe, and Asia Pacific.

Sales Administrator and Multiple BUs
Keep in mind that by default, sales administrators have access to only the data available in the BU to which they're
associated. However, there are few access paths, such as organization hierarchy and default business unit, through
which an administrator could get access to opportunities outside her BU.

Related Topics
• Multiple Business Units High-Level Setup Steps
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Setup Tasks  

Multiple Business Units High-Level Setup Steps  
Before you begin implementing multiple business units (BUs) in your sales application, you need to consider all of the
steps and options available.

Here are the high-level steps to set up multiple-BU functionality in sales, along with where to find more information
about each step. All of these steps may or may not be necessary, depending upon which product or business object
you're enabling for multiple BU support.

Note:  For the purposes the multiple-BU setup in sales, Oracle assumes that your company's basic enterprise
structure, including a legal entity, legal division, and organizations, is already set up. See the Getting Started with Your
Sales Implementation guide for more details.

Step Description Where to Find More Information

Set sales profile options to enable multiple BUs
functionality
 

Set two profile options to enable the multiple-
BU functionality.
 

See the topic, Set Sales Business Unit Profile
Options
 

Create additional BUs
 

Define additional business units in the Setup
and Maintenance work area. If you have already
done this as part of your enterprise setup, then
you can skip this step.
 

• See the topic, Define Business Units

• The guide, Oracle Applications Cloud
Understanding Enterprise Structures

Set business unit functions
 

A business function describes how a business
unit is used. You must set business unit
functions. If you have already done this as part
of your business unit setup, then you can skip
this step.
 

See the topic, Set Business Unit Functions
 

Create set-enabled reference data
 

If you're going to partition reference data by BU,
you must create additional reference data sets
for set-enabled attributes of objects.
 

See these topics:
 

• Overview of Managing Reference Data

• Create Reference Data Sets

Assign a default reference data set to business
units
 

For each BU for which you want to partition
data, assign it a default reference data set.
 

See the topic, Specify Business Unit Set
Assignments
 

Associate sales resources with BUs using
resource organizations
 

While most sales resources are associated with
a single BU, overlay teams might need to work
with multiple BUs. You can associate sales team
members with one or more BUs.
 

See these topics:
 

• Overview of Sales Resources and Multiple
Business Units

• Associate Resource Organizations With
Multiple Business Units

111



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 8
Multiple Business Units

Step Description Where to Find More Information

• Multiple Business Units and Data Access,
 in the Securing Sales and Fusion Service
guide

Associate BUs with territories
 

If you want to assign sales team members
within territories by BU, you can assign the
Business Unit dimension to territories.
 

See these topics:
 

• Territories Defined with Business Units

• How You Model Your Sales Organization

• How to Set Up Territory Dimensions

Enable leads and partners to use multiple BUs
 

You can specify lead attributes and some
partner attributes at the BU level.
 
Use Application Composer to enable the
Business Unit field in the leads UI.
 

See these topics:
 

• Overview of Multiple Business Units in
Leads

• Set Leads Business Unit Properties

• Add the Business Unit Field to Leads

Enable opportunities to use multiple BUs
 

Specify opportunity attributes at the BU level.
 
Use Application Composer to enable the
Business Unit field in the opportunities UI.
 

See these topics:
 

• Overview of Multiple Business Units in
Opportunities

• Set Opportunity Business Unit Properties

• Add the Business Unit Field in
Opportunities

Move opportunities or leads to another BU
 

Run the Migrate Lead and Opportunity
Business Unit Data scheduled process.
 

See the Migrate Lead and Opportunity BU Data
topic in this chapter
 

Implement company-defined, BU-specific
business processes and UI layouts
 

Use Oracle Application Composer to define and
manage UI layouts, workflows, validations, and
triggers for different BUs.
 

See the Configuring Applications Using
Application Composer guide and the chapters
on extending business objects in this guide
 

Related Topics
• Associate Resource Organizations with Multiple Business Units

• Multiple Business Units and Data Access for Sales Objects

Set Sales Business Unit Profile Options  
To enable multiple business units (BUs) for sales, you must set two profile options.

• Multiple Business Units Enabled (HZ_ENABLE_MULTIPLE_BU_CRM): Set this profile option to Yes. The default
value is No.

• Customer Relationship Management Business Unit Default (HZ_DEFAULT_BU_CRM): Set this to the default
sales business unit.
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Note:  If you exported values for business unit profile options and then imported them into another environment,
keep in mind that the values aren't retained, and you need to set them each time after export/import.

To set the profile options:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Common CRM Business Unit Profile Options

2. In the Manage Common CRM Business Unit Profile Options page, select the HZ_ENABLE_MULTIPLE_BU_CRM
profile option and set it to Yes.

3. Click Save and Close.
4. Select the HZ_DEFAULT_BU_CRM profile option and set it to the default sales business unit.
5. Click Save and Close.

Related Topics
• About Business Units

• Overview of Multiple Business Units in Sales

• Associate Resource Organizations with Multiple Business Units

• Multiple Business Units High-Level Setup Steps

Overview of Enterprise Setups  
A single business unit (BU) is created for you when you first set up the sales applications. You can define additional BUs
in as needed. If you have already done this as part of your enterprise setup, then you can skip this step.

The setup of business units is part of the enterprise structure setup. This table shows what you need to do to set up
enterprise structures. For the purposes of the sales multiple-BU setup, we assume that your company's basic enterprise
structure, including a legal entity, legal division, and organizations, is already set up.

Step Description

Define Enterprise
 

Define the enterprise to get the name of the deploying enterprise and the location of the headquarters.
This step is completed for you as part of your initial setup. See the Implementing Sales guide for more
information.
 

Define Enterprise Structures
 

Define enterprise structures to represent an organization with one or more legal entities under
common control. Define organizations to represent each area of business within the enterprise.
 

Define Legal Jurisdictions and Authorities
 

Define information for governing bodies that operate within a jurisdiction.
 

Define Legal Entities
 

Define legal entities and legal reporting units for business activities handled by the Oracle cloud
applications.
 

Define Business Units
 

Define business units of an enterprise to perform one or many business functions that can be rolled up
in a management hierarchy.
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Step Description

 

Define Financial Reporting Structures
 

Define financial reporting structures, including organization structures, charts of accounts,
 organizational hierarchies, calendars, currencies and rates, ledgers, and document sequences used in
organizing the financial data of a company.
 

Define Chart of Accounts
 

Define chart of accounts including hierarchies and values to enable tracking of financial transactions
and reporting at legal entity, cost center, account, and other segment levels.
 

Define Ledgers
 

Define the primary accounting ledger and any secondary ledgers that provide an alternative
accounting representation of the financial data. Some sales implementations don't need to record
accounting transactions and thus don't need a ledger.
 

Define Accounting Configurations
 

Define the accounting configuration that's the framework for how financial records are maintained for
an organization.
 

Define Facilities
 

Define your manufacturing and storage facilities as inventory organizations if your company tracks
inventory balances there and item organizations if your company only tracks the items used in the
facility but not the balances.
 

Define Reference Data Sharing
 

Define how reference data in the applications is partitioned and shared.
 

For detailed concepts about implementing the enterprise structure, read the guide, Oracle Fusion Cloud Applications:
Understanding Enterprise Structures, available on Oracle Help Center. The use case in the topic, Multiple Business Units
in Sales: Overview, can help you with a sample structure.

For a procedure on how to create additional business units, see the topic, Define Business Units.

Related Topics
• Enterprise Structures Business Process Model

• Guidelines for Configuring Global Enterprises

Define Business Units  
You define business units in the Setup and Maintenance work area. You can skip this step if you have already created
business units when you set up your enterprise structure.

Note:  Remember, a single business unit is created for you when you initially set up your applications. The profile
option, HZ_ENABLE_MULTIPLE_BU_CRM enables multiple-BU functionality for the sales applications, and it must be
set to yes in order to be able to create additional BUs.
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Here's how to create additional business units:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Business Unit

2. In the Manage Business Units page, select the create icon, or select Create from the Actions menu.
3. In the Create Business Unit page, in the Name field, enter a name for the BU.
4. Optionally, enter the Manager and a Location.
5. Ensure that the Active check box is selected.
6. Pick a Default Set for the BU. This is the reference data set that the BU will use.

For more information on reference data sets, see the topics on reference data sets.
7. Click Save and Close.

Related Topics
• Reference Data Sets

• Overview of Multiple Business Units in Sales

Set Business Unit Functions  
A business unit can perform many business functions. A business function represents a business process, or an activity,
that can be done by people working within a business unit. It describes how a business unit is used.

You must set up business unit functions in the Setup and Maintenance work area. If you have already done this as part
of your business unit setup, then you can skip this step.

To set business unit functions:

1. Sign in as a setup user or as the sales administrator.
2. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Assign Business Unit Business Function

3. If, after selecting the Assign Business Unit Business Function task, a Select Scope dialog window appears
showing two radio buttons, select the Assign Business Unit Business Function option.

a. Select the arrow in the Business Unit field.
b. Click the Select and Add option.
c. Click Apply and Go to Task.
d. In the Select and Add: Business Unit page, search for and select the BU that you're assigning a function

to.
e. Click Select and Add in the dialog window.

4. After you select a BU, the Assign Business Functions page appears. In the Business Unit Functions list, select
the functions that apply to the business unit.

For more information about business unit functions, see the topic, Business Functions.
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5. Click Save and Close.

Related Topics
• Overview of Multiple Business Units in Sales

• Business Functions

Overview of Managing Reference Data  
Reference data is data that's associated with transactional objects, such as leads and opportunities. Reference data is
organized into reference data sets.

The reference data model lets companies separate transactional data so that it can be used across business units (BUs)
or only for specific BUs. A data set called the Common set is predefined with the application. You can use the Common
set for reference data that you want to share across business units. You can also create and maintain company-defined
sets and assign them to specific BUs.

Examples of reference data include lists of values, such as the Win/Loss Reason list of values in opportunities,
opportunity sales methods lists, opportunity sales stages lists, and price lists.

All reference data is tagged with a configuration ID called Set ID. For example, every value in a list of values in an
opportunity is tagged with a Set ID.

You can create separate sets and subsets for each business unit. Alternatively, you can create additional common sets or
subsets to enable sharing reference data across several business units, without duplicating the reference data.

This illustration shows an example of reference data in the Common set and different reference data in a set called
APAC. Users associated with the BUs assigned to the Common set can access the data associated with it, but they
can't access the data associated with the APAC BU, unless they're part of the BUs assigned to that reference data. 

You assign reference data sets to set-enabled attributes in the Manage Business Unit Set Assignment page in Setup
and Maintenance. For a procedure on assigning data sets to set-enabled data, see the topic, Specify Business Unit Set
Assignments.
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Create Reference Data Sets  
Reference data is organized into reference data sets. You create reference data sets in the Manage Reference Data Sets
page in Setup and Maintenance.

Use the following procedure to create reference data sets. In a later step, you assign them to business units. If you have
already created reference data sets, you can skip this step.

1. Sign in as a setup user or as the sales administrator.
2. In Setup and Maintenance, go to the Sales offering and search for the Manage Reference Data Sets task.
3. Click the new icon, or select New from the actions menu.
4. On the Manage Reference Data Sets page, enter the appropriate data in the following fields:

◦ Set Code: Enter a unique code.

◦ Set Name: Enter the name of the set.

◦ Description: Enter a description of the set.

5. Click Save and Close.

Related Topics
• Overview of Managing Reference Data

• Specify Business Unit Set Assignments

Specify Business Unit Set Assignments  
If you're partitioning reference data so that different business units (BUs) can use different sets of data, you must assign
a default set to each business unit.

You may have already done this when setting up BUs. If that's the case, then you can skip this step. If you do specify set
assignments as described here, these settings override the setting in the business units edit page.

Use the following procedure to assign reference data sets to business units.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Business Unit Set Assignment

2. In the Manage Business Unit Set Assignment page, for each reference data object, select the set that you want
to assign to the business unit.

3. Click Save and Close.

Related Topics
• Overview of Multiple Business Units in Sales
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Sales Resources and Multiple Business Units  

Overview of Sales Resources and Multiple Business Units  
You can map multiple business units (BUs) to your resource organizations in order to regulate sales users' visibility into
transactional data. Transactional data is the data found in business objects such as opportunities, leads, and contracts.

Note:  Before coming to this content, we assume assume you have already created a resource organization hierarchy
according to the instructions in the Implementing Sales guide.

Sales User Access to Transactional Data
Sales users' access to transactional data for an object is the same in multiple BU environments and single BU
environments. That is, sales users can access object data across BU boundaries provided that they have valid access
to the object by means of territory or team membership, through the resource hierarchy, or by being granted full
access to the object. For example, a sales representative can have access to data as determined by team and territory
membership, irrespective of the BUs she's associated with.

Business unit assignment can, however, indirectly affect a user's access to object transactional data. In a multiple BU
environment, BUs are available as territory dimensions and can be included as part of the territory coverage definition
for the assignment of transactions. A sales user gains access to object data through territory membership. If BU is
specified as a territory dimension, then the user's access to data is limited to objects which, when they were created,
were assigned to the same BU that's assigned to the user's territory team. For more information about data access and
users, see the topic, Multiple Business Units and Data Access, in the Securing CX Sales and Fusion Service guide.

Sales Administrator Access to Business Units
Sales administrators, who are created as resources in the organization, have access to all of the data available in the BUs
to which they're associated.

Use Case With Resources Across Business Units
In some cases, you may want to have certain types of users have visibility into data across BUs. For example, you may
want your overlay sales representatives to have access to all BUs. Here are some examples:

• Associate overlay sales representatives with all business units and differentiate them using territory
dimensions, such as geographic region of responsibility.

• Associate sales operations and sales administrators to one, many, or all business units.

In the use case, Vision Enterprises is a global high-technology company with two divisions: Vision Corp., focused on
software, and Vision Systems, selling high-end servers and engineered systems that combine hardware and software
in a single stack. Both divisions operate globally across North America, Europe, and Asia Pacific regions, so they create
BUs for each of these areas.

The following figure shows the use case. The diagram shows Vision Enterprises as encompassing its two divisions,
Vision Corp. and Vision Systems. The diagram shows the two divisions, Vision Corp. and Vision Systems, as each
encompassing three BUs: North America, Europe, and Asia Pacific. The diagram shows the following types of

118

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20049616
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OSCUS


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 8
Multiple Business Units

users having access to all BUs under both divisions: sales overlay team, sales operations, and sales administrators.

Related Topics
• Overview of Multiple Business Units in Sales

• Overview of Data Sharing Mechanisms and Visibility

• Multiple Business Units and Data Access for Sales Objects

Multiple Business Units in Territories  

Territories Defined with Business Units  
You can use the Business Unit dimension in your territory setup to define territory coverage. A territory's jurisdiction can
include one, multiple, or all business units (BUs).

In opportunity and lead assignment, when the BU associated with the opportunity or lead matches the BU mapped to
the territory, the sales team members within that territory get assigned to the lead or opportunity product.

When you implement territories, enable the Business Unit dimension. When you build your territory hierarchy, you can
use the business unit dimension in the territory coverage. You always have just one territory hierarchy, with one top-
level territory. In a typical multiple business unit implementation, you define first-level territories by business unit.

The Business Unit dimension also helps facilitate the loading of territory metrics, partitioned by BUs.

Tip:  Assignment of sales accounts ignores the Business Unit dimension.
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Use Case
In this use case you have one territory hierarchy with one top-level territory. The Vision Enterprises territory has this
structure:

• One overlay territory that includes all products and all geographies. Child territories can be added to further
delineate overlay team member responsibility by product or geography.

• A territory for each business unit. Child territories are defined by product or geography.

This chart shows the use case. Vision Enterprises has two divisions, Vision Corporation and Vision
Systems. Each division has three business units, and therefore three first-level territories defined by
these business units. The overlay territory is defined with all business units, and the Vision Corporation
North America territory defined by the Vision Corp NA BU. The Vision Systems North America territory
is defined by the Vision Systems NA BU. The Vision Corp NA territory has child territories defined by
geography. The Vision Systems NA territory has child territories defined by geography and by product.

Multiple Business Units in Leads  

Overview of Multiple Business Units in Leads  
Using multiple business units (BUs) in leads lets you offer different versions of the Leads UI according to the BU of the
user.
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Users in one BU can't view leads from another BU if they don't have the appropriate access. However, you can present
different drop-down lists for leads in different BUs.

Multiple Business Units in Leads Use Case
Let's say your company has two divisions, each with three BUs for the geographical areas where they do business: North
America, Europe, and Asia. The sales processes between the three business units is different. You can tailor the Leads
pages based on the different business units.

For example, when a lead is created in the North America BU, salespeople have a finite set of values to select from in
the Lead Reject Reason drop-down list. In contrast, salespeople who work in the Europe BU have different reasons for
rejecting a lead and must use values that are specific to their business unit.

Set ID Lookup Types
To enable different values in a drop-down list for a specific BU, you use the supplied set-ID enabled lookup types for
leads.

This table shows the leads set-ID lookup types, the values, and the descriptions. Use the Manage Set Enabled Lookups
task from the Setup and Maintenance work area to access the lookup types related to leads.

Lookup Type Lookup Values Description

Lead Qualification Budget Status
 

• Approved

• Pending

• Unknown

The approval status of a customer budget. The
data is used to assess the lead qualification
status.
 

Lead Rank
 

• Cold

• Hot

• Warm

Lead rank values used as a measure of lead
quality and prioritization.
 

Lead Reassignment Reason
 

• No activity

• Other

• Workload

Possible reasons specified for reassigning leads.
 

Lead Reject Reason
 

• Duplicate lead

• Failed to reach contact

• Incorrect data

Possible reasons specified for rejecting leads.
Rejected leads can be reassigned or retired.
 

Lead Retire Reason
 

• Duplicate lead

• No purchase interest

Possible reasons for retiring leads. Retired leads
are considered closed leads.
 

Lead Registration Type
 

• Co-sell

• Referral

• Resale

Types of leads available for partners.
 

Lead Source Channel
 

• Direct mail

• E-Mail

• Fax

Source channel responsible for lead generation.
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Lookup Type Lookup Values Description

• Marketing Cloud

• Phone

• Sales campaign

• Sales visit

• Social

• Company website

• Wireless message

• Model-based prediction

• Rules-based prediction

Lead Time Frame
 

• 3 months

• 6 months

• 9 months

• 12 months

• 15 months

• 18 months

Lead cycle duration that usually coincides with
a typical sales cycle duration for products and
services offered.
 

Business Units in the Leads UI
Some users can transact in multiple BUs, for example, salespeople who are members of different sales teams. These
users can select the BU they want when the lead is being created but note that the business unit can't be changed once
the lead is created. Based on their selection, the set ID-enabled lookup types display based on the BU of their choice.

Additional Leads Modification by Business Units
You can modify BUs to meet your specific leads requirements. For example, you can:

• Select which assignment rules to use for your leads, which lead assessment templates to use, and so on.

• Set BU attributes to be visible in the Add Fields UI when performing a search for leads.

• Hide BU attributes for single BU deployments in all transaction and search UIs.

• Hide BU attributes for multiple BU deployments for users who transact in one BU only.

Related Topics
• Multiple Business Units High-Level Setup Steps

• Example of a Set-Enabled Lookup

• Overview of Multiple Business Units in Opportunities

Set Leads Business Unit Properties  
You can set several lead settings at the business unit (BU) level. When you set an option such as a rule or template at the
BU level, the option setting is effective for only the BU that you indicate.
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You set leads' BU-level options in the Specify Sales Business Function Properties page, in the Lead Settings section.

Here's how to specify business unit properties for leads:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Specify Sales Business Function Properties

2. If a BU isn't associated with the task, the application prompts you to select one. The Select Scope dialog box
appears. In this dialog box:

a. Select the Specify Sales Business Function Properties option.
b. In the Business Unit list of values, click Select and Add and add the BU.
c. After you have selected the BU, click Apply and Go to Task.

3. In the Specify Sales Business Function Properties page, in the Lead Settings section, set these options:

◦ Lead Templates

◦ Lead Conversion Mapping

4. Save your changes.

BU-Enabled Lead Profile Options
This table describes the lead template and copy map BU-enabled profile options and their default values, if any.

Profile Option Description Default Value

Qualification Assessment Template
 

Specify the qualification template to use for
evaluating and qualifying leads.
 

None
 

Direct Lead to Opportunity Copy Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
direct lead is converted to an opportunity.
 

None
 

Partner Lead to Opportunity Copy Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
partner lead is converted to an opportunity.
 

None
 

Related Topics
• Set Opportunity Business Unit Properties

• Overview of Multiple Business Units in Leads

• Update Existing Setup Data
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Add the Business Unit Field to Leads  
After you modify the UI, salespeople can associate a business unit (BU) with their leads using a drop-down list in the
Edit Lead page. You enable the drop-down list using Application Composer.

Add the Business Unit Field
Here's how to add the Business Unit field to the Edit Lead page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Expand Standard Objects and navigate to Sales Lead > Pages. The Sales Leads: Pages page appears.
4. In the Sales Leads: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, click the duplicate layout icon to duplicate and edit an existing layout.
6. In the Duplicate Layout dialog window, enter the new layout name and select the existing page layout to

duplicate.
7. Click Save and Edit. Your new Details Layout page appears, with the name of the new layout in the page title.
8. In the Summary subtab region, click the edit icon.
9. In the Details Layout: Default custom layout: Edit Summary page, find the Business Unit field in the Configure

Detail Form list. Move the field from the Available Fields list to the Selected Fields list.
10. Click Save and Close.
11. Click Done in the Details Layout: Default custom layout page.
12. Validate the change by navigating to the Edit Lead page and verify that you can see the Business Unit field.
13. Publish the sandbox.

The Business Unit field is now available to sales users in the edit lead pages.

Related Topics
• Overview of Sandboxes

Map the Lead Business Unit for Territory Assignment  
If you want to use business units in territory assignment, you must set up a mapping between the lead BU field and the
territory dimension, Business Unit.

For example, you have a scenario where your organization:

• Has multiple business units with defined territories

• Wants to assign sales leads based on the business unit

In this example, let's say the lead is contained in BU1. In this case, set up the assignment mapping so that territory
assignment only matches the BU1 territories (along with any matching dimensions). For example, matching dimensions
might include geography, product, account type, sales channel and so forth.

Set Up the Lead Business Unit Mapping
Here's how to set up the lead business unit mapping:

1. In the Setup and Maintenance work area, go to:

124

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035520


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 8
Multiple Business Units

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. On the Manage Sales Lead Assignment Objects page, locate and select Sales Lead in the Name column.
3. In the Sales Lead: Details region, select the Candidates tab.
4. Select the Sales Lead Territory candidate.
5. Select the Sales Lead Territory: Mapping Sets tab.
6. In the Name column, select from one of these active mapping sets for the sales lead object you want:

◦ Mapping Set 1

◦ Mapping Set 2

◦ Mapping Set 3

◦ Mapping Set 4

◦ Mapping Set 5

7. In the Mapping Set: Mappings region, locate and select the BUnit dimension function code.
8. Deselect the Inactive check box to make the function code active.
9. Repeat steps 2 through 4 for each sales lead Mapping Set.

10. Click Save and Publish.
11. Monitor and refresh the page to confirm the publish process has succeeded.

The sales lead assignment processing is now ready to use the active BU information when assigning territories.

Related Topics
• Multiple Business Units High-Level Setup Steps

• How to Set Up Territory Dimensions

Multiple Business Units in Opportunities  

Overview of Multiple Business Units in Opportunities  
Using multiple business units in opportunities lets users associate opportunities and related attributes with a specific
business unit (BU) and then report on the data by BU.

Business Units and Opportunity Attributes
In addition to associating an opportunity itself with a BU, you can also associate several opportunity attributes with
business units.

The following opportunity attributes are set-enabled and hence allow association with a business unit and with
reference data sets. Reference data sets let objects share reference data across BUs. For example, you can choose to
have opportunity the Win/Loss Reason lookup type shared across BUs, or you can choose to have each BU manage its
own. You can also assign a reference data set to reference data objects, such as sales methods.

• Opportunity lookup types:
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◦ Win/Loss Reason (MOO_SETID_WIN_LOSS_REASON)

◦ Strategic Value (MOO_SETID_STRATEGIC_VALUE)

◦ Opportunity Assessment Override Reason (MOO_SETID_ASSESS_OVRRIDE_RSN)

◦ Decision Level (MOO_SETID_DECISION_LEVEL)

◦ Estimated Deal Duration (MOO_SETID_DEAL_HORIZION)

◦ Level of Risk (MOO_SETID_RISK_LEVEL)

◦ Sales Revenue Category (MOO_SETID_REVN_CATEGORY)

◦ Sales Revenue Type (MOO_SETID_REVENUE_TYPE)

• Sales methods

• Sales statuses

When you enable set-ID lookup types, you must assign them to a business unit in the Manage Set Enabled Lookups
page in the Setup and Maintenance work area. To find this page, do the following:

1. Sign in as a setup user or sales administrator.
2. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Set Enabled Lookups

For an example of using a set-enabled lookup, see Example of a Set-Enabled Lookup

For more information about reference data sets, see How Business Units Work with Reference Data Sets

You can set several opportunity profile options at the business unit level, and you can specify the default sales method
for a business unit. For more information, see Specify Sales Business Function Properties.

Set Opportunity Business Unit Properties  
You can set several opportunity profile options, including the one for default sales method, at the business unit (BU)
level. When you set a profile option at the BU level, the profile option setting is effective for only the BU that you
indicate.

Here's how to specify business unit properties for opportunities:

1. In the Setup and Maintenance work area, go to:
◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Specify Sales Business Function Properties
2. If a BU isn't associated with the task, the application prompts you to select one. The Select Scope dialog box

appears. In this dialog box:
a. Select the Specify Sales Business Function Properties option.
b. In the Business Unit list of values, click Select and Add and add the BU.
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c. After you add the BU, click Apply and Go to Task.
3. In the Specify Sales Business Function Properties page, set the profile options that you want as outlined in the

BU-Enabled Profile Options section.
4. Save your changes.

BU-Enabled Profile Options
This table outlines the opportunity BU-enabled profile options.

Profile Option Description Default Value

Sales Method
 

Determines the default sales method the
application picks when an opportunity is first
created.
 

Standard Sales Process
 

Require Win/Loss Reason
 

Determines whether, when closing an
opportunity, the user is required to enter a win/
loss reason. Applies both at the opportunity
and revenue item levels.
 

Yes
 

Require Competitor
 

Determines whether, when closing an
opportunity, the user is required to enter a
competitor. Applies both at the opportunity and
revenue item levels.
 

Yes
 

Territory Based Resource Assignment Style
 

Determines if all members of the territory
should be added to an opportunity team or
just the owner. Or, if all (owner and members
of the territory) should be excluded from the
opportunity team.
 

Note:
When you set a profile option at the BU level,
 the profile option setting takes precedence
for the BU. However, the Lock Assignment 
check box, if selected, takes precedence
and prevents a salesperson from being
automatically removed from an opportunity
through the assignment engine.
 

All
 

Related Topics
• Set the Default Sales Method Profile Option

• Set the Close Opportunity Profile Options

• Update Existing Setup Data
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Add the Business Unit Field to Opportunities  
If you want sales teams to be able to associate a business unit with an opportunity, enable the Business Unit list of
values in the opportunities UI.

Add the Business Unit Field
After you use Application Composer to add the Business Unit field to the opportunities UI, all available business units
display in a drop-down list in the Business Unit field.

1. Create and activate a sandbox to work in.
2. Navigate to Application Composer.
3. Expand Standard Objects and navigate to Opportunity > Pages. The Opportunity: Pages page appears.
4. In the Opportunity: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, select the Standard Layout in the table and then click the Duplicate icon.

The Duplicate Layout dialog box appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

6. Enter a name for the new layout and click Save and Edit.
7. In the Summary subtab region, click the edit icon.
8. In the Details Layout: Default Layout: Edit Summary page, find the Business Unit field in the Configure Detail

Form list. Move the field from the Available Fields list to the Selected Fields list.
9. Click Save and Close.

10. Click Done in the Details Layout: Default Layout page.
11. Validate the change by navigating to the edit opportunity page and ensuring that you can see the Business Unit

field in the edit opportunity page.

The user you sign in with to validate the change must belong to a sales resource organization. For example, you
must sign in as a sales representative.

12. Publish the sandbox.
13. The Business Unit field is now available to sales users in the edit opportunity application pages.

Related Topics
• Overview of Sandboxes

Enable Opportunity Territory Assignment by Business Unit  
You can configure the application to assign opportunities based on the BU.

To use BU in territory assignment, you must activate the assignment mapping between the opportunity revenue BU
field and the territory dimension, Business Unit.

For example, you have a scenario where your organization:

• Has multiple BUs, with defined territories

• Wants to assign opportunities based on the BU
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In this example, let's say the lead is contained in BU1. In this case, set up the assignment mapping so that territory
assignment only matches the BU1 territories (along with any matching dimensions). Matching dimensions might include
geography, product, account type, and sales channel.

Set Up the Opportunity Revenue Business Unit Mapping
Here's how to set the up the opportunity revenue BU mapping:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Objects

2. In the Name column of the Manage Sales Assignment Manager Objects page, locate and select Revenue.
3. In the Revenue: Details region, select the Candidates tab.
4. Select the Territory candidate.
5. Select the Territory: Mapping Sets tab.
6. In the Name column, select Sales Account Mapping Set.
7. In the Sales Account Mapping Set: Mappings region, locate and select the BUnit dimension function code.
8. Click the edit icon on the table to go into edit mode.

The Edit Mapping window appears.
9. Deselect the Inactive check box to make the function code active. Click OK.

10. Click Save and Publish.
11. Monitor and refresh the page to confirm the publish process has succeeded.

The opportunity assignment processing is now ready to use the BU information when assigning territories.

Related Topics
• Multiple Business Units High-Level Setup Steps

• How to Set Up Territory Dimensions

• Considerations for Setting Up Opportunity Revenue

Change the Business Unit for a Subset of Opportunities  
Salespeople can update the business unit on an opportunity. They can also update the set-enabled lookup values on the
opportunity and revenue lines.

Read this topic to learn how to add new specific or common set values for sales methods and stages. Learn how to
enable or disable existing lookup values for:

• Set-enabled lookups for these opportunity tasks:

◦ Manage Levels of Risk

◦ Manage Strategic Values

◦ Manage Decision Levels

◦ Manage Deal Horizons
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◦ Manage Win/Loss Reasons

◦ Manage Opportunity Revenue Types

• Sales Status lookup values

• Specific Sales Method and Sales Stage for the Sales Method

You set lookup values from the relevant tasks available from the Define Opportunity Management Lookups page. This
page is accessible from the Sales offering work area.

Modify BU Setup for Opportunities
Here's how to create specific values or enable or disable existing lookup values for opportunities. You also set up the
sales status, sales method, and sales stage before you select your business unit to apply the changes.

1. In the Setup and Maintenance work area, go to:
◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Define Opportunity Management Lookups
2. On the Define Opportunity Management Lookups page, select the opportunity task that you want.
3. Add a new set-enabled lookup value or either enable or disable an existing lookup value.
4. After the setup is done for the task lookups, navigate to the Setup and Maintenance work area and go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Status
5. In the Sales Statuses section of the Manage Sales Statuses page, add a new sales status or select or deselect

Active for an existing sales status.
6. Next, go to the Manage Sales Methods and Sales Stages task.
7. Add a new sales method and sales stage for the sales method that you want.
8. After you complete the setup related to lookups, sales statuses, sales methods, and sales stages, navigate to

the Define Business Units task.
9. Click the Manage Business Unit Set Assignment task.

10. In the Reference Data Set Code column, for each object, set the business unit.
11. Click Save and Close.

Repeat step these steps for each new individual business unit you have added.

Related Topics
• Update Existing Setup Data

Migrate Lead and Opportunity BU Data  
There might be times when you need to move all leads or opportunities from one business unit to another.

For example, you could have a new business unit taking over all opportunities from another business unit. All
opportunities would have to be updated from the old business unit to the new business unit. The migration is easy to do
by running the Migrate Lead and Opportunity Business Unit Data scheduled process.

1. Navigate to Tools > Scheduled Processes.
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Alternatively, run the process from the Migrate Lead and Opportunity Business Unit Data task in Setup and
Maintenance.

2. Click Schedule New Process.
3. Search for the Migrate Lead and Opportunity Business Unit Data process.

Tip:  You may need to search for the process in the search and select window available by clicking the Search
link at the at the bottom of the Name list on the main search window.

4. Select your options:

◦ Business Object: Opportunity or Lead

◦ From Business Unit: Business unit that you want to migrate data from

◦ To Business Unit: Business unit that you want to migrate data to

5. Submit the process.

Related Topics
• Overview of Scheduled Processes

Additional Implementation Concepts  

Reference Data Sets  
Reference data sets are logical groups of reference data that various transactional entities can use depending on the
business context. You can get started using either the common reference data set or the enterprise set depending on
your implementation requirement.

You can also create and maintain additional reference data sets, while continuing to use the common reference data set.
Consider the following scenario. Your enterprise can decide that only some aspects of corporate policy should affect all
business units. The remaining aspects are at the discretion of the business unit manager to implement. This enables
your enterprise to balance autonomy and control for each business unit.

For example, your enterprise holds business unit managers accountable for their profit and loss, but manages working
capital requirements at a corporate level. Then, you can let managers define their own sales methods, but define
payment terms centrally. As a result, each business unit has its own reference data set for sales methods and one central
reference data set for payment terms assigned to all business units.

Partitioning
Partitioning reference data and creating data sets provide you the flexibility to handle the reference data to fulfill your
business requirements. You can share modular information and data processing options among business units with
ease. You can create separate sets and subsets for each business unit. Alternatively, you can create common sets or
subsets to enable sharing reference data between several business units, without duplicating the reference data.
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The following figure illustrates the reference data sharing method. The user can access the data assigned
to a specific set in a particular business unit, as well as access the data assigned to the common set.

Related Topics
• Assignment of Reference Data Sets to Reference Objects

• Reference Data Sets and Sharing Methods

How Business Units Work with Reference Data Sets  
Reference data sharing enables you to group set-enabled reference data such as jobs or grades to share the data across
different parts of the organization.

Sets also enable you to filter reference data at the transaction level so that only data assigned to certain sets is available
to be selected. To filter reference data, Oracle Fusion Human Capital Management (HCM), applications use the business
unit on the transaction. To set up reference data sharing in Oracle Fusion HCM, you create business units and sets, and
then assign the sets to the business units.

Common Set Versus Specific Sets
Some reference data in your organization may be considered global, and should therefore be made available for use
within the entire enterprise. You can assign this type of data to the Common Set, which is a predefined set. Regardless
of the business unit on a transaction, reference data assigned to the Common Set is always available, in addition to the
reference data assigned to the set that corresponds to the business unit on the transaction.

Other types of reference data can be specific to certain business units, so you can restrict the use of the data to those
business units. In this case, you can create sets specifically for this type of data, and assign the sets to the business
units.

132

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20028701


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 8
Multiple Business Units

Business Unit Set Assignment
When you assign reference data sets to business units, you assign a default reference data set to use for all reference
data types for that business unit. You can override the set assignment for one or more data types.

Example: Assigning Sets to Business Units
InFusion Corporation has two divisions: Lighting and Security, and the divisions each have two locations. Each location
has one or more business functions.

The following figure illustrates the structure of InFusion Corporation.

When deciding how to create business units, InFusion decides to create them using the country and business function
level. Therefore, they created the following business units:

• Sales_Japan

• Marketing_Japan

• Sales_US

• Sales_UK

• Marketing_India

• Sales_India

Because locations, departments, and grades are specific to each business unit, InFusion does not want to share these
types of reference data across business units. They create a reference data set for each business unit so that data
of those types can be set up separately. Because the jobs in the Sales business function are the same across many
locations, InFusion decides to create one additional set called Jobs. They override the set assignment for the Jobs
reference data group and assign it to the Jobs set. Based on these requirements, they create the following sets:

• Sales_Japan_Set

• Mktg_Japan_Set

• Sales_US_Set
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• Sales_UK_Set

• Mktg_India_Set

• Sales_India_Set

• Grades_Set

The following table describes the default set assignment and the set assignment overrides for each business unit in
InFusion:

Business Unit Default Set Assignment Set Assignment Overrides

Sales_Japan
 

Sales_Japan_Set for grades, departments, and
locations
 

Jobs set for jobs
 

Marketing_Japan
 

Mktg_Japan_Set for grades, departments, and
locations
 

None
 

Sales_US
 

Sales_US_Set for grades, departments, and
locations
 

Jobs set for jobs
 

Sales_UK
 

Sales_UK_Set for grades, departments, and
locations
 

Jobs set for jobs
 

Marketing_India
 

Mktg_India_Set for grades, departments, and
locations
 

None
 

Sales_India
 

Sales_India_Set for grades, departments, and
locations
 

Jobs set for jobs
 

When setting up grades, departments, and locations for the business units, InFusion assigns the data to the default set
for each business unit. When setting up jobs, they assign the Jobs set and assign the Common Set to any jobs that may
be used throughout the entire organization.

When using grades, departments, and locations at the transaction level, users can select data from the set that
corresponds to the business unit they enter on the transaction, and any data assigned to the Common Set. For example,
for transactions for the Marketing_Japan business unit, grades, locations, and departments from the Mktg_Japan_Set is
available to select, as well as from the Common Set.

When using jobs at the transaction level, users can select jobs from the Jobs set and from the Common Set when they
enter a sales business unit on the transaction. For example, when a manager hires an employee for the Sales_India
business unit, the list of jobs is filtered to show jobs from the Jobs and Common sets.
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The following figure illustrates what sets of jobs can be accessed when a manager creates an assignment for a worker.

Assignment of Reference Data Sets to Reference Objects  
You can assign the reference data sets to reference objects using the Manage Reference Data Set Assignments page.
For multiple assignments, you can classify different types of reference data sets into groups and assign them to the
reference entity objects.

The assignment takes into consideration the determinant type, determinant, and reference group, if any.

Determinant Types
The partitioned reference data is shared using a business context setting called the determinant type. A determinant
type is the point of reference used in the data assignment process. The following table lists the determinant types used
in the reference data assignment.

Determinant Type Description

Asset Book
 

Information about the acquisition, depreciation, and retirement of an asset that belongs to a ledger or
a business unit.
 

Business Unit
 

The departments or organizations within an enterprise.
 

Cost Organization
 

The organization used for cost accounting and reporting on various inventory and cost centers within
an enterprise.
 

Project Unit
 

A logical organization within an enterprise that's responsible for enforcing consistent project
management practices.
 

Reference Data Set
 

References to other shared reference data sets.
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Determinant
The determinant (also called determinant value) is a value that corresponds to the selected determinant type. The
determinant is one of the criteria for selecting the appropriate reference data set.

Reference Groups
A transactional entity may have multiple reference entities (generally considered to be setup data). However, all
reference entities are treated alike because of similarity in implementing business policies and legal rules. Such
reference entities in your application are grouped into logical units called reference groups. For example, all tables
and views that define Sales Order Type details might be a part of the same reference group. Reference groups are
predefined in the reference groups table.

Example of a Set-Enabled Lookup  
Creating a new set-enabled lookup is similar to creating a standard lookup with the addition of specifying a reference
data set determinant for the lookup codes.

The reference data set for a set-enabled lookup code is part of its foreign key. This is unlike other set-enabled entities.
Use the Manage Set Assignments task to define and manage reference data set assignments. Note that you can create
or edit lookup codes only if the configuration level for that lookup type supports it.

Selecting a Reference Group for a Set-Enabled Lookup Type
Specify a reference group for a set-enabled lookup type to indicate which reference data set assignments are available
for its lookup codes. For example a COLORS lookup type might be set-enabled for a Countries reference group that
includes the US and EU reference data set assignments.

Selecting a Reference Data Set for a Set-Enabled Lookup
The reference data set determines which lookup code is included in the list of values. For example, there are two
references data sets - one for the US and the other for EU. If a COLORS lookup type contains RED, YELLOW, ORANGE,
and GREEN lookup codes, you can enable one RED lookup code from the US reference data set and another RED lookup
from the EU reference data, each lookup code having different meanings.

The following table elaborates the example, how these two reference data sets (US and EU) contain one lookup code
that's common, but each differing in its lookup meaning.

Reference Data Set Lookup Code Lookup Meaning

US
 

RED
 

Red
 

US
 

YELLOW
 

Yellow
 

US
 

GREEN
 

Green
 

EU
 

RED
 

Rouge
 

EU ORANGE Orange
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Reference Data Set Lookup Code Lookup Meaning

   

Some lookup codes may be unique to one or another reference data set as the ORANGE lookup is to the EU reference
data set in the example.

In another example in the following table, a lookup type called HOLD_REASON provides a list of reasons for putting a
contract renewal on hold. Reference data sets determine which codes are included in the Hold Reason list of values.

Reference Data Set Lookup Code Lookup Meaning

US
 

SEC
 

SEC Compliance Review
 

US
 

DIR
 

Needs Director's Approval
 

US
 

VP
 

Needs Vice President's Approval
 

CHINA
 

CSRC
 

Pending China Securities Regulatory
Commission Review
 

CHINA
 

PR
 

Needs President's Approval
 

COMMON
 

REQUESTED
 

Customer Request
 

Referring to the example in the table, when end-users place a contract on hold in the US business unit, the three reason
codes in the US set are available. When placing a contract on hold in the China business unit, the two codes in the China
set are available.

Related Topics
• Example of a Standard Lookup

Define Default Reference Data Sets  
Assign a default reference data set to a new business unit. This default set will then be assigned to all the reference data
objects for the business unit, such as such as payables payment terms, and receivables accounting rules.

To assign the default set, select an existing reference data set or create a new one.

Creating Default Reference Data Sets for a Business Unit
Use the Create Business Unit or the Edit Business Units pages to create a reference data set.

The creation of the reference data set for an existing business unit will not impact the actual sets previously assigned
to the business unit. If you want to use the newly created set for your existing business unit use the Manage Set
Assignments task, and assign the set to each reference data object you want to change.
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Note:  You must use the Manage Set Assignments task to assign the set to each specific reference data object that
you want to change. In order to activate the set assignments, you must save the record, even if you have not made
any updates.

Related Topics
• Reference Data Sets

How You Create Reference Data Sets in the Enterprise Structures
Configurator  
If you created business units automatically, then the Enterprise Structures Configurator automatically creates reference
data sets for you. The Enterprise Structures Configurator creates one reference data set for each business unit.

You can add additional sets, but you cannot delete any of the sets that were created automatically. The Enterprise
Structures Configurator creates one reference data set for each business unit. You can add additional sets, but you
cannot delete any of the sets that were created automatically. A standard set called the Enterprise set is predefined.

Common Set
The Common set is a predefined set that enables you to share reference data across business units. When you select
set-enabled data at the transaction level, the list of values includes data in the:

• Common set

• Set associated with the data type for the business unit on the transaction

For example, when you create an assignment, the list of values for grades includes grade in the:

• Common set

• Set that is assigned to grades for the business unit in which you creating the assignment
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9  Territories

Overview of Territory Management Features  
Sales territories form the fundamental infrastructure of sales management because territories define the jurisdiction
that salespeople and channel managers have over accounts, contacts, households, partners, and associated
transactions.

Territories provide the rules for automatically assigning salespeople and other resources to accounts, contacts,
households, partners, leads, and opportunity line items. The structural hierarchy of territories defines resource
responsibilities and controls access to customer and sales data.

Note:  If your salespeople forecast only the opportunities they own and you don't need to assign accounts, leads,
or opportunities to them automatically by address or other criteria, then you can skip implementing territories per
this chapter. Everything you need is in the Forecasting chapter, including a brief territory setup. A process sets up
a territory structure that mirrors your sales organization hierarchy. Opportunities are assigned to the opportunity
owner's territory. The opportunity revenue gets included in the owner's forecast and passed up the management
chain for adjustment and approval.

Summary of Features
Territory Management includes these key features:

• Use territories as the basis for forecasting, quota distribution, compensation, and analysis of sales
performance. Forecasts roll up according to the territory hierarchy.

• Use territories to assign resources and secure access to accounts, contacts, households, partners, leads, and
opportunities.

• Assign channel sales managers to partners and partner transactions within their territories.

• Define territories by logical boundaries called dimensions. Examples of these include address, industry,
product, customer size, sales channel, and organization type.

• Define territories by selecting a list of specific accounts, contacts, households, or partners.

• Model territory realignments and perform what-if analyses to find optimal territory changes.

• Analyze metrics to understand the results of changes to the boundaries of each territory or to understand the
ongoing performance of active territories.

Territory Concepts  

Territory Benefits  
Territories are foundation components that enable many key Sales Force Automation processes. These key capabilities
can improve the overall performance of your sales organization.
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• Model your sales organization hierarchy

• Assign the most effective resources to your accounts and opportunities

• Provide shared data visibility to encourage collaboration and team cross-selling

• Optimize sales coverage and maximize revenue with balanced territories

• Reduce territory administration costs and errors

How You Model Your Sales Organization  
One of the most critical aspects of your implementation is the definition of the sales organization hierarchy and the
assignment of your sales resources within this structure.

This structure represents how your sales force is organized internally and should be aligned with your sales strategy and
how you sell in your marketplace. This structure drives data visibility for your sales users, rolls up the sales forecast, and
aggregates data to measure performance at each level within your sales organization.

• A territory can represent the responsibility of a salesperson such as a set of customers

• A territory can represent the responsibility of a sales manager or executive such as a geographic region, line of
business, product line, customer segment, or sales channel

• A territory can represent the responsibility of a channel account manager, including a specific set of partners
and their respective sales activities

• A territory can represent a branch or a sales office responsible for selling to customers in a specific geographic
region

• A territory can represent the jurisdiction of a channel partner such as authorizing the partner to sell a specific
set of products to a set of customers

You organize territories in a hierarchy. While there is one single global territory structure for your entire enterprise,
each branch of the overall structure represents a different part of the sales organization. The hierarchical relationship
between territories at different levels defines how the data aggregation and visibility are rolled up.

Each territory is associated with one or more sales resources for that territory. Each resource on the territory team may
have a designated function based on the role that team member has in the context of that territory. A resource may be
assigned to multiple territories with the same or different roles.

Financial Company Example
Depending on your specific industry and business model, a territory can be used to model any part of your sales
organization. These examples illustrate different scenarios:

In this example, the International Bank has six lines of business which are business units:Great WesternUK
BankingBusiness BankingPersonal BankingWealth ManagementWholesale BankingThis figure highlights the
Personal Banking business unit and territory coverage:The Brand dimension is Brand 2.The State dimension is New
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South Wales.The Region dimension is Region 2.The Branch dimension within Region 2 contains three branches.

The overall structure shows different lines of business. Within the Personal Banking line of business,
territories are further broken down by brand, geography (state, and then region), and branch. Using
this same example, the Wealth Management line of business is organized differently. The Wealth
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Management line of business defines territories by brand, customer segment, channel, and product.

Automated Territory Assignment  
Instead of manually choosing an owner for each account, lead, or opportunity line, you can use territories to
automatically assign objects to the territory teams. Territories are assigned to objects by matching territory coverage
with the attribute values of the object.
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Territory Coverage
Territory coverage defines the boundary of each territory and describes the business rules by which assignments are
made. You have three types of coverage:

• Dimensional Coverage

This is a combination of dimensions with a list of values for each dimension. A territory dimension is mapped
to an attribute on transactional objects during assignment processing. For example, the adddress dimension
on the territory is mapped to the address of the account or the partner. The following standard dimensions are
provided: address, product, industry, account type, organization type, customer size, and sales channel. Three
additional dimensions are provided for you to configure with customer attributes.

• Inclusion Coverage

This identifies a list of accounts, contacts, households, or partners to be included.

• Exclusion Coverage

This identifies a list of accounts, contacts, households, or partners to be excluded.

You can define territories using a combination of different coverage definitions, thus giving your organization the power
to model complex territories. Here are some examples:

• Steve is a key account director who covers three enterprise accounts, namely ACME Inc, Vision Corporation, and
Pinnacle Technologies.

You define Steve's territory with inclusion coverage of three accounts: ACME Inc, Vision Corporation, and
Pinnacle Technologies.

• Amanda is a territory field salesperson who covers all the high tech accounts in Northern California. In addition,
ABC Technologies, located in southern California, was also assigned to Amanda because she has a prior
relationship with the CFO.

You define Amanda's territory using a dimensional coverage with two dimensions (Address = Northern
California, Industry = High Tech) and an inclusion coverage with one account, ABC Technologies.

Territory Assignment Execution
You can configure when territories are assigned to transactional objects and the frequency the assignment process
should be executed. Territories can be assigned in real time as new transactions are created or when existing
transactions are updated. You can also configure territory assignment to be run as a background process to assign
transactions in batch. This is the recommended approach if you have a large volume of transactions.

During assignment execution, transactional attribute values are matched against territory coverage and all matching
territories are assigned to the object. As an example, on a given opportunity, you can assign multiple territories
composed of the sales team: the account representative, the industry overlay, a product specialist, the channel partner,
and the channel account manager. This enables you to assemble the most effective sales team for each opportunity and
to maximize your chances for closing the deal.
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Territory-Driven Visibility  
After territories are assigned to transactional objects, territory team members gain visibility into these objects through
the territory hierarchy.

In this figure, a salesperson Dave Smith has access to the account because his territory is directly assigned to the
account record. His regional manager and sales director also gain access to the same account because their territories
are ancestors of Dave's territory. By contrast, Regional Manager 2 doesn't have access to the account because her
territory isn't a direct ancestor of Dave's territory.

Combining flexible assignment rules and territory-driven visibility, you gain precise control over data visibility and data
sharing policies. For large enterprise sales organizations with complex sales teams such as the following example,
shared visibility on customer and opportunity data can further facilitate collaboration and team cross-selling. This
figure shows the North America Sales team that includes channels and a sales VP. The sales VP has a Sales Director
managing salespeople, and a Product Overlay group with a product specialist. The Channels division includes channel
representatives. An opportunity is assigned to a channel representative, a product specialist, and a salesperson.
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Territory Administration  
For many sales organizations, territory administration is a task that's performed on a daily basis to account for attrition
or turnover of the sales force.

In addition, major territory realignment resulting from sales reorganization or mergers and acquisitions can often take
weeks, if not months, to implement. Using an intuitive user interface and bulk update capabilities, you can quickly and
efficiently manage territory changes on an ongoing basis. This significantly reduces operational costs and increases
business agility.

Delegated Administration
For large enterprise companies, the responsibility of territory administration is commonly decentralized by lines of
business, divisions, or regions. This can be easily accomplished by adding the regional administrator to the territory
team of the top-level territory corresponding to the scope of delegation. For example, if you add an administrator
to the territory team of the top-level territory for North America Sales, then she can administer all the descendant
territories under North America Sales. However, this administrator has no access to other territories, such as those in
the European region.
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Sales Features Supported by Territories  
You use territories to support other areas in sales.

• Forecasting

Sales Forecasting depends on having territories assigned to product items in opportunities. The forecast is then
submitted and rolled up the management chain using the territory hierarchy.

• Quota Allocation

You can distribute top-down quotas throughout your sales organization using the territory hierarchy. Use
territory coverage and metrics to calculate quotas for sales resources based on current territory potential or
past performance. This helps set more realistic and achievable quotas.

• Intelligent Product Picker

The product list in opportunities or leads automatically applies filters to only show those products that are
defined in the coverage of the salesperson's territory.

• Business Intelligence

Use the territory hierarchy and territory team in reporting and analytics. The territory hierarchy can be a
dimension to aggregate data in building reports and key performance indicators.

Territory Implementation  

Steps to Implement Territories  
When you set up territories, these are the overall steps you follow.:

1. Plan how you want to define the boundaries of your territories. Which dimensions do you need to define the
coverage?

2. Prepare the data you need to define your territory coverage. If you plan to assign accounts directly to each
territory, then you need customer data. A dimension requires data (for example, geography) before you enable
it.

3. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

4. Use the Define Default Proposal Owner task to set this profile option.
5. Start the Enable Dimensions and Metrics task.
6. Click Edit to make changes to existing settings.
7. In the Dimensions region, click Select and Add to add and enable dimensions.
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8. In the Additional Options region, you can choose to enable Territory Precedence.

Included accounts have priority over dimension coverage when assigning accounts to territories with the same
function name. If you don't assign functions to territories, then included accounts have priority over all other
territories. Enabling this option disables metrics, assignment preview, and territory validations.

9. Enable metrics that you want to see when comparing territory proposals.
10. Run Load and Activate to activate all of your settings and perform any data loading required according to your

choices.
11. If you enable Territory Precedence and you want to assign function names to territories, then enter values for

the Territory Function ORA_MOT_TERRITORY_FUNCTION lookup type.
12. Use the Run Territory Proposal Activation task to schedule background processes.
13. Create your hierarchy of territories.

Set the Territory Proposal Profile Option  
The application generates territory proposals, for example when processing territory inheritance. Every proposal must
have an owner. You must provide an owner for generated territory proposals.

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

2. Search for the profile option MOT_DEFAULT_RESOURCE, Proposal Owner Default.
3. Select a resource to be the default owner.
4. Save and close.

Schedule Territory Processes  
You can make changes to many territories at one time using a territory proposal. If you schedule proposals to become
active on certain dates, then you must schedule a background process to run periodically to perform the activation.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Run Territory Proposal Activation

2. To run the process immediately, click Submit.
3. Schedule the Run Territory Proposal Activation process. Click Advanced.
4. Select Run Using a Schedule.
5. For Frequency, select Daily.
6. Select start and end dates and times.
7. Go to the Notification tab.
8. Click Create Notification.
9. Enter the email for the person who should receive notifications.

10. In the Condition field, you should select On Warning and On Error as a minimum.
11. Click Submit.
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Expose the Exclusions Tab and the Enable Forecasting Field  
You can modify the Territory Details UI to add the Exclusions tab and to add the Enable Forecasting field to the
Summary tab. These changes affect the Less Details UI where sales managers can modify active territories without
using a territory proposal.

To add the Exclusions tab to the Territory Details page:

1. Ensure you're working in an active sandbox.
2. From the Navigator, open Application Composer.
3. Select the CRM Cloud application.
4. In Standard Objects, expand Sales Territory.
5. Select Pages.
6. In the Application Pages tab, Details Page Layouts region, select Standard Layout.
7. Click Duplicate.
8. Accept the provided name Default custom layout.
9. Save and close.

10. Click the link to open your new layout.
11. In the Subtabs region, click the Hide, Show, or Reorder Subtabs icon.
12. In the Configure Subtabs dialog, move Exclusions from the Available Subtabs list to the Selected Subtabs list.
13. Click OK.
14. Click Done.

To enable the Enable Forecasting field:

1. Ensure you're working in an active sandbox.
2. Open your Default custom layout for the Details Layout.
3. Click the Summary tab.
4. Click the Edit icon beside the Summary heading.
5. Move the Enable Forecasting field from the Available Fields list to the Selected Fields list.
6. Save and close.

After you complete these procedures, test the changes and publish the sandbox according to your company's business
practices.

Define the Territories UI  
You can determine which UI you see when you first open Territories.

Define the Landing Page
You set profile options to define whether the landing page for territories is the More Details UI or the Less Details UI.

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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2. Search for the profile option code FND_CLASSIC_INTERFACE. This profile option enables access from the
Navigator and springboard to the more details pages when there are more and less detail versions of the same
page. If not set, the default is the less details version.

3. You can set this profile option at the site level or for individual users. Choose one of the following settings:

◦ Yes: The landing page is the more details UI.

◦ No: The landing page is the less details UI.

4. Search for the profile option code MOT_DEFAULT_CLASSIC_INTERFACE. This profile option is also accessed
through the Manage Administrator Profile Values task.

5. Enter one of the following settings for this site-level profile option:

◦ Y: The territories landing page is the More Details UI and users can't access the Less Details UI used to
directly change active territories.

◦ N: The territories landing page is the Less Details UI and users can make changes directly to active
territories. Users can also navigate back and forth between the More Details and the Fewer Details UIs.

Change the Default for the Include Customer Hierarchy Option in
Inclusions and Exclusions  
You can define a territory coverage by selecting individual customer accounts to be included whether or not they match
other coverage criteria.

You can also select customers as exclusions for the territory. They're excluded even though they meet other coverage
criteria. Your selected customer includes all accounts in that customer's hierarchy. You can deselect the Include
Hierarchy check box to not include the hierarchy for that customer. Change the ORA_MOT_INCLUDE_CUST_HIERARCHY
setting to No and the Include Hierarchy check box defaults to deselected.

To change the profile option:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

2. Search for the Include Customer Hierarchy (ORA_MOT_INCLUDE_CUST_HIERARCHY) profile option.
3. Change the site-level profile option to No to show the Include Hierarchy option deselected when you add a

customer inclusion or exclusion. The default value is Yes, which selected the Include Hierarchy option when you
add an inclusion or exclusion.

Copy Extensible Fields from Parent Profile Option  
Fields, including extensible fields for the Sales Territory Resource and Sales Territory objects, are copied to the child
territory from the parent when you create it.

If you don't want the extensible fields to be copied from parent to child, change the profile option
ORA_MOT_COPY_EXT_FIELDS_FROM_PARENT, Copy Extensible Fields from Parent, from Yes to No.
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Configure Prospects for Territory Assignment  
Accounts, households, and contacts are maintained using Manage Customers. Only those accounts, households, and
contacts that are the customer type are assigned to territories by default. But you can change your configuration to
assign prospects or other types as well.

Perform the following steps to prepare prospects:

1. Use Manage Customers to add prospect data or you can import prospect data.
2. You can change a profile option to assign prospects as well as customers to territories. To change the profile

option perform the following steps:

Note:  Only prospects that are part of a customer hierarchy are available for inclusion or exclusion when
defining active territories. Prospects aren't available when defining a draft territory in a proposal.

a. In Setup and Maintenance, go to the Manage Administrator Profile Values task:

- Offering: Sales
- Functional Area: Sales Foundation

b. Search for the profile option ZCA_ASSIGNMENT_ACCT_TYPE_ENABLED, Account Types Enabled for
Assignment

c. Change the profile value to ZCA_CUSTOMER,ZCA_PROSPECT. Make sure you have no space between the two.

Address Dimension  

Enable the Address Dimension  
Use the Address dimension to set up sales territories by a combination of address elements, such as state, city, and
postal code. The application matches your entries using a simple string comparison. You enable the Address dimension
by selecting address attributes.

You can't enable both Geography and Address dimensions.

1. In the Setup and Maintenance work area, use the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. Click Edit.
3. In the Dimensions region, click Select and Add.
4. Select the Address dimension and click OK.
5. In the Address Attributes region, select to make attributes available for defining territory coverage. Country is

required and is selected for you. Postal Code and City are the two that are most often used.
6. From the Actions menu at the page level, select Load and Activate.

When you define a territory, you see your selected address attributes in the Address Coverage region of the Dimensions
tab. Enter your address definition in the correct column. For Canada, E% is an example for all postal codes that start with
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E. You can enter a range of postal codes, a single postal code, or partial postal codes followed by percent like the E%
example. Only postal codes accept a range, like 10001-"20005-9999", or accept the percent sign.

Address Dimension Examples  
When you define territories using address, you need to keep in mind that assignment of territories matches the
characters (ignoring capitalization).

How many different ways do you expect people to enter a state or city name? If it's not in your definition, it won't match.
Each row in your territory address definition is OR criteria. The data within a row are AND conditions.

You can end up with multiple rows to cover different variations of city and state.

City State

St. Louis
 

MO
 

Saint Louis
 

MO
 

St Louis
 

MO
 

St. Louis
 

Missouri
 

Saint Louis
 

Missouri
 

St Louis
 

Missouri
 

It helps to be familiar with your data and any common errors or shortcuts.

The postal code attribute accepts a range, using a hyphen. You can also define a "begins with" using the percent sign
at the end of your value. Place quotes around a 5+4 postal code so the hyphen isn't read as a range. These postal code
definition examples show how the matching works. They aren't necessarily valid postal codes.

Postal Code Defined Matching Address Address Not Matched

94065
 

94065
 

94065-2808
 
94065-
 
94066
 

"94065-2811"
 

94065-2811
 

94065
 
94065-2813
 

94065-94070
 

94065
 

94070-2800
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Postal Code Defined Matching Address Address Not Matched

94065-2808
 
94065-
 

94071
 

"94065-0000"-"94070-9999"
 

94065-0000
 
94065-2808
 
94066
 
94065-4318221
 

94065-
 
94071
 

G1-G9
 

G1
 
G1 7AV
 
G9
 
G10 8AW
 

G90
 
G90 8AW
 

G1 0AA-G99 9ZZ
 

G1 7AU
 
G9 8DD
 
G99 8AW
 
G100
 
G99
 
G10 8AW
 

G1
 

G1 0AA-G9 9ZZ
 

G1 7AU
 
G9 8DD
 
G10
 

G1
 
G99
 
G99 8DD
 

G1%
 

G1
 
G1 7AU
 
G11 8SW
 

G9
 
G99
 

SW1A%
 

SW1A
 
SW1A 6AN
 

SW1
 
SW1W 8BC
 
SW2W 9BC
 

SW1%
 

SW1
 
SW1 6AN
 
SW1W
 

SW2 6AN
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Postal Code Defined Matching Address Address Not Matched

V0A-V9Z
 

V0A
 
V0A 0G9
 
V1A 7B9
 
V9Z
 

V9Z 9D8
 

V0A 0A0-V9Z 9Z9
 

V0A 0G9
 
V1A 7B9
 
V9Z
 
V9Z 9D8
 

V0A
 

Territory Dimensions  

How to Set Up Territory Dimensions  
Dimensions are attributes that define jurisdictional boundaries of territories. For example, you can use the address
dimension to define territories by country or postal code.

Every customer that falls within the defined geography is assigned to the territory and to the resources for that territory.
You assign customers, partners, leads, and opportunity items to the correct territories using dimensions. All dimension
values combine to define the territory boundaries. For example, if Address is set to United States and Customer Size is
set to Large, then the territory is assigned to only large customers within the United States.

Customer and Partner Inclusions
By default, you can define territories by selecting customers or partners to be included in the territory. Customers
and partners are available to select from Customer Data Management for inclusions and exclusions. When a merge
action eliminates duplicate records, one record can be replaced by another. If a customer included in or excluded from a
territory is changed through the merge process, then the new customer record automatically replaces the old record in
the territory.

Dimensions
You must enable dimensions before you can use them to define territories. The dimensions available to assign
customers or partners to a territory are:

• Address

• Account Type
The account type specifies if a customer is a named account or not.

• Customer Size

• Industry
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• Organization Type

• Additional dimensions based on selected classification categories to match specific customer or partner
information

A territory assigned to a customer or partner is also assigned to the corresponding leads and opportunity items. These
dimensions define boundaries specifically for leads and opportunity items:

• Business Unit

• Product

Product groups and products form a hierarchy in the sales catalog.

• Sales Channel

The available sales channels are Direct, Indirect, and Partner.

You must enable each dimension that the sales organization plans to use for automatically assigning territories to
customers, partners, leads, or opportunity items. All dimensions except account type require some preparation before
you enable and use them.

Dimensions You Can Modify
You can modify these dimensions or use them as provided:

• Customer Size

You can change the provided customer sizes within the Organization Size lookup type.

• Industry

The industry hierarchy is from the customer classification module. When you enable the Industry dimension
in Enable Dimensions and Metrics, you must also select the classification category that you want to use. The
available selections include only classification categories belonging to the Industrial Categories grouping. Your
selection modifies the profile option Industry Classification Category.

You can assign primary and nonprimary industry values to accounts. When an account is assigned multiple
classification values, for the purposes of territory and rule-based assignment, the assignment engine can use
all of the values or only the primary account classification. Opportunity assignment also supports multiple
classification values. For more information about assigning accounts using industry classification codes, see
the white paper, Industry Classification and Opportunity Assignment (document ID 2086014.1) available on My
Oracle Support.

• Organization Type

To change the available organization types, edit the Organization Type category using the Manage
Classification Categories task in the Setup and Maintenance work area, Sales offering, Territories functional
area. You can assign primary and nonprimary organization type values to accounts. When an account is
assigned multiple classification values, for the purposes of territory and rule-based assignment, the assignment
engine can use all of the values or only the primary account classification. Opportunity assignment also
supports multiple classification values. For more information about assigning accounts using industry
classification codes, see the white paper, Industry Classification and Opportunity Assignment (document ID
2086014.1) available on My Oracle Support.

• Sales Channel

You can add additional channels under the Partner sales channel.
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Dimensions Requiring Preparation
See related topics to find out how to prepare the following dimensions:

• Business Unit

• Address

• Product

• Auxiliary Dimensions

Related Topics
• Prepare the Product Dimension

• Define Auxiliary Dimensions

Synchronize Territory Dimension Members  
When you define territories, you can select dimension members provided by source data that can change, such as
lookup codes or classification values. You must reload the data to keep it current.

These dimensions can become out of date due to source data changes:

• Industry

• Customer Size

• Organization Type

• Product

• Sales Channel

• Business Unit

• Auxiliary 1, 2, or 3

If, for example, you know there are changes in the classification category used for the Organization Type dimension, you
must load them and activate them.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. Go to Actions > Load and Activate.
An alternative is to use the Territories functional area task Run Territory Dimension Synchronization to load and
activate changes in dimension members.

Prepare the Product Dimension  
The Product dimension captures leads and opportunity line items to assign them to territories. You create a hierarchy of
products and product groups in the sales catalog before enabling the Product dimension.
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Salespeople can select the products or product groups when creating leads or opportunities. When you include a
product group in a territory coverage, the territory then captures leads and opportunity line items containing a product
within the hierarchy of the selected product group.

Tip:  A good practice is to initially set up your sales catalog using product groups, and then add individual products or
inventory items if needed.

1. Create your hierarchy of product groups and products, following the instructions in the Sales Catalogs chapter.
2. Publish your sales catalog.
3. Use the Manage Product Group Usage task in the Sales Catalog and Products functional area to add your root

product group as the Base usage.
4. Go to the Enable Dimensions and Metrics task in the Territories functional area.
5. Add Product to the enabled dimensions.
6. Click Load and Activate to start the background process. The process loads the sales catalog data to become

dimension members available for selection when defining territories. The process also loads dimension
member data for other enabled dimensions.

7. When changes occur in the sales catalog, you must again run the Load and Activate process to update the
Product territory dimension member data. You can perform the maintenance task Run Territory Dimension
Synchronization to schedule the Load and Activate process.

8. A good practice is to run full reassignment processes for leads and opportunities after updating Product
dimension members in the previous step.

Related Topics
• Sales Catalog High-Level Setup Steps

Dimension Parameters  
Use parameters to refine the definition of each dimension so it best fits business requirements.

Three dimensions use parameters:

• Industry

• Time

• Product

Industry
Use the parameter to set the number of levels in the industry hierarchy that display in the dimension member selection
screen.

Time
Set the start of the time period used in calculating metrics using the Calendar Start parameter. Set the number of years
prior to today's date when the calendar starts for metrics.

Product
Use the parameter to set the number of levels in the product hierarchy that display in the dimension member selection
screen.
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Define Custom Dimensions  
You can define up to ten custom dimensions that will match with customer attributes. The custom dimensions can be
used with account, opportunity, lead, deal, or partner objects.

A limited set of sales account or opportunity/revenue standard fields, such as the line of business or revenue type
category, are available to use with custom dimensions. For leads, deals, or partners, any standard or custom field, for
example a custom field Branch or Sales Market, can be used with custom dimensions Your custom dimensions can be
viewed and managed in active territories, territory proposals, REST services, and export/import management.

1. Define a standard lookup to become the source for dimension members for the custom dimension.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

3. Add a custom dimension and rename the dimension to reflect the business purpose for this dimension.
4. Select the correct lookup type that you created.
5. Load and activate your enabled dimensions.

What to do next

Add a field for assignment and map your new custom dimension for territory assignment to accounts, partners, revenue
lines, leads, or deals.

Related Topics
• Custom Dimensions for Revenue Assignment Example

• Custom Dimensions for Lead Assignment Example

Add an Attribute for Revenue Assignment  
Add one or more lookup fields for territory assignment to revenue lines.

You can add one or more of the following for territory assignment to revenue lines:

• A standard opportunity or revenue lookup field

• A custom opportunity or revenue lookup field

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Objects

2. Select Revenue.
3. On the Attributes tab, click Add Row.
4. Select the lookup field you want to use, such as Line of Business or Revenue Type Category.
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5. Save and publish.

What to do next
Add an assignment mapping to use this attribute as a custom dimension.

Add a Revenue Assignment Mapping  
Map your new custom dimension for territory assignment to revenue lines.

Before you start
You created a lookup that provides values for the custom dimension. You added the lookup field as an attribute for
revenue assignment.

Here's what to do

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Objects

2. Select Revenue.
3. In the Candidates tab, select Territory.
4. In the Revenue Territory: Revenue Sets tab, select the Sales Account mapping set.
5. In the Mappings table, click Create.
6. Select or enter values for these fields:

Type Attribute

Exact Match Select

Function Code Enter the appropriate dimension code, such as Ext1

Candidate Object Territory

Work Object Revenue

Candidate Object Attribute: Low Dimension Member ID

Work Object Attribute: Low Select the appropriate field, such as Line of Business

7. Click OK.
8. Save and publish.

Add an Attribute for Lead Assignment  
Add one or more lead lookup fields or custom child object fields for territory assignment to leads.

You can add one or more of the following for territory assignment to leads:

• A standard lead lookup field
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• A custom lead lookup field

• A lead custom child object field

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. Select Sales Lead.
3. On the Attributes tab, click Add Row.
4. Select the standard or custom lookup field you want to use, such as Branch or Sales Market.
5. Save and publish.

What to do next
Add an assignment mapping to use this attribute as a custom dimension.

Add a Lead Assignment Mapping  
Map your new custom dimension for territory assignment to leads.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Leads Assignment Objects

2. Select Sales Leads.
3. In the Candidates tab, select Sales Lead Territory.
4. In the Sales Lead Territory: Mapping Sets tab, select Mapping Set 1.
5. In the Mappings table, click Create.
6. Select or enter values for these fields:

Type Attribute

Exact Match Select

Function Code Enter the appropriate dimension code, such as Ext1

Candidate Object Territory

Work Object Sales Lead

Candidate Object Attribute: Low Dimension Member ID

Work Object Attribute: Low Select the appropriate field, such as Branch or Sales
Market

7. Click OK.
8. Repeat steps 5-7 for each mapping set.
9. Save and publish.
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Custom Dimensions for Revenue Assignment Example  
This example models sales organizations where salespeople are responsible for either new sales or renewal and
expansion sales.

The use case is to define territories with the custom dimension Revenue Type Category in addition to account, product,
and sales channel dimensions.

1. Use Manage Standard Lookups to create the lookup type ORA_MOO_REVN_CATEGORY_TYPE with the lookup codes
New, Renew, and Expansion.

2. Use Application Composer to add the Revenue Tpe Category field to Revenue Table columns in the Opportunity
Details page.

3. In Setup and Maintenance, open the Enable Dimensions and Metrics task. select the Edit action, and add the
Extension 2 dimension.

4. For the dimension source find and select the lookup type ORA_MOO_REVN_CATEGORY_TYPE.
5. Save and close.
6. Perform the Load and Activate action. Use the Refresh Status action to monitor processing and completion of the

processes.
7. In Setup and Maintenance, use the Manage Sales Assignment Manager Objects task and add a mapping for the

Revenue object.
8. In the Attributes tab add the Revenue Type Category attribute.
9. In the Candidates tab select Territory and the Territory: Mapping Sets tab.
10.Select the Sales Account mapping set.
11. Click Add and enter these values:

Type Attribute

Exact Match Select

Function Code Ext2

Candidate Object Territory

Work Object Revenue

Candidate Object Attribute: Low Dimension Member ID

Work Object Attribute: Null Value Handling Derive mapping value

Work Object Attribute: Low Revenue Type Category

12. Save and publish.

Results:
Now you can define territories with a Revenue Type Category coverage, and use this information when assigning
territories to revenue lines.
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Custom Dimensions for Lead Assignment Example  
This example sets up the Branch custom dimension for lead assignment.

The use case is to define territories with the Branch custom dimension in addition to the account and product
dimensions.

1. In Application Composer, create a fixed choice list called Branch for the Lead standard object..
2. In the List of Values region, create a new lookup type MKT_LEAD_BRANCH called Branch, and add lookup codes for

each of the company branches.
3. Add the Branch field to the Lead Detail page and publish.
4. In Setup and Maintenance, open the Enable Dimensions and Metrics task, select the Edit action, and the Extension 3

dimension.
5. For the dimension source find and select the lookup type MKT_LEAD_BRANCH. Save and close.
6. Perform the Load and Activate action. Use the Refresh Status action to monitor processing and completion of the

processes.
7. In Setup and Maintenance, use the Manage Sales Assignment Manager Objects task and add a mapping for the

Sales Lead object.
8. In the Attributes tab add the Branch attribute.
9. In the Candidates tab select Territory and the Sales Lead Territory: Mapping Sets tab.
10.Select Mapping Set 1.
11. Click Add and enter these values:

Type Attribute

Exact Match Select

Function Code Ext3

Candidate Object Sales Lead Territory

Work Object Sales Lead

Candidate Object Attribute: Low Dimension Member ID

Work Object Attribute: Null Value Handling Derive mapping value

Work Object Attribute: Low Branch

12. Save and publish.

Results:
Now you can define territories with a Branch coverage, and use this information when assigning territories to leads.

Define Auxiliary Dimensions  
You can define up to three auxiliary dimensions that will match with customer attributes.

Watch video
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Defining Auxiliary Dimension 1, 2, or 3
You can define up to three customer auxiliary dimensions based on the customer classification model. Define
classification categories first and associate them to the Customer Categories grouping.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Manage Classification Categories

2. Create a new classification category. You can allow parent code assignment. If you allow multiple class code
assignments, then the classification that's designated as Primary in the customer record is the one that's
matched to assign the customer to a territory.

3. Add classification codes for the new category. You can form a hierarchy with the codes or not.
4. Use the Manage Classification Groups task and search for the CUSTOMER_GROUP category group code. Edit

the group and add your new classification category to the group.
5. Add an auxiliary customer dimension in Enable Dimensions and Metrics and select the correct classification

category that you created. Then this classification category becomes the source for dimension members for the
auxiliary dimension.

6. Load and activate your newly enabled dimensions.

Setting Assignment Mapping
Map your new dimension for territory assignment to accounts.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Task: Manage Customer Center Assignment Objects

2. Select Account.
3. Click the Candidates tab.
4. Select Account Territory.
5. Click the Account Territory: Mapping Sets tab.
6. Select Mapping Set 1.
7. Find the auxiliary dimension you want to use, such as Auxiliary Dimension 1.
8. Click Edit.
9. Deselect Inactive.

10. Click OK.
11. Click Save and Publish.
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Territory Hierarchy  

Sales Territory UIs for Different Uses  
You have the option of using multiple UIs to manage sales territories. You can make changes to territory coverage and
other adjustments in Workspace and in the Territories work area. For creating territory hierarchies, you must use the
Territories work area.

The Territories work area includes a full-featured UI that's designed for setting up the territory hierarchy and a simpler
UI that you can use for ongoing minor adjustments to territories after they're set up. Users can toggle between the two
UIs by clicking the Territories and Sales Territories Hierarchy tabs on the left side of the Territories work area or in
Workspace.

Territories Tab for Making Changes
When you open the Territories work area, the application displays the Territories tab. The tab is optimized for sales
managers who want to make simple changes to individual territories, such as changing territory owners or minor
tweaks in coverage.
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Sales Territories Hierarchy Tab for Building Your Sales Territory Hierarchy
To build sales territory hierarchies, you use the Sales Territory Hierarchies tab. On the Sales Territories Hierarchy tab,
territory setup is done not on live territories, but in a proposal that you must activate after your setup is complete.
Proposals make it possible to make territory revisions without affecting live territories and to create different versions to
be used at different times.

Here's a screenshot of the Active Territories page on the tab. The callouts highlight and describe different features on
the page.

Callout Number Feature Description

1
 

The left pane of the Active Territories page displays the active territories as a collapsible hierarchy.
 

2
 

Selecting a territory, displays territory details at the bottom of the page.
 

3
 

Using the Manage Proposals button, you can create territory proposals with your territory changes.
 

4
 

The Show Dimensions,Hide Dimensions button lets you toggle the display of dimension details in the
list of active territories.
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Differences Between the Two UIs
Here are the major differences between what you can do in the two UIs. Whichever UI you're using to make your
territory changes, your records aren't reassigned until the appropriate assignment process runs.

Feature Sales Territory Hierarchies Tab Territories Tab

Changing a territory owner or member
 

Your changes aren't effective until you activate
the proposal.
 

Your changes take effect immediately.
 

Making changes without immediately effecting
live territories
 

You create territories in a territory proposal
that isolates your changes from existing active
territories until you activate. You can even
decide to create different proposals to go live
in the future, to account for seasonal sales
demands, for example.
 

Territory proposals aren't available. Changes
you make to territories are immediate.
 

Inheriting the properties of parent territories
 

When you create child territories in both UIs,
 the child territories automatically inherit
the properties and coverage of the parent

At creation, the child territories automatically
inherit the properties and coverage of the
parent territories. However, in the Territories
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Feature Sales Territory Hierarchies Tab Territories Tab

territories. In the Sales Territory Hierarchies
Tab, you can also link territories so that any
subsequent change in coverage for the parent
territory is automatically reflected in the linked
territory.
 

tab UI, you can't link the territories to make
subsequent coverage changes reflected
automatically.
 

How You Can Make the Sales Territory Hierarchies UI the Default and Only UI
By default, users can toggle between both UIs using the tabs. You can make the Sales Territory Hiearchies UI the default
UI and remove the tab controls. To change the defaults, all you have to do is set the system profile option Default to
Territory Classic Interface (MOT_DEFAULT_CLASSIC_INTERFACE) to Yes. The setting, which is made at the site level,
affects all users. You can edit the system profile value option from the Setup and Maintenance work area using the
following:

• Offering: Sales

• Functional Area: Sales Foundation

• Task: Manage Administrator Profile Values

Use Workspace for Resolving Territory Gaps and Overlap Issues
Managers who need to resolve territory gaps and overlap issues in existing territories, can also use Workspace. Both
Workspace and the Territories work area let you search for territories not only by salespeople but also by dimension
coverage details, such as included accounts, products, or geographies. The territories features in Workspace are the
same as in the Territories tab in the Territories work area. What Workspace doesn't have is the ability to create and
manage hierarchies. For that you must go to the Territories work area.
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Work with Active Territories in Workspace  
Use Workspace to create and make changes to your active territory hierarchy. If you prefer to use proposals to change
multiple territories, go to the Sales Territories Hierarchy tab.

Search and filter your list to begin working. When you open and edit a territory from your list, the Next button opens
the next territory to edit. If enabled and you have the correct privileges, you can work in nested tabs to navigate across
and between territory records without losing context. Use dynamic tabs and nested tabs to resolve territory gaps and
overlaps. Manage customer-centric territories in Workspace. Use other methods for partner-centric, resource-centric,
and inheritance recipient territories.

You can search by territory details and coverage attributes. Here are some coverage search tips.

• The industry, organization type, product group, and auxiliary 1-3 dimensions are hierarchical. A search for
descendant member values finds only territories defined explicitly with the descendant value. For example, to
search for territories which cover the product group Laptop X, but not its parent Hardware, Laptop X must be
present in the territory coverage.

• To search for territories using customer inclusions or exclusions, use the Coverage: Account: Name filter.

• Accounts are hierarchical. To search for territories based on a descendant account, the account must be
explicitly selected in the territory coverage. For example, to search for territories which include Account ABC
USA, this account, and not the parent ABC Global must be present in the territory coverage.

• Accounts are hierarchical. To search for territories based on a descendant account, the account must be
explicitly selected in the territory coverage. For example, to search for territories which include Account "ABC
USA", this account, and not the parent "ABC Global" must be present in the territory coverage.

• When you use dimension filters to search, you can use only one dimension filter. Here are some exceptions:

◦ You can use the coverage type filter together with a dimension filter.

◦ Multiple address dimension filters can be used together. For example: Coverage: Country and Coverage:
Postal Code

◦ The Coverage: Sales Channel and coverage: Sales Subchannel filters can be used together.

• For most dimension filters the search finds all territories with a regular dimension coverage or an inclusion or
exclusion coverage matching the value.

• You can't search using these coverage fields:

◦ Include Hierarchy: This indicates that the account plus its hierarchy is included or excluded from the
territory coverage.

◦ Coverage: Partner: This field represents the partner accounts that are included or excluded in the territory
coverage.

Related Topics
• Adaptive Search Configuration Provided by Oracle

• How can I enable territory dynamic tabs and nested dynamic tabs in Workspace?

• Switch to Work Areas Powered by Adaptive Search

• Enable Business Objects for Adaptive Search

• Get Started with Search in Workspace and Work Areas

• Use Dynamic Tabs and Nested Dynamic Tabs
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Territory Proposals  
Use territories to assign teams to leads, opportunity items, and customers. You model and explore territory definitions
with a territory proposal without affecting active territories. Activate a proposal to update the existing territory
definitions.

Typical Territory Proposal Workflow
This table shows a typical workflow for territory proposals.

Task Description

Create a proposal
 

Create the proposal and set an activation date.
 

Add a territory to the proposal
 

Add an existing territory to the proposal, or create a new territory. Repeat for additional territories.
 

Define coverage
 

Select attributes to define the boundaries of each territory.
 

Select the territory team
 

Every territory must have an owner and can have additional team members.
 

Analyze and compare proposals
 

Review metrics and graphs to analyze proposals for such things as number of customers and amount
of closed opportunity revenue in each territory.
 

Activate the proposal
 

Activate a proposal. The proposal remains in pending activation status until the activation date is
reached. You can reopen and update the proposal until then.
 

Run reassignment processes
 

Reassignment processes are scheduled to run periodically.
 

Related Topics
• Territory Coverage

• Territory Proposal Statuses

• Territory Proposal Rules

Create the Territory Hierarchy Using Proposals  
You create one territory hierarchy starting with a single top territory. Create more than one what-if proposal to compare
and decide which is the most equitable.
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Create a Proposal
Use the territory proposal to create many territories at one time.

1. In Workspace, click the Sales Territories Hierarchy tab.
2. Click the Manage Proposals button on the Active Territories page.
3. In the Current Territory Proposals region, click Create (the plus sign icon).
4. Enter a name for the proposal.
5. Leave the Activation Date field blank. This will cause the proposal to be activated immediately after you build

your territories.
6. Click Save and View.

Your territory proposal opens and you can start building your territory hierarchy.

Create the Master Catchall as the Top of the Hierarchy
Use this procedure to create the territory at the top of the sales territory hierarchy as the master catchall territory.
Because the top territory is usually owned by a senior manager or executive and you don't want executives
troubleshooting territory assignment, you must add a sales administrator, or another resource who does the
troubleshooting, as a territory team member.

1. In the Territories region of your territory proposal, click Create.
2. Enter the territory name.
3. Enter the resource who's the owner of the top territory"

a. From the Owner list, select Search.
b. Search for the resource name using any of the criteria.
c. Select the name and click OK.

The owner appears on the Territory Team tab. You can add additional members to the team, and the owner
himself can add members later.

4. From the territory Type list, select Prime.
5. From the Enable Forecasting list, select Prime only unless you're creating forecasts for overlay territories. This

setting enables the territory to be used for forecasting.
6. Add the sales administrator to this territory:

a. In the Territory Team tab in the Additional Information region, click Select and Add.
b. Search for the resource using any of the fields.
c. Select the resource from the search results and click OK.

7. Click Save and Close.
Your new territory appears in the Territories table of your proposal.

8. With the territory selected in the Territories table, click the Coverage tab in the Details region at the bottom of
the page.
Every enabled dimension is represented by a column, and each column displays the value of Any. This is the
setting you want for your master catchall territory. You're now ready to add the rest of the territory hierarchy.

Add the Rest of the Hierarchy
Add the rest of the sales territory hierarchy from the top down.

1. In the Manage Territory Proposals page, select the name of your proposal to open it for editing.
2. Select the parent territory in the Territories table.
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3. Click Create Child of Selected Territory (the plus sign icon).
4. In the Create Territory page, enter the territory name.
5. Enter the owner for the territory.
6. Your new territory duplicates the definition from the parent. You can make changes.

a. Select the territory type, either Prime or Overlay.
b. If Territory Precedence is enabled, you can select a territory function. Assignment compares all territories

with the same function and gives precedence to the territories with included accounts.
c. From the Enable Forecasting list, select Prime, Overlay, or Prime and Overlay, depending on the

territory you're setting up. For managers of both prime and overlay territories, select Prime and Overlay
so that the managers can adjust forecasts of all their subordinates. Select Disabled to remove the
territory from forecasting.

7. Click Save and Close.
You're returned to the Territory Proposal window. You're now ready to specify the coverage for the territory.

You can copy an existing territory to create a territory at the same level in the hierarchy. No child territories are copied..

1. Select the territory you want to copy.
2. Click Copy territory as a peer with no children.
3. Enter a name for the new territory.
4. The territory definition is copied from the parent territory of the selected territory. This includes the summary

and additional information, including owner. territory type, and the team. Make changes as needed.
5. Save and close.
6. Review the coverage for your new territory. The dimensions, inclusions, and exclusions match the parent

territory. To make changes, follow the steps in the next section.

Define the Territory Coverage
When you create a child territory, it automatically inherits the coverage of its parent, including dimensions, inclusions,
and exclusions. You can use a territory that has no coverage definitions as a parent to create a new territory with a clean
slate.

1. In the Manage Territory Proposals page, select the name of your proposal.
2. In the Territories table, select the territory you want to change.
3. Click the Coverage tab in the Details region of the page. Coverage can include Address, Dimensions, Included

Customers, and Excluded Customers.
4. If a region has no coverage, then click Add in the Actions menu. Otherwise, click Edit (the pencil icon) to make

changes.
5. For dimensions, either Add or Edit opens Edit Coverage:

a. Select the dimension from the Dimensions list.
b. Add or remove dimension members from the Selected Dimension Members box.

Tip:  If the Product dimension doesn't show the correct list of products from the sales catalog, then
navigate to the Scheduled Processes work area and run the Refresh Denormalized Product Catalog
Table for BI process. The wrong products can show up in rare cases where you have changed the root of
your sales catalog.

c. Save and close.
6. To include specified customers:

a. Click Select and Add.
b. Search for and select a customer.

170



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 9
Territories

c. You can click Save and Apply to search for and select another.
d. Click Save and Close.

7. To exclude specified customers, repeat step 7 in the Excluded Customers region.

Activate a Territory Proposal  
When you finish making changes to your territories, use this procedure to activate your territory proposal and start
using the new territories for assignment.

1. Click Navigator > Territories.
2. Select the Sales Territories Hierarchy tab.
3. In the Active Territories page, click the Manage Proposals button.
4. If the proposal you want to activate doesn't appear in the Current Territory Proposals table, select All Proposals

from the Proposals list.
5. Select the proposal and click Activate.

You can see the activation process status in the Details region of your proposal.
6. Click Done to return to Manage Proposals.
7. Click Done to return to the Overview page. Your territory changes now appear in the list of active territories.

Create the Territory Hierarchy One Territory at a Time  
You can build your active territory hierarchy starting by creating the one top territory. You then add one child territory at
a time to a parent territory. When you save a new territory, it immediately becomes active.

To create the top territory:

1. Navigate to Territories. There are no territories listed on the page.
2. Click Create Territory.
3. Enter the territory name.
4. Select an owner for the top territory, most likely the VP of Sales.

The owner appears on the Team Members tab. You can add additional members to the team, and the owner
himself can add members later.

5. From the territory Type list, select Prime and Overlay.
When you select Prime and Overlay, descendant territories can be Prime Only, Overlay Only, or both.

6. From the Enable Forecasting list, select Prime only unless you're creating forecasts for overlay territories. This
setting enables the territory to be used for forecasting. Your administrator enables the Enable Forecasting field
using Application Composer, otherwise it's hidden.

7. Click Save and Continue.
8. Click the Dimensions tab.

All enabled dimensions have Any for the coverage. This is correct for your top territory.
9. Save and close.

Add child territories. The child territory copies the parent territory information such as territory type, dimensions, and
account inclusions. You then make changes as needed.

1. Select from your territories list the territory that will be the parent to your new territory.
2. Go to the Child Territories tab.
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3. Click Create Territory.
4. Enter the territory name.
5. Select a different owner for the territory if needed.
6. Change the territory type, if needed.
7. If Territory Precedence is enabled, then you can select a territory function. Assignment compares all territories

with the same function and gives precedence to the territories containing included accounts.
8. Click Save and Close to keep the definitions that match the parent. You then return to the Child Territories tab

for the parent territory. Click Save and Continue to stay on the Summary tab for your new territory.
9. In the Dimensions tab, you have several choices in the Edit list, depending on your enabled dimensions and the

coverage from the parent.

◦ Edit Address Coverage

◦ Clear Address Coverage

◦ Edit Dimensions and Coverage

Select a dimension and move the values you want to the Selected column. Or click Add Members in Bulk
and enter several members or ranges of members separated by commas.

◦ Remove All

10. To add accounts, select the Inclusions tab.
11. Click Add Customers and select Accounts.
12. Use the Exclusions tab to select customers to be excluded from the territory. (Use Application Composer to

enable the Exclusions tab.)
13. Use the Team Members tab add and remove team members and designate the territory owner.
14. When you complete making all changes, click Save and Close.

Your new territory is now active.
If Click to Edit is enabled, you can make changes to information such as territory owner on the workspace list page. Click
a row to see the fields you can edit. Make your changes, then click Save or Discard Changes.

Territory Proposal Statuses  
A territory proposal contains definitions for territories. It progresses through different statuses in its life cycle.

This table describes proposal statuses.

Status Description

Draft
 

The proposal is first created, and different users can participate to make changes to their child
territories.
 

Pending Activation
 

The owner requests that the proposal be activated. The proposal is in pending activation status until
the activation date.
 

Activated
 

After the owner requested activation and the activation date is reached the proposal is activated and
the territories become active.
 

Failed Any changes introduced to territories as part of this proposal aren't made.
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Status Description

  

Territory Proposal Rules  
Use territory proposals to explore and evaluate new territory definitions.

Keep these rules in mind:

• Only one definition for a territory can be active at a time.

• You can freely create, edit, and delete territories within a proposal without affecting active territory definitions.

• A territory owner can update a proposal with changes to a subordinate's territory.

• If a given territory is updated in two different proposals, and both of them get activated, the changes of the
proposal that's latest to get activated will override the changes in the other proposal. A territory that's added to
territory proposal A, but then deleted from proposal B which gets activated first, is reinstated when proposal A
is activated.

• If a proposal contains territories added to a parent territory that's now deleted, the new territories are deleted
during proposal activation.

• A maximum of 500 territories can be children of the same parent territory.

Examples of Using Analytics to Test Territory Proposals  
View graphs on the Analytics tab to compare your proposed territory changes to existing active territories to determine
if your proposal achieves the goals you set. Will the new territories be more equitable and productive?

Also, evaluate territory changes in multiple proposals, or see the results of territory changes made within a single
proposal.

Scenario
You want to see how much the number of customers changed between the proposed territory version with new
geographic boundaries and the active version. You select the territory and choose the Number of Customers metric for
the current quarter and Version Comparison, Active Version Comparison. You see significantly more customers in your
proposed territory.

Next you compare all child territories of the selected territory and see that only one child has a significant change in the
number of customers and you determine that you need to realign the child territories.
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Territory Coverage  

Territory Coverage  
A territory defines who will sell what to whom. You define territory boundaries using dimensions and criteria, not by
creating rules.

Use these to define a coverage area:

• Dimensions

Values that define what to include in the territory using categories such as address, product, and industry

• Inclusion Criteria

A list of specific customers or partners, whether or not they meet the dimensional definition. These customers
don't have to be designated as named accounts.

◦ Customer Hierarchy: You can choose to include the customer hierarchy for the selected customer. All
customers for the selected customer hierarchy will be assigned to the territory.

◦ Filtering Conditions: Defined dimensions apply to the included customers and their hierarchies so that
only customers that match the dimension definitions get assigned to the territory.

◦ Other Dimensions: Product or sales channel dimensions defined for all of the included customers or
partners.

• Exclusion Criteria

A list of specific excluded customers or partners to be omitted from the territory whether or not they meet
dimension definitions. These customers don't have to be designated as named accounts to be excluded. You
can choose to also exclude the customer hierarchy for the selected customer.

• Overrides: A way to override what's inherited from a source territory.

• Resource-Centric Coverage

The resource-centric territory hierarchy is generated from your resource hierarchy when you enable forecasts
using the quick setup. The Refresh Territories from Resources process synchronizes your territories periodically
to match your latest resource hierarchy. The resources become the territory owners.

Note:  Before you run Refresh Territories from Resources, you must have at least one dimension enabled
using the Enable Dimensions and Metrics task and perform the Load and Activate action.

Note:   We recommend full reassignment to be scheduled for each object. The frequency of this schedule can be
different from one object to another, depending on requirements.

Territory Coverage for Partners
A partner is an organization party with a partner profile associated and an assigned Partner usage. Partners are defined
in the Partner Center.
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Similar to direct sales, channel managers have corresponding sales territories pertaining to partner sales activities.
Some channel managers are assigned to specific partners. Some channel managers are assigned to customers for sales
activities that involve partners. Channel manager territories can be defined by the following coverage models.

• Coverage Defined by End Customer Characteristics (Customer-Centric)

Define the coverage using the characteristics of the end customer, and specific inclusions and exclusions. As
an example, a channel manager is assigned to cover all the indirect opportunities where the end customer is
located in California.

• Coverage Defined by Partner Characteristics (Partner-Centric)

Coverage is defined using the following attributes of a partner organization:

◦ Primary geographical location of the partner

◦ Organization Type of the partner (for example, private, public, government owned, nonprofit)

◦ Industries served by the partner (for example, high tech, manufacturing, banking, pharmaceutical)

◦ Size of the partner

◦ Three auxiliary dimensions are available for partners based on the customer categories classification
model

• Individually Selected Partners

Select partners to directly assign to or exclude from a partner-centric territory. As an example, a channel
manager is assigned to a partner named AA Solutions. This channel manager will be assigned to all indirect
opportunities where AA Solutions is the partner. The opportunities for included partners can be additionally
qualified by product and sales channel.

Territories with No Coverage
You can create a territory that has no coverage by clicking Remove All under Edit on the Dimensions tab. The
dimensions have a blank coverage, rather than the value Any. The territory is indirectly defined by the coverage of its
descendant territories. You can assign quota to the territory and it can participate in forecasting. The territory can't
be automatically assigned to customers, leads, and opportunities, but you can see the assignments of its descendant
territories. You can also assign the territory to an opportunity item manually.

Precedence During Assignment
When you include a customer in the coverage for a territory, that customer is also assigned to any territory with
matching dimension coverage. If you don't want the customer to be assigned to both, then one solution is to add
the customer as an exclusion from the second territory. Another solution is to enable territory precedence so that
assignment automatically assigns the customer only to the territory with the inclusion coverage.

You can limit the automatic exclusion to the territories identified as belonging to the same group. For example, a
primary salesperson Z has exclusive ownership of ABC Corporation, in Arizona. However, your product specialist team
should also be assigned to ABC Corporation using dimension definitions. Use the Territory Function field to identify
each territory with a function to group them.

Here are the territories and their definitions::

• The primary salesperson A's territory is defined with the Primary function.

• The coverage for A's territory is defined by address, including Arizona.

• The primary salesperson Z's territory is identified with the Primary function.
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• The coverage for Z's territory contains ABC Corporation in Inclusions.

• The product specialist's territory is identified with the Technical Specialist function.

• The product specialist's territory is defined by address, including Arizona.

Here are the results of the assignment:

• ABC Corporation belongs to primary salesperson Z because the account inclusion takes precedence.

• ABC Corporation isn't assigned to Salesperson A's primary territory because the inclusion territory takes
precedence over the territory defined by address.

• ABC Corporation is assigned to a Technical Specialist territory that covers Arizona.

Related Topics
• Examples of Territory Coverage

• Inheritance Territories

• Expose the Exclusions Tab and the Enable Forecasting Field

Examples of Territory Coverage  
A territory coverage is a set of boundaries that define what's included or excluded in the territory and what can be sold.
Dimensional coverage consists of the combination of one or more territory dimensions.

You can select individual customers (with or without a hierarchy) or partners to include or exclude from the territory in
spite of dimension selections. These scenarios illustrate using different coverage.

Address Territories with Customer Inclusion and Exclusion
Two salespeople cover all customers in separate areas, Texas and California. Tom owns the Texas territory, and Sue has
California. Sue has a special relationship with the A1 customer located in Texas. The solution is to add A1 as a customer
inclusion to Sue's territory and as a customer exclusion in Tom's territory.

This figure shows Sue's and Tom's territories. 

Define Individual Customers Only
Salespeople sell to ten to twenty individually assigned customers. You don't define a dimensional coverage, but
manually assign the customers as inclusions.

Key Accounts with Subsidiaries
A Key Account Director is responsible for a few strategic accounts (named accounts) and all subsidiaries of the strategic
accounts. You select each strategic account as an included customer, and choose to also include the hierarchy for each.
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Forecasting Using a Parent Territory
Create a parent territory with no coverage except the coverage of its children. You can designate each child territory as
Forecast not visible to territory owner, and then perform all your forecasting activities for the child territories using the
parent territory.

Parent Territory with No Coverage
The territories for your sales managers don't require boundary definitions separate from the territory definitions of their
salespeople. Create a parent territory with no defined coverage for the manager. The managers can view and update the
territories for their groups, have access to their transactions, and can forecast sales for the group.

This figure shows the manager's territory with no defined coverage as the parent territory of three
salespeople's territories. The salespeople's territories are defined by address and selected customers.

Related Topics
• Examples of Using Dimensional Coverage

• Examples of Dimensional Territories

Inheritance Territories  
Sometimes organizations (for example, an industry overlay organization) shadow the prime sales organization.
Inheritance territories offer an approach for simplifying the administration of territories for these shadow organizations.
Inheritance territories consist of a source territory and one or more recipient territories.

A shadow (recipient) territory is linked to the prime territory with the source territory information. The inheritance
territory feature is only available in the More Details pages, where changes to territories are managed using a proposal.

One additional benefit of defining inheritance territories, is that the administrator can override the territory dimensions
on the recipient territory. Customer or partner inclusions and exclusions can also be inherited. The source and recipient
territories can have different territory owners and can be placed in different hierarchies.

Example
Here's an example of a prime salesperson and a shadow industry salesperson. Jane owns the Northern California
territory and is responsible for selling all products to all customers located in Northern California. The source territory,
Northern California, has this dimensional coverage:

• Products: Any
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• Industry: Any

• Address: United States > California > Northern CA

Chris is part of the industry overlay organization and shadows Jane, but Chris is only responsible for high tech and
manufacturing customers located in Northern California. The recipient territory, Northern California HT&M has this
dimensional coverage:

• Products: Any

• Industry: High Tech, Manufacturing

• Address: United States > California > Northern CA

In the Northern California HT&M territory, the high tech and manufacturing industry dimensions are considered
overrides.

Related Topics
• Examples of Inherited Territory Coverage

Create a Territory Inheritance  
You can set a territory as the source for the definitions of another territory. Then you only make changes in the one
source territory, and the rest of the territories inherit the change.

1. Add a territory to a territory proposal to edit.
2. From the Actions menu, choose Inherit > Edit Inheritance.
3. Select the territory that contains coverage (dimensions or inclusions and exclusions, or both) that you want

your proposed territory to inherit. Your territory inherits all coverage information from this source territory,
unless you use overrides to change the coverage in the recipient. You can't have a chain of territory inheritances
where territory B inherits from territory A, and B also is a source territory for territory C.

CAUTION:  If you delete a source territory, the recipient territories aren't deleted, but automated updates to
recipient territories stop.

4. Use dimensional overrides to modify what's inherited from the source.
5. Add or remove any coverage definitions to your proposed territory.
6. Activate your territory proposal.

Recipient territories also inherit the Eligible for Quota, Revise Quota, Revision Reason, and Revision Description
settings from the source territory.

Related Topics
• Examples of Inherited Territory Coverage

Changes to Source Territories  
Create one territory as the source and let the shadowing territories inherit the dimension definitions from the one
source. Then you only make changes in the one source territory, and the rest of the territories inherit the change.

This is an easy way to keep dimension definitions synchronized for a number of territories.
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In this chart, the address dimension in the source territory Is originally US > California > Northern CA. You add US >
Oregon > Southern OR so the source territory includes both Northern CA and Southern OR. The recipient territories

automatically change to match. 

Update Recipients
After you make changes to a source territory, select the territory in the Territories table on the proposal. Go to the
Actions menu and select Inherit > Update Recipients. The Territory Inheritance Recipient Update process makes
changes to the recipient territories.

The default processing behavior uses the Maximum Number of Territories in Proposal parameter to 0 which uses
a faster option to update active recipient territories without using proposals. This improves the performance when
regenerating inheritance territories and minimizes the changes to recipient territories. which is important for customers
with large numbers of territories and complex territory definitions.

Changes to Recipient Territories Including End Inheritance  
When you create a recipient territory, you use dimensional overrides to make changes to the proposed territory. You can
also make changes to recipient territories in a proposal at a later time. To end the inheritance relationship, change the
source territory field to none.

Use Scheduled Processes to run the Update Inheritance Recipients process to update all recipient territories. This
includes your changes and any inherited definitions from source territories. You can select a source territory to update,
or leave that parameter blank to run all territories. The Maximum Number of Territories in Proposal parameter is set to
0 for best performance. This is important if you have a large number of territories or complex territory definitions. If
you want to use proposals to update recipients, you can specify the maximum number of territories per proposal. The
maximum you can enter is 500. This process can also be scheduled to run periodically.

Examples of Territories Defined by Geography  
A common method of dividing sales territories is by geography.
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Countries
You have a small sales team and sell products internationally by phone. All salespeople have the expertise to sell all
products to all customers. You choose to define territories by country. Too many customers are in the United States
for one salesperson, so you create territories for different states that have a parent territory for the country. You group
several small countries by creating a parent zone in the geography hierarchy.

Postal Codes
Your company sells mostly through on-site visits to companies in a few major cities in North America and Europe. To
service city customers adequately, you must assign several salespeople to each city. You choose to create territories
defined by postal codes that form hierarchies with their parent territories, defined by country. Customers with locations
that aren't within the assigned postal codes get assigned to the parent country territory.

Examples of Using Dimensional Coverage  
Enable only the dimensions your organization requires for defining territories. These examples illustrate the use
of different dimensions to assign customers, leads, and opportunity lines to the correct salespeople using defined
territories.

Account Type
You want to assign major customers to Named accounts territories. A named account territory can have child territories
identified by additional criteria, such as address. You also have territories with the account type of Not Named that
include no major named accounts in the hierarchy.

Customer Size
One product line is suitable only for organizations above a certain size. Use the customer size dimension to target only
the larger customers for the product line.

Industry
You sell one type of service to telecommunications companies, another service to utilities, and a third service for
insurance companies. You can create territories for each using the Industry dimension.

Product
You sell a product line that requires salespeople to have a high degree of technical knowledge. Create separate
territories for this product line.

Sales Channel
You delegate customers that are small to partner sales organizations by address.

Examples of Dimensional Territories  
This scenario illustrates using a combination of different dimensions to define a new hierarchy of territories.
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Scenario
The telescope division of your company manufactures and sells a special type of microscope as well as related
accessories and supplies. Your company recently started supplying microscopes to two large universities and several
colleges in the East. Management wants to focus on expanding this new market by dedicating several salespeople to
this industry, and by assigning individual universities to territories.

This chart shows the current territory hierarchy for the division, divided into East and West United States
with a parent territory to catch any accounts outside the United States. All territories for the Telescopes
Division of the company include in the definition the product group: telescopes, accessories, and supplies.

Selling telescopes requires salespeople with more knowledge and experience. Therefore, you separate telescope sales
from sales of accessories and supplies within each US region. To accomplish this, you define the Telescopes territories
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with the Telescopes product and the Telescopes Supplies territories with the Telescope Supplies and Accessories

product group. 
The Telescopes East territory is defined with these dimensions:

• Geography: East United States

• Product: Telescopes

• Industry: Any

The Telescope Supplies East territory is defined with these dimensions:

• Geography: East United States

• Product: Telescope Accessories and Supplies

• Industry: Any

You add two child territories defined by Industry dimension members for 4-year colleges and
universities, and 2-year colleges. Within the 4-year colleges and universities territory, you add the two
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universities who are current customers as inclusions so they have dedicated salespeople to service them.

The Colleges and Universities East territory is defined with these dimensions:

• Geography: East United States

• Product: Telescopes

• Industry: Colleges and Universities - 4 year

The Community Colleges East territory is defined with these dimensions:

• Geography: East United States

• Product: Telescopes

• Industry: Community Colleges - 2 year

Each university territory is defined with these dimensions:

• Included Customer: Harvard (for the Harvard territory)

• Included Customer: Cornell (for the Cornell territory)

• Other Dimensions, Product: Telescopes
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You build the West United States territory hierarchy in the same way. Sales management identified
three universities as named accounts even though they haven't yet purchased telescopes.

Examples of Inherited Territory Coverage  
Use territory inheritance to make coverage changes to one source territory and automatically propagate those changes
to recipient territories that have an inheritance relationship to the source territory.

Use overrides to change the dimensional coverage and other dimension information, and to qualify the included
customers and their hierarchies to only those that match the override information.

In this example, the industry and product dimensions are enabled. This table provides the source territory definition.

Coverage Type Definition Details

Dimensional Coverage
 

Industry
 

Any
 

Dimensional Coverage
 

Product
 

Any
 

Included Customers
 

Customer A
 

Is in the high tech industry
 

Included Customers
 

Customer B
 

Is in the services industry
 

Included Customers
 

Customer C
 

Is in the utilities industry
 

Filtering Conditions
 

None
 

None
 

Other Dimensions
 

Product
 

Desktops, Laptops
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Recipient Territory 1
The override for recipient territory 1 is Industry: Services.

Here's the resulting coverage for recipient territory 1.

Coverage Type Definition Details

Dimensional Coverage
 

Industry
 

Services
 

Dimensional Coverage
 

Product
 

Any
 

Included Customers
 

Customer A
 

Is in the high tech industry
 

Included Customers
 

Customer B
 

Is in the services industry
 

Included Customers
 

Customer C
 

Is in the utilities industry
 

Filtering Conditions
 

Industry
 

Services: Filters out Customers A and C
 

Other Dimensions
 

Product
 

Desktops, Laptops
 

Recipient Territory 2
The override for recipient territory 2 is Industry: High Tech.

Here's the resulting coverage for recipient territory 2.

Coverage Type Definition Details

Dimensional Coverage
 

Industry
 

High Tech
 

Dimensional Coverage
 

Product
 

Any
 

Included Customers
 

Customer A
 

Is in the high tech industry
 

Included Customers
 

Customer B
 

Is in the services industry
 

Included Customers
 

Customer C
 

Is in the utilities industry
 

Filtering Conditions
 

Industry
 

High Tech: Filters out Customers B and C
 

Other Dimensions
 

Product
 

Desktops, Laptops
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Recipient Territory 3
The override for recipient territory 3 is Product: Laptops.

Here's the resulting coverage for recipient territory 3.

Coverage Type Definition Details

Dimensional Coverage
 

Product
 

Laptops
 

Dimensional Coverage
 

Industry
 

Any
 

Included Customers
 

Customer A
 

Is in the high tech industry
 

Included Customers
 

Customer B
 

Is in the services industry
 

Included Customers
 

Customer C
 

Is in the utilities industry
 

Filtering Conditions
 

None
 

None
 

Other Dimensions
 

Product
 

Laptops
 

Custom Access Groups  

Secure Territories Using Custom Access Groups  
You can create custom rules for securing territories and proposals by custom access groups. For example, use custom
rules to give country administrators view access to territories. But your sales operations team uses the provided security
with full access to create and update territories.

The role-based security provides different access to different levels of the hierarchy. Custom Access Group data security
is additive to the standard data security policies or predefined object sharing provided for each job and functional
role. If your custom access group rules apply to users who aren't administrators, take care that you don't provide
inappropriate access. Update, Delete, and Full access levels are available for sharing rules, but each one provides full
access. If a user deletes a territory, all descendant territories are also deleted. Therefore, the user must have full access
to all the territories to successfully delete the top territory.

Note:  You can't create rules that use attributes of the child objects territory team, line of business, or coverage.

Related Topics
• Types of Access Groups
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Export and Import Management  

Overview of Using Import Management to Import Territories  
You can use import management to create, update, or delete sales territory records.

When using Import Management you export a single compressed file containing the files for sales territories, sales
territory resources, sales territory coverage, or sales territory lines of business. You can select whether to export one,
all, or any combination of the territory objects. You import separate files for the territory objects: sales territory, sales
territory resource, sales territory coverage, or sales territory line of business. Additionally, you need separate import files
for creating (or updating), and for deleting records.

1. If you plan to import to a proposal, then create a proposal in the territory More Details UI.
2. Export active territories or export your proposal.
3. Map your source data to object attributes.
4. Complete your changes for one or more comma separated values (CSV) import files.
5. Create the import activity.
6. Review your import results.
7. Review and activate your proposal, if you're using one.

Always specify the user-friendly public unique identifiers when creating, updating or deleting territory records. Here are
some examples.

• Sales Territory

◦ UniqueTerritoryNumber

◦ ProposalNumber

◦ ParentTerritoryUniqueTerritoryNumber

◦ OwnerResourceNumber

• Sales Territory Resource

◦ UniqueTerritoryNumber

◦ ResourcePartyNumber

• Sales Territory Coverage

◦ UniqueTerritoryNumber

◦ CoverageNumber

• Sales Territory Line of Business

◦ UniqueTerritoryNumber

◦ LOBCode

When you delete a territory using import, all the descendant territories are also deleted.

Create separate files for creating and for deleting Sales Territory Resource, Sales Territory Coverage, or Sales Territory
Line of Business records.
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Tip:  Don't update records in the Sales Territory child objects. Instead, import to delete the record and then import to
create the new record with the correct values.

Create New Territories
You can create multiple levels of territories within a single Sales Territory import file. When you create a hierarchy of
territories in single import file, enter a UniqueTerritoryNumber for your parent territory in the sales territory import file.
Then you can use this same number as the ParentTerritoryUniqueTerritoryNumber of your child territories. Another
reason to enter a UniqueTerritoryNumber is you can use the same UniqueTerritoryNumber in the child import files
(sales territory resource, sales territory coverage, sales line of business). Here are other things to keep in mind:

• You must include the effective start date when you create an active territory.

• Include the Proposal Number when creating a new territory that's part of a proposal. It's a good idea to set the
unique territory number to a combination of the Territory Number and the Proposal Number.

• When creating a new territory, the processing of the sales territory object import activity should complete
prior to processing any of the sales territory child object (sales territory resource, sales territory coverage, sales
territory line of business) import activities. The sales territory child object import activities can be processed in
any order.

File Size
Each import file has a limit for the number of records you're importing.

• Sales Territory 50,000

• Sales Territory Resource 50,000

• Sales Territory Lines of Business 50,000

• Sales Territory Coverage 500,000

Coverage Tips
Here are some suggestions for your coverage data:

• To create the coverage Any for an individual dimension, don't include a row in the sales territory coverage file
for that dimension.

• To create the coverage Any for ALL dimensions, include a row in the sales territory coverage file with the
UniqueTerritoryNumber and the CoverageTypeCode. Leave all other columns blank.

• To create the coverage for a Customer Inclusion or Exclusion, the application attempts to look up the account
using RegistryID, but if not found it uses OriginalReference. If values for both RegistryID and OriginalReference
are passed, then the RegistryID is used first.

A Sales Territory Coverage record can be deleted using these fields:

• Unique territory number (UniqueTerritoryNumber): The public unique identifier number of the territory

Coverage type code (CoverageTypeCode): Possible values are REGULAR, INCLUSION, or EXCLUSION

Dimension code (TerrDimensionCode)

Dimension Field: The value for the relevant dimension field representing the territory coverage record to delete.
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Dimension Codes and Fields

Dimension Dimension Code Dimension Field

Sales Channel (None) Either SalesChannelCode or
SubSalesChannelCode

Product Prod ProductGroupNumber or ProductGroupId OR
ItemNumber or InventoryItemId

Account Type AccTp AccountTypeCode

Address Addr AddressCountry and (optionally) one or more of
the following:
 
AddressState
 
AddressProvince
 
AddressCounty
 
AddressCity
 
AddressPostalCode
 
AddressElementAttribute1
 
AddressElementAttribute2
 
AddressElementAttribute3
 
AddressElementAttribute4
 
AddressElementAttribute5
 

Auxiliary 3 Aux3 Auiliary3Code

Auxiliary 1 Aux1 Auiliary1Code

Auxiliary 2 Aux2 Auiliary2Code

Business Unit BUnit BusinessUnitName or BusinessUnitId

Customer Size CSize CustomerSizeCode

Geography Geo GeographyId or GeographyName (the full path
needs to be provided, for example >United
States>CA or ~Global~North America)
 
For Geo ranges, also provide GeographyHighId
or GeoHighName. The full path needs to be
provided (optional).
 

Industry Indst IndustryCode

Organization Size OrgTp OrganizationTypeCode

Partner Prtnr PartnerNumber or PartnerId

Account Acct RegistryId or OriginalReference or AccountId

189



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 9
Territories

Related Topics
• Create the Territory Hierarchy Using Proposals

• Import Your Sales Territory Data

• Import Your Sales Territory Resource Data

• Import Your Sales Territory Coverage Data

• Import Your Sales Territory Line of Business Data

Export Territory Data  
Use export to create CSV files that are ready for your changes. To export territory records to update, create, or delete,
select the Language Independent Header option under Additional Options in the Export Activity.

Use a Proposal
Do you want to import your territory data to a proposal so you can review it before activating?

• You can create a territory proposal in the territory More Details UI, and don't add any existing territories to
it. Make a note of the proposal number to use when you import. You have nothing to export with an empty
proposal.

• Create a territory proposal. Add to it territories you want to change or delete.

Use Tools > Export Management to export territories in your proposal. To export all territories within a proposal, use
the filter criteria for the sales territory object: ProposalNumber = 'XXXX' (Replace XXXX with your proposal number.)

Export Active Territories
Do you want to export your active territories, make changes, and import directly back to live territories? You only need
the records you want to change, such as just a coverage change or a resource (team member) change. Use filters to
restrict the records you export. Here are some examples:

• To export all active territories: Use the Filter Criteria for the Sales Territory object: StatusCode = 'FINALIZED' AND
EffectiveEndDate > '<today's date>'. An example of the date format is '2019-11-19T00:00:00-00:00'

• To export all active territories owned by Lisa Jones: Use the Filter Criteria for the Sales Territory object:
StatusCode = 'FINALIZED' AND EffectiveEndDate > '<today's date>' AND Owner = 'Lisa Jones'

• To export all active territories and coverage with the product Business Services: Use the Filter Criteria for the
Sales Territory object: StatusCode = 'FINALIZED' AND EffectiveEndDate > '<today's date>'

Also use the Filter Criteria for the Sales Territory Coverage object: ProductGroupName = 'Business Services'

• To export all active territories and coverage with the included customer Pinnacle Technologies: Use the Filter
Criteria for the Sales Territory object: StatusCode = 'FINALIZED' AND EffectiveEndDate > '<today's date>'

Also use the Filter Criteria for the Sales Territory Coverage object: AccountName = 'Pinnacle Technologies'

• To export all active territories and all industry dimension coverage: Use the Filter Criteria for the Sales Territory
object: StatusCode = 'FINALIZED' AND EffectiveEndDate > '<today's date>'

Also use the Filter Criteria for the Sales Territory Coverage object: DimensionName = 'Industry'
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Tip:  If you renamed a dimension, then include both the TerrDimensionCode and DimensionName in the export of
the sales territory coverage object. The TerrDimensionCode value is required when adding sales territory coverage
records.

Export a Territory Hierarchy
You can export an active or draft territory and all of its descendants, including territory team, coverage, and line of
business information.

• Use the export filter criteria to specify the unique territory number for the top territory in your hierarchy to be
exported. For example, TerritoryHierarchyUniqueTerritoryNumber = 'CDRM_199'

• If your hierarchy includes draft territories, then you must add the top territory in your hierarchy to a proposal
first. Use the unique territory number generated in the proposal when you create the filter for export.

• To export only active territories, filter with the unique territory number plus the status code "finalized" and
an effective end date greater than today. Here's an example: TerritoryHierarchyUniqueTerritoryNumber =
'CDRM_199' AND StatusCode = 'FINALIZED' AND EffectiveEndDate > '2021-01-01T00:00:00-00:01'

Related Topics
• What's the difference between unique territory number and territory number?

• Export Data

Create Import Templates for Territories  
When you import territories, you use separate files for coverage, line of business, and territory team members.
Coverage, line of business, and team members (resources) are part of the parent object sales territory.

You can create hierarchical import templates to group the files together the same way each time you import. The parent
sales territory file is imported first, then the files for the child objects. A template also includes the import mode, such as
to delete records.

Create a Template
This example shows how to create a template for territories.

1. Navigate to Tools > Import Management > Import Configuration > Manage Template > Create Template.
2. On the Create Template page, name the template Create and Update Territories and Coverage.
3. Select the import object Sales Territory.
4. Click the Import Object Hierarchy link to select the object hierarchy.
5. Select the Enabled check box for each object to import. You can select the child objects under the parent

hierarchy only after selecting the parent object.
6. Select the import mode Update and create records.
7. Save and close.
8. Refresh to see your new template.

Suggested Templates
Create these templates to cover most of your future import needs.
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Note:  Don't use import templates to import territory coverage along with sales territories or resources.

Template Name Objects Import Mode

Create Territory and Team and Coverage
 

Sales Territory
 

• Sales Territory Resource

Create records, or
 
Update and create records
 

Update Territories
 

Sales Territory
 

• Sales Territory Resource

Update and create records
 

Add Territory Coverage
 

Sales Territory Coverage
 

Create records
 

Delete Territory
 

Sales Territory
 

Delete records
 

Delete Territory Resource
 

Sales Territory Resource
 

Delete records
 

Delete Territory Coverage
 

Sales Territory Coverage
 

Delete records
 

Related Topics
• Manage Hierarchical Import Templates

Import Approaches and Examples  

Territory Import Approaches  
You have flexible options for updating territories either incrementally with updates and deletions or with full territory
definitions. You can also use the territory proposal feature to group together updates and activate them only when
ready. Here are some approaches you can take.
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• Update active territories

◦ Proposals aren't used

◦ Make incremental territory changes:

- In the sales territory import file: enter rows for each territory with an updated owner or details such
as type or function

- In the sales territory resource file: enter rows for each territory team member to be added or
removed

- In the sales territory coverage file: enter rows for each territory customer inclusion to be added, or
postal code to be removed

For examples, see these topics:

- Change Active Territory Coverage Using Export and Import Management
- Change an Active Territory Owner Using Export and Import Management
- Add Customer Inclusions Using Import Management
- Remove Customer Inclusions Using Import Management

• Update territories in a proposal where the original territory definition is included in the proposal

◦ Add territories to be updated to a proposal

◦ Make incremental updates only. For example, only dimension members to be removed or team members
to be added are included in the import files

◦ Use the unique territory numbers of the territories within the proposal in the import files

◦ Activate the proposal after import

See the Update Territories with a Proposal Using Export and Import topic for an example.

• Import territories to a new proposal

◦ Create a new territory proposal. Don't add territories to the proposal. The import process doesn't create a
proposal for you.

◦ You import the full territory definition. For example, the sales territory, sales territory team, sales territory
coverage, sales territory line of business import files contain the complete definition of the territory

◦ Include the proposal number when creating a new territory to be part of a proposal. It's a good idea to set
the unique territory number to a combination of the territory number and the proposal number.

◦ Activate the proposal after import

See the Update and Create Territories Using a New Proposal topic for an example.

• Create and delete territories in a hierarchy. See these example topics:

◦ Create an Active Territory Hierarchy Using Import

◦ Delete an Active Parent Territory Using Import Management

◦ Create Parent and Child Territories With a Proposal Using Import

• Use import templates to group import files

See the Import Territories Using a Template topic for an example.
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Change Active Territory Coverage Using Export and Import
Management  
In this example, you have a territory called NA Sales Apps with several child territories. The coverage for some of these
territories includes the product ERP Applications.

You want to change the product to Financial Applications. To do so, you can use the Export and Import Management to
export the coverage file. Then import two coverage files to delete the unwanted coverage and create the new coverage.

Export the Sales Territories and Sales Territory Coverage

1. Click Navigator > Export Management.
2. Click Create Export Activity.
3. Name the export North America Product.
4. In the Object field, select Sales Territory.

The name of your export file appears in the File Name field.
5. Select the Language Independent Header check box.
6. Click Next.
7. Select Sales Territory to set these attributes and filter:

a. Change these fields in the Attributes region:
- Move Unique Territory Number to Selected Fields and move it to the top.
- Move Territory Name to the top.

b. Click Filter Name and create this filter to export active territory details as well as draft territory details, if
they exist:

i. Find the Name field and click Insert.
ii. Enter LIKE 'NA Sales Apps*'.

The child territory names all begin with NA Sales Apps.
iii. Click Save and Close.

8. The Sales Territory object is enabled. Select Enabled for the Sales Territory Coverage object.
9. Select Sales Territory Coverage and set these selected fields to be in this order:

a. Unique Territory Number
b. Territory Dimension Code
c. Dimension Name
d. Coverage Type Code
e. Product Group Name
f. Product Group Number

10. Click Filter Name and create this filter:
a. Find the TerrDimensionCode field name and click Insert.
b. Click the equals symbol.
c. Enter 'Prod'.
d. Save and close.
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11. Click Next.
12. Click Submit.

Edit the Exported Files
When the export is successful, you extract the files and modify them.

1. In the compressed export file, find and open the Coverage .CSV file.
2. Edit the file and save it to a new file name as a delete file to delete every coverage.

Name Value

File name
 

Delete NA Sales ERP.csv
 

UniqueTerritoryNumber Retain the value

CoverageTypeCode Retain the value, for example, REGULAR or INCLUSION

TerrDimensionCode Retain the value, for example, Prod

ProductGroupName
 

ERP Applications (Remove rows that don't contain this product group name.)
 

ProductGroupNumber
 

1-11E-262
 

Note:  When you delete an existing territory coverage for the product dimension, you must include the
Unique Territory Number, Coverage Type Code, Territory Dimension Code, and Product Group Number.

3. Open the original file, make these changes, and save it to add coverage.

Name Value

File name
 

Add NA Sales Fin.csv
 

UniqueTerritoryNumber Retain the value

CoverageTypeCode Retain the value, for example, REGULAR or INCLUSION

TerrDimensionCode Retain the value, for example, Prod

ProductGroupName
 

Change ERP Applications to FIN Applications
 

ProductGroupNumber
 

Change 1-11E-262 to 1-11E-156
 

Note:  When you create a new territory coverage for the product dimension, you must include the Unique Territory
Number, Coverage Type Code, Territory Dimension Code, and Product Group Number.
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Import Your Changed Files
Import your delete file first to remove the existing incorrect coverage. Then import the add file to add the new coverage.

1. Click Navigator > Import Management.
2. In the Manage Imports page, click Create Import Activity.
3. In the Enter Import Options page, select or enter these options.

Field Name Value

Name
 

Delete ERP Apps coverage for NA Sales
 

Object
 

Sales Territory Coverage
 

File Name
 

Delete NA Sales ERP.csv
 

Import Mode
 

Delete records
 

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. In the Manage Imports page, click Create Import Activity to import your coverage additions..
8. In the Enter Import Options page, select or enter these options.

Field Name Value

Name
 

Create ERP Apps coverage for NA Sales
 

Object
 

Sales Territory Coverage
 

File Name
 

Add NA Sales Fin.csv
 

Import Mode
 

Create records
 

9. Click Next.
10. In the Map Fields page, click Next.
11. Click Submit.
12. Verify that both of your imports completed.

Your changes are available in your active territories. Review the NA Sales Applications hierarchy and verify the changed
Product dimension coverage.
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Change an Active Territory Owner Using Export and Import
Management  
In this example, you have a territory called NA Sales Apps with several child territories. NA Sales Apps SouthWest and
NA Sales Apps West are owned by John Dooley, and NA Sales Apps West Central is owned by Joe Hill.

John Dooley recently left the sales organization, so temporarily, his colleague, Joe Hill will be taking over John's
territories. You can make this change without using a proposal or updating the whole territory definition.

Export the Sales Territories

1. Click Navigator > Export Management.
2. Click Create Export Activity.
3. Name the export North America Product.
4. In the Object field, select Sales Territory.

The name of your export file appears in the File Name field.
5. Select the Language Independent Header check box.
6. Click Next.
7. The Sales Territory object is enabled. Select Enabled for the Sales Territory Coverage object.
8. Select Sales Territory to set these attributes and filter:

a. Change these fields in the Attributes region and select the following order:

i. Unique Territory Number
ii. Territory Number

iii. Territory Name
iv. Owner Registry ID
v. Owner(Trans)

b. Click Filter Name and create this filter:

Note:  You can select a previous filter with this criteria instead of recreating it.

i. Find the Name field and click Insert.
ii. Enter LIKE 'NA Sales Apps*'.

The child territory names all begin with NA Sales Apps.
iii. Click Save and Close.

9. Click Next.
10. Click Submit.

Edit the Exported Files
When the export is successful, you extract the files and modify them.

1. In the compressed export file, find and open the Coverage.CSV file.
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2. Open the original file and make these changes:

Name Territory Name Value

File name
 

NA
 

Change Owner.csv
 

OwnerResourceNumber
 

NA Sales Apps West
 

1855
 

OwnerTrans
 

NA Sales Apps West
 

Joe Hill
 

OwnerResourceNumber
 

NA Sales Apps Southwest
 

1855
 

OwnerTrans
 

NA Sales Apps Southwest
 

Joe Hill
 

3. Remove Joe Hill's NA Sales Apps West Central territory, because it needs no updates.
4. Save the file.

Import Your Changed Files
Import your delete file first to change the owner of the two territories.

1. Click Navigator > Import Management.
2. In the Manage Imports page, click Create Import Activity.
3. In the Enter Import Options page, select or enter these options.

Field Name Value

Name
 

Change Territory Owner
 

Object
 

Sales Territory
 

File Name
 

Change Owner.csv
 

Import Mode
 

Update and create records
 

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. Verify that your import completed.

Your changes are available in your active territories. Review the NA Sales Applications hierarchy and verify the changed
territory owners.
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Add Customer Inclusions Using Import Management  
In this example, you create an import file and import two customer inclusions to the NA Sales territory:

• One for the account Pinnacle Technologies without the hierarchy, using the Registry ID information

• On for the account Apex Systems with the hierarchy, using the Original Reference information.

Create your import file and name it Add Customer Inclusions NA Sales.csv.

Field Name Value 1 Value 2

UniqueTerritoryNumber
 

CDRM_380
 

CDRM_380
 

CoverageTypeCode
 

INCLUSION
 

INCLUSION
 

TerrDimensionCode
 

Acct
 

Acct
 

RegistryId
 

999997569264400
 

(empty cell)
 

OriginalReference
 

(empty cell)
 

DNB~638392020043
 

IncludeHierarchyFlag
 

N
 

Y
 

You can add the AcountName column to include your customer names. The column isn't used during the import of
customer inclusions.

Import Your File to Active Territories
Import your file.

1. Navigate to Import Management.
2. Click Create Import Activity.
3. Enter these options.

Field Name Value

Name
 

Add Customer Inclusions NA Sales
 

Object
 

Sales Territory Coverage
 

File Name
 

Add Customer Inclusions NA Sales.csv
 

Import Mode Create records
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Field Name Value

  

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. Verify that the import activity completed successfully.

Your changes are available in your active territories. Review the NA Sales territory and verify the new customer
inclusions.

Remove Customer Inclusions Using Import Management  
In this example, you create an import file to remove the customer inclusion record for the account Pinnacle
Technologies from the NA Sales territory.

Use Export Management to locate the Coverage Number value for the sales territory coverage customer inclusion
record for the account Pinnacle Technologies from the NA Sales territory. Create an import file to remove this customer
inclusion and name it Remove Customer Inclusions NA Sales.csv.

Field Name Value

UniqueTerritoryNumber
 

CDRM_380
 

CoverageTypeCode
 

INCLUSION
 

TerrDimensionCode Acct

RegistryID

Note:  The OriginalReference or
AccountID value can be used instead.

CDRM_1352

Import Your File to Active Territories
Import your file.

1. Navigate to Import Management.
2. Click Create Import Activity.
3. Enter these options.

Field Name Value

Name
 

Remove Customer Inclusions NA Sales
 

Object Sales Territory Coverage
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Field Name Value

  

File Name
 

Remove Customer Inclusions NA Sales.csv
 

Import Mode
 

Delete records
 

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. Verify that the import activity completed successfully.

Your changes are available in your active territories. Review the NA Sales territory and verify the customer inclusion no
longer exists.

Update Territories With a Proposal Using Export and Import  
In this example, you have a territory called NA Direct Sales Apps with several child territories. The coverage for some of
these territories includes the Customer Size Small. You want to change the Customer Size to Large.

You will also update the territory function to Sales Support. To do so, you can use Export and Import Management to
incrementally update the sales territories. You export the sales territory and sales territory coverage files, and then
import a coverage file to delete the unwanted coverage and import a coverage file to create the new coverage, and a
sales territory import file to update the territory function.

Here's the process followed in this example.

1. Create a proposal and add the individual territories to be updated to the proposal.
2. Use Export Management to export all territories in that proposal.
3. Use the Export Management Activity filter criteria (proposal number) to export the sales territories that need to

be updated. Include two objects: sales territory and sales territory coverage.
4. Edit your files for import. This approach uses a proposal to perform incremental updates to the territories, so

you include only the territory records that require updates to the territory function in the sales territory import
file. You include only the Small Customer Size territory coverage records to be removed in the DELETE sales
territory coverage import file. You include only the Customer Size Large territory coverage records to be added
in the CREATE sales territory coverage import file.

5. Import your changed files.
6. Review your proposal and activate it.

Create a Proposal
Create the proposal and add territories to be updated.

1. Navigate to Sales > Territories
2. Click the Sales Territories Hierarchy tab.
3. Click Manage Proposals.
4. Click Create.
5. Name the proposal NA Direct Sales Apps Territory Export Proposal.
6. Click Save and View.
7. Search for territories with a name that starts with NA Direct Sales Apps.
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8. Select NA Direct Sales.
9. Click View in Hierarchy.

10. Expand the hierarchy and add these territories to the proposal:

◦ NA Central region

◦ NA Eastern region

◦ NA Western region

11. Note down the number for the proposal from the Details section.
12. Click Done twice.

Export Sales Territory and Coverage Files

1. Navigate to Export Management.
2. Click Create Export Activity.
3. Name the export Territory Export Proposal.
4. In the Object field, select Sales Territory.

The name of your export file appears in the File Name field.
5. Under Advance Options, select Language Independent Header.
6. Click Next.
7. The Sales Territory object is enabled. Enable the Sales Territory Coverage object.
8. Select Sales Territory to set these attributes and filter:

a. Select these fields in the Attributes region:

- Move Unique Territory Number to Selected Fields and move it to the top.
- Proposal Number
- Territory Number
- Territory Name
- Territory Function

b. Click Filter Name and create this filter:

i. Find the Proposal Number field and click Insert.
ii. Click the equals symbol.

iii. Enter your proposal number in single quotes.
iv. Save and close.

9. Select Sales Territory Coverage and set these selected fields to be in this order:

a. Coverage Number
b. Unique Territory Number
c. Coverage Type Code
d. Territory Dimension Code
e. Customer Size Code

10. Click Filter Name and create this filter:

a. Find the TerrDimensionCode field name and click Insert.
b. Click the equals symbol.
c. Enter 'CSize'.
d. Save and close.
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11. Click Next.
12. Click Submit.

Edit the Exported Files
When the export is successful, you extract the files and modify them to create three import files, one for sales territory
and two for sales territory coverage.

1. In the compressed export file, find and open the territory CSV file.
2. Edit the file rows:

Unique Territory Number Proposal Number Territory Name Territory Function

Leave value as exported
 

Leave value as exported
 

Leave value as exported: NA
Central region
 

Add the territory function value:
SALES_SUPPORT
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported: NA
Eastern region
 

Add the territory function value:
SALES_SUPPORT
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported: NA
Western region
 

Add the territory function value:
SALES_SUPPORT
 

3. Save to a new file name: Update NA Direct Sales Apps child territories.csv.
4. In the compressed export file, find and open the sales territory coverage CSV file.
5. Edit the file:

Coverage Number Unique Territory
Number

Coverage Type Code Territory Dimension
Code

Customer Size Code

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

Leave value as exported
 

6. save it to a new file name to delete a coverage: Delete NA Direct Sales child territories coverage.csv.
7. In the compressed export file, find and open the sales territory coverage CSV file.
8. Edit the file:

Coverage Number Unique Territory
Number

Coverage Type Code Territory Dimension
Code

Customer Size Code

Clear value
 

Leave value as exported
 

SALES_ACCOUNT_
CENTRIC
 

CSize
 

LARGE
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Coverage Number Unique Territory
Number

Coverage Type Code Territory Dimension
Code

Customer Size Code

Clear value
 

Leave value as exported
 

SALES_ACCOUNT_
CENTRIC
 

CSize
 

LARGE
 

Clear value
 

Leave value as exported
 

SALES_ACCOUNT_
CENTRIC
 

CSize
 

LARGE
 

9. save it to a new file name to create a coverage: Create NA Direct Sales child territories coverage.csv.

Import Your Files
Import your territory file.

1. Navigate to Import Management.
2. Click Create Import Activity.
3. Enter these options.

Field Name Value

Name
 

Update NA Direct Sales Child Territories
 

Object
 

Sales Territory
 

File Name
 

Update NA Direct Sales Apps child territories.csv
 

Import Mode
 

Update and insert records
 

4. Click Next.
5. In the Map Fields page, click Next
6. Click Submit.

To import the sales territory coverage delete file:

1. In the Manage Imports page, click Create Import Activity.
2. Enter these options.

Field Name Value

Name
 

Delete NA Direct Sales child territory coverage
 

Object
 

Sales Territory Coverage
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Field Name Value

File Name
 

Delete NA Direct Sales child territories coverage.csv
 

Import Mode
 

Delete records
 

3. Click Next.
4. In the Map Fields page, click Next.
5. Click Submit.

To import the sales territory coverage files:

1. In the Manage Imports page, click Create Import Activity.
2. Enter these options.

Field Name Value

Name
 

Create NA Direct Sales child territory coverage
 

Object
 

Sales Territory Coverage
 

File Name
 

Create NA Direct Sales child territories coverage.csv
 

Import Mode
 

Create records
 

3. Click Next.
4. In the Map Fields page, click Next.
5. Click Submit.

Verify that your imports completed successfully.

Review Your Imported Territories and Activate the Proposal
Check your imported territories before you activate your proposal.

1. Navigate to Sales > Territories.
2. Click More Details.
3. Click Manage Proposals.
4. Click the Territory Export Proposal.

a. Search for the territories in the proposal, such as NA Central and view them in the hierarchy.
b. Show dimensions and confirm the customer size is correct.
c. Confirm your changed territory function.

5. Click Activate.
6. If you get a warning about the activation date, click Yes.
7. Use Refresh to monitor the progress of the activation process. On completion the proposal appears in the

Completed Proposals list.
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Your changes are available in your active territories.

Update and Create Territories Using a New Proposal  
In this example, you have a territory called NA Direct Sales Apps with several child territories. The coverage for some of
these territories (NA Central region, NA Eastern region, NA Western region) includes the customer size Small.

You want to change the customer size to Large, and update the territory function to Sales Support. You also want to
create a new territory named NA Not 48 Region and owned by Alex Smith to cover large, direct customers in Hawaii and
Alaska. Perform these steps:

1. Create a new proposal. Don't add territories to this proposal. Your import won't automatically create a proposal.
2. Import complete definitions of each territory to be created or updated.
3. Activate the territory proposal.

Create a New Empty Proposal

1. Navigate to Sales > Territories.
2. Click the Sales Territories Hierarchy tab.
3. Click Manage Proposals.
4. Click Create.
5. Name the proposal Update and Create Territories Proposal.
6. Click Save and View.
7. Expand the Details section and note down the proposal number. In this example it's CDRM_47012.
8. Click Done twice.

Create the Sales Territory Import File

1. Open an existing exported territory CSV file or create a new file.
2. Save this example file as Update and Create NA Direct Sales child territories in new proposal.csv.
3. Remove all rows for other territories from your export file.
4. Enter a row for each new or updated territory. If you're updating a territory, create the unique territory number

by using the proposal number, hyphen, territory number. If you leave the territory number blank for the
application to create, then enter the unique territory number using the correct proposal number-hyphen-a
unique made-up number.

UniqueTerritoryNumberProposalNumberTerritoryNumberName TypeCode CoverageModelTerritoryFunction
Code

OwnerResource
Number

OwnerTrans ParentUnique
TerritoryNumber

CDRM_47012-
CDRM_122
 

CDRM_
47012
 

CDRM_122
 

NA Central
region
 

PRIME
 

SALES_
ACCOUNT_
CENTRIC
 

SALES_
SUPPORT
 

9147
 

Michael
Rogers
 

CDRM_249
 

CDRM_47012-
CDRM_451
 

CDRM_
47012
 

CDRM_451
 

NA Eastern
region
 

PRIME
 

SALES_
ACCOUNT_
CENTRIC
 

SALES_
SUPPORT
 

9147
 

Michael
Rogers
 

CDRM_249
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UniqueTerritoryNumberProposalNumberTerritoryNumberName TypeCode CoverageModelTerritoryFunction
Code

OwnerResource
Number

OwnerTrans ParentUnique
TerritoryNumber

CDRM_47012-
CDRM_318
 

CDRM_
47012
 

CDRM_318
 

NA Western
region
 

PRIME
 

SALES_
ACCOUNT_
CENTRIC
 

SALES_
SUPPORT
 

5110
 

Alex Smith
 

CDRM_249
 

CDRM_47012-1234
 

CDRM_
47012
 

Leave
blank (the
application
allocates
a territory
number)
or enter
a unique
territory
number, for
example
12539
 

NA Not 48
region
 

PRIME
 

SALES_
ACCOUNT_
CENTRIC
 

SALES_
SUPPORT
 

5110
 

Alex Smith
 

CDRM_249
 

Create the Sales Territory Coverage Import File

1. Open an existing exported territory coverage CSV file or create a new file.
2. Save this example file as Update and Create NA Direct Sales child territory coverage in new proposal.csv.
3. Remove all rows for other territories from your export file.
4. Enter coverage rows as needed for each new or updated territory. Copy the unique territory numbers from you

territory import file. Cells in this table containing N/A should have no entries in your import file.

UniqueTerritoryNumberTerrDimensionCode CoverageTypeCode CustomerSizeCode SalesChannelCode GeographyName

CDRM_47012-
CDRM_122
 

SChnl

 
REGULAR
 

N/A
 

ZPM_DIRECT_
CHANNEL_TYPES
 

N/A
 

CDRM_47012-
CDRM_122
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~Midwest
 

CDRM_47012-
CDRM_122
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~South
 

CDRM_47012-
CDRM_122

CSize
 

REGULAR
 

LARGE
 

N/A
 

N/A
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UniqueTerritoryNumberTerrDimensionCode CoverageTypeCode CustomerSizeCode SalesChannelCode GeographyName

 

CDRM_47012-
CDRM_318
 

SChnl

 
REGULAR
 

N/A
 

ZPM_DIRECT_
CHANNEL_TYPES
 

N/A
 

CDRM_47012-
CDRM_318
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~West
 

CDRM_47012-
CDRM_318
 

CSize
 

REGULAR
 

LARGE
 

N/A
 

N/A
 

CDRM_47012-
CDRM_451
 

SChnl

 
REGULAR
 

N/A
 

ZPM_DIRECT_
CHANNEL_TYPES
 

N/A
 

CDRM_47012-
CDRM_451
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~Northeast
 

CDRM_47012-
CDRM_451
 

CSize
 

REGULAR
 

LARGE
 

N/A
 

N/A
 

CDRM_47012-
CDRM_1234
 

SChnl

 
REGULAR
 

N/A
 

ZPM_DIRECT_
CHANNEL_TYPES
 

N/A
 

CDRM_47012-
CDRM_1234
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~West~Pacific~AK
 

CDRM_47012-
CDRM_1234
 

Geo
 

REGULAR
 

N/A
 

N/A
 

~GLOBAL~North
American
Sales~United
States~West~Pacific~HI
 

CDRM_47012-
CDRM_451
 

CSize
 

REGULAR
 

LARGE
 

N/A
 

N/A
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Import Your Files
Import your territory file and your coverage file.

1. Navigate to Import Management.
2. Click Create Import Activity.
3. Enter these options.

Field Name Value

Name
 

Update and Create NA Direct Sales child territories
 

Object
 

Sales Territory
 

File Name
 

Update and Create NA Direct Sales child territories in new proposal.CSV
 

Import Mode
 

Update and insert records
 

4. Click Next.
5. In the Map Fields page, review the mappings. Optionally apply a specific mapping, or click Save as to save the

mapping or map any unmapped fields.
6. Click Next.
7. Click Submit.

To import the sales territory coverage file:

1. In the Manage Imports page, click Create Import Activity.
2. Enter these options.

Field Name Value

Name
 

Update and Create NA Direct Sales child territory coverage
 

Object
 

Sales Territory Coverage
 

File Name
 

Update and Create NA Direct Sales child territory coverage in new proposal.CSV
 

Import Mode
 

Update and insert records
 

3. Click Next.
4. In the Map Fields page, review the mappings. Optionally apply a specific mapping, or click Save as to save the

mapping or map any unmapped fields.
5. Click Next.
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6. Click Submit.
7. Verify that all of your imports completed successfully.

Review Your Imported Territories and Activate the Proposal
Check your imported territories before you activate your proposal.

1. Navigate to Sales > Territories.
2. Click More Details.
3. Click Manage Proposals.
4. Click the Territory Export Proposal.
5. Find your added or changed territories and verify the coverage.
6. Click Activate.
7. If you get a warning about the activation date, click Yes.
8. Use Refresh to monitor the progress of the activation process. On completion the proposal appears in the

Completed Proposals list.

Your changes are available in your active territories.

Create an Active Territory Hierarchy Using Import  
In this example, you create an active territory and active child territory, each with an owner and dimensional coverage.
The parent territory is for a sales manager, and a child territory for a salesperson, under the NA Diagnostics territory
branch owned by Kerry Evans.

Create Your Import Files
You need this information to start:

• Parent Territory NA Diagnostics has the unique number: 26088

• Salesperson Lisa Jones has the resource registry ID: 15

• Sales Manager Mateo Lopez has the resource registry ID: 16534

You can save a copy of an exported Sales Territory and an exported Sales Territory Coverage file to use as templates for
the import files.

1. Open an exported Sales Territory CSV file.
2. Replace the field values with these territory definitions:

UniqueTerritoryNumberTerritoryNumberCoverageModelName StatusCode TypeCode ParentUnique
TerritoryNumber

OwnerResource
Number

Description

JC1234
 

(Leave blank)
 

SALES_
ACCOUNT_
CENTRIC
 

NA
Diagnostics -
San Mateo
 

FINALIZED
 

PRIME
 

26088
 

16534
 

Large
Customers
in San Mateo
County -
Diagnostic
products
 

210



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 9
Territories

UniqueTerritoryNumberTerritoryNumberCoverageModelName StatusCode TypeCode ParentUnique
TerritoryNumber

OwnerResource
Number

Description

JC5678
 

(Leave blank)
 

SALES_
ACCOUNT_
CENTRIC
 

NA
Diagnostics -
SC and RWC
 

FINALIZED
 

PRIME
 

JCT1234
 

15
 

Large
Customers
in Cities San
Francisco -
Diagnostic
products
 

3. Save the file to the new file name Active Parent and Child Territory Import.csv.
4. Open an exported Sales Territory coverage CSV file.
5. Replace the field values with these values for Mateo's territory coverage:

UniqueTerritoryNumberTerrDimensionCodeCoverageType ProductGroupNumberProductGroupNameCustomerSizeCodeAddressCountryAddressCountyAddressCity

JC1234
 

Prod
 

REGULAR
 

300000095942114
 

Diagnostics
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC1234
 

CSize
 

REGULAR
 

(Leave blank)
 

(Leave blank)
 

LS_LARGE
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC1234
 

Addr

 
REGULAR
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

US
 

San Mateo
 

(Leave blank)
 

6. Add values for Lisa's territory coverage to the same file:

UniqueTerritoryNumberTerrDimensionCodeCoverageType ProductGroupNumberProductGroupNameCustomerSizeCodeAddressCountryAddressCountyAddressCity

JC5678
 

Prod
 

REGULAR
 

300000095942114
 

Diagnostics
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC5678
 

CSize
 

REGULAR
 

(Leave blank)
 

(Leave blank)
 

LS_LARGE
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC5678
 

Addr

 
REGULAR
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

US
 

(Leave blank)
 

San
Francisco
 

7. Save the file to the new file name Active Parent and Child Territory Coverage Import.csv.

Import Your Files for Active Territories
Import the sales territory file first to create the parent and child territories. Then import the sales territory coverage file
to add the new coverage for both territories.

1. Navigate to Import Management.
2. Click Create Import Activity.
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3. Enter these options.

Field Name Value

Name
 

Import Parent and Child Territory
 

Object
 

Sales Territory
 

File Name
 

Active Parent and Child Territory Import.csv
 

Import Mode
 

Update and create records
 

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. Verify that the import activity completed successfully.

Next, import the sales territory coverage file:

1. In the Manage Imports page, click Create Import Activity.
2. Enter these options.

Field Name Value

Name
 

Import Parent and Child Territory Coverage
 

Object
 

Sales Territory Coverage
 

File Name
 

Active Parent and Child Territory Coverage.csv
 

Import Mode
 

Update and create records
 

3. Click Next.
4. Click Next.
5. Click Submit.
6. Verify that your import completed successfully.

Delete an Active Parent Territory Using Import Management  
In this example, you want to delete a parent territory (NAM Parent Territory which covers the countries in North
America, and its three child territories which cover United States, Canada, and Mexico).
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You achieve this by creating a sales territory import file that contains the unique territory number of the parent territory
you want to delete. All child territories are also deleted during import.

1. Create your comma separated delimiter file that contains the column name UniqueTerritoryNumber and the
value of the unique territory number of the NAM parent territory.

2. Click Navigator > Import Management.
3. In the Manage Imports page, click Create Import Activity.
4. In the Enter Import Options page, select or enter these options.

Field Name Value

Name
 

Delete NAM Parent Territory
 

Object
 

Sales Territory
 

File Name
 

Delete NAM Parent Territory.csv
 

Import Mode
 

Delete records
 

5. Click Next.
6. In the Map Fields page, click Next.
7. Click Submit.
8. Verify that the import activity completed.
9. Go to your active territories and confirm that the parent and child territories are gone.

Import Territories Using a Template  
Your import template includes the hierarchy, if needed, of the territory object as the parent and the child objects
coverage, line of business, and sales team (resources). In this example, you have three files to import:

1. Update NA Direct Sales child territories.csv
2. Delete NA Direct Sales child territories coverage.csv
3. Create NA Direct Sales child territories coverage.csv

Import Using Hierarchical Import Template Files
Import the delete coverage file first to remove existing incorrect coverage. You can import it directly or use the Delete
Territory Coverage template recommended in the Create Templates for Territory Imports topic.

1. Navigate to Tools > Import Management > Import from Template.

The Template Summary section shows the list of available templates for use, along with the top-level import
object. When you select a template, the Hierarchy Objects section shows the object hierarchy for the template.

2. Select the Create Territory and Team and Coverage template and click Continue with Template. On the
Enter Import Options page, your object hierarchy is preselected and the advanced import configurations are
already selected for you. If required, you can change these configurations for your import.

3. Click Choose File for the Sales Territory object and select the Update NA Direct Sales child territories.csv file.
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4. Click Choose File for the Sales Territory Coverage object and select the Create NA Direct Sales child territories
coverage.csv file.

5. Click Next.
6. In the Sales Territory Map Fields page, review the mappings. Optionally apply a specific mapping, or click

Save as to save the mapping or map any unmapped fields.
7. Click the Sales Territory Coverage subtab to review mappings. Optionally apply a specific mapping, or click Save

as to save the mapping or map any unmapped fields.
8. Click Next.
9. Review your import details on the Review and Submit page, and submit.

10. Verify that all of your imports completed successfully.

Related Topics
• Create Import Templates for Territories

• Manage Hierarchical Import Templates

Create Parent and Child Territories with a Proposal Using Import  
In this example, you create a territory and child territory, each with an owner and dimensional coverage. You import the
territories to an empty proposal and then activate the proposal.

The parent territory is for a sales manager, and a child territory for a salesperson , under the NA Diagnostics territory
branch owned by Kerry Evans. The sales manager territory is owned by Mateo Lopez and the child territory is owned by
Lisa Jones.

You can create multiple levels of territories within a single Sales Territory import file. When you create a hierarchy of
territories in a single import file, enter a UniqueTerritoryNumber for your parent territory in the sales territory import
file. Then you can use this same number as the ParentUniqueTerritoryNumber of your child territories. Another reason
to enter a UniqueTerritoryNumber is you can use the same UniqueTerritoryNumber in the child import files (sales
territory resource, sales territory coverage, and sales line of business). Here are other things to keep in mind:

• Include the Proposal Number when creating a new territory that's part of a proposal. It's a good idea to set
the unique territory number to a combination of the Territory Number and the Proposal Number. A territory
proposal must be created in advance. The import process doesn't automatically create proposals when
importing territories.

• When creating a new territory, the processing of the sales territory object import activity should complete
prior to processing any of the sales territory child object (sales territory resource, sales territory coverage, sales
territory line of business) import activities. The sales territory child object import activities can be processed in
any order.

• The Import from Template feature can be used to group the uploading and processing sequence of individual
sales territory, sales territory team, and sales territory coverage files.

Create a New Empty Proposal

1. Navigate to Sales > Territories.
2. Click the Sales Territories Hierarchy tab.
3. Click Manage Proposals.
4. Click Create.
5. Name the proposal Create Sales Manager and Salesperson Territory.
6. Click Save and View.
7. Expand the Details section and note down the proposal number. In this example it's CDRM_40012.
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8. Click Done twice.

Create Your Import Files
You need this information to start:

• Parent Territory NA Diagnostics has the unique number: 26088

• Salesperson Lisa Jones has the resource registry ID: 15

• Sales Manager Mateo Lopez has the resource registry ID: 16534

• The proposal number you noted, 40012 in this example.

You can save a copy of an exported Sales Territory and an exported Sales Territory Coverage file to use as templates for
the import files.

1. Open an exported Sales Territory CSV file.
2. Replace the field values with these territory definitions:

UniqueTerritoryNumberTerritoryNumberProposalNumberCoverageModelName StatusCode TypeCode ParentUnique
TerritoryNumber

OwnerResource
Number

Description

JC1234_
CDRM_
40012
 

JC1234
 

CDRM_
40012
 

SALES_
ACCOUNT_
CENTRIC
 

NA
Diagnostics
- San
Mateo
 

FINALIZED
 

PRIME
 

26088
 

16534
 

Large
Customers
in San
Mateo
County -
Diagnostic
products
 

JC5678_
CDRM_
40012
 

JC5678
 

CDRM_
40012
 

SALES_
ACCOUNT_
CENTRIC
 

NA
Diagnostics
- SC and
RWC
 

FINALIZED
 

PRIME
 

JCT1234
 

15
 

Large
Customers
in Cities
San
Francisco -
Diagnostic
products
 

3. Save the file to the new file name Active Parent and Child Territory Proposal Import.csv.
4. Open an exported Sales Territory coverage CSV file.
5. Replace the field values with these values for Mateo's territory coverage:

UniqueTerritoryNumberTerrDimensionCodeCoverageType ProductGroupNumberProductGroupNameCustomerSizeCodeAddressCountryAddressCountyAddressCity

JC1234_
CDRM_40012
 

Prod
 

REGULAR
 

300000095942114
 

Diagnostics
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC1234_
CDRM_40012
 

CSize
 

REGULAR
 

(Leave blank)
 

(Leave blank)
 

LS_LARGE
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
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UniqueTerritoryNumberTerrDimensionCodeCoverageType ProductGroupNumberProductGroupNameCustomerSizeCodeAddressCountryAddressCountyAddressCity

JC1234_
CDRM_40012
 

Addr

 
REGULAR
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

US
 

San Mateo
 

(Leave blank)
 

6. Add values for Lisa's territory coverage to the same file:

UniqueTerritoryNumberTerrDimensionCodeCoverageType ProductGroupNumberProductGroupNameCustomerSizeCodeAddressCountryAddressCountyAddressCity

JC5678_
CDRM_40012
 

Prod
 

REGULAR
 

300000095942114
 

Diagnostics
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC5678_
CDRM_40012
 

CSize
 

REGULAR
 

(Leave blank)
 

(Leave blank)
 

LS_LARGE
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

JC5678_
CDRM_40012
 

Addr

 
REGULAR
 

(Leave blank)
 

(Leave blank)
 

(Leave blank)
 

US
 

(Leave blank)
 

San
Francisco
 

7. Save the file to the new file name Active Parent and Child Territory Coverage Proposal Import.csv.

Import Your Files for Active Territories
Import the sales territory file first to create the parent and child territories. Then import the sales territory coverage file
to add the new coverage for both territories.

1. Navigate to Import Management.
2. Click Create Import Activity.
3. Enter these options.

Field Name Value

Name
 

Import Parent and Child Territory in Proposal
 

Object
 

Sales Territory
 

File Name
 

Active Parent and Child Territory Proposal Import.csv
 

Import Mode
 

Update and create records
 

4. Click Next.
5. In the Map Fields page, click Next.
6. Click Submit.
7. Verify that the import activity completed successfully.
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Next, import the sales territory coverage file:

1. In the Manage Imports page, click Create Import Activity.
2. Enter these options.

Field Name Value

Name
 

Import Parent and Child Territory Coverage in Proposal
 

Object
 

Sales Territory Coverage
 

File Name
 

Active Parent and Child Territory Coverage Proposal Import.csv
 

Import Mode
 

Update and create records
 

3. Click Next.
4. Click Next.
5. Click Submit.
6. Verify that your import completed successfully.

Review Your Imported Territories and Activate the Proposal
Check your imported territories before you activate your proposal.

1. Navigate to Sales > Territories.
2. Click More Details.
3. Click Manage Proposals.
4. Click Create Sales Manager and Salesperson Territory.
5. Search for the territory NA Diagnostics - San Mateo.
6. Select the territory and click View in Hierarchy.
7. The territory appears in the Territories table. Expand the hierarchy to see the child territory.
8. Click Show Dimensions. Review the coverage details for both territories.
9. Click Activate.

10. If you get a warning about the activation date, click Yes.
11. Use Refresh to monitor the progress of the activation process. On completion the proposal appears in the

Completed Proposals list.

Your changes are available in your active territories.

Related Topics
• Import Territories Using a Template
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FAQs for Territories  

Frequently Asked Questions (FAQs) for Territories  
This section contains some frequently asked questions (FAQs) when setting up and maintaining territories. Scroll or
search to find answers to common questions.

When does a territory administrator define territories?  
Sales managers define territories because they have the knowledge about their assigned territory and about their
salespeople, and are best able to assign territories equitably. Sales managers delegate the territory definition activity to
sales operations to save time.

Create an administrator who can modify all territories and quotas by giving her the Sales Administrator job role. Or
select the Administrator check box for a territory team member in your territory. This person must also have a job role
that includes the Territory Management Administration Duty. Now that person can view your territory and modify all
territories lower in your territory hierarchy. He can also assign sales quotas for you.

What's a territory overlap?  
When two or more territories are children of the same parent, and reference the same intersection of dimension
members, then the territories overlap.

For example, a child territory with the dimension member Virginia and a child territory with the dimension member
United States overlap.

An overlap is a problem if it's accidental. If it results in two salespeople mistakenly assigned the same area, the
overlap causes conflicts and incorrectly assigned sales quotas. A deliberate overlap is useful for assigning additional
salespeople or technical experts to the same areas also covered by the salespeople who have quotas. For example, the
same area requires four salespeople with separate territories, but only one technical expert. It's a good practice to assign
one of the territories the territory type of Overlay.

What's a territory gap?  
A territory gap consists of a dimension member that belongs to a territory but doesn't belong to any children of that
territory.
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In this chart the parent territory is defined by the size of the customer, and the available dimension members for
customer size are small, medium, and large. There are child territories for small and medium sized customers, but the

territory for large customers is missing and creates a gap. 

What happens if I select Forecast not visible to territory owner?  
The owner of a parent territory sets the Forecast Invisible to Owner option to perform all forecasting actions and hide
forecasts from the child territory owners.

The owner of the parent territory can submit the forecast for the child territory. If the child territory owner also owns the
parent territory, then the territory owner can edit forecast items, add and remove forecast items as adjustments, and
adjust the territory forecast.

Why did my OBIEE report include old and deleted territories?  
Only active territories can be assigned to sales objects such as accounts, opportunities, and leads. Territories in tables
can be active, draft (in a proposal), or soft deleted.

For OBIEE reports, add these criteria to include only active territories:

• StatusCode = FINALIZED

• EffectiveEndDate is greater than today's date

Why did postal codes not appear sorted when I edited coverage?  
If your coverage values exceed 1000 for a territory, the values aren't sorted. Sorting more than 1000 values slows down
your UI.

What's a line of business?  
A line of business is a category for particular kinds of commercial enterprise. Modify a territory by selecting one or more
lines of business for that territory.
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For example, during implementation a software company uses a broad categorization of products for lines of business
and adds education, licenses, and consulting to their selection list for line of business.

What's the difference between unique territory number and
territory number?  
The unique territory number and territory number are both user-friendly public identifiers for a territory. If updates
are made to active territories only, using Import Management or the Less Details territory UI, then the unique territory
number and territory number are the same.

If updates are made to territories in a proposal using Import Management or the territory More Details UI. then the
unique territory number and territory number are different when there's a draft version of the territory (the territory is
in a proposal). When the proposal is activated, the unique territory number is replaced by the territory number. (This
assumes the Retain Territory Version option is enabled.)

How can I enable territory dynamic tabs and nested dynamic tabs
in Workspace?  
Search for the profile option ZCA_ENABLE_WORKSPACE_DYNAMIC_TABS and enter a value of Y. Add the
SVN_OPEN_OBJECTS_IN_DTNT_PRIV privilege to the sales administrator or an equivalent administrator role.

Related Topics
• Work with Active Territories in Workspace
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10  Multiple Currencies

Overview of Setting Up Multiple Currencies for Sales  
The applications support multiple currencies, multiple daily rates, and currency rate conversion. If you're going to use
multiple currencies, at a minimum you need to:

• Specify corporate currency

• Import or enter daily currency conversion rates

• Enable the currencies you're going to use, if you previously disabled them

Optionally, you can let salespeople select different currencies in leads and opportunities.

The applications also support different currency conversion rate types, allowing your business to maintain different
conversion rates between currencies for the same period. Examples of conversion rate types are supplied: Spot,
Corporate, User, and Fixed.

Related Topics
• Set Up Multiple Currencies for Sales

Set Up Multiple Currencies for Sales  
You must complete several steps to enable salespeople to select multiple currencies in the applications.

Note:  Perform these steps as a setup user (for example, a user with the Application Implementation Consultant job
role).

Here are the high-level steps to enable multiple currencies:

Step Description Where to Find More Information

Set the default currency profile options.
 

Set the two profile options that specify default
corporate currency and rate type.
 

See the Set Default Currency Profile Options
section in this topic.
 

Check the setting of the default currency profile
option.
 

Check the setting of the default currency profile
option. This currency is the default used for
salespeople in the transactional pages. The
default currency is also used in a salesperson's
forecast.
 

See the Check Default Currency Profile Option
Setting in this topic.
 

Ensure currencies are enabled and verify
precision.
 

Ensure that all of the currencies you plan to use
are enabled for use and verify the precision.
 

See the Ensure Currencies are Enabled and
Verify Precision section in this topic.
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Step Description Where to Find More Information

Set the multicurrency profile option for
opportunities.
 

By default, one currency is set for an
opportunity and its product lines. This default
currency is a salesperson's preferred currency.
If you want to enable multiple currencies for
opportunities, set the multicurrency profile
option.
 

See the Enable Multiple Currencies for
Opportunity Product Lines topic in this chapter.
 

Let salespeople select the currency when
editing leads and opportunities.
 

In the opportunity and lead edit pages, the
Currency list of values is read-only by default. If
you have enabled multiple currencies, you can
let users pick a different currency at the header
level by making the Currency field editable.
 

See the Let Salespeople Select the Currency in
Leads and Opportunities topic in this chapter.
 

Enter currency daily rates.
 

To load daily rates, you can use a spreadsheet
or web services.
 

See the Download the Desktop Integration
Installer section in this topic.
 

Define and maintain daily currency conversion
rates and conversion rate types.
 

The conversion rate is the ratio between two
currencies; it shows how much of one money
exchanges for another. Conversion rates are
also known as foreign exchange rates. You
define and maintain different conversion rates
between currencies for the same period using
conversion rate types.
 

See the Overview of Defining Daily Currency
Conversion Rates section in this topic. Also
see the topic, Enter Daily Rates Using the Daily
Rates Spreadsheet, in this chapter.
 

Set up cross rate rules and overrides.
 

If you want to use combinations of cross rates
across many currencies, you must:
 

• Enable cross rates and allow cross-rate
overrides

• Maintain cross-rate rules

See the topic, Guidelines for Creating
Conversion Rate Types, in this chapter.
 

After you have enabled multiple currencies, salespeople can set their preferred currency for the transactional pages and
for business intelligence. For more information, see the related topic on setting general user currency.

Set Default Currency Profile Options
Your first step in the setup is to specify the default corporate currency and rate type by setting the Corporate Currency
Default and Exchange Rate Type Default profile options.

Here's how you set the profile options:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Currency Profile Options

2. On the Manage Currency Profile Options page, click ZCA_COMMON_CORPORATE_CURRENCY and set it to
your default corporate currency. The display name for this profile option is Corporate Currency Default. It stores
configured corporate currency used across the applications.

3. Save your changes.
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4. Click ZCA_COMMON_RATE_TYPE and set it to the default currency rate type. The display name for this profile
option is Exchange Rate Type Default. It stores the default currency exchange rate type.

Check Default Currency Profile Option Setting
You also need to check the setting of the profile option that specifies default currency for users in the applications. The
profile option, Default Currency (FND_CURRENCY), not only specifies the default currency in the transactional pages, it's
also used in a salesperson's forecast. By default, the profile option is set to US dollar. You can set this profile option at
site level (affecting all users of the environment), at product level, or at user level.

Note:  Users can set their own currency preference in the Personalization screens available in the user name menu
in the global header. The setting users set for themselves override the settings that you make in the profile options
screens at site or product level.

Here's how to check the default currency setting:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

Note:  If you can't find this profile option, search for it from the main Sales offering page, using the
search available in the Tasks widget available on the right side of the page.

2. On the Manage Applications Core Administrator Profile Values page, search for and select the profile option
name, Default Currency, or the code, FND_CURRENCY.

3. Ensure the profile option value is set to your environment's default currency at site level.

To set the profile option for a specific user, create a new row in the table and enter the values as needed.

Ensure Currencies are Enabled and Verify Precision
By default, all currencies are enabled. But it's a good idea to double-check that all of the currencies you plan to use are
enabled and that their precision levels are set correctly. Precision is the number of digits placed after the decimal point.
For example, set USD to precision 2 to display one dollar as $1.00 in the UI.

Here's how to check:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Currencies

2. On the Manage Currencies page, click Search to search for all currencies, without entering any search criteria.
3. Check that the Enabled option is set for each currency you plan to use.
4. Check that the Precision is set consistently for each currency you plan to use.

Note:  When setting currency precision, be sure to set it correctly for all currencies you plan to use. This best
practice ensures that decimal places are shown consistently in the UI for all the currencies you're using.

5. If you made any changes, save your work.
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Overview of Defining Daily Currency Conversion Rates
You have a few options for defining daily currency conversion rates, and you can maintain daily currency conversion
rates between any two currencies. You can also enter daily conversion rates for specific combinations of foreign
currency, date, and conversion rate type. The ways you can load currency rates are:

• Load them manually using the Create Daily Rates spreadsheet.

• Load them automatically using web services.

For more information, see the related topics and the topics later in this chapter.

Related Topics
• What's the difference between precision, extended precision, and minimum accountable unit for a currency?

• Enter Daily Rates Using the Daily Rates Spreadsheet

• Currency and Exchange Rate Settings for Analytics

• Load Daily Rates Automatically Using Web Services

• Set General User Currency

Let Salespeople Select the Currency in Opportunities and
Leads  
For salespeople to be able to select a different currency in opportunities and leads, you must make the field editable. By
default, the currency selection field isn't editable for leads and opportunities.

Here's how to make the currency field editable:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, expand Opportunity or Sales Leads, and click Pages.
4. In the region that corresponds to the page you're modifying, duplicate the standard layout and edit the

resulting layout. For example, if you're making the field editable in opportunities, in the Creation Page Layout
region, duplicate the standard layout and then edit the resulting layout.

5. Select the newly created layout, click Actions and then click Edit UI Properties from the drop-down list.
6. Select Currency from the Field Selection drop-down list.
7. Select the custom layout in the Layout Properties section.
8. Click Update.
9. Select the Updatable option.

10. Click Submit.
11. Click Done on the Edit UI Properties: Creation Layout window and save your changes.
12. While still in the active sandbox, navigate to Sales > Opportunities or Sales > Leads as a user who's a sales

resource, such as a sales administrator or sales representative. Verify the change by editing an opportunity or
lead and validating that the Currency field is a drop-down list that users can select.

13. Publish the sandbox according to your company's business practices.
You can find more information on configuring lead and opportunity pages in the related topics.
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Related Topics
• Add the Custom Currency Type Field to Quotes

• Extend Pages for Leads

• Extend Pages for Opportunities

Enable Multiple Currencies for Opportunity Product
Lines  
You may want to let salespeople set different currencies on opportunity product lines. The setup involves the profile
option, Multiple Currencies for Opportunity Revenue Lines Enabled.

Note:  With this setup, when a user changes the opportunity currency, the change is propagated to the opportunity
product lines.

Here's how you set the profile option to enable multiple currencies on product lines:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options
2. On the Manage Opportunity Profile Options page, search for the profile option, Multiple Currencies for

Opportunity Revenue Lines Enabled (the code is MOO_REVN_ENABLE_MULTICURRENCY) and select it.
3. Set to Yes to allow different currencies at the line and header levels in opportunities. Set to No to disallow the

functionality.
4. Save your changes.

Implementation Concepts for Currencies  

Considerations for Defining Currencies  
Consider these points about entering the currency code, date range, or symbol for the currency, when you create or edit
currencies.

Currency Codes
You can't change a currency code after you enable the currency, even if you later disable that currency.

Date Ranges
You can enter transactions denominated in the currency only for the dates within the specified range. If you don't enter
a start date, then the currency is valid immediately. If you don't enter an end date, then the currency is valid indefinitely.
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Symbols
Some applications support displaying currency symbols. You may enter the symbol associated with a currency so that it
appears along with the amount.

Related Topics
• What's the difference between precision, extended precision, and minimum accountable unit for a currency?

• What's a statistical unit currency type?

• Euro Currency Derivation

Currency Precision Level for Quota Amounts  
Currency amounts for quotas use the number of decimal places set in the Precision Level field for the corporate
currency. If you don't set the precision level, then amounts are saved and displayed with two decimal places.

You set the precision level for the currency in the Manage Currencies page. The currency you select for the profile
option ZCA_COMMON_CORPORATE_CURRENCY, Corporate Currency Default, is the corporate currency.

Guidelines for Running the Revalue Opportunity Currency Process
 
The Revalue Opportunity Currency process manages the effects of revaluation of currency exchange rates on
opportunity revenue.

Opportunity revenue is stored in the user-entered currency (also called transaction currency) in the revenue model. The
revenue model also stores two exchange rates:

• The exchange rate between the entered revenue currency and the configured corporate currency, as specified
in the global configuration during the implementation. This rate facilitate construction of materialized views
that roll up revenue metrics along the territory hierarchy.

• The exchange rate between entered revenue currency and the entered opportunity-level currency. This rate
calculates the opportunity summary revenue amounts as the sum of line revenue amounts. Opportunity line
revenue amounts can be entered in currencies that are different from the currency specified at the opportunity
level.

The process works in combination with these two profile options that store corporate currency and rate type:

• Corporate Currency Default: Stores configured corporate currency.

• Exchange Rate Type Default: Stores configured rate type.

Also keep in mind the following impact of the process:

• The process can also be triggered when corporate currency, configured rate type, or exchange rate (or any
combination of these) is modified, either directly through administrator intervention or when these currency
parameters change in the general ledger.

• Only product lines in Open status are targeted by the batch process.
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• When updating product lines, the process doesn't consider whether the revenue is already included in a
forecast.

• Forecasting activity is paused when this process executes.

Run the Process
Run the Revalue Opportunity Currency process from the job process screen available from the Scheduled Processes
option on the Navigator menu. Select the job name Revalue Opportunity Currency.

Here are the steps to run the process in basic mode:

1. Sign in as a sales administrator or as a setup user.
2. From the Navigator, select Scheduled Processes (within the Tools category).

The Scheduled Processes overview page appears.
3. Click Schedule New Process.
4. In the search dialog box, search for and select the Revalue Opportunity Currency process.

The Process Details page appears.
5. Click Submit.

This table shows the logical parameters expected by the batch process:

Parameter Default Description

CRM Common Currency
 

Stored in the profile option, Corporate Currency
Default (ZCA_COMMON_CORPORATE_
CURRENCY)
 

• Configured corporate currency.

• Passed if corporate currency changes.

• Program doesn't check against profile for
a match.

CRM Common Currency Rate Type
 

Stored in the profile option, Exchange Rate
Type Default (ZCA_COMMON_RATE_TYPE)
 

• Configured rate type.

• Passed if there is a requirement to
reevaluate the conversion rate against a
different rate type.

• If no value is passed, the program uses the
profile option value.

 

Business Unit Organization ID
 

No default
 

Leave blank, and all business units are targeted.
Otherwise, provide the specific business unit ID.
 

Number of Opportunities per Database Update
 

500
 

Oracle recommends that you leave this
parameter at the default value or blank (and
program uses default value).
 

Last Batch Job Run Time Stamp
 

See Description column
 

This parameter can be used for batch program
reruns. When a few opportunities have failed,
 the log reflects all the failed opportunities, as
well as provides a time stamp for "Start Batch
Job Time Stamp". Enter this time stamp on
the second run of the batch program to limit
the scope of the batch job to only the failed
opportunities.
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Parameter Default Description

Effective Date
 

System date
 

Date passed to general ledger (using an API)
to calculate the conversion rate. The program
doesn't validate that the date must be in the
future, so, in effect, any date can be passed.
 

Impact of Process on Revenue Attributes
The Revalue Opportunity Currency process impacts several revenue attributes, as shown in this table.

Revenue Model Attribute Attribute Description/Function Batch Process Update

• CRM_CURRENCY_CODE

• CRM_CONVERSION_RATE_TYPE

• CRM_CONVERSION_RATE

These attributes store the exchange rate
between revenue line currency and the
corporate currency, and are used to construct
the materialized views for Closed, Pipeline
and Unforecasted revenue metrics along
the territory hierarchy. For lines in status
category of Open, these attributes are updated
whenever a revenue line is created or updated
or whenever an opportunity with revenue is
updated or saved.
 

• The default for CRM_CURRENCY_CODE is
taken from the profile option, Corporate
Currency Default (ZCA_COMMON_
CORPORATE_CURRENCY).

• The default for CRM_CONVERSION_
RATE_TYPE is taken from the profile
option, Exchange Rate Type Default (ZCA_
COMMON_RATE_TYPE).

• CRM_CONVERSION_RATE is calculated
using a GL API.

CRM_CURRENCY_CODE and CRM_
CONVERSION_RATE_TYPE are updated based
on a parameter to the batch program. If these
two parameters are passed in, the program
uses them to update the revenue tables. If
these values aren't passed in, the application
retrieves the profile option values and updates
the revenue tables with them.
 

REVN_AMT_CURCY_CODE
 

Currency of the revenue (summary or line)
 

Entered currency. Not updated.
 

• CONVERSION_RATE_TYPE

• CONVERSION_RATE

These attributes store the exchange rate
between revenue line currency and the
summary revenue (opportunity level) currency
and are used to convert the revenue line
amounts to opportunity level currency. For lines
in a status category of Open, these attributes
are updated whenever the revenue is created
or updated or whenever an opportunity with
revenues is updated or saved.
 

• CONVERSION_RATE_TYPE is updated
based on a parameter to the batch
program.

• CONVERSION_RATE is updated. Changes
if corporate rate types change. Rate is
obtained using (conversion_rate_type,
 line_currency_code, summary_currency_
code, and system date).

• REVN_AMT

• DOWNSIDE_AMT

• UPSIDE_AMT

For summary revenue amounts, these amounts
are calculated as the sum of line revenue
amounts. These amounts are converted to the
opportunity-level currency before calculating
the sum. The exchange rate stored in the
CONVERSION_RATE attribute is used to
perform the conversion.
 

• Line revenue isn't updated.

• Summary revenue is recalculated.
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Revenue Model Attribute Attribute Description/Function Batch Process Update

LAST_UPDATE_DATE
 

WHO column
 

Updated.
 

USER_LAST_UPDATE_DATE
 

Functional WHO column
 

Not updated.
 

Related Topics
• Considerations for Setting Up Opportunity Revenue

Enter Daily Rates Using the Daily Rates Spreadsheet  
You are required to enter the daily rates for currency conversion from Great Britain pounds sterling (GBP) to United
States dollars (USD) for 5 days.

To load rates using the Create Daily Rates Spreadsheet, you must first install Oracle ADF Desktop Integration client
software. Oracle ADF Desktop Integration is an Excel add-in that enables desktop integration with Microsoft Excel
workbooks. You can download the installation files from the Tools work area by selecting Download Desktop Integration
Installer.

Entering Daily Rates
1. From the General Accounting work area, select the Period Close link.
2. From the Tasks panel, click the Manage Currency Rates link.

Use the Currency Rates Manager page to create, edit, and review currency rate types, daily rates, and historical
rates.

3. Click the Daily Rates tab.

Use the Daily Rates tab to review and enter currency rates.
4. Click the Create in Spreadsheet button.

Use the Create Daily Rates spreadsheet to enter daily rates in a template that you can save and reuse.
5. Click in the From Currency field. Select the GBP - Pound Sterling list item.
6. Click in the To Currency field. Select the USD - US Dollar list item.
7. Click in the Conversion Rate field. Select the Spot list item.
8. Click in the From Conversion field. Enter a valid value: 10/2/2017.
9. Click in the To Conversion Date field. Enter a valid value: 10/6/2017.

10. Click in the Conversion Rate field. Enter a valid value: 1.6.
11. Click Submit and click OK twice.
12. Review the Record Status column to verify that all rows were inserted successfully.
13. Save the template to use to enter daily rates frequently. You can save the spreadsheet to a local drive or a

shared network drive.
14. Optionally, edit the rates from the Daily Rates user interface or resubmit the spreadsheet.
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Related Topics
• Examples of Using Conversion Rate Types in a Journal

• Guidelines for Using Desktop Integrated Excel Workbooks

• Update Currency Rates

Update Currency Rates  
You're required to change today's daily rates that were already entered. The rates you're changing are for currency
conversion from Great Britain pounds sterling (GBP) to United States dollars (USD) for your company InFusion America.

Currency conversion rates were entered by an automatic load to the Daily Rates table. They can also be entered through
a spreadsheet.

Updating Currency Rates
1. Navigate to the Period Close work area.

Use the Period Close work area to link to close processes and currency process.
2. Click the Manage Currency Rates link.

Use the Currency Rates Manager page to create, edit, and review currency rate types, daily rates, and historical
rates.

3. Click the Daily Rates tab.
Use the Daily Rates tab to review and enter currency rates.

4. Click the From Currency list. Select the GBP - Pound Sterling list item.
5. Click the To Currency list. Select the USD - US Dollar list item.
6. Enter the dates for the daily rates that you are changing. Enter today's date.
7. Click the Rate Type list. Select the Spot list item.
8. Click the Search button.
9. Click in the Rate field. Enter the new rate of 1.7 in the Rate field.

10. Click in the Inverse Rate field. Enter the new inverse rate of 0.58822 in the Inverse Rate field.
11. Click the Save button.

Related Topics
• Guidelines for Using Desktop Integrated Excel Workbooks

Guidelines for Creating Conversion Rate Types  
Maintain different conversion rates between currencies for the same period using conversion rate types.

The following conversion rate types are predefined:

• Spot

• Corporate

• User
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• Fixed

You can use different rate types for different business needs. During journal entry, the conversion rate is provided
automatically based on the selected conversion rate type and currency, unless the rate type is User. For User rate types,
you must enter a conversion rate. You can define additional rate types as needed. Set your most frequently used rate
type as the default. Conversion rate types can't be deleted.

Assign conversion rate types to automatically populate the associated rate for your period average and period end
rates for the ledger. For example, you can assign the conversion rate type of Spot to populate period average rates, and
the conversion rate type of Corporate to populate period end rates. Period average and period end rates are used in
translation of account balances.

Conversion rate types are used to automatically assign a rate when you perform the following accounting functions:

• Convert foreign currency journal amounts to ledger currency equivalents.

• Convert journal amounts from source ledgers to reporting currencies or secondary ledgers.

• Run revaluation or translation processes.

When creating conversion rates, decide whether to:

• Enforce inverse relationships

• Select pivot currencies

• Select contra currencies

• Enable cross rates and allow cross-rate overrides

• Maintain cross-rate rules

Enforce Inverse Relationships
The Enforce Inverse Relationship option indicates whether to enforce the automatic calculation of inverse conversion
rates when defining daily rates. The following table describes the impact of selecting or not selecting the option.

Action Results

Selected
 

When you enter a daily rate to convert currency A to currency B, the inverse rate of currency B to
currency A is automatically calculated and entered in the adjacent column. If either rate is changed, the
application automatically recalculates the other rate.
 
You can update the application calculated inverse rate, but once you do, the related rate is updated.
The option enforces the inverse relationship is maintained but doesn't prevent you from updating the
rates.
 

Not Selected
 

The inverse rate is calculated, but you can change the rate and update the daily rates table without the
corresponding rate being updated.
 

Select Pivot Currencies
Select a pivot currency that's commonly used in your currency conversions. A pivot currency is the central currency that
interacts with contra currencies. For example, you set up a daily rate between the US dollar (USD) and the Euro currency
(EUR) and another between the USD and the Canadian dollar (CAD). USD is the pivot currency in creating a rate between
EUR and CAD. EUR and CAD are the contra currencies. Select the pivot currency from the list of values which contains
those currencies that are enabled, effective, and not a statistical (STAT) currency. The description of the pivot currency is
populated automatically based on the currency definition.
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If you want the application to create cross rates against a base currency, define the base currency as the pivot currency.
Selected pivot currencies can be changed in the Rate Types page.

Select Contra Currencies
Select currencies available on the list of values as contra currencies. The available currencies are those currencies which
are enabled, effective, not STAT currency, and not the pivot currency selected earlier. The description of the contra
currency is populated automatically based on the currency definition. Add or delete contra currencies in the Contra
Currencies region of the Rate Types page.

Enable Cross Rates and Allow Cross Rate Overrides
Check the Enable Cross Rates check box to calculate conversion rates based on defined currency rate relationships.
General Ledger calculates cross rates based on your defined cross rate rules. Associate your cross rate rules with
a conversion rate type, pivot currency, and contra currencies. Cross rates facilitate the creation of daily rates by
automatically creating the rates between contra currencies based on their relationship to a pivot currency. If the Enable
Cross Rates option is deselected after entering contra currencies, the application stops calculating cross rates going
forward for that particular rate type. All the earlier calculated cross rates for that rate type remain in the database unless
you manually delete them.

For example, if you have daily rates defined for the pivot currency, USD to the contra currency, EUR, and USD to another
contra currency, CAD, the application automatically creates the rates between EUR to CAD and CAD to EUR. You don't
have to manually define the EUR to CAD and CAD to EUR rates.

Select the Allow Cross Rates Override check box to permit your users to override application generated cross rates. If
you accept the default of not selected, the application generated cross rates can't be overridden.

Maintain Cross Rate Rules
Define or update your cross rate rules at any time by adding or removing contra currency assignments. Add a contra
currency to a cross rate rule and run the Daily Rates Import and Calculation process to generate the new rates. If you
remove a cross rate rule or a contra currency from a rule, any cross rates generated previously for that contra currency
remain unless you manually delete them. Changes to the rule aren't retroactive and don't affect previously stored cross
rates. The Cross Rate process generates as many rates as possible and skips currencies where one component of the set
is missing.

Note:  With a defined web service that extracts daily currency conversion rates from external services, for example
Reuters, currency conversion rates are automatically updated for the daily rates and all cross currency relationships.

Related Topics
• Examples of Using Conversion Rate Types in a Journal

• What's the difference between calendar and fiscal period naming?

232

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20030654
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20030125


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

11  Adaptive Search and Workspace

Overview of Adaptive Search  
Oracle is completing the process of replacing the CRM search technology with Adaptive Search, a high-performance
search engine that provides keyword searching and enhanced filtering capabilities. Digital Sales UIs and features rely
exclusively on Adaptive Search. In CX Sales, some work areas still rely on legacy CRM Search technology.

By default, all customers now have Adaptive Search enabled automatically for Accounts and Contacts. You can enable
other objects using Setup Assistant or manually. Not all the available objects are sales objects. For example, Partner and
Partner Contact are only pertinent for Partner Relationship Management. HR Help Desk Request, Installed Base Asset,
Internal Service Request, and Service Request are specific to Fusion Service. Adaptive Search is also available on custom
objects or child objects you create.

Here's where you can use Adaptive Search:

• All Digital Sales UIs

• Workspace in CX Sales

A work area where salespeople can work on all of the available business objects at the same time.

• Work areas for individual business objects in CX Sales.

• Global Search in CX Sales

This is the keyword search available at the top of the page in CX Sales.

• REST APIs

Note:  Many customers run their applications and Oracle Databases in their own data centers on Oracle
Cloud@Customer. Currently, Cloud@Customer pods don't support Adaptive search.

Workspace and Work Areas Powered by Adaptive Search 

Oracle now provides work areas for the different business objects that use the same underlying Adaptive Search
technology as Workspace.

Salespeople navigating to the Accounts, Contacts, Leads, Opportunities, and other work areas get the same
improvement in search performance and pretty much the same features as Workspace. You can think of the individual
work areas as mini-Workspaces.
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Workspace
Workspace improves and speeds up searches and makes key sales information available all within a single, unified work
area. No more navigation to the Opportunities work area to see your key opportunities and then to the Leads work area
to work on your leads.

The Workspace UI icon appears on the home page in a separate Workspace tab. When you configure navigation, you
can move the icon to the Sales tab so salespeople see all the navigation icons together in one tab.

Here's a screenshot of the Workspace UI highlighting some of its key features.

Callout Number Feature Description

1
 

Select the object and saved search you want to display in Workspace.
 

2
 

Use the Search field to search within the constraints of the saved search you selected. If you selected
My Accounts, you get to view and search only the accounts where you're on the territory or in the sales
team. Selecting All Accounts, makes it possible for you to search them all.
 

3
 

Control the display of filters by clicking Display Filters and Hide Filters.
 

4
 

View the number of records in your search results.
 

5
 

Use filters to understand your search results and to narrow down your search further. Filters show
you the items with the highest number of results, for example, the industries with most accounts or
salespeople who own the most opportunities.
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Callout Number Feature Description

 

6
 

Log calls, take notes, create tasks, and take other actions on search results without having to drill down
into them. For accounts, you can even create an opportunity.
 

7
 

From time to time, you may want to export data from Workspace for offline viewing and verification.
For example, a sales manager might want to export a list of accounts to perform a more in-depth
analysis of their sales team or for reporting purposes. Only sales manager and sales administrator
roles are granted the predefined security privilege ZCA_WORKSPACE_EXPORT to access the export
data feature in Workspace.
 

Work Areas Powered by Adaptive Search
Work areas for individual business objects, provide much the same functionality as Workspace.

There are a few key differences.

• Workspace lets you work on all business objects in one place and switch between them. Work areas for
the different objects don't. For example, in Workspace, you can switch between working on accounts and
opportunities. In the Accounts work area, you can only work on accounts. To work on opportunities, you must
open the Opportunities work area.

• Work areas can include tabs with BI reports and additional functionality. For example, the Territories work area
includes additional features that Workspace doesn't. It enables the creation of sales territory hierarchies.

• The work areas for the individual business objects don't support dynamic tabs, a feature targeted at service
users.
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These work areas support the Adaptive Search and other Workspace features:

• Accounts

• Activities

• Assets

• Campaigns

• Contacts

• Deal Registrations

• Leads

• Opportunities

• Partners

• Quotes and Orders

• Territories

The few sales work areas still use the legacy CRM Search include the following:

• Products

• Competitors

• Business Plans

• Price Books

• Service Requests

How Salespeople Search in the UI and What You Can Configure
Here's how salespeople use both the Workspace UI and the work areas powered by Adaptive Search and how you can
modify the default behavior provided by Oracle.

How Salespeople Search in the UI What Administrators Can Configure

Selecting a saved search displays a list
that matches the saved search criteria and
determines the scope of any search you
perform on the page. For example, if you
select All Accounts, you're searching all
accounts you can view. If you select My
Accounts, then you're searching only the
accounts that you own.
 

You can create your own saved searches targeted to specific roles within the sales organization. And
you can determine which saved search appears by default when salespeople open the UI. Salespeople
can create their own personal saved searches and override the administrator defaults.
 

You can enter one or more search terms in
the Search field.
 
You can use related information for your
searches. For an account, you can search
by company name, the city where the
account is located, or the primary contact
at the company, for example. You can even
search for an account by the name of the
salesperson on the sales team.
 
The search results match whole terms,
 but you can use the (*) wildcard for partial

You can enable or disable the attributes available for search. Oracle enables the most common
attributes for you, but you must enable the search for any child objects and fields you create in
Application Composer.
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How Salespeople Search in the UI What Administrators Can Configure

words and use operators, including NOT,
 OR, and Between for date ranges.
 

You can view the filters used in the saved
search by clicking the Show Filters link.
You can also add filters of your own.
 

You can specify which additional fields users can add as filters and you can set up groupings of values
the filters show. For example, you can break down opportunities by revenue ranges: 0 to 10,000, 10,
000 to 100,000, 100,000 to 500,000, and 500,000 and up.
 

Filters show the most common values
and the number of records in each. For
example, a search of accounts with the
primary industry as a filter, automatically
displays the most frequent industries and
the number of records for each. A search
of opportunities using win probability as
a filter, displays different ranges of win
probabilities and the number of records in
each range.
 
Your filter selections are additive, if
you select Health Care as the primary
industry and then Lisa Jones as the owner,
Workspace displays only those Health Care
accounts Lisa owns.
 

You can configure value ranges for numeric, corporate currency, percent, and date filters. For example,
 you can configure value ranges for the opportunity win probability filter and other similar filters.
 

Salespeople can save any search criteria
they enter as their own personal saved
search.
 

You can create saved searches for use by the whole sales organization and you can tailor them to
different roles.
 
You can expose the saved searches as filters in Workspace infolets to display key sales information
right on the home page.
 

Sales administrators and sales managers
can download search results into an Excel
spreadsheet.
 

You can remove the Export List button from the page using Application Composer. You can also enable
other custom sales roles to use the button, by granting the privilege ZCA_WORKSPACE_EXPORT.
 

Who Gets Workspace and New Work Areas Automatically
 
Oracle automatically enables Adaptive Search and Workspace for accounts and contacts for all customers. Oracle
runs the Publish process behind the scenes, and the Workspace icon is available on the home page for salespeople to
manage accounts and contacts without any additional setup.

New customers get the new work areas powered by Adaptive Search by default. Existing customers must still opt in to
the Open Work Areas Powered by Adaptive Search  feature to get the new work areas.

When you enable an object for Adaptive Search, salespeople clicking on its icon get the new work area. Clicking on an
icon for an object that hasn't been enabled, opens the legacy work area.
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Adaptive Search Setup  

A Quick Rundown of the Adaptive Search Setup UI  
Here's a quick rundown of the Configure Adaptive Search page. The rest of this chapter provides the details.

The Configure Adaptive Search page is made up of five tabs:

• Monitor

• Setup

• Parameters

• Configure UI

• Configure Global Search

Setup
The setup tab includes the Quick and Advanced subtabs. Use the Quick subtab to get an overview of the predefined
and custom objects are available for Adaptive Search. If you're OK with using the search configuration provided by
Oracle, you can select the objects you want to enable and click Publish.

On the Advanced subtab, you can change which objects and fields are enabled for search, how they're searched on, and
other search configurations. You can also enable and disable objects for searching. Click Publish to save these changes.
Once the publish job is complete, any user with permission to access an enabled object can search on fields enabled
within the object, retrieve search results, create saved searches, and more.

The left side of the Advanced subtab shows the ready-to-use objects, including any custom objects or child objects you
created in Application Composer. The right portion lists the fields, including any custom fields you created. You can also
view field names and their types and can enable up to 15 fields for use in searches of related objects in the Include in
Object Reference column. You must publish your changes before they take effect. See the Search Setup section of this
chapter for details.

Note:  To enable search on custom fields and custom child objects, you must first publish them from the sandbox. You
can't use the Configure Adaptive Search UI within a sandbox.
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Monitor
You can monitor the publish process as well as other indexing and maintenance processes on the Monitor tab. From
here, you can view the real-time progress of Adaptive Search indexing jobs. When you click Publish, a progress bar
indicates how much of the indexing job has been processed and what percentage remains to complete the indexing
process. See the Monitor Adaptive Search Background Processes topic for more details.

Parameters
You can configure various parameters to specify how Adaptive Search behaves, using the Parameters tab available in
the Adaptive Search setup page. For example, you can enable mass update and actions, set record-level navigation,
specify the fuzziness level for search, and so on. See the Enable Adaptive Search Parameters topic for details.
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Configure UI
You can use the Configure UI tab to specify which fields are available for selection as filters and for display as columns
in search results. You can also set up filter value groupings or value ranges for date and numeric fields. Users can select
these value groupings to filter search results. See Enable Fields for Display as Filters and Search Result Columns for
details.

Note:  When editing UI columns and specifying fields, always ensure that you have at least four fields selected for
both standard and custom objects.

From here, you can also add or remove Create, Export, and Mass Update buttons for every object using the following
check boxes:

• Create

• Export

• Mass Update

For example, follow these steps if you want to restrict the export option in Workspace based on the Account object.

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and click the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
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3. Click Configure UI.
4. Select Account in the left pane of the tab as the object you want to restrict the export option in Workspace.
5. Uncheck the Export option in the Features section as highlighted in this sample screenshot.

6. Click Save and Close.

You can verify your changes as follows:

1. Log out and Log in again as a sales representative user.
2. Navigate to Workspace > My Accounts Saved Search
3. Verify that the Export List button isn't displaying in the Account Workspace List Page.

See Access Workspace Data Offline for more information.

Configure Global Search
Global search enables you to search for any object to which you have access across Sales and Fusion Services. Searches
are performed across various fields and related objects and across custom fields. Results can be filtered based on
objects and Last Updated Date.

Once you enable global search to use the adaptive search engine, you can use the Configure Global Search tab to:

• Configure objects to be included in Global search.

• Define attributes to be included in the search results.

• Define the format and content of Title, Line 1, and Line 2 of each matching record's search result.

For more information about how to enable Global Search, see the topics in the Global Search section of the Global and
Work Area Search chapter of the sales Implementation Reference guide.
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Overview of Adaptive Search Setup  

Here is a summary of the setup steps for enabling and configuring Adaptive Search. You must have the Application
Implementation Consultant job role to complete the setup. Only the first step is required.

When you enable business objects for Adaptive Search or change the way search is implemented, you must run the
Publish indexing process for the changes to take effect. Other setups take immediate effect.

Step Description Publish Required? Where to Get More Details

1
 

Open the Configure Adaptive
Search task and select the objects
you want on the Setup Quick tab.
 
To use the configuration provided
by Oracle, click Publish to run the
indexing process. Workspace is
ready for use and accessible from
the home page after the process
completes. You can monitor the
process progress by clicking the
Publish link on the Monitor tab.
 

Yes
 

See the following topics in this
chapter:
 

• A Quick Rundown of the
Adaptive Search Setup UI

• Monitor Adaptive Search
Background Processes

2
 

You can modify how search
operates on the Setup Advanced
tab of the Configure Adaptive
Search page. For example, you
can specify which fields of an
object and its related objects can
be used in searches and displayed
as search filters. Because Oracle
configures the fields for you,
 setup is optional unless you
want to enable search on custom
child objects and fields, or to
change Oracle's default search
configuration.
 
You must run the Publish process
for your changes to take effect.

Yes
 

See How Search Action is Modified
and related topics.
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Step Description Publish Required? Where to Get More Details

 

3
 

You can configure search filters
on the Configure UI tab of the
Configure Adaptive Search page.
You can:
 

• Specify which fields can be
used as filters in UI searches
and for display in search
results.

• Define groupings of filter
values for use during search.

For example, you can break
down opportunities by
revenue ranges: 0 to 10,000,
 10,000 to 100,000, 100,000
to 500,000, and 500,000 and
up.

No
 

See the following topics in this
chapter:
 

• Create Groupings of Values
for Display in Search Filters

• Enable Fields for Display as
Filters and Search Result
Columns

• Set Up Search Results in
Groups

4
 

You can create and share saved
searches for different roles in
the organization. You must open
Workspace to complete this setup.
 

No
 

See the Create and Manage Saved
Searches topic.
 

Enable Business Objects for Adaptive Search  
Enabling a business object builds a search index and makes the object available for Workspace, enables navigation from
the business object icon to the work area powered by Adaptive Search, and makes the object available for Global Search,
REST web services, and Workspace infolets.

Watch video
 

How Adaptive Search is used varies by object. Some objects are available through REST web services only. For more
details, see Overview of Adaptive Search. Here's how to enable business objects for Adaptive Search.

1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

Note:  If this is your first time configuring Adaptive Search, then with the Sales Foundation functional area
selected, click Actions and then select Change Feature Selection from the list. In the Edit Features: Sales
Foundation page, click Enable for Configure Adaptive Search and click Done.

2. On the Configure Adaptive Search page, click the Setup tab.
3. On the Setup tab, Quick subtab, select the objects you want to enable for Adaptive Search:
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◦ Account

◦ Activity

◦ Asset

◦ Case - (available only in Adaptive Search REST API)

◦ Campaign

◦ Competitor - (this unique object doesn't have a list page of its own in Workspace)

◦ Contact

◦ Deal Registration

◦ HR Help Desk Request - (available only in Adaptive Search REST API)

◦ Installed Base Asset- (available only in Adaptive Search REST API)

◦ Internal Service Request - (available only in Adaptive Search REST API)

◦ Lead

◦ Opportunity

◦ Partner

◦ Partner Contact

◦ Product (available only in Adaptive Search REST API)

◦ Product Group (available only in Adaptive Search REST API)

◦ Quotes and Orders

◦ Quote and Order Line

◦ Revenue Lines

◦ Service Request

◦ Territory

◦ Work Order (available only in Adaptive Search REST API)

Enabling an object enables any custom child objects and any custom fields you created. Not all the objects are
sales objects. Partner and Partner Contact are only pertinent for Partner Relationship Management. HR Help
Desk Request, Internal Service Request, and Service Request are specific to Fusion Service. The Case, HR Help
Desk Request, Installed Base Asset, Internal Service Request, Product, Product Group, and Work Order objects
can be enabled for REST web services only.

Note:  Making the selection on the Quick tab enables the default search configuration. Use the Advanced tab
to modify search behavior and to enable custom objects.

4. By default, the objects you enable on the Quick subtab are enabled in all the UIs that use Adaptive Search as
well. You can disable objects from appearing in those UIs using the Configure UI and Configure Global Search
tabs, but keep them available for REST web services.
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5. Click Publish.

Your action runs an indexing process and an hourly index refresh for the objects you selected. You can monitor
the progress of the indexing process on the Monitor tab. The process can take several minutes to complete,
depending on your data volume.

Note:  You can choose to publish only those objects for which you have changed the configuration. This
avoids having to perform a full publish every time a configuration change is done, thus saving a lot of time.

6. Click the Monitor tab and Publish subtab to monitor the process. After the process completes with a status of
succeeded, the Workspace icon appears on the home page. If the process completes with errors, contact your
help desk.

Switch to Work Areas Powered by Adaptive Search  
Here's how existing customers can switch from the legacy work areas to the new work areas powered by Adaptive
Search. No action is required for new customers who get the new work areas by default.

You must complete these steps:

• Use the Opt In UI to enable this feature.

• Make sure that the business objects for the work areas are indexed.

• You select the Display Object in Workspace check box on the Configure UI tab in the Configure Adaptive
Search page.

See the Configure UI section of "A Quick Rundown of the Adaptive Search Setup UI" topic for more information.

Note:  Salespeople granted the View Fuse List as Default List Pages (ZCA_VIEW_FUSE_LIST_PAGES) privilege, are
taken to the legacy work areas that use CRM Search technology instead of the new ones.

Opt in to Enable Work Areas Powered by Adaptive Search
Here's how existing customers can enable navigation to the new work areas that use Adaptive Search.

1. Sign in as a setup user.
2. In the Setup and Maintenance area, go to the Sales offering.
3. Select the Change Feature Opt In from the Sales Foundation functional area and open the Edit Features:

Sales Foundation page.
4. In the Features column, locate Open Work Areas Powered by Adaptive Search.
5. Click the pencil icon and select the Enable check box.
6. Click Done.

For more information, see the New Feature Opt-In section of the Oracle Applications Cloud - Using Functional Setup
Manager guide on the Oracle Help Center (docs.oracle.com).
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Monitor Adaptive Search Background Processes  
Adaptive Search requires a number of background processes to run periodically. You can monitor these processes on
the Monitor UI tab of the Configure Adaptive Search page. For example, you can view the real-time progress of Adaptive
Search indexing jobs.

When you click Publish, a progress bar indicates how much of the indexing job has been processed and what
percentage remains before completion. This feature lets you have better visibility on the Publish job progress so that
you can plan your operations accordingly.

Note:  If you update job request parameters after a job is submitted, then the results displayed on the progress bar
may be unreliable.

You also receive email notifications about the status of Publish jobs for Adaptive Search if scheduled jobs haven't
completed within a 12 hour time frame. For example, you're notified about the successful completion of published
processes or receive an alert of failed processes that might be causing issues with data access. Emails are sent to
the user who submitted the last successful publish job, periodic job, or to the user who submitted the first successful
publish job if the ESS data isn't already purged. You can also specify additional email addresses when you schedule the
publish job.

The Monitor UI tab includes subtabs where you can monitor the processes. The following table describes the processes,
provides a recommended run schedule, and explains what actions you can take on each tab.

Note:  Oracle recommends that you perform a full publish at least once in very two releases. When the full publish
job completes successfully, your Adaptive Search configuration becomes the latest active meta model. This ensures
that users have the latest features and enhancements and aren't limited in functionality due to an older version of
an active meta model being in use.  The recommended schedule for some processes may vary according to your
business requirements, existing run assignments, and data load schedules.

Process and Tab Name Process Description Recommended Schedule Available Actions

Periodic Refresh
 

Indexing enables Adaptive Search
to find records based on keyword
search terms entered, search
filters, saved search criteria, and
other search criteria. Periodic
Refresh enables Adaptive Search
to search for imported records and
records that have gone through
the mass update process. While
records you create and update in
the UI are automatically indexed
and made searchable within
seconds, imported records or
records updated by background
processes aren't available for
search until the process completes.
 

Every hour
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.

• Cancel Process cancels the
instance of the process you
selected.
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Process and Tab Name Process Description Recommended Schedule Available Actions

Note:
The Publish process should be
completed before running the
Periodic refresh.
 

Publish
 

Publishes the Adaptive Search
configuration you set up in the
Quick Setup and Advanced Setup
UIs.
 

Note:
For CLOB (Character Large
Object) fields, only the first
4000 characters are indexed.
 
New CLOB fields are no longer
supported in Workspace.
 

Note:
Formula fields can't be
configured.
 
Also system generated ID fields
aren't available to enable for any
objects in Adaptive Search.
 
For example, you can't search on
system ID fields in Workspace
such as Party ID, SR ID, Opty ID,
 Record ID for custom object
and so on. Such fields aren't
searchable and can't be indexed
by design.
 

At least once in very two updates.
 
You must click Publish to run
the process each time you make
changes on the Setup tab.
 
Here are the different phases you
can monitor from the progress bar:

• Preparing for Indexing

• Indexing in Progress

• Updating References

• Updating Latest Changes

• Activating Indexes

• Completed

 
Your changes become effective
when the process completes.
 

You can monitor the progress
of the publish process. Your
configuration is active when the
process completes successfully.
 
If the process fails to complete
successfully, contact your help
desk.
 

Maintenance
 

Backs up the current active meta
model, removes older snapshots,
 and cleans up any search server
index or snapshots that aren't
associated with any workflow state
of the meta model.
 

Note:
Restore from Backup is
disabled if a meta model is
being published.
 

Daily
 

You can restore the current active
Adaptive Search configuration by
clicking Restore from Backup.
This action clears any saved
changes that aren't yet published.
 
If you want to restore the last active
Adaptive Search configuration
version, then click Revert to
Previous Version.
 
Any other actions should be taken
by your help desk.
 

Territory and Resource Hierarchy
Refresh
 

Updates the index with sales
territory and resource hierarchy
changes.
 

Weekly
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.
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Process and Tab Name Process Description Recommended Schedule Available Actions

• Cancel Process cancels the
instance of the process you
selected.

Update Aggregates
 

Updates the index with aggregate
changes.
 

Weekly or as required.
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.

• Cancel Process cancels the
instance of the process you
selected.

Synchronize Access Rules Data
 

Updates access group object
sharing rules.
 

Automatically runs when a job,
 Perform Object Sharing Rule
Assignment Processing, or job set
is submitted for a batch of access
group object sharing rules for all
the available assignment objects.
 

Depending on your requirements,
 you can change the process
frequency by clicking Schedule
Periodic Refresh. You can also
manually Start or Cancel the
process at any time.
 

How To Change Periodic Refresh Frequency
The default periodic refresh process runs every hour. However, you may want to change the frequency to run every 15
minutes so that any new records quickly appear in your Workspace saved searches.

Here's how to change the periodic refresh frequency.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. From the Configure Adaptive Search page, click Monitor >  Periodic refresh.
4. Select the job row which is currently running hourly and has a status of Wait.
5. Click Schedule Periodic Refresh.
6. Click Change Frequency and adjust the schedule to run every 15 minutes or per your specific requirement.

Adaptive Search Meta Model Types
Adaptive search saves the published configuration so you can restore the behavior you had before. Or you can restore
to the seeded one. Meta models encode the information that's necessary to index the entities that are searched.
Adaptive Search supports the following meta models, each with a distinct workflow state.

• Seeded Meta Model

A ready to use model that's shipped to customers. You can click Restore Defaults to revert to the predefined
meta model.
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• Sandbox Meta Model

A modified version of the Adaptive Search configuration is stored and saved when you make changes to the
configuration and click Save or Save and Close.

• Being Published Meta Model

When the configuration changes are saved and you click Publish, the meta model is in a state of being
published.

• Active Meta Model

When the full publish job completes successfully, it becomes the active meta model.

• Archived Meta Model

The previous successful version of the configuration becomes the archived meta model. There is only one
archived version available.

Index Date Ranges for Adaptive Search Objects
Adaptive Search objects are categorized into transactional objects and reference objects. Transactional objects store
CX Sales and Fusion Service transactions while reference objects don't. The following sections outline how the search
records for both types of objects are indexed.

Transactional Objects
When indexing transactional object search records for the first time, Adaptive Search only index records that have the
"Last Updated Date" within the last 365 days. Thereafter, records that are modified or created from transactional objects
are incrementally added to the index. Here's a list of the Adaptive Search transactional objects:

• Activities

• Campaigns

• Case

• Deal Registration

• HR Help Desk Request

• Internal Service Request

• Leads

• Opportunities

• Quotes and Orders

• Quote and Order Lines

• Revenue Lines

• Service Requests

• Work Order

Note:  Adaptive Search transactional object details are updated asynchronously during Near Real-time Indexing. The
asynchronous update happens after the objects in the above list are refreshed.

See the following transactional object examples of what content is indexed for a specific action on a particular date for
Opportunity records:
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Date Action Index Content

Dec 15, 2018
 

Publish job is run
 

Records, which have Last Updated Date > Dec
15, 2017
 

Jan 10, 2019
 

New Opportunity created with name Green
Servers
 

All previously indexed records plus the new
opportunity record (Green Servers) created
 

Jan 20, 2019
 

20 new opportunities created by an import job
 

All previously indexed records plus the 20 new
records created (after the periodic refresh job
completes)
 

Reference Objects
All records from the reference objects are indexed. Custom objects are treated as reference objects and hence all of their
records are indexed. Here's a list of the Adaptive Search Reference objects:

• All custom objects

• Account

• Asset

• Contact

• Installed Base Asset

• Partner

• Partner Contact

• Product

• Product Group

• Territory

Edit Adaptive Search Parameters  
You can configure how Adaptive Search works and control how the Workspace interface based on Adaptive Search
operates using the Parameters tab available in the Adaptive Search setup page.

Modify the parameters to define the way the Adaptive search engine operates and runs the search indexing. For
example, you can perform a partial publish to enable you to publish only those objects that have configuration
modifications. This avoids having to perform a full publish every time a configuration change is done thus saving time.

Some of the parameters you can modify include timeouts, fetch sizes, maximum number of batches and so on. You can
change parameters so that the indexing process runs successfully based on the server size and the volume of data to be
indexed.

Parameter settings include the ability to enable mass actions and record-level navigation, specify the fuzziness level for
search, set the default number of records to be displayed per page, and set the maximum number of records to export
at one time. For example, you might want to modify parameter values for the following:

• Set the maximum columns allowed in the Workspace list page

• Enable Group By in Workspace
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• Enable Mass Actions

• Enable Mass Update

• Enable record level navigation

• Fuzziness Level

• Maximum Number of Records for Export

• Number of records displayed per page in Workspace

• Enable Partial Publish

You can also choose to change current and default values. Here's how to edit Adaptive Search parameters.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters tab.

4. Highlight the Parameter Name that you want to change and click Edit. This warning is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. Do you want to 
continue?

5. Click Yes.
6. In the Current Value field, makes the changes that you require and click Save and Close.
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This table outlines the list of Adaptive search parameters available and shows the minimum, maximum, and default
values.

Parameter Name Description Minimum Value Maximum Value Default Value

Decouple incremental job at
the end of Publish
 

At the end of a Publish
process, a periodic refresh
is run so that any records
updated during the Publish
process get updated.
By default the decouple
parameter is set to N which
means that the periodic
job is run after the Publish
process. Change this
parameter to Y if you don't
want the periodic process
to run.
 

None
 

None
 

N
 

Enable Group By in
Workspace
 

Enable this parameter
to view search results in
groups based on specific
fields on the object or
related objects. Salespeople
get an overview of the
number of records in each
Grouped By grouping
and they can search and
filter records within these
groupings. They can also
view aggregates such as
count, average, and sum
of values on the records of
each group.
 

None
 

None
 

N
 

Enable Keyword
Highlighting in Workspace
 

Setting this parameter
means that any keywords
entered in the Search box
are highlighted in the
search results returned in
Workspace.
 

None
 

None
 

Y
 

Enable Mass Actions
 

You can perform some
actions on multiple records
at the same time. For
example, you can select
multiple leads in Workspace
and qualify them at once by
selecting the Qualify action.
 

None
 

None
 

Y
 

Enable Mass Update
 

You can update multiple
records at the same time.
This saves you time and
helps improve efficiency.
For example, you might
want to update the close
date for opportunity
records at the same time or
change the Lead rank from

None
 

None
 

N
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Parameter Name Description Minimum Value Maximum Value Default Value

Cool to Warm for a number
leads.

Note:
Use the Configure UI
tab from the Configure
Adaptive Search page to
specify which fields to
enable for mass update.
In addition, ensure that
you select the Mass
Update check box
and have at least four
fields selected for both
standard and custom
objects.
 

 

Enable record level
navigation
 

You can use Previous
and Next buttons on the
record details page to
navigate lists of records in
Workspace.
 

None
 

None
 

Y
 

Enable Partial Publish
 

Set this parameter to do a
publish on selected set of
objects without doing a full
publish.
 

None
 

None
 

N
 

Fuzziness Level
 

This parameter defines
the number of character
edits that's considered
when a keyword search is
performed. For a value of 1,
 the search term "redwood"
returns Redwood in the
search result.
 

None
 

Two
 

One
 

Initial target shard size
required for index in GB
 

This parameter lets you
set the initial target shard
size for your search index
file. 30 GB is the predefined
value.
 

1
 

9999
 

30
 

Lookup Type Cache
Concurrency Level
 

You can configure the
Adaptive search lookup
caching to build pipelines
concurrently when the
lookup table or index file is
large. The default number
of pipelines is 2.
 

1
 

10
 

2
 

Lookup Type Cache Initial
Capacity
 

Set the initial capacity for
the concurrent hash map
that's used for the lookup
type cache.

16
 

10000
 

16
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Parameter Name Description Minimum Value Maximum Value Default Value

 

Lookup Type Cache Load
Factor
 

You can modify the cache
load factor for the lookup
type cache. The default
factor is 0.75.
 

0.5
 

1.0
 

0.75
 

Maximum Number of
Columns to Optimize
Column Sizing in
Workspace/List Page

Select the maximum
number of columns for
optimal sizing in Workspace
list pages. The default is
8 columns to optimize
column sizing.
 

1
 

20
 

8
 

Maximum columns allowed
in the Workspace/List Page
 

Adjust the number of saved
search columns to display
in Workspace list pages.
The default is 20 columns.
 

1
 

40
 

20
 

Maximum Number of
Records for Export
 

This parameter represents
the maximum number
of records to save to the
desktop in a single Export
action by users.
 

1
 

10000
 

2000
 

Maximum number of
records that can be selected
in Workspace
 

This parameter enables you
to change the maximum
number of records that can
be selected in Workspace
to perform a mass action.
The default number is 10
records and you can select
up to 25 records.
 

1
 

25
 

10
 

Minimum Characters to
type in Search Box before
Suggestions Filters are
displayed
 

This parameter lets you
change the minimum
number of characters
that you must include
in the Search box before
the suggestion filters
are displayed. The
default minimum value
is 1 character. A value
of 0 means the Filter
Suggestions display
immediately on clicking in
the search box.
 

0
 

100
 

1
 

Number of records
displayed per page in
Workspace
 

You can change the
number of records
displayed on the search
results page from the
default value of 25 records
up to a maximum of 100
records.
 

1
 

100
 

25
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Parameter Name Description Minimum Value Maximum Value Default Value

Screen Width in Pixels to
Optimize Column Sizing in
Workspace/List Page
 

Adjust the screen width
in pixels to optimize the
size of columns displayed
in Workspace list pages.
The default value is set as
auto, which means that the
screen will automatically
adjust to the number of
columns on the page.
 

1280
 

3840
 

Auto
 

Search Filter Limit
 

Set the number of filters
you can include for your
search. The default number
of filters is 6.
 

1
 

10
 

6
 

Shard maximum size
required for index in GB
 

This parameter lets you set
the shard maximum size
for your search index file in
gigabytes (GB).
 

1
 

9999
 

45
 

Related Topics
• Access Workspace Data Offline

How To Publish a Limited Set of Objects in Adaptive Search  
You can choose to publish only those objects which have changed their configuration by performing a partial publish.
This avoids having to perform a full publish every time there is a configuration change.

This significantly reduces the publishing time when changing Adaptive Search configuration or when adding new
objects to your Workspace or other work areas powered by Adaptive Search.

For example, you have enabled 2 additional objects, Asset and Partner. You also made changes to the Account and
Opportunity search configuration. If you have enabled the partial publish parameter, then instead of having to do a full
publish of Adaptive search, you can now select and republish only both the additional enabled objects and the updated
objects. The Enable Partial Publish parameter is enabled by default, but if you want to disable it, do the following:

1. Sign in as a user with an administrator or setup role.
2. Go to the Configure Adaptive Search setup task.
3. Click the Parameters tab.
4. Click Edit to enable edit mode on the page.
5. Update the value of Enable Partial Publish from Y to N.
6. Click Save.

Partial Publish a Limited Set of Objects
Once you have the Enable Partial Publish parameter enabled, you can choose to perform a partial publish on a
selected set of objects without doing a full publish.
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Note:  Whenever a quarterly update happens, the Adaptive Search configuration version isn't updated unless a Full
Publish is done. In such a situation, the runtime searching isn't affected and will continue to work. However, the partial
publish feature won't be available. If you need to make any changes, you will have to do a Full Publish once to bring
the configuration version to the latest version and only then can a Partial Publish be performed. If performing a CSM,
a full publish is automatically started and when complete, you can make any changes to your configuration using the
partial publish feature.

Here are the steps to perform a partial publish.

1. Sign in as a user with an administrator or setup role.
2. Go to the Configure Adaptive Search setup task.
3. From the Configure Adaptive Search page, click Setup  > Advanced.
4. From the Actions menu, select Partial Publish.
5. Select only those objects you want to republish and click Proceed with Partial Publish.
6. Review your partial publish selections from the Partial Publish dialog and then click Publish.

Enable the Favorite Field for Quick Access to Records  
You can designate records as favorites so that salespeople can quickly reach them to view and edit the records that they
want.

Once you enable the favorite field for specific objects, then salespeople can add a filter for favorite records in the
Workspace UI to help improve the speed to reach records.

Enable the Favorites field on the object for which you want salespeople to have easy access to frequently used records:

1. Sign in to the application as a sales administrator or a setup user.
2. Go to the Configure Adaptive Search task in Setup and Maintenance.
3. Click Setup and then the Advanced subtab.
4. Select the business object you want and from the Configure Fields: area, search for the Favorite field.
5. Select the Enable check box to enable the Favorite field for the selected business object.
6. Repeat steps 4 and 5 to enable the Favorite fields for all the other business objects.
7. Click Save and then click Publish.

Once enabled, from the Workspace UI, salespeople can change the columns that display for their search results. For
example, they can add the Favorite column to display on the search results page and in what order by clicking Edit
Column (the pencil icon).

1. From the Edit Columns page, search for Favorite.
2. Select Favorite and move from the Available area to the Selected area.
3. Click OK.

Those records that are marked as favorites are represented by a color-filled star icon. Those items not marked as
favorites have a clear star icon. You can remove and add items to suit your requirements. When selected, the clear star
icon changes to a filled star. You can also change the width of the columns by dragging their sides. Your preferences can
be saved as part of a saved search.

Related Topics
• How Users Mark Favorite Records
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How to Migrate Your Adaptive Search Configurations from Test to
Production Environments  
You can migrate your Adaptive Search configuration along with other configurations from your test environment to your
production environment. From the Navigator, select Configuration Migration . For more detailed information, see the
section Moving Application Changes in the Configuring Applications Using Application Composer guide.

To include the Adaptive Search configuration in your configuration migration, select the Workspace Configuration
option. Before you migrate any changes, you must ensure that:

• ZCA_MANAGE_INTERACTIVE_LISTS_SAVED_SEARCH privilege is assigned to your role

• All changes are published on the target environment.

• There's no publish job in progress.
Note:  For CSM export, you must first run a publish job from Configure Adaptive Search to ensure that the
active meta model version is updated to the latest release.

An error occurs if a publish job is in progress and if a Configuration Set Migration (CSM) import is triggered. Only
migrate changes after your Adaptive Search publish has completed on the target.

Selecting the Workspace Configuration option migrates all of your Adaptive Search configurations except for saved
searches you created. You must recreate any custom saved searches in the production environment after the migration
is complete.

Trigger the CSM import on the customer environment only when all published jobs are in a successful state. After the
successful completion of your CSM migration:

1. Navigate to your target environment and configure the Workspace UI.
2. Run a Publish job to ensure that all changes are indexed and available to Workspace.

Note:  Don't manually configure the production environment for the features you're migrating.

Adaptive Search Configuration Provided by Oracle  
Oracle provides you with a default Adaptive Search configuration as outlined here. For each of the supported business
objects, the table lists:

• The fields you can add as filters

• The fields you can search using the Search box in all the UIs that use Adaptive Search

Fields in parentheses can be included as filters. For example, you can filter an account by contact name, primary
address, primary phone, and so on.

Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

Account • Addresses • Name
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Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

 • Contacts

(Name, Primary Address, Primary Email,
 Primary Phone)

• Created By

• Creation Date

• Emails

• Industries

• Instant Messages

• Last Updated By

• Last Updated Date

• Name

• Organization Types

• Owner

• Phones

• Primary Address

• Primary Contact

(Name, Primary Address, Primary Email,
 Primary Phone)

• Primary Email

• Primary Industry

• Primary Instant Message

• Primary Organization Type

• Primary Phone

• Primary URL

• Record Set

• Registry ID

• Team Members

• Type

• URLs

• Primary Address

• Primary Contact

(Name, Primary Address, Primary Email,
 Primary Phone)

• Primary Email

• Primary Industry

• Primary Instant Message

• Primary Organization Type

• Primary Phone

• Primary URL

• Registry ID

Activity
 

• Account (Name, Primary Address)

• Activity

• Asset (Asset Number, Serial Number)

• Call Report Count

• Consumer

• Contacts

(Name, Primary Address, Primary Email,
 Primary Phone)

• Created By

• Creation Date

• Account (Name, Primary Address)

• Consumer

• Description

• Meeting Minutes

• Owner

• Primary Contact

(Name, Primary Address, Primary Email,
 Primary Phone)

• Subject
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Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

• Date

• Delegated By

• Description

• Dismiss

• Due Date

• Last Updated By

• Last Updated Date

• Lead (Lead Name)

• Location

• Meeting Minutes

• Opportunity (Name)

• Owner

• Primary Contact (Name)

• Priority

• Private

• Record Set

• Start Date

• Status

• Subject

• Team members

• Type

Asset
 

• Account (Name, Primary Address)

• Asset Name

• Asset Number

• Competitor Asset

• Consumer

• Contacts

(Name, Primary Address, Primary Email,
 Primary Phone)

• Created By

• Creation Date

• Description

• End Date

• Install Date

• Last Updated By

• Last Updated Date

• Manufacturer

• Model

• Account (Name, Primary Address)

• Asset Name

• Asset Number

• Consumer

• Description

• Manufacturer

• Model

• Product

• Product Group

• Serial Number
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• Product

• Product Group

• Purchase Date

• Purchase Unit Price

• Quantity

• Record Set

• Serial Number

• Status

• Team Members

• Version

• Year

Campaign
 

• Actual Cost

• Budgeted Cost

• Campaign Created By

• Campaign Creation Date

• Campaign Last Update Date

• Campaign Last Updated By

• Campaign Number

• Created By

• Created by Module

• Creation Date

• Description

• End Date

• Last Updated By

• Last Updated Date

• Name

• Owner

• Parent Campaign

• Product Description

• Region Code

• Source System Campaign ID

• Start Date

• Status

• Total Leads

• Total Opportunities

• Total Opportunities Revenue

• Type (Campaign Number, Name, and
Status)

• Campaign Number

• Description

• Name

• Origin

• Parent Campaign

• Source System Campaign ID

• Status

• Type
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Case
 

• Account (Name, Primary Address)

• Activity ID

• Actual Start Date

• Address Line 1

• Assigned To (Name, Primary Email,
 Primary Phone)

• City

• Contact (Name, Primary Address, Primary
Email, Primary Phone)

• Contact Name

• Country

• Created By

• Creation Date

• Email

• Estimated Start Date

• Favorite

• Field Service Resource (Name, Primary
Email, Primary Phone)

• Integration

• Last Updated By

• Last Updated Date

• Partner Account (Name, Primary Address)

• Phone

• Postal Code

• Primary Asset (Asset Number, Serial
Number)

• Product (Name)

• Product Group (Name)

• Record Set

• Reference Number

• Requested Date

• Requested Date and Start Time

• Requested Time Slot

• Resolution Due

• Scheduled Date

• Scheduled Date and Start Time

• Scheduled Time Slot

• Service Request (Channel Type, Owner
Type, Reference Number, Stripe Code,
 Title)

• State

• Reference Number

261



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

• Status

• Time Zone

• Title

• Work Order Area

• Work Order Integration Status Code

• Work Order Status (Status, Status
Category)

• Work Order Type (Work Order Type Code)

Competitor
 

• Country Name

• Created By

• Creation Date

• Last Updated By

• Last Updated Date

• Name

• Registry ID

• SIC Code

• Status

• Threat Level

• Name

Contact
 

• Affinity

• Annual Income

• Buying Role

• Contact Role

• Created By

• Creation Date

• First Name

• Job Title

• Last Contact Date

• Last Name

• Last Updated By

• Last Updated Date

• Middle Name

• Name

• Owner

• Preferred Contact Method

• Primary Account (Name, Primary Address)

• Registry ID

• Registration Status

• Sales Profile Status

• First Name

• Job Title

• Last Name

• Middle Name

• Name

• Primary Address

• Primary Email

• Primary Instant Message

• Primary Phone

• Primary URL

• Registry ID
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• Type

• Accounts (Name, Primary Address)

• Addresses

• Emails

• Instant Messages

• Phones

• Primary Address

• Primary Email

• Primary Instant Message

• Primary Phone

• Primary URL

• Record Set

• Team Members

• URLs

Deal Registration
 

• Approval Decision By (Name, Primary
Email, Primary Phone)

• Approval Decision Date

• Close Date

• Contact Email

• Contact First Name

• Contact Last Name

• Created By

• Creation Date

• Deal Products (Name)

• Deal Size

• Deal Type

• Existing Account (Name, Primary Address,
 Registry ID)

• Existing Contact (Do not call, Do not
contact, Do not email, Do not mail, Name,
 Primary Address, Primary Email, Primary
Phone)

• Expiration Date

• Job Title

• Last Completed Activity

• Last Completed Call Activity

• Last Completed Email Activity

• Last Updated By

• Last Updated Date

• Lead (Lead Name)

• Registration Number

• Existing Contact (Name)

• Existing Account (Name, Primary Address,
 Registry ID)

• Partner (Name, Partner Number, Primary
Address)

• Status
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• Name

• New Account

• New Contact

• Next Task Due

• Number of Completed Activities

• Number of Completed Call Activities

• Number of Completed Email Activities

• Number of Products

• Number of Team Members

• Opportunity (Name)

• Opportunity Account (Account Name,
 Name, Primary Address)

• Opportunity Contact (Do not call, Do not
contact, Do not email, Do not mail, Name,
 Primary Address, Primary Email, Primary
Phone)

• Owner (Name, Primary Email, Primary
Phone)

• Partner (Name, Partner Number, Primary
Address, Public Address ID, Public Email
ID, Public Fax ID, Public Phone ID)

• Partner Type

• Record Set

• Registration Number

• Rejected Comments

• Rejected Reason

• Returned Comments

• Returned Reason

• Status

• Submitted By (Name, Primary Email,
 Primary Phone)

• Submitted Date

• Team Members (Name, Primary Email,
 Primary Phone)

HR Help Desk Request
 

• Assigned To (Name, Primary Email,
 Primary Phone)

• Category Name

• Channel Type

• Contact (Do not call, Do not contact, Do
not email, Do not mail, Name, Primary
Address, Primary Email, Primary Phone)

• Created By

• Creation Date

• Contact (Name)

• Reference Number
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• Critical

• Date Closed

• Date Reported

• Language Code

• Last Updated By

• Last Updated Date

• Messages (Channel Type, Message
Content, Posted By)

• Outcome Problem

• Owner Type

• Problem Description

• Product (Name)

• Product Group (Name)

• Queue (Queue Name)

• Record Set

• Reference Number

• Reported By (Name, Primary Email,
 Primary Phone)

• Resolution Code

• Resolution Date

• Resolved By

• Severity

• Solution Description

• Status Team Members (Name, Primary
Email, Primary Phone) Title

• Status Type

• Stripe Code

• Team Members (Name, Primary Email,
 Primary Phone)

• Title

Internal Service Request
 

• Assigned To (Name, Primary Email,
 Primary Phone)

• Category Name

• Channel Type

• Contact (Do not call, Do not contact, Do
not email, Do not mail, Name, Primary
Address, Primary Email, Primary Phone)

• Created By

• Creation Date

• Critical

• Date Closed

• Contact (Name)

• Reference Number
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• Date Reported

• Language Code

• Last Updated By

• Last Updated Date

• Messages (Channel Type, Message
Content, Posted By)

• Outcome Problem

• Owner Type

• Problem Description

• Product (Name)

• Product Group (Name)

• Queue (Queue Name)

• Record Set

• Reference Number

• Reported By (Name, Primary Email,
 Primary Phone)

• Resolution Code

• Resolution Date

• Resolved By

• Severity

• Solution Description

• Status Team Members (Name, Primary
Email, Primary Phone) Title

• Status Type

• Stripe Code

• Team Members (Name, Primary Email,
 Primary Phone)

• Title

Lead
 

• Accepted Date

• Account (Name, Primary Address)

• Consumer

• Contacts (Name, Primary Address,
 Primary Email, Primary Phone)

• Conversion Reason

• Created By

• Creation Date

• Deal Size

• Estimated Close Date

• Existing Contact (Name, Primary Address,
 Primary Email, Primary Phone)

• Last Updated By

• Account (Name, Primary Address)

• Consumer

• Existing Contact (Name, Primary Address,
 Primary Email, Primary Phone)

• Lead Name

• Rank
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• Last Updated Date

• Lead Name

• Lead Number

• Owner

• Primary Product

• Primary Product Group

• Products

• Qualification Date

• Rank

• Reassign Reason

• Record Set

• Score

• Source

• Status

• Team Members

Opportunity
 

• Account (Name, Primary Address)

• Asset (Asset Number, Serial Number)

• Close Date

• Consumer

• Contacts (Name, Primary Address,
 Primary Email, Primary Phone)

• Created By

• Creation Date

• Last Updated By

• Last Updated Date

• Leads (Lead Name)

• Line of Business

• Name

• Owner

• Primary Contact (Name, Primary Address,
 Primary Email, Primary Phone)

• Primary Revenue

• Record Set

• Revenues

• Sales Stage

• Status Category

• Team Members

• Line of Business

• Name

• Primary Revenue

Partner
 

• Addresses

• Created By

• Name

• Partner Number

267



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

• Creation Date

• Emails

• Last Updated By

• Last Updated Date

• Level

• Name

• Owner (Name, Primary E-Mail, Primary
Phone)

• Parent Partner (Name, Owner, Partner
Number, Primary Address)

• Partner Contacts

• Partner Number

• Partner Types

• Phones

• Primary Address (Address, City, Country,
 State)

• Primary Contact (Name, Primary Address,
Primary E-Mail, Primary Phone)

• Primary E-Mail

• Primary Phone

• Primary URL

• Record Set

• Registry ID

• Status

• Team Members

• URLs

• Primary Address

• Primary Contact (First Name, Last Name,
Middle Name, Name, Primary Address,
Primary E-Mail, Primary Phone, Primary
URL)

• Primary E-Mail

• Primary Phone

• Primary URL

Partner Contacts
 

• Addresses

• Certification Level

• Certification Reason

• Comments

• Created By

• Creation Date

• Department

• Department Code

• Duplicate Type

• Emails

• Enrichment Status

• First Name

• Internal Job

• Title

• First Name

• Last Name

• Middle Name

• Name

• Primary Address

• Primary E-Mail

• Primary Phone

• Primary URL
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• Last Assigned Date

• Last Contact Date

• Last Known Location

• Last Name

• Last Updated By

• Last Updated Date

• Middle Name

• Name Partner (Name, Owner, Partner
Number, Primary Address)

• Phones

• Primary Address (Address, City, Country,
 State)

• Primary E-Mail

• Primary Phone

• Primary URL

• Record Set

• Registration Status

• Title

• URLs

Quotes and Orders
 

• Account (Name, Primary Address)

• Active

• Amount

• Contact (Name, Primary Address, Primary
Email, Primary Phone)

• Created By

• Creation Date

• Description

• Last Synchronized

• Last Updated By

• Last Updated Date

• Name

• Opportunity (Name)

• Owner

• Placed On

• Quote ID

• Quote or Order Number

• Record Set

• Reference Code

• Reference Number

• Name

• Quote or Order Number
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• Status

• Valid To Date

• Version

• Win Status

Quote and Order Line
 

• Account (Name, Primary Address)

• Contact (Name, Primary Address, Primary
Email, Primary Phone)

• Created By

• Creation Date

• Last Updated By

• Last Updated Date

• Line Amount

• Line Contract End Date

• Line Contract Value

• Line Discount

• Line Price Period

• Line Price Type

• Line Request Date

• Line Status

• Opportunity (Name, Opportunity Number,
 Status)

• Order Line Item

• Product Name

• Record Set

• Sales Orders (Active, Creation Date, Valid
To Date, Name, Quote or Order Number,
 Amount, Status, Win Status)

• Account

• Contact

• Opportunity

• Order Line Item

• Product Name

• Record Set

• Sales Orders

Revenue Lines • Account

• Amount

• Best Case

• Close Date

• Competitor

• Conversation Rate

• Cost

• Created By

• Creation Date

• Discount

• Estimated Price

• Expected Delivery Date

• Account

• Competitor

• Created By

• Forecast Territory

• Last Updated Date

• Opportunity

• Owner

• Primary Partner

• Product

• Product Group

• Recurrence Type Code

• Sales Credit Allocation

270



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

Business Object Fields Enabled for Use as Filters Fields Enabled for the Search Box

• Expected Revenue

• Favorite

• Forecast Territory

• Last Updated By

• Last Updated Date

• Margin

• Opportunity

• Owner

• Primary Partner

• Product

• Product Group

• Quantity

• Record Set

• Recurrence Type Code

• Sales Credit

• Sales Credit Allocation

• Sales Credit Type

• Split Type Code

• Status

• UOM

• Win Probability

• Win / Loss Reason

• Worse Case

• Sales Credit Type

• Split Type Code

• Status

• UOM

• Win / Loss Reason

Service Requests
 

• Account (Name, Primary Address)

• Asset (Asset Number, Serial Number)

• Assigned To (Name, Primary Email,
 Primary Phone)

• Category Name

• Channel Type

• Contacts (Name, Primary Address,
Primary Email, Primary Phone, Registry ID)

• Created By

• Creation Date

• Critical

• Date Closed

• Date Reported

• Language Code

• Last Updated By

• Last Updated Date

• Account (Name, Primary Address)

• Consumer (Name, Primary Address,
 Primary Email, Primary Phone)

• Primary Contact (Name, Primary Address,
 Primary Email, Primary Phone)

• Reference Number
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• Messages (Channel Type, Message
Content)

• Outcome

• Owner Type

• Primary Contact (Name, Primary Address,
Primary Email, Primary Phone, Registry ID)

• Problem Description

• Product (Name)

• Product Group (Name)

• Queue (Queue Name)

• Record Set

• Reference Number

• Reported By (Name, Primary Email,
 Primary Phone)

• Resolution Code

• Resolution Date

• Resolved By

• Severity

• Solution Description

• Status

• Stripe Code

• Team Members (Name, Primary Email,
 Primary Phone)

• Title
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Territory
 

• Coverage

◦ Account Name

◦ Account Type

◦ Additional Attribute 1

◦ Additional Attribute 2

◦ Additional Attribute 3

◦ Additional Attribute 4

◦ Additional Attribute 5

◦ Aux1

◦ Aux2

◦ Aux3

◦ Business Unit

◦ Coverage Type

◦ Coverage Model

◦ Customer Size

◦ City

◦ County

◦ Country

◦ Geography

◦ Geography High ID

◦ Include Hierarchy

◦ Item

◦ Inventory Organization

◦ Industry

◦ Partner

◦ Province

◦ Postal Code

◦ Product Group

◦ Sales Channel

◦ Sales Subchannel

◦ State

• Coverage Model

• Created By

• Creation Date

• Description

• Eligible for Quota

• Coverage

◦ Account Name

◦ Account Type

◦ Additional Attribute 1

◦ Additional Attribute 2

◦ Additional Attribute 3

◦ Additional Attribute 4

◦ Additional Attribute 5

◦ Aux1

◦ Aux2

◦ Aux3

◦ Business Unit

◦ Coverage Type

◦ Coverage Model

◦ Customer Size

◦ City

◦ County

◦ Country

◦ Geography

◦ Geography High ID

◦ Include Hierarchy

◦ Item

◦ Inventory Organization

◦ Industry

◦ Partner

◦ Province

◦ Postal Code

◦ Product Group

◦ Sales Channel

◦ Sales Subchannel

◦ State

• Description

• Function

• Name

• Owner

• Parent Territory
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• Forecast Participation Code

• Function

• Last Updated By

• Last Updated Date

• Leaf Territory

• Line of Business

• Name

• Owner

• Parent Territory

• Parent Territory Number

• Parent Territory Unique Number

• Partner (Name, Partner Number, Primary
Address, Public Address ID, Public Email
ID, Public Fax ID, Public Phone ID)

• Partner ID

• Resource

◦ Forecasting Delegate

◦ Team Member Function

• Source Territory

• Team Members (Name, Primary Email,
 Primary Phone)

• Territory ID

• Territory Number

• Type

• Unique Territory Number

• Parent Territory Number

• Parent Territory Unique Number

• Partner ID

• Resource

◦ Forecasting Delegate

◦ Team Member Function

• Source Territory

• Territory ID

• Territory Number

• Type

Work Order
 

• Assignee Party Name (Name, Primary
Email, Primary Phone)

• Case Category ID

• Case Message

• Case Number

• Case Opportunity (Name)

• Case Resource (Name, Primary Email,
 Primary Phone)

• Closed Date

• Contacts (Name, Primary Address,
 Primary Email, Primary Phone)

• Created By

• Creation Date

• Description

• Favorite

• Case Number
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• Last Updated By

• Last Updated Date

• Open Date

• Primary Contact Party ID

• Queue ID

• Reported by Party Name (Name, Primary
Email, Primary Phone)

• Title

List of Data Security Predicates Supported by Adaptive Search  
This topic lists the standalone data security predicates predefined for each of the business objects supported by
Adaptive Search. Data security predicates provide access to object data, the access type, and the data to be accessed.

The data to be accessed can be All, a specific record, or a subset of the data.

Note:  Adaptive Search doesn't support the use of custom data security policies. Customers must use Access Groups
instead as described in the Securing CX Sales and Fusion Service guide.

The instance set defines the subset of data that limits the condition part of the data resource. For more information, see
the Manage Database Resources section of the Securing CX Sales and Fusion Service guide.

ACCOUNT

This table lists the instance set name and associated description for the Account business object:

Instance Set Name Instance Set Description Required Action Set

HZPARTIESHZ197
 

Access the trading community organization
for table HZ_PARTIES for a trading community
organization that's a partner and the user is a
member of the partner organization.
 

• View Sales Party

• Read

HZPARTIESZBS100105
 

Access the sales party for table HZ_PARTIES
where they're in the management chain of the
account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100106
 

Access the sales party for table HZ_PARTIES
where they're the account owner.
 

• View Sales Party

• Read

HZPARTIESZCM1
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM8
 

Access the sales party for table HZ_PARTIES for
all sales parties in the enterprise.

• View Sales Party
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 • Read

HZPARTIESZCM133
 

Access the sales party for table HZ_PARTIES for
all prospects in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM134
 

Access the sales party for table HZ_PARTIES for
all customers in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM3
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM39
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM4
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM40
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCM44
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM45
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with full
access.
 

• View Sales Party

• Read

HZPARTIESZCM46
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
full access.
 

• View Sales Party

• Read

HZPARTIESZCM51
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM52
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCA99968
 

Access the accounts where they're in access
groups.
 

• View Sales Party

• Read
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This table lists the instance set name and associated description for the Activity business object:

Instance Set Name Instance Set Description Required Action Set

ZMMACTYACTIVITIESZMM1398
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only an owner of an
activity (1=1).
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1399
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only a delegator of an
activity (1=1).
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1400
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of an owner only of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1401
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a delegator only of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1402
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only a resource of an
activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1403
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a resource only of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1404
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're the owner of an
account associated with an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1405
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the sales account
team and the sales account activity that's in
their management hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1406
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the sales account
territory and the sales account activity that's in
their territory hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1408
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the opportunity
team and the opportunity activity that's in their
management hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1409
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the opportunity
territory and the opportunity activity that's in
their territory hierarchy.

• View Activity

• Read
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ZMMACTYACTIVITIESZMM1410
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the lead team and
the lead activity that's in their management
hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1411
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the lead territory
and the lead activity that's in their territory
hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM47
 

Access the activity for table ZMM_ACTY_
ACTIVITIES for all template activities in the
enterprise.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM48
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a
delegator of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM49
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a
delegator of a task or an owner or a delegator
of an appointment or an owner or a delegator
of a call report activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM50
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either the owner or a
delegator of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM51
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of an activity resource.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM52
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain for a task activity or they're an owner for
an appointment activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM53
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of the activity owner.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM54
 

Access the activity for table ZMM_ACTY_
ACTIVITIES for all activities in the enterprise.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM74
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're a participant on the
activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM75
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a

• View Activity
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delegator of a task or an owner or a delegator
of an appointment or a call report activity.
 

• Read

ZMMACTYACTIVITIESZMM76
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where partner users are resources
in the activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM77
 

Access the activity for table ZMM_ACTY_
ACTIVITIES can edit all activities where users
from their partner company are participating.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1413
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a resource for the primary contact of
an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1414
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're member of a partner
territory.
 

• View Activity

• Read

ASSET

This table lists the instance set name and associated description for the Asset business object:

Instance Set Name Instance Set Description Required Action Set

ZCAASSETZCM213
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party.
 

• View Asset

• Read

ZCAASSETZCM214
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party.
 

• View Asset

• Read

ZCAASSETZCM215
 

Access the Asset for table ZCA_ASSET where
user is a member of the territory associated
with the asset owner party.
 

• View Asset

• Read

ZCAASSETZCM216
 

Access the Asset for table ZCA_ASSET where
user is a member of the territory that's an
ancestor of the territory associated with the
asset owner party.
 

• View Asset

• Read

ZCAASSETZCM224
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party with edit access.
 

• View Asset

• Read
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ZCAASSETZCM228
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party with full access.
 

• View Asset

• Read

ZCAASSETZCM252
 

Access the Asset for table ZCA_ASSET where
user is owner of the territory associated with
the asset owner party.
 

• View Asset

• Read

ZCAASSETZCM253
 

Access the Asset for table ZCA_ASSET where
user is a owner of the territory that's an
ancestor of the territory associated with the
asset owner party.
 

• View Asset

• Read

ZCAASSETZCM254
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party with edit access.
 

• View Asset

• Read

ZCAASSETZCM255
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party with full access.
 

• View Asset

• Read

ZCAASSETZCM266
 

Access the Asset for table ZCA_ASSET all assets
in the enterprise where asset owner party is a
prospect.
 

• View Asset

• Read

ZCAASSETZCM268
 

Access the Asset for table ZCA_ASSET all assets
in the enterprise where asset owner party is a
customer.
 

• View Asset

• Read

CAMPAIGN

This table lists the instance set name and associated description for the Campaign business object:

Instance Set Name Instance Set Description Required Instance Name

MKTCAMPAIGNSZCA100054
 

Access groups can view marketing integration
campaigns as a member of an access group
associated to the marketing integration
campaign.
 

• View Marketing Integration Campaign

• Read

CASE

This table lists the instance set name and associated description for the Case business object:
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SVCCASESSVC330
 

Access the cases for table SVC_CASES
where the case is assigned to them or their
subordinate.
 

• View Case Header

• Read

SVCCASEMESSAGESSVC322
 

Access the case messages for table SVC_CASE_
MESSAGES where they're the creator of a
message.
 

• View Case Header

• Read

COMPETITOR

This table lists the instance set name and associated description for the Competitor business object:

Instance Set Name Instance Set Description Required Instance Name

HZPARTIESZCA100184
 

Access the trading community party for table
HZ_PARTIES a member of an access group
associated to the sales competitor.
 

• View Sales Party

• Read

CONTACT

This table lists the instance set name and associated description for the Contact business object:

Instance Set Name Instance Set Description Required Instance Name

HZPARTIESHZ196
 

Access the trading community person for table
HZ_PARTIES for all people in the enterprise
(1=1). Ensure that View Sales Party action is
enabled.
 

• View Sales Party

• Read

HZPARTIESHZ198
 

Access the trading community person for
table HZ_PARTIES for their trading community
person record.
 

• View Sales Party

• Read

HZPARTIESHZ199
 

Access the trading community person for table
HZ_PARTIES for all persons who are a member
of their partner organization.
 

• View Sales Party

• Read

HZPARTIESZBS100105
 

Access the sales party for table HZ_PARTIES
where they're in the management chain of the
account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100106
 

Access the sales party for table HZ_PARTIES
where they're the account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100108
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account.

• View Sales Party

• Read
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HZPARTIESZBS100116
 

Access the sales party for table HZ_PARTIES for
all customer contacts where they're a member
of a territory associated with at least one related
account.
 

• View Sales Party

• Read

HZPARTIESZBS100118
 

Access the sales party for table HZ_PARTIES for
all customer contacts where they're a member
of an ancestor territory to a territory associated
with at least one related account.
 

• View Sales Party

• Read

HZPARTIESZBS100119
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account
with full access.
 

• View Sales Party

• Read

HZPARTIESZBS100120
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account
with edit access.
 

• View Sales Party

• Read

HZPARTIESZCM1
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM133
 

Access the sales party for table HZ_PARTIES for
all prospects in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM134
 

Access the sales party for table HZ_PARTIES for
all customers in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM169
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account
with edit access.
 

• View Sales Party

• Read

HZPARTIESZCM170
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account
with full access.
 

• View Sales Party

• Read

HZPARTIESZCM173
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account.
 

• View Sales Party

• Read

HZPARTIESZCM3
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team.
 

• View Sales Party

• Read
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HZPARTIESZCM39
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM4
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM40
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCM44
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM45
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with full
access.
 

• View Sales Party

• Read

HZPARTIESZCM46
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
full access.
 

• View Sales Party

• Read

HZPARTIESZCM51
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM52
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCM158
 

Access the Contacts with one party usage.
 

• View Sales Party

• Read

HZPARTIESZCM415
 

Access the Contacts which aren't created by
Partner User.
 

• View Sales Party

• Read

HZPARTIESZCA99972
 

Access the Contacts where they're in access
groups.
 

• View Sales Party

• Read

CUSTOM

This table lists the instance set name and associated description for the Custom object business object:
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ZCX_OWNER_[OBJECT_NAME]
 

Access the Custom Object where the user is
Owner of the Custom Object.
 

Read
 

ZCX_MGR_HIER_[OBJECT_NAME]
 

Access the Custom Object where the user is in
management chain of the Owner of the Custom
Object
 

Read
 

DEAL REGISTRATION

This table lists the instance set name and associated description for the Deal Registration business object:

Instance Set Name Instance Set Description Required Instance Set

MKLDMDEALSMKL1500
 

Access the deal registration summary for table
MKL_DM_DEALS for all deal registrations in the
enterprise.
 

• View Deal Registration

• Read

MKLDMDEALSMKL4021
 

Access the deal registration summary for table
MKL_DM_DEALS where they're a resource on
the deal team with view, edit or full access.
 

• View Deal Registration

• Read

MKLDMDEALSMKL5049
 

Access the deal registration summary for table
MKL_DM_DEALS where they're in the partner
organization.
 

• View Deal Registration

• Read

MKLDMDEALSZCA100002
 

Access the deal registration summary for table
MKL_DM_DEALS a member of an access group
associated with the deal registration.
 

• View Deal Registration

• Read

HR HELP DESK REQUEST

This table lists the instance set name and associated description for the HR Help Desk Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC460
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all HRHD service
requests(1=1).
 

Read
 

SVCSERVICEREQUESTSSVC489
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're the
primary contact of the HRHD service request.
 

Read
 

SVCSERVICEREQUESTSSVC514
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to them.
 

Read
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SVCSERVICEREQUESTSSVC486
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the HRHD service request.
 

Read
 

SVCSERVICEREQUESTSSVC515
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're a
member of HRHD service request team.
 

Read
 

SVCSERVICEREQUESTSSVC519
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to them or their
subordinate.
 

Read
 

SVCSERVICEREQUESTSSVC520
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or their
subordinate is a member of HRHD service
request team.
 

Read
 

SVCSERVICEREQUESTSSVC516
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to a queue that
they're a member.
 

Read
 

SVCSERVICEREQUESTSSVC476
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to a queue that they
or their subordinate is a member.
 

Read
 

INSTALLED BASED ASSET

This table lists the instance set name and associated description for the Installed Based Asset business object:

Instance Set Name Instance Set Description Required Instance Set

CSEASSETSBSVC605
 

Access the installed base asset for table CSE_
ASSETS_B for all enterprise assets.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC437
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where
they're listed as the contact on the asset
account team that owns the asset.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC438
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where
they're listed as the primary contact on the
asset.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC439
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where

• Manage Installed Base Asset

• Read
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they're a manager for the account listed on the
asset.
 

CSEASSETSBSVC434
 

Access the installed base asset for table CSE_
ASSETS_B for all customer assets.
 

• Manage Installed Base Asset

• Read

INTERNAL SERVICE REQUEST

This table lists the instance set name and associated description for the Internal Service Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC273
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all internal help
desk service requests (1=1).
 

Read
 

SVCSERVICEREQUESTSSVC289
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to them or
their subordinate.
 

Read
 

SVCSERVICEREQUESTSSVC290
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're the
primary contact of the internal help desk
service request.
 

Read
 

SVCSERVICEREQUESTSSVC311
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to them.
 

Read
 

SVCSERVICEREQUESTSSVC291
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the internal help desk service request.
 

Read
 

SVCSERVICEREQUESTSSVC312
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're a
member of internal help desk service request
team.
 

Read
 

SVCSERVICEREQUESTSSVC292
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or their
subordinate is a member of internal help desk
service request team.
 

Read
 

SVCSERVICEREQUESTSSVC310
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to a
queue that they're a member.
 

Read
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SVCSERVICEREQUESTSSVC288
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to a
queue that they or their subordinate is a
member of HRHD Service Request.
 

Read
 

LEAD

This table lists the instance set name and associated description for the Lead business object:

Instance Set Name Instance Set Description Required Set Instance

MKLLMLEADSMKL1
 

Access the sales lead for table MKL_LM_LEADS
where they're a resource in the lead sales team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL10
 

Access the sales lead for table MKL_LM_
LEADS where they're a resource in the territory
assigned to the sales lead.
 

• View Sales Lead

• Read

MKLLMLEADSMKL104
 

Access the sales lead for table MKL_LM_LEADS
where they're the owner of the sales lead.
 

• View Sales Lead

• Read

MKLLMLEADSMKL114
 

Access the sales lead for table MKL_LM_LEADS
where they're a resource in the lead sales team
with full access.
 

• View Sales Lead

• Read

MKLLMLEADSMKL129
 

Access the sales lead for table MKL_LM_LEADS
where they're a territory resource in the sales
lead territory team or a territory resource with
a descendant territory in the sales lead territory
team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL138
 

Access the sales lead for table MKL_LM_LEADS
for all retired leads in the enterprise.
 

• View Sales Lead

• Read

MKLLMLEADSMKL148
 

Access the sales lead for table MKL_LM_LEADS
for all partner leads in the enterprise.
 

• View Sales Lead

• Read

MKLLMLEADSMKL15
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of a resource in the lead sales team
with full access.
 

• View Sales Lead

• Read

 

MKLLMLEADSMKL152
 

Access the sales lead for table MKL_LM_LEADS
for all sales leads in the business units that
they're authorized.
 

• View Sales Lead

• Read
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MKLLMLEADSMKL16
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of the owner of the sales lead.
 

• View Sales Lead

• Read

MKLLMLEADSMKL22
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of a resource in the lead sales team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL310
 

Access the sales lead for table MKL_LM_LEADS
where they're in the management hierarchy of
the owner of the lead.
 

• View Sales Lead

• Read

MKLLMLEADSZBS902
 

Access the sales lead for table MKL_LM_LEADS
where they're member or in management chain
of lead sales team, member of territory team or
upward territory hierarchy.
 

• View Sales Lead

• Read

MKLLMLEADSZCA99964
 

User can view lead for their access groups.
 

• View Sales Lead

• Read

OPPORTUNITY

This table lists the instance set name and associated description for the Opportunity business object:

Instance Set Name Instance Set Description Required Instance Set

MOOOPTYMOO119
 

Access the opportunity for table MOO_OPTY
for the selected records where I am on the team
on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO120
 

Access the opportunity for table MOO_OPTY
for the selected records I own on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO121
 

Access the opportunity for table MOO_OPTY
for the selected records my subordinates own
on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO122
 

Access the opportunity for table MOO_OPTY
for the selected records where my subordinates
are on the team on the sales U1.
 

• View Opportunity

• Read

MOOOPTYMOO123
 

Access the opportunity for table MOO_OPTY
for the selected records in my territory on the
sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO124
 

Access the opportunity for table MOO_
OPTY for the selected records in my territory
hierarchy on the sales UI.
 

• View Opportunity

• Read
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MOOOPTYMOO88
 

Access the opportunity for table MOO_OPTY
for all opportunities in the enterprise (1=1).
 

• View Opportunity

• Read

MOOOPTYZBS99903
 

Access the opportunity for table MOO_OPTY
where they're a member or in a management
chain of opportunity sales team with view,
 edit or full access, member of territory team or
upward territory hierarchy.
 

• View Opportunity

• Read

MOOOPTYZBS99904
 

Access the opportunity for table MOO_OPTY
where they're a member or in management
chain of opportunity account team, account
territory team or upward territory hierarchy.
 

• View Opportunity

• Read

MOO_OPTYACCTERR_HIER_RES
 

Access the opportunity for table MOO_OPTY
where they're a territory resource in the
opportunity sales account territory team or a
territory resource with a descendant territory in
the opportunity sales account territory team.
 

• View Opportunity

• Read

MOO_OPTY_ADMIN_SALES_ADMIN
 

Access the opportunity for table MOO_OPTY
for all opportunities in the business units that
they're authorized within.
 

• View Opportunity

• Read

MOO_OPTY_EDIT_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales team member with edit or full
access.
 

• View Opportunity

• Read

MOO_OPTY_EDIT_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with edit or full access.
 

• View Opportunity

• Read

MOO_OPTY_FULL_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of
an opportunity sales team member with full
access.
 

• View Opportunity

• Read

MOO_OPTY_FULL_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with full access.
 

• View Opportunity

• Read

MOO_OPTY_TERR_HIER_RES
 

Access the opportunity for table MOO_
OPTY where they're a territory resource in
the opportunity territory team or a territory
resource with a descendant territory in the
opportunity territory team.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_ACCTTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales account team member.
 

• View Opportunity

• Read
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MOO_OPTY_VIEW_ACCTTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're a member of the opportunity
sales account team.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales team member with view, edit,
 or full access.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with view, edit, or full access.
 

• View Opportunity

• Read

MOOOPTYZCA99962
 

User can view Opportunities where they're in
access groups.
 

• View Opportunity

• Read

PARTNER

This table lists the instance set name and associated description for the Partner business object:

Instance Set Name Instance Set Description Required Action Set

HZPARTIESHZ521
 

Access the Partner where the user is the owner
of the Partner Account.
 

Read
 

HZPARTIESHZ522
 

Access the Partner where the user is in
management chain of the owner of the Partner
Account.
 

Read
 

HZPARTIESHZ523
 

Access the Partner where the user is a member
of the Partner Account team.
 

Read
 

HZPARTIESHZ524
 

Access the Partner where the user is in
management chain of the member of the
Partner Account team.
 

Read
 

HZPARTIESHZ525
 

Access the Partner where the user is an owner
or member of the Territory assigned to the
Partner Account.
 

Read
 

HZPARTIESHZ526
 

Access the Partner where the user is a member
of the territory and a descendant territory is
assigned to the Partner Account.
 

Read
 

HZPARTIESHZ197
 

Access the Partner where user is a member of
partner organization.
 

Read
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HZPARTIESZCA99978
 

User can view Partner where they're in access
groups.
 

Read
 

PARTNER CONTACT

This table lists the instance set name and associated description for the Partner Contact business object:

Instance Set Name Instance Set Description Required Instance Set

HZPARTIESHZ530
 

Access the Partner Contact where the user is a
member of the Partner Account team.
 

Read
 

HZPARTIESHZ531
 

Access the Partner Contact where the user is
in management chain of the member of the
Partner Account team.
 

Read
 

HZPARTIESHZ532
 

Access the Partner Contact where the user is
Owner of the Partner Account.
 

Read
 

HZPARTIESHZ533
 

Access the Partner Contact where the user is
in management chain of the Owner of Partner
Account.
 

Read
 

HZPARTIESHZ534
 

Access the Partner Contact where the user is a
member of the Territory assigned to the Partner
Account.
 

Read
 

HZPARTIESHZ535
 

Access the Partner Contact where the user is
a member of the territory and a descendant
territory is assigned to the Partner Account.
 

Read
 

QUOTES AND ORDERS

This table lists the instance set name and associated description for the Quotes and Orders business object:

Instance Set Name Instance Set Description Required Instance Set

ZCASALESORDERHEADERSZBS999939
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're a member
or in management chain of associated
opportunity sales team with view, edit or full
access, member of territory team or upward
territory hierarchy.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZBS999941
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're member or in
management chain of associated opportunity
account team, account territory team or upward
territory hierarchy.

• View Sales Order

• Read
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ZCASALESORDERHEADERSZBS999948
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS for all associated
opportunities in the business units that they're
authorized within 1=1.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5322
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS for all associated
opportunities having a partner organization.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5325
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS where they're in
the management chain of an associated
opportunity sales team member with view, edit,
 or full access.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5326
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're an associated
opportunity sales team member with view, edit,
 or full access.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5329
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're a member of
a partner resource organization whose partner
organization is on the associated opportunity.
 

• View Sales Order

• Read

QUOTE AND ORDER LINE

The Quote and Order Line object follows the same security requirements as the Quote and Order Line business object.

SERVICE REQUEST

This table lists the instance set name and associated description for the Service Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC1
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all customer
relationship management service requests
(1=1).
 

Read
 

SVCSERVICEREQUESTSSVC12
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is
assigned to them or their subordinate.
 

Read
 

SVCSERVICEREQUESTSSVC13
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or
their subordinate is a member of customer
relationship management service request team.
 

Read
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SVCSERVICEREQUESTSSVC14
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or
their subordinate is a member of customer
relationship management service request
account team.
 

Read
 

SVCSERVICEREQUESTSSVC242
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is
assigned to a queue that they're a member.
 

Read
 

SVCSERVICEREQUESTSSVC32
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is for
a partner.
 

Read
 

SVCSERVICEREQUESTSSVC35
 

Access the service request header for table
SVC_SERVICE_REQUESTS where their partner
account is on the customer relationship
management service request.
 

Read
 

SVCSERVICEREQUESTSSVC70
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the customer relationship management
service request or are a member of customer
relationship management service request
contact list.
 

Read
 

TERRITORY

This table lists the instance set name and associated description for the Territory business object:

Instance Set Name Instance Set Description Required Instance Set

MOTTERRITORIESMOT1
 

Access the sales territory for table MOT_
TERRITORIES where they're the territory owner.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT2
 

Access the sales territory for table MOT_
TERRITORIES where they're the owner of a
parent territory in the territory hierarchy.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT4
 

Access the sales territory for table MOT_
TERRITORIES where they're an administrator of
the territory.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT5
 

Access the sales territory for table MOT_
TERRITORIES where they're an administrator of
a parent territory in the territory hierarchy.
 

• View Sales Territory

• Read
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Instance Set Name Instance Set Description Required Instance Set

MOTTERRITORIESMOT26
 

Access the sales territory for table MOT_
TERRITORIES where they're a member of the
territory team.
 

• View Sales Territory

• Read

MOTTERRITORIESZCA100084
 

Access the sales territory for table MOT_
TERRITORIES where they're a member of an
access group associated to the sales territory
with read access.
 

• View Sales Territory

• Read

WORK ORDER

This table lists the instance set name and associated description for the Work Order business object:

Instance Set Name Instance Set Description Required Instance Set

SVCWORKORDERSSVC214
 

Access the field service work order for table
SVC_WORK_ORDERS where the field service
work order is standalone or associated with a
service request.
 

Read
 

SVCWORKORDERSSVC216
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the field service
work order account team.
 

Read
 

SVCWORKORDERSSVC217
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the field service
work order contact team.
 

Read
 

SVCWORKORDERSSVC219
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the service request
team associated with the field.
 

Read
 

SVCWORKORDERSSVC220
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate created the service request
associated with the field service work order.
 

Read
 

SVCWORKORDERSSVC221
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate created the field service work
order.
 

Read
 

SVCWORKORDERSSVC222
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is assigned to a field service work
order.
 

Read
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Instance Set Name Instance Set Description Required Instance Set

SVCWORKORDERSSVC223
 

Access the field service work order for table
SVC_WORK_ORDERS where their partner
account is on the field service work order.
 

Read
 

SVCWORKORDERSSVC224
 

Access the field service work order for table
SVC_WORK_ORDERS where the field service
work order is for a partner account.
 

Read
 

SVCWORKORDERSSVC246
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is the technician assigned to a field
service work order.
 

Read
 

SVCWORKORDERSSVC455
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is the technician assigned to a field
service work order.
 

Read
 

Compare Active Adaptive Search Configuration to the Default
Configuration  
You can generate a spreadsheet that compares any changes made to the current active adaptive search configuration
against the last published default configuration.

For example, you select the business objects you want to enable in Adaptive Search on the Quick subtab and click
Publish to enable the adaptive search configuration provided by Oracle. For custom objects, the default configuration
won't have any custom object configuration details.

You can modify how search operates on the Setup Advanced tab of the Configure Adaptive Search page. For example,
you can specify which fields of an object and its related objects can be used in searches and displayed as search filters.
Because Oracle configures the fields for you, setup is optional unless you want to enable search on custom child objects
and fields, or to change Oracle's default search configuration. You must run the Publish process for your changes to take
effect.

Generate Adaptive Search Comparison Report
Before you run the Publish process, you can view and compare all the attributes for the custom objects in addition to
any entities enabled or disabled in the unpublished configuration.

You must have the ZCA_ADAPTIVE_SEARCH_CONFIG_PUBLISH privilege to generate a comparison spreadsheet for
your currently active Adaptive Search configuration against your default configuration.

1. From Setup, click Advanced.

From here you can change which objects and fields are enabled for search, how they are searched on, and other
search configurations. You can also enable and disable objects for searching.

2. From the Actions menu, select Compare with Previous Configuration.
3. From the Compare with Previous Configuration dialog, under Records, select either Modified or All options.
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4. Next, select one of these Adaptive Search configurations options:

◦ Unpublished Configuration

◦ Active Configuration

to compare against one of these configurations:

◦ Active Configuration

◦ Default Configuration

5. Click Export to download the comparison data from Adaptive Search as a CSV file. You can then use this file to
view or analyze your data offline.

The spreadsheet contains a separate tab for each object and displays a list of attributes for each object in the current
configuration. The first column displays the name of the Attribute, the next four columns shows the Boolean values for
the current configuration and the next four columns shows the Boolean values of the default configuration.

Saved Search Setup  

Create and Manage Saved Searches  
You can create and manage saved searches for different roles and for your own personal use. You can also assign a
unique default saved search for each role.

A default saved search is the search a user sees when first opening Workspace. Sales users can create their own
personal saved searches, manage them, and assign their personal default saved search. These saved searches take
precedence over what you, as administrator, has assigned to them. You create and manage saved searches from the
Workspace UI rather than from the Configure Adaptive Search page.

Note:  By entering precise search criteria for your saved search, you can greatly decrease the number of records
returned and decrease the load time.

Note:  To create and manage saved searches you must have the privilege
ZCA_VIEW_ADAPTIVE_SEARCH_WORKSPACE_PRIV.

Overview of Manage Saved Searches UI
The Manage Saved Search UI contains the My List tab, Workspace List tab, and Set Defaults tab. These allow
administrators to manage their personal list of saved searches, assign saved searches to roles, and assign default saved
searches to roles, respectively. These tabs are only exposed to administrators to:

• Assign saved searches for user roles

• Assign a default saved search for roles

• Change a default saved search for roles

• Perform overall role-based administration
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Note:  Workspace users can manage their own personal saved searches from the Manage Saved Searches page but
they won't have access to the My List, Workspace List, or Set Defaults tabs. However, mobile app users can override
these restrictions and set their own default searches, too. This feature helps to display the most relevant records in
their mobile app with a single tap on the menu.

All sales users can create saved searches for themselves. But sales administrators can create saved searches for the
whole sales organization and for specific sales roles. A default saved search is the saved search that's automatically
displayed when the user first accesses Workspace. Oracle delivers predefined default saved searches for some user
roles and the search results returned depends on what role is assigned. For example, ready-to-use partner roles include
Partner Sales Representative, Partner Sales Manager, and Partner Administrator.

From the My List tab, you can manage your own personal saved searches exclusively, separate from the saved searches
that are shared with the broader organization. Here is a screenshot of the My List window.

Note:  Mobile app users can select the save searches they want from the Default for Mobile column.

From the Workspace List tab, you can share and manage saved searches with other roles. You can designate saved
searches as shared with everyone, with specific user roles, or with no one. Here's a screenshot of what the Workspace
List window looks like.
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The Set Defaults tab enables you to define the default saved search for each user role. However, to assign a default
saved search, you also must have permission to view that specific default saved search. Otherwise it won't appear in the
list of saved searches to assign. Here's a sample screenshot of the UI.

For example, if you select Site Level, the following default saved search options are displayed for Accounts:

• All Accounts

• My Accounts

• My Favorite Accounts

• My List for Accounts
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If you select a specific role, such as Sales Representative, then you may want to select the My Accounts option as your
default saved search as shown in this sample screenshot.
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Create a Saved Search
Here's how you can create a saved search either for yourself or for others in the organization. The saved searches
you create are available for selection in Workspace and also appear as filters in the actionable infolets and Workspace
infolets. The saved searches are listed in alphabetic order.

1. In Workspace, select a saved search as your starting point. For example, the All Accounts saved search
provided by Oracle lets you create your saved search for all the accounts you can see.

2. Enter your search terms. You can enter search terms in the Search box, add filters, select filter values, or any
combination of these.

3. You can add or change the columns displayed in the search results by clicking Edit Columns (the pencil icon
highlighted by callout 2 in the following screenshot).

4. Click Save As (highlighted by callout 1).

5. Enter the name for your saved search. Remember that the saved searches are listed in alphabetic order.
6. To make this saved search the default saved search for you personally, select the Set as my default saved

search option. The default saved search is what you see whenever you navigate to Workspace.
7. Specify how you want to share the saved search you're creating. There are three options:
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◦ Only Me

◦ Everyone

◦ Specific Roles

8. If you selected Specific Roles, click Search (the people icon) and select the job roles.
9. Click Create.

Related Topics
• How can I view and assign a default saved search for a role?

• Why does the Default Saved Search field display with either no name or with a Select drop-down list?

Manage List of Personal Saved Searches  
From the My List tab of the Workspace UI, you can manage your own personal saved searches exclusively, separate
from the saved searches that are shared with the broader organization.

Here are the steps to help you manage your own personal saved searches for a business object:

1. Select the business object.
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2. From the same menu select Manage Saved Searches, then select the My List tab.

Here's a screenshot of the list of items that appears when you click the selector. The image highlights the
Manage Saved Searches task, the last selection on the list.

This screenshot shows the My List tab as seen by administrators. The table describes the columns highlighted
in the screenshot by callouts.

Callout Number Column Name Description

1
 

My Default Saved Search
 

This is the signed in user's personal default
saved search. The user can keep the default
saved search assigned by the administrator,
or change the saved search to a different
one contained in the drop-down list.
 

2
 

Manage List
 

The business object containing the saved
searches you're managing. For example, by
selecting Accounts for Manage List, saved
searches based on the Account business
object will appear.
 

3
 

Default for Mobile
 

The saved search appears in the list of
saved searches for mobile users when
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Callout Number Column Name Description

this option is selected. While you can't
delete lists provided by Oracle, you can hide
them from mobile users by deselecting the
Default for Mobile option.
 

3. Update your personal saved searches. You can:

◦ Rename saved searches you created

◦ Hide any of the shared searches from the shared group by deselecting Show in List.

◦ Specify searches for the whole organization by selecting Everyone from the Shared With list.

◦ Specify searches for users with one or more specific job roles, by selecting Specific Roles from the
Shared With list. The saved search can then be managed from the Workspace List tab, where you assign
the specific roles permission to view the saved search. You must click Save before proceeding to the
Workspace List tab.

◦ Delete saved searches you created from the application by clicking Delete.

4. Click Save and Close when you're done.

If you're sharing a saved search with other user roles, click Save to proceed and manage those saved searches
in the appropriate Workspace List or Set Defaults tabs.

Share and Manage Saved Searches List with Other Job Roles  
From the Workspace List tab, you can share and manage saved searches with other roles. You can designate saved
searches as shared with everyone, with specific user roles, or with no one.

The Set Defaults tab lets you define the default saved search for each user role.
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Share and Manage Saved Searches with Other Roles
Here are the steps to help you manage and share saved searches with other roles:

1. Select the business object.
2. From the same menu select Manage Saved Searches, then select the Workspace List tab.

This screenshot shows the Workspace List tab as seen by administrators. The table describes the columns
highlighted in the screenshot by callouts.

Callout Number Column Name Description

1
 

Manage List
 

The business object containing the saved
searches that are shared across roles. For
example, by selecting Accounts for Manage
List, saved searches based on the Account
business object will appear.
 

2
 

Shared With
 

You can share a saved search with Everyone
(all job roles) in the organization or with
Specific roles, (specific job roles). You can
also select Not shared if you don't want to
share with other job roles.
 

3
 

Delete
 

Deletes the saved search from the
application. You can't delete saved searches
provided by Oracle.
 

3. Click the Workspace List tab to update the saved searches. You can:

◦ Specify searches for the whole organization by selecting Everyone from the Shared With list.

◦ Specify searches for users with one or more specific job roles, by selecting Specific roles from the
Shared With list and then selecting the job roles by clicking Search (the people icon).
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◦ Delete saved searches you created from the application by clicking Delete.

4. Click Save and Close when you're done.
If you want to define the saved search as the default saved search for a user role in the Set Defaults tab, or if
you want to navigate to the My List tab, first click Save before you leave the Workspace List tab.

Define the Default Saved Search for Each User Role
The default saved search is the saved search that will automatically display when the user first accesses Workspace.
With the Set Defaults tab, you can define or change a default saved search for any user role.

Here are the steps to help you define or change a default saved search for any user role:

1. Select the business object.
2. From the same menu select Manage Saved Searches, then select the Set Defaults tab.

This screenshot shows the Set Defaults screen as seen by administrators when they select the set defaults at
the site level.

3. Click the Set Defaults tab to define or change a default saved search for any user role.
Note:  Saved searches that you don't have permission to access, don't appear in the Default Saved Search
drop-down list. To see the assigned default saved search in the drop-down list, and to assign the default
saved search to a role, you must have permission to view the object underlying the saved search.

4. Scroll the page until you see the role name and it's default saved search that you either want define or change
for any user role.

5. From the drop-down list select a new role name for the default saved search or change to a different role
contained in the drop-down list.

6. Click Save and Close when you're done.
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If you want to manage your saved searches in the Workspace List tab, or if you want to navigate to the My List
tab, first click Save before exiting the Set Defaults tab.

Set Default Saved Searches for Mobile App Users  
Saved searches are predefined for Workspace users. In addition, you can set the default saved search per object for
mobile app users for either specific roles or for the whole site.

Mobile users can override these and set their own default searches, to display the most relevant records in their mobile
app with a single tap on the menu.

The Set Defaults tab enables you to define the default saved search for each user role. However, to assign a default
saved search, you also must have permission to view that specific default saved search. Otherwise it won't appear in the
list of saved searches to assign. From example, you might select the role Channel Account Manager from the Select a
role or Site Level to set default saved searches: drop down and select All Deal Registrations as your Default Saved
Search for Workspace:. You can also select a default saved search for other objects from the Set Defaults tab of the
Manage Saved Searches page. Here's a sample screenshot of the UI.
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Set Up Search Results in Groups  
To display search results in groups based on the specific fields on the object or related objects, you must set the Enable
Group By in Workspace parameter to Y.

When the parameter is enabled, salespeople can view an overview of the number of records in each Grouped By
grouping and can search and filter records within these groupings. They can also view aggregates such as count,
average, and sum of values on the records of each group.

Enable Group By in Workspace Parameter
Here's how to set the Enable Group By in Workspace parameter.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters tab.
4. Highlight the Enable Group By in Workspace and click Edit. This warning is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. 
Do you want to continue?

5. Click Yes.
6. In the Current Value field, change the value from N to Y and click Save and Close.

Specify Fields to Use for Group By
Here's how to specify field values for display as a filter in your Group By search.

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and use:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
3. Click the Configure UI tab.
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4. Select the object where you want to set up field values for your Group By search in the left pane of the tab. You
may have to open up the object hierarchy. The fields for the object display in the Configure fields pane on the
right as highlighted in the sample screenshot.

5. Select the Enable for Group By option for the fields you want to enable for use as a Group By search in the UI.

Note:  Ensure that the Display in UI option is also selected

6. Click Save and Close.
7. Sign out and then sign in again to see your changes.

No publishing is required. The changes you made are reflected in the Workspace UI for the Group By field drop down
lists for the selected object.

Note:  If you decide to turn off the Enable for Group By option, any saved searches you created will continue to work
but won't have the group by functionality. However, if you decide to enable the group by feature again and if you
didn't make any changes to your saved searches, then the group by feature will continue to function for your saved
searches.   If the Enable for Group By parameter is disabled and you update an existing saved search that has the
group by option, then the saved search will be updated as a saved search without group by.

Supported Objects and Predefined Fields for Group By  
Here are the supported objects and the associated predefined fields that are available for display as filters for your
Group By search.

This list contains the standard predefined configuration but you can specify field values for display as a filter in your
Group By search by going to the Configure Adaptive Search  > Configure UI > Enable for Group By.

Fields in parentheses represents the associated Adaptive field attribute.
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Business Object Fields Enabled for Group By

Account
 

• Industry (PrimaryIndustry)

• Type (SalesProfileType)

• State - from the Primary Address (PrimaryAddress.State)

• Account Score (AccountScore)

Activity
 

• Type (ActivityTypeCode)

• Priority (PriorityCode)

• Status (StatusCode)

• Primary Contact (PrimaryContactId)

Asset
 

• Account (Account)

• Product (Product)

• Product Group (ProductGroup)

Contact
 

• Account (PrimaryAccount)

Lead
 

• Status -Unqualified, Qualified, Converted, Retired (StatusCode)

• Lead (Score)

• Lead Rank -Hot, Warm, Cold (Rank)

• Week - on lead creation date (CreationDate)

Opportunity
 

• Win Probability (PrimaryRevenue.WinProb)

• Month - on close date (EffectiveDate)

• Close Date

• Sales Stage

• Account (CustomerAccount)

Partner
 

• Tier (TierId)

• Partner Type (ListOfPartnerTypes.AttributePk2)

• Status (Status)

Partner Contact
 

• Partner (Partner)

Quote and Order Line
 

• Account (Account)

• Opportunity

• Product Name

Quotes and Orders
 

• Account (Account)

• Opportunity

Revenue Lines
 

• Account

• Close Date
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Business Object Fields Enabled for Group By

• Win Probability

Service Request
 

• Severity (SeverityCd)

• Status (StatusCd)

• Queue (Queue)

• Product (InventoryItemId)

• Category Name (srCategoryID)

Advanced Setup  

Field Search Setup  

How Search Action is Modified  
During Adaptive Search setup, you can decide which fields of a business object and its related objects can be used in
searches and displayed as search filters.

For example, you can make it possible for salespeople to search for accounts using the account's primary contact name
in the Workspace UI. You can also enable the account primary contact name for use in opportunity searches. When a
salesperson searches on the account primary contact name in the opportunity Search box, the application lists all of the
opportunities belonging to the accounts that have the individual listed as the primary contact.

Note:   By entering precise search criteria for your saved search, you can greatly decrease the number of records
returned and decrease the load time.

Adaptive Search supports relationships between the ready-to-use standard business objects. It also supports one-to-
one and one-to-many custom relationships between standard and custom objects. Setup is done on the Advanced
setup tab of the Configure Adaptive Search page. You select the business object you want to set up in the left pane of
the tab, and set the object's search properties in the right pane.

Note:  To be able to search on a particular attribute in Global Search, you must select the Include in Keyword Search
option for that attribute.

Here's a screen capture of the Advanced setup tab of the Configure Adaptive Search page.
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Left Pane - Select Objects and Related Objects
In the left pane of the tab, you can:

• Enable and disable each business object for the Workspace UI by selecting its check box. (This is the equivalent
of enabling the objects on the Quick Setup tab.)

• Expand each object to view the hierarchy of related objects.

• Select an object or a related object in the hierarchy to display its fields in the right pane.

As an example, here's a diagram of a portion of the related object hierarchy for opportunities and some of the fields
each level of the hierarchy includes.
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Here's an explanation:

Hierarchy Level Object Name Description

1
 

Opportunity
 

Selecting the Opportunity top-level object
in the left pane lets you specify the search
operation for opportunity fields.
 
The list includes opportunity fields, such as
name, asset, creation date, sales method,
 and sales stage and fields created by
Workspace representing the related objects.
These concatenated fields include all of the
configuration settings for each related object.
 
For example, the Account field includes your
configuration of search terms and settings for
the Account object, the Contacts field includes
the configuration for the Contacts object, and
so on.
 

2
 

Account
 

An opportunity includes a field called Account
where you enter the name of the account
related to the opportunity. When you select
Account in the left pane, the right pane only
displays one field: Account.
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Hierarchy Level Object Name Description

 
The Account field in the right pane displays the
identifying attribute name for the respective
objects as follows:
 
Entity - Identifying Attribute Name
 

• Account - Name

• Activity - Subject

• Asset - Asset Number

• Contact - Name

• Lead - Lead Name

• Opportunity - Name

• Partner - Name

• Partner Contact - Name

3
 

Account
 

Selecting the Account object in the hierarchy
displays the list of fields you can enable
and configure for accounts. Configuring the
Account object is the same as configuring the
Account top-level object: the list of fields is the
same and your selections affect all objects that
include Account as a related object.
 

Right Pane - Configure Search Action for Your Selection
The right pane of the tab, Configure Fields, is where you control the search properties for fields of the object or related
object you selected. Depending on the field, there are up to four options you can select:

Option What It Does

Enable
 

Enables the field for search. After you publish your setup and the indexing process completes
successfully, you can:
 

• Search using the field and include it in filters

• Display it as a column in the Workspace table

Analyzed Text Search
 

This option is available for text fields only. Workspace can search text fields either as a single string or
as individual indexed words. Selecting this option indexes individual words and enables fuzzy match
and additional operators that you can use when searching the field. Fuzzy match makes it possible to
search for similar spellings.
 
Selecting the Analyzed Text Search option, enables these operators:
 

• All of the words

• Any of the words

• Contains

• Ends with

• Equals
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Option What It Does

• Fuzzy match

• None of the words

• Not equal to

• Starts with

Leaving the Analyzed Text Search option deselected, restricts you to these operators:
 

• Equals

• Exists

• Is missing

• Not equal to

Include in Keyword Search
 

Makes it possible to search on the field using the Search box at the top of the Workspace UI and
enables keyword search on fields in Adaptive Search REST API. To be able to search on a particular
attribute in Global Search, you must select the Include in Keyword Search option for that attribute.
 
The Adaptive Search application copies all the fields marked as Include in Keyword Search to a
concatenated field that's made available for the search. If you select this option for five account fields,
 then the five are concatenated in a field and all five can be used in searching accounts. If you include
too many fields as Include in Keyword Search, the accuracy of the search may diminish.
 

Note:
Date fields and numeric fields aren't supported for Include in Keyword Search.
 

Include in Object Reference
 

Enables the field for use in searches of related objects. You can enable up to 15 fields. For example, if
you select this option for the Chief Executive Name on the Account object, you can enable this field
also for searching opportunities.
 

Note:  Formula fields can't be configured in Adaptive Search because they aren't searchable and can't be indexed.

Make a Field Searchable in the UI  
You can enable additional fields for search, including custom ones, using the steps in this topic. You can also remove
existing fields from use.

By default, the work areas powered by Adaptive Search include all of the key fields you need for search. (See the topic
Adaptive Search Configuration Provided by Oracle for a list.)

This example shows you how to enable the Chief Executive Name field, a standard application text field, but the same
procedure applies to any field, even a custom field on a standard application object. When you're done with this
configuration and publish it, a salesperson can enter the CEO name, in either Global Search or in the search box for
those work areas powered by Adaptive Search, to find the account where the person is the CEO. The search also returns
all of the opportunities for that account when you enable opportunities to be searched by account fields.

Suppose that you added the CEO name field to the Account UI and want to make entries in this field searchable. Here's a
screenshot of the Edit Account page highlighting the location of the field.
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To make the field searchable in work areas powered by Adaptive Search and Global Search involves these steps:

1. You must make the field searchable for its business object.
2. Optionally, you can enable the field for search of a related object.
3. You must publish your configuration.

Note:  If you want the field to be displayed in the UI, either as a filter or as a column in search results, then you must
enable it for display on the Configure UI tab of the Configure Adaptive Search page.

Make the Field Searchable in Its Business Object
Here's how you make the field available for searching its business object. For example, making the account searchable
by the CEO name.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, Setup tab (callout 1 in the screenshot), click Advanced (callout 2).
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3. In the left pane, click the name link for the object where the custom field appears (callout 3). The CEO name
field is an account field, so you click Account.

The field is listed in the Configure Fields section.

4. Select the Enable option to index the field for Workspace and Global Search (callout 4).
5. For a text field, including Chief Executive Officer, select the Analyzed Text Search option to index individual

words in the field. Your selection also enables fuzzy search (search that retrieves results with similar spellings).
And you enable other search operators, including All of the words and Any of the words.

Note:  For fuzzy search to work, the first 3 characters of the word should match and in the remaining part of
the word there can be 1 character difference. This can be changed to 2 characters difference if needed, but the
first 3 characters still need to match.

6. Select the Include in Keyword Search option to enable the field for both Global Search and search using the
Workspace search box.

Note:  Because they're Personal Identifiable Information (PII), you can't make contact email addresses and
phone numbers available for search using global search or the Workspace search box.

If you leave this check box deselected, users can't search for accounts using the CEO name. But in Workspace,
they can still add the Chief Executive Name field as a filter for accounts and search the field there. Global Search
doesn't permit you to add filters, only to search by keyword.

7. Select the Include in Object Reference option to enable the field for search in related objects. You can enable
up to 15 fields. Make the selection if you want to use the CEO name when searching for opportunities, for
example.

If you didn't select the Include in Keyword Search option, but select Include in Object Reference, then users
searching opportunities can use the field only as a filter in Workspace.
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Make the Field Available for Searching a Related Object
You can only make the field available for search in a related business object if you selected the Include in Object
Reference option for the field.

1. In the left pane of the window, open the object where you want to enable the search. For this example,
Opportunity (callout 1 in the screenshot).

2. Select the field in the left pane, in this example, Account (Callout 2).
3. In the right pane, select Enable (callout 3).
4. If you want to use the field for searches in Global Search and in the Workspace Search box, you must select the

Include in Keyword Search  option (callout 4).

If you don't select this option, but selected Enable, then the field remains available as a filter in Workspace, but
can't be searched in Global Search.

The Include in Object Reference option isn't relevant here. Here's a summary of the two use cases:

Use Case Enable Include in Keyword Search

Users can search on the field using Global
Search and in the Workspace Search box.
For example, entering the CEO name,
 they get results containing, not only the
account where the person is a CEO, but the
opportunities for that account as well. In
Workspace, they can also select the fields
as a filter when searching for the object. For
example, when searching for opportunities
in Workspace, they can filter by CEO name.
 

Selected
 

Selected
 

Users can add the field as a filter in
Workspace, but can't search on it using the
Search box or using Global Search.
 

Selected
 

Deselected
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Publish Your Configuration
After making your option selections, click Publish.

Publishing triggers an indexing process that you can monitor on the Monitor tab, Publish subtab. Your new
configuration becomes available after the indexing process completes. If the process completes with errors for some
reason, contact your help desk.

Enable the Field for Use As a Filter in the UI
For the field to be used as a filter and added as a column in search results, you must enable it for display on the UI:

1. In the Configure Adaptive Search page, click Configure UI.
2. To enable the field for use as a filter on its object (for example, to enable the account field to be used as a filter

when searching accounts), do the following:

a. Select the object in the left pane of the Configure UI tab.
b. Select the Display in UI option for the field.

3. To enable the field for use in the UI of other related objects (for example, to enable the account field as a filter in
opportunity searches), do the following:

a. Display the related object hierarchy for the object where you want to enable the filter in the left pane of
the Configure UI tab. For example, select Opportunity (callout 1 in the following screenshot).

b. Locate and select the field's object in the object hierarchy. For example, select Account (callout 2).
c. Select Display in UI option for the field (callout 3).

4. Click Save and Close.

Related Topics
• Adaptive Search Configuration Provided by Oracle

Example of Including All Addresses in Account Searches  
By default, Workspace makes it possible for you to use the fields in the primary address in searching accounts using the
Search box.
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For example, if you enter the word "main" as a search term when searching for accounts, the application returns
accounts with the word "main" in their names as well as accounts with primary addresses on "Main Street", "Main
Avenue" and so on. If your accounts have multiple addresses, you can broaden the search to include all of the
addresses. To be able to search on a particular attribute in Global Search, you must select the Include in Keyword
Search option for that attribute.

To broaden account searches to include all addresses for searching accounts:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
2. Click Advanced.
3. In the left pane of the tab, open the Account object to reveal its related objects.
4. Select the Addresses related object.

The right pane, Configure Fields: Account displays the concatenated Addresses field.
5. Make sure the Enable option is selected for the Addresses field.
6. Select the Include in Keyword Search option.

Here's a screen capture of the Advanced tab of the Configure Adaptive Search page highlighting the selection
of the Account Addresses in the left pane and the Addresses field with the selected Include in Keyword Search
option in the right pane.
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7. Now that all addresses are included in account searches, you can exclude the primary addresses to avoid
duplication. Primary addresses are already included in addresses.

a. Select Primary Address in the left pane.
b. Deselect the Include in Keyword Search option in the right pane.

Here's a screen capture of the Advanced tab of the Configure Adaptive Search page highlighting the
selection of the Primary Address in the left pane and the Primary Address field with the Include in
Keyword Search option deselected in the right pane.

8. After making your selections, click Publish.

Publishing triggers an indexing process that you can monitor on the Monitor tab. Your new configuration
becomes available after the indexing process completes. If the process completes with errors for some reason,
contact your help desk.

Set Up Searches on Related Object Attributes  
Sometimes you want to enable the search on the attributes of a related business object. For example, you may want to
find opportunities using the account owner or primary contact.

Watch video
 

Enabling this kind of search involves two steps:

1. Specifying which object attributes are searchable.
2. Enabling the related object for search.

For example, to make opportunities searchable by account attributes, you first make sure that the attributes you need
are searchable for the Account object. You then open the Opportunity object and enable the Account related object for
searching opportunities.

Specify Which Object Attributes Are Searchable

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Advanced.
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3. In the left pane of the tab, select the top-level object. For example, to specify which account attributes are
searchable, you select the top-level Account object.

4. In the right pane, do the following for each field you want include in the search:

a. Select the Enable option.
b. Select the Include in Keyword Search option.

All of the fields with the Include in Keyword Search option selected are included in the concatenated
field and can be used in search. It is this field, with the same name as the object, that you enable for the
related object.

Here's a screenshot of the Advanced tab of the Configure Adaptive Search page. It highlights the location
of the Account object and Include in Keyword Search option.

Make the Related Object Available for Search in the Object
Here's how to make the related object available for search.

1. In the left pane of the Advanced tab, open the object to reveal its related objects. For example, open the
Opportunity object.

2. Select the related object. For example, select Account underneath the Opportunity object.

The right pane displays the concatenated field. For Account, the name of the concatenated field is Account.
3. Make sure the Enable option is selected for the field.
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4. Select the Include in Keyword Search option.

Your action enables search on the attributes you enabled for this object.

Here's a screenshot of the Advanced tab of the Configure Adaptive Search page. It shows the selection of the
Opportunity object and its Account related object in the left pane. In the right pane, the Include in Keyword
Search option is selected for the Account field.

5. Click Publish.

Publishing triggers an indexing process that you can monitor on the Monitor tab. Your new configuration
becomes available after the indexing process completes. If the process completes with errors for some reason,
contact Oracle support.

Groovy Support to Count the Number of Search Fields Enabled for Adaptive Search  
Adaptive Search displays the list of records matching the saved search criteria and provides you with a record count.
You can use Groovy scripts to count the total number of search fields you have enabled in Adaptive Search.

Sometimes, the amount of attributes enabled for a business object may exceed the recommended amount of 500
for each object, so you may not find the field attribute you were searching for. You can reduce the count of fields by
deselecting the Include in Object Reference check box for child entities that you may not require. For more details, see
the topic Make a Field Searchable in the UI.

Number of Search Attributes Enabled
Here's sample of the query trigger code that will display a count for the total number of search attributes you have
enabled in your Adaptive Search test environment.

Note:  If you want to count the enabled search attributes in your active production environment, edit the script and
replace Sandbox with Active.

SELECT
ea.ATTRIBUTE_UUID,
ltrim(sys_connect_by_path(CASE WHEN (ea.max_occurs is null and
ea.ATTRIBUTE_TYPE_NAME < > `Enum ) THEN ea.ATTRIBUTE_NAME||'[]' ELSE
ea.ATTRIBUTE_NAME END,`. ),`. ) AS DOC_ATTRIBUTE_PATH,
ad.AGGREGATION_UUID,
ad.SEARCHABLE_FLAG
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FROM FUSION.ZCA_ES_ATTRIBUTES ea, FUSION.ZCA_ES_ATTRIBUTE_DEFAULTS ad
WHERE ( (level > 1
AND ea.INCLUDE_IN_REFERENCE_FLAG = `Y )
OR ( level = 1)
OR (ea.RECORD_ENTITY_UUID IS NOT NULL
AND (SELECT COUNT(*)
 FROM FUSION.ZCA_ES_ATTRIBUTES iea
 WHERE iea.ENTITY_UUID = ea.RECORD_ENTITY_UUID
 AND iea.INCLUDE_IN_REFERENCE_FLAG = `Y ) > 0 ) )
AND ea.META_MODEL_VERSION_UUID = (select meta_model_version_uuid from
FUSION.zca_es_meta_model_versions where workflow_state_type_name = `Sandbox )
AND ea.INDEXED_FLAG=`Y 
AND ea.ENABLED_FLAG=`Y 
AND ea.SEARCHABLE_FLAG = `Y 
AND ea.ATTRIBUTE_UUID = ad.ATTRIBUTE_UUID
AND ad.SEARCHABLE_FLAG = `Y 
START WITH ea.ENTITY_UUID = `d8c3af80-bc97-4ff6-a37c-cf9e8e1775c9 AND
ea.META_MODEL_VERSION_UUID = (select meta_model_version_uuid from
FUSION.zca_es_meta_model_versions where workflow_state_type_name = `Sandbox )
CONNECT BY (ea.ENTITY_UUID = PRIOR ea.RECORD_ENTITY_UUID AND
ea.META_MODEL_VERSION_UUID = (select meta_model_version_uuid from
FUSION.zca_es_meta_model_versions where workflow_state_type_name =
`Sandbox ))
AND PRIOR ea.ENABLED_FLAG=`Y AND PRIOR ad.SEARCHABLE_FLAG = `Y AND ((PRIOR
ea.ATTRIBUTE_TYPE_NAME!=`ForeignKey ) OR (PRIOR
ea.ATTRIBUTE_TYPE_NAME=`ForeignKey AND ea.INCLUDE_IN_REFERENCE_FLAG=`Y ));

For more information on Groovy scripting, see the related links.

Related Topics

Enable Merge Requests for Accounts and Contacts  
The Merge Request Enabled (ZCA_MERGE_REQUEST) profile option specifies whether or not to allow salespeople to
perform a merge request action for account and contact records in Workspace. Merging and resolving duplicate records
ensures that clean customer data is available.

The predefined value is set to N, which means that salespeople can't create a merge request if they have duplicate
records pointing to the same customer. You must set the profile option value to Y if you want salespeople to be able to
consolidate those records into one.

Here's how to edit the Merge Request Enabled profile option.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZCA_MERGE_REQUEST in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click the profile option code link.
5. Select Y in the Profile Value  field to turn on the merge request feature.
6. Click Save and Close.
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Related Topics
• Can I merge similar account or contact records in Workspace ?

• Resolve Duplicate Accounts and Contacts

Filter Search Setup  

Create Groupings of Values for Display in Search Filters  
You can create different groupings of values for numeric, corporate currency, percent, and date fields. These groupings
display when the field is used as a filter in a search.

Watch video
 

Users get an overview of the number of records in each value grouping and they can select the groupings to narrow
down their search results even more. For example, you can break down opportunity revenue into different ranges: 0 to
10,000, 10,000 to 100,000, 100,000 to 500,000, and 500,000 and up. When users use opportunity revenue as a filter,
they see how many opportunities fall in each range. Selecting a range automatically displays a list of opportunities in
that range.

You can also place related records displayed together as a group based on account, country, rank and so on. This
provides an overview of the records in each value and you can select a group list to narrow down your search results
even more. You can also perform search based on the fiscal quarters.

Note:  By entering precise search criteria for your saved search, you can greatly decrease the number of search
records returned and decrease the load time.

Before you start to create a value group field, ensure that the field is enabled for Workspace and enabled for UI display
before creating its value groupings. See the Enable Fields for Display as Filters and Search Result Columns topic for
details.

Note:  You can set up to a maximum of six filters. If you try to add more than six filters, you're prompted to remove
filters to meet the maximum threshold of six. Here's how to create a grouping of values for display as a filter in your
search.

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and use:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
3. Click the Configure UI tab.
4. Select the object where you want to set up filter value groupings in the left pane of the tab. You may have to

open up the object hierarchy. The fields for the object display in the Configure Fields tab on the right.
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Note:  You can create filter value groupings only for fields that display a name of an existing grouping in
the Define Groupings column. The Defined Groupings (checked) indicator (a check mark) in this column
indicates filter groupings are created automatically. You can't create your own groupings for these fields.

5. If a filter grouping supplied by Oracle already exists for the field you want to set up, then remove the filter from
the field. You can't edit filter value groupings provided by Oracle.

6. If no filter value groupings exist for the field, then click Search (the down arrow) to display the list of existing
groupings and either select an existing grouping or click the Create link to create a new one.

Here's a screenshot of a portion of the Configure UI page. Callouts identify the relevant features.

Callout Number Description

1
 

Selecting an object on the left displays its fields on the right.
 

2
 

A name in the Define Groupings column tells you that you can create filter groupings of your
own. You must remove the existing filter groupings before selecting or creating a new one. You
can edit groupings by clicking the name, but not those groups provided by Oracle.
 

3
 

A check mark in the Define Groupings column indicates filter groupings are created
automatically. You can't create your own groupings for these fields.
 

4
 

Clicking Search (the down arrow icon) in the Define Groupings column displays a list of existing
filters. Search is only available after you remove an existing grouping for the fields.
 

5
 

Location of the Create link
 

6
 

Selecting the Display in UI option makes the field available in the Workspace UI.
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7. If you're creating a filter for a date field, then do the this:

a. Enter a unique filter name and description. The filter name appears in the list of existing filters whenever
you're adding a new filter.

b. In the Manage Date Filters region, use the Move buttons (arrows) to select the date ranges you want to
use in the filter and change their order. You can't create additional date ranges.

The image shows a screen capture of the Create Filter page for a date field.

c. Click OK when you're done.

Note:  In Workspace, a filter Date type such as Last Week is considered to be from Monday to Sunday
and displays all records from Monday to Sunday of the previous week. Selecting a filter of Last Year, for
example in 2021, would return all records from January 01 2020 to December 31 2020 for the selected
search object.
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8. If you're creating a filter for a numeric, corporate currency, or percent field, then do this:

a. Enter a unique filter name and description. The filter name appears in the list of existing filters whenever
you're adding a new filter.

b. Create the filter value groupings. You can create up to 10 groupings. No gaps or overlaps are allowed
between groupings. To create the groupings:

i. Click Add (the plus icon).
ii. For the first grouping, you can select either the  Less than or the Between operator and enter the

low and high values as appropriate.

Results with the high value you enter aren't included in the filter value range. If you enter a range of
0 to 10,000 then the filter value grouping displays records between 0 and 9,999.

iii. Subsequent groupings copy the high value from the previous grouping as the low value for the
new grouping.

The low value is inclusive. If the low value is 10,000, then the grouping displays results with 10,000.

You can use the Between, Greater than and equal to and Equal to operators.

This table lists the filter value groupings for a sample filter called Revenue Ranges.

Function Low Value High Value

Between
 

0
 

10,000
 

Between
 

10,000
 

100,000
 

Between
 

100,000
 

500,000
 

Greater than or equal to
 

500,000
 

Not applicable. There's no high value for
the Greater than or equal to function.
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Function Low Value High Value

 

This image shows a screen capture of the Create Filter page for the sample Revenue Ranges numeric
filter.

c. Click OK when you're done.
9. Ensure that the Display in UI option is selected for the fields you want to enable for use as filters in the UI. The

fields are also available for display as columns in the search results.
10. Click Save and Close.

The changes you made are reflected in the Workspace UI. No publishing is required for the filter changes.

Note:  If your Accounting Calendar is modified, then you must click Refresh Cache from the Actions menu in the
Setup - Advanced tab on the Configure Adaptive Search page. When complete, sign out and sign back in again to see
the changes reflect in the Fiscal Year based filters in Workspace.

Enable Fields for Display as Filters and Search Result Columns  
You can specify which fields are available for selection as search filters and can be displayed as columns in search results
and saved searches.

The fields you enable by selecting the Display in UI  option from the Configure UI tab in the Configure Adaptive Search
page are available for selection in the Edit Columns and Edit Filters windows.
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Note:  Before you start, make sure that the field you are setting up as a filter is enabled for Adaptive Search. See the
topic Make a Field Searchable in the UI for details.

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and click the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
3. Click Configure UI.
4. Select the object you want to set up in the left pane of the tab. You must open the hierarchy of related objects to

get to some of the fields.
5. Ensure that the Display in UI option is selected for the fields you want enabled as filters and for display in

search results.

Note:  The default layout specifies that a minimum of four fields must be displayed for your Workspace UI
configuration. Therefore, when editing Workspace UI columns and specifying fields, always ensure that you
have at least four fields selected for both standard and custom objects.

6. Click Save and Close.
If you made your changes to a field that was previously enabled for Adaptive Search and you published the
configuration after you enabled the field, then the field can be used as a filter immediately. Otherwise you must publish
your configuration as described in the topic Make a Field Searchable in the UI.

Enable Territory Membership Record Set Values for Workspace  
You can enable the territory membership and territory membership hierarchy values that appear in the opportunity
search filter record sets in the Workspace UI.

The My territory membership record set returns records where the signed in user is either the owner or a member of
territories assigned to the opportunity. The My territory membership hierarchy returns records where the signed in
user is either the owner or a member of a territory assigned to the opportunity, or owner or member of a territory that's
ascendant to an assigned territory. These record sets are predefined but they must be enabled before your salespeople
can use them in Workspace.

Here are the steps to enable the My territory membership and My territory membership hierarchy values for the
opportunity search filter record sets in Workspace.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter Opportunity Filter Record Sets for Workspace.
3. Click Search.
4. Select the lookup type you want to enable in the ORA_MOO_OPTY_SRCH_RS_WS: Lookup Codes page.

◦ Scroll to the ORA_MYASSGMEMBTERROPTIES (My territory membership) lookup code and select
Enabled.
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◦ Scroll to the ORA_MYASSGMEMBDESCTERROPTIES (My territory membership hierarchy) lookup code
and select Enabled.

5. Click Save and Close.

Lists of Prioritized Recent Items  

My Lists  
Based on your use and engagement patterns with your Digital Sales and CX sales application, My Lists present the most
contextually relevant records to help minimize navigation and searching.

My Lists are automatically created for you and are derived from your past and recent application touches and
interactions with the following supported objects:

• Accounts

• Activities

• Contacts

• Leads

• Opportunities

• Partners

• Products,

• Product Groups

Using a predefined relevancy scoring mechanism, lists are based on near real-time user context and display the most
relevant and contextual records data to users once every 10 minutes. They also help reduce the amount of navigation
and clicks required to perform additional searches. For example, the My List for Accounts includes accounts ranked by
the number of times a salesperson has opened each account, its contacts, and its opportunities and how recently. So,
if today you open or update account information on Acme four times, but only open Pinnacle once, then Acme appears
higher on the list than Pinnacle. Each list can display a maximum of 50 items. Items that haven't been touched for 30
days get automatically taken off the list.

Here are some of the factors that affect how relevancy scores influence the presentation of records for your respective
My List saved searches:

• Recency: Last time you interacted with an object

• Frequency: How frequent you interact with an object

• Favorites: Records you mark as a favorite

• Urgency: When an action is expected from you such as task due tomorrow, upcoming appointment, and so on

• Related objects: Relevancy scores are boosted for related account, opportunity, or lead objects associated with
overdue tasks and appointments

• Event-based updates: Updates to win probability, status, and sales stage boosts the relevancy score for
opportunity records

My Lists are included along with saved searches in Digital Sales list pages and in the Sales Dashboard.
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In CX Sales, My Lists are available in Workspace, in work areas powered by Adaptive Search, infolets, and the in CX Sales
Mobile app. For example, to display a list of your accounts in Workspace, salespeople select Accounts > My List for
Accounts, just like any other saved search.

The list is created and maintained by two processes:

• The Generate Relevancy Feed process creates the list. By default, this process runs every 3 hours.

Note:  You can reduce the refresh rates of My Lists from once every 3 hours to near real-time (10 minutes
refresh intervals) by setting the Enable Near Real Time User Context Relevancy profile option to Y.

• The Age User Context Relevancy process removes items from the list that haven't been touched by the user in
the past 30 days. By default, this process runs once a day.

Modify My List Behavior  
My Lists are available automatically to salespeople as soon as they start working in the application. No setup is required.
However, you can modify My List behavior in a few ways:

• Change how long untouched items are kept in the list. By default, items are kept 30 days after they're accessed
last. For example, if your organization has long sales cycles, then you may want to keep items on the list for a
little longer.

• Enable the Near Real-Time User Contextual Relevancy profile option.

• Change how frequently and when My Lists are refreshed to improve user experience.

Change How Long Items Are Kept in the List
You can change the number of days untouched records are kept in the list by setting the profile option, Relevancy Aging
Maximum Number of Days (ZCA_UC_AGING_CYCLE). Here's how:

1. In Setup and Maintenance, open the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search by the profile option name Relevancy Aging
Maximum Number of Days or code ZCA_UC_AGING_CYCLE .

3. Click the profile option name link.
4. Set the profile option value to the desired number of days.
5. Save your changes.

Enable the Near Real-Time User Contextual Relevancy Profile Option
You can enable near real-time user contextual relevancy by setting the profile option, Enable Near Real Time User
Context Relevancy (ORA_ZCA_UC_ENABLE_NRT). Here's how:

1. In Setup and Maintenance, open the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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◦ Task: Manage Administrator Profile Values
2. In the Manage Administrator Profile Values page, search by the profile option name Enable Near Real Time

User Context Relevancy or code ORA_ZCA_UC_ENABLE_NRT .
3. Click the profile option name link.
4. Change the profile option value from FALSE to Y to enable near real-time user contextual relevancy.
5. Save your changes.

Run the My List Processes with Different Frequencies and Schedules
You can change how frequently or when you run the two processes that generate the My Lst and remove untouched
items from the list:

• Generate Relevancy Feed
Generates My Lists by analyzing all records that have been updated in the last 24 hours. By default, this process
runs every three hours.

• Age User Context Relevancy Feed
Removes from My Lists all items that haven't been accessed in the past 30 days (the number of days set in the
profile option Relevancy Aging Maximum Number of Days). By default, this process runs once a day.

See the User Context section of the Sales and B2B Service Scheduled Processes chapter of Understanding Scheduled
Processes guide for details.

Related Topics
• Create and Edit Profile Options

• Age User Context Relevancy Feed

Additional Configurations  

Set Up Search on Personally Identifiable Information in Workspace
 
Workspace supports personally identifiable information (PII) attributes and includes them in search criteria and search
results. The PII attributes are appropriately secured based on the READ privileges and aren't searchable (masked) if you
don't have the necessary READ privilege.

Here are the PII attributes that are masked or are available in Workspace based on the different user privileges:

• HZ_VIEW_TRADING_COMMUNITY_PERSON_SOCIAL_SECURITY_DATA

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Don't mask
 

Mask
 

Mask
 

Mask all home
and mobile
phones

Mask
 

Mask all home
addresses
 

Mask
 

Mask all
personal
emails
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JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

  

• HZ_VIEW_TRADING_COMMUNITY_PERSON_CONTACT_DATA

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Mask
 

Don't mask
 

Mask
 

Mask all
mobile phones
 

Mask
 

Mask all home
addresses
 

Don't mask
 

Don't mask
 

• HZ_VIEW_TRADING_COMMUNITY_PERSON_MOBILE_PHONE_DATA

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Mask
 

Mask
 

Don't mask
 

Mask all home
phones
 

Mask
 

Mask all home
addresses
 

Mask
 

Mask all
personal
emails
 

• HZ_VIEW_TRADING_COMMUNITY_PERSON_CONTACT_DATA and
HZ_VIEW_TRADING_COMMUNITY_PERSON_MOBILE_PHONE_DATA

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Mask
 

Don't mask
 

Don't mask
 

Don't mask
 

Mask
 

Mask all home
addresses
 

Don't mask
 

Don't mask
 

• HZ_VIEW_TRADING_COMMUNITY_PERSON_ADDRESS_DATA

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Mask
 

Mask
 

Mask
 

Mask all home
and mobile
phones

Don't mask
 

Don't mask
 

Mask
 

Mask all
personal
emails
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JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

  

• No user privilege

JgzzFiscalCode HomePhone MobilePhone PrimaryPhone,
 ListOfPhones

HomeAddress PrimaryAddress,
ListOfAddresses

PersonalEmail PrimaryEmail,
 ListOfEmails

Mask
 

Mask
 

Mask
 

Mask all home
and mobile
phones
 

Mask
 

Mask all home
addresses
 

Mask
 

Mask all
personal
emails
 

Related Topics
• Manage Personally Identifiable Information

• Assign PII Privileges Using Security Console

About Aggregates in Adaptive Search  
In previous releases, Workspace supported a set of predefined aggregated fields. Aggregated fields calculate key record
metrics displayed in search results and lets you view calculations that include count, average, and sum of values across
fields on a record, related objects, and parent-child objects.

Note:  Predefined aggregated fields are no longer available for this release. As an alternative, Oracle recommends that
you use Rollups functionality as search criteria for your summarized data. Rollups summarize data for an attribute of
a business object and its related objects. For example, a rollup can calculate the sum of the potential revenue from
the opportunities for an account hierarchy within the last 120 days. You can view rollups in the Rollups subtab on the
object pages you enable for your CX sales users. See the topic Setup Summary for Rollups from the Rollups chapter of
the Implementing Sales guide for more information.

Access Workspace Data Offline  
You can export data from Workspace for offline viewing and verification. For example, a sales manager might want to
export a list of accounts to perform a more in-depth analysis of their sales team or for reporting purposes.

Only sales manager and sales administrator roles are granted the predefined security privilege
ZCA_WORKSPACE_EXPORT to access the export data feature in Workspace.

The Export List button enables you download data from Workspace as a comma-separated values file. You can then
use this file to view or analyze your data offline.
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Click Export List to download all data in the result set. The result set is determined by the columns displayed in the
Workspace UI. Export doesn't include data for hidden columns. It includes all the rows filtered by the current filter
criteria applied.

The default number of rows to export is 2000 and the maximum limit is set at 10000 rows. You can change the default
number of rows by changing the Maximum Number of Records for Export parameter from the Parameters tab on the
Configure Adaptive Search page. See the related topic Edit Adaptive Search Parameters for more information.

When the maximum limit of rows to export is reached, a warning message is displayed prompting you to click Continue
to export the first 2000 rows in the result. This action generates a file containing the first 2000 rows of the result set. If
you don't want to export the result set, click Cancel to return to the Workspace UI.

The exported file contains the results set data displayed in the same column headers and in the same order as displayed
in Workspace.

Note:  You can also export personally identifiable information (PII) if you have the required access to view PII
attributes in Workspace.

Related Topics
• Edit Adaptive Search Parameters

Dynamic Nested Tabs  
Service users with job roles such as Customer Service Representative and Customer Service Manager can keep multiple
records open at the same time in nested tabs in the Workspace UI.

While this Workspace feature isn't available to the sales job roles provided by Oracle, you can create custom job roles
with these privileges to enable the dynamic nested tabs:

• Open Objects in Dynamic Tabs

• Open Objects in Dynamic Tabs for FSCM

• Open Objects in Dynamic Tabs for HCM

For more information about creating job roles and assigning privileges, see the Securing CX Sales and Fusion Service
guide.

Note:  If you choose to use dynamic tabs, then record-level navigation won't be possible. That means that the
Previous and Next buttons on the record details page won't be available for navigating lists of records for Account,
Contact, Lead, Opportunity, Activity, Campaign, Territory, and custom objects through the Workspace UI.

Related Topics
• Enable Nested Tabs for Territories in Workspace
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Enable Nested Tabs for Territories in Workspace  
You can enable dynamic and nested tabs for territories in Workspace. This allows salespeople to easily find territories, as
well as view and manage multiple territories at the same time.

Dynamic and nested tabs are hidden by default. When using nested tabs, Next and Previous buttons
aren't available in the Edit Territory pages. The Workspace Dynamic and Nested Tabs Enabled
(ZCA_ENABLE_WORKSPACE_DYNAMIC_TABS) profile option enables users to display tabs for different types of work
items at the same time.

Note:  To enable dynamic and nested tabs in Workspace, you must add the Open Objects in Dynamic Tabs
(SVC_OPEN_OBJECTS_IN_DTNT_PRIV) privilege to the Sales Administrator or equivalent administrator role.

Here's how to enable the ZCA_ENABLE_WORKSPACE_DYNAMIC_TABS profile option.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZCA_ENABLE_WORKSPACE_DYNAMIC_TABS in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click the profile option code link.
5. Select Y in the Profile Value  field to enable the dynamic and nested tab feature.
6. Click Save and Close.

Enable Custom Dynamic Choice Lists (DCL) for Resource Object on
Adaptive Search  
You can view, search, and add filters on all dynamic choice list fields for the Resource object using Adaptive Search. You
must first create a user-defined profile option, set its value to Y (Yes), and specify the Site profile level.

A dynamic choice list is a field that contains a list of values which are populated from the actual data of another object.
You can select filter dynamic choice lists by using saved searches as filter criteria to return a set of search records that
best suits your requirements.

Here are the steps to create the ENABLE_CUSTOM_RESOURCE_DCL_IN_ADAPTIVESEARCH user-defined profile option.

1. Navigate to the Setup and Maintenance work area. Click the Tasks side panel icon and then click the Search
link.

2. Search for and select the Manage Profile Options task.
3. Create a new profile option, using these details:

◦ Profile Option Code: ZCA_ENABLE_CUSTOM_RESOURCE_DCL_IN_ADAPTIVESEARCH

◦ Profile Display Name: ENABLE_CUSTOM_RESOURCE_DCL_IN_ADAPTIVESEARCH (alternatively, provide a
name of your choice)

◦ Application: Common Search
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◦ Module: Search

◦ Start Date: Enter today’s date

4. Click Save and Close.
5. In the Profile Values section, for the Site level, check the Enabled and Updatable check boxes.
6. Click Save.
7. Next, you need to set the values for the profile option. Search for and select the Manage Administrator Profile

Values task.
8. Search for the ZCA_ENABLE_CUSTOM_RESOURCE_DCL_IN_ADAPTIVESEARCH profile option you have just

created.
9. In the Profile Values section, navigate to the Site profile level, and enter the Profile Value as Y.

10. Sign out and sign back in again.
Next, navigate to the Adaptive Search configuration and the Resource DCL should show up as a field in your list. You
must click Publish to run the process after you make changes to your configuration and make Resource DCL available
for searching.

Workspace Extensions  

Add Custom Objects, Custom Child Objects, and Custom Fields to
Workspace UI  
Users with permission to access a custom object can search on it from the Workspace UI, search on one or more fields
within the custom object, retrieve search results, and create saved searches for the custom object.

Fields are searchable both in the Search box and in filters. Searching on top-level custom objects and their custom child
objects is supported. Custom child objects of standard objects are also supported.

Adaptive Search supports predefined relationships between the ready-to-use standard business objects. It also
supports one-to-one and one-to-many custom relationships between standard and custom objects.

Note:  Custom long texts aren’t supported.

Custom fields and custom child objects must be published from the sandbox before you configure Adaptive Search to
include them. You can't configure Adaptive Search inside a sandbox. Follow this standard process:

1. Create the custom fields and custom child objects using Application Composer while working in a sandbox.
2. Publish the sandbox.
3. With no sandbox open, configure the search behavior you want in Adaptive Search as described in this chapter

and publish the new configuration.

Note:  If you have dynamic choice list fields included from a custom object to a standard object, such as an
Opportunity, then the standard object attributes that you selected by setting the Include in Object Reference  check
box are displayed in the custom object list page. However, the custom object attributes won't be available in the
standard object list page because dynamic choice list fields aren't supported from standard objects to custom object.
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Synchronization of Custom Objects, Custom Child Objects, and Custom Fields to
Workspace
When you launch the Workspace search configuration, all custom attributes published using Application Composer and
the sandbox are synchronized to the Workspace configuration UIs. It may take a little time to synchronize all custom
objects, custom child objects and custom fields to the Workspace search setup. If the searchable attribute is set to
true in Application Composer, all custom attributes for standard top level objects and custom objects are enabled for
indexing by default. However, if the searchable attribute that you want isn't set to true, then you must explicitly enable it
for indexing.

Setup is done on the Advanced setup tab. You select the business object you want to set up in the left pane of the tab,
and set the object's search properties in the right pane. See the topic How Search Attribute Behavior is Modified for
more information.

Configure Deep Links for Workspace  
Deep links are links that point to another page. You can embed default Workspace deep link URL patterns for the
supported and custom objects to any web page as a link.

By clicking these deep links, your sales and service users can go directly to the details of the corresponding record
within the context of Workspace.

Deep Link URL Patterns
Here's an example of the standard direct URL link to for the Account business object:

https://<hostname>:<port>/crmUI/faces/FuseOverview?fndGlobalItemNodeId=
itemNode_workspace_workspace&fndTaskItemNodeId= ZCA_CC_INTERACTIVE_UI_CRM&fnd=%3B
entityName%253DAccount %253BsubTabName%253DOverview%253BrecordId%253D<RecordID>%253B%3B%3B%3Bfalse%3B256%3B
%3B%3B 

In some cases, an additional parameter, subTabName, is also included in the URL. For example, this sample URL syntax
allows direct links to the specified subtab:

http://<hostname>:<port>/crmUI/faces/FuseOverview?fndGlobalItemNodeId=
itemNode_workspace_workspace&fndTaskItemNodeId=ZCA_CC_INTERACTIVE_UI_CRM&fnd=%3B
entityName%253D<EntityName>%253BsubTabName%253D<SubTabName>%253BrecordId%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B

If you want the selected record to open in inline mode, just add &action=EDIT_INLINE to the end of the URL. For example,
this sample syntax open your record ID in inline mode:

http://<hostname>:<port>/crmUI/faces/FuseOverview?fndGlobalItemNodeId=
itemNode_workspace_workspace&fndTaskItemNodeId=ZCA_CC_INTERACTIVE_UI_CRM&fnd=%3B
entityName%253D<EntityName>%253BsubTabName%253D<SubTabName>%253BrecordId%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B&action=EDIT_INLINE

Note:  If you don't specify &action=EDIT_INLINE, records open in inline mode by default.

You can also configure deep links to open selected records in dynamic and nested tabs by adding &action=EDIT_IN_TAB
to the end of the URL. For example, this sample syntax opens your record ID for edit in a dynamic tab:

http://<hostname>:<port>/crmUI/faces/FuseOverview?fndGlobalItemNodeId=
itemNode_workspace_workspace&fndTaskItemNodeId=ZCA_CC_INTERACTIVE_UI_CRM&fnd=%3B
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entityName%253D<EntityName>%253BsubTabName%253D<SubTabName>%253BrecordId%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B&action=EDIT_IN_TAB

In the above sample syntax, you must replace the <RecordID> with the actual value from your environment. To get
this value, use the this sample SQL syntax to retrieve a record ID for a service request that has an SR Number value of
SR0000000002.

select sr_id from fusion.svc_service_requests where sr_number = 'SR0000000002'

Note:  For deep links to Workspace saved searches, the <Saved_Search_UUID> should belong to the same entity as the
<RecordID>.

For example,

https://<hostname>:<port>/fscmUI/faces/deeplink?objType=ZCA_WORKSPACE_REQUEST&obj
Key=savedSearchUuid%3D<Saved_Search_UUID>%3entityName%3D<EntityName>%3BrecordId%3D
<RecordId>%3BsubTabName%3D<SubTabName>&action=EDIT_INLINE

A URL example to a default action to a Workspace List page is as follows:

https://<hostname>:<port>/fscmUI/faces/deeplink?objType=ZCA_WORKSPACE_REQUEST&action=NONE

Here's an example deep link URL to a default action for a saved search List page:

https://<hostname>:<port>/fscmUI/faces/deeplink?objType=ZCA_WORKSPACE_REQUESTobjKey=savedSearchUuid
%3D<Saved_Search_UUID>&action=NONE

Workspace Deep Link Configuration for Supported Business Objects
For each of the supported business objects, the table lists:

• The URL pattern syntax

• Whether or not the URL pattern supports a subtab name for the specific object

Tip:  Copy the first part of the URL, https://<hostname>:<port>/, from your instance's actual home page.

Business Object URL Pattern Supported Subtabs

Account
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName%253DAccount
%253BsubTabName%253DOverview
%253BrecordId%253D<RecordID>%253B%3B
%3B%3Bfalse%3B256%3B%3B%3B 

• Overview

• Profile

• Sales Account Team

• Contacts

• Assets

• Opportunities

• Quotes

• Leads

• Relationships

• Recommendations

• Notes
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Business Object URL Pattern Supported Subtabs

Activity
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DActivity%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B

None
 

Asset
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DAsset%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B 

None
 

Campaign
 

http://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=ZCA_CC_
INTERACTIVE_UI_CRM&fnd=%3BentityName
%253DCampaign%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B25

None
 

Contact
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DContact%253BsubTabName
%253DOverview%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B 

• Overview

• Profile

• Team

• Opportunities

• Leads

• Assets

• Relationships

• Recommendations

• Notes

• Activities

• Conversations

Custom Object
 

http://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253D<XXXX>%253BsubTabName
%253DSUMMARY%253BrecordId

None
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Business Object URL Pattern Supported Subtabs

%253D<RecordID>%253B%3B%3B%3Bfalse
%3B2 56%3B%3B%3B 

Replace XXXX with the custom object's
 API name

Deal Registration
 

http://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=ZCA_CC_
INTERACTIVE_UI_CRM&fnd=%3BentityName
%253DDealRegistration%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B25

None
 

Lead
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DLead%253BsubTabName%253DSUMMARY
%253BrecordId%253D<RecordID>%253B%3B
%3B%3Bfalse%3B256%3B%3B%3B 

• Summary

• Contacts

• Qualifications

• Sales Team

• Activities

• Responses

• Notes

• Opportunities

• Conversations

• Analytics_1

• Analytics_2

• Analytics_3

Opportunity
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DOpportunity%253BsubTabName
%253DSummary%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B 

• Summary

• Quotes

• Contacts

• Opportunity Team

• Opportunity Partner

• Activities

• Notes

• Assessments

• Leads

• Conversations

Partner
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName

• Overview

• Profile

• Partner Account Team

• Opportunities

• Contacts

341



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

Business Object URL Pattern Supported Subtabs

%253DPartner%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B

• Activities

• Enrollments

• Notes

• Deals

• Leads

• Conversations

• Service Requests

• Business Plans

• Assets

• Assessments

Partner Contacts
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DPartnerContact%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B

None
 

Quotes and Orders
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName%253DSalesOrderHeader
%253BrecordId%253D<RecordID>%253B%3B
%3B%3Bfalse%3B256%3B%3B%3B 

None
 

Service Requests
 

https://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=
ZCA_CC_INTERACTIVE_UI_CRM&fnd=
%3BentityName
%253DCRMServiceRequest%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B256%3B%3B%3B 

• Summary (Default)

• Messages

• Interaction History

• Contacts

• Team

• Activities

• Actions and Plans

• Social

• Linked Articles

• Milestone Details

• Part Details

• Work Orders

• Audit History

• Connected Asset
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Business Object URL Pattern Supported Subtabs

Territory
 

http://<hostname>:<port>/
crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_
workspace_
workspace&fndTaskItemNodeId=ZCA_CC_
INTERACTIVE_UI_CRM&fnd=%3BentityName
%253DTerritory%253BrecordId
%253D<RecordID>%253B%3B%3B%3Bfalse
%3B25

None
 

Manage Workspace Smart Actions  
You can manage predefined Workspace actions, such as Create an Appointment, Create a Task, and Create an
Opportunity, using the Smart Actions administration tool in Application Composer.

Smart actions are actions that are specifically mapped to a client application, such as Workspace, and displayed to users
only when specific conditions are met.

You can control which actions are available to Workspace for display at runtime and set the order in which actions are
displayed to users. For example, you can use the tool to:

• Enable or remove an action by selecting or clearing the Enabled check box.

• Change the runtime display sequence of actions by clicking Reorder. For each set of rows within an object
category, drag and drop table rows until you achieve the desired row order.

Here's how.

1. Create a unified sandbox and navigate to the Smart Actions administration tool in Application Composer, under
Common Setup.

2. Using the Actions search box, look for the action that you want to enable, hide, reorder, modify and so on.
3. If you make changes to predefined actions be sure to publish the sandbox, sign out of the application, and sign

back in.
4. Verify your changes in Workspace.

Related Topics
• Extend Lead-Related Actions for Workspace

• Overview of Smart Actions
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Adaptive Search Troubleshooting  

Why is my Adaptive Search publish process taking time to
complete?  
The Publish process publishes the Adaptive Search configuration you set up in the Quick Setup and Advanced Setup
UIs. You must click Publish to run the process each time you make changes on the Setup tab. Your changes become
effective when the process completes.

The variations in the time it takes for the successful completion of the publish process is mainly due to the volume of
data, the number of objects enabled, and the number of attributes selected for each object.

For example, if you publish more attributes and more objects, then it takes more time to complete the publish and
indexing process. You can improve the performance by removing any attributes that you don't want to be indexed.
You can also monitor the progress of the publish process. Your configuration is live when the process completes
successfully.

Note:  The Publish process should be completed before running the Periodic refresh process.

Can I modify or translate saved searches using the User Interface
Text tool?  
No. You can't use the User Interface Text tool to modify or translate predefined Workspace saved searches. However,
you can select Manage Saved Searches to create a copy of the saved search and rename it to suit your business
requirements.

If you translate the text, ensure you use the current language of the assigned users of the saved search.

How can I display contact information in the Workspace on a
Service Request where no Account exists?  
Primary Contact is considered a Contact if an Account exist for a Service Request. If an account doesn't exist for a
service request, then the Primary Contact is considered as a Consumer.

To display the contact information in the Workspace on a service request where no Account exists, you must expose
Consumer fields in the Edit Columns panel of your search results.

The fields to expose are Consumer: Name, Consumer: Primary Address, and Consumer: Primary Phone. You must make
sure these fields are enabled for Workspace and enabled for UI display before making them available on your service
request search results page. See the Enable Fields for Display as Filters and Search Result Columns topic for details.
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You can then add which columns to display and in what order on the Service Request page by clicking the Edit Column
(pencil icon on the far right of the Workspace UI). See the topic Change Columns Displayed in Search Results for more
information.

Related Topics
• Enable Fields for Display as Filters and Search Result Columns

• Change Columns Displayed in Search Results

How can I defer replicating records during reindexing?  
You can configure how Adaptive Search indexes custom search records using the Advanced subtab from the
Parameters tab available in the Adaptive Search setup page. For example, for custom objects, you might want to defer
re-indexing of previously created records when running a partial publish indexing process.

Note:  You must have the ZCA_ADAPTIVE_SEARCH_EDIT_PARAMS_PRIV privilege to view and access the Advanced
parameters of Adaptive Search.

You can choose to change current and default advanced parameter values if you have the required privilege. Here's how
to edit the Defer Replica Creation During Reindexing Adaptive Search parameters for your custom business object.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters  > Advanced tab.
4. Highlight the Defer Replica Creation During Reindexing that you want to change and click Edit. This warning

is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. Do you want to 
continue?

5. Click Yes.
6. In the Current Value field, change the value from No (default value) to Yes and click Save and Close.

The next time you perform a partial publish, only a reindexing of the custom object occurs and takes less time to
complete.

What security configuration changes does Workspace support?  
Workspace supports standard, predefined job roles, custom job roles, and standard, predefined data security predicates.
Workspace doesn't support custom data security predicates.
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If your deployment uses custom data security predicates that impact data used by Workspace, you can either remove
these custom predicates and replace them with standard, predefined data security predicates or adopt the Access
Groups feature. See the Access Groups chapter in the Securing CX Sales and Fusion Service guide for more information.

FAQs for Adaptive Search and Workspace  

Frequently Asked Questions (FAQs) for Adaptive Search and
Workspace  
This section contains some frequently asked questions (FAQs) when setting up and maintaining Adaptive Search and
Workspace functionality. Scroll or search to find answers to common questions.

How can I specify which Adaptive Search objects to display in the
Workspace UI?  
You can selectively hide or show which Adaptive Search-enabled, top-level objects to expose in the Workspace UI. This
feature provides access to an object through the Adaptive Search REST APIs, without making the object available to
salespeople in Workspace.

For example, your salespeople might want to use an object solely from their mobile device and no longer want to view it
from the Workspace UI. To allow this, you can navigate to the Configure UI  tab in the Configure Adaptive Search setup
task and deselect the Display in UI check box for that object.

How can I view and assign a default saved search for a role?  
To view and assign a default saved search for a role, you must fulfill all of the following conditions:

• Have the ZCA_MANAGE_INTERACTIVE_LISTS_SAVED_SEARCH privilege so that you can view the Set Defaults
tab

• Permission to view the object underlying the saved search to be assigned (for example, to assign an account
default saved search, you must have permission to view the account)

Note:  The search results returned may differ for each user as it depends on the role each user has.

How can I display product revenue details for my opportunity?  
Workspace and work areas powered by Adaptive Search stores revenue details of the products in the Revenues field.
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An opportunity can have more than one product, therefore revenues aren't displayed in the UI. If you want to view a list
of opportunities having one specific product, you can add a filter on the Revenues field to search for corresponding
records.

When you create an opportunity, a primary revenue record is automatically created. The primary revenue record is
independent of products added to an opportunity and is always associated with the opportunity even if no products
are added to the opportunity. The primary revenue record displays as a summary line in the UI but no product related
information such as item name or description values are displayed.

What does the fuzziness level for fuzzy searches mean?  
The percent sign (%) is the character used for fuzzy searches. The number of the % indicates how many characters in
the search term will be ignored by the Adaptive search engine when it runs the query.

The position of the % indicates the number of characters from the beginning of the term that must match exactly with
words in the result set. The following search strings illustrate how this character is used in Workspace:

• app%ly indicates that a matching word must begin with "app", and differ from "apply" by only 1 character.

• a%%pply indicates that a matching word must begin with "a", and differ from "apply" by only 2 characters.

The default fuzziness level is set as 1 character. See the topic Edit Adaptive Search Parameters for information.

Related Topics
• Edit Adaptive Search Parameters

How do I determine what fields are available for mass update?  
As part of your Adaptive Search setup, you can tailor the list of fields available for mass update for each of your enabled
objects.

From the Configure UI page, select the object and highlight the fields you want to have enabled or removed for the
mass update feature and select or deselect the Enable for Mass Update check box.

Why can't I view the Parent Account field in Workspace?  
In the Accounts object, the Parent Account is visible in Page Layout and Detailed view from Application Composer but
as per current design, the field isn't available in custom and standard field layouts in Workspace.

This is expected behavior because the Parent Account is a collection of objects that can have multiple parent accounts.
Therefore users can't populate custom fields with the value of Parent Account.

347



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 11
Adaptive Search and Workspace

Global Search  

Overview of Global Search Setup  
In update 21A, Oracle switched to using Adaptive Search technology for global search. You must complete the Adaptive
Search setup described in the Adaptive Search and Workspace chapter before configuring global search.

If you see the global search box at the top of the page and you configured Adaptive Search, the new global search works
without additional setup. However, you may still want to make some of the configuration changes outlined here.

Step Description Navigation Where to Get More Details

1
 

Check to see if the global search
box appears at the top of the page.
If it doesn't, you can display it by
setting the profile Global Search
Enabled to Yes.
 

Setup and Maintenance > Sales >
Sales Foundation > Manage
Administrator Profile Values
 
 

See the topic: Display the Global
Search Box in the UI.
 

2
 

You can restrict the number of
objects that can be searched using
global search and specify which
fields display for each record in
the search results. By default,
 all of the objects you enabled in
Adaptive Search are automatically
searchable from the global search
box at the top of the page.
 

Setup and Maintenance > Sales >
Sales Foundation > All Tasks >
Configure Adaptive Search >
Configure Global Search
 

See the topic: Configure Global
Search Scope and Display of
Search Results
 

3
 

Optionally, you can change the way
the global search UI appears to
salespeople by creating a custom
configuration. For example, you
can change which suggestions
display when you click in the
search box and which objects
get displayed in search results by
default.
 
If you're an existing customer and
you created a custom configuration
in the past, your configuration still
works even if you created it before
the switch to Adaptive Search.
 

Setup and Maintenance >
Sales > Sales Foundation > All
Tasks > Manage Global Search
Configurations
 

See the topics:
 

• Global Search UI

• Configure Global Search UIs

4
 

You can make additional fields
searchable using global search by
setting the Include in Keyword
Search option.
 

Setup and Maintenance > Sales >
Sales Foundation > All Tasks >
Configure Adaptive Search >
Setup > Advanced
 
 

See the topic: "Make a Field
Searchable in Workspace and
Global Search" in the Adaptive
Search and Workspace chapter.
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Step Description Navigation Where to Get More Details

Note:  Because they're Personal
Identifiable Information (PII),
 you can't make contact email
addresses and phone numbers
available for search using global
search.

Related Topics
• Make a Field Searchable in the UI

Display the Global Search Box in the UI  
Display the global search box at the top of the page by setting the system profile option Global Search Enabled to Yes.

1. In Setup and Maintenance, open the task Manage Administrator Profile Values:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. In the Manage Administrator Profile Values page, search for the system profile option by entering

FUSION_APPS_SEARCH_ENABLED in the Profile Option Code field.
3. In the Profile Values section, select Yes from the Profile Value list.
4. Click Save and Close.
5. You must sign out and sign in again to see the global search box at the top of the page.

Global Search UI  
Global Search is the search box at the top of the page in the CX Sales UIs. This feature isn't available in Digital Sales.
Here's a summary how global search works and how you can configure it.

How It Works What You Can Change

When salespeople click in the global
search box (callout 1), the application
suggests recent search terms, recent
pages you visited, and other recent items.
The items are organized in suggestions
groups (callout 2). For example, under
Recent Items, the application suggests
recent pages you visited.
 

• Change the "Search" prompt in the global search box.

• Specify which suggestion groups get displayed for users by default. For example, you may want
to hide Recent Items and show Recent Searches first.

Salespeople can specify which suggestion
categories they want to see and which
categories of results are available in the

• Specify which suggestion groups are available for use. For example, instead of hiding Recent
Items by default, you may want to remove it from use entirely so users can no longer display the
category.
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How It Works What You Can Change

search results, by clicking Personalize
(callout 3), the application suggests recent
items they worked on recently.
 

Salespeople enter keywords in the search
box (callout 1) and press Return to search
across different objects.
 

• You can specify which objects are available for global search and how the results are displayed.
See the topic Configure Global Search Scope and Display of Search Results

Here's how the results get displayed after you enter your search term and press Enter.

How It Works What You Can Change

The results of the search show the objects
that are enabled for global search during
setup.
 

• You specify which objects are available for global search and how the results are displayed. See
the topic Configure Global Search Scope and Display of Search Results

Salespeople click Show Filters, and select
those objects they want to see in their
search results (callout 1).
 

• The objects you selected for use in global search, show up as the available filters here.

• You can specify which objects are selected by default.

Clicking on the first line of each search
result opens the record for editing.
 

• By default, users drill down on the record name, but you can specify a different field as the title.

• You can also specify which fields display in the two lines below the title in each search result.
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Salespeople can personalize their global searches by clicking Personalize. See the topic Configure Global Search and
Result UIs to learn how to make changes in the default behavior.

How It Works What You Can Change

Salespeople can specify which objects are
included in search results and in which
order.
 

• You can specify which objects are available for selection and which are enabled by default.

• You can disable personalization of search categories.

Salespeople can specify which
autosuggest groups show up and in which
order when they click in the global search
box.
 

• You can specify which autosuggest groups are available for display and which are enabled by
default.

• You can disable personalization of autosuggest groups.

Here's the Search Categories tab salespeople can use to select which objects (categories) are included in search results.
Changing the order of results isn't supported.
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Salespeople can control which Autosuggest Groups tab makes it possible to control the suggestions you get when you
first click in the global search.
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Related Topics
• Configure Global Search UIs

Configure Global Search Scope and Display of Search Results  
You can specify which of the objects you enabled for Adaptive Search are searchable in Global Search and how the
search results are displayed.

Each search result, includes:

• A title that provides the link that users click to drill down into the record. By default, the name of the record is
the title, but you can choose a different field.

• Two lines displaying fields you specify

Here is a screenshot showing the results of an account search:
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1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search
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2. In the Configure Adaptive Search page, click the Configure Global Search tab in the left-side of the page
(callout 1 in the screenshot).

1. Configure each object you enabled for Adaptive Search:

a. Click the object link in the Objects column on the left (callout 2).
b. You can prevent users from using Global Search to search the object by deselecting the Display in UI

option (callout 3). By default, users can search all objects you enabled for Adaptive Search.
c. By default, users click on the record name link in the search results to drill into a record, but you can

select a different field. To change the drill-down link, click Title (the pencil icon, callout 4) and select the
alternate field.

d. Click the Line 1 edit button and select the fields you want to display in the first line under the title.
e. Click the Line 2 edit button and select the fields you want to display in the second line.
f. Click Save.

2. When you complete configuring all the objects, click Save and Close.

Configure Global Search UIs  
Optionally, you can configure the behavior of global search UIs. For example, you can specify which suggestions display
automatically when users click in the search field and which objects display in search results. You can create different
configurations for different application pages.

Tip:  If you already made a copy of the new OSC Default Global Search Configuration, then you can edit that copy and
make your changes there. You don't need to create a second copy.
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Duplicate the Default Configuration Provided by Oracle
You can't make changes to the Global Search configuration provided by Oracle. You must copy the Oracle configuration
and edit that copy instead. If you already created a copy, you can skip this step.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, open the Manage Global Search Configurations task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Global Search Configurations

3. On the Manage Global Search Configurations page, select the configuration with the OSC short name and
Default Global Search Configuration name.

4. Click Duplicate (the document icon).
5. In the Short Name field, enter an alphanumeric code with uppercase letters and no spaces.
6. Enter a name for your configuration in Display Name.
7. Select CRM as the product family and module.
8. Leave the Default option deselected for now. You select this option as a last step.
9. Click Save and Close.

10. Open the Manage Global Search Configurations page again.
11. Click the name link for the configuration you created.
12. Use the tabs to define your configuration:

◦ Autosuggest: Determine what's available to users in the global search autosuggest, as well as how
autosuggest looks and behaves.

◦ Search Field: Control the Search field in the global header and in the search results dialog box.

◦ Search Results: Specify if salespeople can personalize the filters used in their searches

◦ Pages: Specify where you want your configuration to apply.
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Define Which Groups of Suggestions Users See

1. While editing the global search configuration you created, click the Autosuggest tab.

2. Skip setup of Synonyms as they don't apply to Sales.
3. Keep the Enable personalization of search groups option selected unless you want to prevent users from

personalizing suggestion groups.
4. In the Suggestion Groups section:

◦ Move the Saved Searches group (callout 2), and any other unwanted suggestion groups, to the Available
Groups column. This action removes them from use. Saved searches can't be used with Global Search.

◦ You can remove a suggestion group from being displayed by default by setting Enable to No. Users can
still enable the group when they personalized their global search.

◦ You can change the order the suggestion groups are presented to users.

◦ You can change the suggestion group headings.
i. Click Manage Suggestion Groups.

ii. Duplicate an existing group and edit your copy.
iii. Click Refresh.
iv. Swap your copy for the original.

5. You can turn the suggestion group headings off in the Appearance section (callout 3).
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6. You can change suggestion behavior (callout 4):

◦ Show Top Suggestions: Enable this option to display suggestions in autosuggest as soon as the user
clicks in the search field, even without entering a search term. For example, the last few pages the user
opened would appear as suggestions in the Recent Items group.

◦ Minimum Characters for Autosuggest: Enter the number of characters that users must enter in the
search field before matching suggestions appear in autosuggest.

◦ Maximum Number of Suggestions: Enter the maximum number of suggestions to be displayed across
all suggestion groups. This total is distributed as equally as possible among the groups.

Configure the Global Search Field
Here are the main configurations for the global search box field:

• You can change the minimum and maximum number of characters required for search.

• You can specify a different word to appear in the Global Search box instead of "Search".

Configure How Salespeople Can Use Filters

• In the Saved Search and Recent Search section, you can disable the display of recent searches by deselecting
Enable recent searches. Saved searches aren't available in global search.

• In the Filters section:

◦ Keep Enable personalization of search categories selected unless you want to prevent users from
specifying which objects they see in the search results. You determine the objects that show up as filters
in global search while setting up Adaptive Search (see the topic Configure Global Search Scope and
Display of Search Results).

◦ Enable clear all filters: Allow users to clear all filters by clicking the Clear All Filters button in search
results.

◦ Show applied filters: Show all the filters that have been applied

• The Search Categories section and the rest of the sections on this tab don't apply to CX Sales.
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Specify the Sales Pages Where Your Configuration Applies and Complete the
Configuration
Entering the application pages is a one-time setup. If you're editing a configuration you created, then you don't need to
reenter the page codes again. You can skip this step.

1. Enter codes (view IDs) for the applications or pages where you want your configuration to apply. Here are the
entries for CX Sales:

View Type View ID

Application
 

CRMPerformanceApp%
 

Application
 

ORA_CRM_SERVICESAPP%
 

Application
 

ORA_CRM_UIAPP%
 

Application
 

ORA_SERVICEAPP%
 

Application
 

SalesApp%
 

Application
 

ORA_FSCM_UIAPP%
 

You can obtain other codes in Setup and Maintenance, using the Manage Taxonomy Hierarchy task as
described the linked topic: Specify the Pages or Applications That a Global Search Configuration Applies To.

2. At the top of the page, select the Default option.
3. Click Save and Close.
4. Clear your browser cache and navigate to any of the sales pages to test your configuration.
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12  Workspace Infolets

About Workspace Infolets  
New actionable infolets, called Workspace infolets, provide salespeople with many of the features they use in
Workspace, such as quick actions and configurable filters.

For example, from within the My Accounts Workspace infolet, salespeople can take notes, log calls, schedule
appointments, and even create opportunities for a specific account in the list. They can also create new accounts
directly from the infolet. Salespeople can personalize the information in each infolet and can specify their own filter
criteria and decide how they want the infolet information to display.

So that salespeople can start using Workspace infolets, you must set the Enable Workspace Infolets
(ZCA_ENABLE_ADAPTIVE_INFOLETS) profile option value to Yes. See the topic, Edit the Enable Workspace Infolets
Profile Option, for more information. In addition, it's also a prerequisite to have Workspace enabled. See the Adaptive
Search Setup section in the Adaptive Search and Workspace chapter in this guide for information about how to set up
Adaptive Search and Workspace.

You can enable the Sales Infolets page, if it's not enabled by default. Ensure that you have access to the job roles for
which you're enabling the page.

Oracle provides these predefined Workspace infolets:

• My Accounts

• My Appointments

• My Contacts

• My Leads

• My Opportunities

• My Tasks

After you switch to Workspace infolets, Oracle provides four additional Workspace infolet templates that you can extend
and configure based on your business requirements. For more information, see the topic, Set Up Additional Workspace
Infolets.

Edit the Enable Workspace Infolets Profile Option  
The Enable Workspace Infolets (ZCA_ENABLE_ADAPTIVE_INFOLETS) profile option specifies whether Workspace-
search-based actionable infolets or existing sales actionable infolets are available to salespeople from the sales
application pages.

The predefined value is No, which means that salespeople can only see the existing sales actionable infolets in the
Sales Infolets tab, available in the Analytics section on the News Feed home page. Oracle recommends that you use the
Workspace infolets instead, since they're based on the Adaptive Search and Workspace framework.
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Here's how to edit the Enable Workspace Infolets profile option to switch to the Workspace-search-based actionable
infolets.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name

ZCA_ENABLE_ADAPTIVE_INFOLETS in the Profile Option Code field.
3. Click Search.
4. In the list that's returned, click the profile option code link.
5. Select Yes in the Profile Value  field to switch to the Workspace infolets.
6. Click Save and Close.

Display Workspace Infolets  
You can specify which infolet tabs appear in the Analytics section and in which order. For example, the Sales Infolets
page displays key sales information in containers called infolets.

Some infolets provide you with an overview, but others make it possible for you to take direct action, such as actionable
infolets and Workspace infolets. These infolets summarize key sales data and let you take immediate action on the tasks
presented.

Oracle recommends you use Workspace infolets, which are based on the Adaptive Search and Workspace framework. In
addition, these Workspace infolets:

• Provide a set of predefined configuration templates that let users with the required access quickly create their
own custom infolets based on the Workspace user experience

• Enable salespeople to personalize which information to display on their own Workspace infolet pages, such as
including features they frequently use in Workspace

• Let you display different Workspace infolets for different job roles in the organizations

To start using Workspace infolets, you must set the Enable Workspace Infolets (ZCA_ENABLE_ADAPTIVE_INFOLETS)
profile option value to Yes. In addition, it's also a prerequisite to have Workspace enabled. See the Adaptive Search
Setup section in the Adaptive Search and Workspace chapter in this guide for information about how to set up Adaptive
Search and Workspace.

Oracle provides these predefined Workspace infolets:

• My Accounts

• My Appointments

• My Contacts

• My Leads

• My Opportunities

• My Tasks

The Sales Infolets page is enabled by default. Ensure that you have access to the job roles for which you're enabling the
page. For more information, see the Enable and Configure Workspace Infolets section of the Getting Started with Your
Sales Implementation guide.
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To understand how to configure the springboard and home page to fit your unique business needs, see the Oracle
Applications Cloud Configuring Applications Using Application Composer guide on Oracle Help Center.

Note:  Workspace infolets are secured through privileges. For more information, see the Securing CX Sales and Fusion
Service guide and the Security Reference for CX Sales and Fusion Service guide on Oracle Help Center.

Choose Which Workspace Infolets to Display
Here's how to select the predefined individual Workspace infolets.

1. With a sandbox open, click Home to return to the home page.
2. In the sandbox, select Page Composer from the Tools menu.

The Page Composer toolbar appears underneath the sandbox toolbar.
3. Scroll down to the Analytics section where the Workspace infolets are located.

The section displays the same infolet configuration that users with the selected job role see when they open the
home page. The section displays both Workspace infolets and Oracle Business Intelligence infolets.

4. If you don't see the Workspace infolet you're looking for, or want to hide some of the existing infolets on the
page, do this:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select or deselect the individual infolets to display or hide them.
c. You drag infolets around to change their order. Alternatively, click Infolet Repository, scroll down to the

bottom of the list, and select Reorder Infolets.
d. When you're done configuring the Workspace infolets, you need to click Close in the Page Composer

toolbar to save your changes.
e. Publish the sandbox by clicking its name and selecting Publish.
f. You can test your configuration by signing in as a user with the appropriate job role. Remember that

each user can personalize their own Workspace infolet views and that their personalization overrides the
default view you created.

You can also change the order of the infolets by dragging them around.
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Modify Workspace Infolets  
As an administrator, you can specify or remove existing predefined fields (attributes) or select additional user-defined
attributes to display on Workspace infolets for salespeople.

You can apply different setting for salespeople by role or at the site level. Salespeople can improve their sales
performance tasks by prioritizing tasks and using filters.

Before You Modify the Infolets
Before modifying the predefined Workspace infolets, do the following:

• Understand the typical workflows for working with runtime application changes.

• Ensure that you can modify the infolet by checking if the Edit Pages menu item is available in the Settings and
Actions menu available from the global header region. If the menu item isn't available, then you can't modify
the page.

Note:  Workspace infolets are secured through the "View Sales Homepage pagination dot one" and the "View
Sales Representative Dashboard" privileges. Ensure users have these two privileges. For more information,
see the Securing CX Sales and Fusion Service guide and the Security Reference for CX Sales and Fusion
Service guide on Oracle Help Center.

• Confirm that your privilege is sufficient to modify the page.

• Create or activate an existing sandbox.
When configuring Workspace infolets, make sure the sandbox has only the Page Composer tool selected. If you
want to make changes in a context layer other than the default Site layer, you must create a separate sandbox
and use only Page Composer in it. You can then change the context layer from Site to other layers. For example,
to create or edit infolets for a user with a specific job role, you must select the Job Role context layer.

CAUTION:  If you delete an infolet, you can't easily retrieve it. Contact your help desk if you accidentally delete one.

Edit the Infolets for Different Job Roles
Workspace infolets are available to predefined roles. However, you can set the availability of Workspace infolets so that
they become visible to other user-defined roles by editing the visibility settings for the infolet. For example, you can
create different Workspace infolet configurations for the whole enterprise, or for specific job roles. If you're configuring
different configurations of Workspace infolets for different job roles, then you must create separate sandboxes for each
job role.

For more information, see the topic, Create and Enter a Sandbox with Page Composer as Your Tool in the Enable and
Configure Workspace Infolets section in the Configure the Navigator and Home Page chapter of the Getting Started with
Your Sales Implementation guide.

Specify Which Workspace Infolet Attributes to Display
You can select and replace any of the predefined attributes shown on the Workspace infolets with alternate available
attributes of your choice.
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Note:  If you want to hide one of the predefined attributes, enter a blank value, in which case nothing is displayed in
the corresponding drop-down list position you select.

This table shows the attributes that you can modify and represents the order as they appear on the UI.

Workspace Infolet Attributes

My Accounts
 

• Name

• Primary Contact

• Primary Address

My Appointments
 

• Activity Time

• Subject

• Primary Address

My Contacts
 

• Name

• Primary Account

• Primary Phone Number

• Primary Email

My Leads
 

• Rank

• Lead Name

My Opportunities
 

• Sales Stage

• Name

• Close Date

• Amount

My Tasks
 

• Subject

• Activity Type

• Due Date

Here's how to modify the attributes of a Workspace infolet:

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.

2. From Settings and Actions in the global header region, select Edit Pages.
The Edit Pages window appears.

3. Select one of the following:
◦ Site to make your changes available to everyone.

◦ Job Role to target a specific job role you select from the list.
4. From the Workspace infolet that you want to modify, for example, My Accounts, select Configure from the

Actions menu.
5. In the Manage Infolet window, select the Layout tab (callout 1 in the screenshot).
6. Select the saved search you want to configure (callout 2).
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7. Add the fields you want to display (callout 3). Be sure to always display the Name field: it provides the link that
salespeople use to drill down into the record.

8. Set and adjust the two-column table widths in percentage terms by sliding your mouse along the Column Width
ruler.

9. Keep the Show quick actions option selected to display the actions for each record (callout 5).

10. Make the changes that you want to the attribute and select another attribute to edit, if required.

Tip:  A default attribute is used for drilling down to the detail page of the object. For example, for
Opportunity, the Name is the default value. If dynamic choice list fields are added to Workspace infolets, then
the drill-down capability is automatically enabled.

This table shows the field names and associated attribute names that you can select for drill-down for each of
the Workspace infolets:

Workspace Infolet Default Value Attribute

My Accounts
 

Name
 

Primary Contact
 
Primary Address
 

My Appointments
 

Subject
 

Primary Contact Address
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Workspace Infolet Default Value Attribute

My Contacts
 

Name
 

Primary Account
 

My Opportunities
 

Name
 

Amount
 
Close Date
 
Sales Stage
 

My Leads
 

Lead Name
 

Rank
 

My Tasks
 

Subject
 
Primary Contact
 

Type
 
Due Date
 

11. Click Save and Close when you have finished making the changes.
12. Verify your changes and publish the sandbox.

Specify Filters
Selecting available Workspace saved-search filters allows for a more dynamic, effective, and targeted view of the records
that salespeople want to update and take immediate action on. All of the Workspace saved searches associated with the
specified object appear as filters for your Workspace infolet. Filtering reduces the number of searches required to view
any outstanding items that might require attention. You can choose to select or hide predefined filters that you want to
make available on Workspace infolets.

You can select filters to include or not include, rearrange filters, and add custom filters. You can multiselect and double-
click filters in the Available list to move them to the Selected list. You must select at least one filter for the Workspace
infolet filter list.

To access a different set of data, create a new saved search in Workspace and then expose the relevant saved search in
the Workspace Infolets UI.

Note:  Predefined saved searches are available for selection. However, any custom saved searches that you create
must include Record Set values selected for either any records that you own or for records where you're on the team.
In addition, when saving your saved search, you must select the Run Automatically check box to run the search
automatically when your saved search is loaded.

This table shows the filters that you can select for each of the Workspace infolets.

Workspace Infolet Filter

My Accounts
 

• All Accounts

• My Accounts

• My List for Accounts
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Workspace Infolet Filter

• My Team Accounts

My Appointments
 

• My Appointments

My Contacts
 

• My Contacts

• My List for Contacts

My Leads
 

• My Open Leads

• My List for Leads

• My Team's Open Leads

• Open Leads Where I am on the Team

My Opportunities
 

• My Open Opportunities

• My List for Opportunities

• My Team's Opportunities

• Open Opportunities Where I am on the Team

My Tasks
 

• My Open Tasks

• My Overdue Tasks

• My Team's Tasks

Here's how to specify the filters on a Workspace infolet:

1. Ensure that you're working in an active sandbox.
2. Navigate to the Workspace infolet that you want to modify.
3. From the Workspace infolet that you want to specify, for example, My Opportunities, select Configure from the

Actions menu.

The My Opportunities Workspace infolet page is displayed with the predefined saved search filters selected.
4. From the Filters tab, select the filters that you want to display.
5. Click Save and Close when you have finished making the changes.
6. Verify your changes and publish the sandbox.

Set Up Additional Workspace Infolets  
Workspace infolets consist of six preconfigured infolets that display key sales information for accounts, contacts, leads,
opportunities, tasks, and appointments, and four blank infolets with the title Additional Actionable Infolet. After you
enable them, Workspace infolets replace the existing actionable infolets.

Select the Additional Workspace Infolets from the Infolet Repository
The Additional Actionable Infolet is one of four predefined blank infolets that you can use to create custom
Workspace-based infolets from scratch. For example, if some of your salespeople rely heavily on partners for their sales
activities, then you can configure the blank infolets to use Partner-based task flows and saved search filters. Similarly,
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service users might place the Service-based task flow as a higher priority item and their administrators can tailor one
of the additional actionable infolets specifically to their needs. These additional custom Workspace infolets can also be
used by sales users on the Analytics section of the home page or dashboard dot.

Here's how to select the additional Workspace infolet templates that you can configure to suit your business
requirements.

1. Scroll down to the Analytics section where the Workspace infolets are located.
2. Click Infolet Repository (the file icon on the top right side of the Analytics heading, highlighted in the

screenshot).

3. Select or deselect the individual additional infolets to display or hide them.
4. You drag infolets to change their order. Alternatively, click Infolet Repository, scroll down to the bottom of the

list, and select Reorder Infolets.

Configure Additional Workspace Infolets
After you select an additional actionable infolet, you configure and personalize it to suit your business needs. For
example, you can edit the title of your infolet, move, hide, or show specific Workspace infolets on your infolet page, and
refresh your record data. The smart actions match the smart actions available from the Workspace UI, and the quick
action denoted by the ellipsis icon opens an inline window where you perform your action without having to navigate
outside the infolet. You can also create a new record for your specific Workspace Infolet by clicking the Create icon (plus
sign) from the top right corner of the infolet.

Here's how to configure the filters of a Workspace infolet:

1. Ensure that you're working in an active sandbox.
2. Navigate to the Additional Actionable Infolet you want to include to your custom infolet template.
3. Select Configure from the Actions menu.

The Manage Infolet screen is displayed.
4. From the Filters tab, the predefined filters are listed in the Available section of the screen.
5. Select filters to include or not include, rearrange filters, and add custom filters.

You can multiselect and double-click filters in the Available list to move them to the Selected list. You need to
select at least one filter from the Workspace infolet filter list.

6. Click Save and Close when you have finished selecting your filters.
7. From the Layout tab, go to Saved Search drop-down list and select the filter you want.
8. Select the attributes that you want to edit from the respective filter you selected from the Saved Search drop-

down list.
9. Set and adjust the two-column table widths in percentage terms by sliding your mouse along the Column Width

ruler.
10. Select Show quick actions to display the quick actions that you can perform at the record level for this saved

search filter.
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11. Click the Actions icon on the top right corner of the actionable infolet, and select Edit Title and Views to edit
the infolet title.

12. Click Save and Close.
13. Verify your changes and publish the sandbox.

For more information, see the topic, Configure Workspace Infolets.

Manage Custom Actions for Workspace Infolets  
Workspace infolets quick actions match the configured smart actions already created in Workspace. You can manage
predefined Workspace actions, such as Create an Appointment, Create a Task, and Create an Opportunity, using the
Smart Actions administration tool in Application Composer.

Smart actions are actions that are specifically mapped to a client application, such as Workspace, and displayed to users
only when specific conditions are met. For example, you can also control which actions are available to Workspace for
display at runtime. Here are the high-level steps:

1. Create a sandbox and navigate to the Smart Actions administration tool in Application Composer, under
Common Setup.

2. Using the Actions search box, look for the action that you want to reorder, modify or add.
3. If you make changes to predefined actions, be sure to publish the sandbox, sign out of the application, and sign

back in.
4. Verify your changes in Workspace.

Related Topics
• Overview of Smart Actions
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13  Legacy Work Area Search

Work Area Search  

Overview of Work Area Search Setup  
The topics in this section help you maintain and optimize searches in work areas for individual objects and to create
saved searches for the sales organization.

Note:  The topics in this section apply only to work areas that use the legacy CRM search. If you're a new customer or
if you opt in to use the new work areas that are based on Workspace, you must set up Adaptive Search and the saved
searches for Workspace instead.

Enable Work Area Search
If you ran Setup Assistant as described in the Implementing Sales guide. If you didn't use Setup Assistant, or if you need
to index search objects at intervals that are different from the default intervals implemented by Oracle, then complete
the setup tasks outlined in the following table to enable the two searches.

Step Description Setup Where to Get More Information

1
 

Schedule the following processes
to run periodically:
 

• Synchronize CRM Search
Indexes

Oracle recommends that you
set this process, which builds
the search index, to run every
five minutes.

• Optimize CRM Search Indexes

This process prevents
index fragmentation and
degradation in search
performance. Oracle
recommends that you run this
process weekly.

You can schedule both process to
run at the recommended intervals
with the click of a button using
the Schedule Work Area Search
Process quick setup task for the
Sales Foundation functional area.
 
If you require different intervals,
 then you must separately
schedule these processes from the
Scheduled Processes work area.
 

See the topic: Schedule Work Area
Search Processes
 

2
 

Configure the saved searches
(lists) your sales organization
uses in the different work areas.
You can create saved searches
for your organization as a whole
or for select job roles and hide
those supplied by Oracle. You
can also specify which saved
search appears by default when a

In a sandbox with Page Composer,
 configure the saved search
configuration you need for each of
the work areas. You must publish
the sandbox to make the saved
search changes available to others.
 

See the topic Configure Work Area
Lists
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Step Description Setup Where to Get More Information

salesperson navigates to a specific
work area.
 
The saved searches you configure
for work areas are specific to the
individual work areas. They can't
be used in Workspace or as filters
in actionable infolets.
 

Related Topics
• Schedule Work Area Search Processes

Enable Alphabetic Sort in Work Area Lists  
You can enable automatic alphabetic sort of records displayed in legacy Account, Contact, and Household work area
lists by setting these system profile options to Yes. Because sort may affect application performance with large data
sets, it's disabled by default.

Note:  This topic applies only to work areas that use the legacy CRM search. If you're a new customer or if you opt in
to use the new work areas that are based on Workspace, you must set up Adaptive Search and the saved searches for
Workspace instead.

Profile Option Name Profile Option Code

Sort Account Name
 

ZCA_LM_ACCOUNT_SORT
 

Sort Contact Name
 

ZCA_LM_CONTACT_SORT
 

Sort Household Name
 

ZCA_LM_HOUSEHOLD_SORT
 

Setting the Profile Options
To enable automatic alphabetic sort of the lists in the Account, Contact, and Household work areas, set the system
profile option as follows:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for one of the profile options by name or by code.

The application displays the profile option information.
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3. In the Profile Values section, select Yes from the Profile Value list.
4. Click Save and Close.

Schedule Work Area Search Processes  
You must run two processes to enable work area searches for those work areas that use the legacy CRM search.

Note:  This topic applies only to work areas that use the legacy CRM search. If you're a new customer or if you opt in
to use the new work areas that are based on Workspace, you must set up Adaptive Search and the saved searches for
Workspace instead.

Process Name Description Recommended Interval

Synchronize CRM Search Indexes
 

Creates and maintains the search index.
 

Every five minutes
 

Optimize CRM Search Indexes
 

Optimizes the index. (The index can get
fragmented over time.)
 

Weekly
 

These two processes automatically run at the recommended intervals when you use either of the following

• Setup Assistant

Setup Assistant runs these processes without any prompting from you.

• Schedule Work Area Search Processes page

This Quick Setup page is available in the Sales offering, Sales Foundation functional area. You run both
processes by clicking Submit.

Here's how to run the processes at different intervals:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Schedule Process window, click Schedule New Process.
3. In the Schedule New Process window, make sure the Job option is selected.
4. Enter the name of one of the processes in the Name field and click OK.
5. On the Process Details window, click Advanced.
6. On the Schedule tab, select the Using a schedule option.
7. Select a frequency.
8. Enter an end date in the far future.
9. Click Submit.

Modify Work Area Search Behavior  
You can modify work area search behavior by setting the profile options listed in the following table.
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Note:  This topic applies only to work areas that use the legacy CRM search. If you're a new customer or if you opt in
to use the new work areas that are based on Workspace, you must set up Adaptive Search and the saved searches for
Workspace instead.

Profile Option Code Description Default Value

ZCA_MIN_SEARCH_CHARACTER
 

Sets the minimum number of characters
required for searching in the work area
searches. If your data volume is low, you can
decrease the minimum number of characters
required for search to one. If performance is an
issue, you can improve search performance by
increasing the minimum number of characters
required for search to three.
 

2
 

ZCA_MAX_NUMBER_OF_SUGGESTIONS_TO_
SHOW
 

Controls the number of suggestions that are
displayed in the autosuggest window in both
global search and work area search.
 

15
 

ZCA_LM_FIND_USE_STARTSWITH
 

Setting this profile to Yes, substitutes the Starts
With operator for searches in the work areas.
This setting requires users to enter the first
characters of the name of the object they're
searching for.
 
The default Contains operator makes it possible
to search for the keywords within the name,
 including at the beginning, middle, or end of
the name.
 
If you set this profile to Yes, then the application
ignores the setting of profile Include Similar
Results in Searches (ZCA_LM_FUZZY_SEARCH).
Results with similar spellings are never shown.
 

N
 

FND_PURGE_RECENT_ITEMS
 

The number of days a search remains available
as a suggestion in the recent items list. For
example, the default value of 60 days means
that when you start typing the name of an
object in a work area search, the recent items
list displays any matching items you searched
on within the last 60 days.
 

60
 

ZCA_MIN_CHARS_NEW_SUGGESTIONS
 

The minimum number of characters that must
be typed before recent items suggestions are
triggered.
 

3
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Set the Profile Options
To set the system profile options, do the following:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Search: Profile Option region, Profile Option Code field, enter the code.
3. Click Search.

The application displays the profile option information.
4. Make your changes.
5. Click Save and Close.

Change Record Set Values  
You can change the values that appear in the Record Set field list. Each record set value restricts a search to a subset of
records. If a value doesn't apply to your implementation, for example, then you can remove the value from the list by
entering an end-date. If you don't use sales teams or sales territories, then you can remove all of the values that restrict
the search by sales team or by territory.

Changing Record Set Lookup Values

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter %Record Set%.
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3. Click Search.

The page displays a list of the lookup types for search filter record sets for the different sales objects.
Here's a screenshot of the Manage Standard Lookups page showing some of the search results.

4. Select the lookup type you want to change in the search results.
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5. You can edit the values in the Lookup Codes region. You must scroll down.

Here's a screenshot of the Lookup Codes region of the Manage Standard Lookups page for the Lead Search
Filter Record Sets lookup type.

You can perform one or more of the following edits, depending on the lookup type:

◦ Change the wording the user sees in the list by editing the Meaning field.

Changing the meaning doesn't affect application functionality.

◦ Remove a value from use by entering an end date.

◦ Change the display sequence.

6. Click Save and Close.

Disable Rolling-Time Operators for Searches  
You can use rolling-time operators, such as today, this week, and this month, as filters in work area searches. Searching
for all the opportunities created this month, for example, returns all of the opportunities created in the current calendar
month. The rolling-time operators use the time zone of the signed-in user for the calculation. You can disable any of the
operators by editing the lookup type ORA_ZCA_ROLLING_TIME (Rolling Time Values for Work Area Searches).

The predefined rolling-time operators include:

• Yesterday

• Today

• Tomorrow

• Last Week

• This Week

• Next Week

• Last Month

• This Month
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• Next Month

Use the following steps to disable any of the values:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Lookup Type field, enter ORA_ZCA_ROLLING_TIME.
3. Click Search.
4. You can disable any of the rolling-time values, by enter an end date or deselecting the Enabled option.
5. Save your changes.

Disable the Display of Search Results with Similar Spellings  
By default the application displays records with similar spellings in the different work area search results. For example,
if you are searching for accounts using the word software, then the application first displays the account names that
contain that word, such as Compucon Software and Forte Software Inc, followed by names with similar spellings, such
as Softgear Inc. You can disable the display of results with similar spellings in work area searches by setting the system
profile option Include Similar Results in Searches to No.

Note:  The application displays similar spellings in search results only if you are using the default contains search
operator. If you set the system profile option Use Starts With Operator (ZCA_LM_FIND_USE_STARTSWITH) to Yes,
then similar spellings are never shown in search results regardless of the setting of the system profile option Include
Similar Results in Searches.

To disable the display of similar spellings in search results, do the following:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Search: Profile Option region, Profile Display Name field, enter Include Similar Results in Searches.
3. Click Search.

The application displays the profile option information.
4. In the ZCA_LM_FUZZY_SEARCH: Profile Values section, select No from the Profile Value list.
5. Click Save and Close.
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Enable Additional Search Operators for Text and List Field
Searches  
You can enable additional operators (Is Blank, Is Not Blank, and Does Not Equal) for searches in text fields and fields
validated by lists of values. For example, selecting the Is Blank operator, makes it possible for salespeople to search for
records missing values.

These operators aren't available by default because their use can affect search performance. You can make these
operators available on mandatory standard and custom fields, by setting one or both of the following two system profile
options to Yes:

• Enable Additional Search Operators for Text Fields (ZCA_ENABLE_ADDITIONAL_TEXT_OPERATORS) enables
the Is Blank and Is Not Blank operators in text field searches.

• Enable Additional Search Operators for List of Values (ZCA_ENABLE_ADDITIONAL_LOV_OPERATORS) enables
the Is Blank, Is Not Blank, and Does Not Equal operators in fields validated by lists of values (both fixed choice
and dynamic choice list fields).

Here's how to display the additional operators:

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Search: Profile Option region, Profile Display Name field, enter Enable Additional Search Operators%.
3. Click Search.

The application displays information for the two system profile options.
4. Select the name of the system profile option you want to enable.
5. In the Profile Values section, select Yes from the Profile Value list.
6. Click Save and Close.

Configure Work Area Lists  
Here are some procedures you can use to configure work area lists, also called saved searches for those work areas that
use the legacy CRM search. You can create lists to replace those supplied by Oracle and you can make your lists available
to all users or target users with specific job roles. You can also specify which list appears by default when salespeople
open a work area.

Note:  This topic applies only to work areas that use the legacy CRM search. If you're a new customer or if you opt in
to use the new work areas that are based on Workspace, you must set up Adaptive Search and the saved searches for
Workspace instead.

Note:  If you're creating lists for a specific job role, then you must first provision yourself with that job role so you
can test your work before publishing the sandbox. See the steps outlined in the related topic Assigning Yourself an
Additional Job Role.
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Here's an overview of the steps to configure work area lists:

1. Get ready by entering a sandbox with Page Composer.
2. Navigate to the work area landing page you want to configure and open Page Composer.
3. Make your modifications:

◦ Create your own list.

◦ Hide lists provided by Oracle.

◦ Delete any of the lists you created.

◦ Make a different list appear by default when salespeople open the work area.

4. Publish the sandbox to make your changes available to users.

Get Ready to Configure Work Area Lists

1. Create and enter a sandbox with Page Composer as the tool. Other tools don't allow you to make changes at the
job-role level, so creating a separate sandbox is a good idea if you're configuring lists for a specific job role.

a. Navigate to Configuration > Sandboxes.
b. Click Create Sandbox.
c. In the Create Sandbox page, enter a name and select Page Composer as the tool.
d. If you're making changes for a specific job role, then specify the job role for Page Composer:

i. Click Edit in the Support Context column for Page Composer.
ii. In the Edit Sandbox Context window, select the job role.

iii. Click OK.
e. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
2. Navigate to the work area you want to modify.
3. Open Page Composer by selecting the tool from the Tools menu in the sandbox bar at the top of the page.

Create a List
With both the sandbox and the Page Composer toolbar displayed on the top of the page, create your list. You create a
new list by editing an existing list and saving it under a new name.

1. In the work area landing pad, click Show Advanced Search next to the List field.
2. From the Advanced Search panel Saved Search list, select a saved search to use as the starting point for

creating a new one.

Tip:  To create a list using only one field, including custom fields, select a search with either Name or Close
Date in the title. For opportunities and leads, select the Close Date saved search. For all other objects, select
the name saved search, for example, the Account Name saved search or the Contact Name saved search.

3. Make your changes. You can:

◦ Select a different record set to change the scope of your search. For example, selecting My territory
hierarchy searches all the records in your territories and their subordinate territories. The available
record sets vary from object to object.

To improve saved search performance, restrict your saved searches to smaller record sets. For example,
rather than searching all the records you can see, search all the records in your territory hierarchy. Or
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restrict your searches to a smaller geographical area. For example, search all the accounts in one state
instead of the whole country.

◦ Add additional fields by clicking Add.

Note:  If you're adding a custom field to your search, then the field must be indexed for best search
performance.

◦ Select operators for the fields in your search. While most of the operators, which differ field by field, are
self-explanatory, here are some notes on the more complex:

- Between
Selecting the Between operator for a date field, prompts you to enter a specific date range for the
search.

- Rolling-time operators, including Yesterday, Today, Tomorrow, Last Week, This Week, Next
Week, Last Month, This Month, and Next Month
Searching for opportunities created this month, for example, returns opportunities created in the
current calendar month. The rolling-time filters use the time zone of the signed-in user for the
calculation.

- Current User
In some fields, including the Last Updated By and Created By fields, you can create a list that
displays only the records relevant to each signed-in user. For example, when you create a list of all
opportunities last updated by the current user, all of your users can view the opportunities they
recently updated.

- Is Blank, Is Not Blank, and Does Not Equal
Selecting the Is Blank operator, makes it possible to search for records missing values in a text
field or a field validated by a list of values, for example. Administrators can make these operators
available on fields that are not mandatory, by setting two system profile options. The Enable
Additional Search Operators for Text Fields (ZCA_ENABLE_ADDITIONAL_TEXT_OPERATORS)
profile option enables the Is Blank and Is Not Blank operators in text field searches. The Enable
Additional Search Operators for List of Values (ZCA_ENABLE_ADDITIONAL_LOV_OPERATORS)
enables the Is Blank, Is Not Blank, and Does Not Equal operators on fields validated by list of values
(both fixed choice and dynamic choice list fields).

◦ Specify which attributes you want to display in the search results table by selecting Columns from the
View menu.
You can select specific columns or display all columns.

◦ Reorder the filter conditions by clicking Reorder.

◦ Delete any fields you added to the search.
You can't delete the fields provided by Oracle. You can only delete fields you added.

4. You can test your search by clicking Search.
5. When you're satisfied with the results, click Save.
6. In the Create Saved Search window, enter a new name for the saved search.

You can't reuse the names of the saved searches provided by Oracle with the application.
7. Make sure the Run Automatically option remains selected. Selecting this option runs the query each time you

select the list in the UI.
8. If you want users to see the list generated by this search when they navigate to the work area, then select the

Set as Default  option.
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Note:  Making a search the default doesn't override any default searches individual users may have created
for their own use. Each user can personalize lists provided by administrators.

9. Click OK to return to the work area landing page.

Hide a Saved Search Provided by Oracle
You can't delete a search provided by Oracle, but you can hide it. Here's how. If you want to hide a saved search that's
designated as the default search, then you must first designate a different list as the default.

1. In the work area list page, click Show Advanced Search next to the List field.
2. From the Advanced Search panel Saved Search list, select a saved search that's different from the one you

want to hide.
3. Now select Personalize.
4. In the Personalized Saved Searches window, select the saved search you want to hide.
5. Deselect the Show in Search List option.
6. Click OK.

A saved search supplied by Oracle remains available for future use but doesn't display in the work area. You can
restore the saved search to the list in the future by selecting the Show in Search List option.

Delete a Saved Search You Created
You can delete searches that you or other administrators created.

Note:  If you delete a saved search specified as the default, then no list displays when users navigate to the work area.

1. In the work area landing pad, click Show Advanced Search next to the List field.
2. In the Advanced Search panel Saved Search list, select a saved search you want to delete.
3. Now select Personalize.

The Personalize Saved Searches window Saved Searches list displays the name of the saved search you're
about to delete.

4. Click Delete.
5. Click OK.

Save Your Work and Publish the Sandbox

1. When you're done making your changes, you must save them by clicking Close in the Page Composer toolbar.
2. Publish the sandbox by clicking the sandbox name and selecting Publish.

Related Topics
• Overview of Sandboxes

• Publish Sandboxes

• Create and Activate Sandboxes

• What gets saved when I create a saved search for searches with multiple criteria?

• Assign Yourself Additional Job Roles Required for Testing
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Search in Subtabs  

Configure Default Search in Subtabs  
You can specify what information displays by default in all of the standard application subtabs with the exception of
Service Requests and Installed Base Assets tabs. When salespeople open a subtab, they see a list of records based on
the default search criteria that you set.

For example, when salespeople open the Opportunity subtab on an account, they see a list of all open opportunities
they have the permission to view. As an administrator, you can change the default search criteria that generate the list.
For opportunities, you can add Sales Stage as a filter, to narrow down the list, for example. Here's a screenshot of the
Opportunity subtab with the additional Sales Stage filter.

Salespeople can change the default search value, but they can't change the default search field. However, they can
refine their search by adding additional search fields and values at runtime. Adding a default search filter to a subtab
is optional. If you skip this step, then search fields aren't automatically added to the subtab, but users can still see the
search region and perform their desired search.

For tabs that are common to objects such as contacts, set the default search criteria or operator for only one object. The
criteria is set for all the objects where that tab is displayed. If you decide to set different criteria for the same subtab on
different objects, then the last saved change is reflected at runtime. In other words, it's not possible to have different
search criteria for a subtab that's shared across objects.
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Note:  You can select only one default search filter for each subtab. When adding a default search filter to standard
subtabs, the search filter applies to all existing details page layouts with this subtab. Let's say you add a search filter
to the Lead subtab on an Opportunity details page layout. This means that the same search filter is added to the Lead
subtab on an Account details page layout.

The procedure to add a default search filter field, operator, and value is the same for all objects such as, accounts, leads,
and opportunities. Here's an example procedure for the Contacts subtab search on the Edit Lead page.

1. Ensure you're in an active sandbox
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
4. Ensure that the Application Pages tab is selected.
5. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
6. Type a new layout name and click Save and Edit.

The Details Layout page appears.
7. In the Subtabs Region, highlight Contacts and click the pencil icon.
8. From the Configure Detail Form page region, go to the Configure Summary Table: Search Region.
9. Select the default search filter to apply to the Contacts subtab.

You can select from a list of both standard and custom Contact fields. Note that you can't pick dynamic choice
list fields, set ID-based fixed choice list fields, and any fields that aren't searchable. Also, if the subtab was
added based on a many-to-many (M:M) relationship, then you can select from only those intersection object
fields that are already displayed on the subtab.
For example, you want to create a search filter to search for all contacts that have a job title of sales manager.
Select Job Title from the drop-down list and select Equals as the operator and enter Sales Manager.

10. Click Done and ensure that the layout status for your Contacts subtab layout is set to Active.
11. Test the changes: Navigate to Sales > Leads as a user with access to the leads pages. Edit a lead and confirm

that the data that displays on the Contacts subtab includes only contacts with a job title of sales manager.
12. Publish the sandbox.

Overview of Configuring Resource Search  
You can configure resource search according to your business needs. You can:

• Create dynamic, role-based picker layouts

• Show or hide standard fields for search

• Show or hide results sections

• Re-arrange fields in the search and result sections

• Define default values for search fields

• Mark certain fields as required or read-only

Salespeople can use the resource search tools you have configured to search and associate other resources with the
relevant business objects. Salespeople can search using the custom fields and view custom fields in the search results,
allowing them to find and select the right resource records.

You can also configure custom dynamic choice lists for the Resource object that are similar to the predefined search
tools.
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Note:  Prior to Oracle Cloud Applications Release 13, Update 18C, different styles of resource search tools existed
across different sales object flows. From Update 18C, there is a single, unified search tool for the Resource object,
which you can configure, although specific capabilities might differ. For example, auto-suggest isn't supported in
resource search criteria for the organization field.

For procedures detailing how to extend the search, see the Configuring Applications Using Application Composer guide.

Configure Resource Search  
You can configure resource search, enabling users to search and associate a resource as an owner or a team member to
a business object, such as account, contact and opportunity.

Setting up the resource search involves:

• Creating a dynamic page layout for the resource object

• Configuring the resource picker

Creating a Dynamic Page Layout for the Resource Object
To create a dynamic page layout for the resource object:

1. Ensure that you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under the Objects navigation tree, expand the tree structure for the Resource object.
4. Click the Pages node.
5. Select the Application Pages tab.
6. In the Search and Select Dialog Layouts region, create a custom layout.
7. Click the link for the custom layout name you created and set up the fields.

◦ To set up the fields in the search region:

i. Click the edit icon next to Search Region.
ii. In the Configure Search Region area, select the fields that should appear in the search region.

Optionally, you can set the default operator for the fields in the search region and set the fields as
required.

iii. Click Save and Close.

◦ To set up the fields in the search results:

i. Click the edit icon next to Search Results.
ii. In the Configure Detail Form area, select the fields that should appear in the search results.

iii. Click Save and Close.

◦ Test the changes and publish the sandbox according to your company's business practices.

Configuring the Resource Picker
To configure the resource picker:

1. Ensure that you're working in an active sandbox.
2. Navigate to Application Composer.
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3. Under the Objects navigation tree, expand the tree structure for the required object, such as Account.
4. Click the Pages node.
5. Select the Application Pages tab.
6. In the Details Page Layouts region, navigate to the link for your custom layout if it already exists, otherwise

create a new custom layout.
7. Click the link for the custom layout name.
8. In the Subtabs Region, click the required subtab, such as Profile, and click the edit icon next to Summary.
9. In the Configure Detail Form region, click the edit icon next to the Owner field or any custom dynamic choice

list field you have added.
10. Based on your requirements, you can set the default value for the fields. You can also set the fields as read-only.
11. Click OK.
12. Click Save and Close.
13. Test the changes and publish the sandbox according to your company's business practices.
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14  Work Assignment

Overview of Assignment Processing Components  
You can use assignment processes to assign resources (for example, salespeople or territory owners) to the business
objects they work on, such as an opportunity or a lead. Once assigned, resources and territory owners, along with their
managers, have visibility into the business object.

Candidate and Work Objects
When setting up assignment, you should be familiar with two types of assignment objects: candidate objects and work
objects:

• Work objects are the business objects that get assigned, for example, accounts, opportunities, leads, partners,
and deals.

• Candidate objects are the possible pool of assignment candidates, for example resources or territories.

Territory-Based Assignment
After you set up your territories, territory-based assignment matches territory dimensions and attributes to work
objects. You can set up territory-based assignment to be completely automated, to happen on-demand, or you can
use a combination of these settings. Territory-based assignment requires that you set up your territories and resource
hierarchy, set profile options to configure assignment, and run assignment processes.

For an introduction to setting up territory-based assignment, start with the topic, Overview of Sales Territory and
Assignment Setup.

Rule-Based Assignment
Rule-based assignment lets you set up additional rules used to assign resources to work objects. Rule-based
assignment lets you capture attributes not defined in territory-based assignment. Once you set up the rules containing
conditions that records must meet, then resources get assigned to the object when they match the rule conditions.

For example, you can use rules to:

• Assign a certain salesperson to the sales team when the customer is located in specific state or region.

• Assign the accelerated leads expert to leads whose time frame is less than three months.

• Calculate lead rank based on lead score.

Rule-based assignment requires that you plan your rules, create the rules using the rules UI, and set profile options to
configure assignment, in addition to any scheduled processes that must be run.

Assignment Profile Options
Each of the business objects available in assignment has its own set of profile options that allow you to further
configure assignment.
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Scheduled Processes
Scheduled processes are batch jobs that capture data and allow business objects to act on that data. You must schedule
several processes when using assignment.

Assignment Reports
You can use the Diagnostic Dashboard to generate reports about assigned objects and the volume of territory data
involved in assignment.

Assignment Resources
Read more about assignment:

• Considerations for Configuring Assignment

• Implementing Sales guide for more discussion of assignment in sales.

• Assignment Resource Center: For additional assignment articles, see the Assignment Manager Resource Center
(1522958.1) on My Oracle Support.

Implementation Concepts for Assignment  

Considerations for Configuring Assignment  
Assignment is the process of selecting a candidate object and executing the association with a work object. Assignment
consists of three phases:

• Setup phase: Setting up assignment processing through assignment configuration

• Matching phase: Matching rules or mappings are evaluated to find the right assignees from a list of possible
candidates

• Assignment phase: The assignment of matching candidates is handled

An assignment configuration is predefined for each sales application providing assignment processing. This
assignment configuration is available from one of these setup tasks:

• Manage Customer Center Assignment Objects

• Manage Sales Assignment Manager Objects

• Manage Sales Lead Assignment Objects

You can use these setup tasks to add or remove assignment attributes, define the relationship between each work
object and candidate object, and define mapping sets and mappings that drive territory-based assignment and rule
categories that drive rule-based assignment.

Note:  Use the Manage Sales Assignment Manager Objects task for opportunity assignment.

The predefined assignment configuration also includes the mapping sets and mappings that drive territory-based
assignment.
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To best plan the configuration, consider these points.

• Assignment objects

• Attributes

• Related candidates

• Mappings sets and mappings

• Rule categories, rule sets, and rules

Assignment Objects
An assignment object is a data entity or a collection of data treated as a unit, such as a sales account, an opportunity,
or a lead. During assignment configuration, carefully consider which of your business objects require assignment, and
create work objects only for those.

A set of assignment objects is predefined for the assignment of territories or resources to accounts, partners,
opportunities, leads, and deals.

Attributes
You use attributes to further define assignment processing. For example, you might want to assign a sales
representative (resource) to an opportunity (assignment object), based on the risk level of the opportunity. In this case,
you select the attribute of the opportunity work object that corresponds to risk level, and the attribute of the resource
candidate object that corresponds to name or email. Selecting these attributes makes them available for mappings and
for conditions on your rules. Therefore, ensure that you select the attributes that reflect the criteria that you want to use
for matching candidate objects to work objects.

Several attributes are predefined as assignment attributes for each assignment object.

Related Candidates
Candidate objects are related to work objects, and, for each relationship, the appropriate assignment mode (such as
matching and scoring) and processing options are predefined. You must not modify these predefined settings except
for the No Matches Handling option for the Sales Lead work object. The No Match Handling option controls the
assignment action when no matching candidate is found. By default, this is set to Remove current assignment. You
can change this to Retain current assignment, which retains the current candidate assignment when no matching
candidate is found. You can also change it to Error, which generates an error if no matching candidate is found.

Mappings Sets and Mappings
Assignment mapping sets and their related mappings drive territory-based assignment. The mapping sets determine
which mappings are used, and the sequence mapping sets are used in territory-based assignment. The mappings
identify the dimensions, attributes, and territory filtering used in the assignment processing.

Default mapping sets and their related mappings are predefined.

Rule Categories, Rule Sets, and Rules
The application provides default rule categories. These rule categories identify the type of rule processing being
performed, such as matching, scoring, classification, or territory. Rule sets group the assignment rules and determine
the additional processing performed, such as using scores for each candidate and filtering the candidates assigned to
top or random matches. Rules are defined to execute rule-based assignment. Rules are designed to return candidates if
they match a set of criteria, are within a defined scoring range, or are of a specific classification.
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Create rules using work objects, candidate objects, and attributes that you already established. When designing your
rules, carefully consider how you want to match candidates to work objects. For example:

• Do you want resources assigned based on their geographic location, their product knowledge, on the status or
score of an object, or a combination of any of these attributes?

• Do you want to match candidates only, or do you want to match candidates and score them?

• In a multiple-candidate scenario, do you want to assign all matching candidates or only those who achieve
higher than a specific score?

Related Topics
• Examples of Creating Assignment Rules

• Assignment Rule Components

Assignment Objects and Rules Setup Data Migration  
This topic explains exporting and importing assignment objects and rules setup data, along with the points to consider
while moving the setup data.

Almost all application implementations require moving functional setup data from one instance into another at various
points in the lifecycle of the applications. For example, a typical case in any enterprise application implementation is to
first implement in a development or test application instance and then deploy to a production application instance after
thorough testing. You can move functional setup configurations for assignment objects or assignment rules from one
application instance into another by exporting and importing configuration packages from the Manage Configuration
Packages page.

To export and import assignment setup data, you should start by defining an implementation project for the required
assignment setup task:

• Manage Customer Center Assignment Objects

• Manage Object Sharing Assignment Objects

• Manage Object Sharing Rules

• Manage Sales Assignment Manager Objects

• Manage Sales Assignment Manager Rules

• Manage Sales Lead Assignment Objects

• Manage Sales Lead Assignment Rules

• Manage Service Assignment Objects

• Manage Service Assignment Rules

The Manage Configuration Packages setup task exports the assignment objects or rules setup data.

A configuration package contains the setup import and export definition. The setup import and export definition
is the list of setup tasks and their associated business objects that identifies the setup data for export as well as the
data itself. You generate the setup export and import definition by selecting an implementation project and creating a
configuration package. The tasks and their associated business objects in the selected implementation project define
the setup export and import definition for the configuration package. In addition, the sequence of the tasks in the
implementation project determines the export and import sequence.
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You can export a configuration package once you create it, or at any time in the future. During export, appropriate setup
data will be identified based on the setup export definition and added to the configuration package. The setup data in
the configuration package is a snapshot of the data in the source application instance at the time of export. Therefore
you must publish the assignment objects and rules before export. After the export completes, you can download the
configuration package as a compressed archive of multiple XML files, move it to the target application instance, and
upload and import it. You must review and publish the assignment objects and rules setup data in the target application
instance to make them available for assignment processing.

See the chapter about importing and exporting setup data in the Using Functional Setup Manager guide for more
details.

Considerations for Exporting and Importing Setup Data
Based on your implementation, you might have to follow different approaches while exporting and importing
assignment setup data.

Consider these points:

• If your implementation is using territory-based assignment only, then the implementation project must only
include the Assignment Objects setup tasks.

• If your implementation is using territory-based assignment with rule filtering or rule-based assignment, the
implementation project should include both the Assignment Objects and Assignment Rules setup tasks.

• If you aren't sure whether your implementation is using territory or rule-based assignment, then Oracle
recommends that you include both Assignment Objects and Assignment Rules setup tasks in the
implementation project.

• The sequence of the tasks and business objects should remain per the default sequence.

You can delete assignment objects, assignment attributes, rule categories, rule sets, rules and conditions in a test
environment. If the setup data subsequently is exported and then imported into another environment, for example a
production environment, then the data in the target database isn't removed.

If your implementation plans to import and export setup data for assignment objects and assignment rules, you must
ensure not to delete assignment objects, rule categories, rule sets, and rules. You must set them to inactive in case you
want to delete them. Additionally, you must not delete assignment rule conditions. Instead, you must set the rule to
inactive and then recreate the rule excluding the condition that's no longer needed.

Related Topics
• Overview of Setup Data Export and Import

Example of Uploading Assignment Objects and Rules Setup Data
to a CSV File  
This topic explains exporting and importing assignment objects and rules setup data to a CSV file, along with the points
to consider while moving the setup data.

When you enter or update a large volume of setup data for a task, using user interfaces to individually enter or update
them may not be the most efficient method. In such cases, you can upload setup data in bulk by using export and
import processes at the task level. This method requires that your setup data is available in a CSV file format.
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To export and import assignment object and rules setup data, you should start by defining an implementation project
for the required assignment setup task:

• Manage Customer Center Assignment Objects

• Manage Object Sharing Assignment Objects

• Manage Object Sharing Rules

Note:  Access Groups and Access Group Members must exist in the target environment before you export
and import for this setup task.

• Manage Sales Assignment Manager Objects

• Manage Sales Assignment Manager Rules

• Manage Sales Lead Assignment Objects

• Manage Sales Lead Assignment Rules

• Manage Service Assignment Objects

• Manage Service Assignment Rules

Note:  You need the following privileges to export and import assignment objects and rules setup data:
• Submit Export Setup Data Process (ASM_SUBMIT_EXPORT_SETUP_DATA_PROCESS_PRIV)

• Submit Import Setup Data Process (ASM_SUBMIT_IMPORT_SETUP_DATA_PROCESS_PRIV)

• Task-specific privileges

Refer to the Oracle Applications Cloud Security Reference for Common Features guide for detailed information about
task-specific privileges.

Export and Import Setup Data Considerations
Based on your implementation, you might have to follow different approaches while exporting and importing
assignment setup data.

Consider the following points:

• If your implementation is using territory-based assignment only, then the implementation project must only
include the Assignment Objects setup tasks.

• If your implementation is using territory-based assignment with rule filtering or rule-based assignment, the
implementation project should include both the Assignment Objects and Assignment Rules setup tasks.

• If you aren't sure whether your implementation is using territory or rule-based assignment, then Oracle
recommends that you include both Assignment Objects and Assignment Rules setup tasks in the
implementation project.

• Access Groups and Access Group Members must exist in the target environment before you export and import
using the Manage Object Sharing Rules setup task.

• The sequence of the tasks and business objects should remain per the default sequence.

392



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

The application lets you delete assignment objects, assignment attributes, rule categories, rule sets, rules and
conditions in an environment, for example test. If that setup data subsequently is exported and then imported into
another environment, for example production, the data in the target database isn't removed.

If your implementation plans to import and export setup data for assignment objects and assignment rules, you must
not delete assignment objects, rule categories, rule sets, and rules. You must set them to inactive in case you want to
delete them. Additionally, you must not delete assignment rule conditions. Instead, you must set the rule to inactive and
then recreate the rule excluding the condition that's no longer needed.

Export Assignment Objects and Rules Setup Data to a CSV File
To export assignment objects and rules setup data to CSV file, follow these steps:

1. Select Navigator  > My Enterprise  > Setup and Maintenance and go to setup pages that you want. For
example, to export Manage Sales Assignment Manager Objects, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Objects
2. From the Actions menu, select Export to CSV file. This option is disabled if the task doesn't support export.
3. Select Create New. You can export all existing setup data represented by the Manage Sales Assignment

Manager Objects task.

◦ If Scope is supported for the task, you can select appropriate scope values to filter the setup data you
want to export.

◦ You can also download the template without exporting the existing setup data in the environment. To do
so, select the Export only template files check box.

4. Click Submit to start the export process.
5. Select Export to CSV file to see the latest process. Monitor the process until it completes.
6. Select the process once it completes to review the results. Verify that the process completed without any errors

before you download and extract the CSV file.
7. You may find more than one CSV file if there are more than one business object associated with the task.

Prepare Assignment Objects and Rules Setup Data in a CSV File
To enter or modify the assignment objects and rules setup data in the CSV file, follow these steps:

1. Open Microsoft Excel and click the Data tab.
2. In the Get External Data group, click From Text.
3. Navigate to and select the CSV file you downloaded.
4. Select Delimited as Data Type and click Next.
5. Select Comma as delimiter and click Next.
6. Select Text as column data format for all columns and click Finish. You can now edit the file.
7. Make the necessary changes and save the CSV into a .zip file. The file is ready for import.

Note:  The CSV file size must not exceed 10MB.

Import Assignments Objects and Rules Setup Data in a CSV File
To upload the new or modified assignment objects and rules setup data, follow these steps:

1. Select the appropriate task from the Tasks region. For example, to import Manage Sales Assignment Manager
Objects, go to the following:
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◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Objects

2. Select Import from CSV file from the Actions menu.
3. Select Create New.
4. Select the appropriate .zip file that you created. See the Preparing Assignment Objects and Rules Setup Data in

a CSV File section. The application validates that the file corresponds to the selected task before you can submit
the process.

5. Click Submit.
6. Select Import from CSV file to see the latest processes. Monitor the process until it completes.
7. Select the process once it completes to review the results. If any errors occur, review the details listed in Status

Details in the Business Objects section. Fix the issues and import again, if necessary.
8. After you import the assignment manager objects setup data successfully, you can verify the loaded data by

selecting the Manage Sales Assignment Manager Objects task from the Setup page.

See the chapter about importing and exporting setup data in the Using Functional Setup Manager guide for more
details.

Related Topics
• Set Up an Offering with Scope

• Export and Import CSV File Packages

Assignment Mappings  

Assignment Mapping Set Components  
Assignment mapping sets and their underlying mappings drive territory-based assignment. This topic explains how
these components work together in assignment processing.

This figure shows an example of the sales application work objects that have associated default mapping sets and
mappings. Mapping sets and mappings drive territory-based assignment, and the work object attributes map to the
territory candidate object dimensions and attributes.
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Mappings
The mappings identify the dimensions, attributes, and territory filtering used in the assignment process. Default
mapping sets and their related mappings are predefined for account, lead, partner account, deal, and opportunity
revenue assignment. The predefined mapping example assumes that opportunities, leads, sales, partners, accounts,
and deals use the same territory hierarchy.

Each predefined mapping set has between 9 and 16 mappings that determine the information about the object, such as
the account industry or the sales lead product, and how each is mapped to a dimension or attribute on the territory.

You can create additional mappings using the work objects, candidate objects, and attributes that you already
established.

Mapping Sets
Mapping sets enable the grouping of mappings so that you can create more than one mapping for each combination of
work object and candidate object. The mapping set concept is used only with territory-based assignment and territory-
based assignment with rule filtering. Mappings sets are predefined for accounts, leads, opportunities, partner accounts,
and deals. When managing assignment objects, the user can define additional mapping sets, each of which contains
multiple mappings, for each combination or work object and candidate object.

Mapping Types
There are three types of assignment mapping:

Dimension Mapping: Dimension mappings must be used when the work object and candidate object attributes in
the comparison are dimension attributes, such as Product. When creating the mapping, use the Function Code field
to specify a unique identifier for the dimension. Generally attribute mappings are used when the work object and
candidate object attributes in the comparison are non-dimensional attributes.

Note:  The Geography dimension is obsolete. Use the Address dimension for geographical territories. Documentation
is being updated to reflect this change.
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When creating the mapping, the Function Service and Function Code are only needed if a translations function is
used. The function code field is used to specify a unique identifier for the attribute, and this identifier is passed to the
translation function.

An example is assigning territories to opportunity revenue lines based on the product associated with the revenue
line. In this case, dimension is selected as the mapping type. The candidate object low attribute and high attribute
correspond to the names of the low sequence and high sequence attributes for product on the territory. The work object
low attribute and high attribute correspond to the names of the low sequence and high sequence attributes for product
on the revenue line.

Attribute Mapping: This mapping enables you to compare and match attribute values between a work object attribute
and a candidate object attribute. When the value of the candidate object attribute matches the work object attribute,
the candidate is selected. Attribute mappings are typically used when the work object and candidate object attributes
in the comparison are non-dimensional attributes. This type of mapping is also used to capture the mapping between
hierarchical dimensions account and geography.

For example, consider a lead work object with a Partner Identifier attribute and the territory object with Partner ID
attribute. The selection criterion is: select Sales Lead Territories where Sales Lead Territory.Partner Identifier
equals Sales Lead.Lead Partner Identifier. The assignment manager uses this mapping data to construct a query on
the candidate object that's equivalent to the selection criteria.

Literal Mapping: Literal Mapping is used almost exclusively to filter the candidate objects. This form of mapping
enables the comparison of candidate attributes against a specific value chosen by the user. The assignment manager
compares the mapped candidate object attribute against the specified literal value. For example, select the Territory
Candidate object that has the attribute Coverage Model that equals the value PARTNER_CENTRIC.

Note:  For Literal Mappings, ensure that the value entered corresponds to the Lookup Type Value code. Don't enter
the meaning of the lookup.

Assignment Processing Using Mapping Sets and Mappings
When designing your mappings, carefully consider the dimensions and attributes you use in your territory structure
and how you want to match these territory candidates to work objects. Also consider the shape of the information used
in the territory structure; this may affect the sequence of each mapping. A sequence can be entered for each mapping
set which is used to determine the order in which these mapping sets will be used in the territory-based assignment
processing. The sequence of the dimension mappings used in territory matching can affect performance. The most
selective mapping should be given the lowest sequence number. By using the lowest sequence number, it's performed
earliest in the matching process, which results in the smallest number of territory matches. Mappings that don't have a
sequence are used together at the end of the matching process.

Note:  The Geography dimension is obsolete. Use the Address dimension for geographical territories. Documentation
is being updated to reflect this change.

Sometimes the mapping set sequence doesn't matter. For example, there are two predefined opportunity revenue
assignment mapping sets. When the first mapping set is used, it finds matching territories based on the information
about the opportunity/opportunity account, and the territory information. Then the second mapping set is used which
matches territories based on the opportunity/opportunity partner information and the territory information. The order
of the mapping sets is interchangeable; regardless of which mapping set is used first, the resulting territories that match
will be the same.
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In the case of leads, the mapping set sequence is important as the territories matched using the first mapping set may
result in a primary partner being added to the lead. This information is significant to the territory matching performed
using the second mapping set.

Mapping sets can be made conditional to control whether the mapping set is used or not used during assignment
processing. For example, the partner channel manager territory assignment mapping set conditional attribute is set to
the value RevenuePartnerId. During the assignment processing of a revenue line, if the RevenuePartnerId attribute for
that revenue line contains a value, then this mapping set will be used in territory matching processing.

An indicator in the Related Candidates region controls whether to merge the matching assignment candidates identified
from processing each set of mappings. This indicator is used to drive the merging of matching candidates when
multiple mapping sets are used in assignment processing. If the box is checked, then the candidates are merged.
Candidates aren't merged by default.

In most implementations, the predefined mapping sets are sufficient. But mapping sets can offer some flexibility if
user-defined assignment processing is needed.

Examples of Creating Assignment Mappings  
For territory-based assignment, you must create work object to candidate object mappings while creating the
assignment object. These mappings are used to make candidate assignments. The scenarios in this topic illustrate
creating the different mapping types:

• Attribute mapping

• Dimension mapping

• Literal mapping

Create an Attribute Mapping
You want to assign territories to an opportunity revenue line when the territory line of business is the same as the
opportunity line of business. Here's how to create an attribute mapping:

1. Create the following mapping:

◦ Work object - Revenue

◦ Candidate object - Territory

2. Select the territory when the attribute territory line of business code is equal to the revenue line of business.
3. Enter a value for the sequence which determines the order in which the mapping is used when matching

territories.

Note:  Assign the lowest sequence number to the most selective mapping, and the next sequence number to
the next most selective mapping.
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Create a Dimension Mapping
You want to assign territories to opportunity revenue lines based on the product associated with the revenue line. Here's
how to create a dimension mapping:

1. Select the mapping type Dimension and enter a sequence value, which determines the order in which the
mapping is used when matching territories. The most selective dimension mapping should be given the lowest
sequence number.

2. Enter the function getDimMemberSequence and the Service
oracle.apps.sales.territoryMgmt.territories.publicModel.util.ConsumableComponentsUtil.

3. Enter the value Prod for the function code.
4. Select the candidate object Territory, the work object Revenue, and the alternate work object Revenue.
5. Select the candidate object low and high attributes.

The candidate object low and high attributes correspond to the names of the low sequence and high sequence
attributes for product on the territory. For example, Dimension Sequence Low and Dimension Sequence High
respectively.

6. Select the work object low and high attributes.

The work object low and high attributes correspond to the names of the attributes for product on the revenue
line. For example, Inventory Item ID and Inventory Organization ID respectively.

When assigning territories to opportunity revenue lines based on the product, a revenue line may be for a
product group instead of a product. In this case, the work object alternate low and high attributes can be used.
For example, alternate work object low attribute would be set to Product Group.

If the revenue line doesn't contain either a product or product group, the low and high default values for the
product dimension mapping can be used to match against the product dimension with the value Any. In this
example, the default value low would be set to 1 and default value high to 999999999999999.

Create a Literal Mapping
Literal mappings are a way of filtering the matched territories based on specific values of a territory attribute. You
want to find only territories that have an account-centric coverage model assigned to each revenue line. For example,
territory coverage model equals SALES_ACCOUNT_CENTRIC.

Note:  Literal mappings use the code value for lookup-based fields, and not the meaning value.

Here's how to create the literal mapping:

1. Select the mapping type Literal and optionally enter a sequence value, which determines the order in which the
mapping is used when matching territories.

2. Select the candidate object Territory.
3. Select the candidate object attribute that will be used for filtering. For example, Coverage Model.
4. Select the operator value Equals.
5. Select the literal value. In this example, only sales account-centric territories should be assigned to revenue

lines, so the Literal Value entered corresponds to the code value for the coverage model. For example,
SALES_ACCOUNT_CENTRIC.

Related Topics
• Examples of Creating Assignment Rules
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Assignment Rules  

Assignment Rule Components  
The rule category, rule sets, and rules are components that work together to determine how the assignment engine
processes rule-based assignments for work objects.

Rule categories are predefined for each object leveraging assignment rules. Each predefined rule category determines
the type of rule processing performed, for example, matching, scoring, and classification.

Depending on the rule category selected, rule sets may allow filters to be used to determine whether all matches are
assigned, or a random number of matches. Additionally, a score may be used to allow further filtering of the matching
candidates, such as the top X candidates or all above or equal to a minimum score.

At the rule level within a rule set, the action determines what happens when a rule is evaluated as true. The rule action
option works in conjunction with the rule category selected.

Here's how the rule set components work together.

Mode Use Score Filters Action

Matching or Territory
 
Applicable only if you use territory-
based assignment with rule
filtering.
 

X
 

All
 
All Above Minimum Score (set
Minimum Score value)
 
Random (set Number of
Candidates value)
 
Top X (set Number of Candidates
value)
 

Increase Score By x for each
matching or selected candidate
 

Matching or Territory
 
Applicable only if you use territory-
based assignment with rule
filtering.
 

Not applicable
 

All
 
Random (set Number of
Candidates value)
 

Assigns the matching or selected
candidates.
 

Scoring
 

Not applicable
 

Not applicable
 

Increase Score By x
 

Classification
 

Not applicable
 

Not applicable
 

Set Value To x
 

Rule Category and Rule Set
The rule category selected for the rule set determines the type of rule-based assignment processing to be performed.
For example, if you select the rule category named Sales Lead Resource Rule Category, the candidates that match the
conditions of the rules evaluated as true by the assignment manager are assigned to the work object. The number of
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matching candidates that are assigned to the work object is determined by the rule set filter settings. Only one rule
category can be associated with each rule set.

A rule category is predefined for each type of rule-based assignment processing supported by each sales application
object. For example, the rule category named Sales Team Member Recommendation Default Rule Category
is predefined for resource rule-based assignment of Opportunities, and Sales Lead Resource Rule Category is
predefined for resource rule-based assignment of Leads. Similar rule categories can be predefined for territory rule
filtering for revenue lines, territory rule filtering for leads, lead scoring, lead raking, and lead qualification.

Rule categories are created and edited through the Manage Assignment Objects setup task for the relevant application.
A rule set contains rules that belong to a specific rule category.

Use Score
The Use Score option determines whether a score is used when identifying matching candidates. The number of
matching candidates that are assigned to the work object is also determined by the rule set filter settings.

Filter Settings
The filter settings are used in conjunction with some rule categories and the rule set Use Score option. The filters allow
you to indicate how many matching candidates you want to assign to the work object. When set to All Above Minimum
Score, all of the matching candidates above a particular score are assigned to the work object. Set the score in the
Minimum Score field.

When set to Top X, a number of matching candidates with the highest scores are assigned to the work object. Use the
Number of Candidates field to specify how many top matching candidates to assign.

When the filter is set to Random, a random selection of matching candidates is assigned to the work object. When the
rule set Use Score option is selected, and the filter is set to Random, a random selection of matching candidates with
the highest scores is assigned to the work object. Use the Number of Candidates field to specify how many random
matching candidates to assign.

Rules
One or more rules may be defined for each rule set. Each rule is the distinct set of criteria that's evaluated and
candidates or scores that are eligible to assign if the conditions are met. The rule action may apply if all conditions are
met, or any conditions are met.

Note:  You may have resolved duplicate account or contact records to ensure that clean data is available by merging
duplicated records into one single record. During the merge process, some account and contact attributes are
removed to resolve the duplication. This may impact your account assignment rules where the rule conditions apply
to any of the AccountId or ContactId attributes that got deleted during the merge process.

The assignment rule administration allows more than one user at a time to create or update rules that belong to the
same or different rule sets or categories. For example, if User A is currently updating assignment rules for the Sales
Lead Resource Rule Category rule category, then User B can update assignment rules for that same rule category or
another rule category at the same time.

Note:  If you want to rename, delete, or create a rule with the same name as an existing rule, you must click Publish
after you make your changes to the existing rule. Only then should you create another rule with the same name to
ensure that your changes are live and included in the assignment processing.
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Action
The action set at the rule level determines the action that's performed when a rule is evaluated as true.

If defining rules to assign resources to an object, you can search for and select the specific resources to be assigned
when the rule conditions are evaluated as true.

When a matching rule category is selected, for example, Sales Lead Resource Rule Category, the rule action assigns the
matching candidates. If a rule with that action is evaluated as true, the candidates that match the conditions for that rule
are assigned. The filter setting at the rule set level determines whether all matching candidates are assigned (All), or a
random number of matching candidates are assigned (Random).

When a matching rule category and the Use Score option are selected, the rule action increases the candidate score
by the specified value. If a rule with that action is evaluated as true, the candidates that match the conditions for that
rule get the value in the Action added to their score. For example, you select Sales Team Member Recommendation
Default rule category and the Action for one of the rules in that set is Increase Score By 10. If that rule is evaluated as
true, the resources that match the conditions for that rule get 10 added to their scores. The scores are cumulative, so
if any of the resources that matched the conditions in the rule in the example also match the conditions for other true
rules in the set, those resources get additional values added to their current score of 10. The filter setting at the rule set
level determines whether all matching candidates are assigned (All), or all matching candidates above a specified score
are assigned (All Above Minimum Score), or a random selection of matching candidates with the highest scores are
assigned (Random), or a number of matching candidates with the highest scores are assigned (Top X).

When a classification rule category is selected, the rule action is Set Value To  Value Name. For example, the rule
category is Sales Lead Rule Qualification Rule Category, the action for one of the rules in that set is Set Value to
Qualified. If that rule is evaluated as true, the Status for the lead being classified is set to Qualified.

When the rule category Sales Lead Scoring Rule Category is selected, the rule action is Increase Score By  Score
Value. If a rule with that action is evaluated as true, the value in the action is added to the score of the work object
associated with the rule set. For example, if the action for one of the rules in that set is Increase Score By 20, and that
rule is evaluated as true, the score for the Lead is increased by 20.

Note:  When you're creating or updating assignment rules, you must click Save and Publish to ensure that your
changes are live and included in the assignment processing.

Related Topics
• Examples of Creating Assignment Rules

Examples of Creating Assignment Rules  
Assignment rules are created using rule sets, rules, conditions, and actions. The assignment process uses your rules to
evaluate and recommend candidate assignments for specified work objects. This topic provides scenarios to illustrate
the different types of rules you can create.

Note:  When creating an assignment rule that uses a check box field, note that the value of true may be denoted by
"Y" or "Yes" or "T". Ensure the check box is clear is you want to denote a false value.

401



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

Create Lead Qualification Rules
In this scenario, you want to create rules to classify leads as qualified if these attributes are set as specified:

• Lead Customer is sales account.

• Lead Product is set to Is Not Blank.

• Lead Score is greater than 150.

To create a rule to classify leads as qualified:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Rules

2. Search for and navigate to the assignment configuration setup task for the relevant object:

◦ For sales lead and deal assignment, go to the Manage Sales Lead Assignment Rules task. This is the task
used as an example in this topic.

◦ For the Opportunity functional area assignment, select the Manage Opportunity Assignment Manager
Rules task.

3. In the setup task page, select the category for the appropriate assignment flow, in this case Sales Lead
Qualification Rule Category.

4. Click the Add Row icon to create a rule set for the predefined rule category Sales Lead Qualification Rule
Category.

5. Create a rule with the three conditions that match the attribute settings for a lead to be considered a qualified
lead:

◦ Lead Product: Select the lead attribute Primary Product ID. Select the Is Not Blank operator.

◦ Lead Customer: Select the lead attribute Sales Account Indicator, and then select the Equals operator.
Enter the value of Y.

◦ Lead Score: Select the lead attribute Score, and then select the Greater Than operator. Enter the value of
150.

6. In the Actions region, select Qualified from the Return the Candidate Value As Qualified list.

Create Lead Scoring Rules
In this scenario, you want to create a scoring rule to:

• Increase lead scores by 150 if the lead attribute Lead Time Frame is set to 3 months.

• Increase lead scores by 100 if these attributes for leads are set as specified:

◦ Budget Status is Approved

◦ Budget Amount is greater than 500000

To create this scoring rule:

1. Create a rule set for the predefined rule category Sales Lead Scoring Rule Category.
2. Create the first rule with the conditions that match the attribute settings you want a lead to have so that 150 is

added to its score:
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◦ Choose the object Sales Lead and attribute Time Frame, and then select the Equals operator. Select 3
months.

◦ Enter the action as Increase the Score by 150.
3. Similarly, create your remaining rule for the budget attributes and action to Increase the Score by 100.

a. Add the first condition: Choose the object Sales Lead and attribute Budget Status, and then select the
Equals operator. Select Approved.

b. Add the second condition: Choose the object Sales Lead and attribute Budget Amount, and then select
the Greater Than operator. Enter 500000.

c. Enter the action as Increase the Score by 100.

Create Matching Candidate with Scoring Rules
Assign different country specialists to opportunities in some European countries based on the country and the risk level
of the Opportunity. To create matching candidate with scoring rules:

1. Create a rule set for the predefined category Sales Lead Resource Rule Category and select the Use Score 
option, the filter type of All Above Minimum Score, and the minimum score set to 20.

2. Create three rules each with conditions:
a. Create the first rule with these conditions:

- Select the object Opportunity, and then choose the attribute Customer Country. Select the
Equals operator, and then select DE.

- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

b. Create the second rule with these conditions:
- Select the object as Opportunity, and then choose the attribute name Customer Country. Select

the In operator, and then select FR and UK as condition values.
- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

c. Create the third rule with these conditions:
- Select the object Opportunity, choose the attribute name Risk Level. Select the Equals operator,

and then select the value High.
- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

Related Topics
• Update Existing Setup Data

Example of Using Territory-Based Assignment with Rule-Based
Filtering  
This topic illustrates using territory-based assignment with rule-based filtering. In this example, you find one or more
matching territories and use assignment rules to filter the list of territories assigned to sales leads.
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Scenario
Your company wants to assign new leads to the correct territory. If there is no sales channel identified on an incoming
lead, then the application should determine if the lead should go to a partner or remain internal. If the deal is internal,
then only the prime territories are assigned. If the deal is pushed to a partner, then a channel manager is also assigned
to oversee the deal.

Transaction Details
Leads are the primary marketing business objects that the assignment engine processes. Territory assignment is
the primary means of assigning the appropriate salespeople to the lead. Rule filtering may also be used to filter the
territories, for example when the sales channel isn't identified. The rule filtering is performed when the Assignment Rule
for Territory-Based Lead Assignment (MKL_LEAD_ASSIGNMENT_RULE) profile option is set to use rule filtering.

In this scenario, the work object is Lead and the candidate object is Territory. The assignment is territory-based. The
assignment processing finds one or more matching territories. Assignment processing then uses the rule category
defined in the Assignment Rule for Territory-Based Lead Assignment profile option to determine the set of rules to use
for the rule filtering.

After the territory-based assignment delivers a list of territories, the rules can fine-tune the assignment process:

1. Rule for SALES CHANNEL Is not blank

a. SalesLead.Sales Channel Is not blank
b. Action: Return matching candidates

2. Rule for SALES CHANNEL Is blank, Assign Channel Manager

a. Sales Lead.Sales Channel Is blank
b. Sales Deal.Deal Size Greater than 1,000,000
c. Territory.Territory Type In Partner, Sales Channel Manager
d. Action: Return matching candidates

3. Rule for SALES CHANNEL Is blank, Assign Prime

a. Sales Lead.Sales Channel Is blank
b. Sales Deal.Deal Size Lesser than 1,000,000
c. Territory.Territory Type Equals Prime
d. Action: Return matching candidates

When the lead comes in, it must be assigned to a territory for follow-up. Based on the SALES CHANNEL rules, territory-
based assignment can determine if the lead is a smaller deal that can be handled by your partners (and a Sales Channel
Manager to oversee), or whether it's a larger deal that must be followed up by the internal sales force.

Assignment Results
The assignment process first identifies the list of territories for the lead. The rules then determine who gets the deal:

1. This first rule determines if a Sales Channel value exists. If it does, then all territories identified (by way of
territory-based assignment) are assigned.

2. The second rule says if there is no sales channel assigned, and the deal is under one million dollars, assign the
lead to a partner and a Sales Channel Manager.

3. The final rule is used when there is no sales channel value, and the deal is greater than one million dollars, the
lead is assigned to the prime (internal) territories.
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Assignment Using Access Groups  

Overview of Access Groups  
Use access groups to provide sales resources with additional access to sales object data. Access groups are an
alternative way of granting data permissions to users, and they use a different access path provided by the predefined
data security policies.

An access group uses the access control list model. You create an access group and assign users to it. All group
members are given access to standard or custom object data. You define object sharing rules that provide users with
access to the specific records of an object. These rules specify the type of access to be provided and the conditions
under which the access is provided. For example, users might be granted access to:

• All opportunities with a status of Open

• All accounts where country is set to UK

You can also define the type of data access provided, for example, Full access or Read access.

A user can be assigned to one or more access groups. In this case, the user has the access assigned to each group.
So if Lisa Jones is assigned to Access Group A, which provides access to opportunities, and to Access Group B, which
provides access to Accounts, she receives the access provided by both groups. You can also use one access group to
assign access to multiple objects.

For more information about access groups, see the Access Groups chapter in the Securing CX Sales and Fusion Service
guide.

Related Topics

Assignment with User-Defined Objects  

User-Defined Assignment Features  
Assignment processes assign salespeople and their territories to core sales objects, such as opportunities and leads,
using territory dimensions or assignment rules.

You can configure user-defined assignment flows to assign user-defined objects or to perform additional or alternate
assignment processing on standard objects.

Note:  In the context of assignment, "user-defined" objects are those objects you create using the configuration tool,
Application Composer.
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User-Defined Assignment Key Features
User-defined assignment lets you:

• Assign the appropriate resource or group quickly and efficiently using assignment rules.

• Use a simple approach to define the criteria that matches rule values with resources or territories.

• Assign territories to user-defined objects with assignment rules.

• Define rules that match fields on business objects with fields on territories and resource objects. Or, define
rules where fields contain specific values. These fields and business objects can be both user-defined and
standard.

• Define assignment rules to calculate a score for an object or set the value of a specific field if certain conditions
are met.

• Automatically assign new records.

• Run assignment processes from within the applications.

• Use the Perform Assignments batch assignment process to assign user-defined object records in bulk.

Note:  If you make user-defined assignment workflow or trigger configuration changes in a sandbox, you must
publish the sandbox for your changes to take effect. This is expected behavior, since the assignment job is executed
by an internal user. See the topic, How to Publish Assignment Information, for details.

User-Defined Territory Assignment Considerations  
If you use user-defined assignment flows to assign territories to user-defined objects, consider these points:

• You can assign territories to user-defined objects using rule-based assignment. Territory-based assignment
isn't supported.

• You can't use territory coverage, such as geography or product, in the assignment processing of territories to a
user-defined object. Instead, you must use the standard fields on a territory, such as name, number, or owner,
along with any user-defined fields. Assignment processing uses the standard fields on a territory, in addition to
using the standard and user-defined fields on the user-defined object.

• Oracle recommends that you use the Territories feature to create and maintain territories, so that the latest
active territory details are available.

Related Topics
• User-Defined Assignment Features

Publish Assignment Changes  

How to Publish Assignment Information  
Assignment processing uses only published assignment configurations and rules. Therefore, any time you change
assignment configurations or rules, you must publish the changes.
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For example, if you add a new sales lead assignment rule but don't publish the changes, then the next time assignment
processing occurs, the assignment processing will skip the new rule.

You publish assignment information in the following ways:

• Publish from an application's assignment setup pages in Setup and Maintenance. For example, publish in the
Manage Sales Lead Assignment Rules page or the Manage Sales Assignment Manager Objects page.

• Run the scheduled process Perform Assignment Data Publish, Refresh, and Synchronization.

Oracle recommends that you publish assignment information when you:

• Update the assignment configuration, which includes assignment objects, attributes, and mappings.

• Create or update assignment rules where the changes are infrequent or there is only a small number of
assignment rules.

• Create user-defined objects or fields that you're going to use in assignment.

Publish Data Using the Assignment Setup Pages
You can publish assignment data from any of the assignment objects and assignment rules setup pages, such as
Manage Customer Center Assignment Objects or Manage Sales Lead Assignment Rules.

After you create or update assignment data or rules, in the applicable setup page, click Save and Publish to publish
assignment information and make it available for use in assignment processing. Clicking the save and publish button
submits the process that publishes assignment configuration and rules information. To monitor the status of the
publish process, click the refresh icon next to the Last Published text in the page.

If you make updates to assignment data or rules and don't publish, a warning icon appears next to the Last Published
text. If the publish process fails, the warning icon remains next to this text.

Publish Data Using the Publish Assignment Information Process
You can run the Perform Assignment Data Publish, Refresh, and Synchronization scheduled process to publish
assignment information. You can schedule this process daily, weekly, and so on, based on the frequency of changes
to assignment information, including assignment rules. Consider how often the assignment data will change and how
critical it's to have these changes available for use in assignment.

You can use the publish assignment information process when there are a large number of assignment rules (about 100
to 1000) and when there are multiple users making changes to rules at the same time.

To run this process:

1. Click Navigator > Scheduled Processes.
2. Click the Schedule New Process button.
3. On the Schedule New Process window, select Perform Assignment Data Publish, Refresh, and

Synchronization  process from the Name list, and click OK.
4. On the Process Details page, select the application from the Application list.
5. Select the Publish check box.

Note:  The Candidate Object and Owner Module fields don't apply to this process.

6. Click Submit.

This process publishes all assignment information for the selected application so that it's available for use in assignment
processing. You can use the Scheduled Processes page to monitor this process and to view the log file.
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Related Topics
• How You Refresh Assignment Candidate Cache

Account Assignment  

Overview of Account Assignment  
An account represents a company or person you sell to. If your business sells to a contact or household, an account
represents the contact and household you sell to.

Assignment manager lets you assign territories related to your sales accounts, including customers, prospective
customers, individual contacts, and households. You can use assignment rules defined for accounts only to filter the
territories that are assigned to accounts.

Predefined business events, such as Organization Created or Organization Updated, may impact the performance
of account assignment processes if the profile option that controls those business events is enabled. For more
information, see the topic How You Monitor Your Import Activities, in the Oracle CX Understanding Import and Export
Management for CX Sales and Fusion Service guide.

Multiple Classification Types  

Enable Multiple Classification Types  
You can enable multiple organization types and industries classification types for account assignment. While you can
specify multiple industries for each account, the application only uses only the primary industry for assignment. Use
this procedure to enable assignment on all of the industries.

For example, Oracle Corp. is primarily a software supplier, but also manufactures hardware. After you complete the
setup, you can assign the account using both industry categories.

Assignments are run on an account based on classifications and includes these tasks.

• Using multiple organization types for account assignment.

• Using multiple industries classification for account assignment.

• Running assignment manager on an account.

Note:  Before you start these procedures, you must ensure that the Organization Types and Industries fields are
shown on the Profile tab of the Accounts page.

Use Multiple Organization Types for Account Assignment

1. Go to the Setup and Maintenance work area.
2. Search for the Manage Customer Center Assignment task.
3. Select the Account row.
4. Select the Candidates tab of the Account: Details table and then the Account Territory row.
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This row contains mapping information about the account.
5. Select the Account Territory: Mapping Sets tab.

This tab shows the organization type and industries type.
6. Select the row corresponding to Organization Type in the Work Object Attribute Low column and click Edit.

The Edit Mapping Page opens where you can edit the organization mapping to update the work object.

Use default values for fields unless the steps specify other values.

Field Value

Work Object
 

Account Organization Type
 

Work Object Attribute: Low
 
 

Code Assignment
 

7. Ensure that the Inactive check box is clear, so that the mapping remains active.
8. Click OK to save the changes.
9. Verify that your updates are active by reviewing the Mapping Sets tables.

The values of the specific dimension that you have enabled using the multiple values for assignment, instead of
the primary value, should be Code Assignment.

10. Click Save and Publish.

Your changes are published and future territory assignment for accounts is performed using the mapping sets.

Use Multiple Industries Classification for Account Assignment

1. Select the row corresponding to Industry in the Work Object Attribute Low column and click Edit.

The Edit Mapping page opens where you can edit the industry mapping to update the work object.

Use default values for fields unless the steps specify other values.

Field Value

Work Object
 

Account Industry
 

Work Object Attribute: Low
 
 

Code Assignment
 

2. Ensure that the Inactive check box is clear, so that the mapping remains active.
3. Click OK to save the changes.
4. Verify that your updates are active by reviewing the Mapping Sets tables.

The values of the specific dimension that you have enabled using the multiple values for assignment, instead of
the primary value, should be Code Assignment.
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5. Click Save and Publish.

Your changes are published and future territory assignment for accounts is performed using the mapping sets.

Run Assignment Manager on an Account

1. Go to the Accounts list page.
2. Search for the Maple Networks account for which you want to run the assignments based on the mappings.
3. Select the row corresponding to Maple Networks.

You are in the Edit Accounts: Maple Networks page.
4. Go to the Profile tab.
5. Click Industries.

You are in the Manage Industries page.
6. Click Add.
7. Enter Financial Services in the Name field and click Search.
8. Select the row corresponding to the Financial Services industry.
9. Click OK on the Select: Industry page, and then again on the Manage Industries page.

10. Click Save on the Edit Account page.

Saving your changes automatically triggers the assignment process and the account is assigned territories
based on the mapping sets.

Territory-Based Account Assignment  

Overview of Territory Account Assignment  
Territory-based assignment is the default approach used to give sales people and their managers access to account,
contacts and households.

Account assignment is based on the matching of sales account attributes with sales territory dimensions. For example,
you can add an account owner to the account-territory matching to enable the assignment of a territory based on the
account owner.

By default accounts are assigned automatically when the account is created or updated. Alternatively, sales people with
access to the account team can run assignment for a specific account. Additionally, account assignment can run in bulk
on a scheduled basis. You can also add an account owner to the account territory mapping that enables the application
to assign a territory based on the account owner's territory. For example, if the account owner is mapped to the territory
owner, then when you create an account, you're made the account owner

Multiple Industry and Organization Classifications
Opportunity and Lead assignment also supports multiple classification values. For more information on assigning
opportunities and leads using industry classification codes, see the white paper, Assignments Using Nonprimary
Classifications (Doc ID 2086014.1) available on My Oracle Support.

Sales Account Assignment Child Objects
Here's a list of sales account assignment child objects:
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Sales Account Assignment - Child
Objects

Description

Account
 

Represents a company you sell to
 
An account represents a company you sell to. If your business sells to a contact or household, an
account represents the contact and household you sell to.
 

Account Auxiliary Classification 1
 

Multiple auxiliary classification codes associated with the account
 
Select this child object to enable account assignment by all account auxiliary classification 1 values.
 

Account Auxiliary Classification 2
 

Multiple auxiliary classification codes associated with the account
 
Select this child object to enable account assignment by all account auxiliary classification 2 values.
 

Account Auxiliary Classification 3
 

Multiple auxiliary classification codes associated with the account
 
Select this child object to enable account assignment by all account auxiliary classification 3 values.
 

Account Industry
 

Multiple industries associated with the account
 
Select this child object to enable account assignment by all account industry types.
 

Account Organization Type
 

Organization type classification code assigned to the account
 
Select this child object to enable account assignment by all account organization types.
 

Sales Account Assignment Object Attributes and Corresponding Customer Attributes
Here's a list of sales account assignment object attributes and corresponding customer attributes, as shown on the
Profile and Classification nodes of the respective information tree.

Sales Account Assignment Object
Attribute

Corresponding Sales Attribute

Geography Identifier
 

Sell-to Address
 

Industry
 

Primary Industry: The primary classification code for the classification category defined in profile
option Industry Classification Category.
 

Organization Type
 

Primary Organization Type: The primary classification code for the classification category Organization
Type defined in profile option Industry Classification Category.
 

Organization Size
 

Organization Size
 

Named Account Type
 

Named Sales Account Indicator
 

Party ID
 

Party ID
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Sales Account Assignment Object
Attribute

Corresponding Sales Attribute

Auxiliary Dimension 1
 

The primary classification code for the classification category defined in profile option Industry
Classification Category for Auxiliary Dimension 1.
 

Auxiliary Dimension 2
 

The primary classification code for the classification category defined in profile option Industry
Classification Category for Auxiliary Dimension 2.
 

Auxiliary Dimension 3
 

The primary classification code for the classification category defined in profile option Industry
Classification Category for Auxiliary Dimension 3.
 

Related Topics
• Considerations for Configuring Assignment

• Examples of Creating Assignment Mappings

• Overview of Accounts, Contacts, and Households

Assign Primary and Nonprimary Classifications  
As a sales administrator, you have the ability to configure account assignment to enable primary and nonprimary
industry codes, organization types, and classification values.

Enabling Organization Type and Industry Classification Values
To enable the organization type and industry classification values:

1. Sign in as the sales administrator or as a setup user.
2. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Customer Center Assignment Object

3. Click the Manage Customer Center Assignment Object link.

The Manage Customer Center Assignment Object page appears.
4. Select the Account object.
5. In the Account: Details region, select the Candidates tab and then select Account Territory.
6. Select the Account Territory: Mapping Sets tab.
7. In the Mappings region, select the work project.
8. Click Edit.

The Edit Mapping pane appears.
9. Make the required changes and click OK.

10. Click Save and Publish to activate the mapping to enable assignment by all classification values.

Improve the Performance for Territory-Based Account Assignment  
Assignment manager lets you assign territories related to your sales accounts, including customers, prospective
customers, individual contacts, and households. To optimize the performance of assigning sales representatives
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to these sales territories, you can choose to select an enhanced mode of processing for territory-based account
assignment.

This performance enhancement is specific to territory-based account assignment only. There's no performance impact
on other business objects such as Leads, Opportunity, Partner, or any rule-based assignment activities.

If you have permission to configure offerings, then you can use the New Features page to opt in to these two features:

• Optimize Performance for Territory Based Assignment

• Optimize Performance in Accounts, Contacts, and Households

1. Select the Change Feature Opt In from the Sales Foundation functional area and open the Edit Features:
Sales Foundation page.

2. Locate the Optimize Performance in Territory-Based Assignment feature and expand to display the
Optimize Performance in Accounts, Contacts, and Households.

3. Select the Enable check box for both of these features and click Done.
For more information, see the New Feature Opt-In section of the Oracle Applications Cloud - Using Functional Setup
Manager guide on the Oracle Help Center (docs.oracle.com). When you run your next Territory-Based Account
Assignment, note the significant performance improvements after using the enhanced mode of processing.

Note:  While the performance for territory-based account assignment is enhanced by enabling this Opt-In feature,
custom post-processing tasks may be impacted. For example, any custom task flows, Groovy scripts, or event
notifications won't get triggered.

Modify Sales Account Assignment to Assign Partner Type Territories  
As a sales administrator, you can configure account assignment to assign partner type territories.

To assign partner type territories for account assignment, you must deactivate the Territory Type Code attribute as
follows:

1. Sign in as the sales administrator or as a setup user.
2. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Customer Center Assignment Object

3. Click the Manage Customer Center Assignment Object link.

The Manage Customer Center Assignment Object page appears.
4. Select the Account object.
5. In the Account: Details region, select the Candidates tab and then select Account Territory.
6. Select the Account Territory: Mapping Sets tab.
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7. Select the row corresponding to Territory Type Code in the Candidate Object Attribute Low column and
click Edit. The Edit Mapping Page opens where you can edit the Territory Type Code mapping to update the
candidate object.

8. Ensure that the Inactive check box is selected, so that the mapping isn't active.
9. Click OK.

10. Click Save and Publish to deactivate the mapping.

Overview of Account Assignment Profile Options  
The following profile options influence the behavior of sales account assignment:

Profile Option Display Name Default Value Effect

Assignment Rule for Account Territory
Assignment
 

Null
 

Specifies the assignment rule that defines the
sales territory that's assigned to an account.
 

Account Types Enabled for Assignment
 

ZCA_CUSTOMER
 

Enables one or more account types for territory
assignment. Applicable types are Account Type
standard lookup values. Use comma-delimited
string for multiple values.
 

Sales Account Automatic Assignment on
Import Enabled
 

N
 

Enables automatic territory based assignment
after sales accounts are imported. If disabled,
 manually run a batch assignment or assign
each sales account individually.
 

Disable updating Last Assign Date when there
are no territory changes
 

N
 

Disables Stamping of Last Assign Date when
there are no territory changes.
 

Sales Account Automatic Assignment on Create
Enabled
 

Y
 

Enables automatic territory based assignment
processing after a sales account is created.
 

Sales Account Automatic Assignment on
Update Enabled
 

Y
 

Enables automatic territory based assignment
processing after a sales account is updated.
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Account Territory Member Access  
Access for the territory owners and members are the same as that of the team members.

These access levels control the internal and partner territory privileges for the account:

• Internal territory owner: Full access

• Internal territory members (nonowner): Edit access

• Partner territory owner and members: View-only access

Note:  You must implement Territory Management before you can access territory owners.

Related Topics

Account Assignment Scheduled Processes  

Schedule Account Assignment  
The Request Account Assignments scheduled process can be scheduled and run on the Scheduled Processes page. You
must have the Run Sales Party Batch Assignment privilege to define and run account batch assignment.

To access the Scheduled Processes page, click Navigator. In the Tools heading, click Scheduled Processes.

1. Click Schedule New Process, then click type Job.
2. Select the process named Request Account Assignment. If needed, use the Search link on the Search window.
3. Enter your process details. The following table shows the view criteria and its description, as well as any bind

values that are required.

◦ Work Object: SalesAccount_Work_Object

◦ Candidate Object: SalesAccountTerritory_Candidate_Object

◦ Assignment Mode: Territory

◦ View Criteria Name: (as shown in the following table)

◦ View Criteria Bind Values: (as shown in this table)

View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

SalesAccountsUpdatedSinceVC
 

Use this view criteria to assign
accounts which haven't been
previously assigned and have
LAST_UPDATED_DATE is greater
than or equals the specified
date and (LAST ASSIGNED DATE
is empty or LAST ASSIGNED
DATE is less than or equal to the
specified date.

BindLastUpdateDate= [YYYY-
MM-DD HH:MM:SS]
 

Daily
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View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

 

SalesAccountsAssignedBeforeVC
 

Use this view criteria to reassign
accounts which have been
previously assigned and have
LAST_ASSIGNED_DATE (in the
ZCA_SALES_ACCOUNTS table)
less than the specified date.
 

BindLastAssignedDate= [YYYY-
MM-DD]
 

Daily
 

SalesAccountTerritoryBatchReassignmentVC
 

Use this view criteria to reassign
accounts impacted by the
specified territory and territory
dimensional realignment batch.
 
This view criteria is also used
internally to initiate immediate/
automatic assignments after
territory proposal activation and
territory dimension updates.
 

BindReassignment
BatchId=[Territory
Reassignment Batch ID]
 

Ad hoc run as per business
requirements
 

SalesAccountBulkImportVC
 

Use this view criteria to assign
accounts created in a given
customer import batch.
 
This view criteria is also used
internally to initiate immediate/
automatic assignments after
customer import.
 

BindReassignment
BatchId=[Import Activity ID]
 

Ad hoc run as per business
requirements
 

SalesAccountDimsForPartyVC
 

Use this view criteria to assign
the account with the specified
account ID.
 

BindPartyId= [Sales Account ID]
 

Ad hoc run as per business
requirements
 

4. Define a schedule as needed using the Advanced button on the Process Details page. You can schedule the
process to run as soon as possible, or to run at a given frequency and start date.

5. Submit your job and monitor it using the Scheduled Processes list, refreshing it to view the latest status
updates.

Related Topics
• Examples of Creating Assignment Mappings

• How You Refresh Assignment Candidate Cache

• How can I add territories to an account?

• When are territories assigned to accounts?
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Opportunity Assignment  

About Sales Resources and Opportunity Assignment  
Sales resources (team members) are assigned to an opportunity either automatically by the assignment process, or
when you add them to the sales team while editing an opportunity.

The following sections discuss different ways to assign sales resources to an opportunity.

Scheduled Processing
The preferred way to assign sales resources to an opportunity is using a scheduled process, also known as a batch
process or batch method. There are two predefined scheduled processes for opportunity assignment as follows:

• Request Revenue Territory Assignment: Use this process to run territory-based assignment on opportunity
product lines. During this process, the application evaluates every product line in the opportunity batch.
Territories whose dimensions match the dimensional attributes of a given product line are then assigned to that
line.

• Request Opportunity Resource Assignment: Use this process to run rule-based assignment on opportunities.
During this process, assignment processing executes a set of rules, as defined in the profile option, Sales Team
Member Assignment Rule Set Group, to find matching candidates for opportunities. If matching candidates are
found, they're added to the opportunity team. Note that team members for whom lock assignment is disabled
will be replaced if they no longer match the assignment rules.

CAUTION:  These scheduled processes should not be requested to run in parallel against the same opportunity
batch, to avoid potential locking issues. The scheduling service checks for such incompatibilities prior to initiating the
assignment process.

Manually Assigning and Re-assigning
Users with Full access to an opportunity can manually assign or re-assign sales team members, including the
opportunity owner. If an opportunity is re-assigned to a new owner manually, the original owner stays on the sales team
as a non-primary team member, unless he's manually removed from the team.

Real Time Assignment Processing Action
From within an opportunity, sales representatives can use the assign opportunity action to run assignment processing
to automatically assign, in real time, resources to the opportunity. Based on the setting of the profile option,
Opportunity Assignment Mode, assignment processing uses territory-based assignment, rule-based assignment, or
both.

Automatic Assignment On Saving an Opportunity
If the profile option, Assignment Submission at Save Enabled, is yes, when you save an opportunity, assignment
processing runs assignment on the opportunity. In a similar way that on-demand assignment happens, assignment
processing uses territory-based assignment, rule-based assignment, or both, based on the profile option, Opportunity
Assignment Mode.
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Related Topics
• What's lock assignment?

• Opportunity Team Profile Options

• Recommendations for Assignment Processes for Opportunities

• Overview of Territory Account Assignment

Territory-Based Opportunity Assignment  

Set Opportunity Assignment Profile Options  
Whether you're using territory-based assignment or rule-based assignment or both to assign resources to
opportunities, initially in your implementation you should validate the setting of the following two profile options:
Opportunity Assignment Mode and Assignment Submission at Save Enabled.

Set Opportunity Profile Options
Here's how to set opportunity profile options:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the search region of the Manage Opportunity Profile Options page, select Opportunity Management as the
application, or enter the profile option name directly in the Profile Display Name field.

3. In the list that's returned, click the profile option you want to retrieve the details about the profile option.
4. Set the profile option as needed.

These profile options influence the effect of territory-based opportunity assignment:

Profile Option Display Name Default Value Effect

Opportunity Assignment Mode
 

Territory-based Assignment Only
 

Specifies the type of assignment processing
performed for opportunities. The available
options are Territory-based Assignment Only,
Rule-based Assignment Only, and Both (which
runs both rule based and territory based
assignment).
 

Assignment Submission at Save Enabled
 

No
 

Specifies whether to run assignment on an
opportunity when it's saved in the UI. If you
want assignment to run anytime users save an
opportunity, set the profile option to Yes.
 

Territory Based Resource Assignment Style
 

All
 

Specifies if all members of the territory should
be added to an opportunity team or just
the owner. Or, if all (owner and members of
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Profile Option Display Name Default Value Effect

the territory) should be excluded from the
opportunity team.
 

Note:
The Lock Assignment  check box, if
selected, takes precedence and prevents
a salesperson from being automatically
removed from an opportunity through the
assignment engine. Only users with Full
access on the opportunity can select or
deselect the Lock Assignment check box for
sales team members.
 

Territory-Based Assignment Rule Category
 

None
 

Specify the rule category used for rule filtering
during opportunity territory-based assignment.
 

Opportunity Resource Deal Protection Period
 

0
 

Specifies the default number of days that
territory resources are protected to stay on
a deal, even if ineligible through territory
realignment.
 

Related Topics
• About Sales Resources and Opportunity Assignment

• Opportunity Team Profile Options

• Run Territory Assignment Process for Opportunities

• Update Existing Setup Data

Opportunity Team Profile Options  
You set profile options to specify the default function and access levels for both internal and partner resources that you
want added to the sales team for opportunities.

Opportunity Team Profile Settings
This table lists the profile options that affect opportunity team assignment and other team functionality.

Profile Option Display Name Default Value Effect

Internal Resource Sales Team Access Level
Default
 

Edit
 

Determines the default access level for an
internal resource added to the sales team.
 

Internal Resource Sales Team Function Default
 

Integrator
 

Determines the default function for an internal
resource added to the sales team.
 

Partner Resource Sales Team Access Level
Default
 

No Access
 

Determines the default access level for partner
resources added to the opportunity sales team.
 

419

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051179


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

Profile Option Display Name Default Value Effect

Partner Resource Sales Team Function Default
 

Integrator
 

Determines the default function for partner
resources added to the opportunity sales team.
 

Related Topics
• About Sales Resources and Opportunity Assignment

Set Deal Protection on Opportunities  
When a sales territory is assigned to an opportunity product line, the application copies over the territory resources
(salespeople) to the opportunity sales team. When territory realignment happens, ineligible territory resources are
removed from the sales team, unless you enable deal protection.

You enable deal protection by setting the profile option, Opportunity Resource Deal Protection Period
(MOO_DEAL_PROTECTION_PERIOD). The profile option is set to 0 by default.

Note:  When you set the deal protection profile option, all existing sales team members are protected from
realignment for the number of days for which deal protection is in effect.

Enable Deal Protection
Here's how to enable deal protection.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. From the Search region of the Manage Opportunity Profile Options page, enter Opportunity Resource in the
Profile Display Name field.

3. From the MOO_DEAL_PROTECTION_PERIOD: Profile Values region, in the Profile Value field, enter the number
of days for which you want the deal protection to be in effect. For example, enter 15 if you want the deal
protection to be in effect for 15 days.

4. Click Save and Close.

Related Topics
• Update Existing Setup Data

Sales Credit Recipient and Forecast Territory Predefined Logic  
The sales application uses rules to set default sales credit recipients and forecast territories. When a product line is first
added and saved on an opportunity, the line creator is automatically set as the sales credits recipient at 100 percent.

You can edit the default credit allocation, and you can add additional sales credit recipients as needed.

Note:  Nonrevenue credit recipients are never set by default and must be added manually.
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After opportunity assignment is run, the application processes the existing credit allocations for each assigned product
line to ensure that:

• An eligible territory is set as the forecast territory

• The credit recipient is an eligible resource from the forecast territory

Note:  The revenue or nonrevenue sales credit amounts are automatically rolled into the territory's forecast when the
product line is added to the forecast.

Default Forecast Territory Logic
Here is the logic used by the sales application when setting the default forecast territory:

• Keep the forecast territory the user selected, as long as it's still assigned to the product line and its forecast
participation type matches the sales credit type.

• Use the existing credit recipient to derive the forecast territory, whenever possible.

When setting default forecast territory:

• If the current forecast territory for the sales credit is one of the assigned territories with a matching forecast
participation type, the application leaves it unchanged.

• If there is only one territory with a matching forecast participation type, the application sets that territory as the
forecast territory.

• When there are multiple territories with a matching forecast participation type, the application chooses the
forecast territory using the following precedence:

◦ Territory where the existing credit recipient is the owner

◦ Territory where the existing credit recipient is a member

◦ Territory with a matching forecast participation type with the latest effective start date

• When there is no matching territory, the application doesn't set any data value for the forecast territory (this
implies that there is a gap in the territory hierarchy). If the forecast territory for a sales credit allocation is set to
having no data value (is blank) and opportunity assignment was done from the UI, a warning message appears.

Default Credit Recipient Logic
Generally, a sales credit recipient selected by the user isn't replaced by the application unless the recipient is no longer a
qualified credit receiver. The application doesn't change the recipient if:

• The Lock Owner setting for the revenue item is enabled.

• The current credit recipient is under deal protection.

• The current credit recipient is an owner or member of the forecast territory.

If the preceding criteria aren't met, the application sets the forecast territory owner as the new credit recipient.
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Related Topics
• Best Practices for Sales Credits

• Set Opportunity Revenue Forecast Criteria

• Set Deal Protection on Opportunities

• How can I lock in a sales credit recipient?

Opportunity Assignment Scheduled Processes  

Recommendations for Assignment Processes for Opportunities  
You can use two processes for opportunity assignment. You use one for territory-based assignment and one for rule-
based assignment.

The two assignment processes related to opportunity assignment are:

• Request Revenue Territory Assignment: Run this process if you're using territory-based assignment.

• Request Opportunity Resource Assignment: Run this process if you're using rule-based assignment.

Note:  You run processes from the Scheduled Processes page, available from the navigator. You must have the role
of Sales Administrator or a setup user to run scheduled processes.

When setting up the processes, you must enter specific View Criteria names and their Bind Values. The following
sections list the parameters to use and some examples.

Request Revenue Territory Assignment Process
This table identifies the view criteria and view criteria bind values available for the opportunity revenue territory
territory-based assignment process.

View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

OpenOpportunities
ByCreationDate
 

Revenue lines of open
opportunities created in the last 90
days.
 

Note:
The view criteria bind values
aren't required for the default
date range, 90 days. You can
pass a different date range by
entering View Criteria Bind
Values.
 

• BindOptyCreationDateTo=
[date],BindOptyCreation
DateFrom=[date]

• For example:
BindOptyCreationDateTo=
2015-02-29,
BindOptyCreationDateFrom
=2015-01-01

• For example:
BindOptyCreationDateFrom=2015-01-01.
This second example
processes all open
opportunities created
between January 1, 2015, and
the current date.

Daily
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View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

OpenOpportunities
ByEffectiveDate
 

Revenue lines of open
opportunities that have an
expected close date in the last 90
days. Optionally, the user can enter
a different date range.
 

• BindEffectiveDateFrom
=[date], BindEffectiveDateTo
=[date]

• For example:
BindEffectiveDateFrom
=2015-01-01,
BindEffectiveDateTo
=2015-02-29

Daily
 

SalesAccountUpdated InLastNDays
 

Revenue lines of all open
opportunities whose sales account
was updated in the last 30 days.
Optionally, the user can enter a
different number of days.
 

• BindSalesAccountUpdated
Since=[30]

• For example, opportunities
whose sales account
was updated in last 15
days: BindSalesAccount
UpdatedSince=15

Daily
 

SalesAccountUpdatedInLastNHours
 

Revenue lines of all open
opportunities whose sales account
was updated in the last number
of hours. Optionally, the user can
enter a different number of hours.
 

• BindSalesAccountUpdatedSince=[4]

• For example, opportunities
whose sales account was
updated within last 6
hours: BindSalesAccount
UpdatedSince=6

 

Multiple times per day
 

OpenOpportunitiesUpdatedInLastNHours
 

Revenue lines of all open
opportunities updated within the
last four hours. Optionally, the user
can enter a different number of
hours.
 

• BindOptyUpdatedWithinHours=[4]

• For example, open
opportunities updated
within the last 6 hours:
BindOptyUpdatedWithin=6

Multiple times per day
 

OpenOpportunitiesUpdated
InLastNDays
 

Revenue lines of all open
opportunities updated in the last
30 days. Optionally, the user can
enter a different number of days.
 

• BindOptyUpdatedSince =[30]

• For example, open
opportunities updated in last
15 days: BindOptyUpdated
Since=15

Daily
 

FilterByBatchTag
 

Revenue lines of all open
opportunities that contain a
specific value in the Batch Tag field.
 

• BindBatchTag =[text]

• For example, open
opportunities that have
EMEA in the Batch Tag field:
BindBatchTag =EMEA

Ad hoc run as per business
requirements
 

RevenueImportCriteria
 

Revenue lines of all opportunities
imported through the given bulk
import batch ID. The view criteria
bind value, BatchId, is mandatory.
 

• BindBatchId

• For example:
BindBatchId=5618782

Ad hoc run as per business
requirements
 

FilterByOptyNumber
 

Revenue lines of an opportunity
with a specific number.
 

• BindOptyNumber=<number>

• BindOptyNumber=17001

Ad hoc run as per business
requirements
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View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

ClosedOpportunitiesBy
CreationDate
 

Revenue lines of closed
opportunities created in the last 90
days. Optionally, the user can enter
a different date range.
 

• BindOptyCreationDateTo
=[date], BindOptyCreation
DateFrom =[date]

• For example:
BindOptyCreationDateTo
=2015-02-29,
BindOptyCreationDateFrom
=2015-01-01

Daily
 

ClosedOpportunitiesBy
EffectiveDate
 

Revenue lines of opportunities
closed in the last 90 days.
Optionally, the user can enter a
different date range.
 

• BindEffectiveDateFrom
=[date], BindEffectiveDateTo
=[date]

• For example:
BindEffectiveDateFrom
=2015-01-01,
BindEffectiveDateT
o=2015-02-29

Daily
 

Request Opportunity Resource Assignment Process
This table identifies the view criteria and view criteria bind values available for the opportunity resource rule-based
assignment process.

View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

OpenOpportunitiesUpdated
InLastNDays
 

All open opportunities which
were updated in the last 30 days.
Optionally, the user can enter a
different number of days.
 

• BindOptyUpdatedSince=[30]

• For example, opportunities
updated in last 15 days:
BindOptyUpdatedSince=15

Daily
 

OpenOpportunitiesUpdatedInLastNHours
 

All open opportunities updated
within the last number of hours.
Optionally, the user can enter a
different number of hours.
 

• BindOptyUpdatedWithinHours=[4]

• For example, open
opportunities updated
within the last 6 hours:
BindOptyUpdated Within=6

Multiple times per day
 

OpportunityForImport BatchVO
 

All opportunities imported through
the given bulk import batch ID.
Value for BatchId is mandatory.
 

• BindBatchId

• For example:
BindBatchId=5618782

Ad hoc run as per business
requirements
 

OpenOpportunities
ByCreationDate
 

Open Opportunities created in the
last 90 days. Optionally, the user
can pass a different date range.
 

• BindOptyCreation DateTo
[date], BindOptyCreation
DateFrom [date]

• For example:
BindOptyCreation
DateTo=2015-02-29,
BindOptyCreation
DateFrom=2015-01-01 or

BindOptyCreation
DateFrom=2015-01-01. This
second example processes all
open Opportunities created

Daily
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View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

between January 1, 2015 and
the current date.

OpenOpportunities
ByEffectiveDate
 

Open opportunities that have an
expected close date in the last 90
days. Optionally, the user can pass
a different date range.
 

• BindEffective DateFrom
[date], BindEffective
DateTo[date]

• For example: BindEffective
DateFrom=2015-01-01,
BindEffective
DateTo=2015-02-29

Daily
 

SalesAccountUpdatedInLastNHours
 

All open opportunities whose sales
account got updated within the last
four hours. Optionally, the user can
pass a different number of hours.
 

• BindSalesAccountUpdatedSince=[4]

• For example, opportunities
whose sales account was
updated within the last 6
hours BindSalesAccount
UpdatedSince=6

Multiple times per day
 

SalesAccountUpdated InLastNDays
 

All open opportunities whose sales
account got updated in the last 30
days. Optionally, the user can pass
a different number of days.
 

• BindSalesAccountUpdated
Since [30]

• For example, opportunities
whose sales account
was updated in last 15
days: BindSalesAccount
UpdatedSince=15

Daily
 

OpportunitySearchbyOptyNumber
 

The opportunity with a specific
number.
 

• BindOpportunityNumber=<number>

• BindOpportunityNumber=17001

Ad hoc run as per business
requirements
 

ClosedOpportunities
ByCreationDate
 

Closed opportunities created in the
last 90 days. Optionally, the user
can pass a different date range.
 

• BindOptyCreation DateTo
[date], BindOptyCreation
DateFrom [date-90]

• For example: BindEffective
DateFrom=2015-01-01,
BindEffective
DateTo=2015-02-29

Daily
 

ClosedOpportunitiesBy
EffectiveDate
 

Revenue lines of opportunities
closed in the last 90 days.
Optionally, the user can enter a
different date range.
 

• BindEffectiveDateFrom
=[date], BindEffectiveDateTo
=[date]

• For example:
BindEffectiveDateFrom
=2015-01-01,
BindEffectiveDateT
o=2015-02-29

Daily
 

Opportunity Assignment Implementation Considerations
Consider these points when scheduling opportunity batch assignment processes:

• Multiple Revenue Territory Territory Based Assignment and Opportunity Resource Rule Based Assignment
processes can't run at the same time. If one of the processes is running and you submit another process (either
Revenue Territory Territory Based Assignment or Opportunity Resource Rule Based Assignment), then the
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second process has a Paused status until the first job completes. Once the first process completes, the second
process starts.

• For date-based view criteria, for example, OpenOpportunitiesByEffectiveDate, you don't have to enter the view
criteria bind values if the default date range is used.

• For number-of-days-based view criteria, for example, OpenOpportunitiesUpdatedInLastNDays, you don't have
to enter the view criteria bind values if the default number of days is used.

• If you enter view criteria bind values, the date format is YYYY-MM-DD.

• When scheduling opportunity batch assignment processes for the first time, if a process errors, you can try
rescheduling the process and entering a lower value for the Maximum Sub Processes per Process parameter.
The default value is 10. This ensures that each batch contains a small number of opportunities or revenue lines.
If there's an issue with one of the opportunities or revenue lines, then the appropriate subprocess contains an
error status and the other subprocesses completes successfully.

For more information on opportunity assignment, see the help. Use keywords "assignment", "territory-based
assignment", and "rule-based assignment".

Run Territory Assignment Process for Opportunities  
The batch process, Request Revenue Territory Assignment, evaluates opportunity revenue lines and matches eligible
territories and their salespeople to the revenue lines. Use the procedures in this topic to run the process and monitor its
success.

Prerequisites
Here are the prerequisites to successfully assign resources to opportunities using this process:

• The organization hierarchy exists with valid resources.

• Live territories exist.

• Open opportunities exist with open revenue lines.

• Territory attributes match attributes of open opportunity revenue lines.

• The profile option, Opportunity Assignment Mode, is set to either Territory-Based Only or Both (not Rule-Based
Assignment).

• You run the process as a user with the Sales Administrator job role.

Find the Process
Here's how to find the process:

1. Navigate to Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process window, click the drop-down list next to the Name field and click Search.
4. In the Search dialog, enter the name of the process name, Request Revenue Territory Assignment, and click

Search.
5. Select the process name that you want in the results that are returned and click OK.
6. Click OK again, if needed.
7. The Process Details window appears, where you will enter parameters using the steps in the next section, Enter

Process Parameters.
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Enter Process Parameters
Enter the process parameters in the Parameters tab of the Process Details window. The process parameters are called
"view criteria" in the UI.

Since there are many different options when setting up the view criteria, here we are going to use a simple view based
on opportunity creation date. When entering the data, remember that the values are case sensitive, and no spaces are
used.

1. In the View Criteria Name field, enter OpenOpportunitiesByCreationDate as shown in this figure.

2. In the View Criteria Bind Values field, enter BindOptyCreationDateFrom=2014-01-01. This value captures all open
opportunities created since January 1, 2014. The format must be yyyy-mm-dd.

◦ To specify a date range, enter BindOptyCreationDateFrom=<date>, BindOptyCreationDateTo=<date>. Note
the From and To values are separated by a comma.

◦ Leave the field blank to capture opportunities in the default date range, the past 90 days.

3. For the purposes of this example, leave the remaining fields at their default values.
4. Next, schedule the process to run, as described in the next section, Schedule the Process.

Schedule the Process
Set the process to run either on a schedule or immediately in the Schedule tab of the Process Details window (available
within Advanced options).

1. Click the Advanced button in the Process Details window.
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2. Click the Schedule tab.
3. You can run the process on a schedule using the Using a schedule option and entering the schedule

information. However, for the purposes of this example, we are going to run the process immediately. Click the
As soon as possible option.

4. Click Submit.
5. If the process submitted successfully, a confirmation message appears with the request number (process

ID). Make note of this ID to use it in the next step, Viewing Details of the Process Submission. Click Ok on the
confirmation message dialog.

6. Close the Process Details window.

View Details of the Process Submission
You can view details of the process submission, to make sure it ran without errors and to see how many records were
processed.

1. Back in the Scheduled Processes page, enter the process name, Request Revenue Territory Assignment, in the
Name field and click Search.

◦ Alternatively, you can enter the process ID in the Process ID field and click Search.

2. In the search results that are returned, click the job name to view details of the submission. The submission
details include such information as:

◦ Start date and time

◦ Whether the job completed successfully

◦ Parameters used in the job

◦ Log file containing additional details like the number of work objects processed successfully or with
errors and any error messages if the job wasn't successful

Related Topics
• Recommendations for Assignment Processes for Opportunities

Assign a Territory to Closed Opportunity with Revenue Lines  
The batch process, Request Revenue Territory Assignment, evaluates closed opportunity revenue lines and matches
eligible territories and their salespeople to the closed revenue lines.

Use the procedures in this topic to capture closed opportunities created in the last number of days, run the territory-
based assignment process, and monitor its success.

Prerequisites
Here are the prerequisites to successfully assign resources to closed opportunities using this process:

• The organization hierarchy exists with valid resources.

• Live territories exist.

• Open opportunities exist with closed revenue lines.

• Territory attributes match attributes of closed opportunity revenue lines.

• The profile option, Opportunity Assignment Mode, is set to either Territory-Based Only or Both (not Rule-Based
Assignment).

• You run the process as a user with the Sales Administrator job role.
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Find the Process
Here's how to find the process:

1. Navigate to Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process window, click the drop-down list next to the Name field and click Search.
4. In the Search dialog, enter the name of the process name, Request Revenue Territory Assignment, and click

Search.
5. Select the process name Request Revenue Territory Assignment to assign sales territories to opportunity

revenue lines by matching revenue attributes with territory dimensions and click OK.
6. Click OK again, if needed.
7. The Process Details window appears, where you will enter parameters using the steps in the next section, Enter

Process Parameters.

Enter Process Parameters
Enter the process parameters in the Parameters tab of the Process Details window. The process parameters are called
"view criteria" in the UI.

There are many different options when setting up the view criteria. This example uses a simple view based on
opportunity close date. When entering the data, remember that the values are case sensitive, and no spaces are used.

1. In the View Criteria Name field, enter ClosedOpportunitiesByCreationDate.
2. In the View Criteria Bind Values field, enter BindOptyCreationDateTo date, BindOptyCreationDateFrom date.

This value captures all closed opportunities created in the last 90 days. Optionally you can pass a different date
range. The format must be yyyy-mm-dd.

◦ For example, to specify a date range, enter BindEffectiveDateFrom=2012-01-01,
BindEffectiveDateTo=2012-02-29.

◦ Leave the field blank to capture opportunities in the default date range, the past 90 days.

3. For the purposes of this example, leave the remaining fields at their default values.
4. Next, schedule the process to run, as described in the next section, Schedule the Process.

Schedule the Process
Set the process to run either on a schedule or immediately in the Schedule tab of the Process Details window (available
within Advanced options).

1. Click the Advanced button in the Process Details window.
2. Click the Schedule tab.
3. You can run the process on a schedule using the Using a schedule option and entering the schedule

information. However, for the purposes of this example, we are going to run the process immediately. Click the
As soon as possible option.

4. Click Submit.
5. If the process submitted successfully, a confirmation message appears with the request number (process

ID). Make note of this ID to use it in the next step, Viewing Details of the Process Submission. Click Ok on the
confirmation message dialog.

6. Close the Process Details window.

429



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

View Details of the Process Submission
You can view details of the process submission, to make sure it ran without errors and to see how many records were
processed.

1. Back in the Scheduled Processes page, enter the process name, Request Revenue Territory Assignment, in the
Name field and click Search.

◦ Alternatively, you can enter the process ID in the Process ID field and click Search.

2. In the search results that are returned, click the job name to view details of the submission. The submission
details include such information as:

◦ Start date and time

◦ Whether the job completed successfully

◦ Parameters used in the job

◦ Log file containing additional details like the number of work objects processed successfully or with
errors and any error messages if the job wasn't successful

Related Topics
• Recommendations for Assignment Processes for Opportunities

Rule-Based Opportunity Assignment  

Edit Assignment Rules to Randomly Assign Resources to Opportunities  
Create assignment rules using rule sets, rules, conditions, and actions. You can also edit rules and run assignment to
randomly assign resources to opportunities. The assignment process uses rules to evaluate and recommend candidate
assignments for specified work objects.

A rule category is predefined for each type of rule-based assignment processing supported by each sales application
object. For example, the rule category Sales Team Member Recommendation Default Rule Category is predefined for
resource rule-based assignment of Opportunities. When the filter is set to Random, a random selection of matching
candidates is assigned to the work object.

For example, rules exist to assign any opportunity for software products in the California locations to Scott and Lisa, and
server products to Tracy and Bill. Currently, the rules are configured to randomly assign one of the sales representatives
to opportunities in different locations. You now want to update these rules to include new sales locations in San Diego
and Sacramento.

Edit Assignment Rules
Here's how to modify assignment rules.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Assignment Manager Rules
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2. In the Manage Sales Assignment Manager Rules page, select the category where your existing rules were
created, in this case Sales Team Member Recommendation Default Rule Category.

Note:  Random is selected as the filter type.

3. In the Conditions section of the existing rule, update these details for your object:

◦ Attribute = Account State

◦ Operator = Equals

◦ Value = San Diego

◦ Attribute = Account State

◦ Operator = Equals

◦ Value = Sacramento

4. Click Save and Publish to publish the assignment details.

Run Assignment
Mateo Lopez, who's the sales manager for the Western Region, signs in to search for new software opportunities from
Pinnacle Technologies in the Sacramento location. When he finds an opportunity, he runs the assignment process so
that the opportunity is assigned to either one of the sales representatives, Scott or Lisa, as follows:

1. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.
2. Select the opportunity you want.
3. Click Actions.
4. Click Save and Run Assignment.

Each time you run assignment on this opportunity, it could be assigned either to Lisa or to Scott, because the
assignment rule is set to assign resources randomly.

5. Click the Team tab to check which sales representative is assigned to the opportunity.

Related Topics
• How are territories assigned to opportunities?

• About Sales Resources and Opportunity Assignment

• Examples of Creating Assignment Rules

• Update Existing Setup Data

Set Rule-Based Opportunity Assignment Profile Options  
Whether you're using territory-based assignment or rule-based assignment or both to assign resources to
opportunities, initially in your implementation you should validate the setting of these two profile options: Opportunity
Assignment Mode and Assignment Submission at Save Enabled.
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Set Opportunity Assignment Profile Options
Here's how to set opportunity assignment profile options.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. From the Manage Opportunity Profile Options page, enter the profile option name directly in the Profile
Display Name field.

3. In the list that's returned, click the profile option to retrieve the details about the profile option.
4. Set the profile option as needed.

These profile options influence the affect of rule-based opportunity assignment:

Profile Option Display Name Default Value Effect

Opportunity Assignment Mode
 

Territory-based Assignment Only
 

Specifies the type of assignment processing
performed for opportunities. The available
options are Territory-based Assignment Only,
Rule-based Assignment Only, and Both (which
runs both rule based and territory based
assignment).
 

Assignment Submission at Save Enabled
 

No
 

Specifies whether to run assignment on an
opportunity when it's saved in the UI. If you
want assignment to run anytime users save an
opportunity, set the profile option to Yes.
 

Sales Team Member Assignment Rule Category
 

None
 

Specify the assignment rule category used by
the automatic assignment process to assign
sales team members to opportunities.
 

Related Topics
• Set Opportunity Assignment Profile Options

• Opportunity Profile Options Default Values and Effects

• Update Existing Setup Data

How You Refresh Assignment Candidate Cache  
Candidate data, such as resources, are loaded into a cache and used for each assignment request. Rule-based
assignment requests that identify matching candidates or scores for matching candidates use candidate data.

You can refresh the candidate data cache at regular intervals using the Perform Assignment Data Publish, Refresh, and
Synchronization scheduled process. This process marks the candidate for refresh, and the candidate data is refreshed
the next time there is an assignment request using that candidate.

Note:  This feature affects rule-based assignment using the rule set types of matching candidates or matching
candidates with scoring only.
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You can schedule this process daily, weekly, and so on, based on the frequency of changes to the candidates. Consider
how often the candidate data changes and how critical is it to have the changes available for use in assignment. For
example, resource details may change daily and therefore the resource candidate data cache for managing leads may
need to be updated once every day.

The refresh cache process has these parameters that you must enter:

Candidate Object Owner Module

Resource_Candidate_Object
 

Sales
 

Resource_Candidate_Object_Lead
 

leadMgmt
 

ORA_Deal_Resource_Candidate_Object
 

leadMgmt
 

ORA_Queue_Candidate_Object
 

svcMgmt
 

Note:  Don't enter or select values for the Application and Publish parameters if you want to run the refresh cache
process.

For example, you can schedule one process for managing leads, using the parameter Resource_Candidate_Object_Lead/
leadMgmt. Sales would need a process scheduled with the parameter Resource_Candidate_Object/sales.

Related Topics
• Run Territory Assignment Process for Opportunities

• Recommendations for Assignment Processes for Opportunities

• Schedule Account Assignment

Lead Assignment  

Overview of Lead Assignment  
Lead assignment is an automated process that assigns leads to sales resources, sales territories and partners. Sales
leads require assignment, either in real-time or in batch.

Batch assignment runs batch processing that matches the lead objects, either as a one-off or on a scheduled basis. The
two types of lead assignment are:

• Rule-Based Assignment

You can automatically calculate a score for each lead, or determine an appropriate rank or qualify a lead using
rule based assignment. Assignment rules help ensure that sales resources are properly assigned to leads, and
leads are appropriately scored, ranked or qualified. Select from predefined attributes or configure custom lead
attributes to use in lead assignment rules.
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• Territory-Based Assignment with Rule Filtering

Territory-based assignment relies on an association between attributes on the lead work object and attributes
on the lead territory candidate object to match the candidates to the work object. For territory-based
assignment, the lead work object and lead candidate object must have attributes that share the same domain
of values.

Leads use Territory-Based Assignment to identify matching territories and then set up additional rules (Rule-
Based Assignment) to filter the final set of territories that are returned, using any attribute of the work object.

Lead Assignment Profile Options  
Lead assignment profile options are configurable options that affect assignment manager application operations.
Values defined at the user level take precedence over those at the site level. If a value isn't defined at the user level, the
site level value is used.

Lead Assignment
This table lists the profile options that affect the assignment of lead status, rank, score, resources, and territories on
the lead. Before setting these profile options, you must perform the tasks listed under Configure Assignment Manager
for Lead Processing setup task. From there you can review and update assignment of candidate objects such as rank,
qualification status, and resources to leads.

Profile Option Display Name Default Value Effect

Assignment Rule for Qualifying Leads (MKL_
LEAD_ASSIGNMENT_QUAL_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the lead status per rule conditions.
 

Assignment Rule for Ranking Leads (MKL_
LEAD_ASSIGNMENT_RANK_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the lead rank per rule conditions.
 

Assignment Rule for Rule-
Based Lead Assignment
(MKL_LEAD_ASSIGNMENT_MATCHING_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the sale team resources per rule conditions.
 

Assignment Rule for Scoring Leads (MKL_
LEAD_ASSIGNMENT_SCORE_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
a score per rule conditions.
 

Assignment Rule for Territory-Based Lead
Assignment (MKL_LEAD_ASSIGNMENT_RULE)
 

None
 

Specify the rule to evaluate the lead and further
filter territories derived using territory-based
assignment per rule conditions.
 

Lead Assignment Mode (MKL_LEAD_DEFAULT_
ASGN_MODE)
 

Both
 

Specify the default assignment mode type
allowed during on-demand or automatic lead
assignment. On-demand assignment occurs
when a user selects the assign lead action in the
UI.
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Profile Option Display Name Default Value Effect

Lead Batch Reassignment (MKL_LEAD_BATCH_
ASSIGNMENT)
 

N
 

Enable batch lead reassignment, in addition
to lead automatic reassignment. For example,
 when leads are selected for reassignment,
 they get reassigned when the Request Sales
Lead Assignments process next runs using the
Reassign process selection criteria.
 

Territory-Based Lead Assignment  

Considerations for Territory-Based Lead Assignment  
Territory-based assignment relies on an association between attributes on the lead work object and attributes on the
lead territory candidate object to match the candidates to the work object.

For territory-based assignment, the lead work object and lead candidate object must have attributes that share the
same domain of values.

Components That Affect Lead Assignment
Leads are ready for assignment once the data on the lead is cleansed, created, enriched, and scored. Here are the
components that influence the assignment of leads:

• Lead work objects

• Lead candidate objects

• Attributes

• Mapping and rule conditions

Mapped attributes are used for matching appropriate candidates for a work object. For example, a sales lead (work
object) has a geographic location attribute. The lead candidate object (territory) has also a geographic location attribute.
These two attributes are mapped to each other.

Leads, including leads with an associated existing account, and net new leads, are assigned based on several criteria as
outlined here. Net new leads are leads where the account and contact information remain on the lead until the lead is
qualified and converted.

Assignment criteria for leads Assignment criteria for leads with an
associated account

Assignment criteria for net new leads

Lead Source
 
Geography
 
Named accounts, such as the top 20
 
Industry
 
Product
 
Partner for working with a partner organization
 

Geography (Primary Address of the Account)
 
Named account
 
Industry - Customer/Organization Size
 
Organization Type
 
Auxiliary Classifications 1 - 3
 
Product
 

Geography (Contact Address on the Lead)
 
Industry
 
Organization Type
 
Product
 
Sales Channel
 
Primary sales channel associated with the lead
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Assignment criteria for leads Assignment criteria for leads with an
associated account

Assignment criteria for net new leads

Primary sales channel associated with the lead
 
Associated marketing campaign that generated
the lead
 

Business Unit
 
Partner for working with a partner organization
 

For example, lets take the following scenarios for a lead. A lead has either:

• A new Account where the CustomerId has a null value (no data) but other Account related fields such as
AccountName, OrganizationType, OrganizationSize, and so on, have values.

• An existing Account where the CustomerId has a non-null value (has data) as do the other Account related
fields.

• A new Contact where the PrimaryContactId has a null value (no data) but other Contact related fields such as
PrimaryContactName, JobTitle, PrimaryContactEmailAddress, and so on, have values.

• An existing Contact where the PrimaryContactId has a non-null value (has data) as do the other Contact related
fields.

The Sales Lead Territory: Mapping Sets subtab showing the Conditional Attribute column to indicate which mapping
set becomes active. Depending on the lead’s data, more than one mapping set becomes active to find and assign the
matching territories. You can select or deselect the Inactive check box to activate or deactivate any of the mapping sets.

If the account on a lead is removed, then no mapping set is active. However, the predefined mapping set won't remove
the territories assigned to lead. To replace the current territories assigned to a lead with another set on the next
assignment run, you must select the Replace Candidates check box from the Sales Lead Territory: Candidates subtab
on the Manage Sales Lead Assignment Objects page.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. On the Manage Sales Lead Assignment Objects page, locate and select Sales Lead in the Name column.
3. In the Sales Lead: Details region, select the Candidates tab.
4. Select the candidate object Sales Lead Territory and expand this row and check what's the current setting for

no rows matching.
5. Select Replace Candidates if you want to replace disqualified candidates on the team when the next

assignment request is run.
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How Leads Are Assigned
Leads can be assigned based on simple rules evaluation. Leads that have an associated account with an address are
distributed based on territory definitions. Territory-based evaluation can be supplemented by adding filtering rules to
further refine the lead assignment. Territory-based evaluation uses:

• Lead work object

• Territory candidate object data

• Mappings between the territory dimensions and lead dimensional attributes to execute the assignment
processing

Examples of Lead Assignment Setup
A default set of lead work objects and associated candidate objects are predefined. However, you can set up the
necessary lead work objects, and associated candidate objects, rules and mappings for assigning leads to suit your
business requirements.

• Set up rules and rule sets specific to your business requirements.

For example, set up an assignment rule to assign leads with deal size less that a certain amount to partners.

• Set up object mappings for territory-based assignment.

For example, assign a lead to those territories where Territory dimensional attributes are mapped to
corresponding Lead attributes.

• Set up rules to filter territories that match the lead based on additional information on the lead.

For example, set up rules to exclude prime sales territories that match leads which are unqualified.

Related Topics
• Overview of Lead Assignment

• Lead Assignment Rules

• Overview of Scheduling Lead Processing Activities

Lead Assignment Rules  
You specify assignment rules for leads to determine the rank, assign sales resources, calculate scores, and qualify leads.
This topic provides some examples of how assignment rules are evaluated. It also outlines some basic questions to
consider before creating rules.

Assignment rules are created using work objects, candidate objects, attributes, and conditions. You can use multiple
types of assignment rules and rule sets for assignment of candidates, such as rank, qualification status, and resources,
to the lead. For example, you can specify the assignment rule that assigns resources to sales leads by assigning
individual sales resources that meet the rule criteria.

When creating an assignment rule that uses a check box field, note that the value of true may be denoted by "Y" or
"Yes" or "T". Ensure the check box is clear is you want to denote a false value.
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Assignment Rule Criteria
An assignment rule can have one or more assignment criteria. For example, all leads, lower than a certain deal size and
for a specific product, are assigned to a specific Partner resource. Another example might include assigning only those
leads generated from a specific sales campaign, such as a CEO round table discussion event, to a specific salesperson.

Assignment Rule Considerations
When designing rules, carefully consider how you want to match the candidates to the lead. For example, would
you want resources assigned based on their geographic location, or their product knowledge, or their skill level, or a
combination of any of these attributes? Do you want to match candidates only, or would you like to match them and
score them to identify the best fit? In a multiple candidate scenario, do you want to assign all matching candidates or
only those who achieve higher than a specific score?

Note:  You can assign resources to leads only through rule-based assignment.

Related Topics
• Example of Using Territory-Based Assignment with Rule-Based Filtering

• Examples of Creating Assignment Rules

How Lead Status is Automatically Set  
Lead quality is assessed as soon as a lead is generated. This topic describes the settings that are used to determine the
qualification status of a sales lead. Lead quality of a newly created lead is based on:

• Characteristics of the customer contact on the lead

• Type of response which caused the lead to be generated

Lead quality is further assessed based on added qualification data such as customer need, urgency or time frame for
the project, and whether a budget is approved for the product.

Settings That Affect Lead Qualification Status
Leads can get their qualification status from:

• Assignment rules

Rules-based leads qualification process helps standardize the lead qualification process. Based on the positive
results to conditional rules, the value of the Lead Status attribute is set to Qualified. For example, a rule can be
defined to update the lead as qualified if the:

◦ Customer's budget status is approved

◦ Project time frame is three months

◦ Decision maker is identified

◦ Response type is that the customer attended an event

• An imported value

Leads imported through file import can include a designated lead qualification status.
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How Lead Qualification Status Is Calculated
In some companies, the lead qualification data gathered by lead qualifiers is considered in the scheduled automated
process that calculates lead score or lead rank as well as assigning sales team territories. For such companies, a simple
rule to move leads to a Qualified status when the lead score reaches a specific threshold is sufficient.

Examples of Territory-Based Lead Assignment  
You can assign leads to the appropriate territories based on matching lead attributes to territory dimensions.

This topic provides some examples of the relationship between the assignment of sales leads to territories. It also
contains examples of different dimensions used to assign sales leads to the correct sales territories.

A territory is the jurisdiction of responsibility of a sales resource over a set of sales accounts. Use territory-based
assignment to assign sales territories to leads.

Assign Territories to Lead Territory Team
You can set up Assignment Manager to automatically assign sales territories to the lead using territories defined in
Territory Manager. For example, a salesperson navigates to the leads list and opens the newly created lead. Using the
Reassign action, the salesperson accesses the assignment manager feature and selects an option to run automatic
assignment immediately to reassign the lead to the appropriate territories.

Territory-Based Assignment Mapping
You can leverage predefined territory-based assignment mappings to match the correct territories with each lead. For
example, you can map the location attribute on the lead to the geography attribute on the territory. Any territories
where the geography value matches the location of the lead is matched and assigned the lead.

Ensure you have defined your territory boundary based on dimensions. There's only one set of mappings for a work
object and candidate object combination. The mappings for various assignment scenarios (such as assignment of a
territory to a lead) must be setup through a mapping that assigns appropriate sales territories to a lead territory team.
If the lead needs rule-based assignment, then rule sets are used. If the lead needs territory assignment only, then the
rules may not be required.

Examples of Enabling Territory Dimensions
You can enable only the dimensions that your organization requires for defining territories. These examples illustrate
different dimensions used to assign sales leads to the correct sales territories.

Dimension Use

Geography
 

For most of your sales activities, you want to assign salespeople by city and postal code.
 

Account
 

You have a few key accounts that should belong to top salespeople. Use the account dimension to
create territories for individual sales accounts.
 

Customer Size
 

One product line is suitable only for organizations above a certain size, and you have a few skilled
salespeople for that product line. Use the customer size dimension to assign skilled salespeople to the
larger customers for the product line.
 

Industry
 

You sell one type of service to telecommunications companies, another service to utilities, and a third
service for insurance companies. You can create territories for each using the industry dimension.
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Dimension Use

 

Product
 

You sell a product line that requires salespeople to have a high degree of technical knowledge. Create
separate territories for this product line.
 

Sales Channel
 

Your sales department prefers to engage partners as indirect sales channel, and telesales functions in
addition to the direct sales force. You can create territories for these different sales channels such as
telesales, direct, and indirect sales channels.
 

How to Edit Auxiliary Dimensions for Lead Territory Assignment  
This topic is applicable for the lead assignment set up where you want to change auxiliary dimension mappings to point
to different classification codes as part of your lead territory assignment.

Here are the predefined auxiliary dimension work object attribute mappings:

• Aux1 - Auxiliary Classification Code 2

• Aux2 - Auxiliary Classification Code 1

• Aux3 - Auxiliary Classification Code 3

You now have a scenario where your organization wants to change these mappings. For this example, you want:

• Aux1 - Work Object attribute to point to Classification Code 3

• Aux3 - Work Object attribute to point to Classification Code 4

Set the Lead Territory Assignment Mapping
Here's how to change the mappings:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. On the Manage Sales Lead Assignment Objects page, locate and select Sales Lead in the Name column.
3. In the Sales Lead: Details region, select the Candidates tab.
4. Select the Sales Lead Territory candidate.
5. Select the Sales Lead Territory: Mapping Sets tab.
6. In the Name column, select Mapping Set 5 from one of these active mapping sets for the sales lead object you

want:

◦ Mapping Set 1

◦ Mapping Set 2

◦ Mapping Set 3

◦ Mapping Set 4

◦ Mapping Set 5

7. In the Mapping Set 5: Mappings region, locate and select the Aux1 and Aux3 auxiliary dimension function code.
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8. Click the pencil icon to edit them in the Edit Mappings dialog window.
9. In the Work Object Attribute region select these attributes.

◦ Aux1 - Auxiliary Classification Code 3

◦ Aux3 - Auxiliary Classification Code 4.

10. Click OK.
11. Click Save and Publish.
12. Monitor and refresh the page to confirm the publish process has succeeded.

The sales lead assignment processing is now ready to use the changed auxiliary dimension information when assigning
leads to territories.

Lead Assignment Scheduled Processes  

Overview of Scheduling Lead Processing Activities  
This topic outlines the lead processing activity that sets lead rank, score, and lead qualification status for a selected
batch of leads.

Lead data is generated from a variety of sources and goes through further enrichment based on updates and follow-up
activities. As a result, lead quality must be assessed periodically so that leads get distributed to the right salesperson to
ensure timely lead follow up and closure.

Note:  Privileges provide the access required to run specific scheduled processes. Privileges are granted to duty roles,
which are granted to job roles. To see which job roles inherit the required privileges, use the Security Console or the
security reference manuals for the appropriate product family. For example, to update Lead records, you need to be
granted the MKL_UPDATE_SALES_LEAD_PRIV privilege.

Leads are distributed to individual salespeople and sales territories for further qualification and follow-up. The Create
Lead Processing Activity page enables you to:

• Define and submit lead processing activities

• Search for and select specific leads to process

• Start or schedule the lead processing activity

Activity Details
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. The process type determines the type of activity you want to process such as:

• Lead assignment

• Qualification

• Ranking

• Scoring

Each type is associated with appropriate rule categories and assignment rules for the profile option used to activate
the lead processing activity, such as, Assignment Rule for Ranking Leads. For example, if you select lead ranking as the
process type, then rank assignment rules are used for processing the selected leads.

441



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

Lead Selection
You can use filtering criteria for selecting leads as input to the lead processing activity. For example, you can process
leads that are unassigned, or leads that have a status of qualified. The selected leads are processed (qualified, ranked,
scored, assigned) based on the corresponding assignment rules defined.

Schedule
Lead processing activities are scheduled for the purposes of periodic ranking, scoring, qualification, and distribution
of leads. Due to the periodic nature of all lead processing activities, it's necessary to automate the running of these
activities. Enter scheduling options such as schedule mode and frequency to determine when the lead processing
activity should begin and how often the activity is repeated.

Related Topics
• Batch Assignment Diagnostic Log

• Example of Running Lead Batch Assignment in Diagnostic Mode

• About Purging Batch Assignment Information

Example of Running a Lead Assignment Process  
This example describes running a lead assignment process twice. First, run the process to assign imported leads to
the inside sales representatives for lead qualification. Next, assign the qualified leads to field sales for conversion to
opportunities.

Here's how to create a lead processing activity to run the lead assignment process:

1. Search for and open the task Manage Lead Processing Activities from the Setup and Maintenance work area.

The Lead Processing Activities page appears. This page lists all of your processing activities.
2. Click Create Lead Processing Activity.

The Create Lead Processing Activity window appears.
3. To assign the leads you previously imported to inside sales for qualification, enter the parameters listed in this

table.

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Unqualified
 

Lead Selection
 

Assignment Status
 

Unassigned
 

Schedule
 

Schedule Mode
 

Immediate
 

4. Click Submit.
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5. Next, create and submit a second activity to assign the leads to field sales after the leads are qualified. Enter the
parameters listed in this table.

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Qualified
 

Schedule
 

Schedule Mode
 

Run this activity on a repeating schedule to
make sure the leads are transferred to field
sales as soon as they're qualified by inside
sales.
 
To run the activity regularly, select Repeats,
 enter a frequency, a start date, and an end
date far into the future. You must enter both
a start date and an end date for the process
to run.
 

6. You can monitor the processes on the Manage Lead Processing Activities page. This page lists all of your
processing activities.

Depending on your settings, your process runs immediately or at the intervals you specified. You can monitor its
progress by searching for the job set process by name on the Overview page.

You can also set up the process to run regularly per your business requirements as follows:

1. Click Advanced.
2. Click the Schedule tab.
3. Select the Using a schedule option.
4. Select the frequency and start date.
5. Enter an end date far in the future.
6. Click Submit.

Example of Running Lead Batch Assignment in Diagnostic Mode  
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. This topic provides an example of running lead batch assignment in diagnostic mode.

Running Batch Assignment
A sales representative of a company has to follow up on a lead but the lead hasn't yet been assigned to his territory.
He has requested you, the sales administrator, to investigate the details of territory assignment. You can provide these
details by running lead batch assignment in diagnostic mode.

1. Go to Navigator, and then select the Lead Qualification menu item.
2. Select Lead Processing Activities on the Tasks pane.
3. On the Lead Processing Activity page, click the Create Lead Processing Activity button.
4. On the Create Lead Processing Activity page:
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a. Select Assignment from the Process Type list.
b. Enable diagnostic mode by checking the Diagnostic Mode check box.
c. Search and select a lead. Note down the lead number value to use in a later step.
d. Select Immediate from the Schedule list.
e. Click Submit.

5. On the Confirmation dialog box, click OK.

Two process are submitted, one for lead territory assignment and the other for lead rule-based (or resource)
assignment. Note down the identifier of the territory or resource assignment processes you're interested in.

6. Click the Refresh icon until the process has completed successfully or with an error.
7. Select the appropriate territory or rule-based assignment process, and then click the Output log icon in the

View Log column to view details.

Open the log file in another browser window or tab.

Note:  The log file format is designed to be viewed in a browser application. If the log file is opened in another
application, such as Notepad, the format may not be optimal and the file may be difficult to read.

View the log file for details of the assignment processing for the selected lead. You can use the lead number recorded
earlier to search in the log file. Review the file for details of the assignment processing.

Related Topics
• Batch Assignment Diagnostic Log

Rule-Based Lead Assignment  

Lead Ranking  
When setting up lead management capabilities, you can predefine criteria to rank leads. You can define lead rank to
categorize leads into buckets such as Hot, Warm, or Cool. Although lead rank and lead score aren't the same, they serve
a similar purpose.

Create Ranking Rules
When a sales lead is created, a lead rank is first calculated based on assignment rules. The ranking classification rule
set type determines the rank of the lead based on the values of the attributes on the lead. These data points help to
evaluate lead ranking rules:

• All data included on the lead and lead primary product data

• All customer profile data including industry and customer size classifications

• All contact profile data

• All lead qualification data

Here's how you can set up a lead rank rule:

1. Navigate to the Setup and Maintenance work area and select Manage Sales Lead Assignment Rules task.
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2. Select the Sales Lead Ranking Rule Category.
3. Create a rule set with a rule set type of Classification Rule.
4. Set the work object as lead and the candidate object as lead rank.
5. Create a rule with conditions that match the attribute settings you want a lead to have to give it a rank value.

For example, you might select the Decision Maker Identified attribute name and then select the equal (=)
operator.

6. Enter the value of True.

Note:  When creating an assignment rule that uses a check box field, note that the value of true may be
denoted by "Y" or "Yes" or "T". Ensure the check box is clear is you want to denote a false value.

7. Create any other remaining conditions that you want, and then enter the action for your rule, such as Return
the candidate value as Hot.

Calculate Lead Rank Based on a Score
You can schedule when and how often to process lead ranking where the lead rank value or score is calculated and
displayed. Ranking rules determine what rank to assign to a lead. You can also create ranking rules that use the lead
score as the criteria to name each range of scores with a specific rank.

For example, if the lead score is between a value range of 0 and 39, you can create a rule to rank the lead as low priority.
If the lead score is between a value of 40 and a value of 60, then create a ranking rule that assigns a medium rank to
the lead. The assignment manager process passes the rank value to the lead management process and a rank value is
displayed as a list. You can override the value by selecting a different predefined rank code or value from the list.

Related Topics
• Example of Creating a Lead Ranking Rule

Example of Defining the Automatic Assignment of Lead Team Resources  
Using a scheduled process, you can automatically assign lead team members and appropriate sales territories to leads.
The scheduled process accepts criteria to determine the batch of leads to be assigned.

During the rule-based assignment phase of the batch process, matching candidates are automatically added to the lead
team. During the territory-based assignment phase of the batch process, territories are automatically added to the lead
territory team.

This example outlines how to set up lead assignment tasks and to schedule the tasks in sequence so that you can
automate the lead resource assignment process.

Scenario
The automotive sector uses geography data and overall lead quality to periodically assign leads to automotive dealers.
You can assign leads automatically by using score and rank criteria before being assigned a resource. Leads are
automatically assigned through the assignment manager feature by associating assignment criteria to assignment
rules. For example, leads are assigned based on the following criteria:

• Lead source

• Geography

• Lead score

• Named accounts, such as the top 20

• Industry
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• Products

When partners must engage with customers to ensure a timely sales follow up, set up assignment manager to
automatically assign partner leads to internal channel managers.

Manual Setup Assignment Manager Tasks
You can perform manual setup tasks through the assignment manager UI as follows:

• Define lead distribution rules

• Define partner matching rules

• Define the quality parameters to assign leads for follow-up activities

• Set up lead qualification rules

• Set up lead classification rules to assign leads to specific sales channels

• Set up lead routing rules to route leads to sales resources in a selected sales channel

• Set up lead distribution rules to assign leads to a specific salesperson or a partner sales territory

Use rule sets if you're assigning leads by rule-based assignment. If the lead requires territory-based assignment only,
then rule sets aren't used. During a lead import, either ranking or scoring is used as the default qualification criteria.
However, if scoring is used to determine the lead rank, then both lead score and lead rank can be used as criteria for
assigning lead resources.

Automatic Assignment Manager Tasks in Batch Mode
To automate assigning lead resources, schedule and sequence these tasks to occur in this order when assignment
manager runs in batch mode:

• Assign leads to a sales channel

• Route leads to sales organizations and sales territories

• Assign leads to individual salespeople or partners

You can also manually assign leads to specific internal or external resources. You can make these selections:

• Job type

• Rule set

• Filtering criteria for selecting lead

Examples of Sales Lead Team  
A sales lead team is made up of assigned territories and individual team members. Here are some examples that
illustrate some of the features available for the sales lead team.

• Automate assignment of individual resources to sales lead team

• Add ad hoc members to sales lead team

• Update access rights based on the resource

• Change the lead owner

Automate Assignment of Individual Resources to Sales Lead Team
The sales lead team for your company wants to add a support person to the lead. Typically, support people aren't part
of any sales territory. Use the Manage Sales Lead Assignment Rules task to set up a rule set for the category, Sales Lead
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Resource Rule Category. For example, assign support team members as individual resources based on rules which
match the lead product with specific support team members.

Add Ad Hoc Members to Sales Lead Team
Generally, sales team resources are automatically assigned to leads based on configured assignment rules. The
following scenarios provide examples of when you may want to manually add additional team members to assist with
the lead.

• The lead owner, who has full access to your company lead, wants to add one of his company's contractual
experts to his team to help pursue the lead. The lead owner manually accesses the resource drop-down list and
selects the ad hoc resource that he wants to add to his team.

• When pursuing a lead for an insurance policy, the customer contact requests a unique and complex
combination of policy components that require a review from an expert in the company. The lead owner
adds the expert resource to the lead with full access. Now, the expert resource can update the lead with valid
combinations of products and services, and, if required, add more team members to the team.

• A salesperson is pursuing a lead that requires the export of products outside the country. He wants to ensure
there are no legal issues with exporting the products. The salesperson adds a member of their company's legal
team to the lead to review the details before contacting the customer again.

Update Access Rights Based on the Resource
When a resource is added to the sales lead team through rule-based assignment, a profile option determines the
member's default access level. Resources in the management hierarchy of a newly added team member have the same
level of access to the sales leads as the team member.

All members of the sales territories assigned to the lead have full access to the lead. Owners of ancestor territories of all
sales territories assigned to the lead also have full access to the lead.

Change the Lead Owner
Only the lead owner, or the resources in the management hierarchy of the lead owner, can change the ownership of the
lead.

Related Topics
• How Users Gain Access to Leads

Example of Lead Score Calculation  
Use a lead score only when the lead is easily quantified. You might use the score to calculate the lead rank. You can
schedule when and how often to perform lead scoring.

Here's an example of how lead score is calculated.

How Lead Score Is Determined
To get a lead score, the rules engine needs to determine a numeric score based on the value of the lead attribute
participating in the rule. For example, consider this rule:

• If a lead contact is a high-level executive, then add a score of 100. If the lead contact is an operations manager,
then add a score of 50.
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When the rules engine evaluates the lead, it scores the lead based on the job title of the lead contact. After the rules
engine evaluates all such rules, the result of the scoring process is an aggregate score, that's then recorded in the Lead
Score attribute.

Data Points for Lead Scoring
These data points form part of the overall score evaluation:

• All data included on the lead and primary product

• Lead source data such as campaign attributes

• All customer profile data including industry

• All contact profile data

Example of Creating a Lead Ranking Rule  
You can define a lead rank to categorize leads into buckets such as Hot, Warm, or Cool leads. This categorization of
leads lets a salesperson quickly prioritize leads for follow-up activities.

Here's an example of creating a lead ranking rule:

Create a Lead Rank Rule
Your organization wants to assign a rank of Hot to sales leads that have a set time frame and a decision maker
identified. In Assignment Manager, there's already a predefined lead work object and lead candidate object.

Here's how to set up an assignment rule to determine the appropriate classification to apply a rank to all leads for your
organization:

1. From the Manage Sales Lead Assignment Rules page, select the Sales Lead Ranking Rule Category.
2. Select the classification rule type, Sales Lead work object, and Lead Rank as the candidate object.
3. From the Associated Rule Set Groups tab, create a ranking rule and name it Ranking. You can search and select

another rule set group (if one exists), to associate with the classification rule type.
4. Set the conditions for each rule that the rules engine checks during assignment processing. For example, enter

these rule conditions:

◦ Attribute: Time Frame

◦ Operator: Equals

◦ Value: Three months

5. Click Add Row icon in Conditions and enter these details:

◦ Attribute: Decision Maker Identified

◦ Operator: Equals

◦ Value: True

◦ Action: Return the candidate value as Hot

6. Click Save and Close.

The Assignment Manager:

• Finds the matching leads

• Executes the rules
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• Assigns the rank value to the lead

Related Topics
• Lead Assignment Rules

• Lead Ranking

Partner Assignment  

Overview of Assigning Territories to Partners  
Companies can have thousands of partners, so being able to quickly give users access to partner accounts and to the
leads and opportunities for those accounts is very helpful. You can use territory assignment to perform this task.

The available assignment types are:

• Batch assignment

• Manual assignment

You can use the following methods to determine assignment:

• Partner Account Belongs To: For attributes used to match against partner-centric coverage territories

• Partner Account Serves To: For attributes used to match against sales account-centric coverage territories.

You must be on the partner team with full access and have the Partner Account Maintenance or Administration Duty
role to perform manual and batch assignment.

All members of the internal territory, including owner and resources, have full access to the partner information. Users
with Partner Account Maintenance Duty or Partner Account Administration Duty can view territories assigned to a
partner account.

Batch Assignment
After partners are imported, partner accounts created in an import batch can be assigned using view criteria with the
Assign Territories to Partner Account assignment process. After territories are realigned, partner accounts that are
affected by the realignment are reassigned.

During the initial implementation, partner accounts can be created before any territories have been set up (for example,
as part of a migration). These accounts don't receive a territory assignment because no territories exist yet. They must
be explicitly assigned after territories are created. In this case, it's recommended that you run a batch assignment using
the view criteria "PartnersInABatchNeedingReassignment" to assign these accounts to territories.

Manual Assignment
For manual assignment, use the Assign Territories action available in the Edit Partner page. You must have the Partner
Maintenance Duty for the partner to use this action.

When you click the Assign Territories action, assignment processing begins and it returns a list of territories matching
the partner. You can save this list and make the assignment, or cancel and make no changes to the existing assigned
territories.
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Related Topics
• Assign Territories to Partners with Batch Assignment

Assign Territories to Partners with Batch Assignment  
This topic explains how to assign territories to partners using batch assignment.

Configure Batch Assignment
The following table shows the view criteria names and some example bind variable values to use when configuring
batch assignment.

View Criteria Name Bind Variable Value

PartnersOfAStatus
 

BindStatus=ACTIVE
 

PartnersCreatedInLastNDays
 

BindNumberOfDays=1
 

PartnersUpdatedInLastNDays
 

BindNumberOfDays=2
 

PartnersImportedInABatch
 

BindImportBatchId=11001
 

PartnersInACountry
 

BindCountryCode=
 
For example, the BindCountryCode for the United States is US.
 

PartnersBelongingToAnIndustry
 

BindIndustryBelongedTo=1000
 
Where 1000 is Industry Classification code.
 

PartnersWithAProductDim
 

BindProduct=Education
 

PartnersWithAGeographyDim
 

BindGeographyServed=Netherlands
 

PartnersWithIndustryDim
 

BindIndustryServed=Life Sciences
 

1. From the Tools area in Navigator, select Scheduled Processes.
2. On the Scheduled Processes page, click Schedule New Process.
3. On the Schedule New Process dialog box, click the drop-down arrow next to Name and then click the Search

link.
4. On the Search and Select: Name dialog, type Assign in the Name field and click Search.
5. Select Assign Territories to Partner Account from the returned list and click OK.
6. Click OK on the Schedule New Process dialog.
7. On the Process Details page, enter View Criteria Name and View Criteria Bind Values, then click Submit.
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8. The Scheduled Processes page appears. Notice that the Status is Scheduled. You can click the Log link to see
the log.

Overview of Manually Assigning Partners and Partner Sales
Credits in Opportunities  
You can manually add partners to or remove partners from the opportunity team. You also can assign nonrevenue sales
credit to partners in opportunities. Partner assignment and sales credit allocation follow specific rules.

Partner Assignment to Opportunities
Note the following behavior for partner assignment to opportunities:

• Partner resources cannot be removed from the opportunity team if they are receiving non-revenue credit on
the opportunity. To remove a partner, you must first remove the credit allocations he is assigned.

• When a partner organization is removed from the opportunity, and no resource from that partner organization
is receiving sales credit on the opportunity, all partner resources, if they exist, are automatically removed from
the opportunity team.

• Territories of type Partner or Partner Program are not assigned to opportunities.

• The resources list of values only displays partner resources whose partner organization is already associated
with the opportunity.

Sales Credits and Partners
Note the following behavior for partners receiving sales credit:

• Partner resources are only eligible to receive non-revenue credit on opportunity revenue.

• When selecting sales credits for partner resources, only partner resources whose partner organization is
associated with the revenue line are eligible for sales credits.

• Partner resources are not eligible for deal protection.

Assignment Reports  

Example of Generating Assignment Reports  
You can use the Diagnostic Dashboard to generate the following reports:

• Batch Assignment Progress Report

• Batch Assignment Error Report

• Territory Dimension Data Report

This topic explains how to generate a batch assignment progress report, as an example.
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Prerequisite: As a user with access to the Schedule Processes UI, such as the sales administrator, click Navigator, and
then click Scheduled Processes within the Tools heading. Run the batch assignment processes for sales accounts and
opportunities. See the topics, Recommendations for Assignment Processes for Opportunities, and Schedule Account
Assignment, for more information.

You must have the required job or duty roles to run diagnostic reports from the Diagnostic Dashboard. The setup
user created for you by the service is automatically provisioned with the required job role, Application Diagnostics
Administrator (which contains the required duty roles). Therefore, you can use this setup user (or another user that
you create and provision with this job role) to run the diagnostic reports. For details on how to add the duty roles to an
existing user, see DOC ID 1374930.1 on My Oracle Support (support.oracle.com). This article describes how to assign user
access to the Oracle Fusion Applications Diagnostic Dashboard.

Batch Assignment Progress Report
This section describes a scenario for running the batch assignment progress report. It takes you through generating a
batch assignment report and viewing the completed report.

Here's how to generate the batch assignment progress report:

1. Sign in as a user who has access to the Diagnostic Dashboard.
2. Click your user image or name in the global header.
3. Click Run Diagnostics Tests, within the Troubleshooting area.
4. On the Diagnostic Dashboard page, search for the report name you want to run. In this example, search for

Batch Assignment Progress Report.
5. Select Batch Assignment Progress Report and click Add to Run.

The Batch Assignment Progress Report is added in the Choose Tests to Run and Supply Inputs region.
6. Click the warning icon in the Input Status column, and enter the parameters in the Input Parameters page that

appears.
7. Click OK.
8. In the Choose Tests to Run and Supply Inputs region, enter a name in the Run Name field and click Run.
9. In the Confirmation dialog box, click OK.

The status of the report appears in the Diagnostic Test Run Status region.
10. Click the completed report to open the report page.

You can now use the report for your analysis. You can follow the same procedure to generate the Batch Assignment
Error Report and the Territory Dimension Data Report.

Batch Assignment Progress Report  
You can generate a batch assignment progress report to show you a variety of details about your assignment processes.

The batch assignment progress report indicates the number of records processed, unprocessed, successful or failed,
and the number of records processed per minute for a process. The report provides details of assignment processing
for multiple batch assignment processes and their sub-processes. You can run this report while a batch assignment
process (accounts, leads, opportunities, revenue, or partner accounts) is running, or after a process has completed.

Access the Diagnostic Dashboard to generate the batch assignment progress report. The report includes two tables, one
with details of the main process, followed by details of the sub-processes. The second table with sub-processes appears
only if the Include Sub Process parameter is set to True.

Input Parameters
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The report has the following input parameters:

Input Parameter Description

Parent Process ID
 

Identifiers for the parent scheduled processes.
 
You can enter multiple process IDs.
 

From Date
 

Select the start date.
 

To Date
 

Select the end date.
 

Include Sub Processes
 

Select True to include sub-processes. The default value is False.
 

Example Report

Here is an example of a batch assignment progress report, along with description of what each value means:

Column Sample Value Description

Parent Process ID
 

504
 

Identifier for the scheduled process
 

Work Object
 

SalesAccount_Work_Object
 

Code for the work object
 

Candidate Object
 

SalesAccountTerritory_Candidate_Object
 

Code for the candidate object
 

Submitted By
 

Sales_admin
 

User name of the person submitting the
process
 

Process Status
 

Running
 

Status of the process, such as, Not Started, In
Progress, or Canceled
 

Process Start Time
 

11/19/12 8:48 PM UTC
 

Start Time of the process. Shows date, hours,
 and minutes
 

Process End Time
 

11/19/12 8:56 PM UTC
 

End Time of the process. Shows date, hours,
 and minutes
 

Process Elapsed Time (Minutes)
 

22
 

Number of minutes the process has been
running
 

Records per Minute
 

10.46
 

Number of records processed per minute
 

Number of Sub Processes
 

10
 

Number of sub-processes launched from the
parent process
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Column Sample Value Description

Number of Records
 

100000
 

Number of records in the process
 

Number Not Processed
 

94452
 

Number of records not yet processed
 

Number Successful
 

5542
 

Number of records successfully processed
 

Number Failed
 

6
 

Number of records failed
 

Failure Rate
 

0.00006
 

Number of failures divided by the Number of
items
 

Assignment Elapsed Time
 

21.45
 

Number of minutes the assignment processing
has been running
 

Records Processed Last 10 Minutes
 

12.63
 

Number of records processed in the previous 10
minutes
 

Number of Retries
 

0
 

Number of times the process has been
resubmitted
 

You can also use the report to estimate the time it will take to complete a batch assignment process. This report
provides details on the number of records completed and the number of records in progress. You can generate this
report repeatedly to conduct performance analysis of the batch assignment processing.

Related Topics
• Example of Generating Assignment Reports

Batch Assignment Error Report  
Use assignment management functionality to generate batch assignment error report. The batch assignment error
report provides details of the error and warning messages generated while processing individual records during batch
assignment process.

The report provides a summary of the test input parameters and message details for each record that meets the input
parameters. You can run this report while a batch assignment process (accounts, leads, opportunities, revenues, or
partner accounts) is running, or after a process has completed.

Access the Diagnostic Dashboard to generate the batch assignment error report. The report shows the test parameters
followed by two results tables. The first table provides a summary of the process, and the second table shows details of
the records that meet the criteria entered when running the report.

Report Parameters

Here's a description of the input parameters used to generate the batch assignment error report.
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Input Parameter Description

Parent Process ID
 

Identifier for the parent ESS process.
 
You can enter only a single process ID.
 

Assignment Status
 

Enter the status of the assignment, such as, error, succeeded, and so on. The default is error.
 

Work Object Public Unique Identifier
 

This is optional. The value that you enter here will depend on the Identifier Attribute of the work object
being processed in a batch.
 

Range of Records
 

Enter the range of records in a process to report. The default value is the value set in the MOW_DTF_
ERROR_REPORT_MAX_LIMIT profile option.
 
You can change this profile option value in the Manage Administrator Profile Values setup task.
 

Example Report

Here's an example of the Process Summary section of a batch assignment error report:

Process Summary

Work Object Candidate Object Start Time End Time

SalesAccount_Work_Object
 

SalesAccountTerritory_Candidate_
Object
 

2013/2/11 12:13
 

2013/2/11 02:45
 

Here's an example of the Process Details section containing the records that meet the criteria entered when running the
batch assignment error report:

Work Object Public Unique Identifier Assignment Status Message Details

1243213
 

Successful
 

Not applicable.
 

1728224
 

Error
 

225030 MOW_AMENG_AO_ASSERT_ FAILED
An error occurred while loading assignment
object Sales_Account_Work_object. There's a
mismatch between the view object definition
in the assignment configuration and the actual
view object definition used during assignment
processing. Update and save the assignment
object to register it with the latest view object
definition.
 

1982663
 

Successful
 

Not applicable.
 

2392053
 

Successful
 

Not applicable.
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Use the batch assignment error report to check if there were errors in the batch assignment process and if a particular
work object record was processed.

Related Topics
• Example of Generating Assignment Reports

Example of Running Lead Batch Assignment in Diagnostic Mode  
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. This topic provides an example of running lead batch assignment in diagnostic mode.

Running Batch Assignment
A sales representative of a company has to follow up on a lead but the lead hasn't yet been assigned to his territory.
He has requested you, the sales administrator, to investigate the details of territory assignment. You can provide these
details by running lead batch assignment in diagnostic mode.

1. Go to Navigator, and then select the Lead Qualification menu item.
2. Select Lead Processing Activities on the Tasks pane.
3. On the Lead Processing Activity page, click the Create Lead Processing Activity button.
4. On the Create Lead Processing Activity page:

a. Select Assignment from the Process Type list.
b. Enable diagnostic mode by checking the Diagnostic Mode check box.
c. Search and select a lead. Note down the lead number value to use in a later step.
d. Select Immediate from the Schedule list.
e. Click Submit.

5. On the Confirmation dialog box, click OK.

Two process are submitted, one for lead territory assignment and the other for lead rule-based (or resource)
assignment. Note down the identifier of the territory or resource assignment processes you're interested in.

6. Click the Refresh icon until the process has completed successfully or with an error.
7. Select the appropriate territory or rule-based assignment process, and then click the Output log icon in the

View Log column to view details.

Open the log file in another browser window or tab.

Note:  The log file format is designed to be viewed in a browser application. If the log file is opened in another
application, such as Notepad, the format may not be optimal and the file may be difficult to read.

View the log file for details of the assignment processing for the selected lead. You can use the lead number recorded
earlier to search in the log file. Review the file for details of the assignment processing.

Related Topics
• Batch Assignment Diagnostic Log
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Example of Running Opportunity Batch Assignment in Diagnostic
Mode  
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. This topic provides an example of running opportunity batch assignment in diagnostic mode.

Run Batch Assignment
A sales representative of a company has to follow up on an opportunity, but the opportunity hasn't been assigned to
his territory. He has requested that you, the sales administrator, investigate the details of territory assignment. You can
provide these details by running opportunity batch assignment in diagnostic mode.

1. Go to Navigator, and then select Scheduled Processes.
2. Click Schedule New Process.
3. On the Schedule New Process page, click the Name drop-down list, and click Search.
4. On the Search and Select: Name dialog box, search for the Request Revenue Territory Assignment process.
5. Select the Request Revenue Territory Assignment process, and click OK.
6. On the Schedule New Process page, click OK.
7. On the Process Details page, enter the parameter values as shown in the following table:

Parameter Value

View Criteria Name
 

FilterByOptyNumber
 

View Criteria Bind Values
 

BindOptyNumber=XXX, where XXX is the opportunity number
 

Diagnostic Mode
 

Select the check box.
 

8. Click Submit.
9. Note down the process ID.

10. Close the page and search for the process using the process ID.
11. Open the log file in another browser or tab.

Note:  The log file format is designed to be viewed in a browser application. If the log file is opened in another
application, such as Notepad, the format may not be optimal and the log may be difficult to read.

View the log file to review information on the assignment processing, the matching territories found, matching
territories that were dropped because they were parent territories, and the final territories assigned.

Related Topics
• Batch Assignment Diagnostic Log
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Example of Running Account Batch Assignment in Diagnostic
Mode  
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. This topic provides an example of running account batch assignment in diagnostic mode.

Note:  Account batch assignment is usually run in diagnostic mode to find why an account isn't assigned to a territory.
For any view criteria applied in the diagnostic mode, the diagnostic will only be run for one account.

Run Batch Assignment
A sales representative of a company is due to meet with a new account he's now responsible for, but the account hasn't
been assigned to his territory. He has requested that you, the sales administrator, investigate the details of territory
assignment. You can provide these details by running account batch assignment in diagnostic mode.

1. Go to Navigator, and then select Scheduled Processes.
2. Click Schedule New Process.
3. On the Schedule New Process page, click the Name drop-down list, and click Search.
4. On the Search and Select: Name dialog box, search for the Request Account Assignments process.
5. Select the Request Account Assignments process, and click OK.
6. On the Schedule New Process page, click OK.
7. On the Process Details page, enter the parameter values as shown:

Parameter Value

Work Object
 

SalesAccount_Work_Object
 

Candidate Object
 

SalesAccountTerritory_Candidate_Object
 

Assignment Mode
 

Territory
 

View Criteria Name
 

RegistryIDVC
 

View Criteria Bind Values
 

RegistryIDs=XXX where XXX is the party number (also known as registry ID
 

Diagnostic Mode
 

Select the check box.
 

8. Click Submit.
9. Note down the process ID.

10. Close the page and search for the process using the process ID.
11. Open the log file in another browser or tab.
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Note:  The log file format is designed to be viewed in a browser application. If the log file is opened in another
application, such as Notepad, the format may not be optimal and the log may be difficult to read.

View the log file to review information on the assignment processing, the matching territories found, matching
territories that were dropped because they were parent territories, and the final territories assigned.

Related Topics
• Batch Assignment Diagnostic Log

Example of Running Partner Account Batch Assignment in
Diagnostic Mode  
You can run your batch assignment in diagnostic mode to view the details of the assignment processing in an output
log. This topic provides an example of running partner batch assignment in diagnostic mode.

Run Batch Assignment
A channel account manager of a company is due to meet with a partner account he's now responsible for, but the
partner account hasn't been assigned to his territory. He has requested that you, the sales administrator, investigate
the details of territory assignment. You can provide these details by running partner account batch assignment in
diagnostic mode.

1. Go to Navigator, and then select Scheduled Processes.
2. Click Schedule New Process.
3. On the Schedule New Process page, click the Name drop-down list, and click Search.
4. On the Search and Select: Name dialog box, search for the Assign Territories to Partner Account process.
5. Select the Assign Territories to Partner Account process, and click OK.
6. On the Schedule New Process page, click OK.
7. On the Process Details page, enter the parameter values as shown in the following table:

Parameter Value

View Criteria Name
 

QueryByCompanyNumber
 

View Criteria Bind Values
 

BindCompanyNumber=XXX where XXX is the partner number
 

Diagnostic Mode
 

Select the check box.
 

8. Click Submit.
9. Note down the process ID.

10. Close the page and search for the process using the process ID.
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11. Open the log file in another browser or tab.

Note:  The log file format is designed to be viewed in a browser application. If the log file is opened in another
application, such as Notepad, the format may not be optimal and the log may be difficult to read.

View the log file to review information on the assignment processing, the matching territories found, matching
territories that were dropped because they were parent territories, and the final territories assigned.

Related Topics
• Batch Assignment Diagnostic Log

Batch Assignment Diagnostic Log  
When you run batch assignment in diagnostic mode, an output log is generated with details of the assignment
processing. You can use these details to troubleshoot any issues with territory assignment.

The log helps you understand why certain leads or opportunities weren't assigned to your territories as expected. This
table provides an example of a lead batch assignment diagnostic run of territory-based assignment with rule filtering
for a lead. It includes an explanation of each section of the log.

Note:  Use the search feature in your log file to search on keywords, such as the error message number, for example
225203, to locate a specific section.

Example Log File Entries Description

The assignment processing is in diagnostic
mode. Assignment results won't be stored.
The following number of work objects will
be processed: 1.
 

Provides a summary of the assignment processing and the number of work objects to be processed.
 
You can change the number of work objects allowed to be processed in diagnostic mode through the
MOW_DIAG_MODE_WO_LIMIT profile option. The default setting is 1.
 

The process 63034 started at time Wed,
 July 13 05:48:54 and is processing the
following number of work objects: 1.
 
Work Object = Lead_Work_Object_Lead
 
Candidate Object = Territory_Candidate_
Object_Lead
 
Assignment Mode = Territory
 
View Criteria Name =
LeadAssignmentDiagnosticVC
 
View Criteria Bind Values =
BindLeadNumberDiag= 108970
 
Rule Category Name = ORA_Sales_Lead_
Territory_Rule_Category
 
Replace Team = true
 
Maximum Sub Processes per Process = 10

Lets you confirm the objects being processed in this batch, for example territories being assigned to
leads, the type of assignment processing, and the other parameters and their values relevant for this
batch process. Indicates the following:
 

• The process has started.

• Work object being processed and the candidates being found.

• Type of assignment processing:

◦ Territory is territory assignment

◦ Matching is assignment using rules

◦ Score is scoring

◦ Classification is ranking or qualification

• View criteria and bind value in leads which determine the set of leads that are included in this
batch assignment process.

• Diagnostic mode setting.
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Example Log File Entries Description

 
Metric Logging Interval = 0
 
Test Data Parameters =
 
Diagnostic Mode = true
 

Matching request for work object
Lead_Work_Object_Lead with the
identifier 108970 and candidate object
Territory_Candidate_Object_Lead is in
process. (MOW-225169)
 
Geography Identifier = 4,Customer
Primary Address=310 Park Ave SE Ste
2c5,OLYMPIA, WA 98504-0001
 
Party ID = 999997551079430
 
Lead Number = 108970
 
Customer ID = 999997551079430
 
Industry Classification code= 2900
 
Organization Size = VERY_SMALL
 
Organization Type = null
 
Geography Identifier = 15
 
Custom Account Indicator = null
 
Account = A. C. Network (Olympia, US)
 
Sales Account Type = NAMED
 
Sales Channel = ZPM_DIRECT_CHANNEL_
TYPES
 
OrgTp,Classification Code = A: PS-SL; T:
PS-SL
 
Primary Partner Identifier = null
 
Acct,Customer ID = 999997551079430
 
Prospect Account Indicator = null
 
Sales Account Indicator = Y
 
Auxiliary Classification Code 2 = OFN1
 
Auxiliary Classification Code 3 =
LANG-12113
 
Industry Classification Code = 2900
 
Auxiliary Classification Code 1 =
CORPORATION
 
Named Sales Account = Y

Provides a summary of the active assignment attributes and their values that will be used in the
processing of this lead.
 
Only a subset of these attributes may be used in the assignment processing of a lead, for example lead
ranking rule may only use the score and time frame attributes.
 

• Values for the work object.

• Attributes that are null.

• Attributes that indicate the type of lead being processed. For example, Sales Account Indicator =
Y

Use this information to confirm the data values for the work object that may be used in the assignment
processing.
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Example Log File Entries Description

 
Score = null
 

Assignment matching using mapping set
Mapping Set 1 is in process. (MOW-225185)
 
Assignment mapping values were
retrieved. (MOW-225211)
 
Function Code = Geo,Geography Identifier
= 4,Customer Primary Address = 310 Park
Ave SE Ste 2c5,OLYMPIA, WA 98504-0001
 
Function Code = CSize,Organization Size =
VERY_SMALL
 
Function Code = AcTyp,Sales Account
Type = NAMED
 
Function Code = Indst,Industry
Classification Code = 2900
 
Function Code = Acct,Customer ID =
999997551079430
 
Function Code = OrgTp,Classification Code
= A: PS-SL; T: PS-SL
 
Function Code = SChnl,Sales Channel =
ZPM_DIRECT_CHANNEL_TYPES
 

Shows the active assignment mappings that drive territory-based assignment for this lead. Also shows
the value for each mapping.
 
If an unexpected territory or set of territories has previously been assigned to the work object, then
confirm that this is the information you expected to be used for this lead.
 

Assignment mapping values were
translated to sequence values.
(MOW-225212)
 
Function Code = CSize,Translated values =
(7,7)
 
Function Code = Indst,Translated values =
(26,26)
 
Function Code = SChnl,Translated values =
(1,5)
 
Function Code = Acct,Translated values =
(999997551079430)
 
Function Code = AcTyp,Translated values
= (1,1)
 
Function Code = Geo,Translated values=(4,
WA),(999984000001036,Pacific),
(999984000001009,West),(1,United
States),(999984000000008,North
American Sales),(999984000000004),
(ANY)
 
Function Code = Prod,Translated values =
(1,999999999999999)
 

This section is relevant for Oracle Support to troubleshoot assignment issues.
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Example Log File Entries Description

Function Code = OrgTp,Translated values
= (77,77)
 

Candidate matches were identified. Post
processing is in progress. (MOW-225210)
 
The territory with the attribute name
Territory Number and attribute value
5377182 was deleted because it's a parent.
(MOW-225209)
 
The territory with the attribute name
Territory Number and attribute value
282312 was deleted because of an
exclusion. (MOW-225208)
 

Indicates that matching candidates were found and lists the matching candidates that were dropped
since they're either parent candidates or part of excluded territories.
 
If this lead was assigned previously and the territory you expected wasn't assigned, then review this list
of dropped territories. The territory might have been dropped because it was a parent territory and a
lower level territory under this also matched. Alternatively, this territory might have been excluded for
this lead (for example, a partner might have rejected this lead) or the territory might have an exclusion
coverage that contains the account on this lead.
 

The final matching candidates for
mapping set Mapping Set 1 were
identified. (MOW-225207)
 
Territory Number = 83,Territory ID =
100000013157305
 
Territory Number = 473,Territory ID =
100000013157417
 
Territory Number = 69095,Territory ID =
100100051383477
 
Territory Number = 496,Territory ID =
300100003212620
 
Territory Number = 95,Territory ID =
300100003282208
 
Territory Number = 45,Territory ID =
300100004466888
 
Territory Number = 233,Territory ID =
300100004466906
 

Shows the final list of matching territories.
 

Matching request for work object
Lead_Work_Object_Lead with the
identifier 142802 and candidate object
Territory_Candidate_Object_Lead is in
process. (MOW-225169)
 
Assignment processing using rule set RS12
is in progress. (MOW-225202)
 
Candidate matches were identified. Post
processing is in progress. (MOW-225210)
 
The final matching candidates for rule set
RS12 were identified. (MOW-225201)
 
The following number of candidates was
returned for the matching request for work
object Lead_Work_Object_Lead with the
identifier 142802: 63. (MOW-225170)

If territory-based assignment with rule filtering was used, this section shows the rule set processing.
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Example Log File Entries Description

 
The assignment of the following
number of candidates to work object
Lead_Work_Object_Lead with the
identifier 142802 is in process: 63.
(MOW-225167)
 

The existing candidates were identified.
(MOW-225200)
 
Territory Number = 335
 
Territory Number = 274
 
Territory Number = 32
 
The following number of existing
candidates were removed from the work
object Lead_Work_Object_Lead with the
identifier 142802: 13. (MOW-225181)
 
Territory Number = 274
 
Territory Number = 32
 
Territory Number = 220
 
Assignment disposition for work
object Lead_Work_Object_Lead with
the identifier 142802 is complete.
(MOW-225166)
 

If the lead was previously assigned, this section shows the existing territories as well as shows any
territories that no longer match and therefore are going to be removed from the lead.
 

The lead assignment post processing has
started.
 
The lead reassign value is set to N and
assignment status is set to Assigned as
part of lead assignment post processing.
 
The lead last assignment post processing
date and time is set at 2016-08-11
06:31:09.0.
 
The lead assignment post processing has
been completed.
 

Shows the leads post processing information, such as lead reassigned indicator is set to No, and that
the last assigned date and time is set.
 

Assignment matching using mapping
set Mapping Set 2 is in process.
(MOW-225185)
 
The mapping set Mapping Set 2 was
skipped as the conditional attribute
Primary Partner Identifier is blank.
(MOW-225206)
 

Shows the progress of assignment matching for a mapping set.
 
In this example, there are multiple active mapping sets and the next mapping set (for example,
 Mapping Set 2) has a conditional attribute defined. For this lead, this attribute doesn't contain a value,
 and so the territory matching for this mapping set isn't needed and therefore isn't performed.
 

Assignment matching using mapping
set Mapping Set 3 is in process.
(MOW-225185)
 

Shows the progress of assignment matching for a mapping set.
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Example Log File Entries Description

The mapping set Mapping Set 3 was
skipped as the conditional attribute
Prospect Account Indicator is blank.
(MOW-225206)
 

In this example, there are multiple active mapping sets and the next mapping set (for example,
 Mapping Set 3) has a conditional attribute defined. For this lead, this attribute doesn't contain a value,
 and so the territory matching for this mapping set isn't needed and therefore isn't performed.
 

Assignment matching using mapping
set Mapping Set 4 is in process.
(MOW-225185)
 
The mapping set Mapping Set 4 was
skipped as the conditional attribute
Custom Account Indicator is blank.
(MOW-225206)
 

Shows the progress of assignment matching for a mapping set.
 
In this example, there are multiple active mapping sets and the next mapping set (for example,
 Mapping Set 4) has a conditional attribute defined. For this lead, this attribute doesn't contain a value,
 and so the territory matching for this mapping set isn't needed and therefore isn't performed.
 

Assignment matching using mapping
set Mapping Set 5 is in process.
(MOW-225185)
 
The mapping set Mapping Set 5 was
skipped as the conditional attribute
SimlifiedLeadFlag is blank. (MOW-225206)
 

Note:
A sales lead is one where an existing
account and contact is associated to
the lead. A simplified lead is one where
the lead has either a new account or a
new contact associated with it. When
the flag SimlifiedLeadFlag is set to Yes
for a simplified lead, this means the
Mapping Set 5 becomes active.
 

Shows the progress of assignment matching for a mapping set.
 
In this example, there are multiple active mapping sets and the next mapping set (for example,
 Mapping Set 5) has a conditional attribute defined. For this lead, this attribute doesn't contain a value,
 and so the territory matching for this mapping set isn't needed and therefore isn't performed.
 

The total number of work objects
processed: 1. Number of work objects
successfully processed: 1. Number of work
objects failed: 0. (MOW-225127)
 

Provides summary of how many work objects were successfully processed and how many failed.
 

Related Topics
• Example of Running Lead Batch Assignment in Diagnostic Mode

Run Diagnostic Test for Territory Data Used by Assignment
Manager  
You can use territory management to generate a report that shows the dimension and sequence details for territory
dimensions defined for territories. Review the report to troubleshoot issues in territory assignment processing.

This topic explains how to run and generate this report, and shows an example of the report.

465



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

Run and Generate the Diagnostic Test Report
Here's how to run diagnostic test for territory data used by assignment manager:

1. Navigate to Territories.
2. Find the territories whose data you want to view and note down the territory numbers.
3. Click the Run Diagnostic Tests link from the Settings and Actions list.
4. On the Diagnostic Dashboard, search for Test for Data Used by Assignment Manager in the Test Name field.
5. Select the test and click Add to Run.
6. Click the Warning icon to enter the parameters.
7. On the Input Parameters dialog box, enter the parameters in the New Value field as shown in the following

figure.

Note:  If you're running the report for multiple territories, enter the territories without spaces. For example,
CDRM_300,CDRM_123,CDRM_43. If you enter spaces, the report is run only on the first territory.

8. On the Choose Test to Run and Supply Inputs dialog, enter the Run Name and click Run.
9. On the Test Run Submitted dialog box, click OK.

10. On the Diagnostic Test run Status, click the Report icon on the relevant report row.
11. Review the report details.

For further assistance with troubleshooting, share the report with Oracle Support, along with the assignment diagnostic
log files.

About Purging Batch Assignment Information  
When a batch assignment job runs, it creates data as part of the assignment process. Once the job completes, the data
is no longer required and can be purged.

The scheduled process Purge Batch Assignment Information is used to purge the batch assignment tables
based on set parameters. A batch assignment process creates data in two tables: MOW_BATCH_ASGN_JOBS
and MOW_BATCH_ASGN_JOB_ITEMS. With time, records in these tables grow substantially, especially with large
implementations. The purge batch assignment information process clears old records for successfully completed
processes. The process purges data for batch assignment processes for leads, opportunities, accounts, and so on.
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Run this process periodically or as needed. The process has only one parameter Days to Keep. The default value is 30.

Specify the number of days worth of assignment batch job and data to keep until the next purge. For example, if you set
the parameter to 15, the process removes all rows related to successfully completed processes in the batch assignment
data table that were created before 15 days from the current date.

Territory Dimension Data Report  
The territory dimension data report identifies the volume of territory data for each territory dimension and coverage
type. You can use information from this report to determine the sequence for each assignment mapping and optimize
assignment performance.

You must run this report only after you have created and activated your production territories.

Access the Diagnostic Dashboard to generate the territory dimension data report. The report shows the number of
denormalized customer account-centric and partner-centric territory records for each territory dimension and coverage
type. The function code field is used to specify a unique identifier for the attribute. Where dimensional territory
coverage isn't defined, the report shows the counts for inherited customer and partner inclusions and exclusions that
are manually defined.

This table shows an example of a territory dimension data report:

Function Code Count for INCLUSION Count for EXCLUSION Count for PARTNER_
REGULAR

Count for REGULAR

AcTyp
 

7
 

3
 

16
 

305
 

Acct
 

0
 

0
 

16
 

313
 

Aux1
 

7
 

3
 

16
 

385
 

Aux2
 

7
 

3
 

16
 

385
 

Aux3
 

7
 

3
 

16
 

385
 

CSize
 

7
 

3
 

13
 

336
 

Geo
 

7
 

3
 

2
 

4
 

Indst
 

7
 

3
 

14
 

268
 

OrgTp
 

7
 

3
 

14
 

374
 

Prod
 

2
 

3
 

16
 

171
 

Prtnr
 

7
 

3
 

16
 

385
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Function Code Count for INCLUSION Count for EXCLUSION Count for PARTNER_
REGULAR

Count for REGULAR

Schnl
 

7
 

3
 

16
 

259
 

Once the report is generated, you must identify the sequence of mappings as follows:

1. Copy the report to a spreadsheet.
2. Sum up the count for inclusion, exclusion, partner_regular, and regular for each function code.
3. List the function codes in order from lowest total count to highest.

After you list function codes from lowest count to the highest, the report table should look like this:

Function Code Count for INCLUSION Count for EXCLUSION Count for PARTNER_
REGULAR

Count for REGULAR Total Count

Geo
 

7
 

3
 

2
 

4
 

16
 

Prod
 

2
 

3
 

16
 

171
 

192
 

Schnl
 

7
 

3
 

16
 

259
 

285
 

Indst
 

7
 

3
 

14
 

268
 

292
 

Acct
 

0
 

0
 

16
 

313
 

329
 

AcTyp
 

7
 

3
 

16
 

305
 

331
 

CSize
 

7
 

3
 

13
 

336
 

359
 

OrgTp
 

7
 

3
 

14
 

374
 

398
 

Aux1
 

7
 

3
 

16
 

385
 

411
 

Aux2
 

7
 

3
 

16
 

385
 

411
 

Aux3
 

7
 

3
 

16
 

385
 

411
 

Prtnr
 

7
 

3
 

16
 

385
 

411
 

With this information, you can now update the sequence for each assignment mapping. The function code with the
lowest total count, Geo in this example, should be updated to have the sequence 1. The next lowest total count, Prod in
this example, should have sequence 2, and so on. You must update the sequence similarly for every mapping in each
mapping set, for every work-object and candidate-object combination.
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Related Topics
• Example of Generating Assignment Reports

FAQs for Assignment  

Frequently Asked Questions (FAQs) for Assignment  
This section contains the most frequently asked questions (FAQs) when setting up Assignment. Scroll or search to find
answers to common questions.

What's the difference between rule-based and territory-based
assignment?  
Territory-based assignment is the primary means of assignment for your sales application objects, such as accounts,
leads, and opportunities. For territory-based assignment, while creating the assignment object, you create work object
to candidate object mapping sets that are used to make candidate assignments.

You can use rule-based assignment to identify supplemental resources or filter the matching territories. You can also
use rules to score work objects and for classification. For rule-based assignment, you use the rules editor to create
expression-based rules that the assignment feature uses to make candidate assignments.

In a territory-based assignment scenario, you typically create a mapping set between a work object and a candidate
object to make the appropriate candidate assignment. This mapping set can consist of one or more mappings between
the work object attributes and the territory candidate object attributes.

In a rule-based assignment scenario, you create rules with conditions that must be met to make the appropriate
resource assignments. For example, a rule is created with the condition that when the opportunity risk level is high, a
resource located in the state of California is assigned.

Related Topics
• Examples of Creating Assignment Rules

What happens if I mark an assignment object or one of its
attributes as inactive?  
When you mark an assignment object as inactive, the selected work or candidate assignment object isn't available for
assignment processing. When you mark an assignment attribute as inactive, the selected work or candidate object
attribute isn't available for assignment processing.

469



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 14
Work Assignment

Note:  The object or attribute can't be set to inactive if there is a mapping set, mapping, or rule defined using the
object or attribute.

How can I display workflow notifications for Assignment Manager
batch process jobs?  
You can display object workflow notifications for assignment manager batch jobs to alert you of job completions for
your specified assignment manager objects.

Change the Suppress Events for Assignment Processing in Batch Mode (ORA_MOW_ASGN_SUPRESS_EDN_EVENTS)
profile option value to N at both the site and product levels for your selected sales objects. This profile option applies
only to email notifications that are sent as part of Assignment Manager workflow tasks. Bell notifications aren't affected.
The current value is set to Y which hides all batch assignment process workflow notifications.

You can choose to turn on or off this profile option at the product level. For example, you might want to have workflow
notifications for all Opportunity batch assignment jobs but want to hide all notification for batch Account assignment
jobs. Note that the workflow notifications can't be suppressed if the assignment is processed using the Run Assignment
option from the UI.

You can find additional information about profile options in the related topics.

Related Topics
• Set Profile Option Values

When are territories assigned to accounts?  
Internal territories are assigned to accounts in the following scenarios.

• When accounts are created.

• When a sell-to address is added to an existing sales party.

• When accounts are imported in bulk.

• When certain attributes on accounts that correspond with territory assignment dimensions are updated.

• When batch assignment is run.

• When you select the Assign Territories menu action on the Sales Account Team node for the account

• When territories are realigned or when personnel leave the territory or the company.

• When a sales manager reassigns all of the sales representative's account to a different owner that triggers the
reassignment of territories for those accounts to the new owner.
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Note:  The following profile options determine whether territory assignment and reassignment is automatic for
accounts. The default setting for both is YES.

• Sales Account Automatic Assignment on Create Enabled

• Sales Account Automatic Assignment on Update Enabled

Automatic assignments are always enabled following an import, party merge and territory realignment. During initial
implementation and migration, it's possible to create accounts before territories have been set up in the application.
These accounts won't receive any territory assignment because there are no territories. These accounts need to
be explicitly assigned when territories are configured and activated in the application. This is one exception which
doesn't have immediate/automatic assignment. The recommendation is to run a batch assignment to assign these
accounts created at the beginning of the implementation using the view criteria SalesAccountsUpdatedSinceVC.

When you make a field conditionally required on an account, then add the following groovy script before adding your
business logic:

if (userName=='FUSION_APPS_CRM_SOA_APPID'|| userName()=='FUSION_APPS_CRM_ESS_APPID')
return false

Partner territories get assigned to accounts in the following scenarios.

• When a partner-generated lead is approved, all partner territories associated to the partner-generated lead are
automatically assigned to the account.

• Users with the privilege Manage Sales Party Partner Territory can assign partner territories from the account
team UI.

Note:  Territory Management must be implemented to use this feature.

Related Topics
• Overview of Account Assignment Profile Options

• Account Territory Member Access

• How can I add territories to an account?

• Account Team Member Access Levels

How can I add territories to an account?  
Sales assignment capabilities match territories and accounts based on assignment setup. An account can also be
assigned to one or more internal and partner territories.

You can assign internal territories, such as Prime, Overlay, as well as Sales Channel Manager territories, matching
a given account's assignment attributes, to the account. By default, Internal territory assignment runs immediately
and automatically whenever account assignment or reassignment is required. For example, you can run assignment
processing when you create or update an account.

You can run territory assignment when viewing or editing your accounts. Just navigate to your account details, verify
relevant attributes like address, industry, and so on, and run the assignment process manually using the Actions button.
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Additionally, you can run account assignment in a batch on a scheduled or one off basis, or following a territory
realignment.

Partner territories are applicable to sales partner management implementations. When you approve a partner lead, any
partner territories associated to the lead are automatically assigned to the lead's account. Channel managers can also
select specific partner territories to assign to an account with the Add Partner Territories action on the Account Team
page.

Note:  You can also enable automatic assignment of imported accounts. See the related topics for more information.

Related Topics
• When are territories assigned to accounts?

• Schedule Account Assignment

• How Dimensions Define Territories

Can I use Rule-Based Assignment (RBA) to assign resources for
Accounts?  
No, rule based resource assignment for Accounts isn't supported. Rule-based assignment can be used to assign
resources to opportunity and lead teams.

Use territories to assign resources and secure access to accounts. Alternatively, create custom access groups and add
resources as members, and then define the rule or rules that assign an access group to each account.

Why is my Territory assignment job taking more time than usual to
complete?  
The time taken by a job depends on the number of records affected in an assignment. The job may run slow due to the
latest changes in the territories that caused more accounts to be eligible for re-assignment.

Always run the full assignment after making territory changes and allow the job to complete. The first run with a full
assignment may take a long time. However, the subsequent runs end faster than the initial full assignment run.

How are territories assigned to opportunities?  
You can't explicitly add territories to an opportunity. Rather, the assignment engine automatically assigns territories
to opportunity product lines by matching the dimensional attributes of product lines to territory dimensions, such as
Customer Size or Industry.

When the assignment engine assigns territories to opportunity product lines, the territory owner is also copied to the
opportunity team.
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Profile options set by the administrator determine the following:

• Whether, when a territory is assigned to an opportunity product line, all territory team members are also copied
to the opportunity team, in addition to the territory owner.

• Whether the assign opportunity action is available from within an opportunity for salespeople to run
assignment.

• Whether the application runs assignment when salespeople save an opportunity.

Note:  With partner integration, partner territories (territories whose sales channel dimension is equal to Partner)
aren't assigned to product lines. Partner organizations can only be associated with an opportunity manually, or they
can be automatically associated through an approved lead registration.

Related Topics
• About Sales Resources and Opportunity Assignment

• Overview of Territory Account Assignment

How do I assign team members automatically to an opportunity?  
While editing an opportunity, from the Actions menu, select Save and Run Assignment.

You must have Full access to the opportunity to see the Save and Run Assignment action.

Tip:  You can view assigned territories and the associated territory team members on the opportunity team in the
opportunity Team pages.

Related Topics
• Why can't I assign an opportunity?

How can I manually add territories to an opportunity?  
You can manually assign territories to one or more additional salespeople on a product line in order to allow another
salesperson working the deal to forecast it in his territory.

Manual assignment may be required, for example, to even out a temporary unbalanced load between salespeople
reporting to a manager, or to accommodate a salesperson on extended vacation. You manually assign territories in the
assign sales credit screens or in the details of the revenue line by using the territory list of values.

You must have the Sales Administrator job role to perform manual territory assignment on opportunities.
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Which fields in an opportunity drive assignment?  
The following fields drive opportunity assignment: Account, Sales Channel, Product, and Partner (for assigning partner-
centric territories).

Other, peripheral, account and partner attributes also drive assignment, but aren't captured or displayed in the
opportunity. Examples of these other attributes include: Primary Address (Geography), Named/Not Named (Account
Type), Industry, Organization Type, Partner Type, Organization/Customer Size, and the Auxiliary 1-3 Classifications.

Why can't I assign an opportunity?  
You must have Full permission on an opportunity to see the Save and Run Assignment action.

Note that a profile option determines whether the assignment action is available in opportunities.

Related Topics
• How do I assign team members automatically to an opportunity?

What's lock assignment?  
The Lock assignment check box is automatically selected when you run a manual assignment from the UI. Lock
assignment prevents a salesperson from being automatically removed from an opportunity through the assignment
engine.

Only users with Full access on the opportunity can select or deselect the Lock Assignment check box for sales team
members. Resources are assigned automatically to an opportunity during an automatic assignment process or through
a groovy script.

When the lock assignment is selected, an automatic territory assignment can't remove any sales account team
resources or team members. If the lock assignment is deselected, team members may be replaced if they no longer
match the assignment rules.

Note:  The Lock Assignment check box is not available by default and must be added to the Team subtab within the
Edit Opportunity page using Application Composer. See the related links for more information.

Related Topics
• Extend Pages for Opportunities

• Example of Extending Pages for Opportunities Using Application Composer
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What's deal protection?  
With the deal protection feature, all salespeople are automatically protected from being removed from a product line for
which they're receiving sales credit, or from the opportunity team, when territory realignment happens.

Deal protection applies to sales resources that get automatically assigned to product lines as credit recipients or to the
opportunity team using territory-based assignment.

A profile option set by the administrator specifies the default number of days for which salespeople are protected. An
opportunity team member with Full access level can override the dates for which the protection is active.
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15  Accounts and Contacts

Overview of Accounts and Contacts  
After you enable the capabilities of account data management, salespeople can use their Accounts pages to manage
their sales accounts. The sales account information includes their customers, prospective customers, and individual
contacts.

Here's what salespeople can do with the account data management capabilities:

• Create and update accounts, prospective accounts and contacts.

• Maintain account data and view data in hierarchical fashion.

• Enrich customer data.

Use the customer data management capabilities to:

• Prevent and identify duplicate data: Administrators identify duplicates during real time or in a preconfigured
batch. They search and match real-time accounts and contacts to prevent the creation of duplicate data.
Potential duplicate data is identified based on preconfigured matching configurations.

• Verify and standardize addresses: Administrators perform real-time and batch address cleansing for account
or contact address information. They verify and cleanse addresses within an import batch during import.
Address validation is used in context of master geography data, address cleansing in context of Customer Data
Management, address cleansing batch and address verification in real-time on account or contact pages.

• Resolve duplicate data: Administrators merge and link duplicate records to create master records that are the
single source of truth. They can de-duplicate within an import batch and within the entire database. Customer
data management uses a data quality engine to consolidate high-quality account and contact data from
multiple sources, manage duplicate data, enhance data with third-party content, standardize addresses, and
monitor data quality. These data quality checks ensure cleansed, enriched, and complete customer information
that can be trusted by the sales team.

Note:  A competitor is an Account with Competitor party usage. Thus, every time a competitor is created or updated,
servers scripts run, as defined for the Account object. If you don't want the account triggers to execute during the
competitor flow, then adjust the Groovy server scripts in the Account object to not execute in the case of Competitor
party usage.

For more details on the implementation of customer data management, see the Implementing Customer Data
Management for CX Sales and Fusion Service guide. Also see the accounts topics in the Implementing Sales guide.

Data Management  

Enable Display of Multiple Addresses  
The edit pages for accounts, contacts, households, and partners automatically display a primary address region.
However, you can change the view to display a table that lists multiple addresses.
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How Address Details Display
Address details for accounts, contacts, households, and partners display on their respective Profile subtabs in edit
mode.

The Primary Address region displays on the Profile subtab for an account record. This is the default view of address
details. Use Application Composer to display multiple addresses instead of just one primary address region.

Considerations for Configuring Address Display Tables
Consider these points before you let the table display multiple addresses.

• In Application Composer, you must ensure that only one of the address regions is exposed at a time in the
Detail pages layout. For example, expose Primary Addresses or Multiple Addresses on the page, but not both at
the same time.

• The default type for Address is bill-to. You can configure the default address type using Default Address Type
for Account and Default Address Type for Contacts profile options.

• An account can have one or more sell-to addresses (or address type as sell-to). Account territory assignment is
based on the primary address, and the primary address can be any type, such as sell-to or bill-to.

• The default type when creating an account is Prospect. You can change the default type using the Account Type
Default profile option. Similarly, you can use the Contact Type Default profile option to configure the default
type when creating a contact.

Enable the Multiple Addresses Table
Use this procedure to enable the table that displays multiple addresses:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand the object whose pages you want to

modify. For example, select the Account object.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected for either the account, contact, household, or partner object.
6. In the Details Page Layouts region, edit the relevant layout.

If none exists, then duplicate the standard layout using the duplicate layout icon, and edit the resulting layout.
7. In the Details Layout page, click the Profile tab.

In the Primary Address region and Multiple Address region, do one of the following:

a. Click Hide to hide the region at runtime.
b. Click Show to show the region at runtime.

For example, to enable the display of multiple addresses, click Hide in the Primary Address region, and
click Show in the Multiple Address region.

8. Click Save and Close, then Done.
9. Publish the sandbox according to your company's business practices.
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Enable Address Usage Types for Accounts  
You can assign usage types, such as bill to, sell to or ship to, to the account addresses. For that you must enable the
Type field in the Creation layout of the Address page.

You can assign address usage types to the following account types:

• Account

• Contact

• Household

The following address usage types can be assigned:

• Bill to

• Ship to

• Sell to

Enable Address Usage Type on Creation Layout

Here are the steps to enable the address usage type on the Creation Layout:

1. Ensure you're working in an active sandbox.
2. Go to Application Composer > Objects > Standard Objects > Address > Pages.
3. In the Application Pages tab, click the duplicate icon under the Creation Page Layouts section.
4. In the Duplicate Layout window, give a name to the custom layout and click Save and Edit.
5. On Creation Layout, click the edit icon beside Create and Edit Address.
6. Under Configure Detail Form, select Type from Available Fields and move it to Selected Fields.
7. Click Save and Close.
8. Publish the sandbox. Salespeople can now see the Type field that shows the three address usage types in the

Create Contact page. They can mark a contact address as Bill to, Ship to, or Sell to, based on the usage of the
address.

Set a Default Address Usage Type
You can set one of the address usage types (Bill to, Sell to, and Ship to) as a default value for the Type field shown in the
Create and Edit pages of Accounts, Contacts, and Households, using these profile options:

• Default Address Type for Accounts (ZCA_ADDRESS_PURPOSE_DEFAULT)

• Default Address Type for Contacts (ZCA_CONTACT_ADDRESS_PURPOSE_DEFAULT)

• Default Address Type for Households (ZCA_HOUSEHOLD_ADDRESS_PURPOSE_DEFAULT)

Let's look at the steps to add a default address type for Accounts. The procedure is same for the other profile options.

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
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2. On the Manage Administrator Profile Values page, search for the profile option code,
ZCA_ADDRESS_PURPOSE_DEFAULT.

3. Choose a suitable profile value for Site: Bill to, Sell to, and Ship to. Save the changes.
4. Sign in again for the changes to take effect.

Configure Address Regions  
You can configure the primary address region or multiple address regions for accounts and contacts. You can add or
remove custom fields or standard fields (such as Type, D-U-N-S Number, Site Name, Site Number, and so on) in the
address region.

Use the Address object in Application Composer to make the changes.

Note:  You can add or remove custom fields or standard fields in the address region using the Application Composer.
We recommend that you don’t use the Page Composer for this purpose.

Location-specific fields (such as Address Line1, Address Line2, City, State, Postal Code, and so on) need to be managed
using the Manage Address Formats task in Setup and Maintenance. The fields configured in the Manage Address
Formats can't be managed using the Application Composer.

When creating or editing accounts or contacts, salespeople can't save addresses by entering only address fields, without
entering location-specific fields. This rule applies to both standard and custom mandatory attributes on the Address
object that were exposed using Application Composer.

Set Up the Mapping Service for Contextual Addresses  
A contextual address is marked with an orange triangle, the More icon. When users hover over the triangle, an icon
appears, which they can click to display the address on a map.

Set Up Mapping Service
You can specify the mapping service to be used to display the map.

1. In the Setup and Maintenance work area, go to the Manage Application Toolkit Administrator Profile Values
task in the Application Extensions functional area.

2. Search for the Mapping Service for Contextual Addresses (ATK_CONTEXT_ADDRESS_MAP_OPTION) profile
option.

3. In the Profile Values section, enter a full URL of a mapping service in the Profile Value field.

CAUTION:  By default, the Profile Value field is blank. Until you enter a valid value for this profile option,
users continue to get an error when they try to open a map for any contextual address.

Here are a few examples of mapping service URLs:

◦ http://maps.google.com/maps?output=embed&q=

◦ http://maps.live.com/default.aspx?where1=

◦ http://bing.com/maps/?v=2&encType=1&where1=
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Tip:  You can include parameters in the URL. For example, to avoid a locator box in Google Maps, you can add
&iwloc=&amp; to the URL. So, the mapping service URL you would enter in the Profile Value field is:  http://
maps.google.com/maps?iwloc=&amp;&output=embed&q=

Related Topics
• Set Profile Option Values

• Why can't I see the map for contextual addresses?

Display Account Currency for Opportunities on Account Overview
Page  
The opportunity summary box on the account overview tab displays the total amount of open opportunities in the
corporate currency by default. However, for salespeople to view the amount in the currency where that account is
located, you must perform a few setup steps.

Salespeople can associate the currency when they create an account. Theycan also view and update the currency from
the edit account profile tab.

Here are the high-level setup steps:

1. Opt-in to the feature using the Change Feature Opt In link.
2. Set the profile option Use Object Currency for Account to Yes. The default value is No.
3. Add the currency field to the create and edit account pages using Application Composer.

Here's how to opt in and change the profile option.

1. Sign in as a setup user.
2. In the Setup and Maintenance area, go to the Sales offering.
3. Click the Change Feature Opt In link in the Functional Areas row.
4. On the Opt In: Sales page, click the pencil icon in the Features column in the Accounts and Contacts row.
5. On the Edit Features: Accounts and Contacts page, select the Enable check box for Use Account Currency for

Opportunity Summary on Account Overview Page feature.
6. Click Done.
7. Click Done  on the Opt In: Sales page and return to the Setup: Sales page.
8. To change the profile option, go the following:

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

9. Search for the profile option, Use Object Currency for Amount in the Profile Display Name field.
10. Select Yes in the Profile Option Value field.
11. Click Save and Close.
12. Enable the currency field on the create account page and the account profile tab using Application Composer.
13. Verify that the currency field is enabled on the create account and the edit account pages.

Enable the Currency Field
Enable the currency field on the create account page and the account profile tab using Application Composer.

1. In an active sandbox, click Navigator > Configuration > Application Composer.
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2. In the Objects navigation tree, expand Standard Objects, Account, click the Pages node and ensure that the
Application Pages tab is selected.

3. Edit the creation and details layouts to open the Configure Detail Form page. Here's how you edit the layouts.
a. On the Creation Page layouts region, duplicate the standard layout by highlighting the standard layout

and clicking the duplicate icon.
b. Enter a new layout name and click Save and Edit.
c. On the Creation Layout page, click the Edit icon.
d. On the Details Layout page, click the Profile subtab for the field to display on the profile page.
e. In the Subtabs Region, click the Edit Summary Subtab icon.

4. On the Configure Detail Form page, move Currency from the Available Fields window to the Selected Fields
window.

5. Click Save and Close.
6. On the Details Layout page and the Creation Layout page, click Done.

Resolve Duplicate Records  
This feature lets salespeople resolve duplicate records when creating accounts and contacts.

When duplicate accounts or contacts are found, they're displayed on the Notifications page. When salespeople create a
record, they can either ignore the duplicates or select the correct record from the list.

Search Deduplication
When creating an account or a contact, duplicates are found based on one of these conditions:

• Data quality management configuration for accounts and contacts

• Exact name match profile options

Here's a list of profile options for account and contact deduplication.

Profile Option Code Profile Display Name Description

ZCM_ACC_DUP_NOTIFICATION
 

Show Duplicate Account Notification
 

Controls the display of the account duplicate
notification page. Enabled by default.
 

ZCM_CON_DUP_NOTIFICATION
 

Show Duplicate Contact Notification
 

Controls the display of the contact duplicate
notification page. Enabled by default.
 

ZCM_ACC_EXACT_NAME_MATCH
 

Exact Account Name Match
 

Controls the display of potential duplicate
accounts based on an exact name match, when
Oracle Enterprise Data Quality doesn't present
duplicate accounts. Disabled by default.
 

ZCM_CON_EXACT_NAME_MATCH
 

Exact Contact Name Match
 

Controls the display of potential duplicate
accounts based on an exact name match, when
Oracle Enterprise Data Quality doesn't present
duplicate contacts. Disabled by default.
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Note:  If data quality isn't configured in your application and you require an exact name only match, then you must
enable the ZCM_ACC_EXACT_NAME_MATCH and ZCM_CON_EXACT_NAME_MATCH profile options.

How Account and Contact Deduplication Is Performed
Here's a list of the impact of different combinations of the deduplication profile options.

Show Duplicate Account or Contact
Notification

Exact Account or Contact Name Match Description

Disabled
 

Disabled
 

The application doesn't display potential
duplicate accounts or contacts.
 

Enabled
 

Enabled
 

When creating an account or a contact, the
application shows a list of potential duplicate
accounts or contacts, based on the data quality
configuration or an exact name match.
 

Disabled
 

Enabled
 

The duplicate notifications page is hidden.
 

Enabled
 

Disabled
 

This is the default setting.
 
When creating an account or a contact, the
application shows a list of potential duplicate
accounts or contacts based only on the data
quality configuration.
 

Related Topics
• Resolve Duplicate Accounts and Contacts

• Overview of Duplicate Identification

• Automerge

Enable Source System Reference in Accounts  
Source system reference is an identifier where the combination of source system and Source system reference is unique
that lets you maintain a record of the source of the data in sales applications.

Reference System Overview
Sales applications may use data from disparate systems running on different databases. When such data is
consolidated, the source system reference is maintained using a unique reference key for cross-referencing. You can
query the source system using the reference key (unique ID) to get more information about an account from the source
system.
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Here is an image of the Edit Account: Reference Systems page from where you can add or view reference systems.

In accounts, you can enable the source system reference by enabling a subtab that contains such cross-references if any.

Enable Source System References
You use the Reference Systems subtab to view or add source systems. This tab isn't enabled by default, which means
that you must explicitly enable the Reference Systems subtab.

Here's how to enable the Reference Systems subtab:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Account.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. On the Details Layout page, click the Reorder Subtabs icon.
7. In the Configure Subtabs dialog box that appears, move the Reference Systems subtab to the Selected Subtabs

box.
8. Click OK, and then click Done.
9. Publish the sandbox according to your company's business practices.

10. Edit a record on the Accounts page and verify the reference systems subtab.

Related Topics
• Source System References
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Configure Lists for Accounts and Assets  
You can configure the lists of values that appear for accounts, contacts, households, and assets. Extensible lists of
values let salespeople search and associate records using data that's relevant to their business needs.

Salespeople can search using standard fields, view the fields in the search results, and then select relevant records.

Here's a list of the configuration options:

• Create dynamic, role-based lists of value layouts

• Enable hidden standard fields for searching within a list of values

• Re-arrange fields in the search and result sections

• Define default values for search fields

• Mark certain fields as read-only or required

For more information on extending lists of values, see the Configuring Applications Using Application Composer guide
and the topics in this guide on extending accounts and contacts.

Data Enrichment and Verification  

Three Services to Enrich and Verify Your Data and Save
Salespeople Time  
Perhaps nothing is more important for your sales effort than having up-to-date and actionable information about your
customers and contacts and minimizing the time salespeople spend entering data. Oracle provides three services that
enrich your customer data, improve its accuracy, and eliminate data entry time.

For account and contact information, you can choose between two services that provide you with information for
millions of companies worldwide: Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle
DataFox. A third service, Oracle Address, Email, and Phone Verification, ensures that you have the correct postal
addresses, that your emails don't bounce, and your calls go through.

Note:  Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) is the new name for Data as a Service
(DaaS).

Here's an overview of the three services:

Service Oracle Account and Contact
Enrichment by Dun & Bradstreet
(D&B)

Oracle DataFox Oracle Address, Email, and Phone
Verification

Purpose
 

Account and contact search,
 enrichment, and prospecting.
 

Account prospecting, enrichment,
 and alerts to important
developments.
 

Address, phone, and email address
verification.
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Service Oracle Account and Contact
Enrichment by Dun & Bradstreet
(D&B)

Oracle DataFox Oracle Address, Email, and Phone
Verification

What It Does
 

Instead of entering data
themselves when they create
accounts, salespeople can look up
the organizations they sell to from
Dun & Bradstreet Corporation,
 one of the premier sources of
business information. The service
provides access to more than 347
million account records and more
than 135 million contact records
worldwide. Included is information
about more than 90 different
company attributes, including sales
volume, growth data, hiring trends,
 competitors, and so on.
 
Users can also filter the data
by using over 60 company or
contact attributes such as industry,
 revenue, company hierarchy,
 private or public indicator, contact
title, contact department.
 
The service also provides
information about account
hierarchies, showing the
linkages between a corporation's
subsidiaries, branches, and
divisions. You can also schedule
account or contact enrichment on
thousands of records at the same
time.
 
Oracle licenses account and
contact enrichment separately. You
subscribe to the Oracle Account
Enrichment Cloud Service and the
Oracle Contact Enrichment Cloud
Service.
 

Salespeople get the timely
information they need to
prospect and sell effectively
from an intelligence platform
that aggregates content from
all over the web. They can filter
several millions of companies by
keyword, location, headcount,
 the tech stack the company uses
(technographics) and other factors.
 
Salespeople get automatic
alerts on important news in the
companies they sell to. You can get
alerts whenever a company gets
approval for new patents, obtains
new rounds of financing, or opens
a new location, for example.
 
You can set up account scoring
to prioritize accounts using the
information you care about.
The service provides account
information only.
 
 

Salespeople can search and
validate addresses in more than
248 countries using data from
Loqate.
 
They can verify addresses when
creating or editing an account:
correct misspellings, add missing
elements (such as the postal code),
 and standardize elements (for
example, changing "Drv" to "Dr").
You can also schedule address
verification on thousands of
records at the same time.
 
The service automatically checks
if phone numbers and email
addresses exist and informs
you if they're invalid. No more
bounced emails or calls that don't
go through.
 

How It Works
 

Salespeople start typing the
account name, and the application
suggests possible matches
straight away. Selecting a match
automatically fills in all the rest of
the information.
 
Salespeople can add contacts to
accounts by job role. Selecting the
Enrich action for existing accounts
gets the latest information.
 
The account and contact
information continues to be
updated automatically based on
synchronization rules setup by
your administrator.
 

You prospect for accounts in the
Oracle DataFox UI and import
them into Oracle CX Sales. You
link up the accounts you want
to keep updated, set an update
frequency, and your account
information continues to be
updated automatically.
 

Salespeople start typing the street
address in the search field and
the application starts suggesting
possible matches. Selecting one of
the suggestions fills in the rest of
the address fields.
 
You can also enable a Verify
Address button that salespeople
can use to verify addresses for a
particular country. That's useful if
you added nonstandard fields to
the address or if salespeople don't
always use the search field to look
up an address.
 
You can also verify and update
addresses in bulk.
 

486



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 15
Accounts and Contacts

Service Oracle Account and Contact
Enrichment by Dun & Bradstreet
(D&B)

Oracle DataFox Oracle Address, Email, and Phone
Verification

The service informs salespeople
if phone numbers and email
addresses are invalid as soon as
they enter them. They can also
verify any existing ones to make
sure they're still valid.
 

Setup
 

After you activate the service,
 and complete the simple setup
described in this chapter in your
sales application, salespeople can
start looking up and enriching their
data right away.
 
To get the most out of the
application, however, you must
add fields to the UI to expose
the additional information
you're getting. While most of the
information maps onto fields you
can expose using Application
Composer, you must create some
custom fields to map the rest.
 

After you connect with Oracle
DataFox, find the company you
want and link it up with your
account in Oracle CX Sales using
the account registry ID.
 
To get most out of the application,
 you must add fields and create a
mashup in the sales UI to expose
the additional information you're
getting.
 

After you activate the service,
 and complete the simple setup
described in this chapter in your
sales application, salespeople can
start looking up street addresses
and verifying phone numbers and
email addresses. You can expose
the Verify Address button with a
few extra steps.
 

Where to Get More Information
 

This guide includes the information
you need to get started. You can
get the full scoop in the Using
Account and Contact Enrichment
by Dun & Bradstreet guide.
 

See the Using DataFox for Sales
and Marketing guide.
 

This guide includes the information
you need to get started. You can
get the full scoop in the Using
Oracle Address, Email, and Phone
Verification guide.
 

Related Topics

Where to Find Information on Implementing Enrichment and
Verification Services  
Information on how to set up the integrations between CX Sales and the three enrichment services is covered in
multiple guides.

Information on How to Started with the Integrations
The Three Services to Enrich and Verify Your Data and Save Salespeople Time topic in the Implementing Sales guide
provides you with the basic information on how to enable the integrations. If you're an existing customer and you are
adding services, then you can skip some of the initial steps.

Implementing the Oracle DataFox Integration
Integrating and using Oracle DataFox is covered in a separate Using DataFox guide.
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Implementing Integration with Oracle Account and Contact Enrichment by Dun &
Bradstreet (D&B)
For details on setting up the service and using the native application UI is covered in the Using Account and Contact
Enrichment by Dun & Bradstreet guide.

Integration with the Address, Email, and Phone Verification Service
For information on this service, especially on the REST API information, see the Using Oracle Address, Email, and Phone
Verification guide.

Enable the Lookup and Creation of Sales Accounts from Oracle
DataFox  
If you have an existing integration with Oracle DataFox, you can enable salespeople to search for an account they want
to create in DataFox and populate all relevant account information automatically.

To enable the Smart Data feature, select the Smart Data option for Enable DataFox in the Manage Data Enrichment
Integration page.

What You're Enabling
Your setup enables a search field (also referred to as Smart Data) in the Create Account page (highlighted in the
screenshot).

When salespeople create an account, they can use the field to search for the account in DataFox. Selecting an account
copies over account information from DataFox and links the new sales account to the selected DataFox account. Linking
the account makes it possible for DataFox to automatically update account information in the future and provide timely
account news.
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Note:  You can use the Smart Data feature only with one service. So, if you're already using Smart Data with the Oracle
Account and Contact Enrichment by Dun & Bradstreet (D&B), enabling DataFox disables your existing integration.

Setup Steps for Customers with Existing DataFox Integrations
1. In Setup and Maintenance, open the Manage Data Enrichment Integration task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Data Enrichment Integration

2. In the Manage Data Enrichment Integration page, the integration information should be already populated for
existing customers.

3. If you want to enable salespeople to manually enrich individual accounts from the Edit Account page at will,
then select the Enrichment check box for Enable DataFox option.

If you leave the option unselected, the account data gets enriched by Oracle DataFox sync jobs when they run.
4. To enable the search field on account create page, select the Smart Data option for Enable DataFox.
5. Click Save and Close.

Enable the DataFox-Powered Smart Data for Accounts  
Let your salespeople use DataFox smart data when they're creating a new account in the sales application. The
DataFox-powered smart data helps salespeople get quality information and near real-time data about the companies.
This makes account creation faster and more accurate.

Here's how you enable smart data for accounts:

1. In the Setup and Maintenance work area, use the Manage Data Enrichment Integration task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Data Enrichment Integration

2. On the Manage Data Enrichment Integration page, select Smart Data option for Enable DataFox.
3. Enter the DataFox credentials. See the Enable Oracle DataFox Features in CX Sales topic for more details.
4. Save and Close.

We recommend you select the Data Enrichment check box for Enable DataFox along with smart data so that your
users get the best search results with the latest high-quality data related to the accounts.

Configure Combined Enrichment from DataFox and D&B for
Accounts  
Configure combined data enrichment from DataFox and D&B so that your sales team gets the benefit of enriching their
accounts from Oracle DataFox and D&B simultaneously in real-time. You can configure in such a way that your sales
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team gets the firmographic data such as employee count and revenue from D&B, and the account scoring-related data
from Oracle DataFox.

Complete the following setups to configure combined enrichment:

1. Set up the Manage Data Enrichment Integration task.
2. Map the account fields with D&B and DataFox.

Set Up the Manage Data Enrichment Integration Task  
The Manage Data Enrichment Integration task lets you configure D&B and DataFox to coexist for a combined
enrichment. Here’s the setup:

1. In the Setup and Maintenance work area, use the Manage Data Enrichment Integration task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Data Enrichment Integration

2. On the Manage Data Enrichment Integration page, select the Enable DataFox and Enable DaaS check boxes
for Enrichment.

3. Select the Enable DaaS option for Smart Data. Don't select Enable DataFox for Smart Data.
4. Enter the credentials for DaaS and DataFox.
5. Save your changes.

Note:  The following existing tasks that were used for enriching from Oracle DataFox and D&B are now deprecated:

• Manage DataFox Data Enrichment Integration

• Manage Integration with Oracle Data as a Service

Map the Account Fields with DataFox and D&B  
Map the Account Score related fields with DataFox and the other fields with D&B.

Map Account Score Fields with DataFox
We recommend you map the following three fields with DataFox so that you get the account score data:

• DataFox Company ID

• Account Score

• Account Scoring Tier

For navigation and steps to map the fields, see the Integrate with Oracle CX Sales in the Using DataFox for Sales and
Marketing guide.

Map Account Fields with D&B
After mapping the Company ID and Account Score related fields with DataFox, map all the other account fields with
D&B.
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Undo Enrichment  

Configure Undoing Enrichment for Accounts  
In certain scenarios, your sales team may have to undo the enrichment of an existing D&B or DataFox enriched account
and associate it with D&B or DataFox again to get the right updates for the account.

You need to ensure that data enrichment is already set up and an account is enriched for the Undo Enrichment option
to be available for the enriched accounts. Here’s how you can verify if data enrichment is enabled:

1. In the Setup and Maintenance work area, use the Manage Data Enrichment Integration task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Data Enrichment Integration

2. On the Manage Data Enrichment Integration page, ensure that Enable DaaS, Enable DataFox, or both the
options for Enrichment are selected.

3. Ensure that either Enable DaaS or Enable DataFox options is selected for Smart Data.
4. Ensure that the credentials for DaaS and DataFox are entered if you have enabled both. If you are using

enrichment and smart data of one of them, ensure that the credentials are correctly configured for the
respective provider.

5. Save your changes.

Your users can see the Undo Enrichment option in the Actions list on the Account page.

Related Topics
• Undo Enrichment of an Enriched Account

Contact Preferences  

Overview of Setting Up Contact Preferences  
Salespeople capture and modify preferences about whether accounts and contacts want to be contacted, such as
selecting a Do not email or Do not call check box while editing a contact.

As an administrator, you have several setup options for modifying the pages used to capture such information.

Overview of the Options
You can set up the application to be as simple as including a Do Not Contact check box on a page, or as complex as
letting salespeople enter Do Contact and Do Not Contact preferences for multiple contact methods, such as phone,
email, and so on. You can also display a Reason field next to the do not and do contact options.

You use a combination of Application Composer and Page Composer to set up contact preference UIs.
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Privilege to Tag a Reason Code as Legal
Contact restriction information is captured as a Reason Code. Salespeople can create and edit contact preference
information with any Reason Code that's not identified as Legal. To create and edit contact restriction information using
a Reason Code that's tagged as Legal, add the HZ_LEGAL_CONTACT_PREFERENCES_PRIV privilege to the required role.

You can set up a reason code as legal by tagging the Reason Code lookup value. Tag the lookup type REASON_CODE
with the value LEGAL using the Manage Trading Community Common Lookups task.

Set Up Contact Preferences  
You can set up the Accounts and Contacts profile pages so that salespeople can capture contact preferences, such as do
not call preferences.

Use Application Composer to expose the Manage All Phones and Manage All Emails dialog windows. Then use Page
Composer to expose the OK to Call, Do Not Call, and (optional) Reason fields.

Set Up UI Elements to Capture Preferences
Enable Manage All Phones and Manage All Emails dialog windows so that salespeople can set contact preferences for
accounts and contacts. You can enable them on the Create Contact and Edit Contact: Profile pages and on the Create
Account page (Manage All Phones only) and Edit Account: Profile page.

Set up OK to Contact preference for a specific phone, email, or address of a contact. Identify if a contact has made a
choice to be contacted, or has made no choice. The OK to Call and OK to Email options are mutually exclusive with the
Do Not check box. Only one can be enabled for a given contact.

Here's a procedure that uses the Contacts pages as an example. Modify it for Accounts by navigating to the Accounts
object in Application Composer and editing the Creation Page and Details page layouts.

Here's how to enable all phones and emails.

1. Ensure that you're working in an active sandbox.
2. Click Navigator  > Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, Contact, and then Pages.
4. Ensure that the Application Pages tab is active.
5. In the Creation Page Layouts section, in the Create Contact table, duplicate the Standard Layout. Name the new

layout and edit it.
6. In the Creation Layout page, click the Edit icon that appears next to Create Contact.
7. Select and move fields from the Available Fields column to the Selected Fields column, depending on your

requirements.

This table shows the fields:

Fields Description

Do not contact
 

Enables the Do not contact check box in the contact Profile page. Lets salespeople set a blanket
do not contact preference at the contact level. This signifies that this contact must not be
contacted at all.
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Fields Description

Do not call
 

Enables the Do not call check box in the contact Profile page. Lets salespeople set the contact
preference at the phone level for a contact.
 

Do not email
 

Enables the Do not email check box in the contact Profile page. Lets salespeople set the contact
preference at the email level for a contact.
 

Do not mail
 

Enables the Do not mail check box in the contact Profile page. Lets salespeople set the contact
preference at the physical mailing address level for a contact.
 

All phones
 

Enables the All phones icon in the Create or Edit Contact page, and enables the Manage All
Phones dialog window that appears when users click this icon.
 

All emails
 

Enables the All emails icon in the Create or Edit Contact page, and enables the Manage All
Emails dialog window that appears when users click this icon.
 

8. Click Save and Close.
9. Click Done.

Note:  If you want the contact preference fields to appear in the Create Contact page, then you must perform
steps 1 to 9. If you want the fields to appear in the Edit Contact page, then you must also perform steps 10 to
15.

10. In the Details Page Layouts section, in the Edit Contact table, copy the Standard Layout. Name the new layout
and edit it.

11. In the Details Layout page, click the icon that resembles the Profile icon.
12. Click the Edit icon that appears next to Edit Subtab: Summary.
13. Select and move fields from the Available Fields column to the Selected Fields column, depending on your

requirements.
14. Click Save and Close.
15. Click Done.
16. Publish the sandbox according to your company's business practices.

Set Up UI Elements to Capture Preferences for Different Phones and Email Addresses
You can enable UI elements that let salespeople capture preferences for contacts and accounts at the phone and email
level. You can also enable a Reason field for the preference.

Note:  You must first enable the All phones and All emails fields in Application Composer (see the previous
procedure). Then you enable the additional UI elements using Page Composer.

This procedure uses the phone contact method as an example. Modify it for the email contact preference UI elements:

1. Ensure you're working in an active sandbox the supports Page Composer.
2. Navigate to Sales > Contacts.
3. Activate Page Composer: From the drop-down list under your user name in the global header, select Edit

Pages.
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When Page Composer is active, the phrase Editing: User Interface displays at the top of the page.
4. In the Contacts landing page, search for and select a contact.
5. Click the name of the contact to open the edit page. In the Edit Contact page, click the Profile icon.
6. In the Profile page for the contact, click the edit icon for All phones.
7. In the Editing: User Interface dialog window, click the Select tab at the top of the page.
8. In the Manage All Phones dialog window, click any one of the columns, such as Primary, Type, or Number

columns and select the Edit Parent Component option in the dialog box.
9. In the Component Properties dialog window, click the Children tab.

10. Select the Do Not Call or OK to Call options, and, optionally, the Reason.
11. Click Apply and then OK. Notice that the Do Not Call, OK to Call, and Reason columns (if selected) are now

visible in the Manage All Phones dialog window.
12. In the Editing: User Interface window, click the Add Content tab.
13. In the Manage All Phones dialog window, click OK.
14. Click the edit icon next to the All phones field to verify your changes.
15. Click Close to close Page Composer.
16. Publish the sandbox according to your company's business practices.

Personally Identifiable Information  

Manage Personally Identifiable Information  
Any piece of information that can potentially be used to uniquely identify, contact, or locate a single person is called
personally identifiable information (PII). Administrators use PII to access information such as social security numbers,
addresses, bank account numbers, phone numbers, and so on.

As a sales administrator, you can manage PII information. You can add or update PII data for your contacts. You must
expose PII attributes from Application Composer or Page Composer in an active sandbox. For more information about
how to enable the PII attributes, see topic, Manage Personally Identifiable Information in the Implementing Customer
Data Management for CX Sales and Fusion Service guide.

Related Topics
• How You Protect Personally Identifiable Information

Data Removal  

Delete Accounts and Contacts  
Users with the sales administrator role can delete accounts and contacts.

Sales administrator can give privileges to the other administrative roles to be able to delete accounts and contacts.
Here's a description of the privileges you must have:
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Object Privilege Additional Information

Account
 

Delete Sales Party
 

You can't delete an account if it's a partner or
competitor account, or if the account is the
topmost tier in the account hierarchy.
 

Contact
 

Delete Sales Party Contact
 

You can delete standalone contacts. You must
also have full access to all of the accounts
associated to the contact. When you delete
a contact, you remove the entire person
record of the contact, including profile data,
 account usages, household memberships, and
relationships to other accounts.
 

Note:  When you delete an account or a contact, all the child entities may not become inactive. Run the Delete Child
Entities of Inactive Party Records scheduled process to deactivate them.

Purge Inactive Data  
When you delete a party record which can be a sales account, a sales contact, or sales households in your application, it
becomes an inactive record. Inactive records may get accumulated in your application and you may want to purge them.

Purging inactive records helps helps you free space and comply with data protection regulations.

Note that only inactive records that are available in the sales context can be purged. For example, an inactive Partner
record can't be purged because Partner isn’t related of Sales.

Only inactive and related merged sales accounts, sales contacts, and sales households which have no dual usage, or any
additional usage (more than one usage) can be purged. Examples of inactive contacts, accounts, or households with
dual usage are:

• contact which is also a supplier contact

• sales account which also has billing account usage

The following sales contact record types are supported:

• CONTACT

• ORG_CONTACT

• CUSTOMER_CONTACT

• SALES_PROSPECT

• SALES_ACCOUNT

The following sales account record types are supported:

• SALES_PROSPECT

• SALES_ACCOUNT

Also, along with the purge of the inactive accounts, contacts, or households references of these purged records, such as
identifier or name, are also removed in other applications like opportunities, leads, campaigns, territories, assets, deals,
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quotes, activities (tasks and appointments), notes, forecasts, business plans, and contracts. For these flows, purged
accounts, contacts, or households don't appear on application pages, web service responses, and BI reports.

Merged records can be purged only when the master (survivor) party becomes inactive.

Purge account, contact, or household records in the following situations:

• Purge Inactive sales accounts, contacts, or households to comply with General Data Protection Regulations
(GDPR).

• Cleanup data because incorrect data was created that's no longer needed.

• In some rare cases, cleanup of data maybe required to improve performance of the application.

How You Enable Purging of Inactive Records
You use the two profile options to help you enable and manage purging of inactive records:

• ORA_HZ_ENABLE_PURGE: This profile option enables purging of inactive records. By default, this profile option
is enabled and is set to No.

• ORA_HZ_PURGE_MIN_AGE: This profile option specifies the number of days after which inactive records can be
purged. By default, the value of this profile option is 30 days.

You can enable these profile options by clicking the Setup and Maintenance area and going to the following:

• Offering: Sales

• Functional Area: Sales Foundation

• Task: Manage Administrator Profile Values

You must specify filter criteria to select the inactive records that you want to purge. The value of the profile
ORA_HZ_PURGE_MIN_AGE is displayed as the Minimum Age on the Manage Party Purge Activities page and
the default value of the Age By field on the Create Purge Filter page. Modify the value of the profile option
ORA_HZ_PURGE_MIN_AGE to change the default value of the Age By field.

Create and Edit Filters and Purge
You must create a filter criterion to purge records. The records that are to be purged are selected based upon the filter
criteria. So, you can't skip creating filters and proceed to purging records. You can either immediately purge the selected
records or schedule the Purge Inactive Party Records scheduled process to purge inactive records later. You must create
a filter criterion to purge records.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Party Purge Activities

Note:  The Purge Enabled field on Manage Party Purge Activities page indicates whether inactive records can
be purged, and the Minimum Age field indicates the minimum number of days after which inactive records
can be purged. Use the profile options discussed earlier in the topic to change these profile option values, if
needed.
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2. Click Actions >  Create to create a purge filter.
You can click Actions >  Edit to edit the existing filter criteria or click Actions >  Remove to remove an existing
filter.

3. Specify the purge filter criteria or change the existing filter criteria as required.

Note: You can't specify a number less than the number specified in the Age By field. If you want to reduce
this Age By value, change the value of the profile option ORA_HZ_PURGE_MIN_AGE to a smaller number.

Note:  To purge records on the same day that they were deleted, specify Age By in the filter criteria
and the value of the profile option ORA_HZ_PURGE_MIN_AGE as -1.

4. Select the Enabled option to make the filter criterion available for filtering and purging records. If you don't
select this option and continue to save the filter, the filter criteria is saved but isn't available to filter and purge
records.

5. Click Save and Close.
The Final Result section displays the first 500 records that match your filter criteria.

6. Click Purge to immediately purge all the records that currently match your filter criteria.
Else, click Save and Close to save the filter criteria and purge the records in the next cycle of running the Purge
Inactive Party Records scheduled process.

Note:  If you want to automatically purge records in the next cycle of running the scheduled process, the
purged records may not be the same records that appeared in the preview section of the Manage Party Purge
Activities page. The records purged are the ones that match the filter criteria when the scheduled process is
run.

Related Topics
• Purge Inactive Party Records

Additional Configurations  

Make the Account Field Required for Contacts  
You may want to make the Account field required when salespeople create a contact, so that you can be sure an account
always gets associated with a contact. By default, the Account field isn't required when creating a contact.

Use Application Composer to set the field as required:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, and then expand Contact.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. In the Create Contact layouts region, duplicate the standard layout and edit the resulting layout.
7. In the Creation Layout page, click the Account link.
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8. In the Edit UI Properties: Account dialog box, Layout Properties section, set the Required field to Yes.
9. Click Save and Close.

10. Click Done on the Creation Layout page.
11. Publish the sandbox according to your company's business practices.

Set Up Required Address Option for Accounts and Contacts  
Administrators can set an address as required or optional depending on the type of account or contact. You can specify
that an address is required and determine how the address appears on the UI.

Manage Profile Values
Use the Manage Administrator Profile Values task to specify that an address is required while creating an account.
Profile options let you enable or disable address options for accounts and contacts. Use these profile options to specify
that an address is required while creating an account.

Profile Option Code Profile User Name Description

ZCA_ACCOUNT_ADDRESS_REQUIRED_
ENABLED
 

Account Address Required
 

Specify whether an address is required while
creating an account.
 

ZCA_CONTACT_ADDRESS_REQUIRED_
ENABLED
 

Contact Address Required
 

Specify whether an address is required while
creating a contact.
 

This table lists the profile values and which types of accounts require the address to be entered. By default, the profile
option setting is Required for customer.

Profile Value Description Required for Account Type

Yes
 

The address is required.
 

All types of accounts.
 

No
 

The address isn't required.
 

The address is optional, regardless of the
account type.
 

Required for customer
 

The address is required only for the account
type that's set to this profile value.
 

The address is required only for customers.
 

To make the address required while creating an account:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
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2. Click the Manage Administrator Profile Values link.

The Manage Administrator Profile Values page appears.
3. Enter the code in the Code field, and click Search.

The application displays the profile option information.
4. In the Profile Values section, select Yes in the Profile Value field.
5. Click Save and Close.

Manage Address Formats
Use the Manage Address Format task to set up address attributes. The address format lets you manage the appearance
of the address for accounts and contacts. For example, you can change the case of letters in an address, or mark a
specific address attribute as required.

To specify which fields in an address are required:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Address Formats

2. Click the Manage Address Formats link.

The Manage Address Formats page appears.
3. Select a country from the drop-down list.
4. In the Format Variation Layout area, select the fields that you want to set as required in the Required column.
5. Click Done.

Groovy Support for Numbering Management
You can automatically generate the site ID of an address while creating a contact or an account using a groovy script.
Before you can use the groovy script, you must verify that the value for HZ_GENERATE_PARTY_SITE_NUMBER profile
option is set to Auto numbering, update allowed (AUTONUM_UPDATE).

Add the Time Zone Field to Contacts Pages  
You can add the Time Zone field to the Contacts create and edit pages, so that salespeople can specify the customer
contact's time zone.

1. Sign in as a user with the Sales Administrator job role.
2. Ensure you're working in an active sandbox.
3. Navigate to Configuration > Application Composer.
4. Navigate to the Contact object and click Pages.
5. Duplicate the page where you want the time zone field to appear. For example, duplicate the Create Contact page

standard layout and edit the copy.
6. In the Creation Layout page, Configure Detail Form fields region, move Time Zone from the Available Fields to the

Selected Fields window.
7. Save your work.
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8. Navigate to the Create Contact page in Sales > Contacts. Verify that the Time Zone field appears in the Create
Contact page.

9. Publish the sandbox according to your company's business practices.

Related Topics
• Specify Customer Time Zones

Enable the Photo Field for a Contact  
You can enable users to upload and show photos on a contact's profile.

Here's how to display the Photo field on the contacts pages:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Contact.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the duplicate icon.
7. Enter a new layout name and click Save and Edit.

The Details Layout page appears.
8. Click Subtab Profile for the field to display on the Profile page.
9. In the Subtabs Region, click the Edit Summary Subtab icon.

The Configure Detail Form page appears.
10. Move Photo from the Available Fields window to the Selected Fields window.
11. Click Save and Close.
12. From the Details Layout page, click Done.
13. Make sure that the layout status for your layout is set to Active, and that it's associated to your application user

role.
14. Test the changes as follows:

◦ Navigate to Sales > Contacts > select a contact > Edit Contact page > Profile subtab > Photo field >
upload photo.

◦ On the Contacts landing page, in the card view, you can see the photo for the contact you selected.

15. Publish the sandbox according to your company's business practices

Manage Contact Views  
Set the list view as the default view for the Contacts landing page. By default, the contact view is set to card view.
Salespeople can use either the card view or list view.

CAUTION:  If you use both card view and list view, then a blank list of contacts appears.
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To enable the list view:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, and then expand the Contact object.
4. Within the object you're modifying, click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. The Landing Page Layouts region, duplicate the standard landing page layout.
7. Edit the new layout. In edit mode of the Landing Page Layout page, click the edit icon on the Default Contact

View.
8. Select List View in the Select Default View dialog box.
9. Click OK.

10. Click Done on the Landing Page Layout page.
11. Publish the sandbox according to your company's business practices.

Configure Event Tracking  
You can track changes to your accounts, contacts, or household data by configuring the following profile options:

• HZ_INVOKE_OBJ_WF_ON_TRACKING: Enable this profile option to indicate that there are changes to parent
records. That is, whenever a child is updated, the parent record is marked as updated. For example, if the email
address or phone number of a contact was updated, the contact is marked as updated which in turn indicates
that the contact requires synchronization.

• HZ_ENABLE_EVENT_TRACKING: Use this profile option to enable event tracking of records. This profile option
facilitates tracking of changes to records and raises an event whenever there is a change.

Note:  If you don't plan to integrate your application with data quality, extensibility, object workflow, or Oracle Eloqua,
you can turn off the HZ_INVOKE_OBJ_WF_ON_TRACKING profile option. This helps to avoid locking issues. But you
must carefully review the implications of turning off this profile option in your application.

You can enable these profile options by clicking the Setup and Maintenance area and going to the following:

• Offering: Sales

• Functional Area: Sales Foundation

• Task: Manage Administrator Profile Values

How to Display the Contracts Tab on the Accounts Details Page  
You can enable the Contracts tab within the Accounts pages using Application Composer. From the Contracts tab,
salespeople can view and download contracts associated with accounts.

Groovy Support for Team Member Notifications  
You can add or delete team members for accounts, contacts, and households using the respective UI pages or REST
APIs. When you add or delete team members, notifications are prompted for the parent record.
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These notifications enable you to define Groovy prompts on the parent object.

For more information on Groovy scripting, see Oracle Applications Cloud Groovy Scripting Reference guide. For more
information about REST APIs, see the REST API for CX Sales and Fusion Service guide.

Groovy Support for Email Address Format Validation  
You can add email addresses for accounts or contacts using the respective UI pages or REST APIs. While entering these
email addresses, the format of the email address should be validated.

You can use Groovy scripts to specify the rules to validate email address formats.

For more information on Groovy scripting, see Oracle Applications Cloud Groovy Scripting Reference guide. For more
information about REST APIs, see the REST API for CX Sales and Fusion Service guide.

The following code is a sample for validating email addresses:

def regex = /(?i)^([\w-]+(?:\.[\w-]+)*)@((?:[\w-]+\.)*\w[\w-]{0,66})\.([a-z]{2,6}(?:\.[a-z]{2})?)$/ 
def email = getAttribute('ListEmailAddress'); 
def EmailCollection = Email ;
EmailCollection.reset();

if (email == null)
{
while(EmailCollection.hasNext()){
def emailRec = EmailCollection.next() 
email = emailRec.EmailAddress
if (!(email =~ regex)){ 
throw new oracle.jbo.ValidationException("Populate email in the appropriate format (example
 someone@oracle.com)") 
} 
} 
}
else
if (!(email =~ regex)){ 
throw new oracle.jbo.ValidationException("Populate email in the appropriate format (example
 someone@oracle.com)") 
}

Foundation Profile Options  
Foundation profile options configure various features such as geographies, Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B), address formats, and so on.

The following table lists foundation profile options, descriptions, default values, and the impact these profile options
have on different parts of the application.

To view the details of these profile options:

1. Click Navigator >  My Enterprise >  Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
3. Search using the profile option code.

To change the default values of these profile options:

1. Click Navigator >  My Enterprise >  Setup and Maintenance work area.

502

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=CGSAC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAAPS
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=CGSAC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAAPS


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 15
Accounts and Contacts

2. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
3. Search using the profile option code.
4. Change the profile value.

Profile Option Code Profile Option Name Default Value Description Impact Related Topics

HZ_UPDATE_STD_
ADDRESS
 

Update Standardized
Addresses Enabled
 

No
 

Enable to allow the
update addresses
that are already
standardized using
postal information.
 

This profile option
is applicable to
Application UI and
REST
 

HZ_POST_IMPORT_
GNR_INVOKE
 

Address Validation
After Import
 

Y
 

Runs the Geography
Name Referencing
(GNR) process
after geography
data import. The
recommended value
for this profile option
value is N. This helps
improve the import
performance. After
setting this to N, GNR
process isn't invoked
for every import.
 

This profile option
is applicable to File-
based Import (used
in high volume
import) and Import
Management
 

See Validate
Geographies of
Addresses Against
Master Geographies

HZ_ORGANIZATION_
PROFILE_INDEX_
THRESHOLD
 

Organization Profile
Index Threshold
 

10
 

Specify the number
of profile history
records above which
organization profile
history information
will be automatically
denormalized
into a secondary
table for improved
performance.
 

This profile option is
applicable to REST
 

HZ_INVOKE_OBJ_WF_
ON_TRACKING
 

Child Entity Rollup
Enabled
 

Yes
 

Enable rollup of the
child entity changes to
the root object during
event tracking. This
invokes the root object
workflow whenever
the child entities
change.
 

This profile option
is applicable to
Scheduled Process,
 Application UI, REST
 

See Configure Event
Tracking

HZ_GENERATE_
PARTY_NUMBER
 

Party Number
Generation
 

Auto numbering,
 update allowed
 

Select how a party
number will be
generated, and if
you can update the
number when creating
or editing a person or
organization party.
 

This profile option
is applicable to
Application UI, REST
 

See Set Up the Third-
Party Involuntary
Payment Interface

HZ_ENABLE_EVENT_
TRACKING
 

Composite Event
Tracking Enabled
 

Yes
 

Enable composite
event tracking for
customer and contact
entities. This tracks
changes to the

This profile option
is applicable to
Scheduled Process,
 Application UI, and
REST

See Configure Event
Tracking
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

entities, and raises
an event whenever
there is a change to
the entities.
 

 

HZ_AUTO_SITE_
NUMBERING
 

Site Use Identifier
Generation
 

Auto numbering,
 update not allowed
 

Select how the site
use identifier will be
generated, and if you
can update it when
creating or editing an
account site use.
 

This profile option
is applicable to
Application UI and
REST
 

HZ_AUTO_LOG_
INTERACTIONS
 

Call Interaction
Logging Enabled
 

No
 

Enable adding
phone calls to the
interactions log when
the call action is used.
 

This profile option
is applicable to
Application UI and
REST
 

ORA_HZ_RES_
ENABLE_MGR_END_
UNCOND
 

Enable End Dating
Resource Manager
Unconditionally
 

N
 

Allows organization
membership end
date for resource
with managerial role
without any validation.
You need not move
out all reports before
moving manager out.
Set the value to Y to
enable this option.
 

This profile option
is applicable to
Application UI,
 REST, and Import
Management (only
Resource object)
 

See,
How You Manage
Resource Organization
Hierarchy Changes
 

ORA_HZ_PURGE_
MIN_AGE
 

Minimum Threshold
Value for Purge of
Inactive Data
 

30
 

Specify the minimum
number of days after
which inactive records
are to be purged.
 

This profile option
is applicable to
Application UI
 

See,
Purge Inactive Data
 
Purge Inactive Party
Records
 

ORA_HZ_INCLUDE_
REGIONAL_COUNTRY
 

Regional Country
in Address Formats
Included
 

No
 

Enable address format
functions to include
regional country. You
must set the value to
yes to include regional
country.
 

This profile option
is applicable to
Application UI
 

See, Create an Address
Style Format

ORA_HZ_GEO_
HIERARCHY_LIMIT
 

 100000
 

Specify the maximum
number of nodes that
each parent node
can handle for any
geography element.
 

This profile option
is applicable to
Application UI and
Import Management
(only for geography
object)
 

See,
Best Practices for
Managing Geography
Mismatches
 
Manage Geography
Structures, Hierarchies,
 and Validation
 

ORA_HZ_ENABLE_
PURGE
 

Purging of Inactive
Data Enabled
 

N
 

Enables the purging
of data that are in
inactive state using
the Manage Party
Purge Activities task.
You must specify

This profile option
is applicable to
Application UI
 

See, Purge Inactive
Data Purge Inactive
Party Records
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

filter criteria to purge
inactive data using
Manage Party Purge
Activities task.
 

ORA_HZ_ENABLE_
MPLCRI_ACTIVE_
WORKER
 

Enable Current Active
Worker Sync For
MPLCRI Job
 

No
 

Enable current active
worker sync for
Maintain Party and
Location Current
Record Information
batch job. If set to N,
 then current active
workers won't get
synced to person
party.
 
This profile option
is associated with
the Maintain Party
and Location Current
Record scheduled
process. This profile
option ORA_HZ_
ENABLE_MPLCRI_
ACTIVE_WORKER
must be set to Y and
the HRC_DISABLE_
HCM_EVENTS_
PROCESSING profile
option must be set
to Yes to sync active
workers. For more
information topic,
 see, Maintain Party
and Location Current
Record Information.

This profile option
is applicable to
Scheduled Process
 

see, Maintain Party
and Location Current
Record Information

ORA_HZ_ENABLE_
DAAS_LOQATE
 

DaaS GBG | Loqate
Data Import Enabled
 

Yes
 

Enable the import
of DaaS GBG |
Loqate geography
information.
 

This profile option
is applicable to
Scheduled Process,
 Application UI, and
Import Management
 

see, How to Import
Nokia Geography Data

ORA_HZ_DAAS_GEO_
ENDPOINT
 

DaaS Geography
Server Endpoint
Information
 

https://
geo.daas.us-
phoenix-1.ocs.oraclecloud.com
 

Specify the endpoint
information, such as
the host name and
the port number, of
the DaaS geography
server.
 

This profile option
is applicable to
Application UI and
REST

HZ_TIMEZONE_
POPULATION_
ENABLED
 

Time Zone Population
Enabled
 

No
 

Enable update of
contact records with
time zone details
from the Populate
Location Latitude and
Longitude Information
scheduled process.
 

This profile option
is applicable to
Scheduled Process
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

HZ_SHARE_
LOCATIONS
 

Location Sharing
Mode
 

Share among all
parties
 

Select if location can
be shared among
different persons and
organizations.
 

This profile option
is applicable to File-
based Import. This
profile option isn't
applicable in Import
Management.
 

HZ_RS_DEF_START_
DATE
 

Resource Start Date
Default
 

Current date
 

Select if the default
start date will be
the date when the
resource is created, or
the employment start
date of the resource.
 

This profile option
is applicable to
Application UI. This
profile option isn't
applicable in Import
Management and
resource user REST.
 

HZ_RESOURCE_
ALLOW_
CUSTOMIZATION
 

Application Composer
for Resource Desktop
Pages Enabled
 

No
 

Enable access to
Oracle CX Sales
Resource desktop
pages in the
Application Composer.
 

This profile option
is applicable to
Application UI
 

See Resource Directory

HZ_LANG_FOR_
COUNTRY_DISPLAY
 

Language for Country
Display
 

 Specify the default
language used to
translate the country
name for international
addresses. This is
typically the language
of the country where
an item is mailed from.
 

This profile option
is applicable to
Application UI and
REST
 

HZ_GEOCODING_
BATCH_SIZE
 

Geocoding Subprocess
Batch Size
 

1000
 

Specify the maximum
number of locations
that each batch
subprocess can handle
for geocoding.
 

This profile option
is applicable to
Scheduled Process

HZ_GENERATE_
PARTY_SITE_NUMBER
 

Party Site Number
Generation
 

Auto numbering,
 update not allowed
 

Select how a party
site number will be
generated, and if you
can update the site
number when creating
or editing a party site
address.
 

This profile option
is applicable to
Application UI, and
REST
 

See Set Up Required
Address Option for
Accounts and Contacts

HZ_GENERATE_
CUSTOMER_NUMBER
 

Customer Account
Number Generation
 

Auto numbering,
 update not allowed
 

Select how a customer
account number will
be generated, and if
you can update the
number when creating
or editing a customer
account.
 

This profile option
is applicable to
Application UI, and
REST
 

HZ_GENERATE_
CONTACT_NUMBER
 

Contact Number
Generation
 

Auto numbering,
 update not allowed
 

Select how the
contact number will
be generated, and if
you can update the

This profile option
is applicable to
Application UI, and
REST
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

number when creating
or editing a contact.
 

 

HZ_ENABLE_VO_
SECURITY
 

Enable VO-Based
Security
 

No
 

Enable VO-based
security and override
the default EO based
security for all objects
that use the secured
PartyEO.
 

This profile option
is applicable to
Application UI and
REST
 

HZ_ENABLE_
MULTIPLE_BU_CRM
 

Multiple Business
Units Enabled
 

Yes
 

Enable the multiple
business units feature
for Oracle Fusion
Customer Relationship
Management.
 

This profile option
is applicable to
Application UI
 

See Set Sales Business
Unit Profile Options
Define Business Units

HZ_ENABLE_ENTITY_
EVENTS
 

Entity Level Events
Enabled
 

Yes
 

Enable entity level
events for account,
 contact, and
household entities.
 

This profile option
is applicable to
Scheduled Process,
 Application UI, and
REST
 

HZ_ENABLE_CLICK_
TO_DIAL
 

Click to Dial Enabled
 

Yes
 

Enable automated
dialing by clicking on a
phone number.
 

This profile option
is applicable to
Application UI
 

HZ_ENABLE_BUSI_
VALID
 

Business Key
Validation Enabled
 

No
 

Enable the business
key validation rule to
check for duplicate
contact points, such
as mobile, URL, and
Email.
 

This profile option is
applicable to REST
 

HZ_DEFAULT_NAME_
STYLE
 

Name Style Default
 

Concatenated Name
 

Specify a default style
for name formatting.
 

This profile option
is applicable to
Scheduled Process,
 Application UI, and
REST
 

HZ_DEFAULT_BU_
CRM
 

Customer Relationship
Management Business
Unit Default
 

Vision Operations
 

Specify the default
business unit for
Oracle Fusion
Customer Relationship
Management.
 

This profile option is
applicable to REST
 

See Set Sales Business
Unit Profile Options
Define Business Units

HZ_DEFAULT_ADDR_
STYLE
 

Address Style Default
 

Postal Address
 

Specify a default
style for address
formatting.
 

This profile option
is applicable to
Application UI and
REST

HZ_AUTOMATE_
RESOURCE_CREATION
 

Automated Resource
Creation Enabled
 

No
 

Enable automatic
creation of resource
from employee
creation process

This profile option
is applicable to
Application UI
 

See Overview of HCM
Job-to-Role Mapping
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

without user
intervention.
 

HZ_ALLOW_
MULTIPLE_SELLTO
 

Multiple Sell-to
Addresses Enabled
 

No
 

Enable multiple sell-
to address creation
for a party, using the
Data Import program.
This profile option
should not be used by
customers.
 

This profile option
is applicable to
Application UI, and
REST
 

HZ_ADDRESS_
DISABLE_ALT_NAMES
 

Hide Alternate
Address Names
 

No
 

Hide alternate names
in the Address list of
values. This option,
 when enabled,
 displays only the
primary geography
names for the address.
 

This profile option
is applicable to
Application UI
 

HZ_GNR_NUM_OF_
WORKERS
 

Number of workers
for a given Geography
Name Referencing
request
 

1
 

Determines the
number of sub-
processes for Validate
Geographies of
Addresses Against
Master Geographies
scheduled process.
 

This profile option
is applicable to
Scheduled Process
 

See Best Practices for
Geography Validation

ZCA_SA_AUTO_
ASSIGN_ON_UPDATE
 

Sales Account
Automatic Assignment
on Update Enabled
 

No
 

Enable automatic
territory based
assignment
processing after
a sales account is
updated.
 

This profile option
is applicable to
Scheduled Process,
 Application UI, and
REST
 

See How You Enable
Automatic Account
Assignment Enable
Automatic Assignment
of Imported Accounts

HZ_GNR_COMMIT_
SIZE
 

Batch Size for
committing records
in Geography Name
Referencing process
 

N/A
 

The Batch Size for
committing records
in Geography Name
Referencing process
 

This profile option
is applicable to
Application UI,
Scheduled Process,
File-based Import, and
Import Management.
 

ORA_HZ_IMPORT_
MULTI_ADDRESS_
TYPE
 

Import Processing
for Multiple Address
Types Enabled
 

Yes
 

Enable the processing
of multiple address
types for Account,
 Contact, Address,
 Organization, and
Person objects.
 

This profile option is
applicable to Import
Management
 

See Import Your
Household Data
Import Your Account
Data Import Your
Contact Data

ORA_HZ_RES_
ENABLE_SKILLS
 

Skills Section in
Resource Detail Page
Enabled
 

No
 

Enable the skills
section in the
Resource Detail page
of the Resource
Directory and Manage
Resources task. The
valid values are YES

This profile option
is applicable to
Application UI
 

See How to Enable the
Skill and Qualification
Tabs on Resource
Pages
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Profile Option Code Profile Option Name Default Value Description Impact Related Topics

and NO, and the
default value is NO.
 

Integration with Financials  

Overview of Oracle Financials Cloud  
Oracle Financials delivers a complete solution that includes:

• General Ledger

• Intercompany Accounting

• Payables

• Receivables

• Payments

• Cash Management

• Tax

• Expenses

• Assets

Use these applications with business intelligence, compliance reporting, and mobile data access for:

• Financial accounting

• Transaction processing

• Payment delivery

• Cash reconciliation

• Employee expense processing

• Asset management

509



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 15
Accounts and Contacts

Access data through pages that contain:

• Navigation tools in the global area of the Home page.
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• Icons to navigate to pages.

• Infolets in an Infolets page or work area.
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• Panel tabs for tasks, searching, and analytics accessed by icons on the page.
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• Transaction details in a work area.

• Transaction details as a separate page.

From the application pages, access:

• Embedded analytics, which enables you to complete a transaction or analyze data.

• Interactive infolets and work areas to view:

◦ Information summaries for a high-level overview.

◦ Information monitoring and drill-down capability.

◦ Transaction information that's central to one or more business processes.

◦ Business intelligence content that's complementary to one or more business processes.

• Real-time reporting for:

◦ Viewing reports and analytics for each individual work area.

◦ Exploring predefined analyses.
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◦ Creating and editing analyses from the Reports and Analytics panel tab or work area.

◦ Accessing the Oracle Business Intelligence (BI) Enterprise Edition through the Reports and Analytics
panel tab. See the new objects and changes to existing objects that you made in Oracle BI Enterprise
Edition, which are then available from Oracle Financials.

◦ Viewing and running financial reports from the Financial Reporting Center, which is a single point of
entry for general ledger financial reporting functions. The Financial Reporting Center includes:

- Tools to create and format financial reports, including Financial Reporting Studio and Workspace.
- Live and interactive financial reports with multiple output options, including HTML, PDF, Excel, or

Excel in Query Ready mode using Smart View Enabled formats.
- Drill downs to underlying journals and subledger transactions with the Account Inspector.
- Multiple reporting methods for ad hoc analysis, efficient monitoring, and tracking of key account

balances in real time with the Account Monitor.

Synchronize Financials Accounts  
After users create accounts and contacts in Oracle Financials, use the scheduled process, Synchronize Financials Cloud
Accounts and Contacts, to synchronize the data into the sales application.

Here's how the process works:

1. The scheduled process checks for all party records (organization and person) that have the Customer usage in
Oracle Financials and that don't have a record in the Sales Accounts table (ZCA_SALES_ACCOUNTS) in the sales
application.

2. For the identified records, the process inserts new records in the Sales Accounts table, and in the Party Usages
table (HZ_PARTY_USG_ASSIGNMENTS), for Organization, Sales Account, and Person.

Keep these points in mind as well:

• The process supports the addresses associated with customer accounts and contacts, and supports address
purposes, such as "bill-to".

• After the billing process finishes, the application creates billing accounts and contacts in Oracle Financials.

Note:  Enable the Billing Accounts sub-tab from Application Composer to let your users see the customer
account number and the description.

• If you need your data to refresh regularly, it's a good idea to set up a schedule for the process using the
advanced option in the scheduled processes window.

To synchronize accounts and contacts data from Oracle Financials to your sales application:

1. Click Navigator > Tools > Scheduled Processes.
2. Click Actions > Schedule New Process and search for the Synchronize Financials Accounts and Contacts with

CX Sales process.
3. Verify that the data is synchronized in your sales application: Sign in to the Accounts pages as a user who has

access to the sales pages, such as the sales administrator or a sales representative, and view the new data.

Related Topics
• Synchronize Financials Accounts and Contacts with CX Cloud
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Integration with Third Parties  

Overview of Third-Party Integrations for Accounts  
You can use the Account, Contact, and Household interfaces to gain a comprehensive view of your customer
information. This functionality utilizes sales data, as well as relevant third-party content.

Third-Party Integrations for Sales Customers
OneSource and Siebel CRM are two third-party integrations that you can configure in sales applications. This topic
explains how you map third-party customer data to sales customers.

Map OneSource Data Sales Application
You access OneSource data directly from the OneSource node on Sales Account, Contact, and Household information
trees.

The sales application searches for OneSource company data in the following order:

1. Search based on the mappings defined in the HZ_ORIG_SYS_REFERENCES table, where orig_system is ONESOURCE.
2. Search based on the sales customer stock symbol, checked if no mapping is found in HZ_ORG_SYS_REFERENCES.
3. Search based on the sales customer name, checked if no mapping is found by the stock symbol lookup. If

multiple OneSource companies match the sales customer name, you can choose from the list of matching
OneSource companies.

Mapping Siebel CRM Service Data to Sales Application
You access mappings for Siebel CRM accounts, contacts, and groups to sales customers in the HZ_ORIG_SYS_REFERENCES
table, where orig_system is SIEBEL.

Note:  The sales application doesn't include licenses for OneSource and Siebel CRM. You must acquire third-party
application licenses separately. If you want to enable OneSource and you have a web proxy for external HTTP(S)
traffic, you must select Enable Web Proxy on the Web Proxy Configuration screen and specify your web proxy
configuration.

FAQs for Accounts and Contacts  

Frequently Asked Questions (FAQs) for Accounts and Contacts  
This section contains some frequently asked questions (FAQs) when setting up and maintaining accounts and contacts.
Scroll or search to find answers to common questions.
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How can I set Customer as the default account type?  
You can set the default account type to Customer on the create account page by changing a profile option.

To change the profile option:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Enter ZCA_ENABLE_SELLTO_ADDR_CHECKBOX in the Profile Option Code field.
3. Click Search.
4. In the Profile Option: Profile Values region, set the Profile Value to Yes.

You have now set the default value of the account type to Customer.

Tip:  To hide the Type field, use Application Composer. For more information about how to hide or show
fields in application pages, see the Configuring Applications Using Application Composer guide.

Related Topics
• Extend Application Pages for Activities

How can I prevent the validation script of the contact object from
impacting other objects such as resources and suppliers?  
You must write your application code in such a way that the validation script of the contact object doesn't impact other
object flows such as resources or suppliers.

Here's a sample Groovy code:
if (InternalFlag == 'N')
{
<your application code>
}

What happens when I delete an account?  
When you delete an account, the entire record is removed from the sales application and can't be restored.

In general, when you delete an account:

• The account party status becomes inactive in the database.
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• The deleted account doesn't appear in the accounts list, account search, account list of values, account data
quality match, segmentation, and recent items.

• The deleted account's profile and children, such as attachments and notes, can no longer be viewed.

• The account's contact relationships, if any, are deleted. The contact can still be viewed, but deleted contact
relationships aren't shown in the contact.

• Deleting an account doesn't delete account-related objects, such as opportunities, leads and tasks. You can
still view related objects and the account name on these objects, but you can no longer access the deleted
account's details.

Related Topics

What happens when I delete a contact?  
When you delete a contact, the record is removed and can't be restored.

In general, when you delete a contact:

• The person record of the contact is removed , including all profile data, customer usages, and group
memberships.

• Relationships with associated customers or sales accounts are deleted.

• Contact points or other child objects specific to the customer-contact relationship aren't shown.

• A deleted contact isn't shown or available in any other contact or customer lists. A deleted contact isn't visible
to all contact types (standalone, single, or multiple) including a customer-contact, a consumer or prospect, or in
cases where the contact is both a customer contact and a consumer or prospect.

• Even if you have the functional privilege to delete a contact, you can't delete contacts unless you have full or
edit access to at least one of the accounts associated with the contact.

Related Topics
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16  Activities

Overview of Activities  
Salespeople use the Activities pages to schedule appointments, create tasks and call reports, and view scheduled
activities on their calendars.

Key features include:

• Calendars: My Calendar provides a full set of calendar functionality. You can change colors to make calendars
more friendly-looking. Associate assets with activities so that salespeople can view the asset calendar and
manage their appointments.

• Notifications: After you set up notifications, salespeople receive them in the notifications list and can drill-down
into activities.

• Call reports: Call reports help salespeople track key updates to their sales activities.

• Delegation: After you set profile options, salespeople can delegate activities to another user.

• Default record sets: You can configure the default sets of records for salespeople to access tasks and
appointments in the Activities tab from other objects such as opportunity and leads.

See the related topics in this chapter for more setup information. See the Using Sales guide for salesperson tasks.

Activity Search and Views  

Enable the Search of All Activities  
Let salespeople search all activities by setting the profile option, All Records I Can See Enabled, to Yes. By default, the
value is No, meaning salespeople can only search activities they own or are associated with as a resource.

Setting the profile option to Yes enables the search for all activities, but only in Advanced Search. You can set the profile
option either for the whole site or for individual users.

Here's how to set the profile option.

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Activity Profile Options

2. Click the ZMM_ACTIVITY_ENABLE_ALL_RECORDS link.
3. To enable access at the site level, select Yes in the Profile Value field.
4. To enable access for specific users::

a. Click the Add icon.
b. In the Profile Level field, select User.

519

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASTG


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 16
Activities

c. In the User Name field, search for and select the user name.
d. Select Yes in the Profile Value field.

5. Click Save and Close.

Configure Default Activity Search  
Salespeople access tasks and appointments in the Activities tab from other objects such as opportunity and leads. A
search Show filter determines the default list of activities that display when a user lands on a page.

You can configure the default set of records by modifying a lookup type. The available values for Activity search types
are Open Activities, Completed Activities, and All Activities. To change the default search:

1. Navigate to the Manage Standard Lookups task in Setup and Maintenance.
2. Search for the ORA_ZMM_ACTIVITY_FILTER_TYPE lookup type.
3. Set the order of the default values to the order in which you want them to appear in the Show filter.

The application displays the first one by default, followed by the second one, and then the third one.

Note:  You can't add, delete, or change the end date of values provided in the list.

Activity Notifications and Delegation  

Set Up Activity Notifications  
You can configure company-level and user-level notifications for activities. You also can set the default appointment
reminder, and the default appointment duration, calendar view, and calendar start time.

Company-Level Notifications
For the entire company, you can specify whether users:

• Receive notifications as owners of an activity

• Receive notifications if they aren't the owners of an activity

• Receive task notifications if changes are made to completed tasks

For both appointments and tasks, you can specify:

• Whether users receive email notifications

• Whether users receive notification messages in the notifications list

Note:  If you enable email notifications at the company level, each individual user can still choose not to receive email
notifications. If you enable notifications in the notifications list, each individual user can still choose not to receive
notifications in the notification list.
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Here are the profile options for setting up company-level activity notifications:

Profile Option Name Default Value Description

Task Notification to Contacts and Consumer
Customers Enabled
 

N
 

Enables notifications to external participants
when tasks are created, updated, or deleted
 

Appointment Notification to Contacts and
Consumer Customers Enabled
 

Y
 

Enables notifications to external participants
when appointments are created, updated, or
deleted
 

Disable Appointment E-Mail Notification
 

N
 

Specifies whether to disable appointment email
notifications
 

Disable Task E-Mail Notification
 

N
 

Specifies whether to disable task email
notifications
 

Disable Task Notification List
 

N
 

Specifies whether to disable task notifications
in the notifications list
 

Disable Appointment Notification List
 

N
 

Specifies whether to disable appointment
notifications in the notifications list
 

User-Level Notifications
You can set several profile options at the user level to control the behavior of notifications. The user preferences setting
are stored in the profile options. Users can modify their notification preferences using the preferences pages, located
under their user names in the global area.

Here are the user-level profile options for activity notification preferences:

User Name Default Value Description

Appointment Owner Notifications
 

N
 

Enables receiving appointment notifications
when the user is the owner of the appointment
 

Appointment Resource Notifications
 

Y
 

Enables receiving appointment notifications
when the user is a resource or invitee of the
appointment
 

Task Owner Notifications
 

N
 

Enables receiving task notifications when the
user is the owner of the task
 

Task Resource Notifications
 

Y
 

Enables receiving task notifications when the
user is a resource on the task
 

Task Notifications For Completed Tasks
 

N
 

Enables receiving task notifications for tasks
that have already been completed
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User Name Default Value Description

Notification List Appointment Notifications
Enabled
 

Y
 

Enables receiving appointment notifications in
the notifications list
 

Email and List Appointment Notifications
Enabled
 

NA
 

Enables receiving appointment notifications in
the notifications list and through email
 

Notification List Appointment Notifications
Enabled
 

Y
 

Enables receiving appointment notifications in
the notifications list
 

E-Mail Task Notifications Enabled
 

Y
 

Enables receiving task notifications by email
 

E-Mail Appointment Reminders Enabled
 

Y
 

Enables receiving appointment reminders by
email notifications
 

Notification List Appointment Reminders
Enabled
 

N
 

Enables receiving appointment reminders in the
notifications list
 

Owner Initiated Task Notifications Enabled
 

N
 

Enables receiving task notifications when a user
creates, updates, or deletes a task and he's the
owner of the task
 

Owner Initiated Appointment Notifications
Enabled
 

N
 

Enables receiving appointment notifications
when a user creates, updates, or deletes an
appointment and she's the owner of the
appointment
 

How to Disable Notifications for the Entire Company
You can disable activity notifications globally, so that no one in the company receives notifications. To disable
notifications:

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Enter the profile option to disable email or appointment notification, in the Profile Option Code field.
Here the items you can disable and the profile options you use to disable them, company-wide:

What to Disable Profile Option

Appointment email notification
 

ZMM_ACTIVITY_DISABLE_EMAIL_APPT_NOTIF
 

Task email notification
 

ZMM_ACTIVITY_DISABLE_EMAIL_TASK_NOTIF
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What to Disable Profile Option

Appointment notification in the
notification list
 

ZMM_ACTIVITY_DISABLE_LIST_APPT_NOTIF
 

Task notification in the notification list
 

ZMM_ACTIVITY_DISABLE_LIST_TASK_NOTIF
 

3. For each item you're disabling, change the related site-level profile value to Yes.

Related Topics
• Enable Drill-Down Capabilities in Notifications

• Get Reminded When a Task Is Due

Enable Drill-Down Capabilities in Notifications  
You can enable salespeople to drill down to an activity from a notification list or an email. To use the enhanced
notifications feature, salespeople must set their preferences to accept notifications.

You enable the enhanced capabilities by opting in to the feature and setting profile options. With enhanced
notifications, salespeople can take actions on an activity from a notification list or an email. For example, they can click
a link in an email to accept or decline an appointment or mark a task as completed.

Note:  While you can revert to opt out of the enhanced notifications, Oracle recommends that you don't opt out of the
enhanced notifications between releases.

Setup Overview
Here are the high-level steps to set up enhanced notifications:

1. Opt in to the Activity Drill-down and Actionable Notification feature in Setup and Maintenance.
2. Set site-level profile options that enable the notifications.
3. Set profile options that enable users to set their preferences for notifications. The profile options can be set at

site-level or user-level.

If salespeople opt in for the capability to drill down and act from activity notifications, then they receive both a
notification list and an email. Salespeople don't have the option to choose only one type of notification.

Opt in to Activity Drill-Down and Actionable Notifications
To opt in to the Activity Drill-Down and Actionable Notifications feature:

1. Sign in as a setup user.
2. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

3. Click the drop-down button on Sales Foundation.
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4. Click Change Feature Selection.
5. In the Edit Features: Sales Foundation page, select the Enable check box for the Activity Drill-down and

Actionable Notification.
6. Click Done.

To revert to the earlier setup, clear the Enable check box and save your changes.

Set Profile Options to Enable the Notifications
Use profile options to enable email or list notifications at the site level. After you enable the profile options, if
salespeople opt in for enhanced notifications, then they receive both list and email notifications with drill-down
capabilities.

To set the profile options:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for the profile option, update it, and save your changes.

Here are the profile options to set:

Profile Display Name Profile Option Code Description

Email and List Appointment Notifications
Enabled
 

ZMM_ACTIVITY_APPT_NOTIF_LIST_EMAIL
 

Enables appointment notifications in
notification lists and emails
 

E-Mail and List Task Notifications Enabled
 

ZMM_ACTIVITY_TASK_NOTIF_LIST_EMAIL
 

Enables task notifications in notification lists
and emails
 

In addition to enabling the site-level profile options, you must also enable profile options for the user
preference settings. Here are the profile options that you enable at site or user level:

Profile Display Name Profile Option Code Description

Email and List Task Notifications Enabled as
per User Preference
 

ZMM_ACTIVITY_TASK_NOTIFICATIONS
 

Enables users to receive task notifications
in the notification list and through email
according to their preference settings
 

Email and List Appointment Notifications
Enabled as per User Preference
 

ZMM_ACTIVITY_APPT_NOTIFICATIONS
 

Enables users to receive appointment
notifications in the notification list and
through email according to their preference
settings
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Get Reminded When a Task Is Due  
You can configure the application so that salespeople are reminded by email or get an alert in the Notifications area
when their tasks are due.

To get the reminders, salespeople simply configure the default reminder period in their user preferences. As an
administrator, you can enable or disable the reminder notifications across the site and for individual users. You can
specify whether to notify users via email, notifications, or both. You can configure the default reminder profile option to
set a default reminder period based on the task due date. For example, you can configure whether to send a notification
three days before the task due date or when the task due date is reached.

Additionally, you need to enable the Due Date field on the Task Create and Task Details page layouts. See Add Due Date
Reminder Field to the UI for more information.

For the procedure to set the profile options, see Set Task Reminder Profile Options.

Set Task Reminder Profile Options  
Set profile options to configure task reminders for sales users.

Here's how to set the profile options:

Note:  These two site-wide profile options need to be enabled as well: Disable Task E-Mail Notification and Disable
Task Notification List. See Set Up Activity Notifications.

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Activity Profile Options page, access and enable these profile options:

◦ ORA_ZMM_TASK_NOTIF_LIST_REMINDER: Enable to show task reminders in the Notifications area.

◦ ORA_ZMM_TASK_EMAIL_REMINDER: Enable to show task reminders by email.

◦ ORA_ZMM_TASK_DEFAULT_REMINDER: Set a default reminder period.

3. Save your changes.

Add Due Date Reminder Field to the UI  
Add a Due Date Reminder field to the Create Task and Edit Task pages in the Activities UI to let salespeople configure
their default reminder time for tasks.

Here's how you enable the Due Date Reminder field to allow salespeople to set a reminder period

1. In an active sandbox, use Navigator to go to Configuration > Application Composer > Activity > Pages.
2. Add the Due Date Reminder  field to the Task Create and Task Details page layouts.
3. Save your changes and publish the sandbox.
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Enable Activity Delegation  
You can enable the ability for all sales users in your implementation to delegate their activities, such as calendar
appointments and tasks, to another user. To enable the delegation functionality, you set separate profile options for
appointments and tasks.

When a user delegates an activity, he simply changes the owner of the activity. After a user delegates an activity to
another user, both the user (who's the original owner) and the person to whom the activity is delegated (the new owner)
can edit or update the activity.

To enable activity delegation:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for and set two profile options according to your business needs. The following table lists the profile
options.

Profile Option Display Name Profile Option Code Description and Setting

Appointment Delegation Enabled
 

ZMM_ACTIVITY_APPT_DELEGATION
 

Enables sales users to delegate
appointments to other sales users. Set to
Yes at site level to enable all users in the site
to use the delegation feature
 

Task Delegation Enabled
 

ZMM_ACTIVITY_TASK_DELEGATION
 

Enables sales users to delegate tasks to
other sales users. Set to Yes at site level
to enable all users in the site to use the
delegation feature
 

3. Save your changes.

Activity Types and Subtypes  

About Activity Type and Subtype  
Managers can track the performance of salespeople by their activity type, such as an email or a call. Managers can
further track details of an activity using the Activity Subtype field.

526



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 16
Activities

For example, the activity type email can have subtypes of outbound, inbound, and others. The Activity Subtype field is
dependent on the Activity Type value. Each activity type has a function. The supplied functions are Appointment, Task,
and Call Report.

The application populates the type and subtype values from the parent activity to the child activity. After you add the
Activity Subtype field to the application, you can:

• Create values for the Subtype field depending on the type of activity.

• Define relationships between the two values.

• Auto-populate the type and subtype values for:

◦ Autocreated tasks, such as logging calls.

◦ Follow-up activities created in the context of an activity, such as creating a call report.

◦ Follow-up appointment or task.

• Auto-populate supplied values from the parent activity when you create a call report or a follow-up
appointment or task.

• Add a new type using the Activity Type Subtype task.

Note:  If you add a new lookup type, ensure that the lookup code tag has: APPOINTMENT:TASK:CALLREPORT.

Use Application Composer to make the Subtype field available on the create and edit pages of appointments, tasks, call
reports, and list pages in the Activities UI. Use the Manage Activity Type and Subtype task to create and edit type and
subtype values related to activities.

Add an Activity Subtype Field  
Add the Subtype field to activities so that salespeople can classify their activities in detail for each activity type, such as
an appointment, task, or call report. You enable the Subtype field in Activities using Application Composer.

Here's how to enable the Subtype field:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Account.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. On the Details Layout page, click the Reorder Subtabs icon.
7. In the Configure Subtabs dialog, move the Reference Systems subtab to the Selected Subtabs box.
8. Click OK and then click Done.
9. Test the changes and publish the sandbox according to your company's business practices.

Note:  Remember, salespeople can add subtypes only for active activity types. And, the subtype field is always
dependent on the activity type selected.
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Associate Activity Type with a Function and Subtype  
Activity types categorize the actions of salespeople. When you associate an activity type with a function and subtype,
salespeople can further classify details of an activity.

You can associate a type value with one or more activity function types, such as an appointment, task, and call report.
Then map the activity type with a subtype. Use lookups to associate a type value with a function type.

Note:  If you don't associate an activity type value with a function type, users won't be able to see that value in the
UI. For example, if you add an activity type value of Zoom, you must associate that type value with the Appointment
function type or users won't be able to see it.

Here's how to associate a type value with a function and then a subtype.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

2. Search for Manage Activity.
3. Click the Manage Activity Type and Subtype task.
4. In the Manage Activity Types: Manage Activity Types by Function page, select the relevant activity type. For

example, for the activity type Call, select Appointments, Call Reports, and Tasks. The activity type is now
mapped to the activity function.

5. Click Next. The Manage Activity Subtypes: Manage Subtypes by Activity Type page appears.
6. Map the activity type to a subtype. For example:

◦ Select Call in the Select Activity Type field and then click the add icon.

◦ Create subtypes of Inbound and Outbound.

◦ Select the Enabled option.

7. Click Save and Close. The activity type is mapped to the subtype.

Additional Configurations  

Let Salespeople Associate Addresses with Activities  
You can enable selection of addresses from a drop-down list. From the address selector users can then select an
address that's associated with an activity's account or contact.

The address for activities can be exposed on the create and edit pages of tasks, appointments or call reports.

Here's how to expose the address selector using the Application Composer:

1. Ensure you're working in an active sandbox
2. Navigate to Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Activity.
4. Click the Pages node.
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5. Ensure that the Application Pages tab is selected.
6. Scroll down to a section where you want to expose the address selector:

◦ Creation Page Layouts: Task Create, Call Report Create, Appointment Create

◦ Details Page Layouts: Task Details, Call Report Details, Appointment Details

7. Duplicate the required standard layout and edit the resulting copy.
8. Click Show next to the Address option to enable the address selector.
9. Click Done.

10. To validate whether the address selector is available on the Activities UI:

a. Navigate back to the respective Task, Appointment, or Call Report pages.
b. Click Create or Edit on the Task, Appointment, or Call Report page on which you enabled the address

selector. Ensure that you can view the address selector on the page.
11. Publish the sandbox according to your company's business practices.

View and Edit Calendar Appointments of Users  
As a sales administrator, you can view and edit the calendar appointments of your users by enabling the profile option,
Share All Appointment Details (ZMM_ACTIVITY_SHARE_ALL_APPT_DETAILS), at site level.

Here's how to set the profile option:

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for the Share All Appointment Details (ZMM_ACTIVITY_SHARE_ALL_APPT_DETAILS) profile option and
set it to Yes at site level.

Note:  The users whose appointments you want to view must not have set them to private.

Related Topics
• Make Your Calendar Appointments Visible to Others

• Can my administrator view and edit my appointments?

Allow Updating of External Appointments  
The salespeople who use the Microsoft 365 add-in can share external appointments with the sales application. Even
though the appointment is external to the company, you may want to let salespeople edit certain details, such as the
account, opportunity, and lead.

Remember that the meeting details, such as day, time, description, and location, will still be read-only.
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Here's how you can allow salespeople to update external appointments:

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option, External Appointments Editing
Enabled (ORA_ZMM_ENABLE_EXTERNAL_APPT_EDIT), and set the Site value to Yes.

3. Save and Close the page.

Note:  External appointments synced from Microsoft 365 should be linked to your sales data to allow for tracking and
analytics.

Change Calendar Colors  
You can change the color of various items on salespeople's calendars. Providing color codes makes calendars look
colorful and more friendly.

You can use any standard HTML color codes. You can find color codes in many places on the internet, for example,
http://html-color-codes.info/.

Change Calendar Colors
Here's how you change calendar colors:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Activity Standard Lookups

2. Click ZMM_ACTIVITY_TYPE.

The ZMM_ACTIVITY_TYPE: Lookup Codes area appears.
3. In the Tag field, enter an HTML color code in for each item you want to change.
4. Click Save and Close.

Related Topics
• Manage Your Calendars

Enable Default Task Status  
Administrators can set the default status of a task and provide a sequence number using the lookup type,
ZMM_ACTIVITY_STATUS_CD. The sequence that you define determines the sequence in which the task statuses are
available for selection in the list of values.
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Here's how to enable the default task status:

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Activity Standard Lookups

2. In the Manage Activity Standard Lookups page, click the ZMM_ACTIVITY_STATUS_CD link.

The ZMM_ACTIVITY_STATUS_CD: Lookup Codes area appears.
3. Enter a display sequence. The lowest sequence number defines the default status of a task.
4. Click Save and Close.

Considerations When Setting Up Call Reports  
Call reports let salespeople capture the outcome of a sales activity, make related changes, and track key updates. When
setting up call reports, consider these points:

• You can modify lookup types and profile options related to call reports.

• You can configure call reports using Oracle Application Composer, to suit the requirements of your
organization.

Modify Activity Objectives and Outcomes
Call reports record a snapshot of the outcome of a sales activity, including summaries, meeting minutes, complete
objectives, attendees, attachments, notes, and so forth. You can use the Manage Activity Standard Lookups task in the
Setup and Maintenance work area to update or modify the lookup type values for activity objectives and outcomes.

Here are the lookup types for objectives and outcomes:

Lookup Type Display Name Description

ORA_ZMM_ACTIVITY_OBJECTIVE
 

Activity Objective
 

Possible objectives of a sales activity.
 

ZMM_ACTIVITY_OUTCOME
 

Activity Outcome
 

Possible outcomes of a customer activity.
 

Enable Call Report Submissions
Use the Submit Call Report Action Enabled (ZMM_ACTIVITY_ENABLE_SUBMIT_CALL_REPORT) profile option to enable
submission of call reports. These are the options:

• Yes: The Submit button is enabled on the Create Call Report page. When you click Submit, the application sets
the call report to read-only and salespeople can't modify the call report.

• No: The Submit button isn't displayed on the Create Call Report page. This is the default value.

Access the profile option from the Manage Administrator Profile Values task in the Setup and Maintenance work area.
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Related Topics
• Track Updates with Call Reports

Enable Sales Team to Log Interactions  
You can let your salespeople manually add call logs, web conferences, wrap ups, and emails as interactions and view
them in the Interactions History subtab instead of activities.

In CX sales, these interactions are considered as activities. In Digital Sales, these are interactions tracked in the list of
Activities for each record. The Activity work area in CX sales only displays tasks and appointments. This way all the
planned communication can be tracked as activities and the actual communication will be tracked as interactions in the
sales application.

If you’re new to CX Sales or transitioning to Digital Sales, Oracle recommends you enable logging sales interactions.

To enable logging interactions, grant the required privileges and configure the setups outlined in the table here:

Prerequisite Prerequisite Type Description What You Need to Do

ZCM_MANAGE_SALES_
INTERACTIONS_PRIV

Role Privilege Enables your users to log
interactions.

Add the privilege to the users
with the sales administrator, sales
manager, and salesperson roles.

ORA_ZCA_ENABLE_TRACKING_
EMAIL_CONVERSATIONS

Profile Option Enables users to share emails as
conversations from the Microsoft
365 add-in and see them in the
Interactions History subtab. See
the topic Autosync the Email
Responses of Manually Shared
Emails for more information.

Set it to Y or Yes.

ORA_ZCA_ENABLE_TRACKING_
INTERACTIONS

Profile Option Enables users to see emails and
call logs in the Interactions History
subtab instead of activities.

Set it to Y or Yes.

SVC_MCA_RECORD_ACTIVITIES_
YN

Profile Option Generates tasks and call reports
automatically and shows them
on the Activities tab. See the
topic Configure Multichannel
Architecture (MCA) Profile
Optionsfor more information.

Set it to No.

Interactions History Subtab on the object pages. From this subtab, you can review
all the previous interactions and
add call logs and emails manually
to an opportunity or a lead.

Enable this subtab on the relevant
object pages. SeeHow to Add
the Interactions History Subtab
to Opportunities for more
information.

Log an Interaction Smart action for Workspace. Users can log interactions from the
object pages of Workspace.

Enable the smart action on relevant
object pages of Workspace from
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Prerequisite Prerequisite Type Description What You Need to Do

the Application Composer. See the
topic Manage Workspace Smart
Actions for more information.

Log a Call Smart action for Workspace. Users can log a call from the object
pages of Workspace.

Disable the smart action for all the
objects.

Where can Salespeople See and Log the Interactions
After you complete the setup, the calls and emails logged from the object pages of sales application will be available in
the Activities panel of the object foldout view in Digital Sales. Similarly, the calls and emails logged from Digital Sales will
be available in the Interactions History subtab of the object pages in the CX Sales application.
Calls and emails logged prior to enabling interactions remain in Activities and are available for historical context.

Salespeople can log the interactions using the:

• Log an Interaction button on the Interactions History subtab of the object pages of the sales application.

• Log an email button on the Interactions History subtab of the object pages of the sales application.

• Log an Interaction smart action from the Workspace action menus on all the relevant object pages of
Workspace.

Note:  Salespeople won’t be able to log a call from activities or use the Log a Call smart action on the object pages of
Workspace.
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17  Notifications

Overview of Configuring Notifications for Sales  
A notification is an alert for users, such as salespeople and managers, to notify them about an event on a business
object, such as an account, and let them take necessary actions. Enabling notifications is a global setup and feature opt-
in step.

You can generate, configure, and enable notifications for CX Sales objects such as accounts, contacts, leads, and
opportunities.

Depending on your configuration, the application sends notifications to users when there are updates to records. When
configuring notifications, you determine who receives the notifications and when they receive them.

Note:  All of these types of notifications appear at the top of the page under Notifications (the bell icon) and when
clicked, you are directed to the appropriate page for your enabled UI.

Use this chapter to learn to do these tasks:

• Enable Notifications for Sales

• Define Notification Scripts for Sales

• Set Notification Preferences for Sales

• Debug Groovy Prompts

• Configure Push Notifications

This table lists the tasks, navigation path, and topics in this chapter where you can get more information.

Step Description Navigation Where to Get More Details

1
 

Enable notifications for sales
objects.
 

Setup and Maintenance
 

Enable Notifications for Sales
 

2
 

Get an overview of the tasks to
configure notifications.
 

Application Composer > Standard
Objects > Server Scripts
 

Overview of Setting Up Notification
Scripts and Preferences
 

3
 

Define Groovy scripts using
Application Composer.
 

Application Composer > Standard
Objects > expand the object you
want > click Server Scripts
 

Define Notification Scripts for Sales
 

4
 

Configure notification rules.
 

Tools > Notification Preferences
 

Set Notification Preferences for
Sales
 

5
 

View the runtime log and debug
your Groovy script.
 

Application Composer > Expand
Objects, Common Setup > Run
Time Messages
 

Debug Groovy Prompts
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Step Description Navigation Where to Get More Details

6
 

Push notifications to mobile
devices.
 

Setup and Maintenance
 

Configure Push Notifications
 

Related Topics
• View and Act On Notifications

Enable Notifications for Sales  
You define and generate notifications with a Groovy script in Application Composer, using conditions that must be met
for each notification. When a notification is created on an account that salespeople own, you can specify the notification
recipients.

For example, you can reference sample Groovy scripts to define and activate notifications for salespeople when:

• They're added to the account team.

• They're designated as owner of an account.

• An account they own has been deleted.

• A sales object is assigned to an account.

Note:  Before you enable notifications for sales, ensure that you have enabled notifications generally. For steps,
see the topic about enabling and disabling notifications, linked in the Related Topics section. If you update the
applications, be sure to go back and check these settings again.

Notifications are lined up in a queue, and you can manually add a record to a queue by changing the owner. Or, you can
add a notification to a queue based on specific criteria. You can use a rule or condition to add leads to a queue based on
specific record criteria, for example. Records remain in a queue until they're assigned an owner.

Here's how you enable notifications.

1. Sign in as a setup user.
2. In the Setup and Maintenance go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

3. Click the drop-down button in the Sales Foundation row.
4. Click Change Feature Selection in the menu. The Edit Features: Sales Foundation page appears.
5. Select the Enable check box for the notification-related features you want to set up. This enables notifications

for the Sales objects.

Note:  This opt-in is for your chosen channel or communication path, such as bell notifications, and not for
specific objects.

6. Click Done.
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Related Topics
• Disable or Enable Workflow Notifications

• About Object Workflows

• Best Practices for Content and Layout in Workflow Notifications

Overview of Setting Up Notification Scripts and
Preferences  
After you enable the notifications feature for sales, you then configure the notifications.

Here are the overall steps:

1. Define notification prompts as Groovy scripts in Application Composer. The scripts contain the conditions that
must be met for each notification. Notifications are sent when the defined conditions are met. For example, you
can send a notification when a sales object is assigned to an account.

For more information about defining notification prompts, see Define Notification Scripts for Sales.
2. Configure notification preferences using the Notification Preferences page. For example, configure the

notification message using SmartText and specify the notification recipient.

For more information about notification preferences, see Configure Delivery Preferences and Text for a
Notification.

Define Notification Scripts for Sales  
Here's how you define a Groovy script for a notification prompt:

1. Ensure you're working in an active sandbox.
2. Click Navigator  > Configuration  > Application Composer.
3. In the navigation tree, expand Standard Objects, expand the object you want, and then click Server Scripts. For

example, Standard Objects > Account > Server Scripts.
4. Click the Triggers tab on the Server Scripts page.
5. Click the add icon.
6. In the Create Trigger Object page, create the Groovy trigger:

a. In the Trigger field, select the trigger type.

Oracle recommends that you use the trigger type After Changes Posted to Database. This trigger type
lets you to stop potential issues if the Groovy script is accidentally written to run indefinitely. If the trigger
type is set to Before Update to Database, with a bad script, you may receive errors.

If you're creating a new object, and you want to trigger a notification when the object is created, Oracle
recommends that you use the trigger type Before Insert to Database. However, some of the Before
trigger types don't have all attributes exposed yet, resulting in some fields being blank. To debug your
triggers if you're not getting the expected results, follow the steps in Debug Your Groovy Scripts.

b. Enter a name for the trigger.
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c. Enter the trigger Definition details. When you create a Groovy script, you need the API names of the
fields you're trying to access. Create your triggers based on parent/child fields, with these steps:

i. In the Trigger Definition section, click Show/Hide Expression Palette.
ii. Click the Fields tab.

iii. Select an Object.
iv. Click the Maximize Edit Script arrow. The fields for the selected object are displayed.
v. Select the API you want, and click Insert.

vi. To close the expression palette, click the Restore Edit Script arrow, and then click Show/Hide
Expression Palette.
The isAttributeChanged() function works only for the Before trigger types. The workaround for the
After trigger types involves retrieving the old value before the database is updated, then retrieving
the new value after the update, and then comparing the two values to see whether the attribute is
changed. However, this workaround works only for high-level attributes, such as CriticalFlag and
Status, and not for the ViewRow attribute.

7. Add a Groovy script. For example, if you're defining the notification for accounts, add the Account Push
notification received Groovy script.

8. Click Save and Close.
9. Navigate to the Notification Preferences page to configure your preferences for the notifications. See Configure

Delivery Preferences and Text for a Notification for more information.

Note:  You can reuse a Groovy notification prompt if no other notification uses it.

Related Topics
• Overview of Sandboxes

• Create and Activate Sandboxes

• Publish Sandboxes

Configure Delivery Preferences and Text for a
Notification  
Here's how you specify the recipient types, delivery methods, and notification text for a specific trigger event:

1. Sign in as a user with the Sales Administrator job role.
2. In the Navigator, click Tools > Notification Preferences.
3. In the Notification Preferences page, select an object from the Object list.
4. Click Add to add a blank row to the table.
5. Select Yes from the Enabled drop-down list
6. In the Override  field, select Yes or No:

Override lets you specify whether a user has the ability to opt-out of the notification. If you set it to no, users
can't opt out of the notification.

7. Select a Groovy notification prompt from the Triggering Event list.
8. Enter the notification name and description. The text you enter into the Notification Name field becomes the

first part of the notification subject.

538

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035520
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20067187
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20067977


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 17
Notifications

9. In the Recipients column, click the edit icon.
10. In the Configuration for Trigger Name window, select the notification delivery options for recipients and then

click Done.
The application sends notifications to the specified recipients only if you select at least one delivery method,
so be sure to select at least one method. In addition to getting communication through the selected delivery
method, the recipient also receives a bell notification. Select the Bell Notifications option to enable the
notifications that appear in the global header.
See the tables later in this topic for more information about the supplied recipients and delivery methods.

11. Click the New SmartText link, enter the notification text for the selected object, and then click Publish.
SmartText also lets you add variables to the notification message.

12. To delete a notification preference, select the row and click Delete. This action deletes any associated
notification text, too.

Note:  If you delete a notification that's generated using a Groovy script, you can create a new notification
using the same Groovy script, if it isn't used by another notification.

13. To modify an existing notification text, click the Update SmartText icon for the selected row.
14. Click Save.

Here are the predefined notification recipients:

Recipient Description

Manager of Owner ID
 

Manager of the notification owner
 

Owner ID
 

The one who sends or assigns the notification
 

Resource team
 

Additional resources added to an object in the Team subtab (Fusion Service only)
 

Note:
Resource teams aren't applicable for Digital Sales.
 

Here are the predefined delivery methods:

Delivery Method Description

Bell Notifications
 

Enables the bell notification for the web application
 

Mobile Notifications
 

Enables notifications on the mobile application
 

Browser Notifications
 

Enables notifications to users in the Omnichannel toolbar (Fusion Service only)
 

Email Notifications
 

Enables email notifications
 

For more information about using SmartText, see topics on using smart texts in the Using Fusion Service guide.
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Note:  In the sales applications, activities (tasks and appointments) use a different model to set up notifications.
For more information on how to set up notifications for activities, see the "Set Up Activity Notifications" topic in the
Activities chapter in the Implementing Sales guide.

Related Topics
• Set Up Activity Notifications

• How You Use SmartText in Service Requests

• SmartText Naming Conventions

Debug Your Groovy Scripts  
Use the Groovy debugger in Application Composer to debug the object functions and validations that you defined for
an object. While debugging, you can also examine object and attribute values. Access the debugger from either the
Custom Objects or Standard Objects page.

Accessing the Debugger
Access the debugger from either the Custom Objects or Standard Objects page in Application Composer.

To access the debugger:

1. In Application Composer, under the Objects tree, click either the Custom Objects or Standard Objects link.
2. On the resulting Objects page for either custom or standard objects, select the object that you want to debug

and then click the debugger icon in the table's toolbar.
The debugger icon is a ladybug.

3. On the debugger UI, examine the object functions and validations defined in Groovy for that object.

Using the Debugger
The debugger contains multiple regions, described in the following table, which you can use to debug your scripts for an
object:

Debugger Region Description

Main toolbar
 

From the toolbar, you can select the object to examine and start the debugging process.
 

Left pane region
 

This region displays the object functions and validations defined for the selected object.
 

Main script region
 

This region displays the selected Groovy script.
 

Stack region
 

This region displays the call stack. For example, assume there are two functions, Function1 and
Function2. Function1 calls Function2. When debugging within Function2, the Stack region displays
which statement from Function2 is currently being executed, as well as information about the parent
Function1 from where Function2 was called.
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Debugger Region Description

Variables region
 

This region displays variables and associated values.
 

Breakpoints tab
 

This tab displays which statement (line number) has a breakpoint. A breakpoint is a location in a
Groovy script where you want the script to pause during debugging. The debugger stops at that
statement.
 

Log tab
 

This tab displays all logs. If the script has any println() statements, then those values are captured
on this tab.
 

To use the debugger:

1. In Application Composer, under the Objects tree, click either the Custom Objects or Standard Objects link.
2. On the resulting Objects page for either custom or standard objects, select the object that you want to debug

and then click the debugger icon in the table's toolbar.
3. On the debugger UI, the left pane displays the object functions and validations defined in Groovy for that

object. Select the script that you want to review.
The script is displayed in the main script region.

4. To start debugging, click one of these icons in the toolbar:

◦ Step Over
Review one statement in the selected script at a time.

◦ Step Into
If a statement in execution is a call to some function, and you want to debug inside that function, then
click Step Into.

◦ Step Out
If you are debugging inside a child function and you want to move the control back to the parent
function, then click Step Out.

◦ Run
Move to the next breakpoint in the script. If no further breakpoints exist, then the debugger completes its
evaluation of the selected script and then closes the debugger session.

Enabling and Disabling the Debugger
The debugger is enabled by default. However, if you want to hide the debugger, or later show it again, then set the ADF:
Enable Script Debugger profile option.

To set the ADF: Enable Script Debugger profile option:

1. In the Setup and Maintenance work area, select the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
The Manage Administrator Profile Values page appears.
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2. In the Profile Display Name field, enter ADF: Enable Script Debugger and click Search.
3. In the Profile Values region, at the Site level, enter either TRUE or FALSE.

◦ TRUE displays the debugger.

◦ FALSE hides the debugger.

Sample Groovy Scripts for Notifications  
Use Groovy scripts to define the start of notifications. Here's sample code to generate notifications to the recipients
specified in the Notification Preferences page for sales objects. You can modify the scripts to fit your requirements.

Scripts for Standard Objects
Here are sample scripts for standard sales objects:

Object Scenario Create and Assign Scripts

Accounts
 

Push notification received
 

Account Create
 

// Send notification to Owner when
 Account is created
// Use trigger type BEFORE INSERT TO
 DATABASE
def map = new HashMap();
// Specify one or more channels
map.put("Channels",["ORA_SVC_BELL"]);
// Specify default MessageText
def messageText = "Account created
 with name: " + OrganizationName;
map.put("MessageText", messageText);
// The following can be used to pass
 a Long PartyId
map.put("RecipientPartyId",
 OwnerPartyId);
adf.util.sendNotification(adf, map)

Accounts
 

Drill down to details page
 

Account Assign
 

// Send notification to Owner when
 Account is assigned to them
// Use trigger type BEFORE UPDATE TO
 DATABASE
if
 (isAttributeChanged('OwnerPartyId'))
 {
 try {
 def map = new HashMap();
 def messageText = "This Account has
 been assigned to you"
 def recipientPartyId = OwnerPartyId

 // Specify one or more channels
 map.put("Channels",["ORA_SVC_
BELL"]);
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Object Scenario Create and Assign Scripts

 // Specify default MessageText
 map.put("MessageText", messageText);
 // The following can be used to pass
 a Long PartyId
 map.put("RecipientPartyId",
 recipientPartyId);

 if (recipientPartyId) {
 adf.util.sendNotification(adf, map)
 } else {
 println("No Owner associated with
 this Account")
 }
 } catch (e) {
 throw new
 oracle.jbo.ValidationException('Failure:
 ' + e.getMessage())
 }
}

Contacts
 

Push notification received
 

Contact Create
 

// Send notification to Owner when
 Contact is created
// Use trigger type BEFORE INSERT TO
 DATABASE
def map = new HashMap();
// Specify one or more channels
map.put("Channels",[ "ORA_SVC_
BELL"]);
// Specify default MessageText
def messageText = "Contact created
 with name: " + PersonName;
map.put("MessageText", messageText);
// The following can be used to pass
 a Long PartyId
map.put("RecipientPartyId",
 OwnerPartyId);
adf.util.sendNotification(adf, map)

Contacts
 

Drill down to details page
 

Contact Assign
 

// Send notification to Owner when
 Contact is assigned to them
// Use trigger type BEFORE UPDATE TO
 DATABASE
if
 (isAttributeChanged('OwnerPartyId'))
 {
 try {
 def map = new HashMap();
 def messageText = "This Contact has
 been assigned to you"
 def recipientPartyId = OwnerPartyId

 // Specify one or more channels
 map.put("Channels",[ "ORA_SVC_
BELL"]);
 // Specify default MessageText
 map.put("MessageText", messageText);
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Object Scenario Create and Assign Scripts

 // The following can be used to pass
 a Long PartyId
 map.put("RecipientPartyId",
 recipientPartyId);

 if (recipientPartyId) {
 adf.util.sendNotification(adf, map)
 } else {
 println("No Owner associated with
 this Contact")
 }
 } catch (e) {
 throw new
 oracle.jbo.ValidationException('Failure:
 ' + e.getMessage())
 }
}

Leads
 

Push notification received
 

Lead Create
 

// Send notification to Owner when
 Lead is created 
// Use trigger type BEFORE INSERT TO
 DATABASE
def map = new HashMap();
//give lead object API name
def objectCode = 'MklLeadVO'
map.put("ObjectCode", objectCode)
// Specify one or more channels
map.put("Channels",["ORA_SVC_BELL"]);
// Specify default MessageText
def messageText = "Lead created with
 name: " + Name;
map.put("MessageText", messageText);
// The following can be used to pass
 a Long PartyId
map.put("RecipientPartyId", OwnerId);
adf.util.sendNotification(adf, map);

Leads
 

Drill down to details page
 

Lead Assign
 

Lead Assign
// Send notification to Owner when
 Lead is assigned to them
// Use trigger type BEFORE UPDATE TO
 DATABASE
if (isAttributeChanged('OwnerId')) {
 try {
 def map = new HashMap();
 def messageText = "This Lead has
 been assigned to you"
 def recipientPartyId = OwnerId

 // Specify one or more channels
 map.put("Channels",["ORA_SVC_
BELL"]);
 // Specify default MessageText
 map.put("MessageText", messageText);
 // The following can be used to pass
 a Long PartyId
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Object Scenario Create and Assign Scripts

 map.put("RecipientPartyId",
 recipientPartyId);

 if (recipientPartyId) {
 adf.util.sendNotification(adf, map)
 } else {
 println("No Owner associated with
 this Lead")
 }
 } catch (e) {
 throw new
 oracle.jbo.ValidationException('Failure:
 ' + e.getMessage())
 }
}

Opportunities
 

Push notification received
 

Opportunity Create
 

// Send notification to Owner when
 Opportunity is created
// Use trigger type BEFORE INSERT TO
 DATABASE
def map = new HashMap();
// Specify one or more channels
map.put("Channels",["ORA_SVC_BELL"]);
// Specify default MessageText
def messageText = "Opportunity
 created with name: " + Name;
map.put("MessageText", messageText);
// The following can be used to pass
 a Long PartyId
map.put("RecipientPartyId",
 OwnerResourcePartyId);
adf.util.sendNotification(adf, map)

Opportunities
 

Drill down to details page
 

Opportunity Assign
 

// Send notification to Owner when
 Opportunity is assigned to them
// Use trigger type BEFORE UPDATE TO
 DATABASE
if
 (isAttributeChanged('OwnerResourcePartyId'))
 {
 try {
 def map = new HashMap();
 def messageText = "This Opportunity
 has been assigned to you"
 def recipientPartyId =
 OwnerResourcePartyId

 // Specify one or more channels
 map.put("Channels",[ "ORA_SVC_
BELL"]);
 // Specify default MessageText
 map.put("MessageText", messageText);
 // The following can be used to pass
 a Long PartyId
 map.put("RecipientPartyId",
 recipientPartyId);
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 if (recipientPartyId) {
 adf.util.sendNotification(adf, map)
 } else {
 println("No Owner associated with
 this Opportunity")
 }
 } catch (e) {
 throw new
 oracle.jbo.ValidationException('Failure:
 ' + e.getMessage())
 }
}

Tip:  In these scripts, you're only enabling the bell icon in the global header. To enable notifications for other channels
(for example, browser and mobile), use this syntax:

// Specify one or more channels

map.put("Channels",["ORA_SVC_BELL", "ORA_SVC_OMNI","ORA_SVC_MOBILE"]););

• ORA_SVC_BELL: Notifications icon in the global header

• ORA_SVC_OMNI: Notifications icon in the browser

• ORA_SVC_MOBILE: Mobile notifications

Script for Custom Objects
You can use a Groovy script to send notifications for custom objects.

Prerequisites:

• Use the global function, adf.util.sendNotification (adf, map).

• The ObjectCode needs to be explicitly passed as part of the request parameter hash map in the Groovy trigger.

• Your custom object needs to be published.

Object Scenario Create and Assign Scripts

Custom object
 

Send bell notification to the user based on the
user's party ID
 

try {
 Long recipientPartyId =
 100010037456865
 def messageText = 'A custom object
 notification (default message).'
 def objectCode='CustomObject_SR_c'
 def map = new HashMap();
 map.put("Channels", ["ORA_SVC_
BELL"]);
 map.put("MessageText", messageText);
 map.put("RecipientPartyId",
 recipientPartyId);
 map.put("ObjectCode", objectCode);
 adf.util.sendNotification(adf,map)
 println("Triggered a
 notification"); 
 } catch (e) {
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Object Scenario Create and Assign Scripts

 // Log the failure in groovy
 logging. Logs can be viewed in
 'Runtime Messages'.
 println("Failure to trigger
 notification from Groovy Script " +
 e.getMessage());
}

To find the Object Code for your custom object, navigate to the overview page for the object. The API name is listed in
the Object Information region of that page.

Configure Push Notifications  
With push notifications, users get notifications on their mobile devices. You define notifications in Application
Composer with your unique, conditional logic. Devices such as iOS and Android support push notifications.

For example, you can define alerts for upcoming milestones, reassignments, or escalations. Define the starting point to
send a notification when you assign a high-severity request to a user.

After they sign in to the mobile application, users can view a list of their notifications by clicking the Notifications icon
on the global header. They can dismiss notifications after viewing or dismiss them in bulk.

As you implement push notifications, you decide when to raise each notification. You specify whether to enable mobile
push notification alerts, or to deliver the alerts only to the bell notifications on the desktop application.

Note:  If the Notifications feature is set up, it automatically sets up bell notifications. Delivery of bell notifications
happens even if mobile notifications are disabled. Clicking a notification and navigating to the record details marks
the notification as read, and it's cleared from the notification list.

Here's how you enable push notifications:

1. Ensure you're working in an active sandbox.
2. Navigate to Setup and Maintenance.
3. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Click the drop-down button in the Sales Foundation row.

◦ Click View Feature Selection in the menu. The Edit Feature: Sales Foundation page appears.

4. Select the Enable check box for Mobile Notifications.
5. Publish the sandbox.
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18  Approval Workflows

Configure Workflow Approvals and Notifications  
With approval management in BPM Worklist, you configure workflow tasks that users act on for approvals, including
the notifications involved. For example, specify levels of approval needed, control approval routing, and configure email
notifications.

After all assignees approve a workflow task, whatever got approved takes effect. Some tasks are just FYI, and assignees
don't need to do anything. Either way, here are some examples of what you can do to configure workflow tasks,
including notifications:

• Set how many levels of approval are needed for transactions over a particular amount

• Define whom the assignees would be, based on the supervisory hierarchy in Oracle Fusion Cloud HCM

• Create approval groups so that the workflow task can be assigned to the set of users in the group instead of an
individual user

• Control when to send notifications to users involved with the task

• Disable or enable in-app or email notifications, or both

Get Started
In the Offerings work area, enable the Approval Routing Administration feature at the offering level so that these setup
tasks are available in the Application Extensions functional area:

• Manage Task Configurations

• Manage Approval Groups

These setup tasks take you to BPM Worklist, where you do most of the setup and configuration related to workflow.
But, depending on your offering, you might use a different functional area or even another approval setup task. Some
product families have pages or tools that you can use instead of, or in addition to, BPM Worklist, depending on what you
want to configure.

Manage Workflow Tasks
After users create a task, for example by submitting something for approval, you can use the Transaction Manager:
Transactions page in the Transaction Console work area to keep track of the workflow task. And also to jump in when
you need to, especially if something goes wrong.

For workflow data, you can use the tables that start with FND_BPM in the Oracle Fusion Cloud Applications Tables and
Views for Common Features guide, and the Manage Tasks API in the REST API for Common Features in Oracle Fusion
Cloud Applications guide. Don't query other tables or use other APIs that aren't documented.
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Related Topics
• Oracle Fusion Cloud Applications Tables and Views for Common Features

• REST API for Common Features in Oracle Fusion Cloud Applications

• Configure Offerings

• Update Existing Setup Data

Create Approval Groups  
An approval group is a set of specific users that can act on workflow tasks. You can set up approval rules so that tasks
can get routed to an approval group. An approval group can contain other approval groups.

• When a task is assigned to an approval group in a parallel participant, someone in the group can claim the task
and act on it. When the task is claimed, no one else in the group can act on it. But if the person who claimed the
task releases it, then someone else from the group can claim it.

• If it's a serial participant instead, the task is routed to each member of the approval group in sequence, so
everyone must act on it.

• There are two types of groups in workflow. One is the approval groups we are talking about here that you can
use in task configurations to define routing. The other is LDAP groups that are available for users to select when
they delegate or reassign tasks, but it's not recommended for them to use LDAP groups.

There aren't any predefined approval groups, so it's up to you if you want to create any. Here's how you go about it:

1. In the Setup and Maintenance work area, go to the Manage Approval Groups task in the Application
Extensions functional area.

2. In BPM Worklist, on the Approval Groups tab, click the Create Approval Group icon in the Groups toolbar.
3. On the Details page, enter the group name.
4. In the Members section, click the Add Member icon.
5. In the Add to Group dialog box, select User or Approval Group, depending on what you want to add to your

group.
6. Find and select the specific user or group, and click OK.
7. Add more members, and edit or delete any if you need to.

Note:  For approval groups that you plan to use in serial participants, add members in the order that you want
tasks to get assigned. If you add User 1, User 2, and then User 3, the task is first assigned to User 1, then User
2, and finally User 3.

8. Click Save.

CAUTION:  Don't delete your approval group if it's used in at least one approval rule. You can still edit the group.

Configure Approval Rule Sets and Rules  
Rule sets and rules control how a workflow task is routed, assigned, and completed, based on specific conditions. For
example, a rule can say that transactions over a certain amount must have approvals up three levels in the management
chain.
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A workflow task has one or more rule sets, and a rule set has one or more rules. At run time, if a rule set has multiple
rules, all the rules are evaluated at the same time. A rule has two parts, an If section that has the conditions, or tests,
and a Then section that has the actions to take when the conditions are met.

Configure Rule Sets
First, create or find the rule set you want to work on:

1. In the Setup and Maintenance work area, go to the Manage Task Configurations task in the Application
Extensions functional area. Or, depending on your offering, you might use a different functional area or
another approval setup task.

2. In BPM Worklist, on the Task Configuration tab, search for the workflow task in the Tasks to be configured
pane.

3. Select the task from the search results and click the Edit task icon in the toolbar.

Note:  You may see a message saying that flexfields have been modified. This means someone used
Application Composer to create new fields, which creates flexfields on the back end. Click the Start
Synchronization button to get the latest set of flexfields that you can use for the rules in this task.

4. Click the Assignees subtab.
5. If the diagram mapping out the workflow task is big, click the Switch to Vertical Layout link.
6. In the diagram, find the participant you want to work on. Click the Go to rule icon and select Go to rule. Or,

select the participant and, in the pane after the diagram, click the link in the Business rule field.
7. Go on to work on the rule set that's displayed on the Rules tab. Or, from the drop-down list with rule set names,

select another rule set to edit, or select Add New Rule Set.
8. Click the View Properties link after the rule set name to see the Effective Date setting and Active check box.

The rule set needs to be effective and active to apply when people create workflow tasks. It's a good idea to
leave the effective date set to Always.

CAUTION:  From here, you can also click the Delete Rule Set link. Before you delete any predefined rule
sets, make sure you’re really not using it and never will. Don’t delete the predefined Modification Rules and
Substitution Rules rule sets.

9. In the Rules pane, you can add, edit, or delete rules in the rule set. Expand the rule if it's not already. As with the
rule set, you can click the Show Advanced Settings icon for a rule to make sure that the rule is effective and
active.

◦ Create: Click the Advanced Add or Modify Options icon and select General Rule.

◦ Edit: Select the rule if it's not already.

◦ Delete: Select the rule and click the Delete icon in the toolbar in the Rules pane.

For the rule you’re creating or editing, you can click the Properties link after the rule name to rename the rule
and make sure that the rule is effective and active.

Here's a screenshot to help us understand what we see in the Rules subtab on the Assignees tab:
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Callout Number What It Is

1
 

The rule set drop-down list, where you can select a rule set to work on or create a new rule set.
 

2
 

The link to open properties for the rule set.
 

3
 

The Rules pane, which lists the rules within the rules set and has a toolbar for working on those rules,
 for example to add or delete them.
 

4
 

The names of the rule that’s selected in the Rules pane, followed by a link to open properties for that
rule.
 

5 The If section of the rule, where the conditions are defined and there’s a toolbar for working on those
conditions.

6 The Then section of the rule, which defines what happens when the conditions are met. There’s also a
toolbar specific to this section.

Configure the If Section in Rules
In the If section of the rule, define conditions for the rule. Each line in this section is called a test.

1. For existing conditions, click on the line that you want to edit, making it active and selected. To add a new line,
click the Advanced Add or Modify Options icon and select a type to add, for example simple test.

2. Click the Left Value icon to select an attribute in the Condition Browser dialog box.
3. Select an operator.
4. Click the Right Value icon to select something from the Condition Browser dialog box, or enter a value in the

corresponding field.

552



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 18
Approval Workflows

5. If you’re not working on the last line, you can click the and or or link at the end of the line to toggle between the
two.

CAUTION:  If the attribute you're evaluating in the condition is optional, users might not have entered a value
for that attribute in the UI. For your rule to work properly, it's highly recommended that you first have a line
in the condition that checks if the attribute isn't blank. So that means you select the attribute, select isn't as
the operator, amd enter null. Then add another line with the condition that you're evaluating the attribute for,
and make sure you have an and between the two lines.

To delete a line, put your cursor in any field in the line, and click the Delete icon.

Configure the Then Section in Rules
In the Then section of the rule, define what happens when the conditions in the If section are met.

1. Edit any existing actions. Or, click the Insert Action icon, and you usually select Add Approver and then a list
builder, which controls how to route the task.

2. Fill in the rest of the section. The fields you get depends on the list builder, but here are some that you might
use.

Field What This Is

Response Type
 

Required: The assignee needs to take action, for example to approve or reject.
 
FYI: The assignee doesn't need to take action.
 

Number of Levels
 

Number of levels required for the task to be completely approved, from the starting participant
to the top participant.
 

Starting Participant
 

The first assignee in the approval chain.
 

Top Participant
 

The last assignee in the approval chain if the chain goes up that high. Approvals don't go
beyond this participant, for example in the supervisory hierarchy.
 

Auto Action Enabled
 

If set to True, there's an automatic action that is taken on the task when the rule conditions are
met.
 

Auto Action
 

"APPROVE": The task is automatically approved.
 
"REJECT": The task is automatically rejected.
 

Rule Name
 

The name of the rule with the Then section that you want to use.
 

◦ Leave the field with the name of the rule you're working on, to indicate that this rule will
use the Then section defined here for this rule.

◦ Or, you can enter the name of an existing rule from any task, enclosed with quotation
marks, and leave all the other fields in this Then section blank. The Then section in the

553



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 18
Approval Workflows

Field What This Is

rule you entered would apply to this rule you're working on. So basically, you're reusing the
Then section from another rule.

To select the starting or top participant:

a. Click the Starting Participant or Top Participant icon.
b. In the Add Hierarchy Participant dialog box, select the Get User option for a particular user, or Get

Manager for an attribute, such as the task creator.
c. For the Get Manager option only, select the list builder that's used for the rule.
d. For the Get User option, enter in the Reference User field the user ID that the user signs in with, enclosed

in quotation marks, for example "KLEE".

For the Get Manager option, here's what you do for the Reference User field:

i. Click the Expression Builder icon.
i. In the Variables tab of the Expression Builder, select the attribute you want in the hierarchy. For

example, expand Task > payload and find your attribute there.
ii. Click the Insert Into Expression button.

iii. Click OK.
e. Leave the Effective Date field blank to use the latest hierarchy, for example supervisory hierarchy.
f. Click OK.

What shows up in the Starting Participant or Top Participant field reflects what you have in the Add Hierarchy
Participant dialog box. Here are a couple of examples.

◦ HierarchyBuilder.getManager("supervisory",Task.payload.Owner User Name,-1,"","")

Part of the Participant Value What This Means

getManager

 
You selected the Get Manager option.
 

"supervisory"

 
You selected the Supervisory list builder.
 

Task.payload.Owner User Name

 
For the Reference User field, you went to Task > payload > Owner User Name in the
Variables tab to select the Owner User Name attribute.
 

-1

 
This is the default value, which corresponds to the primary employment assignment. That
supervisory hierarchy will be used to find assignees for the task.
 

"",""

 
You left the Hierarchy Type and Effective Date fields blank, so there's nothing between
the quotation marks.
 

554



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 18
Approval Workflows

◦ HierarchyBuilder.getPrincipal("KLEE","","")

Part of the Participant Value What This Means

getPrincipal

 
You selected the Get User option.
 

"KLEE"

 
For the Reference User field, you entered "KLEE".
 

"",""

 
You left the Hierarchy Type and Effective Date fields blank, so there's nothing between
the quotation marks.
 

Example of a Rule
Let's take a look at an example of a rule. In the If section, we have two tests, the first checking if an attribute is a specific
value, the second checking if an attribute is more than a certain amount. The attribute names reflect where the attribute
is in the hierarchy you get in the Condition Browser dialog box. The and connecting the two tests means that both
conditions must be met.

In the Then section, there's the action that applies if the conditions are met, and it's defined based on a Supervisory list
builder. Assignees must take action, and only one approval is needed.
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Test and Apply Your Rule Set
1. Click the Validate button in the Assignees tab to see if there’s anything wrong with the rules that needs to be

fixed. Results appear in the Business Rule Validation – Log subtab after the Rules subtab.
2. In the Tasks to be configured toolbar, click the Commit task icon when you're ready to roll out your changes.

Related Topics
• Search for Workflow Tasks to Configure

• Overview of Flexfields

• Define Fields

• Assignments
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Disable or Enable Workflow Notifications  
If you have BPM Workflow System Admin Role (BPMWorkflowAdmin), you can disable or enable email and in-
app notifications for all users. For example, disable when testing changes to approval rules, to avoid sending test
notifications. When done testing, reenable notifications.

When workflow tasks are assigned to users, they can get email notifications, as well as in-app notifications from a few
places:

• The Things to Finish section on the home page.

• The notifications list in the global header.

• The Notifications page, which users can open from either of the first two places to see all their in-app
notifications.

Here are things to know about disabling workflow notifications:

• You disable only email notifications that are sent as part of workflow tasks, not all emails in general.

• Users can still find their workflow tasks in the Worklist: Notifications and Approvals work area.

Set the Notification Mode
Here's how you disable or enable workflow notifications:

1. Click the Notifications icon in the global header.
2. Click Show All.
3. On the Notifications page, click the Worklist button.
4. In BPM Worklist, click your user name and select Administration.
5. On the Administration tab, open the Application Preferences page and go to the Notification section.
6. Select a value from the Notification Mode list:

◦ All: This is the default value.

- Email notifications are enabled.
- Workflow notifications are included in the global header, home page, and Notifications page.

◦ None:

- Email notifications are disabled.
- Workflow notifications aren't included in the global header, home page, and Notifications page.

◦ Email:

- Email notifications are enabled.
- New workflow notifications won't appear in the global header, home page, and Notifications page.

◦ In-app:

- Email notifications are no longer sent.
- Workflow notifications in the global header, home page, and Notifications page are enabled.

7. Click Save.
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Related Topics
• More Setup for Workflow Email Notifications

• Send Test Workflow Email Notifications to One Address

• View and Act On Notifications

Define When to Automatically Dismiss or Withdraw
Workflow Tasks  
For a workflow task to be purged and removed from users' worklists, it must have a final status, like Completed or
Withdrawn. FYI tasks must be dismissed. You can control when FYI tasks are eligible to be automatically dismissed.

Tasks go from the Assigned status to the Completed status when the final assignee approves or rejects the tasks. For
your information (FYI) tasks get a final status when assignees explicitly dismiss the tasks. If assignees don't do anything
within a certain period of time that result in a final task status, the tasks are automatically dismissed (FYI tasks) or
withdrawn (all other tasks).

When FYI Tasks Are Eligible to Be Automatically Dismissed
The FYI Notifications Expiration Period (FND_NOTIFICATION_EXP_PERIOD) profile option controls when FYI tasks are
eligible to be automatically dismissed.

1. In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values
task in the Application Extensions functional area.

2. On the Manage Applications Core Administrator Profile Values page, leave the profile option with the default
value of 7 at the Site level, or replace it with a different number.

The profile value represents the number of days after the FYI task is created. When assignees don't read or dismiss an
FYI task within this many days after the task was created, the task is then eligible to get automatically dismissed.

When All Other Tasks Are Eligible to Be Automatically Withdrawn
All other tasks (the ones that aren't FYI) are eligible to be automatically withdrawn if both of these things happen:

• The expiration settings for the particular task is set to Do Nothing on the Deadlines subtab, within the Task
Configuration tab in BPM Worklist.

• Assignees don't take action to send the task to a final status within 180 days after the task was created. This
number is reflected in the Open Tasks Withdrawn After Number of Days field on the Application Preferences
page, which you can open by clicking the Administration tab in BPM Worklist.

When Eligible Tasks Are Automatically Dismissed or Withdrawn
Now we know when tasks are eligible, but when are they actually dismissed or withdrawn automatically?

• FYI tasks: A process runs every three days, starting the first day of each month. For example, it runs on May 1,
4, 7, and so on, and again on June 1 and every three days after. So, if you leave the FYI Notifications Expiration
Period profile value at 7, depending on when the process runs, an FYI task can be automatically dismissed
within seven to ten days after it's created. The process changes the task status from Assigned to Completed.
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• All other tasks: A process runs every three days, starting the second day of each month. For example, it runs on
May 2, 5, 8, and so on, and again on June 2 and every three days after. The process changes the task status to
Withdrawn.

Related Topics
• Set Profile Option Values

• Update Existing Setup Data

• Define the Due Date and Expiration Policies for Workflow Tasks

Synchronize Notifications in the Global Header and
Home Page with Workflow Tasks  
Users can get in-app notifications for the same workflow task in various UIs, as well as email notifications. The
Synchronize Notifications in Global Header scheduled process ensures that all the in-app notification UIs reflect the
latest task status.

When workflow tasks are assigned to users, they can get an email as well as a notification in the global header and
in the Things to Finish section on the home page. Updates they make to tasks from the global header, for example
approving them, are automatically reflected in the Things to Finish section. Same goes the other way around, too.

But, the notifications don't immediately reflect changes to the task status if users take action through email, the
Worklist: Notifications and Approvals work area, or BPM Worklist. For example, after you approve a task from email, you
can still see the notification in the global header and home page asking for approval. Another case like that's when a
task is assigned to an approval group, and everyone in the group gets a notification. Say you approve that task from the
Things to Finish section. Your notification is removed from that section and the notifications list in the global header,
but the same notification is still there for everyone else in the approval group.

So, use the Synchronize Notifications in Global Header scheduled process to synchronize notifications with the latest
task status for all users:

• This affects the notifications list in the global header, the Things to Finish section, and the Notifications page
that shows all notifications, not just what's pending for the user.

• The process includes notifications not just for tasks that require action, but also ones that are just FYI.

• The process doesn't update the title of notifications in the global header, home page, or Notifications page. Like
email subjects, the notification titles are static.

Note:  No matter what the task status is, the scheduled process also removes notifications that are older than 30 days
from the notifications list, Things to Finish section, and Notifications page.

Even when notifications aren't in sync with the latest workflow task status, users can still find the latest task status in the
Worklist: Notifications and Approvals work area.

Schedule the Process
In the Scheduled Processes work area, submit the Synchronize Notifications in Global Header process to run on a
schedule. It's recommended that you schedule the process to run every two hours. How often you should run the
process depends on the volume of approvals. For example, there might be more during month-end or year-end

559

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20052787
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051179
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20067961


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 18
Approval Workflows

activities. But if you do need to run the process more frequently, don't schedule it to run more often than every 30
minutes.

How long the process takes to run also depends on the volume of approvals. If you're running the process for the first
time, or it hasn't run in a very long time, then the process might take hours to finish.

You need to have the Manage Scheduled Job Definition (FND_MANAGE_SCHEDULED_JOB_DEFINITION_PRIV) privilege
to run this process. Predefined administrator job roles for product families have this privilege.

What Happens After Synchronization
One key thing that affects what users see in the notifications list, Things to Finish section, or Notifications page is
whether the workflow task is pending for the user. Here's an example of what happens before and after the scheduled
process runs:

1. A notification is pending a user's approval.
2. The user approves the task from email. The task status changes, but the notification requesting approval is still

in the global header and Things to Finish section.
3. After synchronization, because the task status is Completed and the task is no longer pending for the user,

here's what happens to the notification:

◦ It's removed from the list in the global header.

◦ It's no longer a card in the Things to Finish section.

◦ On the Notifications page, it moves from the Assigned to Me tab to the All tab.

Related Topics
• Submit Scheduled Processes and Process Sets

How Workflow Tasks Are Archived and Purged  
Workflow tasks with a final status of Completed, Errored, Expired, or Withdrawn can be archived and purged. In progress
tasks with statuses like Assigned, Information Requested, or Suspended aren't eligible.

• Archiving keeps a copy of the task data for audit, data retention or analysis, and other purposes. Archived
data includes task details, approval history, comments, and attachments. How you view or use the archived
data depends on the products you're using. For example, the data might be displayed in a table on a page, or
available through a business intelligence subject area that you can select to create an analysis.
These are the database tables that store the archived data:

◦ FND_BPM_TASK_B

◦ FND_BPM_TASK_TL

◦ FND_BPM_TASK_HISTORY_B

◦ FND_BPM_TASK_HISTORY_TL

◦ FND_BPM_TASK_ASSIGNEE

◦ FND_BPM_TASK_COMMENT

◦ FND_BPM_TASK_ATTACHMENT
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• Purging removes the completed tasks from users' worklists and permanently deletes the original data.

Archive
Tasks are automatically archived once a day without you having to set anything up. You can't change or stop this
automatic archive, which includes all eligible tasks that aren't archived yet. These scheduled processes run in this order
to get the daily archive done:

• Extract Workflow Tasks for Archive

• Process Translations for Workflow Tasks Archive

• Upload Workflow Task Attachments for Archive

All three scheduled processes must complete for tasks to get archived. But, as soon as Extract Workflow Tasks for
Archive is done, the tasks are available for purge. It usually takes around two hours for each automatic process to finish.

Though unlikely, if you ever need to archive more frequently, you can use the Scheduled Processes work area to
manually run these processes. But it's best not to unless it's really necessary. In which case, keep these in mind:

• Run the processes in the same order that they're run for the automatic archive.

• Don't run these processes when any of three processes are still running, including the automatic runs.

• Run the processes during off hours, but not at midnight when the purge is running.

• Optionally set parameters for the Extract Workflow Tasks for Archive process. Let's say you select 50000 for
the Number of Tasks in Batch parameter and 120 for the Maximum Runtime in Minutes parameter. That means
the process will archive in batches of 50000 workflow tasks. If it's still running after two hours, the process
finishes archiving the current batch and then stops. You can check the log file of the process to see how many
tasks are included in the archive.

If the automatic archive isn't working, don't manually run the processes to compensate. Instead, contact your help desk
to ensure that the automatic archive works again.

Purge
Archived tasks that were last updated over 30 days ago are purged without you doing any setup. The purge runs daily at
midnight. You can't change or stop this automatic purge.

After a task is purged, users can no longer find it in BPM Worklist or the Worklist: Notifications and Approvals work area.
The task's approval history won't be available either. But, the tasks are still in the archive tables and available in analytics
or anything else that reflects the archived data.

Related Topics
• Submit Scheduled Processes and Process Sets

• View Status and Other Details for Scheduled Processes

• Oracle Fusion Cloud Applications Tables and Views for Common Features

Roles for Workflow Administration Access  
Predefined roles provide access to workflow administration functionality. Users with the workflow roles can perform
tasks such as setting up approval rules and managing submitted approval tasks.
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This table identifies the predefined Oracle Business Process Management (BPM) role for sales workflow administration
access, and the predefined job roles that inherit it. It also shows the BPM role that provides workflow administration
access for all product families. You can assign a predefined BPM role to a custom job role, if required.

Product Family Role Name and Code Inherited by Job Role

Sales
 

BPM Workflow Customer Relationship
Management Administrator
 
BPMWorkflowCRMAdmin
 

Corporate Marketing Manager
 
Customer Relationship Management
Application Administrator
 
Marketing Analyst
 
Marketing Manager
 
Marketing Operations Manager
 
Marketing VP
 
Sales Lead Qualifier
 

All
 

BPM Workflow All Domains Administrator Role
 
BPMWorkflowAllDomainsAdmin
 

This role isn't assigned to any predefined job
role, but you can add it to custom job roles.
 

Search for Workflow Tasks to Configure  
Some workflow setup applies to all tasks, but most of the time you configure specific tasks. To work on a specific
workflow task in BPM Worklist, you first run a search and then select the task from the search results.

1. In the Setup and Maintenance work area, go to the Manage Task Configurations task in the Application
Extensions functional area. Or, depending on your offering, you might use a different functional area or
another approval setup task.

2. In BPM Worklist, on the Task Configuration tab, run a search in the Tasks to be configured pane.
3. If you don't get any results, or the ones you want, change your search term and try again.

Here are some things to know about the search:

• This searches against various attributes, for example the task title (the one on the General subtab that appears
on the Task Configuration tab after you select a task from the search results), application name, and category.
But, the search doesn't match against the task name you see in the search results.

• The search is case-sensitive.

• Search by * if you want all tasks in the search results.

• Only default tasks are included in the search results. You can click Show and select the Active Versions check
box to get both default and active tasks.

Related Topics
• Update Existing Setup Data
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19  Products

Overview of Sales Products  
Create and edit products in your sales application and then use these products in your sales catalog. The sales catalog is
the source for product groups and products in leads, opportunities, contracts, and service requests.

Revenue entered for products (and product groups) drives metrics for sales forecasting and salesperson quota.

Sales Products Tasks
As the sales administrator, here are your typical sales products tasks:

• Create products, view products, and edit products and have them automatically updated in the back-end
product model.

• Price "standalone" products directly in price books or in the Edit Product page.

• Add images and attachments to products

• Add products to your sales catalog

• Mark products as usable in service requests and customer self-service applications

• Import products and create and update products using Import Management

• Create and update products using REST or SOAP web services

For more information about importing products, see the Implementing Sales guide. For more information about REST
and SOAP web services support for products, see the REST API and SOAP web services guides available on Oracle Help
Center.

Integration with Other Applications
You can integrate sales products with other applications to provide additional functionality. Here's an overview of sales
products integrations with other applications:

Functionality Integrating Application Where to Find More Information

Sales product changes are automatically
updated in the product model
 

Oracle Supply Chain Management (SCM) Cloud
 

• Oracle SCM Cloud Implementing Product
Management guide

• Oracle SCM Cloud Using Product Master
Data Management guide

• Products chapter in the Implementing
Sales guide

Use products in the sales catalog
 

Sales Catalog
 

• Sales Catalogs chapter in this guide

• Opportunity Products and Revenue
chapter in the Using Sales guide

Use products in leads
 

Leads
 

• Leads chapter in this guide

563

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSI


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 19
Products

Functionality Integrating Application Where to Find More Information

• Leads chapter in the Using Sales guide

Use products in opportunities
 

Opportunities
 

• Opportunity Products and Revenue
chapter in this guide

• Opportunity Products and Revenue
chapter in the Using Sales guide

Use products in service requests and mark
them as customer self-service enabled
 

• Oracle Fusion Service

• Oracle Digital Customer Service

• Third-party customer self-service
applications

• Implementing Fusion Service guide

• Using Fusion Service guide

Related Topics
• Download the Macros for Importing Products and Product Groups

• Import Your Product Data

• Overview of Opportunity Products and Revenue

Setup Tasks  

Sales Products High-Level Setup Steps  
Set up sales products so that you can use them in your sales catalog. The setup involves a number of implementation
steps.

Use the additional topics in this chapter and in other guides to understand all of the setup steps.

Setup Steps for Sales Products
Here are the high-level steps to set up sales products:

Step Description Where to Find More Information

Ensure the setup prerequisites:
 

1. Set up units of measure (UOMs)
2. Create a location
3. Create an item master organization
4. Identify the Item Master Organization as

the source of import data
5. Specify the item master for sales products

1. UOMs: UOMs are standard definitions for
product measurements; therefore, you
must set up UOMs.

2. Location: You must create a location for
your organization location is required for
creating another prerequisite for products:
the item master organization.

3. Item Master: The item master organization
contains definitions of items that you can
use across one or more item and inventory
organizations.

See the Overview of Sales Catalog Setup topic
in the Implementing Sales guide.
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Step Description Where to Find More Information

Note:  We highly recommend you use the
Setup Assistant to set up your catalog. The
Sales Assistant creates the root product
group for you and performs other steps that
you would otherwise need to do manually.

4. Import Data Source: If you're importing
products, you must specify the item
organization as the default source of the
import data using the Manage Spoke
Systems task.

5. Item master for Sales: You must set the
Sales Products Item Organization profile
option to the item master organization the
sales products are defined in.

Add products to the application
 

Use the Sales > Products UI to create and edit
the products you sell. Or, use the import macros
to import products.
 

See:
 

• The Create Products topic in this chapter

• For import information, see the Download
the Macros for Importing Products and
Product Groups topic in the Implementing
Sales guide

Set attributes for products you plan to sell
 

Set these attributes according to your business
needs:
 

• Eligible to Sell

• Eligible for Service

• Enable Customer Self-Service

The topic in this chapter, Product Attributes You
Must Set
 
Also see the Implementing Fusion Service guide,
 if you plan to integrate with Oracle Fusion
Service
 

Add products to the sales catalog
 

Add your sales products to the sales catalog
hierarchy in order to make them available in
opportunities, leads, and contracts.
 

The topic, Add Products to the Catalog, in the
Sales Catalog chapter of this guide
 

Run the required scheduled process
 

Run the Import Sales Products scheduled
process anytime you update or create products
in the SCM Cloud Product Model.
 

The topic in this chapter,Import Sales Products
Process
 

Build the search keyword index
 

Build the item keyword index so that imported
products are available in the browse catalog
view.
 

The Build the Item Keyword Index topic in this
chapter
 

Enhance product display with attachments and
images
 

Optionally, enhance the look and feel of your
products in the catalog with attachments and
images.
 

• The topic in this chapter, Add
Attachments, URLs, and Images

• The topic, Edit Product Details, in this
chapter

Set up eligibility rules for products
 

Optionally, implement eligibility rules that
enable salespeople to check product eligibility
in opportunities.
 

The topic, Set Up Product Eligibility, in this
chapter
 

Modify the list of values for the Product Type
lookup type
 

Optionally, modify the list of product types that
display in the sales UI.
 

These topics:
 

• Significance of the Sales Product Type
Field

• General topics about lookup types
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Step Description Where to Find More Information

Understand how sales products and the SCM
Cloud Product Model fit together
 

When you create or update product
information in sales, the product information
is automatically updated in the SCM Cloud
Product Model.
 
Keep in mind that certain attributes in products
are named differently and map to different
attributes in the SCM Cloud Product Model.
For example, in products, the Number field
maps to the Item field the SCM Cloud Items UI.
Similarly, the Name field in products maps to
the Description field in the SCM Cloud Items UI.
 

These topics:
 

• How Sales Products and SCM Cloud
Products Work Together

• Create Products

These guides:
 

• Oracle SCM Cloud Implementing Product
Management

• Oracle SCM Cloud Using Product Master
Data Management

Understand supported item life cycle phases
and item classes for sales products
 

Remember that sales products support only:
 

• Production life cycle phase

• Root item class

These sections in this topic:
 

• Sales Products Support a Single Product
Life Cycle

• Sales Products Use the Supplied Root Item
Class

The topic, Set Up Item Lifecycle Phases, in
the Oracle SCM Cloud Implementing Product
Management guide
 

Understand how the sales products business
logic interacts with the Oracle SCM Cloud
Product Model
 

Product data follows specific business logic that
relates to the Oracle SCM Product Model.
 

The topic, Sales Products Business Object Logic,
 in this chapter
 

Display additional details about products using
extensible flexfields in the Product Model
 

After you set up extensible flexfields and add
more details to products, salespeople can
browse the catalog and drill down further to
view more details about the products. This
setup requires a license to Oracle Fusion
Product Hub (part of SCM).
 

The article, Extensible Flexfield Data
Configuration for Product Information
Management (Doc ID 2091164.1), available on
My Oracle Support
 

Sales Products Support a Single Product Life Cycle
Sales products functionality supports a single product life cycle, called Production. If this default life cycle meets your
business requirements, no implementation steps are required around product life cycle.

Sales Products Use the Supplied Root Item Class
By default, sales products functionality uses the supplied Root item class to classify products. Additional classifications
are only available if you license the Product Hub.

Sales Products Support Custom Inventory Item Status Codes
When setting up products, you can use custom inventory Item Status codes. These codes don't have to be set as Active
either. As long as you have the attributes like Eligible to Sell and Eligible to Service enabled, then products with custom
inventory Item Status codes show up in your sales applications.
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This change applies to these flows:

• A user adds a product to the product catalog

• A user adds a product to a transaction (for example, she adds a product to an opportunity or lead using the
standard list of values or by browsing the catalog)

• You add a product to a price book

• Select product using custom product dynamic choice list

To read more about inventory Item Status codes, see the Oracle SCM Cloud Using Product Master Data Management
guide.

Related Topics
• Data Import Options

• Item Specifications and Attributes

Product Attributes You Must Set  
When implementing products, set the attributes described here according to your business needs:

Attribute What It Does

Eligible to Sell
 

The attribute marks a product as available in the consuming sales applications. You enable or
disable this attribute in the edit product pages. It can also be updated using web services or Import
Management. This attribute interacts with the SCM Cloud item attributes Customer Orders Enabled
and Orderable on the Web. Keep in mind the following points about the attribute:
 

• All sales products must have the check box checked to be visible in consuming sales applications.

• If the check box is unchecked, then the SCM Cloud item attributes Customer Orders Enabled and
Orderable on the Web are set to no.

• If the check box is checked, then the SCM Cloud item attribute Customer Orders Enabled is set to
yes.

Note:
After you create a product using the simplified products UI, you can't delete it. To "hide" products in
consuming applications, deselect the Eligible to Sell indicator in the product details screen. You can
delete products in the Product Model, and then after you run the scheduled process, Import Sales
Products from PIM Data Hub, the products are removed from sales. To understand how to delete
products in the Product Model, see the Using Product Master Data Management guide.
 

Eligible for Service
 

The attribute makes a product available in the service application. You enable or disable this attribute
in the edit product pages. It can also be updated using web services or Import Management. This
attribute interacts with the SCM Cloud item attribute Service Request. Keep in mind the following
points about the attribute:
 

• All serviceable products must have the check box checked to be visible in the service request
application.

• If the check box is checked in the sales product pages, then the Service Request indicator in SCM
Cloud is enabled.
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Attribute What It Does

• If the check box is unchecked after being checked in the sales products pages, then the
corresponding SCM Cloud item attribute Service Request is set to null.

• If, in SCM Cloud, the Service Request attribute is disabled, inactive, or null, then the application
clears the Eligible for Service check box in the sales products pages.

Enable for Customer Self-Service
 

The attribute makes a product available in consuming self-service customer applications, such as
Oracle Digital Customer Service. You enable or disable this attribute in the edit product pages. You can
also update it when adding a product to the catalog. Furthermore, it can also be updated using web
services or Import Management. This attribute interacts with the SCM Cloud item attribute Enabled for
Customer Self-Service.
 

Service and Self-Service Attributes Examples:
Here are some examples of using the service and self-service attributes:

Example 1

A company that sells electronics has externally-exposed products, such as televisions, appliances, video games, and
so on, that are eligible to be serviced. Internally, the company tracks products that go into making these external
products, such as cables or peripherals. In this scenario, the company marks all externally-exposed products that can be
serviced with Enable Customer Self-Service indicator as yes, while all of the internal products (for example, cables and
peripherals) that aren't self-service-enabled, with the indicator as no.

Example 2

Using a self-service application, a customer requests service on all current models. In this case, these models would be
eligible-for-service enabled and customer self-service enabled. However, if the customer wants service on, for example,
an older model, then he calls a service agent and the service agent can request service on the old model. In this case,
the old model would be eligible-for-service enabled, but customer self-service would be disabled.

Import Sales Products Process  
Run the Import Sales Products from PIM Data Hub scheduled process any time you update or create products in the
SCM Cloud Product Model.

You must run this scheduled process so that products you have created (or those you updated) in the Product Model
show up in the sales Products UI.

Here are the steps:

1. Sign in as a setup user and navigate to Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog window, click the down-arrow next to the Name field and click Search.
4. In the Search dialog window, enter %Sales%Products%, and click Search.
5. Select the Import Sales Products from PIM Data Hub process in the results that are returned and click Ok.
6. Click Ok again, if needed.
7. In the Process Details window, click Submit.
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Build the Item Keyword Index  
The item keyword index lets Product Model users quickly locate products in the search list of values. For sales
applications you must build the item keyword index so that products are available in the browse catalog view in sales
applications like opportunities and leads.

Here are high-level steps to build the index. For complete details, see the topic on building the item keyword index in the
Oracle SCM Cloud Implementing Product Management guide.

1. In the Setup and Maintenance work area, select the Manage Item Keyword Search Attributes task.

◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Manage Item Keyword Search Attributes

2. Select the attributes that you want to use in the indexing process.
3. Click Index from the global header region and choose from these indexing options:

◦ Create Index: This action lets you start the indexing process using the current configuration of
attributes, organizations, and languages.

◦ Schedule Indexing: This action gives you the option of scheduling the indexing process. The indexing is
run based on your selections on this page.
This initiates the indexing process.

Related Topics
• Build Item Keyword Index

Set Up Product Eligibility  
Product eligibility lets salespeople check whether products added to opportunities are eligible to sell based on rules that
you set up.

For example, you sell software, and government regulations prevent you from selling certain types of software to
certain countries.

So you set up rules to keep salespeople from selling these products to customers with locations in these countries.
Salespeople can click the Check Eligibility button in the opportunity Products table to check whether products are
eligible to sell.

Setup Overview
Perform the steps listed here to enable eligibility in opportunities.

Prerequisite: Before you can implement product eligibility, you must have created a sales catalog and added products to
it.

Here are the high-level setup steps:

1. Set up eligibility rules in the catalog.
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2. Set the eligibility check to run.
3. Enable the Check Eligibility button on the Products table in opportunities.

Note:  Keep in mind that eligibility functionality is only available for individual products. You can't implement eligibility
rules for product groups. Also, eligibility checks can only be performed in opportunities.

Create Eligibility Rules
You set up eligibility rules in the product group pages in Setup and Maintenance. Here's how:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Product Groups

2. In the Manage Product Groups page, select the product group that has the products in it, for which you're
setting up eligibility rules.

3. Lock the product group to modify it.
4. Select the product for which you're setting up eligibility rules.
5. Add a row to the Eligibility Rules table.
6. In the Eligibility Rules table, for each rule, set your options:

◦ Rule Type: Set the product as available. To disable eligibility for the product set the product as
unavailable.

◦ Country: Select a country for which the Available and Unavailable actions apply.

◦ Dates: Select the dates for the eligibility rule.

7. Click Publish.
8. Unlock the product group.
9. Click Save and Close.

Setting Eligibility Check to Run
Set the eligibility check to run using the product group usage pages in Setup and Maintenance:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Product Group Usage

2. In the Manage Product Group Usage page, select the Base catalog in the upper portion of the page. (If your
catalog uses a different usage, then select it.)

3. Click the Functions tab in the Details section of the page.
4. For the Eligibility engine option, click the Value drop-down list and set the value to Run.
5. Click Save and Close.

Enable the Check Eligibility Button
Use Application Composer to enable the Check Eligibility button on the opportunity Products table:

1. Ensure that you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
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3. In the navigation tree, expand Standard Objects.
4. Expand the Opportunity object and then click Pages.
5. In the Opportunity: Pages page, ensure that the Application Pages tab is active.
6. In the Details Page Layouts region, select the Standard Layout in the table and then click the Duplicate icon.

The Duplicate Layout dialog box appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

7. Enter a name for the new layout and click Save and Edit.

You're returned to the edit page for the new layout.
8. In the Edit Revenue Table region, click the edit icon.
9. In the Edit Revenue Table page, find the Check Eligibility button in the Buttons and Actions window. Move the

field from the Available Buttons window to the Selected Buttons window.
10. Click Save and Close.
11. Click Done.
12. Validate the change by navigating to the edit opportunity page and ensuring that you can see the Check

Eligibility button on the Products table.

Note that the user you sign in with to validate the change must belong to a sales resource organization. For
example, you must sign in as a sales representative.

13. Publish the sandbox according to your company's process.
14. The Check Eligibility button is now available to sales users on the opportunity Products table.

Related Topics
• Overview of Sales Products

• Sales Products High-Level Setup Steps

• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalog Usages

• Overview of Setting Sales Catalog Options and Actions

Use Access Groups to Secure Products and Product Groups  
Predefined access group rules provide your users with global access to products and product group data, but you can
configure this access for different groups of users. Let's say you only want sales managers to be able to update products
or product groups.

Let's say you only want sales managers to be able to update products or product groups. You set up an access group
with update privileges just for those users.

Here are the high-level steps:

1. Plan out the different access levels needed for your users. For example, determine what access level to give
only to your sales managers.

2. Create one or many access groups for the different access levels you want your users to have.
3. Assign resources to each group. For example, assign your sales managers to a new "product groups" group.
4. For each group, create object sharing rules to specify the access levels.
5. Publish the rules and run a scheduled process to apply the access to group members.

For complete steps, see the related topics.
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Related Topics
• Use Access Groups to Secure Product, Product Group, and Price Book Data

• Considerations in Deciding When to Use Access Groups

Work with Sales Products  

Overview of Working with Sales Products  
This section covers how to:

• View sales products: This task includes basic and advanced search and creating saved searches.

• Create products: This task includes entering product basic information.

• Edit products: This task includes modifying some product basic information (including setting sellable and
serviceable attributes) and adding or editing attachments, URLs, and images.

• Configure default pricing: See Set Default Price Book and Get Prices

Related Topics
• Add Products to the Catalog

View the Product List  
To view your product list, sign in as the sales administrator and navigate to Sales Products . The default saved search is
for products updated by you in the last week.

In the overview page, you can:

• Search for products using the Find text box. For more information, see the topics on using search in the
applications.

• View products updated by you in the last week. Keep in mind that if you haven't updated any products in the
past week, then the list will be blank.

• Use advanced search to modify and execute the supplied saved search.

• Create additional saved searches.

• Access product details.

Related Topics
• Add Products to the Catalog
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Create Products  
When you create a product, you enter product basic information and save the product for the first time.

Keep in mind that:

• After you create a product using the sales products UI, you can't delete it. But you can hide it in the UI by
deselecting the Eligible to Sell option in the product details screen.

• The fields in the sales products UI don't map name-for-name to the SCM application; see the table in this topic
for more details.

Here's how to create a new sales product:

1. Navigate to Sales > Products.
2. In the Products overview page click Create Product.
3. In the Create Product page, fill out the fields.

This table shows the fields, their descriptions, and the table columns in SCM products that they map to:

Note:  To speed up product creation, import your products and product groups. See the Download the
Macros for Importing Products and Product Groups topic in the Implementing Sales guide for more
information.

Field Description SCM Products Table Column Mapping

Product Number
 

Enter a unique product number. You can't
edit this field after you save the product.
 

Item
 

Name
 

Enter the name of the product whose
number you entered.
 

Description
 

Description
 

Enter a description for the product.
 

Long Description
 

Sales Product Type
 

Further categorize the product by selecting
a product type. See Significance of the Sales
Product Type Fieldfor more information.
 

Sales Product Type
 

Default UOM
 

Select the default UOM for the product.
You can't edit this field after you save the
product.
 

Primary Unit of Measure
 

Eligible to Sell
 

Check this box to make the product
available in the consuming Sales
applications.
 

Customer Orders Enabled
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Field Description SCM Products Table Column Mapping

Eligible for Service
 

Optionally, if integrating with the Service
Request application, enable this option.
Only products with this option set can be
used in the service request application.
 

Service Request
 

Enable Customer Self-Service
 

Optionally, if integrating with Oracle Digital
Customer Service or another third-party
customer self-service application, enable
this option. Only products with this option
set can be used in customer self-service
applications.
 

Enable Customer Self-Service
 

4. Save your changes.

Related Topics
• Add Products to the Catalog

Edit Product Details  
When you edit products, you might do such things as:

• Modify basic information

• Add product information, such as attachments, URLs, and images

To edit product details:

1. Navigate to Sales > Products.
2. Select a product from the list. The table shows the editable fields, their descriptions, and the table columns in

SCM products that they map to.

Field Description SCM Products Table Column Mapping

Name
 

Enter the name of the product whose
number you entered.
 

Description
 

Description
 

Enter a description for the product.
 

Long Description
 

Sales Product Type
 

Further categorize the product by selecting
a product type. See Significance of the Sales
Product Type Fieldfor more information.
 

Sales Product Type
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Field Description SCM Products Table Column Mapping

Eligible to Sell
 

Check this box to make the product
available in the consumingSales
applications.
 

Customer Orders Enabled
 

Eligible for Service
 

Optionally, if integrating with the Service
Request application, enable this option.
Only products with this option set can be
used in the service request application.
 

Service Request
 

Enable Customer Self-Service
 

Optionally, if integrating with Oracle Digital
Customer Service or another third-party
customer self-service application, enable
this option. Only products with this option
set can be used in customer self-service
applications.
 

Enable Customer Self-Service
 

3. Attachments: Add or remove attachments or URLs as needed. Multiple attachments or URLs can be associated
with a product.

4. Images: Add or remove images as needed. Only one image can be associated with a product. All files types
supported by Oracle WebCenter Content are supported.

5. When done editing, save your changes.

Related Topics
• Add Products to the Catalog

Add Attachments, URLs, and Images  
You can associate both attachments (which can be files or URLs) and images with products. But keep in mind:

• The application supports all file types that are supported by the content storage application, Oracle WebCenter
Content.

• You can only associate one image with a product.

• You can associate multiple attachments (files) or URLs with a product.

Configure Default Pricing  
You can configure default pricing for products in the sales Products pages.
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Note:  You can configure pricing for "standalone" products. Standalone products are products that have no
association with a product group in the sales catalog. This means you can set prices for products independent of the
catalog hierarchy.

Here are the high-level steps to configure default prices for products:

• Enable the Default Pricing region in the Edit Product page, using the steps in the section, Enable the Default
Pricing Region, in this topic.

• Configure the pricing. Use the steps in the section, Configure Default Pricing, in this topic.

Enable the Default Pricing Region
After you enable it using Application Composer, the Default Pricing region shows up in the Edit Product page. Here are
the steps:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. Under Standard Objects, navigate to Product > Pages.
4. Go to the Details Page Layouts section and duplicate the standard layout. Name and then edit the resulting

layout.
5. In the Details Layout page, click Show in the Edit Default Pricing region.
6. Click Done.
7. Now, test the change:

a. Click the Home icon in the global header.
b. Navigate to Sales > Products.
c. Edit a product.
d. Verify that you can see the Default Pricing region on the page.

8. After you have verified the change, publish the sandbox according to your company's business practices.

Configure Default Pricing
Now that you have the Edit Default Pricing region ready to go, search for and edit the product you want to configure
pricing for.

Note:  As a prerequisite, the product must be created and be in a price book. See the Price Books chapter in this guide
for more information. The product doesn't need to be part of a product group or product group hierarchy.

Configure the default pricing:

1. In the Default Pricing region of the Edit Product page, click the Add button.
2. Enter the currency, UOM, and list price of the product.

◦ Currency: This list of values is based on the same fixed choice list as in the price book header.

◦ Name: This field shows the name of the default price book for the selected currency, for your reference.

◦ UOM: This list of values is based the same fixed choice list as in the price book line.

◦ List Price: This field is the same type of field as in the price book line.

3. Save your work.

Add the product to a published product group to complete the setup and display the product to users in the sales
catalog.
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Important Considerations for the Default Pricing Region
Keep these considerations in mind as you implement and use the Default Pricing region:

• You can't extend the region. For example, you can't add or remove columns on the table.

• The application doesn't support custom price book and price book line attributes.

• You can only maintain default prices for the product you're editing. However, you can maintain other, additional
prices for the product using the Edit Price Book UI or using REST services or import management.

• The region table displays all prices for the product you're editing, from all active default price books.

• If you have added a default price and the corresponding price book becomes inactive or is no longer marked as
the default, these prices are no longer displayed in the new region.

• The list of available values in the Currency list is the unique list of currencies from all active, default price books.

• The combination of Currency and UOM must be unique in the table. In other words, you're not able to save
multiple rows for the same combination of currency and UOM, for the product you're editing.

Set Up Validation of Product Configurable Models  

Validate That Configurable Models Are Entered Correctly  
In the sales Products UI, you can set up the UI so that it validates that configurable product model information is entered
correctly. Model information in products and product groups includes the collection of model, model line model family,
and model attribute values. These values are required to identify Oracle Configure, Price, and Quote (Oracle CPQ)
configuration models. This validation enforces consistent entry of model information when managing products and
product groups.

This feature lets you validate and enforce consistent entry of model information required to identify Oracle CPQ
configuration models for the Oracle CPQ integration purposes.

Keep these points in mind as you set up and use this feature:

• This feature is primarily useful for customers using the Oracle CPQ integration.

• The validation is enforced to ensure entry of Model, Model Line, and Model Family field values when the
Configurable field is set to Yes as a user creates or edits a product.

• The validation is enforced to ensure entry of Model Line and Model Family field values when the Model field
value is specified as a user edits a product group.

• The entry of model attributes is optional.

• You can also use this feature in REST APIs and in Import Management.

Here are some additional steps to consider to enable this validation feature for Product and Product Groups.

• Users must set the Configurable indicator to Yes to enforce model information entry validation in the Products
UI.

• As an additional configuration, you can set the Default Operator to Is blank for the Configurable field in
the Search Region configuration page under Search and Select Dialog Layouts (Application Composer >
Product > Pages). This configuration lets users search pre-existing product records that have a blank
Configurable field value without having to specify the Configurable condition explicitly.
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• Users must specify the Model value to enforce model information entry validation in the Product Group edit UI.

For procedures, see:

• UI Setup for Validating Product Configurable Models

• UI Setup for Validating Product Group Configurable Models

Note:  This feature is primarily useful for customers using the Oracle CPQ integration. For more information about
how to enable the integration, see the Integrating Oracle CX Sales with Oracle CPQ guide.

Related Topics
• Set Up Point-to-Point Integration for Quotes and Sales Orders

UI Setup for Validating Product Configurable Models  
To enable validation of model information entry for Product, adjust the page layout and expose fields for the Product
object using Application Composer:

The validation is enforced to ensure entry of Model, Model Line, Model Family, and Model Attributes field values when
the Configurable field is set to Yes as a user creates or edits a product.

1. Sign in as a user with the Sales Administrator job role.
2. Ensure you're working in an active sandbox.
3. Navigate to Configuration > Application Composer.
4. Navigate to the Product object and click Pages.
5. Navigate to the Details Page Layouts region and duplicate the standard layout to create a new, custom layout.

Note:  To expose model information fields in the Create Product page, use the Creation Page Layouts region in
Application Composer.

6. Edit the new layout.
7. In the Details Layout region, click the edit icon in the Edit Subtab: Summary region.
8. In the Configure Detail Form page, move the Configurable, Model, Model Line, Model Family, and Model Attributes

fields to the Selected Fields area in the given order.

Note:  You must expose all five fields in the given order, for example: Configurable, Model, Model Line, Model
Family, and Model Attributes.

9. Save your work.
10.Navigate to the Edit Product page in Sales > Products. Verify that the Configurable, Model, Model Line, Model

Family, and Model Attributes fields appear in the Edit Product page.
11. Publish the sandbox according to your company's business practices.

UI Setup for Validating Product Group Configurable Models  
To enable validation of model information entry for Product Group, adjust the Desktop page layout and expose fields for
the Product Group object using Application Composer:
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The validation is enforced to ensure entry of Model Line and Model Family field values when the Model field value is
specified as a user edits a product group.

1. Sign in as a user with the Sales Administrator job role.
2. Ensure you're working in an active sandbox.
3. Navigate to Configuration > Application Composer.
4. Navigate to the Product Group object and click Pages > Desktop Pages.
5. Click Edit Summary Form in the Details Page region.
6. In the Edit Details Page Summary Form page, in the Configure Default Summary region, move the Model, Model

Line, Model Family, and Model Attributes fields to the Selected Fields area in the given order and save.

Note:  You must expose all four fields in the given order, for example: Model, Model Line, Model Family, and Model
Attributes.

7. Navigate to Setup and Maintenance and Search for the task, Manage Product Groups.
8. Select a product group and click Lock to edit the product group. Verify that the Model, Model Line, Model Family,

and Model Attributes fields appear in the Product Group page.
9. Unlock the product group.

Speed Data Entry Using Dynamic Choice Lists  

Increase Efficiency with Product Group Dynamic Choice Lists  
Speed administrator tasks by setting up dynamic choice lists for product group data selection within Sales objects like
opportunities and leads. After you configure product group dynamic choice lists in Application Composer, Sales Catalog
administrators can use them with specific filter criteria. You can also use dynamic choice lists with your own custom
objects.

Use the procedure, Create Product Group Dynamic Choice Lists, to create the dynamic choice lists. As you implement
this feature, keep in mind:

• Oracle supplies an existing filter named GetProductGroupsForUsage to facilitate setup.

• The example filter expression value for Bind_usageCode is 'BASE'.

• The example filter expression value for Bind_UsageModeCode is 'MOO' when you define a custom choice list
field for Opportunity. This includes any other associated filter functions, such as the territory engine, if defined
for Opportunity in the Manage Product Group Usage task.

• If you want a choice list field to display all available product groups, use the filter expression value, 'QSC' for
Bind_UsageModeCode.

• The filter expression value for Bind_UsageModeCode is 'MKL' when you define a custom choice list field for
Lead.

• For example filter expression values to set up for variable Bind_UsageModeCode when you define the custom
choice list (dynamic) field for Opportunity, navigate and refer to Setup and Maintenance > Manage Product
Group Usage > Select Usage: Base > Base Details > Modes > Description.

Note:  You must include the single apostrophes in the filter expression values when you enter them.
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Create Product Group Dynamic Choice Lists  
The product group dynamic choice lists that you set up let catalog administrators filter data when making selections,
thus boosting efficiency and performance.

To enable Product Group dynamic choice lists, you first add a dynamic-choice-list type custom field for an object using
Application Composer:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. Navigate to the Fields page in Opportunity, Sales Lead, or your own custom object.
4. In the Fields page, create a new, custom field.
5. Select Choice List (Dynamic) and click OK.
6. Specify basic information in the Create Dynamic Choice List: Basic Information page.
7. Click Next.
8. In the Create Dynamic Choice List: List of Values page, select Product Group as the related object you want to query

to populate the list.
9. For List Selection Display Value, select Display.
10.Expand the Data Filter region and click Existing Filter.
11. For Data Filter Name, select GetProductGroupsForUsage.
12. For Bind_UsageModeCode, specify the expression value, for example, 'MOO' (for Opportunity).
13. Click Submit.
14.Publish the sandbox according to your company's business practices.

Implementation Concepts  

How Sales Products and SCM Cloud Products Work Together  
When you create or update product information in the Sales Products area, the product information is automatically
updated in the back-end application, Oracle Supply Chain Management (SCM) Cloud.

This table shows the mapping between sales product attributes and SCM Cloud item attributes:

Sales Product Attribute SCM Cloud Products Attribute

Inventory Item ID
 

Item
 

Organization ID
 

Organization
 

Number
 

Item (in SCM Cloud Items UI header region)
 

Name Description (in SCM Cloud Items UI header region)
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Sales Product Attribute SCM Cloud Products Attribute

  

Description
 

Long Description (in SCM Cloud Items UI Overview tab)
 

Product Type
 

Sales Product Type (in SCM Cloud Items UI Specifications tab and Sales and Order Management side
navigation region). See Significance of the Sales Product Type Fieldfor more information.
 

Default UOM
 

Primary Unit of Measure (in SCM Cloud Items UI Overview tab)
 

Eligible to Sell
 

Customer Orders Enabled (in SCM Cloud Items UI Specifications tab and Sales and Order Management
side navigation region)
 

Eligible for Service
 

Service Request (in SCM Cloud Items UI Specifications tab and Service side navigation region)
 

Attachments
 

Attachments tab (in SCM Cloud Items UI)
 

Image
 

Image (in SCM Cloud Items UI header region)
 

Sales Products Business Object Logic  
Sales product data follows specific business logic, and at times, as an implementor, you may sometimes need to be
aware of how the data maps to other applications or objects.

Here's an example of business logic you may want to be aware of:

• When you create a product in the Sales Products UI, or using web services, the Inventory Item ID is null.
However, if you create a product using import, the Inventory Item ID is the same as the Inventory Item ID in the
Oracle Supply Chain Management (SCM) Cloud product tables.

This table describes the business logic for various business objects when using sales products. In the table "sales
product" means a product created in the sales products UI. "Import" refers to Oracle import.

Sales Products Attribute Business Logic

Inventory Item ID
 

• Sales product creation through UI or web services: null.

• Sales product creation through import: Same as the Inventory Item ID for the SCM back-end item
that's being created as the sales product. The SCM back-end item attribute should match the
sales product Number attribute.

• Required when a product is updated.

Organization ID
 

• Sales product creation through UI or web services: The value for the profile option QSC_SALES_
PRODUCTS_INVENTORY_ORG_ID is set as the default.

• Sales product creation through import: Same as the organization ID for the SCM Cloud back-end
item that's being created in Sales products screens.
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Sales Products Attribute Business Logic

Item Master Organization
 

• Sales product creation through UI or web services: The value for the profile option QSC_SALES_
PRODUCTS_INVENTORY_ORG_ID is set as the default.

• Sales product creation through import: Same as the organization ID for the SCM Cloud back-end
item that's being created in Sales products screens.

Item Class
 

• Required attribute when creating a new product in the SCM Cloud back-end products application.

• The value should be Root Item Class.

Template
 

• Required attribute when creating a new product in the SCM Cloud back-end products application.

• The value should be Finished Goods.

Number
 

• Required attribute when creating a new product or updating an existing product.

• The value must be unique for an item master.

• Creating a product with an existing number throws an API unique violation error.

Name
 

• Required attribute when creating a new product.

• The value should be passed during product update only if changed.

Product Type
 

Sales products retrieves the list of values for Product Type from the lookup type QSC_SALES_
PRODUCT_TYPE. See Significance of the Sales Product Type Fieldfor more information.
 

Default Unit of Measure (UOM)
 

• Validated against all UOMs that are effective as of current date.

• Optional for create operation.

• Update of UOM isn't allowed for saved products.

Eligible to Sell
 

• All Sales products must have this indicator set to yes (checked).

• For update operation, pass only if changed.

• When a user sets it to no from yes, the corresponding SCM Cloud item indicators Customer
Orders Enabled and Orderable on the Web are set to no.

• When a user sets it to yes from no, only the corresponding SCM Cloud item indicator Customer
Order Enabled is set back to yes.

Eligible for Service
 

• All Service products that will be used in the service request management application must have
this indicator set to yes (checked).

• For update operation, pass only if changed.

• When a user sets it to no from yes, the corresponding SCM Cloud item indicator Service Request
is set to Disabled

• When a user sets it to yes from no, the corresponding SCM Cloud item indicator Service Request
is set to Enabled

Image
 

• Image maps to the SCM Cloud attachment entity ITEM_ENTITY and the category IMAGE.

• Only one image per product is allowed.

• Optional for create operation. For update operation, pass only if changed.

• In the case of errors, API messages are returned.

Attachments
 

• A product can have multiple attachments.
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Sales Products Attribute Business Logic

• Only attachments of type "file" are allowed.

• Product attachments map to the SCM Cloud items attachment entity ITEM_ENTITY.

• The attachment category can be one of the following:

◦ One of the attachment categories associated with the Root Item Class except IMAGE.

◦ Null

• Optional during product creation.

• Attachments can be added, updated, or deleted at any time.

• In the case of errors, SCM Cloud API messages are returned.

Related Topics
• Overview of Sales Products

• Overview of Working with Sales Products

• Sales Products High-Level Setup Steps

• How Sales Products and SCM Cloud Products Work Together

Significance of the Sales Product Type Field  
The Sales Product Type field is an important attribute in relation to Sales Products. The value set in this field indicate
whether a product can participate in specific CX Sales management processes by default, without customization.

For example, the sales product types, Subscription and Extended Warranty, are meant for products that follow
Subscription Management (in other words, the Subscription-Sales management process), whereas One Time Service,
Installation, Software Maintenance, and Preventive Maintenance are example Service products and are referred to in the
Service Sales Management process.

Note:  In the create and edit product pages, if the Sales Product Type selected is one of the following, then the Eligible
for Service check box is cleared and disabled: Extended Warranty, Included Warranty, Preventive Maintenance, Service
Level Agreement, Software Maintenance.

Optionally, you can modify the list of product types that display in the sales UI. Sales products retrieve the list of values
for Product Type from the lookup type, QSC_SALES_PRODUCT_TYPE. You can find the lookup type in the Setup and
Maintenance task, Manage Standard Lookups.
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20  Price Books

Overview of Price Books  
Use price books to create product lists with prices that you can then use in other sales applications, such as contracts,
accounts, and opportunities.

Some of the ways your organization might use price books include:

• Integrate price books with accounts and opportunities for greater flexibility in pricing. For more information,
see the Price Books in Opportunities and Accounts section in this chapter.

• Set default list prices on contract sales agreements. See the topic, Create a Sales Agreement Line, for more
information.

Using Price Books with REST APIs
You can create and update price books using REST APIs. You can avoid certain errors by setting your preferred language
to English. See the topic, How to Set the Preferred Language, in the Related Links below.

Related Topics
• Work with Price Books

• Overview of Sales Products

• Overview of Sales Catalogs

• How to Set the Preferred Language

• Create a Sales Agreement Line

Work with Price Books  
You use price books to create product lists with prices that you can then use in other sales applications, such as
contracts, accounts, and opportunities.

Create a Price Book
Here's how to create a price book:

1. Navigate to Sales > Price Books.
2. In the Price Books page, click Create Price Book.
3. In the Create Price Book page, enter the details of the price book.

◦ Name: Enter a unique name for the price book.

◦ Currency: Select a currency from the list of implemented currencies. Note that the currency set in your
user preferences is initially used as the default currency.
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◦ Description: Optionally, enter a description for the price book.

4. Click Save and Continue. Or, click Save to save the price book so you can edit it later.

The default status for a new price book is Draft.
5. In the Edit Price Book page, add products. Click Add to add a single product line. Click Add Many to add several

product lines.
6. Search for and select the product or products. Click OK in the search page to return to the edit page.
7. For each product line, fill in the following fields:

◦ UOM: Select the unit of measure.

◦ List Price: Enter a price.

8. Save your changes by clicking Save or Save and Close.
9. When you're ready for your price book to become active and ready for use, change the Status to Active. After

you save a price book in Active status, the name can't be updated.

Edit a Price Book
You can edit price books, but not all of the fields are editable when they're Active. See the Price Book Statuses section in
this topic for more details on which fields are editable in the various statuses.

To edit a price book:

1. Navigate to Sales > Price Books.
2. In the Price Books landing page, click the name of a price book.
3. In the Edit Price Book page, edit the price book as needed.

Copy a Price Book
You may want to copy a price book to save the time needed to create a new one. You can copy price books while they're
in any status.

Here's how to copy a price book:

1. Navigate to Sales > Price Books.
2. Click the name of a price book in the list.
3. In the edit page, from the Actions menu, select Copy Price Book.
4. In the dialog box, enter a new, unique name for the price book and click Save and Continue.
5. Edit the price book as needed.

Delete a Price Book
After you delete price books, the application removes them from the list of price books and they're no longer available in
consuming applications. Keep in mind that you can only delete price books that are in Draft status.

To delete a price book.

1. Navigate to Sales > Price Books.
2. Click the name of a price book.
3. From the Actions menu, select Delete Price Book.

Related Topics
• Overview of Price Books
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Price Book Statuses  
Price books have statuses, such as Draft or Active. The status of a price book determines what actions you can take on
it.

Here are the price book statuses and additional details about the behavior of price books while in a specific status.

Status Description Additional Details

Draft
 

Indicates a price book that's not yet available for
use.
 

• Only price books in Draft status can be
deleted.

• Can be moved to Active status.

Active
 

Indicates a price book that's available for use.
 

• Can be updated to Expired status. Note
you can't delete expired price books.

• Can't be updated to Draft status.

Expired
 

Indicates a price book that's no longer available
for use.
 

• Cannot be moved to Draft status;
therefore, can never be deleted.

Here are the transitions allowed for price book statuses. Price books start out as draft status, then move to active, and
finally to expired.

Add the Default Price Book Check Box  
Expose the Default Price Book check box in the Edit Price Book page in order to mark a price book as the default one.
The prices in the default price book are used before any other prices for products in your catalog.

Here's how to expose the Default Price Book check box in the Edit Price Book page.

1. Ensure you're working in an activate sandbox.
2. Select Tools > Application Composer.
3. In the navigation tree, expand Standard Objects > Price Book Header.
4. Click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.
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8. In the Details Layout page that appears, click the edit (pencil) icon next to the Edit Subtab: Summary region.
9. Move Default Price Book from the Available Fields to the Selected Fields window.

10. Click Save and Close.
11. From the Details Layout page, click Done.
12. Make sure that the layout status for your layout is set to Active.
13. Test the changes as follows:

◦ Navigate to Sales > Price Books as a user with the Sales Administrator role.

◦ Edit a price book and ensure you can see the Default Price Book check box in the Edit Price Book page.

14. Publish the sandbox according to your company's business practices.
For more information, see the related topics in the Configuring Applications Using Application Composer guide.

Related Topics

Use Access Groups to Secure Price Books  
Predefined access group rules provide all users with global access to price book data, but you can configure this access
for different groups of users.

Let's say you only want sales managers to be able to delete price books. You set up an access group with delete
privileges just for those users.

Here are the high-level steps:

1. Plan out the different access levels needed for your users. For example, determine what access level to give
only to your sales managers.

2. Create one or many access groups for the different access levels you want your users to have.
3. Assign resources to each group. For example, assign your sales managers to a new "price books" group.
4. For each group, create object sharing rules to specify the access levels.
5. Publish the rules and run a scheduled process to apply the access to group members.

For complete steps, see the related topics.

Related Topics
• Use Access Groups to Secure Product, Product Group, and Price Book Data

• Considerations in Deciding When to Use Access Groups

Price Books in Opportunities and Accounts  

Overview of Integrating Price Books with Accounts and
Opportunities  
Integrate price books with opportunities and accounts to let salespeople provide the right prices at the right time. Here
are just a few of the ways you can use price books to streamline your pricing capabilities:
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• Price opportunity products according to specific agreements with your customers. Do this by associating price
books with an account and defaulting the price book from the account onto opportunities associated with that
account.

• Use Groovy scripting to default an appropriate price book based on different opportunity attributes like country,
channel, or partner.

• Use Groovy scripting to update prices when items change on price books.

• Add custom price book fields to accounts and opportunities.

In this section, you can learn how to set default prices for an account and make the associated UI changes.

As a prerequisite, create a price book in the Price Books application. For steps, see the Work with Price Books in this
chapter.

Here are the tasks we cover in this section:

1. Create a custom price book field for accounts and opportunities.
2. Add your custom field to account and opportunity pages.
3. Create a Groovy trigger to set the default price book and get prices.
4. Create a Groovy script to find updated prices that might have changed.
5. Add the Reprice Opportunity action to the Edit Opportunity page.
6. Copy the supplied Sales Representative role and add the Manage Price Books privilege to your new, custom

role.

Note:  Make these changes in a sandbox and publish it according to your company's processes.

Create Price Book Field for Accounts and Opportunities  
In order for salespeople to select a price book in the Edit Account and Edit Opportunity pages, you need to create a
custom field called "Price Book".

Here's how to create the custom field:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. Navigate to Standard Objects > Account > Fields. For opportunities, navigate to Standard Objects >

Opportunity > Fields.
4. Ensure you're on the Custom tab.
5. Click the Create a custom field icon.
6. In the Select Field Type dialog window, select Choice List (Dynamic).
7. Click OK.
8. In the Display Label field in the Create Dynamic Choice List: Basic Information page, enter Price Book. As you

click away from the Display Label field, the Name field automatically populates with the internal name. You can
change this name now, but after you save the new field, you won't be able to change it.

9. Ensure Updatable is checked and Required is unchecked.
10. Click Next.
11. In the Create Dynamic Choice List: List of Values page, in the Related Object field, select Price Book Header.
12. Select Name in the List Selection Display Value field.
13. Click Submit.
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14. Next, add the field to the Edit Account and Edit Opportunity pages.

Add Price Book Field to Account and Opportunity Pages  
Now that you have created the new Price Book field, you need to add the field to the Edit Account and Edit Opportunity
pages.

1. In Application Composer, navigate to Standard Objects > Account > Pages. For opportunities, go to Standard
Objects > Opportunity > Pages.

2. Ensure that you're on the Application Pages tab.
3. In the Details Page Layouts regions of Account: Pages or Opportunity: Pages, duplicate the standard layout

and edit the resulting layout.

The detail steps are different for account and opportunity:

Account detail steps:

a. In the Subtabs region, edit the Profile subtab (click the Profile icon).
b. Edit the Summary Edit Subtab: Summary region.

Opportunity detail steps:

a. In the Details Layout page, edit the Edit Subtab: Summary region.
4. In the Available Fields window, select and move the custom Price Book field to the Selected Fields list.
5. Click Save and Close.
6. Click Done.

Set Default Price Book and Get Prices  
You can use a Groovy script to set the default price book on an opportunity and get the latest prices onto the price book.
The default price book can be set based on various opportunity attributes.

These opportunity attributes can be, for example, currency, customer geography, or customer account.

Here's how to set a default account price book on an opportunity.

Note that this procedure also sets a default Corporate price book on an opportunity, if an account price book can't be
found.

1. Ensure you're working in an active sandbox.
2. In Application Composer, navigate to Standard Objects > Opportunity > Server Scripts.
3. Select the Triggers tab.
4. Select the Add a New Trigger icon.
5. In the Trigger field, select Before Insert in Database.
6. In the Trigger Name field, enter SetPriceBook.
7. In the Trigger Definition region, enter this script:

//Fetch the Id of Account Pricebook
def pricebookId = Organization?.PriceBook_Obj_c?.PricebookId;

// Set the Id of Account PriceBook to Opty
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 setAttribute('PriceBook_Id_c', pricebookId);

8. Click Save and Close.
9. Test the changes and publish the sandbox.

If a price book isn't defined in the Account object, you can define a default price book in Groovy as follows:
def accountplist=Organization?.getAttribute('PriceBook_c')
def optyplist=getAttribute('PriceBook_c')
if (optyplist == null ) {
 if (accountplist == null ){
 optyplist = 'Corporate' //This is the name of the default pricebook
 }
 setAttribute('PriceBook_c',accountplist)

Note:  You can also add the Default Price Book check box to the Edit Price Book page using Application Composer >
Price Book Header object > Details Page Layouts.

Update Prices on Product Lines  
You can also use a Groovy script to pull the list price for a product from the selected price book and stamp that value in
Amount field on the product line.

1. Ensure you're working in an active sandbox.
2. In Application Composer, navigate to Standard Objects > Opportunity > Opportunity Revenue > Server

Scripts.
3. Select the Triggers tab.
4. In the Server Scripts Opportunity Revenue page, in the Field Triggers section, select the Add a New Trigger

icon. The page changes to the Create Field Trigger page, and the Trigger Type field defaults to After Field
changed.

5. In the Create Field Trigger page, select Product for the Field Name.

Note:  If there are two instances of Product in the list, select the first one.

6. In the Trigger Name field, enter FetchPrice.
7. In the Trigger Definition region, enter this script:

//Get the ID of the item:
def var_InventoryItemId = nvl(getAttribute('InventoryItemId'), (long) 0) 
//Get the ID of the price book (this is useful if you have multiple price books):
def var_DCL_PriceBook = Opportunity?.PriceBook_Id_c // 
//PriceBook is a dynamic choice list on the opportunity.
//Make a view of the PriceBookItem object, since that's where the prices for items are stored:
def view_PriceBookItem = newView('PriceBookItem')
def view_Criteria = newViewCriteria(view_PriceBookItem)
def view_criteria_row = view_Criteria.createRow()

//Define the first sort criteria. Basically, find all records in PriceBookItem that match the ID of the
 InventoryItemId on revenue.
def view_condition = view_criteria_row.ensureCriteriaItem('InvItemId')
view_condition.setOperator('=')
view_condition.setValue(var_InventoryItemId)

//Define the second sort criteria. If there are multiple price books that contain the same item with
 different prices, get the price of the item corresponding to the price book selected in the dynamic
 choice list on the opportunity.
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def view_condition_1 = view_criteria_row.ensureCriteriaItem('PricebookId')
view_condition_1.setOperator('=')
view_condition_1.setValue(var_DCL_PriceBook)

//Execute the sort and query the records:
view_Criteria.insertRow(view_criteria_row)
view_PriceBookItem.appendViewCriteria(view_Criteria)
view_PriceBookItem.setMaxFetchSize(1400) //1,400 is the number of records in the system; change this
 number according to your system records.
view_PriceBookItem.executeQuery()

def var_price // This is a variable that will hold the price from PriceBookItem
while(view_PriceBookItem.hasNext()){
def var_Row = view_PriceBookItem.next()

//Get the price from PriceBookItem for the item you want:
var_price = var_Row.getAttribute('ListPrice') 
}
//Assign the price to the revenue field UnitPrice:
setAttribute('UnitPrice',var_price) 

8. Click Save and Close Verify that the FieldName in the Triggers section appears as InventoryItemId.
9. Test the changes and publish the sandbox.

Add Reprice Action to Edit Opportunity Page  
Add an action in the Edit Opportunity page that salespeople can use to retrieve updated prices.

1. In Application Composer, navigate to Standard Objects > Opportunity > Actions and Links.
2. Click the Create icon.
3. In the Opportunity: Create Action or Link page, in the Display Label field, enter Reprice Opportunity. As you

click away from the Display Label field, the Name field automatically populates with the internal name.
4. In the Type field, ensure that Action is selected.
5. In the Script region, click the New icon.
6. In the Create Object Function page, in the Function Name field, enter RepriceOpty.
7. In the Edit Script region, enter this script:

def revenueItems = ChildRevenue
def pricebook = nvl (PriceBook_Obj_c, null)
if (pricebook == null)
return
def priceBookId = pricebook?.getAttribute("PricebookId")

def view_PriceBookItem = newView('PriceBookItem')
def view_Criteria = newViewCriteria(view_PriceBookItem)
def view_criteria_row = view_Criteria.createRow()
def view_condition = view_criteria_row.ensureCriteriaItem('InvItemId')
view_condition.setOperator('=')

view_Criteria.insertRow(view_criteria_row)
view_PriceBookItem.appendViewCriteria(view_Criteria)
def view_condition_1 = view_criteria_row.ensureCriteriaItem('PricebookId')
view_condition_1.setOperator('=')
view_condition_1.setValue(priceBookId)
while (revenueItems.hasNext()) {
def revenueLine = revenueItems.next()
def itemid= nvl(revenueLine.InventoryItemId, 0L)
def invorgid = nvl (revenueLine.InventoryOrgId, 0L)
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view_condition.setValue(itemid)
//1,400 is the number of records in the system; change this number according to your system records.
view_PriceBookItem.setMaxFetchSize(1400) 
view_PriceBookItem.executeQuery()
while(view_PriceBookItem.hasNext()){
def var_Row = view_PriceBookItem.next()

//Get the price from PriceBookItem for the item you want:
revenueLine.setAttribute('UnitPrice', var_Row.getAttribute('ListPrice'))}
}

8. Click Save and Close.
9. Back in the Opportunity: Actions and Links page, click Save.

10. Verify the action was created by going to Opportunity > Server Scripts > Object Functions. If you still don't
see it, sign out and back in.

11. Add the action to the opportunity details page: Navigate to Opportunity > Pages.
12. Ensure that the Application Pages tab is selected.
13. In the Opportunity: Pages page, find the Details Page Layouts region. Duplicate the standard layout and then

name and edit the copy.
14. In the Details Layout page, at the top right of the page next to the Actions drop-down list, click the Edit icon.
15. In the Buttons and Actions page, find the action you created and move it to from the Available Actions shuttle

area to the Selected Actions shuttle area.
16. Click Save and Close.
17. Click Done.

Create New Sales Representative Role and Add Price Books
Privilege  
In order for your sales representatives to have access to price books in opportunities, they need the Manage Price Books
privilege in the job role you give them.

High-Level Steps
It takes just three steps to set up the new role and assign it to users:

1. Copy the supplied Sales Representative role.
2. Edit your new, custom sales representative role to add the Manage Price Book privilege.
3. Assign the new sales representative role to all users who need access to price books in opportunities.

You must have the IT Security Manager job role for these tasks.

Copy the Sales Representative Role
First, copy the supplied Sales Representative role:

1. Navigate to the Tools Security Console.
2. On the Roles tab of the Security Console, search for the Sales Representative job role

(ORA_ZBS_SALES_REPRESENTATIVE_JOB).
3. Select the role in the search results.
4. In the search results, click the down arrow for the selected role and select Copy Role.
5. In the Copy Options dialog box, select the Copy top role option.
6. Click Copy Role.
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7. On the Copy Role: Basic Information page, review and edit the Role Name, Role Code, and Description values,
as appropriate.

8. Click the Summary train stop.
9. Click Submit and Close, then OK to close the confirmation message.

10. Navigate to the Administration tab.
11. Click the Role Copy Status subtab to monitor the progress of the copy. After it completes, edit the copied role.

Edit and Assign the Role
Next, edit the new role to add the Manage Price Book privilege, and then assign the role to users:

1. Navigate to the Roles tab.
2. Search for and select your custom role.
3. In the search results, click the down arrow for the selected role and select Edit Role.
4. On the Edit Role: Basic Information page, edit the role name and description, if needed. Role code isn't editable.
5. Click Next.
6. On the Edit Role: Function Security Policies page, add the Manage Price Book privilege to the copied role:

a. Click Add Function Security Policy.
b. In the Add Function Security Policy dialog box, search for and select the Manage Price Book privilege.
c. Click Add Privilege to Role.
d. Close the Add Function Security Policy dialog box.
e. On the Edit Role: Function Security Policies page, scroll to the end of the list of privileges to see the new

privilege you added.
f. Click Next.

7. Click the Summary train stop and confirm that the new privilege was added to your custom role.
8. Click Submit and Close, then OK to close the confirmation message.

Assign the Role to Sales Representatives Using Role Provisioning
There are a few different options for assigning the role:

• If you want all sales representatives to get the custom role, just edit the existing provisioning rule for the
Salesperson resource role to provision the custom role. See the topic, Create Rules to Automatically Provision
Job Roles to Sales Users, for the steps.

• But if you want only a specific group of users to get the new custom role, create a new resource role and a new
provisioning rule for the resource role, then use import/export to change the resource role assigned to the
specific users. See the topic, Create Additional Resource Roles, for more information.

• If you only want to assign the role to a few users, you can do it manually on the Edit User page. For an example
of changing the resource role for an individual user see the topic, Change User Resource Roles When Job
Assignments Change.

Related Topics
• Edit Job or Abstract Roles

• Steps for Setting Up Role Provisioning

• Create Additional Resource Roles

• Create Rules to Automatically Provision Job Roles to Sales Users

• Change User Resource Roles When Job Assignments Change
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21  Sales Catalogs

Overview of Sales Catalogs  
Using sales catalogs lets you:

• Use product group as a territory dimension so assignments can be made based on product.

• Give salespeople a mechanism to add product revenue to opportunities.

• Let salespeople add products to leads.

• Have product revenue available in forecasting and salesperson quota.

Note:  While you can include individual products (also known as inventory items) in your catalog, they're not required
unless you're integrating with a product application downstream, such as Oracle Configure, Price, and Quote Cloud
(Oracle CPQ). For information on the setup of individual products, see the topics on sales products.

Sales Catalog Key Features
Here are the key features of the sales catalog:

• Import your inventory list using standard import or import macros.

• Quickly build and deploy sales catalogs in a single administration UI.

• Build product groups in a hierarchy.

• Translate product group display name and description into different languages.

• Use the sales Products UI to create individual products that you add to the product catalog.

• Use price books and the default pricing region in the Products UI to price "standalone" products outside of the
catalog hierarchy.

Product Group Hierarchy Example
The following figure shows an example of a product group hierarchy.

In the example: At the top of the product group hierarchy is the root product group, named Special Deals.The
nested groups begin with the child groups of the Special Deals root group. These include: Men, Women, and
Kids.Within the Kids group, more nested groups appear, including Girls and Boys.Within the Girls group, a child
group called Apparel appears.Within the Apparel group, further nesting occurs, with the groups Pants, T-shirts,
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and Dresses.Together, the root group and configuration of parent and child groups make up the sample hierarchy.

Related Topics
• Sales Catalog High-Level Setup Steps

• Add Products to the Catalog

• Validate the Sales Catalog

• Run the Refresh Denormalized Product Catalog Table Process

• Example of Creating a Sales Catalog

The Sales Catalog  
Salespeople enter the products or product groups that customers are interested in purchasing by making a selection
from a sales catalog. They can either browse the catalog or start typing the product name when they make entries in
opportunities and leads.

The sales catalog consists of a hierarchy of product groups, which classifies and organizes the products in your catalog.
You can include a description for each product group and product. You can upload one image for each product.

You can use product groups as a dimension in your sales territories and for sales forecasting. During forecasting setup,
you can specify the number of levels in your sales catalog product group hierarchy that you want to forecast. For
example, Vision Corp. uses product groups to assigns specialists to help close deals on opportunities with the line of
green servers that the company has just launched. The company also creates forecasts for each server line.

Here's a screenshot of the Browse page in the CX Sales UI, which salespeople see as they
browse the catalog. The screenshot highlights the product group hierarchy in the Browse
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section (callout 1) and the products with descriptions in the Products section (callout 2).

Salespeople can drill down into the individual product pages to view the product description and an image. Here's a
screenshot of the Product Detail page in the CX Sales UI for a sample product. The page includes the product name,
description, and image. The Details and Specifications tab and the rest of the tabs at the bottom of the page aren't used
by the Sales Catalog.
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CX Sales and Fusion Service Catalogs
The building blocks of sales and service catalogs are the same. Both use product groups and products and you create
them using the same UIs and import processes. You create a root product group and build your catalog underneath.
Salespeople use the catalog to enter product interest in opportunities and leads. Service agents use the catalog for
entering products into service requests. There are two differences between sales and service catalogs:

• How product groups are used.

In sales, you can forecast by product groups and use product groups for assigning opportunities. In service, you
can use product groups to channel service requests to the right work queue for resolution.

• Different product options determine if the product shows up for sales or for service.

Products must have the Eligible to Sell option selected for them to appear in the sales catalog and the Eligible
for Service option selected for them to appear in the service catalog.

You can share products and product groups between the two catalogs and you can even create one catalog for both
sales and service. If you do opt for a single catalog or even reuse the same product groups for the two catalogs, you
must keep in mind that sales may discontinue selling some products that you may still need to service. Or sales may
create product groups specific to promotions or seasonal sales.

Products in the CX Sales and Fusion Service Catalogs
While you can create sales and service catalogs with product groups only, you must create products to take advantage
of advanced sales features such as price books. You must also use products to enable integrations with other Oracle
cloud services, including Oracle Configure, Price, and Quote (CPQ) Cloud. You can also use Application Composer to add
fields and perform other modifications to products, a feature not available on product groups.

Products you create are also stored in the Oracle Fusion Product Model, which serves as the master item repository for
all front-office cloud services. So, the product you create can be priced and quoted in Oracle CPQ Cloud and serviced in
Oracle CX Sales and Fusion Service.

The Oracle Fusion Product Model, which is included with the different cloud services, provides basic functionality for
use in the front-office cloud services. If you're implementing supply chain cloud services or ERP cloud services together
with your sales application, then you must license the Oracle Product Hub Cloud Service and set up your items using the
UIs and import features of Oracle Product Hub Cloud. You can't create products in your sales application with enough
detail that would make them suitable for back-office supply chain applications. Sales applications don't need to track the
physical locations of the items you're selling or shipping, for example, so all products you create in the sales application
are created at the Item Master Organization level in the Oracle Fusion Product Model. Only the Oracle Product Hub
Cloud includes the ability to manage item classes. All products created in the sales application are created at the default
item class and use the Production design phase.

The following diagram outlines the role products play in Oracle CX Sales and Fusion Service and related cloud services:

• In Oracle CX Sales and Fusion Service, you can create the products for your sales and service catalogs either
individually in the UI (indicated by callout 5) or you import products from a file (callout 6).

• Product records are created both in Oracle CX Sales and Fusion Service and in the Oracle Fusion Product Model
(callout 7).

• You expose the products in the sales or service catalogs (callout 3) by associating them with product groups.

• Salespeople can browse or search the sales catalog from the Opportunity UI (callout 1) and select the products
the customer is interested in buying. Only products with the Eligible to Sell option selected appear in the sales
catalog.
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• Service agents enter products from the Service Request UI (callout 4). Only products with the Eligible for
Service option selected appear in the service catalog.

• You can price the products using price books (callout 2), or create quotes for them in Oracle Configure, Price,
and Quote Cloud (callout 8). Price books and CPQ Cloud require additional integration, so aren't covered in this
guide. (Although price books are a sales feature, you must integrate them with opportunities using Groovy
scripting.)

• The Oracle Fusion Product Model (callout 7) forms the foundation of the Oracle Product Hub Cloud (callout
10), a powerful product management application designed for supply chain, order management, and inventory
tasks, which must be licensed separately. Because the sales application uses less than a dozen of the hundreds
of the item attributes that can be captured in Oracle Product Hub, you can't use the sales UIs or product import
if you're implementing Oracle Product Hub Cloud. To create products in Oracle Product Hub Cloud that can be
used with Oracle Supply Chain Cloud or Oracle ERP Cloud (callout 11), you must use the Oracle Product Cloud
Hub UI and item import (callout 9).
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How You Create a Sales Catalog
Here's an overview of how you create a sales catalog:

1. Create the root product group of the catalog. You can create the product group in the UI or you can import it
with the rest of the product groups. You're required to create only the root product group. All the other product
groups are optional.

2. Create the products for your sales catalog either in the UI or by importing them.
3. You can import the rest of the product group hierarchy, if any.
4. To display individual products in the sales catalog, you must associate the product groups with the products.

You can create the association by editing each product group in the UI and selecting the products it contains.
Alternatively, you can create the association between product groups and the products in your import.

Sample Sales Catalog Structure
Here's a diagram of the Vision Corp. sales catalog structure. The company sells laptops and two types of servers: Green
Servers and Sentinel Servers. To create the catalog, Vision Corp:

1. Creates Vision Products as the root product group in the UI.
2. Imports the products using the product import macro.
3. Imports the remaining product groups and their associations with the products using the product group import

macro.

Setup Tasks  

Sales Catalog High-Level Setup Steps  
Creating your sales catalog involves a number of steps.

This table shows the high-level setup steps and where to find more information about the step:
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Note:  If you're using the Setup Assistant to create your catalog, consult the Implementing Sales guide first. When you
use the Setup Assistant, many steps are done for you by the assistant.

Step Description Where to Find More Information

Ensure prerequisites are set up
 

Ensure that your prerequisite structures are set
up before starting to create the catalog.
 

See the Prerequisite Setups for Sales Products
topic in this chapter
 

Create the root product group
 

Create the root product group. The root catalog
or root product group is the top of the product
group hierarchy. All other product groups are
nested underneath.
 

See the Create the Root Product Group topic in
this chapter
 

Create the product group hierarchy
 

Add additional product groups to create the
catalog hierarchy of product groups and
subgroups.
 
Once your hierarchy is set, you can add the
product groups manually in the product groups
pages, or you can import them. Importing
products lets you use quick import macros
or Import Management to create the entire
product group and product hierarchy all at
once.
 

Note:
If you're not integrating with an order
management application or doing quoting,
 you can simply use a product group
hierarchy without products. There's no need
to use individual products unless you need to
for downstream applications.
 

See:
 

• Create the Product Group Hierarchy topic
in this chapter

• The topic, Options for Importing Data Into
Your Application, as well as additional
topics about importing products, in the
Implementing Sales guide

Create or import products
 

If you're going to use individual products in the
catalog, add products to the application. You
can create products using the sales Products
UI or the product model available with Oracle
Supply Chain Management Cloud.
 
You can also import products and the product
hierarchy all at once. Or, you can use Import
Management to import products and the
hierarchy.
 

• If using the sales Products UI, see the
Products chapter in this guide

• If using Oracle Supply Chain Management
(SCM) Cloud product model see these
guides:

◦ Oracle SCM Cloud Implementing Product
Management

◦ Oracle SCM Cloud Using Product Master
Data Management

• The topic, Options for Importing Data Into
Your Application, as well as additional
topics about importing products, in the
Implementing Sales guide

Add products to the catalog
 

If you're going to use individual products in
the catalog, add products to the product group
hierarchy.
 

See the Add Products to the Catalog topic in
this chapter
 

Publish the sales catalog
 

Publish the product group hierarchy that
makes up the sales catalog. Perform this step

See:
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Step Description Where to Find More Information

in the product groups pages in Setup and
Maintenance.
 
When you publish a catalog, the scheduled
process, Refresh Denormalized Product Catalog
Table for BI, runs automatically to update the
current view of the product group hierarchy in
consuming applications.
 

• Publish the Sales Catalog topic in this
chapter

• Run the Refresh Denormalized Product
Catalog Table topic in this chapter

Enable the sales catalog
 

To enable a sales catalog for use in the
applications, you associate it with a "usage"
called the Base usage.
 

See the  Enable the Sales Catalog by Setting the
Base Usage topic in this chapter
 

Run the scheduled process, Refresh
Denormalized Product Catalog Table for BI
 

If you make a new assignment of Base to a root
product group, you must run the scheduled
process, Refresh Denormalized Product Catalog
Table for BI. If you don't run the process, your
product group hierarchy may not appear in the
consuming applications.
 

See the Run the Refresh Denormalized Product
Catalog Table topic in this chapter
 

Enable salespeople to browse the catalog
 

Set the profile option, Browse Sales Catalog in
Opportunities Enabled, to Yes to enable Browse
Sales Catalog button on the Products table.
 

See the Enable Salespeople to Browse the
Catalog topic in this chapter
 

Let salespeople sort alphabetically
 

Salespeople browsing the sales catalog can sort
products and product groups alphabetically
after you set a profile option.
 

See Let Salespeople Sort the Sales Catalog
Alphabetically in this chapter
 

Set usage options for searching and browsing
 

If you have set up the browse catalog feature,
 configure search and browse options.
 

See the Set Sales Catalog Search and Browse
Options topic in this chapter
 

Verify your setups
 

After you have published and enabled your
catalog and, optionally, set up browsing,
 validate your setups.
 

See the Validate the Sales Catalog topic in this
chapter
 

Set up eligibility rules for products
 

You can implement eligibility rules that enable
salespeople to check product eligibility in
opportunities.
 

See the Set Up Product Eligibility topic in the
Products chapter of this guide
 

Set territory filtering options
 

You can configure whether the sales catalog
displays only product groups and products
within a user's sales territories, or if it displays
all product groups and products defined in the
catalog.
 

See the Filter Sales Catalog Display by Territory
s topic in this chapter
 

Integrate with Oracle Configure, Price, and
Quote (Oracle CPQ) for additional capabilities
 

You can use the prebuilt Fusion Sales-Oracle
CPQ integration to let salespeople manage a
variety of quote-related activities.
 

See the Quotes and Orders chapter in this guide
and the Integrating Fusion Sales with Oracle
CPQ guide on Oracle Help Center
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Prerequisite Setups for Sales Products  
Before you set up and use sales products, ensure that your environment has completed the prerequisite setups
discussed in this topic.

Create a Location
You must create a location for your organization so that you can select it when you create the item organization.
However, if you have already set up locations as part of your initial setup with another cloud service, then you don't
need to perform this step.

1. Sign in as a setup user and go to the following in Setup and Maintenance:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Show: All Tasks

◦ Task: Manage Locations

2. Click Create.
3. In the Location Information region Name field, enter any name. For example, HQ.
4. Enter any combination of letters or numbers without spaces in the Code field. For example, HQ.
5. You don't need to change the other values.
6. Click Submit.

The application displays a warning informing you that the request will be submitted.
7. Click Yes.
8. Click OK to close the confirmation message.

Create Item Master and Ensure Setup of Location
Sales products functionality relies on the item master organization, the organization that holds the definitions of all
products your company plans to sell. Therefore, before you can use products in your catalog, you must set up a location
and then an item master organization.

For more information, see the related topics and these guides:

• Oracle Applications Cloud Understanding Enterprise Structures guide

• Oracle SCM Cloud Implementing Product Management guide

• Oracle SCM Cloud Using Product Master Data Management guide

1. Sign in as a setup user and go to the following in Setup and Maintenance:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Item Organizations

2. On the Manage Item Organizations page, click Create (the plus icon).
3. Enter any name in the Name field, for example, Vision Item Master.
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You must select this name when setting the system profile option Sales Products Item Organization in a
separate and related task. This name is visible only during setup.

4. In the Organization field, enter any combination of up to 18 uppercase letters and numbers, for example,
VISION.

You must enter this name in the separate and related setup task: Manage Spoke Systems.
5. In the Name field in the Location region, click the down arrow and select Search from the list.

The Search and Select: Location Details window appears.
6. In the Name field, enter the name of the location you created.
7. Click Search.
8. Select the organization name and click OK.
9. On the Create Item Organization page, click Next.

10. On the Manage Item Organization Parameters page, make sure the organization name you entered (Vision
Item Master) is selected in the Item Master Organization list. This selection establishes the organization as the
item master.

11. In the Starting Revision field, enter a number. For example,1. Again, your entry doesn't matter.
12. Click Save and Close.
13. Click Done.

Ensure Setup of Units of Measure
Units of measure (UOMs) are standard definitions for product measurements; therefore, you must set up UOMs. If
UOMs are already set up as part of your company's existing setups, then you can skip this step.

Setting up UOMs involves creating the larger UOM classes (or categories), as well as the UOMs themselves. For
example:

• If you're selling consulting services where you charge by the hour and minute, then you set up Time as the
UOM class and Hour and Minute as UOMs.

• If you're selling goods that are priced by the box and by the unit, you set up Quantity as the UOM class and Box
and Each as the UOMs.

• If you're selling and pricing goods by the meter, then you set up Dimension as the UOM class and Meter as the
UOM.

Note:  Each class can have only one base UOM. Base UOMs should generally be the smallest UOM in the class.

Tip:  When disabling UOMs, disable the conversions first, then the UOM. It the UOM you're disabling is a base unit, the
class should be disabled also. After an item has been defined in the item master, then the primary UOM for that item
can't be modified.

1. Sign in as a setup user and go to the following in Setup and Maintenance:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Units of Measure

2. Create the class for the unit of measure:

a. Click Manage UOM Classes.

604



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 21
Sales Catalogs

b. On the Manage UOM Classes page, set up each class:

i. Click Add, (the plus sign icon in Search Results).
ii. Enter the class code (no spaces permitted), class name, and optional description.

For example, for quantity, enter QUANTITY as the Class Code, Quantity as the Class Name.
iii. Enter a code (three-character limit) and name for the smallest unit you're selling in the UOM Code

and Base UOM Name fields.

For example, for the class Quantity, enter Ea as the UOM Code and Each as the Base UOM Name.

Salespeople use your entry in the name field for entering opportunity quantities.

Here's a screen shot of the Manage UOM Classes page:

3. Click Save and Close.
4. You created the smallest unit of measure for each class. Now create any additional units of measure for each

class:

a. On the Manage Units of Measure page, click Add, (the plus sign icon) in Search Results.
b. Enter the code (maximum of three characters) and the name of the unit of measure.

For example, if your smallest unit of measure for the class Time was Minute, then create Hour as another
unit of measure if your organization charges by the hour.

c. Select a class from the Class Name list.
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5. Click Save.

Here's a screen shot of the Units of Measure page with Hour and Minute units of time measure:

6. Click Manage UOM Standard Conversions.
7. On the Manage UOM Standard Conversions page, enter the conversions for each of the additional units of

measure you created:

a. Enter the UOM name, for example, Hour, and click Search.
b. Enter the conversion. For Hour, enter 60 to indicate there are 60 minutes in the hour.

Here's a screen shot of the Manage UOM Standard Conversions page showing the conversion for the
hour unit of measure.

8. After you enter all of the conversions, click Save and Close.

Specify the Item Master Organization for Sales Products
You must set the Sales Products Item Organization system profile option to the item master organization you just
created.

1. Sign in as a setup user and go to the following in Setup and Maintenance::

◦ Offering: Sales

606



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 21
Sales Catalogs

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Profile Display Name field, enter Sales Products Item Organization.
3. Click Search.
4. Click the name of the profile option in the search results.
5. In the Profile Value field, select the item master organization you created from the list.
6. Click Save and Close.

Identify the Item Master Organization as the Source of Import Data
You must specify the item organization as the default source of the import data using the Manage Spoke Systems task.
Spoke systems (also called source systems) identify the source of import data.

1. Open the Manage Spoke Systems task from the implementation project. Alternatively, you can search for the
task by name in the Setup and Maintenance work area. (You must use the side-panel search because the task
isn't in the Sales offering.)

The Manage Spoke Systems page appears. You can ignore any error message you receive regarding read
permissions.

2. In the Name column in the Search Results region, click the Product Information Management Data Hub link.
3. On the Edit Spoke System: Product Information Management Data Hub page, Import Options tab, select the

item master organization name you created earlier from the Default Organization list. For example, VISION.

Here's a screen shot of the Edit Spoke System: Product Information Management
Data Hub page highlighting the location of the Default Organization field:

4. Click Save and Close.
5. Click Done.
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Related Topics
• Sales Products High-Level Setup Steps

• Item Master Organizations

• Item Organizations

• How Units of Measure, Unit of Measure Classes, and Base Units of Measure Relate to Each Other

• How to Assign Base Units of Measure to Unit of Measure Classes

Create the Root Product Group  
The root product group is the top-level product group in your catalog. The display name you use appears in the UI for
users.

Note:  If you're importing product groups, follow the steps in the Implementing Sales guide.

Here's how to create the root product group:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog (or Sales Catalog and Products)

◦ Task: Manage Product Groups

2. In the Manage Product Groups page, click the create icon (the add icon available in the toolbar in the left pane).
3. In the Name field, enter a unique name without spaces. This is the internal name of the group.
4. In the Display field, enter the product group display name. This is the name that displays in the UI to users.
5. Optionally, enter a description and start and end dates.
6. Select these check boxes:

◦ Active: Your catalog must be active to be used in consuming applications.

◦ Root Catalog: The root catalog is the top product group in the hierarchy. All other product groups
created under it are considered subgroups. You can only add root catalogs to the Base usage in the
Manage Product Group Usage page. You need to add your catalog to the Base usage so that it can be
used in consuming applications.

◦ Locked: A product group must be "locked" to be edited.

7. Deselect the Allow Duplicate Children check box. You must deselect this check box because the same product
groups can't appear multiple times in the sales catalog hierarchy.

8. Leave the Allow Selection check box checked.
9. Click Save and Close.

10. Verify that the root product group appears in the Manage Product Groups pane.

Create the Product Group Hierarchy  
If you're manually creating the product group hierarchy in the UI, create the remaining product groups under the root
product:
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1. Click the root product group in the side pane.

Keep in mind that when you view product groups in the Manage Product Groups page, you have two
view options: List view: When you first enter the Manage Product Groups page, you see the product
groups as a list of folders. Click the tree view icon to enter tree view.Tree view: Tree view shows the
product groups as nested parent-child groups. To return to list view, click the list view icon. In order
to see the list view icon and the list of product groups, you may need to expand the Manage Product
Groups pane.Here's what the list view and tree view icons look like on the Manage Product Groups page:

2. In the Manage Product Groups page, click the Subgroups tab in the main work area.

The product group information for the selected group appears in the main work area.

Tip:  A product group must be "locked" to be edited, so ensure that the parent of the product group you're
creating is locked.

3. Click the Create icon.
4. In the Create Subgroup dialog box, enter the product group information.

◦ In the Name field, enter a unique name without spaces.

◦ In the Display field, enter the product group display name.

◦ Enter a description and start and end dates if you want.

◦ Select these check boxes:

- Active: Only active product groups are available for use in the consuming applications.
- Root Catalog: Don't select the Root Catalog check box. You can have only one root catalog.

◦ Deselect the Allow Duplicate Children check box to make sure that product groups and products don't
appear multiple times in the hierarchy.

5. Click Save and Close.
6. Verify that the product subgroup is visible in the Manage Product Groups pane. If the new subgroup doesn't

appear, then click View and then Refresh.
7. Repeat the steps to create additional levels in your sales catalog hierarchy.
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Add Products to the Catalog  
Now that you have created products following the steps in the Products chapter of this guide, or, if you have imported
them, your next step is to add them to the product groups that make up the sales catalog hierarchy.

Here's how to manually add products to the sales catalog product group hierarchy.

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Groups

2. In the Manage Product Groups page, in the product group hierarchy, select the product group that you want to
add products to.

3. Lock the product group for editing by clicking the Lock button.
4. Click the Products tab for the product group you selected.
5. In the View filter, ensure that the Administration view is selected.
6. In the products table, select Actions > Select and Add.
7. In the Select and Add: Products screen, search for and select the product you're adding.
8. Click Apply and then OK in the select and add window.

The application returns to the Manage Product Groups page with the product added to the product group.
9. Click the Publish button to publish the product group.

10. Finally, click Yes in the Confirm Publish dialog window and then dismiss the confirmation message. The
application publishes the product group.

11. Save your changes.
To select the organization that provides the set of products available for marketing and sales activities, select an option
in the QSC_SALES_PRODUCTS_INVENTORY_ORG_ID profile value.

For more information about how to create products manually in the sales UI, see the Products chapter in this guide. To
understand how to import products and the product hierarchy, see the product import topics in the Implementing Sales
guide.

Of course, if you're integrating with Oracle Supply Chain Management (SCM) Cloud, you may be creating product in that
application's Products screens. To understand this integration a little more see the Products chapter in this guide.

Related Topics
• Overview of Sales Products

• Data Import Options

Enable Salespeople to Browse the Catalog  
If you want salespeople be able to browse the catalog in opportunities and leads, rather than select products from a list,
set the profile option, Browse Sales Catalog in Opportunities Enabled, to Y.
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The application shows the Browse Sales Catalog button on the Products table in opportunities and leads after you do
this:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. Search for:

◦ Profile Display Name: Browse Sales Catalog in Opportunities Enabled

or

◦ Profile Option Code: MOO_ENABLE_BROWSE_CATALOG

3. In the list that's returned, click on the profile option name link.
4. In the Profile Values region, set the Profile Value to Y.
5. Save your changes.

Publish the Sales Catalog  
After building your catalog, you must publish it. While your catalog may have many product group nodes, you must at
least publish the root group.

After you publish the at least the root group, you enable the catalog by associating the root group with the Base usage.
Find these steps in the topic, Make Your Sales Catalog Available for Use, available in the related links section.

Here's how to publish the root group:

1. Lock the root product group and the remaining groups in your hierarchy that you want to make available to end
users.

2. Select the root group and click the Publish button.

CAUTION:  When you publish a node in the hierarchy, the application tries to also publish all of the locked
product groups. So, if you have product groups in the application that you don't want published, be sure to
unlock them so that they don't get published with the root and its subgroups.

3. Click Yes in the Confirm Publish dialog box.
4. Click OK on the confirmation message that's displayed.
5. Click Save and Close.

Related Topics
• Sales Catalog High-Level Setup Steps

Enable the Sales Catalog by Setting the Base Usage  
Now that you've built your catalog, you enable it by associating it with a "usage" called the Base usage.

1. In Setup and Maintenance, go to:

611



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 21
Sales Catalogs

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

2. In the Manage Product Group Usage page, select the Base record. If a product group is already associated with
the Base usage in the Details section in the portion of the screen, then you can remove the product group by
selecting it and clicking the Delete icon.

3. In the Details section, click the Select and Add icon.
4. In the dialog box that appears, search for the root catalog that you just created.
5. Select the record and click OK
6. In the Manage Product Group Usage page, click Save and Close.

Note:  Each time you make a new assignment of Base to a root product group, be sure to run the scheduled process,
Refresh Denormalized Product Catalog Table for BI. If you don't run the process, your product group hierarchy may
not appear in the applications. See the topic, Run the Refresh Denormalized Product Catalog Table Process, for more
information.

Run the Refresh Denormalized Product Catalog Table Process  
Every time you publish a catalog, the scheduled process, Refresh Denormalized Product Catalog Table for BI, runs
automatically to update the current view of the product group hierarchy in the applications.

In addition, each time you make a new assignment of Base to a root product group, you must run the process. If you
don't run the process, your product group hierarchy may not appear in the applications.

Run the Process
Here's how to run the Refresh Denormalized Product Catalog Table for BI process:

1. Sign in as a setup user and navigate to Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog window, click the down-arrow next to the Name field and click Search.
4. In the Search dialog window, enter %Refresh%, and click Search.
5. Select the Refresh Denormalized Product Catalog Table for BI process in the results that are returned and

click Ok.
6. Click Ok again, if needed.
7. In the Process Details window, click Submit.

Related Topics
• Sales Catalog High-Level Setup Steps

• Enable Salespeople to Browse the Catalog

• Validate the Sales Catalog

• Best Practices for Sales Catalog Setup
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Validate the Sales Catalog  
After you publish and enable your catalog, validate that the product groups are appearing in leads and opportunities:

1. Sign in as a sales manager or salesperson.
2. Navigate to Sales > Leads and create a lead.
3. In the Create Lead window, click the Primary Product search icon and verify that you can see the product

groups in the search utility.
4. Next, navigate to Opportunities and create an opportunity.
5. Search for the opportunity you just created and edit it.
6. In the Products region, click Add.
7. For Type, select Group.
8. In the Product list, verify that your product groups display.
9. In the Products table, click the Browse Sales Catalog button. Ensure that you can browse the catalog. Note that

this option is available only if the administrator has enabled it.

Related Topics
• Sales Catalog High-Level Setup Steps

• Enable Salespeople to Browse the Catalog

• Run the Refresh Denormalized Product Catalog Table Process

• Best Practices for Sales Catalog Setup

Usages, Options, and Actions  

Overview of Sales Catalog Usages  
Each catalog is associated with an attribute called a "usage" that specifies the application areas where it's in use.
Typically, it's the Base usage that you use for your catalog. It's the one predefined for the sales applications such as
opportunities and leads.

Oracle also supplies a few other usages that are described here.

Here are the predefined usages:

Usage Description

Base
 

Used for the sales applications, such as forecasting, territories, opportunities, and leads.
 

Help Desk HCM
 

Used for Human Capital Management Cloud.
 

Loyalty
 

Used for Loyalty Cloud.
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Usage Description

Opportunity Management Alternate
Catalog
 

Used as an alternate for opportunities, for example for Outlook integration.
 

Partner Management
 

Used for partner management.
 

Within a usage, you can set various options and actions, as described in the topic, Overview of Setting Sales Catalog
Options and Actions.

Related Topics
• Overview of Setting Sales Catalog Options and Actions

• Set Sales Catalog Options and Actions

• How can I set exceptions for particular usages of product groups?

• Sales Catalog High-Level Setup Steps

Overview of Setting Sales Catalog Options and Actions  
You can configure various options and actions for your catalog.

The options and actions include:

• Product Groups: Specify which catalogs the usage includes.

• Modes: Create and maintain "modes", which in the catalog are departments within your organization that use
a particular product group as their parent catalog. Modes are used in combination their parent product group
and further with the usage options you set.

• Templates: Select the template that determines how the catalog is displayed for this mode of usage.

• Functions: Configure functions, such as whether to run the eligibility rules or enforce territory restrictions.

• Miscellaneous: Change miscellaneous catalog display settings, such as button labels or number of items per
page.

See the Set Sales Catalog Options and Actions topic for steps.

Functions
In the Functions tab, you can specify options for eligibility checks, display of prices, and product display filtering by
territory.

Here are the function options:

Function Description Value Effect

Eligibility Engine
 

Determines whether to display the
eligibility of products based on the
eligibility rules in place.
 

Don't run
 

The eligibility service is off. Users
can't check eligibility of products in
the catalog.
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Function Description Value Effect

  Run
 

The eligibility service is on. Users
can check eligibility of products in
the catalog.
 

Pricing Engine
 

Determines whether to display
prices for a product, if pricing
integration is set up.
 

Don't run
 

The pricing service is off. Prices
don't display in the catalog.
 

Not applicable
 

Not applicable
 

Complex
 

The pricing service is on. The
catalog shows prices, such as List
Price, Your Price, and Discount
Price.
 

Not applicable
 

Not applicable
 

Simple
 

The pricing service shows List Price
only.
 

Territory Engine
 

Determines whether to display
product groups and products in a
territory.
 

Don't run
 

Territory filtering is off. The Filter
by Territory check box doesn't
display.
 

Not applicable
 

Not applicable
 

Enforce territory
 

Territory filtering is on, but is
transparent to the user. The Filter
by Territory check box doesn't
display.
 

Not applicable
 

Not applicable
 

Display user choices
 

• Checked by default: Territory
filtering is on. The territory
filter check box is displayed
and checked by default. The
user can deselect the check
box to disable the territory
filtering.

• Unchecked by default:
Territory filtering is off. The
territory filter check box is
displayed and deselected by
default. The user can check
the check box to enable the
territory filtering.

Miscellaneous Actions
In the Miscellaneous tab, you can set various catalog display preferences, such as the button labels, to display and the
number of products to display per page.

This table shows the display options:

Name Description

Add item button label
 

The selected value is shown next to the product at runtime.
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Name Description

Add category button label
 

The selected value is shown next to the catalog or category at runtime.
 

Add category enabled indicator
 

Allows buttons to be shown next to the catalog or categories.
 

Enforce product group selection
 

Hides sales catalog product group hierarchy nodes in the runtime UI. Click Yes to make it so users can't
select product groups while browsing and hide product groups in the opportunity Products table list of
values.
 

Records per page
 

The number of records to be displayed per page.
 

Sort by format text
 

The sort format of the entire label that you want displayed in the runtime interface. The default is
{ATTR}: {SORT_ORDER}.
 
Example: Name: A to Z.
 

Sort by product label prefix
 

The sort format of the prefix label that you want displayed.
 
Example: If the default is Name: A to Z, you can select an alternate label for Name. It could be Item: A to
Z.
 

Sort by sequence product ascending label
 

The sort format of the ascending suffix label that you want displayed.
 
Example: If the default is Name: A to Z, you can select an alternate for A to Z. It could be Name:
Ascending.
 

Sort by sequence product descending
label
 

Sort format of the descending suffix label that you want displayed.
 
Example: If the default is Name: Z to A, you can select an alternate for Z to A. It could be Name:
Descending.
 

Sort by sequence ascending first indicator
 

Select Yes to display ascending labels first in the Sort By list of values.
 

Show immediate child products only
 

Shows immediate products of a given category disregarding the standard action of showing all
products (including child categories) if narrow by is defined on the category.
 

Image server
 

Identifies the source of images for products and product groups.
 

Image server alternate path
 

Identifies an alternate image source location (URL)
 

Enable transactional attribute
 

Allows transactional attributes to show up in product detail page. Transactional attributes are attributes
that can be selected such as color and size of shirt.
 

Hidden category optional attribute list
 

You can specify the attributes you would like to hide from the category list. Enter a comma-separated
list of attributes to be hidden.
 

Hidden product optional attribute list
 

You can specify the attributes you would like to hide from the product pages. Enter a comma-
separated list of attributes.
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Name Description

Hide quantity
 

To hide the quantity field shown in the product page, set this to Yes.
 

Hide unit of measure
 

To hide the unit of measure field shown in the product detail page, set this to Yes.
 

Related Topics
• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalog Usages

• Filter Sales Catalog Display by Territory

• Disable Sales Catalog Product Group Display

Set Sales Catalog Options and Actions  
You can use the product group usage pages in Setup and Maintenance to change many actions of the sales catalog in
the runtime UI.

For example, you can configure whether the sales catalog shows only product groups and products within a
salesperson's territories, or if it shows all product groups and products defined in the catalog.

Set Options and Actions
Here are the steps to set miscellaneous options and actions:

1. Select the Base catalog in the upper portion of the page. (If your catalog uses a different usage, then select it.)
In the Details region of the page, the Product Groups tab shows the catalogs associated with the usage you
have selected.

2. To have the settings apply to a specific product node (or catalog), optionally, in the Product Groups tab, select
the product group before making the changes in the other tabs.

3. To modify functions, such as territory filtering, click the Functions tab in the Details section of the page.

Within the Functions tab, click the Value drop-down list for the option you want to modify. If multiple
applications have a row for an option, then select the row that has the application you want the setting to apply
to. The applications that can use each option appear in the Mode column of the Functions tab. For example,
click Territory engine for the Opportunity Management application shown in the Mode column.

4. To set miscellaneous options, such as button labels to display and the number of products to display per page,
click the Miscellaneous tab and then make your selection.

5. Save your changes.

For more information on the options that can be set, see the topic, Set Sales Catalog Options and Actions.

Related Topics
• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalog Usages

• Overview of Setting Sales Catalog Options and Actions
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Additional Configurations  

Enable Salespeople to Browse the Catalog  
If you want salespeople be able to browse the catalog in opportunities and leads, rather than select products from a list,
set the profile option, Browse Sales Catalog in Opportunities Enabled, to Y.

The application shows the Browse Sales Catalog button on the Products table in opportunities and leads after you do
this:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. Search for:

◦ Profile Display Name: Browse Sales Catalog in Opportunities Enabled
or

◦ Profile Option Code: MOO_ENABLE_BROWSE_CATALOG

3. In the list that's returned, click on the profile option name link.
4. In the Profile Values region, set the Profile Value to Y.
5. Save your changes.

Set Sales Catalog Search and Browse Options  
The browse catalog feature lets salespeople search and browse product groups and products in a hierarchy view. When
configuring search and browse, you set these two options:

• Search Product Groups: Specifies whether the search returns product groups and products, or only products. If
you're using not using products in your catalog, then you must set this option to yes.

• Show Immediate Child Products Only: Specifies which products display in the Products heading in the Browse
Catalog window. You can ignore this option if you're not using products in your catalog.

Search Product Groups Option
In the Browse Catalog window, users enter keywords to search for product groups and products. The Search Product
Groups option specifies whether the search should return product groups and products, or only individual products.

Take a look at this table to understand how to use the Search Product Groups option.

Description Settings Example When Set to Yes Example When Set to No

• Determines whether the
search finds product groups

• Yes: Search returns both
product groups and products.

Search for the term Green: The
application returns all product

Search for the term Green: The
application returns only products
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Description Settings Example When Set to Yes Example When Set to No

and products or only
products.

• Searches names and
descriptions.

• The default setting is no.

If you're using not using
products in your catalog, then
you must use this setting.

• No: Search returns products
only.

groups and products with that
term in the name or description,
 such as Green Servers (product
group), Green Server 3000
(product), and Green Server
6000 (product).
 

with that term in the name or
description, such as Green
Server 3000, Green Server
6000, and Green Server 9000.
 

Show Immediate Child Products Only Option
In the Browse Catalog window, salespeople can browse product groups and products by selecting product groups. The
Show Immediate Child Products Only option specifies whether to display only the products immediately within the
selected product group, or also to display the products contained within the subgroups of the selected product group.

Here's how to use the Show Immediate Child Products Only option.

Description Settings Example When Set to Yes Example When Set to No

• Determines whether the
browse feature shows only
products within the selected
product group in the catalog,
 or to also show products
within the subgroups of the
selected product group.

• The default setting is yes.

• Yes: Browse shows only the
products within the selected
product group.

• No: Browse also shows
the products within the
subgroups of the selected
product group. If you're
not using products in your
catalog, only product groups,
then this setting has no effect
on the browse feature.

The product group Servers
has no products within it, but its
subgroups, Green Servers and
UltraPro Servers, each have
several products within them. The
user clicks the Servers product
group in the catalog browse
pane. No products display in the
Products section of the display
page.
 

The product group Servers
has no products within it, but its
subgroups, Green Servers and
UltraPro Servers each have
several products within them. The
user clicks the Servers product
group in the catalog browse pane.
The products contained within the
Green Servers and UltraPro
Servers product groups display in
the Products section of the display
page.
 

Understand Catalog Usage Option Modes
Before you set the usage options discussed here, be aware of the concept of "modes" for the catalog usage options.
Each catalog usage option has a corresponding Mode value. The Mode setting lets you specify which application
or applications the usage option applies to. If you leave the Mode value blank, then the usage option applies to all
applications where the catalog is in use.

Set the Search and Browse Options
Use these steps to set the sales catalog search and browse options.

1. Sign in as the sales administrator.
2. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

3. In the Product Group Usage list, select the Base usage.
4. In the Base: Details region, click the Miscellaneous tab.
5. Find the option in the list and set it as needed. For example, set Search Product Groups to Yes for the mode,

Opportunity Management.
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6. Save your changes.

Related Topics
• Overview of Sales Catalogs

• Sales Catalog High-Level Setup Steps

Filter Sales Catalog Display by Territory  
You can configure whether the sales catalog displays only product groups and products within a user's sales territories,
or if it displays all product groups and products defined in the catalog.

Furthermore, you can configure whether to have territory filtering off by default, and to let users turn the territory filter
on or off.

In the sales catalog runtime UI, the territory filter appears as follows, if enabled:

• While browsing the catalog, users can select the Filter by Territory option in the Settings menu. For example,
while editing an opportunity, a sales representative clicks Browse Catalog on the Products table, which
launches the catalog where she can browse product groups and products. In the Settings menu, she enables
the Filter by Territory option, to have the display of product groups and products limited to only those in her
assigned territories.

• While searching for products or product groups, users can select the Filter by Territory check box. For
example, while editing an opportunity, a sales representative searches in the products or product groups lists
in the Product table. In the Select: Products or Product Groups pages, she enables the Filter by Territory check
box, to have the display of product groups and products limited to only those in her assigned territories.

Set Territory Filter Options
You set the territory filtering options in the product groups setup pages.

1. Sign in as the sales administrator.
2. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

3. Select the Base catalog in the upper portion of the page. (If your catalog uses a different usage, then select it.)
4. Click the Functions tab in the Details section of the page.
5. Click the Value drop-down list for the Territory engine option. If multiple applications have a Territory engine

row, then select the row that has the application you want the filtering to apply to. The applications that can use
the territory filtering functionality appear in the Mode column of the Functions tab. For example, click Territory
engine for the Opportunity Management application shown in the Mode column.

6. Make your filtering selection, using the information in the following table.

Option Description

Do not run
 

Territory filtering is off. The Filter by Territory check box does not display.
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Option Description

Enforce territory
 

Territory filtering is on, but is transparent to the user. The Filter by Territory check box does not
display.
 

Display choice - checked by default
 

Territory filtering is on. The territory filter check box is displayed and checked by default. The
user can deselect the check box to disable the territory filtering.
 

Display choice - unchecked by default
 

Territory filtering is off. The territory filter check box is displayed and deselected by default. The
user can check the check box to enable the territory filtering.
 

7. Click Save and Close.

Related Topics
• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalog Usages

• Overview of Setting Sales Catalog Options and Actions

Overview of Setting Up Additional Product Information  
When a user browses the product catalog, selects a product, and drills down into the product details, the application
displays more tabs with additional information. These tabs are considered related items of that item that the user is
viewing. You set up all of the related information in Product Information Management (PIM).

The related item tabs are:

• Details and Specifications: Populated from the PIM Long Description field

• Similar Products: Products with a relationship type of Substitute

• Service Products: Products with a relationship type of Service

• Included Warranty: Products with a relationship type of Warranty

• Accessories: Products with a relationship type of Accessories

Here are the high-level steps to add content to these tabs. For complete information, start with the Item Specifications
and Attributes topic in the Using Product Master Data Management guide.

1. Sign in as a setup user.
2. From the Manage Items task in the Product Information Management UI, search for an item and edit it.
3. Navigate to the Relationships tab.
4. Search for and add the related items.
5. Save your changes.

Note:  You can't show custom fields for the Product object in the Browse Catalog UI.
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Disable Sales Catalog Product Group Display  
You can hide sales catalog product group hierarchy nodes in the runtime UI if you don't want users to see or select
them.

By default, nodes of the product group hierarchy can be seen and selected by users in the product group list of values
and in the browse view of the catalog.

After you set the option to hide product group hierarchy nodes in the runtime UI, the UI changes as follows:

• In the opportunity Products table, when a user selects a the list of values to select a product group, product
groups do not display.

• In browse catalog view, the product groups display but cannot be selected.

For more information about creating and editing product groups, see the Creating the Sales Catalog: Getting Started
topic.

Disable Group Nodes During Creation or Editing
You can hide a product group and its child product groups from displaying in the runtime UI by deselecting the Allow
Selection check box while creating or editing the group in the product groups pages.

Here's how you hide a product group and its child product groups:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Groups

2. If you're creating a product group, click the create icon and fill in the require fields. Be sure to deselect the Allow
Selection check box.

3. If you're editing a product group, select the product group and lock it for editing.
4. Deselect the Allow Selection check box.
5. Click Save and Close.

Disable Groups Nodes
You also can configure the display of product group hierarchy nodes using Enforce product group selection option
available in the Miscellaneous tab of the Product Group Usages page.

Here's how:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

2. Select the Base catalog in the upper portion of the page. (If your catalog uses a different usage, then select it.)

In the Details region of the page, the Product Groups tab shows the catalogs associated with the usage you
have selected.
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3. To have the settings apply to a particular product node (or catalog), optionally, in the Product Groups tab, select
the product group before making the changes in the other tabs.

4. Click the Miscellaneous tab and modify the Enforce product group selection option.

◦ A setting of Yes means that the product groups are disabled in the product selection list of values and in
the browse catalog view.

◦ A setting of No means that the product groups are not disabled.

5. Click Save and Close.

Related Topics
• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalog Usages

• Overview of Setting Sales Catalog Options and Actions

Let Salespeople Sort the Sales Catalog Alphabetically  
Salespeople browsing the sales catalog can sort products and product groups alphabetically after you set a profile
option.

Enable the sorting by setting the profile option, Default Sort By Behavior in Browse (ORA_QSC_SORT_BY_NAME), to yes
in Setup and Maintenance:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Profile Option Values

2. Search for the profile option and set it to yes.
3. Click Save and Close.

Set Performance-Tuning for Opportunity Products Search  
By setting a profile option, you can enable or disable the smart list in the Product list of values in the Products table in
opportunities. The smart list is a pre-fetched list of products.

For performance reasons, Oracle recommends that if you have more than 5,000 products in the application, then you
should prevent the entire smart list from being pre-loaded when a user clicks the pre-loaded list.

As a user types, the application searches against the product smart-list entries. If the user clicks the drop-down list then
the application initializes the complete smart-list. To disable the preload of the smart list, set the profile option Preload
Territory-Filtered Product List Enabled (ZBS_ENABLE_PRODUCTLOV_SMARTLIST) to No. By default, the profile option
is set to yes.

Set the Profile Option
Here's how to set the Preload Territory-Filtered Product List Enabled profile option.

1. In the Setup and Maintenance work area, go to:
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◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search for and select the profile option name, Preload
Territory-Filtered Product List Enabled, or the code, ZBS_ENABLE_PRODUCTLOV_SMARTLIST.

3. Set the profile option to No to disable the preload of the smart list.
4. Save your changes.

Related Topics
• Update Existing Setup Data

Enable the Catalog for Languages Other Than English  
For users to be able to view the sales catalog in session languages other than English, you need to enable languages in
the applications:

1. Sign in as a setup user and navigate to the Security Console in the Tools menu.
2. Click Create Role and create a new role with these details:

◦ Role Name: Custom_ProductOrgLang

◦ Role Code: CUSTOM_PRODUCTORGLANG

◦ Role Category: CRM - Job Roles

3. Click Next until you get to the end of the train, and then click Save and Close.
4. In the Security Console, search for the role you just created and edit it.
5. In Function Security Policies, click Add Function Security Policy.
6. Search for the privilege, Manage Item Keyword Search Organizations and Languages, and add it to the role.
7. Click the Users train stop.
8. Click Add User and add the user to the new role.
9. Click Next until you get to the end of the train, and then click Save and Close.

10. You should receive a confirmation message that the changes were saved.
11. Next, navigate to Scheduled Processes in the Tools menu.
12. Click Schedule New Process and run these two processes:

◦ Import User and Role Application Security Data

◦ Retrieve Latest LDAP Changes

Tip:  You may need to search for the processes in the search and select window available by clicking the
Search link at the at the bottom of the Name list on the main search window.

13. After these jobs have completed, sign out and back in.
14. Go to the Setup and Maintenance > Sales offering.
15. Use the search from the right task drawer to open the task, Manage Item Keyword Search Attributes.
16. In the Indexed Organizations and Languages region, set up the languages as required.

For more information about setting up languages, see the related topics.

624

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051179


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 21
Sales Catalogs

Related Topics
• When do I create or edit ISO languages?

Catalog Use Case Examples  

Example of Creating a Sales Catalog  
In this example, a Vision Corp. sells servers and is setting up the product catalog for the first time.

Create a Sales Catalog
1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the list of functional areas, click the Sales Catalog and Products area.
3. Select the Manage Product Groups task.
4. In the Manage Product Groups page, create a new product groups.
5. In the Details dialog window, enter the data shown in the following table.

Field Sample Data

Name
 

VisionCatalog
 

Display
 

Vision Catalog
 

Description
 

Contains servers for enterprise sales.
 

Root Catalog
 

Select this check box to make this a root catalog.
 

6. In the Details tab, select the image that you want to display in this catalog.
7. In the Subgroups tab, create the following product groups, which are the categories for this product catalog.

Field Sample Data

Subgroup Name
 

◦ Sentinel Power Server 1000

◦ Sentinel Power Server 3000

◦ Sentinel Power Server 6000
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8. Add more categories within some subgroups by switching from list to tree view and selecting the categories
within which you want subgroups.

Tip:  To show the catalog in hierarchy mode so that you can see the nesting of the product groups, click the
hierarchy icon in the Manage Product Groups pane.

Add the following categories within subgroups.

Parent Subgroup Sample Data

Sentinel Power Server 1000
 

◦ Sentinel Power Server 1050

◦ Sentinel Power Server 1100

◦ Sentinel Power Server 1200

Sentinel Power Server 3000
 

◦ Sentinel Power Server 3050

◦ Sentinel Power Server 3100

◦ Sentinel Power Server 3200

Sentinel Power Server 6000
 

◦ Sentinel Power Server 6050

◦ Sentinel Power Server 6100

◦ Sentinel Power Server 6200

9. In the Products tab, add products to all the subgroups that you created.
10. Click Publish to publish the product hierarchy that you just created.

A published catalog is available for use by different departments.
11. You must enable a sales catalog for use by associating it with the Base usage. To associate a published catalog

with a particular usage, go to the Product Group Usage page and select the Base usage. Then, click the Product
Groups subtab and select the catalog you just created.

Related Topics
• Sales Catalog High-Level Setup Steps

Example of Reusing a Sales Catalog  
This example demonstrates how you can reuse a sales catalog. After creating a catalog for a business that sells chairs
and sofas, you get a call from another division of the company that wants a similar catalog with the same look-and-feel.

You find that this division needs the products in the Chair category of your existing catalog, so you can reuse this
category instead of creating a new catalog.

Note:  To complete this task, an application developer must create an application that can use the sales catalog task
flows, just like sales uses the task flows provided by the sales catalog team.
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Prerequisite
You can select only product groups that are catalogs themselves. In other words, the catalog must be a root catalog.
You realize the Chairs group is a category of your larger catalog, so you must make it a root catalog as a prerequisite to
reusing the category.

1. On the Manage Product Groups page, in the product group list, select Chairs.
2. In the Details tab, select the Root Catalog check box.
3. Save and publish the catalog.

Reuse the Sales Catalog
1. On the Manage Product Group Usage page, create a new usage and name it the Call Center Division usage.
2. Click the Product Groups subtab.
3. In the Manage Product Groups Usage page, add the product group Chairs to the new usage that you created.

The Chairs catalog is now available for the Call Center Division.

Example of Adding Filter Attributes to Product Groups  
This example shows how to enable filtering by attributes in the sales catalog.

Use case: A business that sells furniture wants to provide filters in the catalog that let users narrow the product groups
based on an attribute, such as color.

Prerequisite
Before you perform this task:

• The filtering attributes must already be registered. You register attributes in the Manage Product Group
Attributes page.

• The filtering attributes must be associated with the products in the item master.

Filtering Product Groups by Attributes
1. In Setup and Maintenance go to the Sales offering.
2. In the list of functional areas, click the Sales Catalog and Products area.
3. Select the Manage Product Groups task.
4. In the Manage Product Group page, select a product group. For example, select the group named Chairs.
5. With the product group selected, click the Lock button.
6. Click the Filter Attributes tab.
7. In the Filter Attributes tab, click New to add a new attribute.
8. In the Create Filter Attribute dialog box, Name field, search for and select the filter attribute.

For example, select the Color attribute.
9. Optionally, in the Create Filter Attribute dialog box, select the Advanced Search, Narrow By, and Sort By check

boxes for the attribute, so that this attribute will be displayed in those regions at runtime.
10. Click OK in the Create Filter Attribute dialog box to save your changes.
11. In the Attribute Values area, add records and enter values for the attributes.

For example, add Blue, Pink, and Black as the values for the chair color.
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12. Unlock the group, save the changes, and publish the product group.

After publishing the product group, you validate the changes in the catalog. You can see the attributes that you
created and their values in the Advanced Search, Narrow By, and Sort options of the catalog.

Related Topics
• Sales Catalog High-Level Setup Steps

• Example of Creating a Sales Catalog

Catalog Troubleshooting  

Best Practices for Sales Catalog Setup  
Sales catalog and product group setup can be quite complex. Therefore, be sure to follow the best practices described in
this topic.

Here are the main best practice areas covered in this topic:

• Importing product groups

• Finding and entering reference numbers

• Checking your work before publishing or importing

• Locking and publishing product groups

• Associating the product group root with the Base usage

• Creating a new product group hierarchy

• Running a scheduled process after changing Base usage

Import Product Groups
If your import file contains spelling and other errors, you can make your corrections in the same file and import again.
The import process overwrites the existing entries.

Find and Enter Reference Numbers
Unique product group reference numbers can be used to establish the relationships between parent and child product
groups in some import spreadsheets. You can find the reference number in the Reference Number column in the
Manage Product Groups page.

In your import spreadsheet, be sure any numbers are formatted as numbers (versus, for example, formulas), with zero
digits to the right of the decimal. Otherwise, the import process can't recognize them. For example, generally, when you
paste the reference number into a spreadsheet, the spreadsheet will automatically format it as something other than a
plain number. In order for the import process to recognize the number as a number, you may need to explicitly format it
as a number (with zero digits to the right of the decimal).
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This figure shows an example of a reference number after being pasted into a spreadsheet cell (in the first highlighted
box), and then the same reference number formatted as a number with no digits to the right of the decimal (in the

second highlighted box). 

Check Your Work Before Publishing or Importing
After you have published a product group, you can't delete it. You can only make it inactive. Thus, be sure to check
your work before you publish the product groups you create in the UI and before you import. Importing publishes all
unpublished product groups automatically, even those that aren't in your file.

1. Click on the root group name in the list and then click the tree view icon in the tool bar.
2. Check that the names are correct and that the hierarchy is set up as you want it.

Lock and Publish Product Groups
Any product group you want to edit must be "locked". You lock a group by selecting it in the UI and then clicking the
Lock button. When you lock a product group, no one else can make changes to it until it's unlocked again.

Any product group hierarchy you want to use in consuming applications must be published. Publishing is done by
clicking on the root node of the group and then clicking the Publish button or when you import your product group data
file. When you publish, the application publishes all product groups that are locked. If you don't want some groups to be
published, then you must unlock them.

Set Product Group Hierarchy Base Usage
The root product group you use for leads, opportunities, and territories must be assigned to a usage called "Base". You
make this assignment in the Manage Product Group Usage page in Setup and Maintenance. Use the Manage Product
Group Usage task to get to the page.

Note:  The root product group must be published to be able to associate it with the Base usage.

Create a New Product Group Hierarchy
If for some reason you don't want to use a product group hierarchy that you have created, you can always create a new
root and subgroups, publish them, and associate the Base usage with the new product group root.

Run a Scheduled Process After Changing Base Usage
Each time you make a new assignment of Base to a root product group, you must run the scheduled process Refresh
Denormalized Product Catalog Table for BI. If you don't run the process, your product group hierarchy may not appear in
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the consuming applications. Also, if you use future start or end dates for product groups, then you should schedule the
refresh process periodically as well.

Related Topics
• Sales Catalog High-Level Setup Steps

• Overview of Sales Catalogs

• Enable Salespeople to Browse the Catalog

• Add Products to the Catalog

• Validate the Sales Catalog

Why can’t I see any products, product groups, or price books listed
in the manage UI?  
Navigate to Sales and Service Access Management > Configure Groups > Object Sharing Rules. Run the following
checks:

• Check Access Group set up and ensure that the signed-in user has access to the object, either through
predefined object sharing global rules or through custom access group rules (Assign Access Group).

• Make sure that the latest changes in the access group rules are published.

• If you're using a custom rule, ensure that you deactivate/disable the system global rule.

Related Topics
• Use Access Groups to Secure Product, Product Group, and Price Book Data

FAQs for Sales Catalogs  

Frequently Asked Questions (FAQs) for Sales Catalogs  
This section contains some frequently asked questions (FAQs) when setting up and maintaining sales catalogs. Scroll or
search to find answers to common questions.

What's the difference between the administration and published
product group versions?  
The administrator who defines the product group uses the administration version.

The user of the sales catalog sees the published version.
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Note:  When you publish the administration version, you make it available as the published version.

What's a related group?  
A related group shows the relationship between two different product groups. For example, you can see that a group
with extended warranties for computers is related to a group with laptop computers. The application supports several
relationship types, such as Revenue and Service.

What's a rollup catalog?  
Use a rollup catalog to create a hierarchy that feeds data to the forecast.

A sales catalog can have the same product group appear multiple times in its hierarchy. For example, the product group
Toys can be part of the Children category as well as the Electronics category within the same catalog. However, in
forecasts, each product appears only once, so the rollup catalog can't have the same product group appear multiple
times in its hierarchy.

Note:  The Allow Duplicate Children check box controls whether a product group can have duplicate child nodes.

How can I change the labels for filter attributes at runtime?  
In the Filter Attributes tab of the Manage Product Group page, change the value in the Display field for the attribute.

You can also create a user-friendly name to display at runtime. Let's say that an attribute name is Laptop Color. You can
change its display name to Available Colors. The user-friendly name shows up in the Narrow By or Advanced Search
options at runtime.

How can I change sales catalog button labels?  
You can change the default Add to Cart label, and you can select a different label, such as Add to Shopping Cart. On the
Manage Product Groups page, select the Display Options tab and the Miscellaneous subtab.

Keep in mind that before you can select button label values, they must be values in the lookup type Add Item Label
Values in the Manage Product Group Lookups page.
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How can I set exceptions for particular usages of product groups?  
In the Manage Product Group Usage page, select a usage.

For example, select the Base usage. Click the product group in the Product Groups tab, select the usage in the Modes
tab, and use the other tabs to specify the exceptions for this usage.

You can use this method to modify the appearance of a product group in minor ways for different uses. For example,
you might want a product group to look slightly different when it's used for lead management and for campaign
management.

Why did some of the products in my published catalog disappear? 

Products in your catalog are active for a specified period. Inactive products don't show up in a published catalog. You
can activate products using the Products tab of the Manage Product Groups page.

How can I check whether my catalog is used by other catalogs?  
You can get this information from the Sharing region in the Manage Product Groups page. By default, all product
groups can be shared.

Why can't I modify a product group?  
Lock a product group to modify it. Click Lock in the Manage Product Groups page. If the product group is locked by
another user, then you can see the locked indicator and you can't modify the product group.
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22  Leads

Overview of Lead Management  
Leads provide a way for your sales organization to capture the potential interest in your products. After your
organization qualifies the information and determines the lead is worth pursuing, you turn it into an opportunity and
the sales process begins in earnest.

Use the Contact time zone field to capture the preferred time zone of a contact pursued on your lead. The contact time
zone is based on the contact address and helps you know the preferred time to call or email a prospect or customer. You
can also use the functional who columns to capture the record history of a lead. The columns let you accurately report
on leads that are imported from other systems.

Other lead management features help to align marketing and sales objectives from lead generation to lead execution.
Lead information is generated from a variety of sources and captured from:

• A company's existing contacts

• Sales campaigns

All leads then undergo the qualification and assessment process and are qualified either manually by a salesperson or
automatically based on predefined rules. Finally, qualified leads are converted into opportunities.

Related Topics
• How Lead Components Work Together

Implementation Concepts for Leads  

Considerations for Implementing Lead Management  
This topic lists some of the considerations to take into account when planning your implementation of the lead
management feature. No setup tasks are mandatory for this feature.

You can manage the necessary configuration, integration, and metadata settings through profile options and lookups to
tailor lead management functionality to match your business requirements.

Job Roles and Associated Duty Roles
The Sales Lead Processing Duty gives access to all the underlying processing duties and processing tasks. The Sales
Lead Qualification duty provides access to all underlying qualification duties and qualification tasks.

Profile Option Decision Points
Profile options are configurable options that affect application operations. This table outlines some of the decision
points that you must consider and the associated profile option that you access to make the appropriate change:
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Decision Question Profile Option

Which assignment rules do you want to
use to assign individual resources to the
lead sales team?
 

Lead Assignment Mode
 
Assignment Rule for Rule-Based Lead Assignment
 

Which assignment rules do you want to
use to assign a territory team to a lead?
 

Assignment Rule for Territory-Based Lead Assignment
 
Assignment Rule for Rule-Based Lead Assignment
 

Which lead ranking rules do you want to
use?
 

Assignment Rule for Ranking Leads
 

Which lead qualification rules do you want
to use?
 

Assignment Rule for Qualifying Leads
 

Which leads scoring rules do you want to
use?
 

Assignment Rule for Scoring Leads
 

Do you want to display the assessment tab
in the Edit Lead page?
 

Lead Assessment Enabled
 

Which assessment template do you want
to use for lead qualification?
 

Lead Assessment Template Default
 
Advanced Lead Qualification Enabled
 
Lead Qualification Template
 

How many days should you look back
when querying leads in Search?
 

Lead Query Maximum Number of Days
 
Lead Query Default Number of Days
 
Lead Query Warning Threshold Number of Days
 

Do you want to set the maximum number
of leads that can have mass update
applied in one user action?
 

Mass Update Threshold Value
 

Note:
The ZBS_MASS_UPDATE_THRESHOLD (Mass Update Threshold Value) profile option specifies
the maximum number of records that can be updated in one user action. For Leads, the maximum
number of records that can be updated at once is 500. The default value of the profile option is 25.
 

Do you want users to the able to add or
edit products to leads?
 

Add and Edit Products to Leads Enabled
 

Do you require additional search criteria,
 other than creation date, when searching
across all leads, or for searches relying on
hierarchy rollups?
 

Require Additional Criteria for Lead Search Enabled
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Decision Question Profile Option

Do you want to set context-based data
security policies for improved performance
of lead search?
 

Lead Search Context-Based Data Security Enabled
 

Note:
If you enable this option, then you must also ensure that the filters in the Lead Overview page,
 such as My Leads, My Subordinate Leads and so on have the required access in Security Console.
Otherwise, your lead data search won't return expected results.
 

Lookup Decision Points
Lookups enable quick selection from drop-down lists. Lookups associated with lead management capabilities are
incorporated into its application to speed the process of entering data into forms. You might want to change or add
some of the values that are used in the lookup tables. Some of the values you can change include:

Lookup Description and Values

Lead Retire Reason
 

Possible reasons for retiring leads. Retired leads are considered closed leads. Values include:
 
Duplicate lead or No purchase interest Lead
 

Reject Reason
 

Possible reasons specified for rejecting leads. Rejected leads can be reassigned or retired. Values
include:
 
Duplicate lead, Failed to reach contact, and Incorrect data
 

Lead Time Frame
 

Lead cycle duration that usually coincides with a typical sales cycle duration for products and services
offered. Values include:
 
3 months, 6 months, 9 months, 12 months, 15 months, and 18 months
 

Lead Reassignment Reason
 

Possible reasons specified for reassigning leads. Values include:
 
No activity, Other, and Workload
 

Lead Rank
 

Lead rank values used as a measure of lead quality and prioritization. Values include:
 
Cool, Hot, and Warm
 

Lead Source Channel
 

Source channel responsible for lead generation. Values include:
 
Direct mail, E-mail, Fax, Marketing Cloud, Phone, Sales campaign, Sales visit, Social, Company website,
Wireless message, Model-based prediction, and Rule-based prediction
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Related Topics
• Sales Lead Profile Options

• Example of Defining a Sales Lead Qualification Template

• Lead Qualification Templates

• Example of Defining the Automatic Assignment of Lead Team Resources

How Lead Components Work Together  
The lead life cycle includes an automated process that captures leads and then prioritizes them for sales engagement
through a scoring and ranking process. Leads are distributed to appropriate sales resources for further lead
qualification, follow-up, and conversion.

A sales lead cycle ends when salespeople convert a lead to an opportunity or when they retire a lead. A lead is retired if
no possibility exists for converting the lead to an opportunity.

Lead Life Cycle
Leads are automatically monitored for sales representative acceptance. Unaccepted or rejected leads are reassigned as
appropriate. The quality of the lead is continuously reviewed and adjusted by the lead owner at different stages of the
lead life cycle. The lead owner can be a marketing resource or a sales resource, depending at what stage the lead is at in
its life cycle. The lead life cycle is captured in the following sections:

• Lead Generation

• Lead Qualification

• Lead Distribution

• Lead Assessment

• Lead Conversion

Lead Generation
Leads are generated and captured from many different sources, such as:

• Campaign responses

• Third-party lead sources

Flexible lead import, customer and contact creation, and deduplication ensure that sales lead generation efforts are
optimized. For example, the lead import process checks whether leads represent new or existing customers. For new
customers, data must be created for the lead. If the lead is an existing customer, then part of the lead import process
checks to ensure customer and lead information isn't duplicated.

Lead Qualification
Marketing departments help with the lead qualification process to ensure that only qualified leads are handed over
to sales. Leads are typically ranked as Hot, Warm, or Cool. Leads are further qualified by the use of company-specific
standard questions to score a lead. Lead scores are numeric values typically ranging from 1 to 100, in which a high score
represents high quality.
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It isn't good practice to let stale leads build up. Standardized criteria for lead qualification ensure that quality leads
reach the sales representative and help maximize the conversion rate from leads to opportunities. For example, your
organization has criteria and processes for ensuring that leads are either developed or retired within 30 days. When
the lead age is greater than 30 days and the rank is Warm, Marketing reassigns the leads for follow-up by an internal
telemarketing group. If leads can't be qualified or further developed to revenue opportunities, then rejected leads are
reassigned or manually set to retired.

Lead Distribution
As the qualification of leads progresses into real potential prospects, assignment manager uses expression-based
rules to associate one or more internal sales representatives with each lead. If the lead is associated with either a sales
prospect or a sales account, then assignment manager uses territory definitions to associate (typically one) internal
territory with each lead. The sales representative newly assigned to the lead can be related to the lead record directly
through the lead team or indirectly through a territory associated with the lead. The sales representatives can view and
update those leads assigned to them in the lead work area and can claim ownership of the lead by accepting the lead.

Other assigned resources can view and update the lead, but they can't make themselves the owners. If a sales prospect
changes to a sales account by adding an address, assignment manager is automatically called during the next
automated assignment cycle. Depending on the assignment logic, the lead can be reassigned to a different territory
or sales resource. If the assigned sales representative takes no action on a lead for several days, then the lead can be
manually reassigned to another sales representative.

Lead Assessment
Sales representatives must evaluate the quality of the information that they have received for the lead. They determine
whether the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the
help of preconfigured assessment templates. Assessment templates help qualify the lead by:

• Reviewing the content shared with the customer during a campaign

• Framing the lead in the context of the campaign

• Ensuring the salesperson understands the information sent to the customer

You use the lead assessment feature to assess leads. Predefined questions help determine the likelihood of the lead
being accepted by Sales. For example, you're a sales representative and you ask the customer a series of questions
created by Marketing and Sales to assess the quality of the lead. You record the answer of each question and the lead
assessment tool automatically factors the answer into the assessment score of the lead. At the end of the call, you note
that the assessment lead score is high, so you request that the lead is assigned to the direct sales team. If the lead score
was low, then you might want to retire the lead. If the lead needs qualifying, then you can decide to leave it in your list
of leads for follow-up. Finally, if the lead is good, but the potential revenue opportunity is less than a predetermined
monetary amount, for example, twenty-five thousand dollars, then you can convert the lead to an opportunity to pursue
as part of the sales cycle.

Lead Conversion
After establishing that the lead has potential, the sales representative can convert the lead to an opportunity. You can
schedule meetings and presentations with your lead contact to move the opportunity along the sales pipeline. To track
the progress of the lead, you can capture contact notes and associate them with the contact and opportunity.

Note:  Administrators can write a validation rule to check if there's more than one lead attached to an opportunity. For
example, using a Groovy script, you can restrict the creation of another opportunity from a lead. To learn more about
writing validation rules and scripts, see the Groovy Tips and Techniques chapter in the Groovy Scripting Reference
guide, and the Groovy Scripts chapter in the Configuring Applications Using Application Composer guide.
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As the lead progresses through its life cycle, decisions to retire the lead are based on reasons such as:

• You can't verify the customer and lead details.

• The customer isn't interested in pursuing the lead any further.

Expose New Account and New Contact Fields for Leads  
Lead Management supports both net new leads, where salespeople manually enter the contact and account names, and
repeat business leads.

For repeat business leads, salespeople search for and select existing accounts and contacts to assign to leads. If your
business uses net new leads where contact and account values are entered manually using free form text fields, then
you can make the New Account and New Contact fields available on the Leads UI through Application Composer.
These fields are hidden by default so to use them for your new leads, you must manually unhide these fields. If the
new lead that you enter gets converted to an opportunity, the details become available as existing account or contact
information.

You can expose the New Account and New Contact fields for these Lead pages:

• Create Lead

• Edit Lead

• Convert Lead

• Mass Convert Lead

• Lead List Page

Here's how to expose the New Account and New Contact fields in Lead pages:

Note:  There are two standard Existing Account DCL fields. You can only update the Account field with the API name
AccountName. The other existing account name has the API name of ExtnAccountName and can't be updated.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Available Fields pane, select the New Account field and move it to the Selected Fields pane. Repeat this

step for the New Contact field.
9. Use the Selected Fields pane directional arrows to position the New Account and New Contact fields as

required.

Note:  You can position the fields to group the New Account and New Contact fields with the Existing Account
and Existing Contact fields. Salespeople can enter an account or contact in the new or the existing fields, but
not both.

10. Click Save and Close.
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11. Repeat this procedure for all standard and customer-defined layouts on which you want to add the New
Account and New Contact fields.

12. Test the changes: Navigate to Sales > Leads as a user with access to the leads pages, for example, as a
salesperson. Edit a lead and ensure you can see the New Account and New Contact field.

13. Publish the sandbox.

Note:  If you want automatic email notifications sent to the new contact about activities, such as appointments,
created for this lead, then see the related topic, Send Automatic Emails to New Lead Contacts.

Related Topics
• Send Automatic Emails to New Lead Contacts

• Add the New Account and New Contact Fields to the UI

Sales Lead Profile Options  
Profile options are configurable options that affect application operations. Values defined at the user level take
precedence over those at the site level. If a value isn't defined at the user level, the site level value is used.

The effect of setting each of the sales leads profile options are described under these sections:

• Lead Assignment

• Lead Qualification and Assessment

• Lead Update and Attribute Mapping

• Partner Leads and Deal Registrations

• Lead Searches

Lead Assignment
This table lists the profile options that affect the assignment of lead status, rank, score, resources, and territories on
the lead. Before setting these profile options, you must perform the tasks listed under Configure Assignment Manager
for Lead Processing setup task. From there you can review and update assignment of candidate objects such as rank,
qualification status, and resources to leads.

Profile Option Display Name Default Value Effect

Assignment Rule for Qualifying Leads (MKL_
LEAD_ASSIGNMENT_QUAL_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the lead status per rule conditions.
 

Assignment Rule for Ranking Leads (MKL_
LEAD_ASSIGNMENT_RANK_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the lead rank per rule conditions.
 

Assignment Rule for Rule-
Based Lead Assignment
(MKL_LEAD_ASSIGNMENT_MATCHING_RULE)
 

None
 

Specify the rule to evaluate the lead and assign
the sale team resources per rule conditions.
 

Assignment Rule for Scoring Leads (MKL_
LEAD_ASSIGNMENT_SCORE_RULE)

None
 

Specify the rule to evaluate the lead and assign
a score per rule conditions.

639

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20067785


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 22
Leads

Profile Option Display Name Default Value Effect

  

Assignment Rule for Territory-Based Lead
Assignment (MKL_LEAD_ASSIGNMENT_RULE)
 

None
 

Specify the rule to evaluate the lead and further
filter territories derived using territory-based
assignment per rule conditions.
 

Lead Assignment Mode (MKL_LEAD_DEFAULT_
ASGN_MODE)
 

Both
 

Specify the default assignment mode type
allowed during on-demand or automatic lead
assignment. On-demand assignment occurs
when you select the assign lead action in the UI.
 

Lead Batch Reassignment (MKL_LEAD_BATCH_
ASSIGNMENT)
 

N
 

Enable batch lead reassignment, in addition to
lead automatic reassignment.
 

Lead Qualification and Assessment
This table lists the profile options that affect the qualification and assessment of leads. Before setting these profile
options, you must perform the tasks listed under Configure Assessment Reference Data for Leads setup task. From
there you define and manage the setup for configuring templates used for assessing and qualifying sales objects.

Profile Option Display Name Default Value Effect

Lead Assessment Enabled (MKL_LEAD_
ASSESSMENT_TEMPLATE)
 

None
 

Enable the display of Qualification, a tab
containing the sets of predefined questions and
answers collected to assist in evaluating the
lead.
 

Advanced Lead Qualification Enabled (MKL_
LEAD_QUALIFICATION_TEMPLATE_PROFILE)
 

None
 

Enable advanced lead qualification by
specifying the template name to display the
collection of questions, possible answers, and
questionnaire feedback.
 

Enable Multiple Assessments Per Qualification
Template (MOW_MULTIPLE_ASSESSMENTS_
ENABLED)
 

No
 

Enable the ability to perform multiple
qualifications for the same lead qualification
template by setting the value to Yes. This
setting isn't enabled by default.
 

AI Update Who Columns Threshold (ORA_ZCA_
AI_UPDATE_WHO_THRESHOLD)
 

5
 

Specifies the percentage threshold value that
tracks both the AI Lead Score field for Leads
and the Predictive Win Probability field for
Opportunities. The profile option is set to 5
percent by default. If the score in either of these
fields exceeds the percentage threshold value
specified in the profile option, then the Last
Updated Date field gets updated for the lead or
opportunity record.
 

Lead Update and Attribute Mapping
This table lists the profile options that affect the update of leads and lead-to-opportunity attribute mapping.
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Profile Option Display Name Default Value Effect

Add and Edit Products to Leads Enabled (MKL_
LEAD_PRODUCTS_ENABLED)
 

Y
 

Enable the ability to add or edit products to
leads. The ability to add or edit product groups
to leads is enabled by default.
 

Use Default Lead Notification Process (MKL_
LEAD_OOTB_NOTIFICATION)
 

N
 

Specify whether default lead notification
business process should be used. Set Yes
for default process, and No for user-defined
process or if no notification is intended.
 

Create Account and Contact from Lead (ORA_
MKL_LEAD_ACT_CON_CREATE)
 

Both
 

Enable the default setting for the creation of
an account, a contact, both an account and a
contact, or none during lead conversion. The
default value is to create both.
 

Direct Lead to Opportunity Mapping (MKL_
DIRECT_LEAD_TO_OPTY_MAPPING_NAME)
 

Copy Lead To Opportunity Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
direct lead is converted to an opportunity.
 

Lead to Account Mapping (MKL_LEAD_TO_
ACCOUNT_MAPPING_NAME)
 

Standard Copy Lead To Account Map
 

Specify the mapping file name created in Copy
Maps. This file maps objects and attributes
during the creation of an account when
converting a lead to an opportunity.
 

Lead to Contact Mapping (MKL_LEAD_TO_
CONTACT_MAPPING_NAME)
 

Standard Copy Lead To Contact Map
 

Specify the mapping file name created
in Copy Maps. This file maps objects and
attributes during the creation of a contact when
converting a lead to an opportunity.
 

Lead to Deal Registration Mapping(MKL_LEAD_
TO_DEAL_MAPPING_NAME)
 

Copy Lead To Deal Registration Map
 

Provides the mapping file name to be used to
copy attributes while converting a Lead to a
Deal Registration.
 

Partner Leads and Deal Registrations
This table lists the profile options that affect sales partner leads, deal registrations, and deal assignments.

Profile Option Display Name Default Value Effect

Partner Contact Addition Enabled (MKL_ADD_
PARTNER_CONTACT)
 

Y
 

Specify whether to automatically add the
primary partner contact to the lead team when
a partner contact is added to the lead. The
default value is Y.
 

Lead Registration Approval Administrator
(MKL_LEAD_REGISTRATION_APPROVAL_
ADMIN_PROFILE)
 

None
 

Select the recipient of notifications when an
approver can't be determined, who's qualified
to respond to the notification, and can modify
approval configurations.
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Profile Option Display Name Default Value Effect

Deal Registration Expiration Days (MKL_DEAL_
REG_EXPIRATION_DATE)
 

90
 

Specify the number of days, after the deal
registration creation date, used to derive the
deal registration expiration date.
 

Resource Sales Team Access Level Default
for Deal Registration ( MKL_DEAL_DEFAULT_
SALES_TEAM_ACCESS_LEVEL)
 

200
 

Specify the default access level for resources
added to the deal registration sales team.
 
The following values represent the access levels
for the team:
 

• 100 = View Only

• 200 = Edit

• 300 = Full

Deal Registration Query Default Number of
Days (MKL_DEAL_SEARCH_LAST_UPDATED_
RANGE_DEFAULT)
 

90
 

Specify the default number of days used
to derive the last updated date range when
searching for deal registrations.
 

Partner Lead to Opportunity Mapping (MKL_
PARTNER_LEAD_TO_OPTY_MAPPING_NAME)
 

Copy Lead To Opportunity Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
partner lead is converted to an opportunity.
 

Deal Registration to Opportunity Mapping
(MKL_DEAL_TO_OPTY_MAPPING_NAME)
 

Copy Deal Registration To Opportunity Map
 

Specify the mapping file name to be used
to copy attributes while converting a Deal
Registration to an Opportunity.
 

Assignment Rule for Rule-
Based Deal Assignment
(MKL_DEAL_RBA_RULESETGROUP)
 

None
 

Specify the assignment rule that assigns
resources to deal registrations. Resource
members are added to the deal registration
team.
 

Assignment Rule for Territory-
Based Deal Assignment
(MKL_DEAL_TBA_RULESETGROUP)
 

None
 

Specify the assignment rule that assigns
territories to Deal Registrations. Territory
members are added to the deal registration
team.
 

Deal Registration Assignment Mode (MKL_
DEAL_DEFAULT_ASGN_MODE)
 

ORA_RBA
 

Specify the default assignment mode used
during deal registration assignment. The mode
is set to rule-based assignment mode.
 

Advanced Lead Qualification
Enabled - Indirect Leads
(MKL_PARTNER_LEAD_QUALIFICATION_TEMPLATE)
 

None
 

Specify a default template to enable lead
qualification for partner sales channel and
display questions, possible answers, and
questionnaire feedback in the Edit Lead user
interface.
 

Days Prior to Deal Registration Expiration
(MKL_DEAL_SEARCH_EXPIRE_RANGE_
DEFAULT)
 

30
 

Specify the number of days prior to expiration
that deal registrations must be included in the
predefined saved search. 30 days is the default
value.
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Profile Option Display Name Default Value Effect

Deal Registration Default Approver (MKL_
DEFAULT_DEAL_REGISTRATION_APPROVER)
 

None
 

Select the recipient of notifications when an
approver can't be determined, who's qualified
to respond to the notification, and can approve
deal registrations.
 

Use Default Deal Registration Approval
Business Process (MKL_DEAL_USE_DEFAULT_
APPROVAL_PROC)
 

Y
 

Specify whether the default deal registration
approval business process should be used. The
default value is set to Y. Set to No for customer-
defined processes.
 

Lead Searches
This table lists the profile options used to manage sales lead searches.

Profile Option Display Name Default Value Effect

Lead Query Maximum Number of Days (MKL_
LEAD_QUERY_IN_N_DAYS)
 

360
 

Specify the maximum number of days allowed
when searching leads based on the creation
date range.
 
The value for the maximum number of days
must be a positive number. If the value isn't a
positive number or left blank, the value of 360
days is used.
 

Lead Query Default Number of Days (MKL_
LEAD_SEARCH_CREATION_RANGE_DEFAULT
 

90
 

Specify the default number of days used to
derive the creation date range for searching
leads. The search criterion is derived by using
the current date for the creation end date value
and the profile option to derive the creation
start date value.
 
For example, if you want leads for the last 15
days to be the default query action, then set
the profile value to 15. The default creation date
search criteria will have an end date for the
current date and the start date will be 15 days
prior to the current date. The values can be
overridden in the search criteria.
 
The value for the default number of days must
be a positive number. If the value isn't a positive
number or left blank, the value of 30 days is
used.
 
This profile option can be defined at both the
site and user levels.
 

Lead Query Warning Threshold Number
of Days (MKL_LEAD_SEARCH_CREATION_
RANGE_RECOMMENDED)
 

180
 

Specify the number of days for the lead
creation date search criteria before issuing an
alert to the user.
 
To disable the warning, delete the profile option
value.
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Profile Option Display Name Default Value Effect

Lead Search Context-Based Data Security
Enabled (MKL_LEAD_CDS_ENABLED)
 

N
 

Enable context-based data security policies
for improved performance of lead search. The
default value is set to N.
 

Note:
If you enable this option, then you must also
ensure that the filters in the Lead Overview
page, such as My Leads, My Subordinate
Leads and so on have the required access in
Security Console. Otherwise, your lead data
search won't return expected results.
 

Require Additional Criteria for Lead Search
Enabled (MKL_SRCH_ADDL_CRITERIA_REQD)
 

N
 

Enable additional search criteria, other than
creation date, when searching across all leads,
 or for searches relying on hierarchy rollups.
 

Related Topics
• Sales Lead Lookups

• Profile Options for Sales Campaigns

• Overview of Scheduling Lead Processing Activities

Sales Lead Lookups  
Lookups enable quick selection from drop-down lists and are incorporated into the lead management capability to
speed the process of entering data into forms. They are also used in applications to represent a set of codes and their
translated meanings.

For example, a product team might store the values 'Y' and 'N' in a column in a table. When displaying those values they
would want to display "Yes" or "No" (or their translated equivalents) instead. Each set of related codes is identified as a
lookup type.

Lead Lookups
Lookup types are classified using tasks that involve a group of related lookups, such as Manage Sales Leads Standard
Lookups. Each task gives you access only to certain lookup types. Use the Manage Sales Lead Standard Lookups task
from the Setup and Maintenance work area to access the lookup types related to leads. Generic tasks provide access to
all lookup types of a kind, such as all common lookups that are associated with the Manage Common Lookups task.

Note:  If the lookups in an application are available in the standards, common, or set-enabled lookups view, they're
central to an application and can be easily managed. However, lookups defined in a specific application view can only
be managed by following instructions provided by that application.

This table displays lead lookup names (called lookup types in the application), their values, and their descriptions.
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Lookup Type Lookup Values Description

Lead Access Level (MKL_ACCESS_LEVEL)
 

• Full

• View only

Specifies the access level of team members
for actions they can perform on specific sales
leads.
 
Full access level allows the user to update
the team by adding or removing individual
resources or by updating the access level for
any member.
 

Lead Acceptance Status (MKL_LEAD_
ACCEPTED_FLAG)
 

• No

• Yes

Status that indicates whether or not a lead is
accepted by sales departments.
 

Lead Assignment Mode (MKL_LEAD_ASGNT_
STATUS_CODE)
 

• Both

• Rule-based assignment

• Territory-based assignment

Determines whether lead assignment is based
on rule-based, territory-based, or both types of
rules.
 

Lead Assignment Process Type (MKL_ASGN_
JOB_TYPE)
 

• Assignment

• Qualification

• Ranking

• Scoring

Lead processing types supported by
Assignment Manager.
 

Lead Assignment Status (MKL_LEAD_ASGNT_
STATUS_CODE)
 

• Assigned

• Reassigned

• Rejected

Assignment status indicating whether sales
team resources are assigned.
 

Lead Display in Simplified Pages (MKL_FUSE_
DASHBOARD_DISPLAY)
 

• Leads Enable the display of leads in the simplified
pages dashboard.
 

Lead Processing Activity Progress Status (MKL_
LEAD_SCHEDULE_STATUS)
 

• Completed

• Completed with error

• New

• In progress

• Scheduled

Progress details indicating lead current and end
processing status.
 

Lead Processing Activity Schedule Mode (MKL_
LEAD_SCHEDULE_MODE)
 

• Immediate

• Schedule date

• Repeats

Scheduling options for lead processing
activities.
 

Lead Processing Repeat Frequency (MKL_
WAIT_LAG_UNITS)
 

• Days

• Months

• Weeks

• Years

The time intervals between lead processing
activities.
 

Lead Process Scheduling Operators (MKL_SCH_
OPERATORS)
 

• Equal to

• Greater than

Operators used for lead processing scheduling
options.
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Lookup Type Lookup Values Description

• Greater than or equal to

• Less than

• Less than or equal to

Lead Reassignment Status (ORA_MKL_LEAD_
REASSIGN_STATE)
 

• N

• R

• T

• Y

Reassignment status values for leads
reassigned only by Territory Based Assignment
or Resource Based Assignment jobs.
 
The Reassign indicator is set to:
 

• N when lead is processed by Lead
Assignment Job

• R when Lead Resource Based Assignment
is completed by Lead Assignment Job

• T when Lead Territory Based Assignment
is completed by Lead Assignment Job

• Y for processing lead in Lead Assignment
Job

Lead Registration Approval Status (MKL_DEAL_
APPROVAL_STATUS)
 

• Approved

• Pending approval

• Rejected

• Submitted

Approval status for leads registered by partners.
 

Lead Registered Status (MKL_LEAD_
REGISTERED)
 

• No

• Yes

Status that indicates whether or not a partner
lead is registered.
 

Lead Search Filter Record Sets (MKL_LEAD_
SRCH_GROUP)
 

• All records I can see

• Records in my territory hierarchy

• Records in my territory

• Records I own

• Records where I am on the team

• Records where my subordinates are on the
team

Record visibility filters for lead search.
 

Note:
Record sets involving subordinates, which
are resources within an organization or a line
manager's hierarchy, are available only to
managers.
 

Lead Status (MKL_LEAD_STATUS)
 

• Converted

• Qualified

• Retired

• Unqualified

Lead status values based on specific actions
performed on a lead. Used to mark the
milestones in the lead life cycle.
 

Lead Retire Reason (MKL_RETIRE_REASON_
CD)
 

• Duplicate lead

• No purchase interest

Possible reasons for retiring leads. Retired leads
are considered closed leads.
 

Lead Yes or No Indicator (MKL_YES_NO_
REVERSE)
 

• Yes

• No

Generic status that indicates yes or no with
reverse meanings.
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Lookup Type Lookup Values Description

Recommended Lead Actions Type (MKL_SPD_
ACTION_TYPE)
 

• Accept leads

• Create sales campaign

Type of actions to perform on recommended
leads.
 

AI Update Who Columns Threshold Modes
(ORA_ZCA_AI_WHO_THRESHOLD_MODES)
 

• Turned Off

• 5

• 10

• 25

• 50

The percentage threshold for change in AI Lead
Score for Leads or Predictive Win Probability for
Opportunities. The Last Updated Date field gets
updated, if the threshold is exceeded.
 

Set ID Leads Lookups
This table shows the leads set-ID lookup types, their values, and their descriptions. Use the Manage Set Enabled
Lookups task from the Setup and Maintenance work area to access the lookup types related to leads.

Lookup Type Lookup Values Description

Lead Qualification Budget Status (MKL_LEAD_
BUDGET_STATUS_SETID)
 

• Approved

• Pending

• Unknown

The approval status of a customer budget. The
data is used to assess the lead qualification
status.
 

Lead Rank (MKL_LEAD_RANK_SETID)
 

• Cold

• Hot

• Warm

Lead rank values used as a measure of lead
quality and prioritization.
 

Lead Reassignment Reason (MKL_LEAD_
REASSIGN_REASON_SETID)
 

• No activity

• Other

• Workload

Possible reasons specified for reassigning leads.
 

Lead Reject Reason (MKL_REJECT_REASON_
SETID)
 

• Duplicate lead

• Failed to reach contact

• Incorrect data

Possible reasons specified for rejecting leads.
Rejected leads can be reassigned or retired.
 

Lead Retire Reason (MKL_RETIRE_REASON_
CD_SETID)
 

• Duplicate lead

• No purchase interest

Possible reasons for retiring leads. Retired leads
are considered closed leads.
 

Lead Registration Type (MKL_DEAL_TYPE_
SETID)
 

• Co-sell

• Referral

• Resale

Types of leads available for partners.
 

Lead Source Channel (MKL_LEAD_CHANNEL_
SETID)
 

• Direct mail

• E-Mail

• Fax

• Marketing Cloud

Source channel responsible for lead generation.
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Lookup Type Lookup Values Description

• Phone

• Sales campaign

• Sales visit

• Social

• Company web site

• Wireless message

• Model-based prediction

• Rules-based prediction

Lead Time Frame (MKL_LEAD_TIMELINE_
SETID)
 

• 3 months

• 6 months

• 9 months

• 12 months

• 15 months

• 18 months

Lead cycle duration that usually coincides with
a typical sales cycle duration for products and
services offered.
 

Deal Registration Lookups
This table displays deal registration lookup names (called lookup types in the application), their values, and their
descriptions.

Lookup Type Lookup Values Description

Deal Registration Access Level (ORA_MKL_
DEAL_ACCESS_LEVEL)
 

• Edit

• Full

• View only

Specifies the access level of team members for
actions they can perform on deal registrations.
 
Full access level allows the user to update
the team by adding or removing individual
resources or by updating the access level for
any member.
 

Deal Registration Assignment Mode (ORA_
MKL_DEAL_ASSIGN_MODE)
 

• Both

• Rule-based Assignment Only

• Territory-based Assignment Only

Determines whether deal registration
assignment is rule-based, territory-based, or a
combination of the two.
 

Deal Registration Reject Reason (ORA_MKL_
DEAL_REJECT_REASON)
 

• Duplicate

• Ineligible Customer

• Ineligible Partner

Possible reasons for rejecting a deal registration
request.
 

Deal Registration Return Reason (ORA_MKL_
DEAL_RETURN_REASON)
 

• Incomplete Customer Information

• Ineligible Product

• Insufficient Quantity

Possible reasons for returning a submitted deal
registration.
 

Deal Registration Search Filter Record (ORA_
MKL_DEAL_SRCH_RECORD_SET)

• All records I can see Specifies record visibility filters for deal
registration filtering.

648



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 22
Leads

Lookup Type Lookup Values Description

 • Records I own

• Records pending my approval

 

Deal Registration Filter Record Sets for
Workspace (ORA_MKL_DEAL_WRKSPC_
RECORD_SET)

• All records I can see

• Records where I am on the team

• Records I own

Specifies record visibility filters for deal
registration filtering specific to Workspace
search.

Deal Registration Status (ORA_MKL_DEAL_
REG_STATUS)
 

• Approval

• Draft

• Expired

• Pending Approval

• Rejected

• Returned

• Withdrawn

Deal registration status values based on specific
actions performed on deals registered by
partners. Used to mark the milestones in the
deal registration life cycle.
 

Deal Registration Deal Type (ORA_MKL_
DEALREG_DEAL_TYPE)
 

• Existing

• New

Indicates the type of deal the partner is
submitting for registration.
 

Related Topics
• Overview of Lookups

Assure That the Assigned Lead Owner Remains the Owner of a
Converted Opportunity  
When you assign a lead owner, that lead owner must also accept the lead. If they don't, another salesperson can convert
the lead into an opportunity. Converting the lead makes that salesperson the new owner of both the lead and the
opportunity. You can assure that the assigned owner remains the owner by creating a Groovy script to automatically
accept the lead for the assigned lead owner.

To automatically accept the lead for the assigned lead owner, create a Before Update in Database trigger on the Sales
Lead object. Here is a sample script:

if (isAttributeChanged('OwnerId') && OwnerId != null){
 setAttribute('LeadAcceptedFlag', 'Y')
}

Steps to Create the Trigger
1. Enter a sandbox with Application Composer as one of the tools.
2. Open Application Composer by selecting it from the sandbox Tools menu.
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3. In the left pane, search for the Sales Lead object (callout 1 in the screenshot).

4. Expand Sales Lead under Standard Objects (callout 2).
5. Click Server Scripts (callout 3).
6. In the Server Scripts Sales Lead page, click the Triggers tab (callout 1 in the screenshot).

7. Click Add a new trigger (callout 2).
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8. In the Create Object Trigger page Name Trigger list, select Before Update in Database (callout 1 in the
screenshot).

9. Enter a trigger name.
10. Enter the Groovy script (callout 2).
11. You can validate the script by clicking Validate on the right side of the Trigger Definition section.
12. Click Save and Close.

You must publish the sandbox for the trigger to become active.

Related Topics
• Server Scripts

• Defining an Object-Level Trigger to Complement Default Processing

Lead Qualification Templates  

Lead Qualification Templates  
Lead qualification templates enable a uniform lead-qualification process across leads. This topic provides an overview
of how you can assign and use the templates as part of the lead qualification process.

Using lead qualification templates, you can:

• Define lead qualification templates

• Assign lead qualification templates

• Gather lead quality information

• Enable multiple assessments per lead qualification template
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Define Lead Qualification Templates
Qualification templates are collections of questions and answers that can be weighted and scored to evaluate
the quality of gathered information about the sales lead. You use the templates to define consistent and specific
qualification criteria for leads.

Assign Lead Qualification Templates
Once the qualification template is defined, you assign the template to the Lead Qualification Template profile available
from the Manage Sales Lead Administrator Profile Values page. You can define more than one qualification template by
assigning templates at the site level profile.

Gather Lead Quality Information
Along with other key qualification fields available in the lead, the qualification template questions are displayed on the
lead Qualification tab if you have enabled the Advanced Lead Qualification profile option. Lead qualification is typically
conducted through phone conversations. As you enter responses for the qualification questions, the qualification
template's weighted score is calculated and a progress bar provides immediate rating and feedback.

Enable Multiple Assessments Per Lead Qualification Template
To enable sales representatives to perform multiple assessments per qualification template, set the profile option
Enable Multiple Assessments Per Qualification Template to Yes.

Related Topics
• Example of Defining a Sales Lead Qualification Template

• Enable Multiple Assessments Per Lead Qualification Template

Example of Defining a Sales Lead Qualification Template  
This topic provides an example that illustrates defining a lead qualification template to assess the basic quality of a lead.

Scenario
Your company sells alternative energy solutions to small businesses. The company employs a group of people that:

• Qualify the basic information about a lead

• Gather the necessary information required by the sales team to prepare for follow-up sales calls

Unqualified leads are generated from various sources and captures when customers have requested more information
from your website. Before creating the qualification template, your company evaluates the following:

• Compile a set of questions that each lead qualifier is expected to ask so as to:

◦ Verify the customer's intent in requesting more information

◦ Ensure a consistent and thorough communication with the customer
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• Categorize a set of responses to help identify what leads to transfer to the sales team.

For example, once your company has gathered the initial lead information, they can set up assignment rules so
that only leads with a greater potential for a sale are transferred to the sales team. The level of response assists
the lead qualifier identify those leads with the greatest sales potential.

To ensure the full range of possible responses, the qualification information is categorized into four basic
response levels:

◦ Very little information was obtained from the customer

◦ A high potential of the customer working on an alternative energy project

◦ Not applicable

◦ Information not available

• Perform analysis of your qualification template and model the set of question responses and questions

Question responses and questions are analyzed and modeled to effectively place the weighted score ranges
into the four categories. For example, a budget that expires less than ten days may score low if the average
sales cycle is greater than 10 days. However, any answer to a budgeting question has higher weight in the
overall questionnaire than a question about the customer's project team. If a qualification template's weighted
score is 90 or above, the customer is categorized as a high potential for an energy project. Such a lead is
transferred to a sales resource to pursue.

Lead Qualification Template Considerations
Navigate to the Manage Assessment Templates page from the Manage Sales Lead Qualification Template
implementation task. The following categories of qualification levels are entered as ratings of:

• Little Information Available

• Low Project Potential

• Medium Project Potential

• High Project Potential

Questions about the customer's budget, time frame, decision maker, and project drive the sale potential and resulting
lead rank. These questions aren't included in the qualification template because the lead qualifier enters those directly
in the Lead UI.

Use the qualification template to effectively evaluate the customer's project and prepare the sales team to progress the
lead once the lead is qualified.

• Enter a set of questions and responses to qualify the time frame including what phase the customer's
implementation project is in.

• Gather information to meet export policies. For example, add questions about implementation projects outside
of the country.

• Add questions to determine if and when a customer's budget is due to expire.

• Identify competition by adding questions and responses about competing suppliers or in-house solutions and
satisfaction levels.

• Allow a free-form response to enable the lead qualifier to capture specific customer comments about their
greatest issue they're trying to solve.

653



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 22
Leads

Next, the weighed scores ranges are assigned to the four ratings. To provide a visual queue and feedback to the lead
qualifier to guide them in their decision to update the lead as qualified, a color and feedback phrase is entered for the
four ratings. The color-coded bar, score, and feedback appear at the top of each qualification questionnaire in the lead.

Lead Qualification Template Profile
Once the qualification template is defined, the template is assigned to the Lead Qualification Template profile available
from the Manage Sales Lead Administrator Profile Values implementation task. Since there is only one business unit for
your Company and only one qualification template, the template is assigned at the profile Site level.

As your company continues to grow into a global company with a broader set of business units and products,
Qualification templates are created in different languages and assigned to business unit sets. The appropriate
qualification template is assigned to corresponding lead qualification users through the Lead Qualification Template
profile.

Note:  The Advanced Lead Qualification Enabled profile option must be set so that you can specify the template name
to use. The template displays the collection of questions, possible answers, and questionnaire feedback in the Edit
Lead UI.

Related Topics
• Lead Qualification Templates
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23  Opportunities

Overview of Opportunities  
Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up
analytics.

Within opportunities, sales organizations can capture a wide variety of information related to an opportunity, such as
customer (account) and the products to be sold. They can use the supplied sales methods and sales stages to step the
opportunity to its eventual conclusion.

In addition, account intelligence, sales actions, and historical sales analysis further enable salespeople to increase
their win rates by offering data-driven pipeline management and recommendations for the next best sales action. For
example, setting win probability variance thresholds and providing multiple recommendations per opportunity enables
sales representatives to optimize their sales opportunities.

This table lists opportunity features.

Feature Details

Support the sales life cycle
 

Create, manage, and close opportunities, supporting the entire sales life cycle. By integrating with
leads, you can convert leads to opportunities. Post-sale, take advantage of supplied business
intelligence reports related to sales.
 

Maintain opportunity information
 

Here are just some of the data that sales teams can capture for an opportunity:
 

• Accounts: You can associate an account (for example, a customer or prospect) with the
opportunity.

• Opportunity owner: The person who creates an opportunity is automatically assigned ownership.
You can change owner if needed.

• Contacts: You can associate contacts with an opportunity. In addition, you can specify a contact's
role, affinity, and influence level on an opportunity. A single contact can be marked as primary.

• Currency: The application supports multiple currencies at both the opportunity header and
revenue-line levels.

• Budget: A Budgeted indicator lets you display whether the opportunity revenue amount has been
budgeted by the customer, as well as the date that the budget was made available.

• Competitors and partners: You can associate partners and competitors with opportunities, both
at the opportunity and revenue line levels.

• Marketing data: The Source field allows the association of sales campaigns with an opportunity.

• Mass update opportunities: Allow sales personnel to update several opportunity attributes at
once on multiple opportunities.

Employ sales methodology
 

Your company can employ its own sales methodology by using the supplied sales methods and
stages. For each sales stage, administrators can create action items (process steps), task templates,
 recommended documents, assessment templates, and fields that are required for use in opportunities.
In addition, administrators can specify a different default win probability percentage for each sales
stage.
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Feature Details

Use Sales Coach for guided selling
 

Sales Coach, part of sales methods, guides salespeople through each step of the sales cycle with
an organization's own sales methodology and best practices. The action items (process steps), task
templates, recommended documents, assessment templates, and mandatory fields set up by your
administrator in each of the sales stages translate into guided notes and appropriate opportunity UI
interactions.
 

Leverage the product revenue model
 

Opportunities support a product revenue model that features revenue-based forecasting, products and
product groups, recurring revenue, and revenue data captured at the line level, such as win probability,
close date, include in forecast, and status.
 

Support recommended actions
 

Prompts salespeople to respond to the next best set of recommended actions for customer
engagement, drive pipeline and determine how often to reach out to customers post sales.
 
Here are some of the benefits of the next best sales action feature:
 

• Support multiple recommendations per opportunity.

• Enables smarter sales experiences and optimizes the selling process.

• Provides a percentage win probability in comparison to other opportunities from your sales
organization or a prediction about the close date of the opportunity.

For example, based on historical data, the likelihood to close an opportunity is less than 40%.

• Supports user feedback per opportunity.

• Enables administrative and supervisory controls.

For example, manage the win probability variance thresholds for opportunities and define
user actions to suit the organization's requirements. As salespeople update the opportunity
information, win likelihood and recommended actions are regenerated.

Assign sales team
 

Opportunities align with territories and the assignment engine for rule-based or territory-based
autoassignment of salespeople to opportunities. In the team pages, you also can manually add sales
team members to an opportunity.
 

Allocate sales credit
 

By allocating sales credit to salespeople on product lines, you can capture the amount of credit
salespeople receive for the sale. You can track direct, channel, and overlay resources and their
contributions using revenue and nonrevenue credit splits.
 

Use forecast territories on product lines
 

By integrating with forecasting, you can use forecast criteria to automatically include product-line
revenue in the forecast. You can leave the default forecast territory on the product lines or assign
another forecast territory. The forecast is refreshed in real-time from revenue when an opportunity is
created or updated.
 

Assess opportunities and their products,
 contacts, and competitors
 

You can use assessments to evaluate the health of an opportunity or an opportunity product, contact,
 or competitor. After setup by the administrator, assessments are available to salespeople in the
Assessments tab.
 

View business intelligence reports
 

Several supplied business intelligence reports give you views into sales metrics, from lists of
opportunities and accounts, to pipeline data, sales team performance, and other revenue metrics.
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Related Topics
• Best Practices for Sales Credits

• Overview of Sales Methods, Sales Stages, and Sales Coach

• Overview of Opportunity Products and Revenue

Sales Methods, Sales Stages, and Sales Coach  

Overview of Sales Methods, Sales Stages, and Sales Coach  
You can use sales methods and sales stages to employ the sales methodology that best aligns with an opportunity.

Use Sales Coach, which administrators set up within sales stages, as both a teaching tool and a method to make your
organization's best-practice information readily available to salespeople.

Sales Methods and Sales Stages
Sales methods are an opportunity attribute that link sales strategy to sales execution. For example, is the customer
more interested in price, features, service, or delivery time? After you make these decisions, you can align your sales
methods and sales stages to reflect these customer requirements. You can also use a different sales methodology for
your price-conscious customers than for your customers who are interested in features. A sales method can include all
activities associated with the different sales stages during the sales process, from qualifying, to negotiating, to closing.

The application comes with a few sales methods and associated sales stages. Administrators can modify the supplied
sales methods and stages, or create new ones.

Sales Coach
Sales Coach is a virtual coach available to salespeople while they view or edit an opportunity. For example while viewing
an opportunity, a salesperson will see Recommended Documents for the sales stage that his opportunity is in. He can
download the Recommended Documents that his administrator has posted to help with the sale.

This table describes the tools available as part of sales methods and sales stages.

Tool Description

Action items (called process steps in the
setup UI)
 

Part of Sales Coach. Guides salespeople through an organization's sales best-practice processes for a
particular sales stage.
 

Recommended documents
 

Part of Sales Coach. Provides coaching strategies and best-practice information in the form of
documents, such as customer letter templates, relevant websites, and training materials.
 

Task templates
 

Provides a list of required or recommended tasks relevant to a particular sales stage. Recommended
task templates are optional. Autogenerated task templates are automatically applied to your list of
tasks for a particular sales stage, when the opportunity moves to that stage. Note that task templates
aren't supported in the simplified UI.
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Tool Description

Assessment templates
 

Helps salespeople analyze and score an opportunity attributes. After selecting an assessment type,
 salespeople enter a series of responses to achieve a weighted score. This score then helps determine
the success rate of the opportunity.
 

Related Topics
• Create and Edit Sales Methods and Stages

• Sales Stages Attribute Setup

• Overview of Sales Coach

Overview of Opportunity Sales Methods and Stages  
A company's sales methodology is a formalized approach toward achieving a sale. In opportunities, you can employ
your company's sales methodology using a sales method that's automatically associated with the opportunity when it's
created.

The sales method contains several sales stages that salespeople progress as the opportunity matures. Several sales
methods and stages are predefined. You can use the predefined ones, modify them to suit your business needs, or
create your own ones.

You can specify the default sales method using the profile option, Sales Method Default. Setting the profile option is
described in the topic, Set Default Sales Method Profile Option.

Note:  Sales Coach, which is a teaching tool and method to push best practice information to salespeople in
the opportunities UI, is also set up in the sales methods pages, using the sales stages. Assessments also can be
associated with sales stages.

Related Topics
• Create and Edit Sales Methods and Stages

• Set the Default Sales Method Profile Option

Sales Stages Attribute Setup  
Sales stages track the progress of an opportunity during the sales cycle. You change the sales stage when you
determine it's time to move the opportunity to the next stage.

Sales Stage Attributes
You typically set up these attributes while setting up sales stages:

• Phase: A step in the sales cycle of an opportunity.

For example, the first step might be Discovery, where the salesperson researches the customer's needs.
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• Order: The sequence of the stage within a sales method.

For example, you might start with Discovery and move to Conclusion.

• Duration: The number of days an opportunity will remain in this stage.

• Stalled Deal Limit: The number of days an opportunity can remain in this stage before it's considered stalled.

You can also associate elements of Sales Coach, such as recommended documents, action items, or assessments, with a
sales stage.

Related Topics
• Overview of Sales Coach

How Sales Methods and Sales Stages Work with Opportunities  
A typical sales method has several sales stages. Each stage within a sales method delineates the progress of an
opportunity.

Sales Methods
The sales method used on an opportunity represents your company's formalized approach toward the sale. The
application comes with a few predefined sales methods. By default, the sales method used on a newly created
opportunity is the supplied Standard Sales Process sales method.

Sales Stages
Several stages usually exist within a single sales method. You use different stages to represent different phases of an
opportunity, from prospecting to forecasting to closing the opportunity.

Related Topics
• Sales Stages Attribute Setup

• Overview of Sales Methods, Sales Stages, and Sales Coach

• Create and Edit Sales Methods and Stages

Sales Methods and Sales Coach Configuration  

Create and Edit Sales Methods and Stages  
You can create and edit sales methods and their stages by following the procedures in this topic.

Watch video
 

It doesn't cover these components of sales methods and stages setup:

• Recommended documents

• Action items (called process steps in the setup UI)
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• Assessment Templates

• Activity Templates

• Mandatory fields

For information about setting up sales methods and stages, see the related topics.

Create or Edit Sales Methods
Here's how to create or modify existing sales methods.

Note:  Several sales methods are predefined. You can use the predefined ones, modify them to suit your business
needs, or create your own sales methods. However, if you modify or create a default sales method, then this affects
your standard prebuilt business intelligence reports for Sales and you may have to modify them.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. If you want to create a sales method: In the Manage Sales Methods page, click the Create icon.
3. If you want to edit a sales method: In the Manage Sales Methods page, drill down on the sales method, or select

the row showing the sales method and click the Edit icon.
4. In the Create Sales Method or Edit Sales Method page, fill in the required information. Here are some details of

the more complex attributes of sales methods:

◦ Set: A set represents a group of business units. The Set field allows the sales method to be shared
across multiple business units. Select the Common Set, unless you're aware that a different set should be
selected.

◦ Close Window: Set in days, the Close Window value is added to the current date to set the initial
opportunity close date. If it isn't set, the application retrieves the default close window from the
Opportunity Close Date Default profile option.

◦ Disable: The Disable check box lets you disable the sales method. Only disable sales methods during
implementation and not after the methods are in use in current opportunities.

5. Add new or modify existing sales stages as described in the section, Create or Edit Sales Stages.
6. Save your changes.

Create or Edit Sales Stages
Here's how to create or modify existing sales stages.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. From the Manage Sales Methods page, select the sales method whose sales stages you want to modify.

The Edit Sales Method page appears.
3. To add another sales stage to the sales method: In the Edit Sales Method page, click the Create icon and fill out

the required information in the Create Sales Stage page.
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4. To edit a sales stage: In the Edit Sales Method page, drill down on the sales stage, or select the row and click the
Edit icon. Fill out the required information in the Edit Sales Stage page.

5. Set or enter attributes of sales stages. Here are some details of the more complex fields:

◦ Disable: This check box lets you disable the sales stage. Only disable sales stages during implementation
and not after the stages are in use in current opportunities.

◦ Win Probability: This field represents the likelihood (in percent form) of winning the opportunity. This
Win Probability field sets the default win probability at opportunity level for the sales stage. If you don't
want your sales stages to control opportunity win probability, make sure they aren't defined by blanking
out any value in this field.

◦ Duration: Enter the average number of days you expect opportunities to stay in this stage. This field is
used in the Stalled Deals infolet and underlying report. When opportunities are in a sales stage longer
than the value entered here, they're considered stalled at that stage, and are reported in the stalled deals
infolet on the dashboard.

6. Save your changes.

Related Topics
• Overview of Sales Methods, Sales Stages, and Sales Coach

• Sales Stages Attribute Setup

• Set the Default Sales Method Profile Option

Associate Sales Coach and Other Elements with Sales Stages  
Sales Coach is a mechanism to present best practice sales methodology to salespeople to improve their sales
effectiveness. A teaching tool, Sales Coach can help less experienced salespeople with aspects of an opportunity when
and where they need help.

Administrators set up Sales Coach by associating action items and recommended documents with a sales stage.
Salespeople can then view these items as they work their opportunities. Since the teaching components or job aids are
associated with a specific sales stage, each sales stage potentially can have multiple action items and recommended
documents associated with it.

Here are the elements that you can define for each sales stage:

• Sales Coach items:

◦ Action items (process steps): These are recommended actions the salesperson should take while working
an opportunity in a specific sales stage. Action Items appear in the Sales Coach region of the edit
opportunity page.

◦ Recommended documents: These are documents, files, or URLs recommended for viewing or sharing
during a specific sales stage. Recommended Documents appear in the Sales Coach region of the edit
opportunity page.

• Other items:

◦ Task templates: You can define task templates to set tasks for salespeople to perform. For more
information, see the topic, Associate Task Templates with Assessment Templates.

◦ Assessment templates: Assessments let salespeople evaluate the health of an opportunity. Opportunity
assessments appear under a separate tab labeled Assessments in the edit opportunity page. For more
information, see the topic, Guidelines for Setting Up Opportunity Assessments.

◦ Required fields: You can mark specific fields as required for a specific sales stage. When a salesperson
moves an opportunity to that sales stage, the fields you mark as required become marked with an
asterisk that users must complete before moving to the next sales stage.
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Note:  The required fields validation doesn't support check box fields so don't mark check box fields as
a required field for a specific sales stage.

Add Action Items (Process Steps)
Here's how to add action items to a sales stage. Note that in the setup pages, action items are set up in the Process
Steps region.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. From the Manage Sales Methods page, click the sales method whose sales stages you want to modify.

The Edit Sales Method page appears.
3. In the Edit Sales Method page, click the sales stage you want to modify. In the upper portion of the page, it's

assumed you would have already entered the core information for the sales stage. For more information about
these fields, see the topic, Create and Edit Sales Methods and Stages.

4. In the Process Steps region, click the create icon to create a process step. Enter your process step information.
For example, a first process step or action item might be "Gather High Level Information from Customer".

Process steps show up as Action Items in the Sales Coach region in the edit opportunity pages. The action
items show up only when the opportunity is in the sales stage that you associated with the process steps.

5. Save your changes.

Add Recommended Documents
To add recommended documents, edit a sales stage using the steps outlined in the preceding procedure, Adding Action
Items (Process Steps). In the Recommended Documents region, attach documents, files, or URLs that you want your
salespeople to have access to in the edit opportunity pages. For example, you can give your salespeople access to
marketing materials, collateral, or websites. Recommended documents are available in the edit opportunity page when
the salesperson is editing the opportunity in the sales stage that's associated with these documents.

Related Topics
• Overview of Task Templates

• How Assessment Templates Work with Task Templates

• Update Existing Setup Data

Set the Default Sales Method Profile Option  
You can specify what sales method to apply to all newly created opportunities by setting the profile option Sales Method
Default.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options
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2. In the search region of the Manage Opportunity Profile Options page, select Opportunity Management as the
application, or just enter the profile option name Sales Method Default directly in the Profile Display Name
field.

3. In the search results list, click the profile option name.
4. Set the profile option to the sales method you want to be the default for newly created opportunities.

Note:  Opportunity and revenue reports and analytics are designed to work with the Standard Sales Process method
supplied by Oracle. If you use other sales methods as the default sales method, then you might have to modify your
reports.

Related Topics
• Update Existing Setup Data

Task and Assessment Templates  

Add Assessment Templates to Sales Stages  
Assessments let salespeople evaluate the health of an opportunity while they work on it as part of their sales process.

Assessments can be used, for example, to help determine whether an opportunity is viable enough for the salesperson
to offer an incentive, such as a discount, to the customer. Assessments include questions with scored responses.
Responding to the questions provides the salesperson with immediate scoring and recommendations or follow-up
business processes.

You create assessment templates in the setup pages and then add the assessment template to an opportunity
sales stage. The assessment generated from the template are accessible to salespeople in the Assessments tab in
opportunities for the sales stage you associated with them.

Here are the high-level steps to add assessments to sales stages:

1. Define your assessment templates using the Manage Opportunity Assessment Templates task available from
the Setup and Maintenance work area.

For more information, see the Assessments chapter in the Implementing Sales guide. The topic, How to Create
Assessment Templates, has the steps.

2. Edit a sales stage and, in the Assessment Templates area, associate the assessments with a sales stage. Mark
the assessment mandatory to make it required that salespeople complete the assessment before they can
move the opportunity to another sales stage.

For more information, see the section Opportunity Assessments, in the Opportunities chapter of the Using
Sales guide. The topic, Perform an Opportunity Assessment, has the steps.

Add Assessments to Sales Stages
Here's the procedure to add an assessment template to an opportunity sales stage.

Note:  You must have already created an assessment template before it's available to add to a sales stage. See the
topic, Create Assessment Templates, for the steps.
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1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. On the Manage Sales Methods page, click the sales method whose sales stages you want to modify.

The Edit Sales Method page appears.
3. In the Edit Sales Method page, click the sales stage you want to configure. In the upper portion of the page, it's

assumed you would have already filled out the core information for the sales stage. For more information about
these fields, see the topic, Create and Edit Sales Methods and Stages.

4. In the Assessment Templates region, click the create icon.
5. Search for and select the assessment template you created earlier.
6. In the Type column, pick:

◦ Recommended if you want the salesperson to have access to the assessment in the Assessments tab for
this sales stage, but isn't required to complete before moving the opportunity to the next sales stage.

◦ Mandatory if you want the salesperson to have access to the assessment in the Assessments tab for this
sales stage, and is required to complete before moving the opportunity to the next sales stage.

7. Save your changes.

Related Topics
• Guidelines for Setting Up Opportunity Assessments

• How to Create Assessment Templates

• Update Existing Setup Data

Add Task Templates to Sales Stages  
A task template is a group of tasks associated with a business object, including opportunities. You create a task template
in the setup pages and then add the task template to an opportunity sales stage.

The tasks generated from the template are accessible to salespeople in the Activities tab in opportunities, for the sales
stage you associated with them.

Here are the high-level steps to add tasks to the Activities tab in opportunities for a particular sales stage:

1. Define your task templates using the Manage Sales Task Templates task available from the Setup and
Maintenance work area.

For more information, see the Task Templates chapter in the Implementing Sales guide. The topic, Create a Task
Template, has the steps.

2. Edit a sales stage and, in the Activity Templates area, associate the task template with a sales stage, as
described next.

Add Task Templates to Sales Stages
Here's how to add a task template to an opportunity sales stage.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities
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◦ Task: Manage Sales Methods and Sales Stages

2. On the Manage Sales Methods page, click the sales method whose sales stages you want to modify.

The Edit Sales Method page appears.
3. In the Edit Sales Method page, click the sales stage you want to configure. In the upper portion of the page,

it's assumed you would have already completed the core information for the sales stage. For more information
about these fields, see the topic, Create and Edit Sales Methods and Stages.

4. In the Activity Templates region, click the create icon.
5. Search for and select the task template you created earlier.
6. In the Type column, select Automatically generated as the type.

If you don't select Automatically generated, the associated tasks won't appear in the UI for users.
7. Save your changes.

Related Topics
• Overview of Task Templates

• Define Tasks

• Create a Task Template

• Update Existing Setup Data

Sales Statuses  

Set Up Sales Statuses  
Opportunities and product lines on opportunities have statuses, such as Lost, No Sale, Open, and Won. These
predefined statuses are part of larger status categories. The application uses status categories when calculating
business intelligence metrics for win/loss analysis.

Status categories aren't visible in the UI but statuses are. To change statuses, you can create statuses, associating them
with the existing status categories. You can't add new status categories.

Predefined Sales Statuses and Categories
The application comes with four predefined sales statuses and status categories, as shown in the following table.
Salespeople can select these statuses for an opportunity or for a product line while editing an opportunity. The
application can set statuses automatically when synchronizing the opportunity header and its product lines.

Status Code, Status, and Category Meaning

Lost
 

Opportunity is closed without proceeding to a sale and lost to competitors, if any
 

No Sale
 

Opportunity is closed and not pursued
 

Open
 

Time between when a potential sales is realized and the customer decision on the sale is obtained
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Status Code, Status, and Category Meaning

Won
 

Opportunity is closed with a buying decision from the customer and won over competitors, if any
 

Create and Modify Sales Statuses
You can create sales statuses or update existing ones, as long as you stay within the four predefined categories. You
also can mark statuses as inactive or active. Inactive statuses don't display in the UI.

The following rules apply when creating sales statuses:

• Statuses must belong to one of the predefined status categories.

• The Status values display in alphabetic order on the UI.

• Status codes must be unique and can't be blank.

• The Status value must be unique and can't be blank.

• At least one active status in the Open status category must exist.

Oracle recommends that you retain the predefined status codes. As a best practice, if you want to configure statuses,
create additional codes. Don't obsolete or replace existing status codes.

Here's how to modify sales statuses:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Sales Status

2. In the Manage Sales Statuses page click the Add icon to add a new status and:

a. Enter a new Status Code.
b. Enter a new Status. This is the value that displays in alphabetic order in the opportunity pages.
c. Select the Active check box.
d. Select from one of the predefined values for Status Category.

3. To modify an existing status, click in the row of the status so that it becomes editable and modify the values as
you want.

4. Save your changes.

This figure shows the Manage Sales Statuses page with a new status added named "Abandoned".
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Related Topics
• Opportunity and Product Line Attributes Synchronization

• Update Existing Setup Data

Opportunity Closure  

About Setting Up Opportunity Closing  
Salespeople can close an opportunity when the deal is either won, lost, or abandoned for some reason by setting the
opportunity to a closed status.

Here's the default application behavior. The application sets the close date to 20 days after the opportunity is created
if you didn't enter a different period in the Close Window field during sales method setup (callout 1).When salespeople
select one of the closed statuses (Won, Lost, or No Sale) (callout 2), they must enter a win or loss reason and a
competitor (callouts 3 and 4).
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By setting profile options, you can:

• Make the entry of the win or loss reason optional.

• Make the entry of the competitor optional.

• Set a different number of days for the default opportunity close date.

If you keep the default application behavior, then the setup user or another user with the Sales Administrator job role
must create the list of competitors as described in the Setting Up Competitors chapter.

If you make the win or loss and competitor entry optional, the fields remain in the Edit Opportunity page. You can use
Application Composer to remove them.

Set the Close Opportunity Profile Options  
You can configure close opportunity behavior by using profile options outlined in this topic.
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Close Opportunity Profile Options
This table shows the profile options that control opportunity close behavior.

Profile Option Display Name Default Value Effect

Close Opportunity Win/Loss Reason Required
 

Yes
 

Determines whether, when closing an
opportunity, the user is required to enter a win
or loss reason. Applies both at the opportunity
and revenue item levels.
 

Close Opportunity Competitor Required
 

Yes
 

Determines whether, when closing an
opportunity, the user is required to enter a
competitor. Applies both at the opportunity and
revenue item levels.
 

Opportunity Close Date Default
 

20
 

Determines the number of days to add to the
system date when determining the default
opportunity close date.
 
The close date defaulting logic follows this
precedence.
 

• If the Close Window value on the sales
method is set, it's used

• Or else, if this profile option (MOO_
DEFAULT_CLOSE_WINDOW) is set, its
value is used

• Or else, the Close Date is left blank

Opportunity Close Date Retain on Closure
 

No
 

Tells the application to retain the old close date
even after the status of the opportunity or
product line is set to a closed status. If you don't
set this profile option to yes, then the close
date on the opportunity header or product
line is updated with the current date when the
opportunity or product line is closed.
 

Set the Profile Options
Here's how to find and set the close opportunity profile options.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the search region of the Manage Opportunity Profile Options page, enter the profile option name in the
Profile Display Name field.

3. Click Search.
4. In the list that's returned, click on the profile option name link.
5. Set the profile option value as needed.
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Related Topics
• Update Existing Setup Data

Opportunity Business Logic Summary  
This topic provides a summary of opportunity and product-line business rules relevant to opportunity close processes
and their applicability in the edit opportunity, close opportunity, mass update opportunities, and mass update revenue
lines flows.

This table describes the synchronization update effect during the close opportunity flow.

Object or Field Being
Updated

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to Mass
Update Opportunities

Win probability, close date,
 status
 

Copy opportunity attribute
value to revenue line
attribute values.
 

Yes
 

Yes
 

Yes
 

Win/loss reason
 

Copy opportunity attribute
value to revenue line
attribute values.
 

No
 

Yes
 

Yes
 

This table describes the field or attribute change affect during a change to opportunity status in the context of the close
opportunity flow.

Opportunity Status
Change

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to Mass
Update Opportunities

To won
 

Set sales stage to last stage
of sales method. Set win
probability to 100 percent.
 

Yes
 

Yes
 

Yes
 

To lost or no sale
 

Set close date to current
date
 

Yes
 

Yes
 

Yes
 

From open to closed
 

• Enable win/loss
reason

• Set actual close date
to system time stamp

Yes
 

Yes
 

Yes
 

From open to closed
 

Copy primary competitor
to revenue line where
competitor is undefined
 

No
 

Yes
 

Yes
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Opportunity Status
Change

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to Mass
Update Opportunities

From closed to open
 

• Set actual close date
to undefined

Disable win/loss
reason. Set win/loss
reason to undefined.

Yes
 

Yes
 

Yes
 

This table describes the field or attribute change affect during a change to opportunity revenue line status in the
context of the close opportunity flow.

Revenue Line Status
Change

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to
Mass Update
Opportunities

Mass Update
Revenue Lines

To won
 

Set win probability to
100 percent.
 

Yes
 

Yes
 

Yes
 

Yes
 

To lost or no sale
 

Set close date to
current date.
 

Yes
 

Yes
 

Yes
 

Yes
 

From open to closed
 

• Enable win/loss
reason.

• Set actual close
date to system
time stamp.

Yes
 

Yes
 

Yes
 

Yes
 

From closed to open
 

• Disable win/loss
reason.

• Set win/loss
reason to
undefined.

• Set actual
close date to
undefined

Yes
 

Yes
 

Yes
 

Yes
 

This table describes the validations done for competitor, win/loss reason, and status, during the close opportunity flow.

Object Being
Validated

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to
Mass Update
Opportunities

Mass Update
Revenue Lines

Competitor
 

If the profile option,
 Close Opportunity
Competitor
Requirement, is
enabled, require
competitor on
opportunity and
revenue line.
 

Yes
 

Yes
 

Yes
 

Yes
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Object Being
Validated

Effect Applicable to Edit
Opportunity Flow

Applicable to Close
Opportunity Flow

Applicable to
Mass Update
Opportunities

Mass Update
Revenue Lines

Competitor
 

Validation error dialog
option to copy primary
competitor to revenue
line.
 

Yes
 

Yes
 

No
 

No
 

Win/loss reason
 

If the profile option,
 Close Opportunity
Win/Loss Reason
Requirement, is
enabled, require
win/loss reason on
opportunity and
revenue line.
 

Yes
 

Yes
 

Yes
 

Yes
 

Status
 

Revenue line status
must be valid for
opportunity status.
 

Yes
 

Yes
 

Yes
 

Yes
 

Related Topics
• Opportunity and Product Line Attributes Synchronization

Data Security  

How Sales Users Gain Access to Sales Information  
The security reference implementation provided by Oracle determines who can access opportunity information in your
sales organization. While basic information on accounts and contacts is available to all salespeople, your access to sales
data is restricted by your position in the resource hierarchy, membership in the sales team, and ownership.

Whether or not you can access a particular opportunity or a lead depends on your membership in the resource and
territory hierarchies. Here's how you gain access to opportunities. Lead access follows the same pattern. You can access
an opportunity if:

• You create the opportunity.

• You're on the opportunity sales team.

• The opportunity owner or sales team member is your direct or indirect report in the resource hierarchy.

• You're the owner or are a member of the territory assigned to the opportunity.

• You're the owner or member of a parent territory of the territory assigned to the opportunity.

• You're assigned to a territory for the account associated with the opportunity.

• You're assigned to a territory that's a parent of the territory for the account associated with the opportunity.
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Salespeople can see all opportunities related to their accounts but access differs between territory members and
opportunity members:

• An opportunity owner gets full access to the opportunity, which includes the ability to edit as well as add and
remove team members.

• Owners and members of territories or parent territories assigned to the opportunity account get read-only
access to the opportunity and aren't added to the opportunity sales team.

• Owners and members of territories assigned to the opportunity product lines are added as a distinct list
of territories to the opportunity sales team. Owners and members of these territories get full access to the
opportunity. Depending on a profile option, either only the owner or all the members of the territory are added
as resources to the opportunity sales team. Regardless of the access level for these members as a resource on
the opportunity team, they always have full access.

Owners and members of parent territories of the territory assigned to the opportunity aren't added to the
opportunity sales team but they always get full access.

The following diagram illustrates some of the different ways that you can gain access to an opportunity:

• Named agents in the diagram (A, B, and C) can access the opportunity.

• Unnamed agents (highlighted in yellow) can't access the opportunity.

• Sales managers can access the opportunity because a salesperson in their management chain has access.

• Owners of parent territories can access the opportunity through the sales territory hierarchy.
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This diagram shows who in a sales hierarchy can access an opportunity. 

• Agent A can access the opportunity because she created it. When you create an opportunity, you're the initial
owner.

• Agent B can access the opportunity because he's on the sales team.

• Sales managers who are higher up in the management chain can also see the opportunity because access is
provided through the resource hierarchy. The managers of Agent A and Agent B can access the opportunity
information, but agent A and Agent B's colleagues can't.

• Agent C can access the opportunity because he's the owner of the NW territory. The owner of the parent
territory can also access the opportunity.

• Sales administrators can access the opportunity.

Note:  Access using accounts isn't shown in this diagram.
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Special Access
Some access isn't affected by the management hierarchy and membership in sales teams or territories. This special
access includes:

• Administrators: Users assigned the Sales Administrator job role get full access to opportunities and other
objects. This access is based on their privileges, regardless of where the administrators are in the management
hierarchy. Administrators don't have to be on the sales team or members of territories.

• Deal Protection: Salespeople assigned to an opportunity retain the sales credit on an opportunity even if they're
moved to another opportunity.

Default Sales Channel  

Default Sales Channel Setup in Opportunities  
The sales channel of an opportunity indicates whether the opportunity is being handled directly by an internal
salesperson, or indirectly by an outside partner, such as a distributor or a reseller.

You can define your territories to include a sales channel, which lets you assign defined resources for each channel and
to analyze your revenue by sales channel.

Sales Channel Support
You can set the sales channel at the opportunity header and revenue item levels. The application automatically applies
the header value to revenue items when the status category matches.

Use the Manage Default Attributes for Partner Opportunities task to set the default sales channel. This setup enables
the Lead Registration Type of a partner lead to determine the default sales channel on an opportunity once the lead
registration is approved and converted into an opportunity. If partner functionality isn't implemented, the application
automatically sets the sales channel to Direct for all opportunities.

Default Sales Channel During Opportunity Creation
If you create an opportunity and there's no partner and no lead registration type associated with the opportunity, the
header-level sales channel is set to Direct. If you add revenue items while creating the opportunity, the sales channel of
the revenue lines is set to the same sales channel as the header.

If you create an opportunity from a lead conversion, it won't have a lead registration type, and the sales channel is set to
Direct.

If you create an opportunity from an approved lead registration, the application uses the lead registration type to
determine the appropriate header-level sales channel value. For example, an opportunity that originated from a Resale
lead registration carries a default sales channel of Indirect (using the default configuration).

When a revenue item is added to an opportunity, the default value of the sales channel always matches the header-level
value.

Note that if a lead registration is linked to an opportunity manually from the leads UI, the sales channel predefined logic
based on lead registration type doesn't apply.
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Opportunity Search  

Set Opportunity Search Profile Options  
You can configure opportunity search activity by setting profile options described in this topic.

Opportunity Search Profile Options
This table lists the profile options that control opportunity search activity.

Profile Option Display Name Default Value Effect

Require Additional Criteria for Opportunity
Search Enabled
 

No
 

Determines whether additional search criteria,
 other than close date, is required when you
want your search to:
 

• Extend across all opportunities

• Rely on hierarchy rollups

Opportunity Number Search Enabled for
Simplified UI
 

No
 

Enable opportunity search by Opportunity
Number in the simplified UI.
 

Opportunity Search Close Period Default
 

Current Quarter
 

Sets the system date and system date + 90
days as the default value displayed in the Close
Period list of values in opportunity search.
 

Search Opportunity Filter Default
 

My Opportunities
 

Specify the default value displayed in the table
filter in revenue search.
 

Opportunity Search Context-Based Data
Security Enabled
 

No
 

Enable for improved performance of
opportunity search.
 

Opportunity Search High Performance Data
Security Wrapper Query Enabled
 

Yes
 

Enable SQL wrapper query on top of data
security SQL predicates for improved
performance of opportunity search. If disabled,
 use underlying data security SQL predicates.
 

Opportunity Search Panel Collapsed
 

Yes
 

Enable a collapsed view of opportunity search
panel by default. Set to No to have default view
as expanded.
 

Sort Opportunity Searches by Last Updated Date
You can sort the records returned from your opportunity search by setting the Opportunity List Sort profile option. By
default, records on the Opportunity List are sorted by Win Probability and Opportunity Name. However, setting the
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Opportunity List Sort profile option value to Y enables opportunities to be sorted by last updated date in descending
order so that sales representatives can quickly review and action recently updated opportunities.

Set the Profile Options
Here's how to set the opportunity search profile options.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the search region of the Manage Opportunity Profile Options page, enter the profile option name in the
Profile Display Name field.

3. Click Search.
4. In the list that's returned, click the profile option name link.
5. Set the profile option value as needed.
6. Click Save.

Related Topics
• Sort Opportunity List By Last Updated Date

• Update Existing Setup Data

Sort Opportunity List By Last Updated Date  
You can sort the records returned from your opportunity search by setting the Opportunity List Sort profile option.

Sort Opportunity Searches by Last Updated Date
By default, records on the Opportunities overview page are sorted by win probability and opportunity name. However,
if you set the Opportunity List Sort (MOO_LIST_DEFAULT_SORT) profile option to Y, then the opportunities are sorted
by last updated date in descending order. This enables sales representatives to quickly review and act upon recently
updated opportunities.

Set the Profile Option
Here's how to set the Opportunity List Sort profile option:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the search region of the Manage Opportunity Profile Options page, enter Opportunity List Sort in the Profile
Display Name field.

3. Click Search.
4. In the Profile Values section, select Y from the Profile Value drop-down list.
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5. Click Save.

Related Topics
• Update Existing Setup Data

Configure Opportunity Close Period Search  
When users search for opportunities, they have a choice of several opportunity fields on which to search. One of the
fields is Close Period, which is a range based on opportunity close date.

If the supplied opportunity Close Period search values don't meet your business needs, you can add or remove the
values that the user can see by modifying the opportunity lookup type, Close Period Values for Search. For example,
you can configure the Close Period search so that users can pick all opportunities in the past 45 days, in the current
year, in the next three quarters, or in the next three years. You can enable values that aren't enabled by default, and you
can add your own user-defined values.

Note that users can search for an opportunity without any close date filter.

Here's how to modify the Close Period Values for Search lookup type:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Standard Lookups

2. In the Manage Standard Lookups page, search for the lookup type, Close Period Values for Search
(MOO_OPTY_SRCH_CLS_PERIOD) and update the lookup codes as needed:

◦ Use the Enabled to enable or disable a specific lookup code.

◦ Update the meaning (display name), start date, end date, check box or display sequence of any of the
predefined values.

◦ Add or remove lookup codes, as long as they follow the correct lookup code formatting. See the section,
Action and Best Practices, for more information about properly formatted lookup codes.

Action and Best Practices
Typically, in your implementation, you have already created and have in use the accounting calendar, also called the
fiscal calendar. The effect of and best practices for the close period lookup type values are different depending on
whether they reference standard Gregorian or accounting calendar lookup values.

This table describes the differences for the lookup type MOO_OPTY_SRCH_CLS_PERIOD.

Standard Gregorian Calendar Values Fiscal/Accounting Calendar Values

The enabled Gregorian periods are
displayed.
 

The enabled fiscal periods are displayed, in addition to the enabled Gregorian periods.
 

Supported periods are:
 

• Day

Supported periods are:
 

• Quarter
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Standard Gregorian Calendar Values Fiscal/Accounting Calendar Values

• Week

• Quarter

• Month

• Year

• Year

Lookup codes don't require a suffix as per
these examples:
 

• CURR_QTR: Current Quarter

• NEXT_4_QTRS: Next 4 Quarters

• PREV_180_DAYS: Previous 180 Days

You must enter the correct code as invalid
values aren't displayed in the UI.
 

• Fiscal period lookup codes must have the suffix _FSCL.

• Predefined fiscal periods include the term "Fiscal" in the display name, for example, CURR_QTR_
FSCL: Current Fiscal Quarter.

These actions and best practices are common to both types of calendars:

• Close period lookup codes not in the correct format aren't shown.

• When the accounting calendar and the close period setup don't match (for instance, the accounting calendar is
set up for a quarter, but the fiscal period is set to Next Month), then this close period value isn't shown.

• When the default close period value or a value previously used in a saved search is disabled, then the close date
range for that search is set to blank. Users can save the same search with a new value for future use, or they can
restore the value, in which case the search would work as before.

• You can define a close period called "All" that includes a time span wide enough to view all open opportunities
in one list, rather than viewing multiple lists for different periods.

Related Topics
• Create the Accounting Calendar

• Update Existing Setup Data

Enable Opportunity Search Filter Record Set Values for Territory
Membership  
You can enable the territory membership and territory membership hierarchy values that appear in the opportunity
search filter record sets.

The My territory membership record set returns records where the signed in user is either the owner or a member of
territories assigned to the opportunity. The My territory membership hierarchy returns records where the signed in
user is either the owner or a member of a territory assigned to the opportunity, or owner or member of a territory that's
ascendant to an assigned territory. These record sets are predefined but they must be enabled before your salespeople
can use them.

Here are the steps to enable the My territory membership and My territory membership hierarchy values for the
opportunity search filter record sets.

1. Navigate to the Setup and Maintenance work area, and use the following:
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◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter Opportunity Search Filter Record Sets.
3. Click Search.
4. Select the lookup type you want to enable in the MOO_OPTY_SRCH_RECORD_SET: Lookup Codes page.

◦ Scroll to the MYASSGMEMBTERROPTIES (My territory membership) lookup code and select Enabled.

◦ Scroll to the MYASSGMEMBDESCTERROPTIES (My territory membership hierarchy) lookup code and
select Enabled.

5. Click Save and Close.

Opportunity Setup Data Reference  

Opportunity Profile Options Default Values and Effects  
Opportunity profile options are configurable options that affect how opportunities are managed. Values defined at the
user level take precedence over values set at the site level. If a value isn't defined at the user level, the site level value is
used.

The effect of setting each of the opportunity profile options is described in these sections:

• Opportunity Assignment

• Opportunity Close Options

• Opportunity Sales Method and Revenue

• Opportunity Team and Partner

• Opportunity Searches

• Opportunity Lists and Filters

• Opportunity Copy Mapping

Opportunity Assignment
This table lists the profile options that affect the assignment of opportunities.

Profile Option Display Name Default Value Effect

Territory-Based Assignment Rule Category
 

None
 

Specifies the rule category used for rule filtering
during opportunity territory-based assignment.
 

Territory Based Resource Assignment Style
 

All
 

Determines whether to copy all territory
resources to the opportunity team or just the
territory owner during territory assignment.
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Profile Option Display Name Default Value Effect

Note:
The Lock Assignment  check box, if
selected, takes precedence and prevents
a salesperson from being automatically
removed from an opportunity through the
assignment engine. Only users with Full
access on the opportunity can select or
deselect the Lock Assignment check box for
sales team members.
 

Sales Team Member Assignment Rule Category
 

None
 

Specifies the assignment rule category used
by the automatic assignment process to assign
sales team members to opportunities.
 

Opportunity Assignment Mode
 

Territory-based Assignment Only
 

Determines the types of assignment modes
allowed during opportunity assignment.
 

Assignment Submission at Save Enabled
 

No
 

Determines whether the assignment engine is
started automatically when an opportunity is
saved.
 

Territory-Based Assignment Selective Update
Enabled
 

Y
 

Enables opportunity time stamp update during
territory-based assignment if assignment
outcome changed. If disabled, always update
opportunity time stamp during territory
assignment.
 

Opportunity Close Effects
This table shows the profile options that affect opportunity close actions.

Profile Option Display Name Default Value Effect

Close Opportunity Win/Loss Reason Required
 

Yes
 

Determines whether, when closing an
opportunity, the user is required to enter a win
or loss reason. Applies both at the opportunity
and revenue item levels.
 

Close Opportunity Competitor Required
 

Yes
 

Determines whether, when closing an
opportunity, the user is required to enter a
competitor. Applies both at the opportunity and
revenue item levels.
 

Opportunity Close Date Default
 

20
 

Determines the number of days after an
opportunity is created for the initial close date.
 
If you want the application to show a blank
close date when an opportunity is initially
created, blank out any value in this profile
option and ensure the Close Window field in the
Edit Sales Method page is blank.
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Profile Option Display Name Default Value Effect

 

Opportunity Close Date Retain on Closure
 

No
 

Instructs the application to retain the old close
date even after the status of the opportunity or
product line is set to a closed status. If you don't
set this profile option to yes, then the close
date on the opportunity header or product
line is updated with the current date when the
opportunity or product line is closed.
 

Close Opportunity Flow Enabled
 

No
 

Enables the Close Opportunity interface to
record details about the close.
 

Close Date Range Maximum Value
 

366
 

Specifies the maximum number of days the
Close Date Range parameter can be set to.
Applies to both revenue and opportunity
search.
 

Opportunity Sales Methods and Revenue
This table lists the profile options that affect the opportunity sales methods and revenue lines.

Profile Option Display Name Default Value Effect

Search Revenue Filter Default
 

My Revenue Items
 

Specifies the default value displayed in the
Show table filter in revenue search.
 

Multiple Currencies for Opportunity Revenue
Lines Enabled
 

N
 

Enables multiple currencies for opportunity
revenue lines independently of the opportunity
header currency. A value of No synchronizes
header currency to the lines.
 

Nonrevenue Credit Allocation Style
 

Proportional
 

Specifies the default type of nonrevenue credit
allocation split.
 

Sales Method Default
 

None
 

Specifies the default sales method for the
business unit. The value specified is used when
creating a new opportunity.
 

Browse Sales Catalog in Opportunities Enabled
 

N
 

Specifies whether to allow sales personnel to
browse the sales catalog from the Products
region in the opportunities UI.
 

Opportunity Sales Credit Enabled
 

N
 

Enables the sales credit interface in the
opportunity UI to view and record sales credit
allocations for opportunity lines.
 

Opportunity Synchronization Cascade Enabled
 

Y
 

Enables the opportunity cascading logic to keep
opportunity summary and revenue lines in
synchronization with each other.
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Profile Option Display Name Default Value Effect

 

Opportunity Team and Partner
This table lists the profile options that affect the team and partner options for opportunities.

Profile Option Display Name Default Value Effect

Internal Resource Sales Team Access Level
Default
 

Edit
 

Determines the default access level for an
internal resource added to the sales team.
 

Internal Resource Sales Team Function Default
 

Integrator
 

Determines the default function for an internal
resource added to the sales team.
 

Opportunity Resource Deal Protection Period
 

0
 

Specifies the default number of days that
territory resources are protected to stay on
a deal, even if ineligible through territory
realignment.
 

Partner Resource Sales Team Access Level
Default
 

No Access
 

Determines the default access level for partner
resources added to the opportunity sales team.
 

Partner Resource Sales Team Function Default
 

Integrator
 

Determines the default function for partner
resources added to the opportunity sales team.
 

Opportunity Searches
This table lists the profile options that affect opportunity searches.

Profile Option Display Name Default Value Effect

Require Additional Criteria for Opportunity
Search Enabled
 

No
 

Determines whether additional search criteria,
 other than close date, is required when you
want your search to:
 

• Extend across all opportunities

• Rely on hierarchy rollups

Opportunity Number Search Enabled for
Simplified UI
 

No
 

Enables opportunity search by Opportunity
Number.
 

Opportunity Search Close Period Default
 

Current Fiscal Quarter
 

Specifies the default value displayed in the
Close Period list of values in opportunity and
revenue search.
 

Search Opportunity Filter Default
 

My Opportunities
 

Specifies the default value displayed in the table
filter in revenue search.
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Profile Option Display Name Default Value Effect

Opportunity Search Context-Based Data
Security Enabled
 

No
 

Enables improved performance of opportunity
search.
 

Opportunity Search High Performance Data
Security Wrapper Query Enabled
 

Yes
 

Enables SQL wrapper query on top of
data security SQL predicates for improved
performance of opportunity search. If disabled,
 the application uses underlying data security
SQL predicates.
 

Opportunity Search Panel Collapsed
 

Yes
 

Enables a collapsed view of opportunity
search panel by default. Set to No to make the
expanded view the default view.
 

Opportunity Lists and Filters
This table lists the profile options that affect opportunity lists and filters.

Profile Option Display Name Default Value Effect

Opportunity List Show Filter Default
 

My Open Opportunities
 

Specifies the default value for the Show
filter in the opportunity list. Enter My Open
Opportunities or My Sales Team Open
Opportunities.
 

Opportunity List Time Period Default
 

Quarter
 

Specifies the default time period in the
opportunity list. Enter Quarter or Year to set
the default to current quarter or current year,
 respectively.
 

All Open Opportunities List Enabled
 

Y
 

Enables the opportunity list to show all open
opportunities across all time periods.
 

Opportunity List Sort
 

N
 

Specifies how you want to sort opportunities.
The default is to sort by Win Probability and
Name. You can specify to sort by Last Updated
Date or you can remove any form of sorting.
 

Sales Historical Snapshot Record Limit
 

10000000
 

Specifies the maximum number of records
retained in the Sales historical snapshot tables.
 

Sales Historical Snapshot Configuration
 

C=120,D=120,W=58,M=14,Q=5
 

Specifies the capture and retention settings
for opportunity historical snapshots. C is the
number of days to look backward at closed
opportunities. D is for number of days, W is for
number of weeks, M is for number of months,
 and Q is for number of quarters.
 

684



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 23
Opportunities

Opportunity Copy Mapping
This table lists the profile option used when copying opportunities.

Profile Option Display Name Default Value Effect

Copy Opportunity Mapping
 

Copy Opportunity Map
 

Specify the mapping file name to use when
copying an opportunity. The file is used to copy
attributes and child objects when creating a
copy of an existing opportunity.
 

Modify the Recurring Revenue Forecast Type Profile Option  
The profile option, Recurring Revenue Forecast Type (ORA_MOO_REV_RECUR_FORECAST), controls whether to
forecast revenue lines based on every single schedule occurrence or aggregated based on the start date. The default is
to forecast on each single occurrence.

Use these steps to change the default value of Each Individual Scheduled Occurrence
(ORA_INDIV_SCHED_OCCURRENCE) to the Aggregated Based on Start Date (ORA_AGGR_BASED_ON_START_DATE)
value so that existing multiple recurring revenues lines are aggregated to a single close date:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ORA_MOO_REV_RECUR_FORECAST in the Profile Option Code field.

3. Click Search.
4. Change the default value of the profile option from ORA_INDIV_SCHED_OCCURRENCE to

ORA_AGGR_BASED_ON_START_DATE.
5. Click Save and Close.

FAQs for Opportunities  

Frequently Asked Questions (FAQs) for Opportunities  
This section contains some frequently asked questions (FAQs) when setting up and maintaining core opportunities
functionality. Scroll or search to find answers to common questions.
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How do I access the Revenue-to-Opportunity status category
mapping matrix?  
You can access the Revenue-to-Opportunity Status Category Mapping matrix by searching for the Manage Sales Status
Category Mapping task from the Setup and Maintenance work area.

There are four predefined sales statuses and status categories such as Lost, No Sale, Open, and Won. Salespeople can
select these statuses for an opportunity or for a product line while editing an opportunity. The application uses status
categories when calculating business intelligence metrics for win/loss analysis. Status categories aren't visible in the UI
but sales statuses are.

Related Topics
• Set Up Sales Statuses

What QBE values are supported in the Sales Status setup page?  
You can use only Y and N in the query by example (QBE) field located above the Active column in the Manage Sales
Statuses page.

Related Topics
• Set Up Sales Statuses

How can I restrict Account owners and Account team members
from viewing Opportunities?  
You need to define a custom role so that members of the Account Team or Account Territory can't view opportunities
associated with the account unless they're also members of the opportunity team.

For example, the predefined Sales Representative role has the following duties added:

• Opportunity Sales Representative Duty

• Opportunity Territory Resource Duty

• Opportunity Sales Account Sales Representative Duty

• Opportunity Sales Account Territory Resource Duty

Define a custom role similar to Sales Representative but without the Opportunity Sales Account Sales Representative
Duty and Opportunity Sales Account Territory Resource Duty duties. To restrict opportunity visibility based on the
Opportunity Owner, Team or Territory, assign users a custom role that has only the following duties:

• Opportunity Sales Representative Duty

• Opportunity Territory Resource Duty

686



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 23
Opportunities

See the related topics in the Securing Sales and Fusion Service guide for more information on modifying the default
roles.

Related Topics
• Guidelines for Copying Roles

• Copy Job or Abstract Roles

Can partner users view, add, and modify opportunity team
members?  
Yes, depending on their resource security, partner users can access opportunity team members based on their roles or
access groups they belong to.

For more information about access groups, see the Access Groups chapter in the Securing CX Sales and Fusion Service
guide.

687

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051248
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051246


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 23
Opportunities

688



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 24
Opportunity Products and Revenue

24  Opportunity Products and Revenue

Considerations for Setting Up Opportunity Revenue  
The sales opportunity revenue model allows several feature configuration options during and after implementation. For
example, you can make some fields read-only and modify lookups to meet your unique business needs.

Revenue Amount and Revenue Type
Consider the following options about the Revenue Amount and Revenue Type fields:

• You may want to configure opportunities with Revenue Amount as a read-only field. This setup ensures that
the revenue amount reconciles with quantity and estimated price. By default, the Revenue Amount is editable
for cases where salespeople know a projected revenue amount but may not know the quantity. You can make
the revenue amount read-only through configuration. For general information about configuring applications,
see the Configuring Applications Using Application Composer guide. You can find information on extending
opportunity revenue pages in the chapters on extending business objects in this guide.

• Using Revenue Type, you can categorize revenue lines for grouping, sorting, and summarization purposes. The
maximum number of opportunity revenue lines for a single opportunity is 500. The application comes with
several predefined values, such as Pipeline, Upside, Expected, Committed, and Closed. Stored in the lookup
MOO_REVENUE_TYPE, the values are user-defined.

CAUTION:  You should avoid changing these values after users have begun using the application, as data
integrity issues may result. If you do decide to obsolete existing values after the application is deployed, be
sure to clean up the revenue records that refer to the obsolete values.

Product Selection
Consider the following options for product selection:

• To enable users to browse the sales catalog, you must set the profile option, Browse Sales Catalog in
Opportunities Enabled (MOO_ENABLE_BROWSE_CATALOG), to Yes.

• The product and product group search screens and sales catalog filter by territory. This filtering limits the
product selection to those products available in a salesperson's territories. A check box in the product search
pages lets salespeople turn off the filtering. For more information about this setup, see the topic, Set Sales
Catalog Options and Actions in the Sales Catalogs chapter.

• The product and product group search screens contain the same values as those in the sales catalog, if
implemented.

Sales Credit Assignment
Consider the following rules around sales credit assignment:

• To enable the Sales Credit icon in the opportunity products table, you must set the profile option, Opportunity
Sales Credit Enabled (MOO_ENABLE_SALES_CREDITS) to Yes.
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• The application automatically assigns the salesperson who added the product line to the opportunity one
hundred percent of the sales revenue credit, and makes him the default sales credit recipient.

• Users need Full or Edit permissions to override the default sales credit recipient.

• The territory assignment process can update credit recipients, unless they're locked in.

For more information about how salespeople assign sales credits in opportunities, see the Using Sales guide. Also see
the related setup topics for sales credits.

Business Units
Each product line is associated with a single business unit. The application uses the opportunity header business unit
(which is based on the profile of the user who created the opportunity) to populate the default business unit on product
lines. Business unit as a field isn't displayed in the UI by default, but it can be exposed to suit your requirements.

• For more information about multiple business units in opportunities, see the topic, Overview of Multiple
Business Units in Opportunities.

• For more information about configuring applications, see the Configuring Applications Using Application
Composer guide.

Multicurrency Support
Opportunities and product lines support multiple currencies, if multiple currencies have been implemented. When
a salesperson adds a product or product group to an opportunity, the application uses the opportunity header
currency as the default currency on the product line. However, salespeople can override the default currency. For more
information about currency setup, see the topic, Set Up Multiple Currencies.

Territory Assignment
When you're using territory-based assignment, the assignment engine automatically assigns territories to product lines.
Territory team members on the territories are assigned to product lines based on their membership in the territories.
For more information about territory setup, see the topics on setting up territories.

Related Topics
• Guidelines for Setting Forecasted Opportunity Revenue

Enable the Products Subtab in Opportunities  
You can expose the Products subtab in the Edit Opportunity page to let salespeople view more revenue line items at a
glance. By default, the Products subtab doesn't appear in the Edit Opportunity page.

Here's how to expose the Products subtab in the Edit Opportunity page.

1. Activate a sandbox.
2. Navigate to Application Composer, in the Configuration category.
3. Select Sales.
4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.

690



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 24
Opportunity Products and Revenue

6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and
clicking the Duplicate icon.

7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Products from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. From the Details Layout page, click Done.
12. Make sure that the layout status for your layout is set to Active.
13. Test the changes as follows:

◦ Navigate to Sales > Opportunity as a user with access to the opportunity pages, for example, as a
salesperson.

◦ Edit an opportunity and ensure you can view the Products subtab in the Edit Opportunity page.

14. Publish the sandbox.
For more information, see the related topics in the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Subtabs

• Overview of Sandboxes

Enable Quick Edit to Opportunity Products  
An opportunity can have a large number of products. If changes are required, salespeople have to modify product lines
with lots of attributes, often a time-consuming task.

So to make the task easier, use Application Composer to let salespeople quickly navigate to a secondary dialog window
to add new or edit existing product lines. From the products area of the opportunities UI, they can add, view, edit, close,
go to next and previous records in a dedicated dialog box.

Here's how to enable the product line dialog box:

1. Activate a sandbox.
2. Navigate to the Application Composer, available under the Configuration menu.
3. Expand the Opportunity object tree.
4. In the Opportunity tree, click the Pages link.
5. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
6. From the Edit Revenue Table region, click the edit icon.
7. Click these check boxes:

◦ Enable Separate Create Pages check box to control how new product line records are added.

If you enable this check box, salespeople can click Add to display a dedicated Add Product  dialog box
where they can add new product lines.

◦ Enable Separate Edit Pages check box to control how existing product line records are edited.
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If you enable this check box, salespeople can click the link in the Name field to display a dedicated Edit
Product dialog box for the product line records they want to change.

8. Click Save and Close.
9. Back in the Details Layout page, click Done.

10. Ensure that the layout status for your user-defined layout is Active.
11. Test the changes: Navigate to Sales >  Opportunities  as a user with access to the Edit Product page, for

example, as a salesperson. Click the Name link for the product or group you want and ensure that a dedicated
Edit Product dialog box is displayed.

12. Publish the sandbox.

Forecasted Revenue  

Guidelines for Setting Forecasted Opportunity Revenue  
The application includes opportunity revenue in the current sales forecast based on how you set up the forecast criteria.
If enabled, you can see which revenue items are included in the forecast and you can include or exclude revenue from
the forecast.

You can also include or exclude an entire opportunity, and thus its revenue from products, if enabled.

Examples of Forecasted Opportunity Revenue
You use the Edit Opportunity page revenue (or products) region to view which revenue items are in the current forecast.
A check mark in the Forecast column of a revenue line indicates that the revenue is included in the forecast the next
time it's generated.

Note:  A revenue item marked as forecasted doesn't necessarily mean that it's already included in the latest forecast.
The inclusion is dependent upon when the refresh forecast process was last run. For example, a revenue item may
meet the current forecasting criteria, but the latest forecast may have already been submitted when the revenue was
added to the opportunity. When the next forecast snapshot is generated, the revenue item is included, provided it
continues to meet the forecast criteria.

Revenue is included in the forecast based on how the configuration of the forecast rules. Here are some examples of
how forecasted opportunity revenue operates:

• Opportunity revenue can be systematically added to the forecast based on a set of global criteria specified
during setup.

• Include in Forecast drop-down list:

You can enable a drop-down list called Include in Forecast. The drop-down list appears in both the opportunity
and revenue (products) region.

In the Edit Opportunity page, you can override the criteria for an entire opportunity or for individual
opportunity revenue items by using the Include in Forecast drop-down list.

• The application changes the Include in Forecast setting dynamically when you make changes to any of the
following revenue attributes in the opportunity page. (The corresponding forecast is only updated when you
save your changes.)
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◦ Product Group

◦ Quantity

◦ Estimated Price

◦ Revenue

◦ Win Probability

◦ Revenue Type

◦ Expected Revenue

◦ Status

• The application always includes in the forecast revenue items that have a status category of Won.

Related Topics
• Considerations for Setting Up Opportunity Revenue

• Set Opportunity Revenue Forecast Criteria

Set Opportunity Revenue Forecast Criteria  
You can control how the opportunity revenue forecasting criteria operates by setting these two sales forecasting fields:

• Enable Forecast Criteria Override: You can control the appearance and effect of the Include in Forecast list of
values in the Edit Opportunity header and revenue (products) region.

• Forecasting criteria: You can pick one of several different criteria for including revenue in the forecast. After
you set criteria, the text, Forecast Criteria, along with the actual criteria, display in the revenue region.

You set these fields in the Select Forecasting Options page, Unadjusted Forecast Criteria region. This page is
accessible by using the Setup and Maintenance work area and selecting the Forecasting Options task. For more
information about creating forecasts, start with the topic, Two Forecasting Scenarios.

Set Forecast Criteria
Use this procedure to set forecast criteria:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Forecasting

◦ Task: Select Forecasting Options

2. In the Unadjusted Forecast Criteria region of the Select Forecasting Options page, set the criteria as you want.

The remaining sections in this topic describe the impact of setting the criteria fields for opportunity revenue
lines.

For more information about other forecasting setups not covered in this topic, see the help. Use keywords "forecasting"
and "forecast".
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Forecasting Criteria for Product Lines
You can specify one of several different criteria by which opportunity product line revenue is included in the current
forecast. Here are the supported criteria. All of the criteria are fields in the products region of the Edit Opportunity page.

• Estimated Price

• Expected Revenue

• Probability

• Product Group

• Quantity

• Revenue (amount)

• Revenue Type

• Status

Impact of Enabling Forecast Criteria Override
If you check the Enable Forecast Criteria Override field in the Select Forecasting Options page, then a choice list
appears in the opportunity UI called Include in Forecast. The list appears both in the opportunity header area and
the products region. Salespeople can use the field to manually add or remove revenue from the current forecast. If the
choice list is enabled, salespeople can add revenue to the forecast even if the revenue doesn't fit the current forecast
criteria. Additionally, the impact of the opportunity UI changes depend on whether you also have set up forecasting
criteria. For example, you might have set up a win probability percentage that must be met before a revenue item gets
included.

This table explains how the application operates if you have set up forecasting criteria in the Unadjusted Forecast
Criteria region in the Select Forecasting Options page.

Enable Forecast Criteria Override Checked Enable Forecast Criteria Override Unchecked Forecast Criteria Text Appears in
Opportunity UI

The Include in Forecast list of values displays in
the UI, allowing sales personnel to select from
these options:
 

• Always

• Never

• When matches forecast criteria

The Include in Forecast list of values doesn't
appear. The default value for revenue items is
When matches forecast criteria.
 

Yes
 

This table explains how the application operates if you haven't set forecasting criteria in the Unadjusted Forecast
Criteria region in the Select Forecasting Options page.

Enable Forecast Criteria Override Checked Enable Forecast Criteria Override Unchecked Forecast Criteria Text Appears in
Opportunity UI

The Include in Forecast list of values displays in
the UI, allowing sales personnel to select from
these options:
 

• Always

The Include in Forecast list of values doesn't
appear. The default value for revenue items is
When matches forecast criteria.
 

No
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Enable Forecast Criteria Override Checked Enable Forecast Criteria Override Unchecked Forecast Criteria Text Appears in
Opportunity UI

• Never

Related Topics
• Considerations for Setting Up Opportunity Revenue

• Guidelines for Setting Forecasted Opportunity Revenue

• Update Existing Setup Data

Modify the Recurring Revenue Forecast Type Profile Option  
The profile option, Recurring Revenue Forecast Type (ORA_MOO_REV_RECUR_FORECAST), controls whether to
forecast revenue lines based on every single schedule occurrence or aggregated based on the start date. The default is
to forecast on each single occurrence.

Use these steps to change the default value of Each Individual Scheduled Occurrence
(ORA_INDIV_SCHED_OCCURRENCE) to the Aggregated Based on Start Date (ORA_AGGR_BASED_ON_START_DATE)
value so that existing multiple recurring revenues lines are aggregated to a single close date:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ORA_MOO_REV_RECUR_FORECAST in the Profile Option Code field.

3. Click Search.
4. Change the default value of the profile option from ORA_INDIV_SCHED_OCCURRENCE to

ORA_AGGR_BASED_ON_START_DATE.
5. Click Save and Close.

Sales Credits  

Best Practices for Sales Credits  
Companies use sales credits to report on the performance and quota attainment of their sales personnel. They also use
sales credits to aid in compensation calculation and to facilitate forecasting by territories.

Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment.
You assign sales credits to sales resources (salespeople or other sales users) while editing product lines in opportunities.
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When a product line is first added to an opportunity, the application sets the user who added it, as the sole sales credit
recipient. This means that the sole recipient receives 100 percent of the sales credit.

Two types of sales credit exist for opportunities:

• Revenue sales credit: Typically allocated to salespeople working the deal.

• Overlay sales credit: Typically allocated to other resources helping out with the deal, such as a product or
market specialist. Overlay sales credit is also known as nonrevenue sales credit.

Revenue Sales Credit
When assigning revenue sales credits, keep in mind:

• Only internal resources are eligible as revenue credit recipients.

• Revenue sales credits must add up to 100 percent.

• The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and
Nonrevenue Forecast Participation.

Overlay Sales Credit
When assigning overlay sales credits, keep in mind:

• Both internal and external (for example, partner) resources are eligible as nonrevenue credit recipients.

• Nonrevenue sales credits doesn't have to add up to 100 percent.

• If the selected Allocation Style is Proportional to Revenue, the sales credit amounts adjust automatically and
proportionally when the product line amount changes.

• If the selected Allocation Style is Ad Hoc Amounts the sales credit amounts don't change with product line
amount changes.

• The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and
Nonrevenue Forecast Participation.

Note:  Territories with a Forecast Participation of Nonforecast aren't eligible to be set as the forecast territory on either
revenue or nonrevenue sales credits.

Configure Revenue Territory Default Assignment
You can configure the revenue territory assignment default logic to meet your specific business needs for reporting
and forecasting the product amounts on an opportunity. When a sales representative creates an opportunity, the
opportunity amount gets reported in the sales representative's pipeline and forecasted in their territory. This is achieved
through the seeded defaulting logic, part of the revenue territory assignment process, that sets the appropriate credit
recipient and forecast territory on the opportunity product lines.

Some companies have territory setup that may result in many overlapping territories assigned to the opportunity
products. They may have specific business logic that determines to whom the pipeline from an opportunity should be
reported and forecast. For example, the opportunity creator may not be the owning sales representative. Instead the
owner of the sale may be determined by the role or geography of the sales representative involved in closing the sale,
or the business unit of the sale. Many of these scenarios can be met through appropriate territory setup, the standard
revenue territory assignment processing, and subsequent sales credit recipient and forecast territory defaulting logic.
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Note:  A sales credit recipient selected by a user doesn't get replaced by the application unless the recipient is no
longer a qualified credit receiver. The application won't change the recipient if:

• The Lock Owner setting for the revenue item is enabled

• The current credit recipient is under deal protection.

• The current credit recipient is an owner or member of the forecast territory.

The application sets the forecast territory owner as the new credit recipient if the preceding criteria isn't met.

This table outlines the predefined deal protection logic to set the forecast territory for each revenue line in the sales
credit.

If you're using Deal protection... If you aren't using Deal protection...

Sets the owner of the revenue line as the
Forecast territory's owner. As a result,
 multiple revenue lines have the same
owner after assignment.
 

Sets the owner of the revenue line as the owner of the forecast territory after setting the Primary
forecast territory of the sales credit revenue line.
 

You can make the revenue line owner deal
protected by setting a deal protection
period in the MOO_DEAL_PROTECTION_
PERIOD profile option. Go to Setup and
Maintenance >  Manage Opportunity
Profile Options and set MOO_DEAL_
PROTECTION_PERIOD to a value as
required.
 

If you need to bypass setting the owner of the revenue line as the owner of the forecast territory,
 you will have to lock the owner either through running a Groovy script while adding the Sales Credit
Recipient (SCR). Alternatively, you can set the MOO_DEAL_PROTECTION_PERIOD profile option, as
required.
 

In the trigger createNonRevenueSplitLineAndAssignSCR
add the following lines in places where you're adding the SCR.

splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y');

This will retain the resource that you're adding to the overlay from the
 territory resources.
From the script, the places are as follows:
1. //==============================================================
// Block of code to create Non-Revenue Sales Credit Splits
//==============================================================
def splitRevenueNonQuotaIterator =
 nvl(getAttribute("SplitRevenueNonQuota"),null);
splitRevenueNonQuotaIterator?.reset();
if (!splitRevenueNonQuotaIterator?.hasNext()) {
splitNonRevenueRow = splitRevenueNonQuotaIterator.createRow();

splitNonRevenueRow.setAttribute('SplitParentRevnId',getAttribute("RevnId"));
splitNonRevenueRow.setAttribute('SalesCreditTypeCode','NONQUOTA');
splitNonRevenueRow.setAttribute('SplitPercent',60);
splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y'); //<--Added code here
splitNonRevenueRow.setAttribute('ResourcePartyId',Opportunity?.OwnerResourcePartyId);
println('Opportunity?.OwnerResourcePartyId
 '+Opportunity?.OwnerResourcePartyId)
setAttribute('ResourcePartyId',Opportunity?.OwnerResourcePartyId)

2.
if (splitRevenueNonQuotaIterator1?.hasNext()) {
splitNonRevenueRow = splitRevenueNonQuotaIterator1.createRow();
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If you're using Deal protection... If you aren't using Deal protection...

splitNonRevenueRow.setAttribute('SplitParentRevnId',getAttribute("RevnId"));
splitNonRevenueRow.setAttribute('SalesCreditTypeCode','NONQUOTA');
splitNonRevenueRow.setAttribute('SplitPercent',84);
splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y'); //Added code here
splitNonRevenueRow.setAttribute('ResourcePartyId',newSCR);
splitRevenueNonQuotaIterator1.insertRow(splitNonRevenueRow);
setAttribute('SplitTypeCode','PARENTSPLIT');
setAttribute('ResourcePartyId',newSCR);
println('Inside IF SET ATTRIBUTE.. (!
splitRevenueNonQuotaIterator1?.hasNext())....SplitTypeCode' +SplitTypeCode)

See the article, Configuring Credit Recipients and Forecast Territories Assignment (Doc. ID 2089301.1), available on My
Oracle Support (support.oracle.com).

Manual Territory Assignment by Administrators
In the sales credits screens, sales administrators can manually assign a sales representative's territory to a product
line when the territory hasn't been assigned automatically. Manual assignment allows sales personnel to forecast an
opportunity immediately while the territory setup is being reviewed and updated.

Related Topics
• Sales Credit Recipient and Forecast Territory Predefined Logic

• Set Deal Protection on Opportunities

• Allocate Sales Credits

• How can I lock in a sales credit recipient?

Enable Sales Credits  
To enable sales credit functionality in opportunities, you must set the profile option, Opportunity Sales Credit Enabled
(MOO_ENABLE_SALES_CREDITS).

If the value of the profile option is Y, the Sales Credit column displays in the opportunity Products table, and the editable
sales credit icon displays on product lines. The sales credits icon lets salespeople access the pages where they assign
revenue and nonrevenue (overlay) sales credit to other users. For more information, see the related topics.

Prerequisites
Keep in mind the following prerequisites when salespeople assign sales credits in opportunities:

• Territories have been set up and your company is using territories for assignment of opportunity products.

• The user must have Full access to the opportunity to assign sales credits.
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Set the Sales Credit Profile Option
Here's how to set the sales credit profile option.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the search region of the Manage Opportunity Profile Options page, search for the profile option, Opportunity
Sales Credit Enabled (MOO_ENABLE_SALES_CREDITS).

3. In the search results, click the profile option name.
4. Set the profile option value to Y.
5. Save your changes.

Related Topics
• Sales Credit Recipient and Forecast Territory Predefined Logic

• Best Practices for Sales Credits

• Allocate Sales Credits

• Update Existing Setup Data

Recurring Products  

Overview of Recurring Opportunity Products  
Recurring schedules in opportunities enables you to enter and track opportunity products or product groups that are
part of a subscription business model.

The subscription business model applies to the sale of goods, software, or services where the customer is required to
pay a subscription price for access to the goods, software, or services, with additional usage or pay-as-you go charges
in some cases. Some examples are:

• Data and phone services

• Credit collection or payment processing services

• Software, platform, or data-as-a-service costs

• Magazine subscriptions

• Product life cycle costs

• Engineering and infrastructure services

The subscription model can encompass both business-to-business (B2B) and business-to-consumer (B2C) customers.
For example, a telecommunications company may sell mobile phone services to individuals, and multiple phone lines to
a business for their employees. The supplier of these services typically charges the customer a periodic rate applicable
to the plan that they subscribed to.
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After you define a schedule for a subscription product or service, the application creates the recurring transactions from
the frequency and the number of transactions specified in the schedule. There are several time frequencies to choose
from, such as weekly, monthly, quarterly, yearly, and so on. The multiple frequencies make it easy to set up a recurring
schedule, like a monthly subscription for three years, or a biweekly annual subscription. You can review the schedule
and quickly add a one-time registration or installation fee, and adjust the amount or date of any transaction.

Subscription changes are easy to manage. If there is a change in the terms or price of the subscription, you can quickly
define a new schedule to replace the previous one. If the original subscription is extended, say, for another year, you can
easily extend the existing schedule on the product for the period that you want.

Product amounts from recurring schedules are summed into the corresponding quarterly or yearly periods, and are
readily available in pipeline reports and forecast rollups for you and sales managers.

Related Topics
• Create and Maintain Recurring Opportunity Products

Enable Recurring Opportunity Products  
To enable recurring opportunity products, use Oracle Application Composer to add the Schedule column to the
opportunities UI.

You access the recurring schedules pages from the schedule icon in the Schedule column of the edit opportunity page.
For more information about recurring opportunity products functionality, see the related topics.

Add the Schedule Column
Here's how to add the Schedule column to the edit opportunity page from Application Composer.

Note:  When modifying the UI, you must make your changes in a sandbox. See the Configuring Applications Using
Application Composer guide for more information about using sandboxes.

1. Create and activate a sandbox to work in.
2. Navigate to Application Composer.
3. In the Application Composer page, select Sales as the object.
4. Expand Standard Objects and navigate to Opportunity, then Pages. The Opportunity: Pages page appears.
5. In the Opportunity: Pages page, ensure that the Application Pages tab is active.
6. In the Details Page Layouts region, select the Default Layout in the table and then click the edit icon. The

Details Layout: Default Layout page appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

7. In the Edit Revenue Table region, click the edit icon.
8. In the Details Layout: Default Layout: Edit Revenue Table page, find the Schedule field in the Configure

Summary Table window. Move the field from the Available Fields window to the Selected Fields window.
9. Click Save and Close.

10. Click Done in the Details Layout: Default Layout page.
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11. Validate the change by navigating to the edit opportunity page and ensuring that you can see the Schedule
field in the Products table.

Note that the user you sign in as to validate the change must belong to a sales resource organization. For
example, you must sign in as a sales representative.

12. Publish the sandbox.
13. The Schedule field is now available to sales users in the edit opportunity pages.

Related Topics
• Manage Fields for Recurring Opportunity Products

• Overview of Recurring Opportunity Products

• Create and Maintain Recurring Opportunity Products

Manage Fields for Recurring Opportunity Products  
You can add and modify fields to the recurring schedules UI in opportunities. You can also rearrange the frequency
values that salespeople can choose from when creating a recurring schedule.

For more information about recurring opportunity functionality, see the related topics.

Configure Additional Fields
You can use Oracle Page Composer to enable additional fields in the recurring schedule UI, to meet your specific
requirements.

The fields you can enable are:

• Expected Revenue

• Status

• Win Loss Reason

• Estimated Price

• Best Case

• Worst Case

• Win Probability

• Additional Number 1

• Additional Amount 1

• Additional Text 1

• Additional Text 2

Note:  You can't add custom fields to set schedule and manage schedule pages in the recurring schedule UI.

Here are the steps to enable these fields:

Note:  To perform this procedure, you must have already enabled the Schedule icon in the Products table in the Edit
Opportunity page. For more information, see the topic, Enable Recurring Opportunity Products.
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1. Click Navigator > Sales > Opportunities.
2. Create and activate a sandbox to work in.
3. Click your user name in the global header and select Edit Pages.
4. Select a layer that you want to modify. For example, you can make the changes available only to users with a

specific job role, such as sales representatives. Click OK to commit the modified layer.
5. When modifying work areas, you start in the Design view. Design view lets you navigate to the component you

want to modify.
6. Click an opportunity to edit it.

The Edit Opportunity page appears.
7. Click the Schedule icon in the Products table.

The Manage Schedule page appears.
8. Click Select.
9. Hover over the last column in the Transactions table header row until a border appears. Click the edge of the

border.
10. In the menu that appears, click Edit Parent Component.

The Component Properties window appears.
11. Click the Children tab.
12. Select the fields you want to enable.
13. Click Close to save.

You can use a similar procedure to modify the Set Schedule Page.

For more information about using Application Composer and Page Composer, see the Configuring Applications Using
Application Composer guide.

Change the Display Order of Frequencies
When you create a recurring schedule, you must select a value, such as monthly, from the Frequency field. You can
change the display order of the frequencies that display in the list. For example, you can make the Monthly value the
first one in the list. You make these changes by modifying the supplied lookup type, MOO_RECURRING_FREQUENCY.

Here's how to change the display sequence.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Standard Lookups

2. In the Lookup Type field of the Manage Standard Lookups page, enter MOO_RECURRING_FREQUENCY and search. Or,
you can enter Sales Recurring Revenue Frequency in the Meaning field and search.

3. In the list of values, reorder the items as needed by changing the numbering in the Display Sequence column.

The value that has the lowest display sequence is the one that's set as the default value.
4. Click Save and Close.
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Related Topics
• Enable Recurring Opportunity Products

• Overview of Recurring Opportunity Products

• Create and Maintain Recurring Opportunity Products

• Update Existing Setup Data

• Overview of Sandboxes

Additional Implementation Considerations for Revenue  

Opportunity and Product Line Attributes Synchronization  
Opportunities and their product lines share common attributes, for example, status or win probability percentage. For
several attributes, under certain conditions, the application automatically synchronizes them so that they're the same.

In addition, the application updates certain opportunity and product line attributes based on the values of other
attributes. The attributes that the application synchronizes or updates automatically are:

• Win probability

• Close date

• Include in forecast setting

• Status

• Win/loss reason

• Competitor

Note:  An attribute is said to be synchronized if its opportunity and product line values are the same, and if the
product line is in the same status category as its opportunity. If a product line and its opportunity both have
undefined values, they're considered to have the same value.

Synchronization of Opportunity and Product Line Attribute
The application synchronizes certain product line attributes based on the opportunity-level attribute, under certain
conditions.

Synchronization occurs for these attributes:

• Win probability

• Close date

• Include in forecast setting

• Status (not status category)

Here is an example of close date synchronization:

• An opportunity with an Open status category has a close date of July 14, 2018.

• Product lines 1, 2, and 3 have the same close date and they're in the same status category.

703

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20049835
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20051179
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035520


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 24
Opportunity Products and Revenue

• Product line 4 has a different close date, but the same status category.

• The close date of the opportunity is changed to August 14, 2018. The application automatically sets the close
dates of product lines 1, 2, and 3 to the same close date as that of the opportunity. The close date of product
line 4 remains unchanged, because it has close date that wasn't already synchronized with the date of the
opportunity.

Opportunity Status Updates
These scenarios explain what happens when the opportunity status is updated. Note that status values display in
alphabetic order on the UI.

• Opportunity status is updated to a Won status:

◦ The application updates the opportunity win probability to 100 percent. It also updates all synchronized
product lines' win probability to 100 percent.

• Opportunity status is updated to a Lost or No Sale status:

◦ The application updates the opportunity close date to the current date. It doesn't update the close date
on synchronized product lines.

• Opportunity status is updated from an Open status to a Closed status:

◦ The application enables the opportunity win/loss reason attribute.

◦ If an opportunity primary competitor has been defined, the application updates the product line
competitor to the opportunity primary competitor for all opportunity product lines, if they aren't already
defined. This action applies only to the close opportunity and mass update opportunities flows.

• Opportunity status is updated from a Closed status to an Open status:

◦ The application disables the opportunity win/loss reason attribute.

◦ The application sets the opportunity win/loss reason attribute to "undefined". It doesn't update the win/
loss reason on synchronized product lines.

Product Line Status Updates
These scenarios explain what happens when the product line status is updated:

• Product line status is updated to a Won status: The application sets the product line win probability to 100
percent.

• Product line status is updated to a Lost or No Sale status: The application sets the product line close date to the
current date.

• Product line status is updated to a Closed status: The application enables the product line win/loss reason
attribute.

• Product line status is updated to an Open status:

◦ The application disables the product line win/loss reason attribute.

◦ The application updates the product line win/loss reason attribute to "undefined".
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Opportunity Win/Loss Reason Updates
When an opportunity is in an Open status, the opportunity win/loss reason attribute is disabled. Win/loss reason
is activated when the opportunity is set to a Closed status. When the opportunity win/loss reason is updated, the
application updates all opportunity product lines where the win/loss reason attribute is synchronized.

Note:  If the opportunity line item status is set to inactive, then Reason field is editable in the List view so that you
can include a reason why the line item isn't active. However, the Reason field isn't editable on the Form view of the
Opportunity Line Item. This is expected behavior due to the difference in the page structure. The edit page from the
List view has a table view for Revenues, while the Form page has a form view and is therefore not editable.

Opportunity and Product Line Competitor Updates
If a primary competitor has been defined at the opportunity level, when the opportunity status changes from an Open
status to a Closed status, the application updates the product line competitor to the primary competitor for all lines that
don't already have a competitor.

Tip:  If a product line without a competitor is set to closed and the opportunity is saved, the application displays a
dialog box that lets you copy the opportunity primary competitor to the product lines without competitors.

This action applies only to edit opportunity and close opportunity flows. It doesn't apply to the mass update flow.

Related Topics
• Set Opportunity Revenue Forecast Criteria

• Example of Product Line Synchronization with Win Probability

Add Attributes for Opportunity Summary and Revenue Lines
Synchronization  
You can enhance and perform opportunity summary and revenue line synchronization for some attributes using Groovy
scripting. Use the sample scripts in this topic to add rule definitions to the predefined opportunity cascading logic.

The rule definitions keep opportunity summary and revenue lines in synchronization with each other. Here's how to add
specific attributes for opportunity summary and revenue lines synchronization:

1. Sign in as a sales administrator or a setup user.
2. Navigate to Application Composer.
3. Select Sales to filter the object search.
4. Expand Standard Objects and then expand Opportunity.
5. Under Opportunity, click Server Scripts.

The Server Scripts Help Request page opens.
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6. Under Validation Rules tab, select Action - Add  under the Field Rules region and enter values as shown in the
following example:

Field Value

Field Name
 

Choose the field or attribute that you want from the drop-down list of values.
 

Rule Name
 

Enter a meaning full name for the rule.
 

Error Message
 

Enter a user-defined error message, for example, a message that warns the user the
synchronization cascade has failed.
 

Rule Definition
 

In the script text field, cut and paste the script that you have written to validate the condition.
For example, see the sections Sample Groovy Scripts for Opportunity Attributes and Sample
Groovy Scripts for Opportunity Revenue Attributes in this topic for sample groovy scripts.
 

7. Click Save and Close.
For a more detailed explanation of Groovy scripting using Application Composer, see the Oracle Applications Cloud
Groovy Scripting Reference.

Sample Groovy Scripts for Opportunity Attributes
This table contains sample groovy script code for a subset of opportunity attributes:

Attribute Sample Groovy Script

Close Date
 

cascadeInSyncValueToAllRevenues("EffectiveDate", oldValue, newValue)

return true

Status and StatusCodeSetId
 
 
 
Both the Status and StatusCodeSetId
attributes have to be assigned together.
If you decide to selectively enable
synchronization cascade for Status, then
you must also perform synchronization
cascade for StatusCodeSetId.
 

// For Status def cache_name = '_statuscode_insync_cascade' 
if (oldValue == 'OPEN' && newValue == 'WON') 
{
// Only allow synchronization cascade if Status moved from OPEN to WON. 
cascadeInSyncValueToAllRevenues("StatusCode", oldValue, newValue) 

// Mark this opportunity's StatusCode as having been synchronization cascaded 
adf.userSession.userData.put(getAttribute('OptyId') + cache_name, true)
// mark this opportunity as having status just cascaded. 
}
return true

// For StatusCodeSetIddef cache_name = '_statuscode_insync_cascade'def insync_
cascade = adf.userSession.userData[getAttribute('OptyId') 
+ cache_name]println("StatusCodeSetId: insync_cascade = " 
+ insync_cascade)insync_cascade = (insync_cascade == null) ? false : insync_
cascade 
// ensure insync_cascade is either true/false try 

{ 
if (insync_cascade) 
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Attribute Sample Groovy Script

 {
cascadeInSyncValueToAllRevenues("StatusCodeSetId", oldValue, newValue) 
// only cascade if the Status has just been cascaded. 
 }
}
Finally
{ adf.userSession.userData.remove(getAttribute("OptyId") + cache_name)
}
return true

Win/Loss and ReasonWonLostCodeSetId
 

// For Win/Loss Reasondef cache_name = '_winlossreason_insync_cascade'if
 (oldValue == 'INSTALL_BASE' && newValue == 'TEST_VO_1') 
{ cascadeInSyncValueToAllRevenues("ReasonWonLostCode", oldValue, newValue) 
// Mark this opportunity's WinLossReason as having been synchronization
 cascaded adf.userSession.userData.put(getAttribute('OptyId') 
+ cache_name, true)}return true
// For ReasonWonLostCodeSetIddef cache_name = '_winlossreason_insync_
cascade'def insync_cascade = adf.userSession.userData[getAttribute('OptyId') 
+ cache_name]println("ReasonWonLostCodeSetId: insync_cascade = " 
+ insync_cascade)insync_cascade = (insync_cascade == null) ? false : insync_
cascade 

// ensure insync_cascade is either true/falsetry 
{
 if (insync_cascade)
 { cascadeInSyncValueToAllRevenues("ReasonWonLostCodeSetId", oldValue,
 newValue) 
 }
}finally
{ 
adf.userSession.userData.remove(getAttribute("OptyId") + cache_name)
}
return true

Primary Partner
 

cascadeInSyncValueToAllRevenues("PrimaryPartnerId", oldValue, newValue)

return true

Primary Competitor
 

cascadeInSyncValueToAllRevenues("PrimaryCompetitorId", oldValue, newValue)

return true

Sample Groovy Scripts for Opportunity Revenue Attributes
Let's look at sample groovy script code for a subset of opportunity revenue attributes.

Attribute Sample Groovy Script

Win Probability
 

cascadeInSyncValueToAllRevenues("WinProb", oldValue, newValue) 
return true

Sales Channel
 

cascadeInSyncValueToAllRevenues("SalesChannelCd", oldValue, newValue)
return true
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Attribute Sample Groovy Script

Include Forecast
 

cascadeInSyncValueToAllRevenues("SalesChannelCd", oldValue, newValue)
return true

Related Topics
• Opportunity and Product Line Attributes Synchronization

• How can I disable opportunity to revenue line synchronization logic?

Add Status Categories for Open Revenue  
You can specify additional revenue line status categories to include when the application calculates opportunity
amount. By default, the application only includes revenue lines in Open status when calculating the opportunity
summary amount.

However, you can include, for example, both won and open lines by modifying the lookup type, Open Opportunity
Rollup Status Mapping.

Here's how to modify the Open Opportunity Rollup Status Mapping lookup type:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Standard Lookups

2. In the Manage Standard Lookups page, enter Open Opportunity Rollup Status Mapping in the Meaning field. The
lookup type code, which you can search for in the Lookup Type field, is ORA_MOO_OPEN_ROLLUP_MAPPING.

3. Add the new lookup code. For example, add a code called WON.

◦ Use Enabled to enable or disable a specific lookup code.

◦ Update the meaning (display name), start date, end date, or display sequence of any of the predefined
values.

◦ Add or remove lookup codes, as long as they follow the correct lookup code formatting.

Note:  The OPEN category can't be modified.

4. Click Save and Close.

After you make the changes, the opportunity summary amount calculation will include all revenue lines in OPEN status
category, as well as any other status categories you have added and enabled.

Related Topics
• Overview of Lookup Types
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FAQs for Opportunity Products and Revenue  

Frequently Asked Questions (FAQs) for Opportunity Products and
Revenue  
This section contains the most frequently asked questions (FAQs) when setting up and maintaining opportunity
products and revenue. Scroll or search to find answers to common questions.

Why can't I see REST API revenue line updates in opportunities?  
If a salesperson creates or updates a revenue line in the Opportunities UI and you also create or update the same record
using a REST API, then the last record accessed is temporarily held in a storage area as cached data.

This means that the more recent REST API update to the same revenue line record isn't displayed on the Opportunities
UI. To get around this issue, close and open the opportunity page after you complete your REST API revenue line record
updates.

How can I disable opportunity to revenue line synchronization
logic?  
By default, opportunity cascading logic keeps opportunity summary and revenue lines in synchronization with each
other.

If you no longer want opportunity summary and revenue lines to be synchronized, open the Opportunity
Synchronization Cascade Enabled profile option (MOO_ENABLE_INSYNC_CASCADE) and set the value to N. Note that
you can enhance and perform opportunity summary and revenue line synchronization for some attributes using Groovy
scripting if you choose to disable the predefined opportunity summary and revenue lines synchronization.

What's the maximum number of Opportunity revenue lines for
one opportunity?  
The maximum number of Opportunity revenue lines is 500.
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How can I reduce the number of revenue lines generated for
forecasting purposes?  
Recurring revenue line items can be aggregated into a single line item with a single close date for forecasted recurring
revenue. This means that you can view pipeline forecasts using a single opportunity close date and reduces complexity
while maintaining performance.

By setting the profile option, Recurring Revenue Forecast Type (ORA_MOO_REV_RECUR_FORECAST), you can control
whether to:

• Forecast revenue lines based on every single schedule occurrence (default)

• Aggregate multiple recurring revenues lines to a single close date (Opportunity Close Date).

This means that only a single revenue line is required to calculate the total value for pipeline forecasts.

To learn how to change the default value, see the related topic.

Related Topics
• Modify the Recurring Revenue Forecast Type Profile Option
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25  Competitors

Overview of Sales Competitors  
Use the sales competitors pages to store information about the sales competition. As a sales administrator, you create
the competitor profiles. Salespeople then can associate competitors with opportunities, associate product groups with
competitors, and view competitor details.

The key features of managing competitors include the following:

• Competitor profile: Store several aspects of competitor companies, such as name, URL, threat level, and
industries and geographies where the competitors are doing business.

• Internal experts: Associate with competitors people from your company who are considered experts about the
associated competitor.

• Collateral: Attach relevant competitor documents. After you store them, salespeople can access the competitive
collateral to position products or solutions against competitors.

• Competitors in opportunities: Associate competitor information with opportunities, both at the opportunity
level and at the product-line level. After salespeople associate a competitor with an opportunity, the competitor
profile shows opportunities where the competitor is present.

• Notes: Create free-form notes about the competitor.

• Revenue at stake: The competitor profile displays revenue at stake, which is potential opportunity revenue
where the competitor is present.

• Analytics and reports: Access several analytics and reports around competitor data, such as win/loss trends.
See the sales Creating and Administering Analytics guide for more information on reports and analytics.

Note:  A competitor is an Account with Competitor party usage. Thus, every time a competitor is created or updated,
servers scripts run, as defined for the Account object. If you don't want the account triggers to execute during the
competitor flow, then adjust the Groovy server scripts in the Account object to not execute in the case of Competitor
party usage.

Related Topics
• Manage Sales Competitors

• Set the Close Opportunity Profile Options

Manage Sales Competitors  
As a sales administrator, you create and maintain information on sales competitors. After you set up the initial
competitor record, sales teams can add competitors to opportunities and product revenue lines. Downstream analytics
help teams see how well they competed.
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Create a Competitor
Here's how you create a competitor:

1. Navigate to Sales > Competitors.
2. Click the Create icon.
3. In the Create Competitor page, enter or select values. Use the information in this table to guide you:

Field Description

Organization Name
 

Name of the competitor.
 

Name Suffix
 

Value appended to the name of the Organization Name for the competitor.
 

Chief Executive Name
 

Name of the competitor company's chief executive officer or highest-level employee.
 

Line of Business
 

Line of business of the competitor company's products.
 

D-U-N-S Number
 

Dun & Bradstreet Corporation unique nine-digit identification number for the competitor
company.
 

Organization Size
 

Size of the competitor company.
 

Year Established
 

Year the competitor company was first started.
 

Threat Level
 

Perceived threat level of the competitor in closing deals, such as low, medium, and high.
 

Year Incorporated
 

Year the competitor company was first incorporated.
 

Stock Symbol
 

Stock symbol for the competitor company in the financial markets.
 

Fiscal Year End Month
 

Month that the competitor company closes its fiscal year.
 

Dun & Bradstreet Corporation Credit
Rating
 

Credit rating of the competitor company with Dun & Bradstreet Corporation.
 

Privately Owned
 

Indicates the competitor company is privately owned.
 

Minority Owned
 

Indicates that the competitor company is minority owned.
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Field Description

Small Business
 

Indicates that the competitor company is a small business.
 

Status
 

Status of the competitor record, either active or inactive.
 

4. Save your changes.

Note:  Upon saving, if you get an error that a matching company has been found in the application, then
respond to the dialog box by either merging this record with the existing one or creating a new organization
in the application.

Enter SWOT for a Competitor
You can assign strength, weakness, opportunity, and threat (SWOT) levels for competitors. Recording and reviewing
SWOT levels helps you understand, plan, and craft an effective competitive strategy when facing a competitive threat on
a deal.

Here's how you enter SWOT information for a competitor:

Tip:  You can edit SWOT values after you save them.

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, add a new row to the SWOT table by clicking the add icon or selecting Add Row

from the Actions menu.
4. In the new table row, select or enter the SWOT information:

Field Description

Type
 

Indicates the type of SWOT value, such as a threat or weakness.
 

Description
 

Used to describe the type of SWOT.
 

Comments
 

Additional comments for the SWOT value.
 

5. Save your changes.

View Competitor Opportunities
After salespeople associate a competitor with an opportunity while editing or closing it, the opportunities are
automatically added to the competitor profile. The list of opportunities in a competitor's profile is a consolidated view of
past and current opportunities where the competitor is present. The opportunity data provides you with useful insight
to plan appropriate sales strategies.
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Here's how you view competitor opportunities.

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, click the Opportunities tab. The Opportunities table shows all opportunities where

the competitor is present.

Add Attachments to a Competitor
Attachments let you provide additional details about the competitor.

Here's how to attach files, text, or URLs to a competitor record:

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, click the Attachments tab.
4. In the Attachments table, add a new table row by clicking the add icon or selecting Add Row from the Actions

menu.
5. In the new table row, select or enter the following values:

Field Description

Type
 

Indicates the type of attachment, either a file, free-form text, or a URL.
 

File Name or URL
 

◦ If you selected File as the type, you can browse to the file on your computer.

◦ If you selected Text as the type, use to enter free-form text.

◦ If you selected URL as the type, use to enter the URL of the competitor's web site.

Title
 

Title of the attachment.
 

Description
 

Description of the attachment.
 

6. Save your changes.

Associate Internal Experts with a Competitor
Internal experts are people in your company who are experts on a competitor. They can help you work with the
competitor to close deals.

Use the following procedure to associate internal experts with a competitor.

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, click the Internal Experts tab.
4. In the Internal Experts table, add a new table row by clicking the add icon or selecting Add Row from the

Actions menu.
5. In the Search and Select: Internal Expert dialog window, search for and select the person.
6. In the search dialog window, click Apply and then Done.
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7. Save your changes. The table displays the details of the internal expert, such as his e-mail address and phone
number.

Associate Geographies or Industries with a Competitor
You can associate geographical locations, such as a country, with a competitor in order to record additional information
about a competitor. The stored geographies are locations where the competitor is present. The available geographical
locations are those that are defined in your application. You also can store the industries where the competitor
competes with your company. The available industries are those that are defined in your application.

Use the following procedure to associate geographies or industries with a competitor.

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, click the Geographies tab. Or, if entering industries, click the Industries tab.
4. In the table, add a new table row by clicking the add icon or selecting Add Row from the Actions menu.
5. Search for and select the geographical location or industry.
6. In the search dialog window, click OK.
7. Save your changes.

Add Notes to a Competitor Profile
You can add free-form notes to a competitor profile. Here's how:

1. Navigate to Sales > Competitors.
2. In the list, select the name of the competitor.
3. In the Edit Competitor page, in the Notes area, click the create icon.
4. Enter the free-form note and save your changes.

Related Topics
• Enable Competitors in Opportunities

• Overview of Sales Competitors

• Overview of Sales Competitors

Enable Competitors in Opportunities  
Salespeople can manage competitors within opportunities after you expose some UI elements using Application
Composer.

Here are the UI elements you can expose in opportunities to support managing competitors. Note that all of these UI
elements are hidden by default.

• Competitors subtab: Enable the Competitors subtab within the Edit Opportunity page.

• Primary Competitor or Competitors field: Enable the Primary Competitor or Competitors fields in the Edit
Opportunity page. Note you likely want to enable either the Competitors subtab or the Primary Competitor
field, but not both at the same time.

• Product-line-level Competitors field: Add the Competitors column to the Products table within the Edit
Opportunity page.
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For more information about how salespeople manage competitors, see the related topics.

Add the Competitors Subtab to the Edit Opportunity Page
Here's how to add the Competitors subtab to the Edit Opportunity page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under Standard Objects, navigate to Opportunity > Pages.
4. In the Opportunity: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
6. Type a new layout name and click Save and Edit. The Details Layout page appears.
7. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon. The Configure Subtabs dialog box

appears.
8. Move Competitors from the Available Subtabs to the Selected Subtabs window.
9. Click OK.

10. Back in the Details Layout page, click Done.
11. Be sure that the layout status for your user-defined layout is Active.
12. Validate the change by navigating to the edit opportunity page as a sales user, such as a salesperson, and

ensure that you can see the Competitors subtab in the Edit Opportunity page.
13. Publish the sandbox following your company's practices.

Add Competitor Fields to the Edit Opportunity Page
Here's how to add either the Competitors or Primary Competitor fields to the Edit Opportunity page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under Standard Objects, navigate to Opportunity > Pages.
4. In the Opportunity: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, select the Standard Layout in the table and then click the Duplicate icon.

The Duplicate Layout dialog box appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

6. Enter a name for the new layout and click Save and Edit. The application returns you to the edit page for the
new layout.

7. In the Summary region, click the edit icon.
8. In the Details Layout: <Layout>: Edit Summary page, find the Competitors field or the Primary Competitor

field in the Configure Detail Form region. Move the field from the Available Fields window to the Selected Fields
window.

Tip:  You may see duplicate fields in the list. Hover over them to see the hover text. For Primary Competitor,
select the one whose hover text reads PrCmptPartyId. This way you ensure that the Primary Competitor field
is editable and allows salespeople to select different competitors for different product lines. If you don't want
users to be able to set different competitors on product lines, then enable the other Competitor field (with the
hover text Party Name1).

9. Click Save and Close.
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10. Validate the change by navigating to the edit opportunity page as a sales end user, such as a salesperson, and
ensuring that you can see the applicable field in the edit page.

11. Publish the sandbox following your company's practices.

Add the Competitor Column to the Products Table
Here's how to add the Competitor column to the opportunity Products table.

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under Standard Objects, navigate to Opportunity > Pages. The Opportunity: Pages page appears.
4. In the Opportunity: Pages page, ensure that the Simplified Pages tab is active.
5. In the Details Page Layouts region, select the Standard Layout in the table and then click the Duplicate icon.

The Duplicate Layout dialog box appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

6. Enter a name for the new layout and click Save and Edit. The application returns you to the edit page for the
new layout.

7. In the Edit Revenue Table region, click the edit icon.
8. In the Details Layout: <Layout>: Edit Revenue Table, find the Competitor field in the Configure Summary Table

window. Move the field from the Available Fields window to the Selected Fields window.

Tip:  You may see duplicate fields in the list. Hover over them to see the hover text. For Primary Competitor,
select the one whose hover text reads PrCmptPartyId. This way you ensure that the Primary Competitor field
is editable and allows salespeople to select different competitors for different product lines. If you don't want
users to be able to set different competitors on product lines, then enable the other Competitor field (with the
hover text Party Name1).

9. Click Save and Close.
10. Validate the change by navigating to the edit opportunity page as a sales end user, such as a salesperson, and

ensuring that you can see the Competitor field in the Products table.
11. Publish the sandbox following your company's practices.

Related Topics
• Overview of Sales Competitors

• Associate Competitors with Opportunities

Enable Competitors in Leads  
Salespeople can manage competitors within leads after you expose some UI elements using Application Composer.

Here are the UI elements you can expose in leads to support managing competitors. Note that all of these UI elements
are hidden by default.

• Competitors subtab: Enable the Competitors subtab within the Edit Lead page.

• Primary Competitor field: Enable the Primary Competitor field in the Edit Lead page. Note you likely want to
enable either the Competitors subtab or the Primary Competitor field, but not both at the same time.
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For more information about how salespeople manage competitors, see the related topics.

Add the Competitors Subtab to the Edit Lead Page
Here's how to add the Competitors subtab to the Edit Lead page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under Standard Objects, navigate to Sales Lead > Pages.
4. In the Sales Lead: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
6. Type a new layout name and click Save and Edit. The Details Layout page appears.
7. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon. The Configure Subtabs dialog box

appears.
8. Move Competitors from the Available Subtabs to the Selected Subtabs window.
9. Click OK.

10. Back in the Details Layout page, click Done.
11. Be sure that the layout status for your user-defined layout is Active.
12. Validate the change by navigating to the edit opportunity page as a sales user, such as a salesperson, and

ensure that you can see the Competitors subtab in the Edit Lead page.
13. Publish the sandbox following your company's practices.

Add Competitor Fields to the Edit Lead Page
Here's how to add the Primary Competitor field to the Edit Lead page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer.
3. Under Standard Objects, navigate to Sales Lead > Pages.
4. In the Sales Lead: Pages page, ensure that the Application Pages tab is active.
5. In the Details Page Layouts region, select the Standard Layout in the table and then click the Duplicate icon.

The Duplicate Layout dialog box appears.

Note that you may be using a different layout than the default one. If this is the case, then select the
appropriate layout.

6. Enter a name for the new layout and click Save and Edit. The application returns you to the edit page for the
new layout.

7. In the Summary region, click the edit icon.
8. In the Details Layout: <Layout>: Edit Summary page, find the Primary Competitor field in the Configure Detail

Form region. Move the field from the Available Fields window to the Selected Fields window.
9. Click Save and Close.

10. Validate the change by navigating to the edit lead page as a sales end user, such as a salesperson, and ensuring
that you can see the applicable field in the edit page.

11. Publish the sandbox following your company's practices.

Related Topics
• Overview of Sales Competitors

• Associate Competitors with Opportunities
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26  Quotes and Orders

About Integrating With Quotes  
You can integrate with Oracle Configure, Price, and Quote (Oracle CPQ) to enhance sales processes in an automated
opportunity-to-quote-to-order flow. Quotes let your sales team members create professional proposal documents for
customers that include current product and pricing information.

Salespeople can create quotes from an opportunity as part of a deal cycle or directly for an account. Basic quote
information, such as quote number, quote amount, status, and proposal documents are captured in the quotes and
orders pages. Salespeople can view the quotes and orders in the context of an account or an opportunity. Salespeople
use quotes to select valid product configurations based on customer needs, to specify pricing and discounts, and to
create professional proposal documents. Here's a summary of the features provided with the quoting integration:

• Create valid product configurations

• Perform automated pricing calculations

• Apply discounts

• Streamline approval processes

• Create professional proposal documents to share and collaborate with customers to close a deal

The integration is point-to-point, with most of the setup involving editing the end points for each integration touch
point. Oracle CX Sales initiates and controls all user interactions. The Oracle CPQ UIs display as embedded iFrames
running within CX Sales. Conversely, all web service integrations use web services provided by CX Sales that are invoked
by Oracle CPQ Cloud.

For more information on how to enable the integration, see the related topic and the additional details in the Integrating
Oracle CX Sales with Oracle CPQ guide.

Related Topics
• Configure the Navigator and Page Entries on the Home Page for Navigation

• How is the number of open quotes on the Quotes and Orders summary box calculated?

Setup Tasks  

Set Up Point-to-Point Integration for Quotes and Sales Orders  
The integration between Oracle CX Sales and Oracle CPQ supports standard B2B selling processes, which feature highly
configurable products; variable or dynamic pricing models; discount negotiations requiring executive approval; and
large, branded sales documents.

The addition of Oracle CPQ to CX Sales ensures that sales forecasts are reliable and based on real-world quotes. It
ensures that sales orders are valid and contain the correct billing and shipping details to eliminate costly change orders.

719

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20050717
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20075350


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 26
Quotes and Orders

Additionally, the quote data can be fed back into CX Sales so that the business can effectively analyze and improve the
overall efficiency of their sales team.

For more information about how to enable the integration, see the Integrating Oracle CX Sales with Oracle CPQ guide.

Related Topics

Enable the Quotes UI Elements  
Use the Structure page to enable the UI elements of the quotes integration.

The UI elements include:

• The Quotes and Orders icon on the springboard

• The Quotes and Orders link in the Navigator

• The Quotes and Orders landing page

Salespeople click Quotes and Orders in the Navigator or springboard to launch the Quotes and Orders landing page.
The quotes landing page shows a salesperson's list of relevant quotes, based on the default search. Salespeople can
search for quotes from the quotes landing page or from the global search.

To enable the Quotes and Orders UI elements:

1. Sign in as the sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Configuration > Structure.
4. In the Navigation Configuration page, select Quotes and Orders under the Sales section.
5. In the Edit Page Entry: Quotes and Orders page, select Yes for the Show on Navigator and Show on Springboard

options.
6. Click Save and Close.
7. Publish the sandbox.

Enable Quotes by User Role
You can enable access to quotes by user role. Enable the Quotes and Orders icon for each user role using the Structure
page. See the related topics for more information.

Related Topics
• Overview of Configuring Home Page and Navigation

• Configure the Navigator and Page Entries on the Home Page for Navigation

• Edit and Reorder Groups and Page Entries for Navigation

• Examples of EL Expressions

Configure the Actions Menu for Quotes  
Configure the Quotes action menus, such as disabling actions or removing actions altogether. The action menus show
up in quote lines in the Edit Opportunity and Edit Account Quotes and Orders subtabs.
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You can use either lookup types or Groovy scripting to make the changes.

You must configure the Oracle Configure, Price, and Quote (Oracle CPQ) Action Menu Control lookup to control the
display of options in the Actions menu. Set the value to Yes for these codes and enable the lookup type codes.

Lookup Type Meaning Description

ORA_ZCA_CPQ_ACTION
 

CPQ Action Menu Control
 

Consists of codes that you select to control the
display of CPQ options in the Actions menu.
 

Lookup Codes
 

ORA_ZCA_CPQ_ACTION_EDIT
 

Edit command in the CPQ action menu
 

This lookup option maps to the Edit command
in the CPQ Actions menu.
 

ORA_ZCA_CPQ_ACTION_DUPLICATE
 

Duplicate command in the CPQ action menu
 

This lookup option maps to the Duplicate
command in the CPQ Actions menu.
 

ORA_ZCA_CPQ_ACTION_NEW_VERSION
 

Create Version command in the CPQ action
menu
 

This lookup option maps to the Create Version
command in the CPQ Actions menu.
 

Here's how to control the display of Oracle CPQ options in the Actions menu.

1. Navigate to the Manage Standard Lookups task in Setup and Maintenance.
2. Search for the CPQ Action Menu Control in the Meaning lookup type.
3. Set the order of the values to the order in which you want them to appear in the Actions menu.
4. Select the Enabled check box.

Use a Groovy Script
You can also use the cpqActionMenuPreRender Groovy script to implement complex business logic that enables or disables
the menu items. Create this script within SalesOrder object, Object Functions section. Here's how to create the function:

1. Ensure you're working in an active sandbox.
2. Click Navigator  > Configuration  > Application Composer .
3. Navigate to Sales Orders in Standard Objects.
4. Expand Sales Orders.
5. Click Server Scripts.
6. Click Object Functions.
7. Click Add in the Action drop-down list.
8. In the Create Object Function enter the following:

Field Details

Function Name
 

cpqActionMenuPreRender
 

Returns
 

Map
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Field Details

Edit Script
 

def menuItemsMap = [ORA_ZCA_CPQ_ACTION_EDIT:'N',ORA_ZCA_CPQ_ACTION_NEW_

VERSION:'Y',ORA_ZCA_CPQ_ACTION_DUPLICATE:'Y']return menuItemsMap;

 

9. Click Save and Close.
10. Test your changes. Go to the Opportunity list page, open a record, click the Quotes and Orders subtab, and

check the Actions drop-down list in the quotes row.

Disable Oracle CPQ Menu Items
The procedure explains how to disable the Create Oracle CPQ menu item for a specific sales order using sales order
attributes from groovy function. Here's how you can use your Groovy script and disable a create Oracle CPQ menu item.

1. Ensure you're working in an active sandbox.
2. Click Navigator  > Configuration  > Application Composer .
3. Navigate to Sales Orders in Standard Objects.
4. Expand Sales Orders.
5. Click Server Scripts.
6. Click Object Functions.
7. Click the Create icon to add a new object function.
8. In the Create Object Function page, do as follows:

a. Enter cpqActionMenuPreRender in the Function Name field.
b. Select Map in the Returns field.
c. Enter this script in the Edit Script field:

def editDisabled = 'N';
def duplicateDisabled = 'N';
def createVersionDisabled = 'N';
if(Name.equals('Quote1')){
createVersionDisabled = 'Y';
}
def menuItemMap = ['ORA_ZCA_CPQ_ACTION_DUPLICATE':editDisabled,
 'ORA_ZCA_CPQ_ACTION_EDIT':duplicateDisabled,ORA_ZCA_CPQ_ACTION_NEW_VERSION :
 createVersionDisabled];
return menuItemMap;

9. Click Save and Close.
10. Create an opportunity and post sales order using REST.
11. Test your changes. Drill down to the opportunity you created and click Quotes and Order subtab and verify that

the Create Version menu item is disabled for sales order named Quote1.

Set Up Reconciliation of Revenue Lines from Quote Lines  
When your users activate a quote from the sales application, reconciliation of revenue lines and quote lines is triggered.
Reconciliation is the process of rolling up information from quote line into revenue lines.

Quote line information used for configuration of a product is summarized and presented in a roll up view in revenue
lines based on the setup you do.
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Here are the steps involved in the setup:

1. Enable the profile option, ORA_MOO_REVN_RECONCILE_FROM_SO.
2. Set the reconcile option for quote lines to Root or Part.
3. Optionally, you can review the opportunity lock time used during the reconciliation process.
4. Map the attributes of CX Sales and Oracle CPQ to synchronize revenue lines from quote lines.

The first three of these steps are included in this topic. For the step 4, see the topic: Map CX Sales and Oracle CPQ
Attributes to Synchronize Revenue Lines from Quote Lines.

Step 1: Enable the Profile Option
Here are the steps:

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option code,
ORA_MOO_REVN_RECONCILE_FROM_SO. The default value of Site is set to No.

3. Change the profile value to Yes and save the changes.
4. Sign in again for the changes to take effect.

Step 2: Set the Reconcile Option for Quote Lines
You have two types of reconcile options for quote lines: Root and Part. If you sell several standalone parts in your
business, then the recommendation is to choose Part. Alternatively, if you sell configured products, such as laptops,
the recommendation is to choose Root. As an Oracle CPQ administrator, decide on the option during the analysis and
implementation phase and set it to Root or Part based on the business need.

Note:   We recommend that you don't change the reconcile option once set. If you do so, you will lose all the previous
data and can't retrieve it.

Here are the steps:

1. In the Setup and Maintenance work area, use the Manage Oracle CX Sales to Oracle CPQ Cloud Integration
task.

◦ Offering: Sales

◦ Functional Area: Integration

◦ Task: Manage Oracle CX Sales to Oracle CPQ Cloud Integration

2. In the Manage Oracle CX Sales to Oracle CPQ Cloud Integration page, under the Revenue Reconcile Option
column to the right of the page, select Root or Part.

3. Save and close the task.
4. Sign in again for the changes to take effect.

Step 3 (Optional): Review Opportunity Lock During Reconciliation
When a salesperson sets a quote as active, the sales application triggers the reconciliation of revenue lines from quote
lines. During this time, the opportunity is locked so that the user doesn't accidentally change anything. By default, this
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lock is set to 120 seconds. If the reconciliation process takes longer than 120 seconds, the lock continues for the next 120
seconds, and so on, until the reconciliation process ends.

The ORA_MOO_OPTY_LOCK_RELEASE profile option controls this lock time. You can change the default time, if
needed. Here are the steps:

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option code,
ORA_MOO_OPTY_LOCK_RELEASE. The default value of Site is set to 120 seconds.

3. If you're changing this value, save your changes and sign in again for the changes to take effect.

Related Topics
• Make Quotes Active without Navigating to Oracle CPQ

CX Sales and Oracle CPQ Attributes Mapping to Synchronize
Revenue Lines from Quote Lines  
As the final step in setting up the reconciliation of revenue lines from quote lines, verify the mapping of CX Sales and
Oracle CPQ attributes.

Here are the steps to verify your default mapping:

1. In the Setup and Maintenance work area, use the Manage Oracle CX Sales to Oracle CPQ Cloud Integration
task.

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Oracle CX Sales to Oracle CPQ Cloud Integration

2. On the Manage Oracle CX Sales to Oracle CPQ Cloud Integration page, go to the Quote Line to Revenue Line
Mapping tab.

3. Verify that the default mapping of CX Sales and Oracle CPQ attributes is intact. Refer to the table here for the
standard mapping:

Revenue Attribute Name (CX Sales) Quote Lines Attribute Name (Oracle CPQ)

InventoryOrgId
 

InventoryOrgId
 

InventoryItemId
 

InventoryItemId
 

UnitPrice
 

UnitListPrice
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Revenue Attribute Name (CX Sales) Quote Lines Attribute Name (Oracle CPQ)

Discount
 

DiscountPercentage
 

Quantity
 

Quantity
 

UOMCode
 

UOMCode
 

NonRecurringRevenue
 

NonRecurringRevenue
 

RecurringRevenue
 

RecurringRevenue
 

UsageRevenue
 

UsageRevenue
 

RevnAmount
 

ContractValue
 

MonthlyRecurringRevenue
 

MonthlyRecurringRevenue
 

MonthlyUsageRevenue
 

MonthlyUsageRevenue
 

ContractStartDate
 

ContractStartDate
 

ContractEndDate
 

ContractEndDate
 

RecurStartDate
 

ContractStartDate
 

RecurEndDate
 

ContractEndDate
 

RevnAmountCurcyCode
 

CurrencyCode
 

RecurFrequencyCode
 

PricePeriodCode
 

RecurNumberPeriods
 

ContractPeriods
 

4. If you have made any changes, save them.
5. Sign in again for the changes to take effect.
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Show Price Type on Opportunity Product (Revenue) Lines  
The Price Type in quotes gives you an idea about the category of your pricing. Typically, quote lines can have three
kinds of price types: "one-time", "recurring" and "usage". Example of a one-time price type is an installation charge.

Similarly, monthly subscriptions are an example of a recurring price type. Usage price type is applied to quote lines
that are priced based on consumption. You can set up the application to retrieve the Price Type of quote lines during
reconciliation and show it on product (revenue) lines in opportunities. At the end of a successful reconciliation, if all
of your quote lines are one-time, then the product lines show in the Price Type column as One-time. Similarly, after
reconciliation, quote lines with recurring or usage Price Type are shown as Recurring and Usage, respectively, in the
Products table. However, if your quote lines have different price types, then, on reconciliation, product lines show Price
Type as Mixed, indicating that the quote lines have combinations of one-time, recurring, or usage price types.

To show the price type on the revenue lines, enable the profile option, ORA_MOO_REVN_RECUR_PRICETYPE, and
add the Price Type field to the Opportunity Products (revenue) table and Recurring Schedule pages using Application
Composer.

Enable the Profile Option
Here are the steps:

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option code,
ORA_MOO_REVN_RECUR_PRICETYPE. The default value of Site is set to No.

3. Change the profile value to Yes and save the changes.
4. Sign in again for the changes to take effect.

Add the Price Type Field to Opportunity Pages
Here are the steps to add the Price Type field to the opportunity Products table in the Edit Opportunity page:

1. Ensure you're working in an active sandbox.
2. Go to Configuration > Application Composer > Standard Objects > Opportunity > Pages > Details Page

Layouts.
3. Click the edit icon in the Edit Revenue Table of a detail page layout.
4. Move Price Type from Selected Fields to Available Fields.
5. Save your changes.
6. Publish your sandbox.
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Enable Revenue Attributes for Revenue Lines and Workspace
Search  
For salespeople, revenue attributes such as the recurring revenue can be very valuable information when reviewing the
opportunity revenue lines. They can also use these attributes as filters to search for opportunities in Workspace.

Complete these setups to let your salespeople use them effectively:

• Enable the opportunity revenue attributes on the opportunity revenue lines.

• Add the attributes as filters in Workspace.

Enable the Attributes on Opportunity Revenue Lines

1. Navigate to Configuration > Application Composer > CRM Cloud Application > Standard Objects >
Opportunity > Opportunity Revenue > Pages.

2. Duplicate the standard layout of the Details page layout.
3. Click the Edit icon beside Revenue Edit Form.
4. Move the following attributes from Available Fields to Selected Fields:

◦ Price Type

◦ Nonrecurring Revenue

◦ Recurring Revenue

◦ Usage Revenue

Click Save and Close to save the changes.

Add the Attributes as Filters in Workspace
Add the attributes as filters in the Workspace so that your users can use the filters to search for opportunities.

1. In Setup and Maintenance, use the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

2. On the left navigation pane in the Configure Adaptive Search page, go to Set up > Advanced.
3. In Objects Enabled for Adaptive Search, go to Opportunity > Revenues and select Opportunity Revenue.
4. Select the Enable check box for all the following attributes:

◦ Price Type

◦ Nonrecurring Revenue

◦ Recurring Revenue

◦ Usage Revenue

5. Click Save.
6. Go to Actions and select Partial Publish.
7. Select Opportunity in the Partial Publish window and click Proceed with Partial Publish.

It may take a while for the application to publish your changes.
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Your users can add the new attributes as filters in Workspace and search for opportunities based on their
values.

8. Add the revenue attributes as filters to Workspace:

a. Go to Navigator > Workspace.
b. Click the edit icon in the Filters.
c. On the Edit Filters window, search for Price Type, Recurring Revenue, Non-Recurring Revenue, and Usage

Revenue and move them from Available to Selected.
d. Click OK.

Use the filters to get the list of opportunities you want.

Add the Custom Currency Type Field to Quotes  
You can enable salespeople to enter a currency when creating a quote.

Here's how to add an editable custom currency field:

1. Create and activate a sandbox.
2. Navigate to Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, and then expand Sales Order.
4. Click the Fields node.
5. On the Custom tab, select New from the Action menu.
6. In the Select Field Type window, select the Currency field type and click OK.
7. In the Create Currency Field window, enter a display name for the field for example, enter "Currency". Ensure

that Updatable is checked under Constraints.
8. Click Save and Close.
9. Next, expose the new field for quotes (Sales Orders object).

10. Click the Pages node under Sales Orders.
11. In the Sales Orders: Pages page, ensure that the Application Pages tab is selected.
12. From the Actions menu, select Duplicate.
13. In the Duplicate Layout dialog box, enter a name for the new layout and click Save and Edit.
14. In the Landing Page Layout page, click the edit icon next to Fuse Quote Overview Table.
15. In edit mode, find the newly created Currency field in the Available Fields box and move it to the Selected Fields

box.
16. Click Save and Close and then click Done.
17. Verify the changes by signing in as a user with access to the Quotes and Orders pages, such as a sales

administrator or sales representative. Do these steps:

a. Navigate to Quotes and Orders while still in the active sandbox.
b. Click Show Advanced Search.
c. Click Add.
d. Click Currency and add the field.

18. Publish the sandbox.
For more information, see the Configuring Applications Using Application Composer guide.
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Related Topics

Enable Salespeople to Create a Copy from an Opportunity Quote  
Configure the ZCA_SO_COPY_QUOTE_ACROSS_OPPTY profile option to let the salespeople create a copy of a quote
from an opportunity to another.

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option code,
ZCA_SO_COPY_QUOTE_ACROSS_OPPTY. The default value of Site is set to No.

3. Change the profile value to Yes and save the changes.
4. Sign in again for the changes to take effect.

Related Topics
• Make a Copy from an Opportunity Quote

Enable Creating a Quote Automatically from an Opportunity  
Set up automatic quote creation to let your salespeople use the auto-generated quotes when negotiating and closing
the deals with customers.

The process adds products automatically and generates quotes for opportunities.

This automatic process involves Oracle CX Sales and Oracle Configure Price Quote (CPQ). So, for the quotes to get
generated, you need to complete the setups in both the application. Here are the prerequisites before you set up:

Prerequisites
For a quote to be created successfully by the automatic process, ensure that:

• The opportunities have one or more revenue lines.

• The products or revenue lines are mapped accurately between Oracle CX Sales and Oracle CPQ.

• The opportunity doesn’t already have a quote associated with it.

• The routine rules are defined accurately by selecting the right attribute and attribute values.

• The approval of quotes in Oracle CPQ isn't set to manual approval.

Set Up Automated Quote Creation
1. Assign administrative privileges to a user of Oracle CPQ to allow the automatic creation of a quote from an

opportunity.
2. Set up CX Sales to Oracle CPQ configuration. See the CX Sales Configuration Steps topic in the Integrating CX

Sales with Oracle CPQ guide.
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3. Assign security policy to the integration:
a. In the Setup and Maintenance work area, use the Manage Oracle CX Sales to Oracle CPQ Cloud

Integration task:
- Offering: Sales
- Functional Area: Integration
- Task: Manage Oracle CX Sales to Oracle CPQ Cloud Integration

b. On the Manage Oracle CX Sales to Oracle CPQ Cloud Integration page, enter an Oracle CPQ environment
URL for Endpoint URL.

c. Next, set up the endpoint credentials. For that, click the Set Up link under the Authorization column as
highlighted in the screenshot.

d. In the Endpoint Credentials window, select oracle/wss_username_token_over_ssl_client_policy for
Security Policy. Here's a screenshot of the Endpoint Credentials window that shows selecting the
security policy from the drop-down list.

e. Enter the Single Sign-on credentials for the User Name and Password fields.
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f. Click Save and Close.
4. Set up routines on the Opportunity object, select the Create Quote action, and define the rules. See the

Overview of Routines topic to learn more.

Note:  In a rare occurrence, if a quote creation fails, the process tries to re-create a quote after 24 hours.

Renewal Opportunities  

Setting Up Renewal Opportunities  
Oracle CPQ checks for subscriptions that are due to expire soon and automatically creates quotes of type Renewal,
which in turn create the Renewal opportunities.

These renewal opportunities from Oracle CPQ appear in the Opportunities list of the sales application. However, for
your users to distinguish these opportunities as renewals, you must enable the settings listed in this table:

What to Enable Navigation or Reference

Enable the Revenue Line sync feature
 

For navigation and details, see the "Set Up Reconciliation of Revenue Lines from Quote Lines" topic in
the "Quotes and Orders" chapter in the Implementing Sales guide.
 

Verify the CX Sales and Oracle CPQ
attributes mapping to synchronize revenue
lines from quote lines
 

For navigation and details, see the "CX Sales and Oracle CPQ Attributes to Synchronize Revenue Lines
from Quote Lines" topic in the "Quotes and Orders" chapter in the Implementing Sales guide.
 

Verify the Quote Headers and Opportunity
attributes mapping
 

For navigation and details, see the "Quote Headers and Opportunity Attributes Mapping" topic in the
"Quotes and Orders" chapter in the Implementing Sales guide.
 

Add the Opportunity Type attribute to the
custom Landing, Creation, and Details
layouts
 

Application Composer > Standard Objects > Opportunity > Pages.
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What to Enable Navigation or Reference

Add the Revenue Type Category attribute
to the Products section of the custom
Creation and Details layout of Opportunity
 

Note:
The Revenue Type Category will be set
to Renew, based on the renewal quote
information provided by the Oracle
CPQ.
 

Application Composer > Standard Objects > Opportunity > Pages.
 

Note:  Your users can create renewal opportunities manually as well.

Quote Headers and Opportunity Attributes Mapping  
The default Quote header and Opportunity attributes mapping enables Oracle CPQ to create and populate renewal
quotes as renewal opportunities.

Here are the steps to verify your default mapping:

1. In the Setup and Maintenance work area, use the Manage Oracle CX Sales to Oracle CPQ Cloud Integration
task.

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Oracle CX Sales to Oracle CPQ Cloud Integration

2. On the Manage Oracle CX Sales to Oracle CPQ Cloud Integration page, go to the Quote Header to Opportunity
Mapping tab.

3. Verify that the default mapping of CX Sales and Oracle CPQ attributes is intact. Refer to the table here for the
standard mapping:

Opportunity Attributes (Sales) Quote Headers (Oracle CPQ)

Business Unit ID
 

BuOrgId
 

Name
 

Name
 

Account
 

SoldCustomerPartyId
 

Primary Contact
 

SoldContactPartyId
 

Owner
 

OwnerResourcePartyId
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Opportunity Attributes (Sales) Quote Headers (Oracle CPQ)

Sales Method
 

Defaulted based on Profile or Business Unit setting
 

Sales Stage
 

Defaults to the FIRST Sales Method for this Renewal Opportunity
 

Opportunity Type
 

QuoteTypeCategory
 

Renewal Process
 

RenewalProcess
 

Currency
 

CurrencyCode
 

4. If you have made any changes, save them.
5. Sign in again for the changes to take effect.

Quote Security  

User Roles for the Quotes Integration  
Several of the supplied user roles automatically have access to the quotes functionality. In addition, you can add
privileges for partner and custom roles.

User Roles That Automatically Have Access to Quotes
The user roles that automatically have access to quotes functionality are:

• Sales Representative

• Sales Manager

• Sales VP

• Sales Administrator

• Channel Operations Manager

• Channel Account Manager

• Channel Sales Manager

• Partner Administrator

• Partner Sales Representative

• Partner Sales Manager
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Give Access to Quotes to Company-Defined User Roles
To give quotes access to users who have company-defined roles, add the applicable function privileges and data
security policies. See the Securing CX Sales and Fusion Service guide for more information.

Related Topics
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27  Business Plans

Overview of Business Plans  
Business plans are a set of goals that an account or partner wants to accomplish. Business plans allow both brand
owners and partners a way to show their commitment to the partnership.

Let's take a look at the business plan components:

Component Description

Business Plan Header The header area contains key information about a business plan, including its duration and partner or
account information.

SWOT This is an acronym for the strength, weaknesses, opportunities, and threats of a business plan.

Team These are sales resources who have access to business plans.

Activities Users can associate tasks, appointments, and call logs with business plans.

Notes Users can associate notes with business plans.

A business plan attribute class is used to determine which object a business plan is created for. Two business plan
classes, Partner and Account, are supplied, and you can add others. Use the Manage Business Plan Classes task to
manage business plan classes.

Partner business plans consist of partner goals and are primarily used by channel account managers and their
counterparts partner sales managers. The plans include specific objectives that a partner can follow to meet business
plan goals. Partner business plans provide a means of collaboration between brand owners and their partners in
defining strategic goals.

Account business plans consist of goals for sales representatives and sales managers for specific accounts that they
manage.

If you have customized roles for your business plan users, be sure to to add the following data security policy using the
Security Console's Database Resource page – otherwise, your users won't be able to save business plan notes:

• Database Resource: Note

• Data Set: Select by instance set

• Condition Name: Notes Default Instance Set

• Parameter 1: SALES_BUSINESS_PLAN

• Actions: Read, Update, Delete, Manage Sales Business Plan Note

For more information, see Manage Database Resources in the Configure and Troubleshoot Data Security chapter in the
Securing Sales and Fusion Service guide.
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Enable Account Business Plans  
In the ready-to-use application, the default class of business plans is partner business plans. If your requirement is to
only manage partner business plans, then you don't need to make any changes related to the business plan class.

If you manage only account business plans, then you must make only one change related to the business plan class
using the task, Manage Business Plan Classes. You can either disable all classes except for Account class, or make
sure that the display sequence for the account class is the smallest. After you make the change, the partner attribute
isn't visible on the Create Business Plan and Edit Business Plan pages, and instead the account attribute shows. If you
manage both partner and account business plans, then you must ensure that both partner and account classes are
enabled using the Manage Business Plan Classes task. The class attribute must be exposed in the Create Business Plan
page so that users can select a business plan class when creating a new business plan.

To change the business page plan:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Business Plan.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. Duplicate the Standard Layout for the Landing Page.
7. Edit the new layout by adding Account and Class fields on the Landing Page Layout.
8. Duplicate the Standard Layouts for Create and Details layouts.
9. Add Class field in the Creation Page Layouts, and optionally the Details Page Layouts on the Business Plan

page.
10. Ensure that the layout status for your new layout is Active.
11. Test the changes.
12. Publish the sandbox according to your company's business practices.

Related Topics
• Overview of Business Plans

• Overview of Managing Partner Business Plans

Enable Objectives on the Business Plans Overview Tab  
You can enable salespeople to view and drill into objectives on the overview tab of business plans. Use the profile option
ZCA_SHOW_OBJECTIVES_IN_SUBTAB to specify where objectives are displayed. The default value depends on the
following:

• For a new installation, the default value is Y. If the value is set to Y, then objectives are displayed as a subtab on
the Edit Business Plan: Summary page.

• For an existing customer without objectives in the application, the default value is Y.

• If the value is set to N, then the objectives are displayed on the Edit Business Plan: Summary page.
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To enable objectives on the overview tab:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Enter ZCA_SHOW_OBJECTIVES_IN_SUBTAB in the Profile Option Code field.
3. Click Search.
4. In the Profile Option: Profile Values region, do one of the following:

◦ To display objectives on the overview tab, set the Profile Value to No.

◦ To display objectives in a separate side tab, set the Profile Value to Yes.

5. Click Save and Close.

Considerations When Managing Business Plan Classes  
As a sales administrator you can manage business plans and their classes.

The following table shows business plan features and what you can do with them:

Business Plan Feature What You Can Do

User-defined classes
 

• Rename the supplied classes, add classes, and mark classes as disabled.

• Use the Manage Business Plan Classes task to rename the lookup type values. The account and
partner classes are supplied in the ready to use application.

• In addition to those used for partners or accounts, you can add business plan classes that define
more business plans, such as territories business plans.

Supplied business plan classes
 

• Access the following supplied business plan classes:

◦ Partner

◦ Account

• Enable and disable any of the supplied classes using the Manage Business Plan Classes task.

Default business plan class
 

The default business plan class is determined by the business plan class settings. A class represented
by an enabled look up code with the lowest display sequence is selected as the default class of a new
business plan. You can view and manage business plan classes using in Manage Business Plan Classes
task. You can import business plans of any class that's specified and enabled in Manage Business Plan
Classes task.
 

Conditionally required partner or account
information
 

Partner information is required only if the class of the business plan is Partner. Similarly, account
information is required only if the class of the business plan is Account.
 

Owner list of values
 

The Owner list of values depends on the class of the business plan. For the Partner class, the list of
values shows selected partner team members as the candidates for the business plan owner. For the
Accounts class, the owner list of values shows selected account team members as the candidates for
the business plan owner.
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Business Plan Feature What You Can Do

 

View Business Plan Lookups  
You can view lookups that are supplied in a business plan and also add values to them. Lookups corresponding to
business plan classes, business plan types, business plan statuses, and business plan team member functions have
dedicated tasks namely:

• Manage Business Plan Classes

• Manage Business Plan Types

• Manage Business Plan Statuses

• Manage Business Plan Team Member Functions

Other lookups are covered by the Manage Business Plan Configurable Lookups task. To view business plan lookups:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Customer Center

◦ Task: Manage Business Plan Configurable Lookups

2. View the remaining lookup types.
3. Click any lookup type to see the lookup codes.
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28  Assets

Overview of Setting Up Sales Assets  
Assets are high-net-worth products owned by an organization. After you enable assets in the sales applications,
salespeople can create and manage assets associated with their customers and associate assets with activities like
appointments and tasks.

Here are some of the ways sales users access assets:

• Click Sales > Assets on the springboard to use a full set of create, edit, and manage assets capabilities

• Manage assets within the context of accounts

• Associate assets with activities, such as tasks and appointments

• Create an organization-level view of calendars associated with assets

• Associate assets with opportunities and leads

Setup Options for Assets
This table describes the setup configurations available for Assets:

Decision Point Description Where to Find More Information

Determine whether to use Oracle Supply Chain
Management (Oracle SCM) Installed Base
Assets or the default Assets functionality that
comes supplied with the application
 

Which option you choose depends on your
business needs. The default option lets your
users do the tasks listed earlier in this topic. If
you enable Oracle SCM Installed Base Assets,
 your users have additional capabilities for
tracking assets in Activities.
 

See the Enable Installed Base Assets topic in
this chapter
 

Expose the Assets icon in the springboard
(default setup)
 

The Assets icon isn't available by default from
the Sales springboard. You can enable it to give
salespeople access to the Assets pages.
 

See:
 

• The section in this topic, Expose the
Assets Icon

• The topic, Configure Navigation

Enable the Assets list of values in Activities
pages (default setup)
 

The Assets list of values isn't available by
default in the Activities pages. You can expose
the Assets list of values in activities, including in
appointments, call reports, and tasks, to allow
salespeople to associate an asset with activities.
 

See:
 

• The topic, Enable the Assets List of Values
in this chapter

• The topic, Extend Application Pages for
Activities, in this guide

Enable the Leads and Opportunities subtabs in
the Assets pages.
 

The Leads and Opportunities subtabs aren't
available by default in the Assets pages. You
can expose the subtabs in the Assets pages
to allow salespeople to associate leads and
opportunities with assets.
 

See these topics:
 

• Enable the Leads Subtab in Assets

• Enable the Opportunities Subtab in Assets
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Expose the Assets Icon
The Assets icon isn't available by default. You enable it using these steps:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Structure.
3. In the Structure page, ensure that the Navigation Configuration tab is selected.
4. Expand the Sales node and click the Assets link.
5. In the Edit Page Entry: Assets page:

a. In the Navigator field, select Yes.
b. In the Springboard field, select Yes.
c. Click Save and Close.

6. Verify the changes by signing in as a user with access to the Sales pages, such as a sales representative. Ensure
you can see the Assets icon on the Sales home page and springboard.

7. Publish the sandbox.

For more information about modifying the UI and using sandboxes see the Configuring Applications Using Application
Composer guide.

Sales Catalog Integration
The Assets application is automatically integrated with the sales catalog and with sales products. In the assets pages,
lists of values appear for products and product groups that are included in the catalog. For more information, see the
Sales Catalogs and Products chapters in this guide. Also see the sales user topics on using assets in the Using Sales
guide.

Import and Web Service Integration
You can import assets into the application. You can also use web services to create an asset. For more information, see
the Understanding Import and Export Management for CX Sales and Fusion Service guide.

Overview of Asset Security  
By default, the standard Sales job roles, such as Sales Representative and Sales Manager, have access to the Assets UI. If
you want to configure Assets security, use the information in this topic.

If duty roles aren't configured, then users need one of these duties to view, create, edit, delete, and export assets:

• Sales Party Review Duty (grants view access only)

• Sales Party Management Duty

• Marketing Sales Party Management Duty

The duty roles can be configured by adding or removing these privileges:

• View Assets

• Create Asset

• Edit Asset
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• Delete Asset

For more information, see the Securing CX Sales and Fusion Service guide.

Setup Tasks  

Configure Assets Saved Search  
You can configure the number of days, in the past, from the current date, for which the application retrieves records for
the All My Customer's Assets saved search.

Set the Profile Option for the Saved Search
The profile option, Default Asset Purchase Date (ZCM_ASSET_DEFAULT_PURCHASE_DATE), controls the behavior of the
saved search based on the asset's purchase date. To set the profile option:

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for the profile option using either the code or the display name.
3. Set the profile value as required.
4. Click Save and Close.

How the Profile Option Is Calculated
If you select 60 in the profile option, then the application retrieves all those assets whose purchase date is within 60
days of the current date.

Similarly, you can select 90 or 180 days, and the application retrieves assets whose purchase date is within the selected
days from the current date.

Note:  You can update or remove the purchase date from the Advanced Search option.

Enable Installed Base Assets  
Let salespeople manage activities like tasks and appointments more efficiently by including Installed Base Assets in
Activities. You can also enable the Installed Base Assets tab in the Accounts pages.

For example, salespeople can tie the maintenance of a copier to a task, or in the Automobile verticals application, tie a
car's test drive to an appointment.

You can add Installed Base Asset fields to the Activity and Account page layouts in Application Composer. From here,
installed base asset data can then be passed to downstream processes such as Field Service or Service Logistics.
Installed Base Assets is part of Oracle Supply Chain Management (SCM).
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You can show these attributes or fields on the Activity create and edit pages:

• Installed Base Asset

• Installed Base Asset Number

• Installed Base Asset Serial Number

Opt In to Installed Base Assets
Ensure first that you have opted in to Installed Base Assets:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Change Feature Opt in link

2. Click the Features icon for Sales in the first row.
3. Select Enable for Manage Assets Using Common Asset Model.
4. Click Done.
5. Click Done on the Opt In page.

Note:  This is a global setting where you choose whether to use Oracle SCM Installed Base Assets or the default CRM
Asset object. You can't use both asset objects in the sales application, so carefully consider the impact if you have
requirements to support asset management.

Enable the Activities Subtab in Assets  
You can expose the Activities subtab in the Edit Asset page to let salespeople associate activities with assets. You must
expose asset fields in the activities pages to display the asset information for the activity.

By default, the Activities subtab doesn't appear in the Edit Asset page.

Here's how to show the Activities subtab in the Edit Asset page:

1. Ensure you're working in an active sandbox.
2. Navigate to Application Composer, in the Configuration category.
3. In the navigation tree, expand Standard Objects, expand Asset, and click Pages.
4. Ensure that the Application Pages tab is selected.
5. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the duplicate icon.
6. Enter a new layout name and click Save and Edit.

The Details Layout page appears.
7. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
8. Move Activities from the Available Subtabs window to the Selected Subtabs window.
9. Click OK.

10. From the Details Layout page, click Done.
11. Make sure that the layout status for your layout is set to Active.
12. Test the changes as follows:
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◦ Navigate to Sales > Assets as a user with access to the assets pages, for example, as a salesperson.

◦ Edit an asset and ensure you can see the Activities subtab in the Edit Asset page.

13. Publish the sandbox according to your company's business practices.

Enable the Assets List of Values in Activities  
You can expose the Assets list in the Activities pages for salespeople to associate an asset with appointments, tasks, and
call reports. By default, the Assets list doesn't appear in the Activities pages.

To enable the Assets list in the Activities pages:

1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. Expand Standard Objects and then expand Activity.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. Find the section you want to add the Assets list to. For example, to add the Assets list to the appointment

details page, use the Appointment Details section in the Details Page Layouts region.
7. Within that section, duplicate the standard layout by highlighting the standard layout and clicking the duplicate

icon.
8. Type a new layout name and click Save and Edit.

The Details Layout page appears.
9. Click the edit icon to edit the Summary region.

The Details Layout: Edit Summary page appears.
10. In the Configure Detail Form section, move the Asset field from the Available Fields box to the Selected Fields

box.
11. Click Save and Close.
12. On the Details Layout page, click Done.
13. Ensure that the layout status for your new layout is Active.
14. Test the changes: Navigate to Sales > Activities as a user with access to the Activities pages, for example, as a

salesperson. Edit an appointment and ensure you can see the Asset list in the Edit Appointment page.
15. Publish the sandbox according to your company's business practices.

Enable the Assets Subtab in Accounts  
You can expose the Assets subtab list in the Accounts pages to give salespeople the ability to associate an asset with an
account. You must expose asset fields on the Accounts pages to display the asset information for the account.

By default, the Assets subtab doesn't appear in the Accounts pages.

Note:  You also can expose a subtab for Installed Base Assets (part of Oracle SCM) in accounts. This is a separate
configuration, not part of CRM Assets. Therefore, Installed Base Assets won't show in the Assets subtab. Instead, you
need to expose the Installed Base Assets subtab using Application Composer.

Here's how to expose the Assets subtab list in the Edit Account page:

1. Activate a sandbox.

743



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 28
Assets

2. Navigate to Application Composer, in the Configuration category.
3. Select Sales.
4. In the navigation tree, expand Standard Objects, expand Account, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit. The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Assets from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. Back in the Details Layout page, click Done.
12. Be sure that the layout status for your user-defined layout is Active.
13. Test the changes: Navigate to Sales > Accounts as a user with access to the assets pages, for example, as a

salesperson. Edit an account and ensure you can see the Assets subtab in the Edit Account page.
14. Publish the sandbox.

For more information, see the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Setting Up Sales Assets

• Enable the Opportunities Subtab in Assets

• Overview of Sales Assets

• Overview of Sandboxes

Enable the Leads Subtab in Assets  
You can expose the Leads subtab list in the Edit Assets page to give salespeople the ability to associate an asset with a
lead. You must expose asset fields on the Lead pages to display the asset information for the lead.

By default, the Leads subtab doesn't appear in the Assets pages.

Here's how to expose the Leads subtab list in the Edit Assets page.

1. Activate a sandbox.
2. Navigate to Application Composer, in the Configuration category.
3. Select Sales.
4. In the navigation tree, expand Standard Objects, expand Asset, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Leads from the Available Subtabs to the Selected Subtabs window.
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10. Click OK.
11. Back in the Details Layout page, click Done.
12. Be sure that the layout status for your user-defined layout is Active.
13. Test the changes: Navigate to Sales > Assets as a user with access to the assets pages, for example, as a

salesperson. Edit an asset and ensure you can see the Leads subtab in the Edit Asset page.
14. Publish the sandbox.

For more information, see the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Setting Up Sales Assets

• Enable the Opportunities Subtab in Assets

• Overview of Sales Assets

• Overview of Sandboxes

Enable the Opportunities Subtab in Assets  
You can expose the Opportunities subtab in the Edit Asset page to give salespeople the ability to associate
opportunities with assets. You must expose asset fields in the opportunity pages to display the asset information for the
opportunity.

By default, the Opportunities subtab doesn't appear in the Edit Assets page.

Here's how to enable the Opportunities subtab in the Edit Asset page.

1. Activate a sandbox.
2. Navigate to Application Composer, in the Configuration category.
3. Select Sales.
4. In the navigation tree, expand Standard Objects, expand Asset, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Opportunities from the Available Subtabs window to the Selected Subtabs window.

10. Click OK.
11. From the Details Layout page, click Done.
12. Make sure that the layout status for your layout is set to Active.
13. Test the changes as follows:

◦ Navigate to Sales > Assets as a user with access to the assets pages, for example, as a salesperson.

◦ Edit an asset and ensure you can see the Opportunities subtab in the Edit Asset page.

14. Publish the sandbox.
For more information, see the related topics and the Configuring Applications Using Application Composer guide.

745

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACEX
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20056776
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035520


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 28
Assets

Related Topics
• Overview of Setting Up Sales Assets

• Enable the Leads Subtab in Assets

• Overview of Sales Assets

• Overview of Sandboxes
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29  Promotions

Overview of Sales Promotions  
Salespeople can create and manage promotions that offer discounts based on specified conditions. After they're
created, promotions can be used in other applications that want to leverage promotions in their pages.

Note:  You don't need to do anything to set up promotions. However, to leverage promotions, you must modify the
applications where you're going to use them.

Promotions Tasks
As the sales administrator, you can:

• Create promotions

• View and edit promotion details and attributes

• View a list of promotions

• Search for promotions

• Copy promotions

• Import promotions and create and update promotions using Oracle import

Related Topics
• Work with Sales Promotions

Work with Sales Promotions  
Use the procedures in this topic as you create and maintain sales promotions.

This topic covers:

• Viewing a list of sales promotions: This task includes searching and filtering.

• Creating promotions: This task includes entering promotions basic information.

• Editing promotions: This task includes modifying the details of promotions.

• Copying promotions: This task includes copying a promotion so that you can repurpose it.

• Deleting promotions.

Note:  You don't need to do anything to set up promotions. However, to leverage promotions, you must modify the
applications where you're going to use them.
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View the Promotions List
To view a list of promotions, navigate to Sales > Promotions.

In the landing (or list) page, you can:

• Search for promotions.

• Filter the view between promotion statuses, such as active or inactive.

Create and Edit Promotions
Creating promotions includes entering basic information, such as name and status, and saving the promotion for the
first time. In edit mode you enter more details, such as the type of discount and the discount value.

Here's how to create and edit a new sales promotion.

1. Navigate to Sales > Promotions.
2. Click the Create Promotion button.
3. In the Create Promotion page, enter a unique name in theName field.
4. Optionally, enter a description and start and end dates.
5. Click Save and Continue to save the promotion and begin entering additional details. The page refreshes and

becomes the Edit Promotion page.
Note:  At this point you can copy the promotion or delete it.

6. In the Status field, select the status of the promotion. Inactive promotions aren't available in consuming
applications.

7. In the Type field, select the adjustment type. The type can be either:

◦ Fixed amount: Select Line Discount Amount.

◦ Percentage: Select Line Discount Percent.
8. In the Apply To field, select whether the discount should apply to:

◦ List Price: List price is the advertised, published or sticker price on a product being marketed to a
business or consumer buyer.

◦ Net Price: Net price is the actual price paid once any discounts are taken off the list price.
9. In the Value field, enter an amount. The amount is either the percentage of the discount or a fixed amount,

depending on which type of adjustment you selected in the Type field.

Copy Promotions
To repurpose existing promotions, you can copy them any time after saving them.

Here's how:

1. Navigate to Sales > Promotions.
2. Select the name of a promotion in the list.
3. In the Edit Promotions page, from the Actions menu, select Copy Promotion.
4. In the Copy Promotion page, in the Name field, enter a new, unique name.
5. Click the Save and Continue button.

The Edit Promotion page appears, where you can edit the details of the promotion. See the Create and Edit
Promotions section in this topic for more information.
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Delete Promotions
To delete a promotion:

1. Navigate to Sales > Promotions.
2. Select the name of a promotion in the list.
3. In the Edit Promotion page, from the Actions menu, select Delete Promotion.
4. Click Yes in the warning message window.

Related Topics
• Overview of Sales Promotions
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30  Sales Campaigns

Sales Campaigns  
Sales campaigns make it easy for salespeople to keep their contacts informed, announce product launches, and invite
them to events. You can configure HTML email templates that salespeople can use to send emails using the built-in
email server provided by your application.

The application monitors responses and can create follow-up tasks or send emails to the sales campaign owners.

Note:  For existing CX Sales and Fusion Service users of Sales Campaigns, Oracle plans to decommission this feature
over the next few releases. As alternatives, Oracle recommends that you plan to use Engage Sales Tool by Oracle
Eloqua, and Integration between CX Sales and Eloqua, as you will no longer be able to use the Sales Campaign
functionality once discontinued.

Note:  Sales campaigns are created with an end date of one year internally and this end date can't be changed. Sales
campaigns are meant to be short lived objects where salespeople create and launch campaigns, checks responses,
and proceed with other actions.

Here's how it works:

1. Sales administrators create an HTML template referencing images stored separately on a public server.

You can include merge fields, links (URLs), and three predefined response links provided by Oracle. Using the
predefined response links, contacts can request a call-back, request more information, or fill out a form to have
the email sent to others.

2. Salespeople use the template to create a sales campaign and select the contacts they want to email.

Note:  If you're creating an email campaign for the first time after migrating to Oracle Cloud Infrastructure
(OCI), a confirmation email is sent to the From address for verification. You must click on the link to
confirm and authenticate the From address before you can use it. Otherwise, emails will be sent from no-
reply@oracle.com instead of the correct email address.

3. For each sales campaign, salespeople can modify the template, add messages for each recipient, and have the
application generate follow-up tasks or emails.

4. Salespeople can have the sales campaign emails sent either immediately after clicking Submit or at the
specified date and time.

5. When contacts open the email, click a URL or one of the response links, the application records their responses.
6. The application creates a task for each response or sends a notification email, depending on campaign setup.
7. The sales campaign owner reviews the sales campaign responses and can convert them into leads.
8. Salespeople can review the tasks generated by the sales campaign in the Activities work area.

Here's a diagram that illustrates the process.
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Note:  Domain-based Message Authentication, Reporting, and Conformance (DMARC) settings aren't supported with
Sales Campaigns. With specific policies, your emails may not get delivered to certain email providers.
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Email Sales Campaigns  

Set Up an Email Sales Campaign  
Sales managers and salespeople use sales campaigns to promote a specific product or event to specific customers in
a personalized email campaign. These campaigns can contain links that recipients can respond to, and their responses
can be tracked.

You can set up language-specific versions of templates, headers, and footers, to use in international campaigns. This
topic outlines the steps that you perform to set up a sales campaign.

Switch to ESS Job for E-Mail Sending
The MKT_ESS_EMAIL (Switch to ESS Job for E-Mail Sending) profile option enables the delivery of emails by switching
domains from the Envelope Sender Domain (ESD) to the user messaging service from Oracle. This MKT_ESS_EMAIL
profile option isn't enabled by default. Set the value to Yes to use the standard fulfillment scheduled process to deliver
emails for your sales campaigns.

Here's how to set the MKT_ESS_EMAIL profile option value to Yes.

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name

MKT_ESS_EMAIL in the Profile Option Code field.
3. Click Search.
4. In the list that's returned, click the profile option code link.
5. Select Yes in the Profile Value field.
6. Click Save and Close.

Validate the Email Server
The email server provides:

• The email sending daemon that delivers email

• The bounce-handling daemon that tracks emails that can't be delivered

• The click-through daemon that tracks email recipient responses

Here's how to validate the email server:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Sales Campaigns

◦ Task: Manage Marketing Supplier Details and Distribution Profiles
2. In the Oracle Fusion Email and Web Marketing: Distribution Profiles area, select the E-Mail Profile.
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3. Verify the following server details for the selected ESD email delivery channel:
◦ CTD protocol

◦ CTD host, such as [your environment].oraclecloud.com

◦ CTD port, such as 443

◦ BHD host, such as [your environment].oraclecloud.com
For external email domains, use this BHD host format: workflow.mail.[dc].oraclecloud.com where [dc]
= data center of the host. You can get the data center value from your environment information or from
your environment support team.

4. Click Cancel or click Save and Close  if you made changes.

Set Up Headers and Footers
You create header and footer content for email messages delivered as part of your email sales campaign. The email
header and footer can be assigned to a specific organization unit and language. It can be in HTML or text format and
can be marked for restricted viewing.

Here's how to create header and footer content:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Sales Campaigns

◦ Task: Manage Marketing E-Mail Headers and Footers
2. On the page, select Create from the Actions list.
3. Enter the following information on the Create E-Mail Header or Footer page:

a. Select the All check box for Organization.
b. Name Enter a descriptive name.
c. Language Select American English or whatever language that you want.
d. Select the Primary check box.
e. Select Header in the Type field.
f. In the HTML or Plain Text subtab, set up your header.

g. Edit records in the table to ensure the header content is present.
h. Click Save and Close.

4. Repeat the steps 2 and 3 to create a footer. Be sure to select Footer for Type.

Set Up the Marketing Template
Use treatment templates to help you quickly create:

• Treatments

• Channel specific marketing promotions

• Marketing messages

• Fulfillment instructions to assign to campaigns

Here's how to create a treatment template:

1. Select the Manage Marketing Treatment Templates task.
2. In the Manage Marketing Treatment Templates page, click the Create icon.
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3. On the Create Treatment Template page, enter the required information.
4. Select the Active check box.
5. Either upload your HTML template as a file, or paste it in the work area.
6. Click Save and Close.

Related Topics
• Profile Options for Sales Campaigns

• Update Existing Setup Data

Sales Campaign Content  
You can personalize your sales campaign by adding components such as images, merge fields and response forms.

To create the content of your sales campaign, you can add any combination of these components:

• Images

• Merge fields

• Response forms

• Standard and other URLs

• Conditional content

Images
Add graphic images to your email. You can provide a link to an image already on a server, or select a local file and
upload it to the server. Specify the size and placement of the image. You can add a URL of a publicly hosted image using
the img src  tag.

Merge Fields
Personalize your email message body by adding placeholders from a list of merge fields, such as the recipient's first
name. Merge fields are standard sets of attributes pertaining to an individual contact. You can insert them into your
email content. When you launch the campaign, merge fields are dynamically populated directly from the database. With
sales campaigns you can also compose a personalized text message for each recipient.

Response Forms
Insert response forms as active links in your email campaign content. When a contact clicks one of the links, a specific
response is automatically generated. All such responses are gathered and monitored, to track contacts' actions.
Available response forms for sales campaigns are:

• Forward to Friend

• Request Call Back

• Request More Information

Standard URLs
You can add any of the following types of URL:

• Standard URLs are predefined and commonly used across the enterprise.
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• A URL can be created when you define your email content.

By default, all standard URLs are tracked automatically. You can optionally enable tracking for other URLs, or disable
tracking for standard URLs. With tracking enabled, every time a contact clicks a link in a campaign email, the click is
recorded as a specific response, together with details pertaining to the URL.

Conditional Content
Conditional content is inserted or omitted based on the results of a rule. There are two elements that you can use to
generate conditional content within an email:

• If-Then-Else cases are used to determine if a block of text or HTML is removed from an outgoing email, by
verifying if a merge field value is defined. The merge field is defined if it isn't an empty string or, for numeric
merge fields, if it isn't a value of 0 (zero). If the merge field is defined, the block of text or HTML remains in the
outgoing email. If the merge field isn't defined, the block of text or HTML is removed from the outgoing email.

• Named Blocks are used to decide whether to insert a block of text or HTML into an outgoing email, by
comparing one string to another. If the two strings are identical, the block is inserted.

Related Topics
• Use Conditional Content to Personalize Sales Campaign Emails

Use Conditional Content to Personalize Sales Campaign Emails  
Conditional content lets you present information that's specific to individual email recipients without having to create
multiple messages. There are two ways to generate conditional content within a sales campaign template:

• Block statement personalization

• If-Then-Else personalization

Conditional content and merge fields are available in both HTML and Text format emails.

Insert Text Using Block Statement Personalization
Blocks determine whether to insert a block of text or HTML into an outgoing email by comparing one string to another:

• If the two strings are identical, the block is inserted.

• If the two strings aren't identical, the block isn't inserted.

Note:  The string comparison is case-sensitive.

Here are the components of the block personalization element.

Personalization Component Description

$(DefineBlock "MatchString") Starts a block of text or HTML that's inserted in place of an Insert Block component when
MatchString is identical to the MatchString of the Insert Block component.
 

$(EndBlock) Ends a block of text or HTML that was started with the Define Block component.
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Personalization Component Description

 

$(InsertBlock "MatchString") A block of text or HTML is inserted at the location of this component when MatchString is identical
to the MatchString of a Define Block component.
 

Let's look at an example of a block personalization element:

You live in $(InsertBlock "${Account Country}").
$(DefineBlock "USA") <B>the United States.</B>
$(EndBlock)
$(DefineBlock "India") <B>India</B>
$(EndBlock)

If you enter USA in the Country field of the Account record, then this displays:

You live in the United States.
 

If a given recipient has no associated value for a block variable listed in the InsertBlock MatchString component, then
nothing is inserted into the message for that block.

Insert Text Using a Block Statement
Here's how to insert a block statement:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the insert the block.
3. Create the Insert Block statement as follows:

◦ In the editor toolbar, select Insert Block from the rule conditions drop-down list.

◦ In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.

◦ In the next drop-down list, select the field in the record.

◦ Click Insert.

4. Here's how to create a Define Block component:

◦ In the drop-down list immediately within the email tag, select Create Block.
A $(DefineBlock "") and $(EndBlock) statement appear in the text.

◦ Type a field value within the quotation marks of the $(DefineBlock "") statement.
This is the value that drives the content displayed in the block.

◦ Type the text that you want to insert into the email between the $(DefineBlock "") and $(EndBlock) tags.

5. Repeat Step 4 until you have added all the Define Block components that you need.

Insert or Remove Text Using If-Then-Else Personalization
You can insert or remove text in your email depending on the value of a merge field by using If-Then-Else
personalization. The merge field is defined if it contains a value, or, for numeric merge fields, if the value isn't 0 (zero).

• If the merge field is defined, the text remains in the outgoing email.

• If the merge field isn't defined, the text is removed from the outgoing email.
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Here are the components of the If-Then-Else personalization element.

Personalization Component Description

$(if {Record.FieldName}) Use the If component to start an If-Then-Else personalization element. It determines whether the
merge field named [FieldName] has a value. If there's a value for [FieldName, the text between this
If-Then-Else component and the next If-Then-Else component isn't removed from the email.
 

$(elseif {Record.FieldName}) Ends a block of text or HTML that was started with the Define Block component.
 

$(else) Use the Else component after a $(if)  or $(elseif) component. If the preceding $(if) or
$(elseif) component removes the preceding block of text or HTML from the email, the $(else)
component's block of text or HTML is included in the email. If the preceding$(if) or $(elseif)
component doesn't remove its block of text or HTML, the $(else) component's block of text or HTML
isn't included in the email.
 

$(endif) The End-If component closes the If-Then-Else personalization element.
 

Here's an example of an If-Then-Else personalization element:

$(if ${Contact.First Name})
Dear ${Contact.First Name}${Contact.Last Name},
$(else)
Dear Mr. or Ms. ${Contact.Last Name},
$(endif)

• If the Contact.First Name field is defined, the email begins with "Dear First Name Last Name".

• If the Contact.First Name field isn't defined, the email begins with "Dear Mr. or Ms. Last Name".

You can use If-Then-Else statements similarly to block statements, by including operators such as Equal to, Starts
with, or Contains. You can select these operators from a drop-down list when you generate If or If-Else statements.
Unlike blocks, this permits you to insert conditional content where the variable is true or not true.

For example, to modify the email with a condition for accounts in the state of California, you use the following
statement:

$(if ${Account.Bill to State} == "CA") Join us all month long for special events and workshops held in each of

our California locations.

$(else) Join us all month long for weekly online workshops and special offers at www.mycompany.com/events.

$(endif)

You can also nest If-Then-Else statements, placing one within another.

Note:  The components of personalization elements must be placed in the correct locations in the text. Any incorrect
placement causes an error.

Insert an If-Then-Else Personalization Statement
Here's how to insert an If-Then-Else statement:

1. Display the email template in the HTML editor.
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2. Place the cursor in the location where you want the If-Then-Else statement.
3. Create the If or ElseIf statement as follows:

◦ In the editor Toolbar, from the drop-down list, select either If or ElseIf.

◦ In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.

◦ In the next drop-down list, select the field in the record.

◦ In the next drop-down list, select the operator.

◦ In the next text box, enter the value that the field is compared with.

◦ Click Insert.

4. Following the If or ElseIf statement, enter the text that appears if the condition in the statement is satisfied.
5. At the end of the entire If-Then-Else statement, enter $(endif).

Related Topics
• Sales Campaign Content

• Marketing Content and Standard URLs

Marketing Content and Standard URLs  
When creating marketing content, you can insert various types of URLs. Standard URLs are one type that you predefine
and that can be used across many sales campaigns.

Additional URLs are common response forms predefined by Oracle and ad hoc URLs that can be defined while creating
content, if a predefined URL doesn't already exist. An ad hoc URL isn't reusable.

Standard URLs
Navigate to the Manage Standard URLs task in the Setup and Maintenance work area to define Standard URLs that can
be easily selected when creating marketing content.

Enable tracking if you want to track email recipient clicks. If enabled, every time a contact clicks a link in a campaign
email, the click is recorded as a response, together with details pertaining to the URL.

Managing URL Categories
The Marketing URL Category lookup provides the choices for Standard URL categories. Your application administrator
can add categories by navigating to the Manage Marketing Standard Lookups task in the Setup and Maintenance work
area.

Marketing Content
To include a predefined standard URL in your marketing content, select the Element toolbar button from the Edit
Treatment Template page and then select Standard URL. This feature is available for content created or edited in
Treatments, Treatment Templates, and Sales Campaigns.
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Related Topics
• Sales Campaign Content

• Use Conditional Content to Personalize Sales Campaign Emails

Profile Options for Sales Campaigns  
Profile options are configurable options that affect application operations. Values defined at the user level take
precedence over those at the site level. If a value isn't defined at the user level, the site level value is used.

The effects of setting each of the sales campaign profile options are described under the following broad sections:

• Design Sales Campaigns

• Manage Responses

• Define Data Import and Data Migration

Design Sales Campaigns
This table lists the profile options and the effect of setting each on the design of sales campaigns.

Profile Option Display Name Default Value Effect

Switch to ESS Job for E-Mail Sending
(MKT_ESS_EMAIL)
 

N
 

Enables the delivery of emails by switching
domains from the Envelope Sender Domain
(ESD) to the user messaging service from
Oracle. This MKT_ESS_EMAIL profile option
isn't enabled by default. Set the value to Y to
use the standard fulfillment scheduled process
to deliver emails for your sales campaigns.
 

Sales Campaign Maximum Contacts (MKT_
SALES_CAMPAIGN_MAX_CONTACTS)
 

None
 

Specify the maximum number of contacts
that sales users can target in a sales campaign
launch.
 

Allow Treatment Template (MKT_DEFAULT_
TREATMENT_TEMPLATE)
 

None
 

Specify a default treatment template.
 

E-mail Treatment Distribution Profile Default
(MKT_DEFAULT_EMAIL_DELIVERY_PROFILE)
 

None
 

Select the fulfillment supplier's distribution
profile used as the default value when creating
e-mail treatments.
 

E-mail Treatment Supplier Default
(MKT_DEFAULT_EMAIL_TREATMENT_VENDOR)
 

None
 

Select the fulfillment supplier used as the
default value when creating e-mail treatments.
 

Read Receipt Response Form Default (MKT_
DEFAULT_MESSAGE_RECEIPT)
 

Y
 

Enable the automatic use of read receipt
tracking to HTML e-mail treatment content.
This profile option can be updated at the user
level.
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Profile Option Display Name Default Value Effect

SMS Treatment Distribution Profile Default
(MKT_DEFAULT_SMS_TREATMENT_VENDOR)
 

None
 

Select the fulfillment supplier's distribution
profile used as the default value when creating
short message service treatments.
 

SMS Treatment Supplier Default (MKT_
DEFAULT_SMS_TREATMENT_VENDOR)
 

None
 

Select the fulfillment supplier used as the
default value when creating short message
service treatments.
 

Treatment Content Directory (MKT_DEFAULT_
TEMPLATE_FOLDER_SETUP)
 

None
 

Specify the folder path in Oracle WebCenter
Content to store marketing treatment content.
 

Treatment Template Directory (MKT_DEFAULT_
TEMPLATE_FILE_NAME)
 

None
 

Specify the folder path in Oracle WebCenter
Content to store marketing treatment
templates.
 

Treatment Template Name Prefix (MKT_
DEFAULT_TEMPLATE_FILE_NAME)
 

None
 

Specify a default prefix for treatment template
names. This profile option can be updated at
the user level.
 

Manage Responses
This table lists the profile options and outlines the effect of setting each on the management of marketing responses.

Profile Option Display Name Default Value Effect

Response to Lead Mapping (MKT_RESPONSE_
TO_LEAD_MAPPING_NAME)
 

Copy Response To Lead Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
Response is converted to a Lead.
 

Response to Opportunity Mapping (MKT_
RESPONSE_TO_OPTY_MAPPING_NAME)
 

Copy Response To Opportunity Map
 

Specify the mapping file name created in
Application Composer, Copy Maps. This file
is used to map objects and attributes when a
Response is converted to an Opportunity.
 

Define Data Import and Data Migration
This table lists the profile options and outlines the effect of setting each for marketing data migration and for defining
data import.

Profile Option Display Name Default value Effect

Marketing Migration Look Back Period (ZMG_
MKTG_LOOKBACK_PERIOD)
 

30
 

Specify a number of days to precede the
migration date, so that all marketing records
modified before the specified number of days
are migrated prior to the downtime period.
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Profile Option Display Name Default value Effect

Migrate Siebel Marketing Prospect Data (ZMG_
MKT_PROSPECT_DATA_OPTION)
 

Y
 

Specify the way in which marketing prospect
data is migrated.
 

WebCenter Content Applet Enabled (MKT_IMP_
ENABLE_UCM_APPLET)
 

N
 

Enable Oracle WebCenter Content applet to
browse and load large files when creating file
import processing activities.
 

Related Topics
• Sales Lead Profile Options

• Sales Lead Lookups

• Set Up an Email Sales Campaign

Overview of Campaign Management and Reporting  
You can store marketing related data, such as campaigns and campaign members created and updated in Oracle
Marketing Cloud, also called Oracle Eloqua, in your sales application.

Campaign management and reporting is greatly improved by having campaign related data maintained and
synchronized between Oracle Marketing Cloud and Oracle CX Sales.

You can view meaningful information about marketing campaigns and campaign members from the Campaigns user
interface. The Campaigns UI provides visibility into the campaign effectiveness to support the sales processes. For
example, you can view the campaigns and campaign members associated with a given lead and contact to gain key
insights for closing a sale.

In addition, your administrator can also display a campaigns subtab and an Add to Campaign button
on the Leads and Contacts user interface pages from where you can view data about the marketing
campaigns and add the associated leads and contacts to the campaign. The functional security privilege
MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER must be assigned to the intended user or their role.

Note:  If you want users to have access only to Marketing Campaigns without granting them additional roles to
other objects, then you can create a custom access group. Access groups are an alternative way of granting data
permissions to users, and they use a different access path to that provided by the predefined data security policies.
For more information, see the Create a Custom Access Group topic in the Securing Sales and Fusion Service guide.

The topic describes how to create an access group, create object sharing rules to give group members access to object
data, and add members to the group. For the object sharing rules, use the All Marketing Campaigns predefined rule
which gives full access to campaign records. You can create a group membership rule to add members to your access
group based on user name, role, organization and so on. For more information, see the Create Membership Rules for
Custom Access Groups topic in the Securing Sales and Fusion Service guide.

You can add contacts or leads to marketing campaigns from these locations within your sales application:

• Campaigns subtab on the Edit Contact page

• Campaigns subtab on the Edit Lead page
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• Campaign Members subtab on the View Campaign page

• Contact and Lead saved search pages in Workspace

Use the campaign summary data to view associated leads, contacts, opportunities, and revenue amounts. You can add
contacts and leads to marketing campaigns, and view only already added contacts or leads through the Campaign
Members subtab. The total number responding to a campaign represents the total count of campaign members who
have responded to a marketing campaign and can only be viewed from the Analytics subtab. Campaign members
include either leads or contacts that were sent or responded to a marketing campaign and have a status of Responded
or Sent. Note that the response is only counted once even when a campaign member has responded multiple times to
the same campaign.

Related Topics
• Enable the Campaigns Subtab and Add to Campaign Button in Leads

• Enable the Campaigns Subtab and Add to Campaign Button in Contacts

• Enable the Campaign Analytics Tab in Campaigns List Page

• About Campaign Management Reports
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31  Assessments

Overview of Assessments  
Assessments enable you to evaluate the condition of a business object, such as an opportunity or lead. Administrators
define assessment templates that consist of questions with scored responses and then make the assessments available
in the application.

During the assessment process, you're presented with assessment questions. Responses to the questions provide you
with immediate scoring and recommendations or follow-up business processes.

Assessments can consist of the following components:

• Questions

• Question ratings

• Responses, including free-form responses

• Scoring of the assessment

• Tasks to be performed based on feedback score

Setup Tasks  

How to Create Assessment Templates  
You can use assessment templates to analyze the condition of your business objects, such as opportunities or leads.
This topic explains the various tasks involved in creating an assessment template.

This table lists the business objects that support assessment templates, along with the setup task that you must use to
create templates for each object.

Business Object Task Name

Accounts
 

Manage Customer Center Assessment Template
 

Opportunities
 

Manage Opportunity Assessment Templates
 

Leads
 

Manage Sales Lead Assessment Template
 

The steps to create assessment templates is the same for all objects. Here's how to create an assessment template for
the Opportunity business object.

1. In the Setup and Maintenance work area, go to the following:
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◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Assessment Templates

2. Search for and select the assessment template setup task for the applicable business object.

For example, search for and select the Manage Opportunity Assessment Templates task. The Manage
Opportunity Assessment Templates page appears.

Assessment Template Basic Details
To create an assessment template for a business object, start by entering the basic details:

1. In the relevant business object's assessment template page, click the Create icon.
2. In the assessment template details page, enter the details shown here:

Field Description Example

Name
 

Enter a name for the template.
 

Note:  After you deploy a template, you
can't change its name or edit many other
aspects. If you need to make changes,
 make changes in a copy, and then deploy
the copy.

Discount Eligibility
 

Template Type
 

Select the type of template that you want to
create.
 
The template type options vary depending
on the object that you're creating the
template for. For example, if you're creating
an assessment template for opportunities,
 only the template types meant for
opportunities, such as Opportunity,
 Opportunity Product, and Opportunity
Contact are visible.
 

Opportunity
 

Template Set
 

Select the template set.
 
A template set is a reference data set that
contains one or more business units (BUs).
Selecting the template set ensures that the
template is available for use only to those
BUs that are part of this template set.
 

Common Set
 
Selecting Common Set makes the template
available for all BUs.
 

Description Optionally, provide a description. Discount eligibility assessment.
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Field Description Example

   

3. Add attachments if there is any information that might help the salesperson. For example, add a .pdf file that
contains information that might be helpful.

4. Click Next.

The Configure Ratings page appears.

Configuring Ratings
Ratings group question responses in a template into different categories. There are three predefined ratings: Poor,
Average, and Excellent. You can add your own ratings or modify the predefined ratings.

To add a rating:

1. Click the Add Row icon and enter Text and Description.
2. Click Next.

The Enter Questions and Responses page appears.

To modify a rating, just replace the text in the Text field.

Enter Questions and Responses
In this step, you create questions and responses, and also set a rating for each of the question responses.

The score range for ratings is derived automatically in the next step of the assessment template creation process based
on the rating you set here.

To create questions and responses:

1. Click the Create icon and select Create Question Group.

Note:  All questions must be part of a question group.

2. In the Create Question Group dialog box, enter Name and Description. For example, enter Deal and Question
group for deals respectively.

3. Click Save and Close.
4. Click the Create icon and select Create Question.
5. In the Create Question dialog box, enter details as shown in the following table:

Field Description Example

Question
 

Enter a question that you want in the
assessment template.
 

How soon will the implementation start?
 

Question Group
 

Select the question group to which this
question should belong.
 

Opportunity Question Group
 

Weight Enter the weight for this question. 50
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Field Description Example

  
Weight determines the relative importance
of a question within the assessment
template. The higher the weight for a
question, the more important this question
is compared to the other questions in the
template.
 
The sum of weights for all questions in a
template must be 100.
 

Note:
You can also enter the weight in a later
step, or even edit what you have entered
here in a later step.
 

 
This indicates that this question has 50%
importance compared to other questions in
the template.
 

Description
 

Optionally, provide a description.
 

Description for the opportunity question
group.
 

6. Click Save and Close.
Note:  In the Question Details section, select the Include Free-Form Response Option check box only if
you have a question that supports a free form response. Selecting this option adds a default response in the
Possible Responses section. Free-form responses are recorded as comments in consuming applications, and
they're not scored.

7. In the Possible Responses section, click the Add icon.
8. Enter details as shown in the following table:

Field Description

Response
 

Enter a response that the user can select for this question.
 

Score
 

Add the score that you want to allocate to each of these responses.
 

Note:
Score is displayed as Weight multiplied (*) by the (Normalized Score percent (%)) based on
the response selected. For example, the selected response's normalized score is 35 and the
question's weight is 20. So the assessment's score will be 20 * (35 %) = 7.
 

Normalized Score
 

This appears automatically once you fill in the score.
 
The response that has the highest score gets a 100%.
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Field Description

 

Rating
 

Define the rating that you want to assign to each of the responses.
 

Description
 

Optionally, provide a description.
 

Here's an example of the possible responses:

Response Score Normalized Score Rating

0 to 3 months
 

5
 

25
 

Poor
 

4 to 6 months
 

10
 

50
 

Average
 

7 to 12 months
 

15
 

75
 

Good
 

> 1 year
 

20
 

100
 

Excellent
 

9. Similarly, create all the questions that you want to include in this template along with the possible responses.
10. Click Next.

The Edit Question Weights page appears.

Edit Question Weights
You can use this page to verify the weights that you entered for all the questions in the previous step. Check whether
the weight total aggregates to 100. If not, you must update the weights to reach a total of 100. You can also use this
page to edit the weights of questions.

Click Next. The Configure Score Range Attributes page appears.

Configure Score Range Attributes
Depending on the scoring to response mapping in the questions and responses that you entered earlier, score ranges
for ratings are automatically derived here. You can select the Override score ranges check box to edit the automatically
derived score ranges and set different start and end scores for the ratings. You can modify the colors shown in the
various score ranges.

Based on the assessment score, feedback can be displayed for the assessment in the consuming application, such as in
opportunities. To provide feedback, enter the feedback in the Feedback field. For example, if the score is 95 and it maps
to Excellent as rating, you could enter feedback such as Qualified for discount pending manager approval.

Click Save and Close.

You have now completed creating your assessment template.
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Additional Implementation Steps
Once your assessment template is ready, you might have to perform some additional implementation steps before the
template is available for the user.

For opportunities, you must attach the template to a sales stage within a sales method:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. In the Manage Sales Methods page, create or edit a sales method, and then add or edit sales stages.
3. In the Create or Edit Sales Stage page, navigate to the Assessment Templates region.
4. Click Add.
5. Search for the template you want to associate with the sales stage and add the template.

When an opportunity is in the relevant sales stage, the sales representative can use the associated assessment
templates from the Assessments subtab.

Related Topics
• Overview of Assessments

• Considerations for Setting Up Assessment Templates

• Guidelines for Setting Up Opportunity Assessments

• Create and Edit Sales Methods and Stages

• Update Existing Setup Data

Implementation Concepts for Assessments  

Assessment Template Components  
The question weight, response score, and response rating are the assessment template components. They fit together
to calculate and display the overall assessment score, rating, and feedback text.

The assessment multiplies a question weight by a response score to achieve a weighted score for an
assessment template response. It adds the weighted scores for all responses together to determine
the total assessment score. This score falls within a score range calculated in advance, that's also
associated with a response rating and feedback text. Therefore, the score range within which the total
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assessment score falls, determines the rating and feedback text to display for a completed assessment.

Question Weight
The question weight is the relative importance of a question within an assessment template. The template expresses it
as a percentage. All of the question weights within a template must total to exactly 100. When you use an assessment
template, the template multiplies a question's weight by the score of the question response to produce a weighted score
for that response.

Response Score
A response score is the score that the template administrator assigns to a possible question response in the template.
The template administrator sets response scores with no upper or lower bounds. The template normalizes each score
to accurately score an assessment that uses the template. The template normalizes the response scores by assigning a
score of 100 to the highest response score. The template then assigns all other responses a normalized score relative to
that highest score.

When you use an assessment template, the template multiplies the normalized score of the question response by the
question's weight to produce a weighted score for that response.
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Response Rating
A response rating is:

• The rating assigned to a possible response to a question in the template.

• A textual qualification, such as Excellent or Poor that provides a metric other than a numeric score for
qualifying the outcome of an assessment.

A response rating relates directly to a response score, and this relationship should ensure that a higher score translates
to a higher rating.

Early in the template creation process, the administrator configures ratings to assign to responses. The administrator
then assigns scores and ratings to responses, and the application calculates score ranges based on those entries. The
application assigns each rating to a score range, and gives the administrator the opportunity to apply feedback text to
the rating-score range combination.

When you use an assessment template, the template adds the weighted scores from all responses to determine the total
assessment score. That score falls somewhere within the calculated score ranges. These ranges then determine which
rating the template assigns to the assessment and what feedback text to display. The maximum total assessment score
is 100.

Related Topics
• How Assessment Template Score Range is Calculated

Considerations for Setting Up Assessment Templates  
You can implement assessment templates to let salespeople analyze the health of a business object, such as a lead
or an opportunity, and suggest appropriate next steps based on its diagnosis. To best plan and create assessment
templates, you should consider the following points:

• Ratings

• Questions, question groups, and question weights

• Responses and scores

• Associated task templates

Ratings
A rating is a textual qualification, such as Excellent. There are three delivered ratings in the assessment template:
Excellent, Average, and Poor. Ratings provide a metric other than a numeric score to qualify the outcome of an
assessment. Ratings are created at the beginning of the assessment template creation process. They're later applied
to possible responses to questions in the template, which associates each rating with a score. Ratings display an
appropriate feedback based on the completed assessment score once you submit an assessment. When setting
up ratings and applying them to possible responses, remember that ratings and their associated feedback text will
eventually display as part of the overall assessed health of a business object.

Questions, Question Groups, and Question Weights
Questions are the main components of an assessment template. They're written to help in systematically determining
the health of a business object, and are grouped into logical collections called Question Groups. Each question in the
template is assigned a question weight. Question weight is expressed as a percentage, which is the relative importance
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of the question within the template. When you use an assessment template to perform an assessment, a question's
weight is multiplied by the normalized response score given for the question to produce a weighted score for that
question.

When setting up questions, question groups, and question weights, you must carefully analyze which factors determine
the health of a particular business object (like a lead or an opportunity) in your organization. Use those factors to create
your question groups; and then write three to five questions per group that are weighted according to your analysis.
There's no limit to the number of questions that can be in a question group, but each question group must have at least
one question.

Responses and Scores
Responses are attached to questions in the template. Each question should have at least two responses, unless it's a
free-form only question. More than one response can be tied to the same rating. However, between all of its responses,
each question should accommodate at least two ratings, unless it's a free-form only question. For example, if your
ratings are Excellent, Average, or Poor, for each question you can include two responses that correspond to at least one
of those ratings, such as average. There must be enough responses to cover at least two of the ratings, such as Excellent
and Average. You assign a score to each response for a question, and the application normalizes the score based on a
standard scoring scale.

When an assessment template is used to perform an assessment, a question's weight is multiplied by the normalized
score of the response given for the question to produce a weighted score for that response. When adding responses
to questions, ensure that the scores and ratings you assign to each response correlate. In other words, the higher the
score you assign to the response, the higher the rating should be so that you have a strong quantitative relationship
between the two. Also note that you can allow free-form responses for one or more questions in the template, but free-
form responses are never scored.

Associated Task Templates
A task template is an instruction to generate a group of related activities. You can associate task templates with an
assessment template to recommend tasks that should be performed after an assessment has been done for a business
object. When you associate task templates with an assessment template, you can indicate a score range for each task
template. Based on the total score of any assessment that uses your template, one or more task templates will be
recommended as follow-up activities. For a task template to be available to associate with an assessment template, it
must be assigned to the same business object type as that assigned to the assessment template, and it must have a
subtype of Assessment. Ensure that you have set up task templates correctly before associating them to assessment
templates.

Related Topics
• How Assessment Template Score Range is Calculated

• Assessment Template Components

• Assessment Template Status Codes

• How to Create Assessment Templates

What happens if I include a free-form response for a question?  
A score of 0 is assigned for free-form responses.
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A free-form response option has no effect on the overall assessment score. The free-form response offers the
opportunity to enter a textual response to a question that doesn't conform to any of the prepopulated responses
provided by the assessment template.

What's a question group?  
A question group is a logical grouping of questions within an assessment template, and is strictly used as a category
header for those questions. By naming the question group carefully, you can provide the template user an idea of the
type of questions to

Assessment Template Status Codes  
This topic explains the status codes for an assessment template. Throughout the life of an assessment template, you
can assign different status codes.

These status codes control the actions you're allowed to make against an assessment template.

• In Progress

• Active

• Retired

In Progress
This is the initial status of an assessment template. In this status, you can edit any part of the template. This is the only
status in which you can delete a template. If the template isn't deleted, it moves to the Active status.

Active
This is the status assigned when the assessment template is deployed for general usage. In this status, you can make
only minor textual edits to it, including, but not limited to, template description, question text correction, question
sequencing change, response description, and score range feedback. From this status, you can move the template to
Retired, but you can't delete it.

Retired
When an assessment template is in this status, it's no longer available for general usage. You can't edit any part of it,
and you can't move it to any other status. However, it can still be copied. Active templates that are deleted revert to this
retired status.

How Assessment Template Score Range is Calculated  
You calculate the score range for an assessment template using the question weights and the ratings and scores
assigned to the possible responses for all the questions in the template.
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This topic explains how the score range is calculated and the components that are used in the calculation, so that you
can make the best decision regarding the feedback text to apply to each score range. In addition to the automatic score
range calculation, you can manually adjust the score range by using the administration functionality.

Settings That Affect Score Range
In order for the application to calculate the assessment template score range, you must:

• Apply weights to all template questions.

• Configure ratings and apply them to possible responses for all template questions.

• Apply a score to each of the possible responses for all template questions.

How Score Range Is Calculated
The score ranges for each rating in an assessment template are determined using the lowest and the highest weighted
response scores for each question. So for each rating score range, the lower end of the range starts where the previous
rating range ended, and the higher end of the range is the sum of the highest weighted scores that can be attained for
that rating.

The following table displays a simple example of the components used in the score range calculation.

Question (Weight) Response (Normalized Score) Weighted Score Rating

What is the customer win? (20%)
 

Lower Operating Cost (100)
 

20
 

Excellent
 

What is the customer win? (20%)
 

Higher Revenues (80)
 

16
 

Average
 

What is the customer win? (20%)
 

Other (53)
 

11
 

Average
 

What is the customer win? (20%)
 

Don't Know (27)
 

5
 

Poor
 

What is our win? (80%)
 

Reference (60)
 

48
 

Average
 

What is our win? (80%)
 

Resale (50)
 

40
 

Poor
 

What is our win? (80%)
 

Partnership (100)
 

80
 

Excellent
 

The following table displays the score range calculation based on the components from the previous table.

Rating Score Range

Excellent
 

65 - 100
 

Average
 

46 - 64
 

Poor 0 - 45
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Rating Score Range

  

If a template administrator doesn't use a particular rating while assigning ratings to possible responses, this could result
in improper score range calculations. To counteract this problem, the score range calculation uses a built-in correction
algorithm to ensure proper score ranges. The correction algorithm works like this: For a question where a particular
rating is skipped, the low score for the skipped rating is calculated to be equal to the high score of the next lower ranked
rating. The high score for the skipped rating is calculated to be equal to the low score of the next higher ranked rating.

Using the ratings displayed in the tables in this topic, if the rating Average isn't used for a question's possible responses,
the score range calculation assigns a low score to Average for that question that's equal to the high score of Poor for
that question. It also assigns a high score to Average for that question that's equal to the low score of Excellent for that
question. This ensures that the overall template score range for Average is calculated to fall between the score ranges
for Poor and Excellent.

Opportunity Assessments  

Guidelines for Setting Up Opportunity Assessments  
When setting up and maintaining opportunity assessment templates, consider the implementation points described in
this topic.

You can find a procedure describing how to set up assessment templates in the How to Create Assessment Templates
topic.

Setup Task for Opportunity Assessments
In the Setup and Maintenance work area, the setup task for implementing opportunity assessments is Manage
Opportunity Assessment Templates.

Assessments Added to Sales Stages
Assessments are available to sales users only after you create an assessment template and then add the assessment
template to a sales stage within an opportunity sales method.

Mandatory and Recommended Assessments
When adding an assessment to a sales stage, you can mark the assessment as mandatory to be completed for the sales
stage. In this case, the user must complete the assessment before moving the opportunity to the next sales stage. If you
mark a template as recommended for a sales stage, the user isn't required to complete the assessment before moving
to the next sales stage.

Opportunity Access Levels for Assessments
The actions that you can perform with opportunity assessments depend on your access levels on an opportunity. This
table shows the access levels and actions.
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Access Level Allowable Actions

View Only
 

• View assessments in read-only mode

• Can't add assessments

Edit or Full
 

• Add assessments

• Edit assessments

• Delete assessments (if enabled)

Allowing Users to Delete Assessments
You may want to enable the Delete Assessment button in the Assessments page so that sales representatives can
remove an assessment and start over or remove an assessment that's no longer required.

You use Page Composer to add the Delete Assessment button. See the Configuring Applications Using Application
Composer guide for procedures.

Enable Multiple Assessments Per Template
To enable sales representatives to perform multiple assessments per assessment template, you must set the profile
option, Enable Multiple Assessments Per Assessment Template, to Yes.

Related Topics
• How to Create Assessment Templates

• Enable Multiple Opportunity Assessments Per Template

Enable Multiple Opportunity Assessments Per Template  
Often sales representatives want to re-assess opportunity information and perform several assessments for
opportunities using the same assessment template. To enable sales representatives to perform multiple assessments
per assessment template, you must set the profile option, Enable Multiple Assessments Per Assessment Template.

Set the Profile Option
Multiple assessments per assessment template isn't enabled by default. To enable the functionality, set the profile
option Enable Multiple Assessments Per Assessment Template (MOW_MULTIPLE_ASSESSMENTS_ENABLED) to Yes at
the site level. Follow these steps.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option display name
Enable Multiple Assessments Per Assessment Template in the Profile Display Name field.

3. In the search results list, click the profile option name.
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4. In the Profile Values section, select Yes from the Profile Value list.
5. Click Save and Close.

Related Topics
• Perform Multiple Opportunity Assessments Using the Same Template

• Update Existing Setup Data

Add Submit and Delete Assessment Buttons Using Page
Composer  
Salespeople can submit and delete assessments associated with their opportunities through the Edit Opportunity:
Assessment subtab. They must have Full or Edit access on the opportunity to submit or delete an assessment.

You must enable the Submit and Delete Assessment buttons in the Assessments page so that sales representatives can
submit an assessment or remove an assessment that's no longer required. You use Page Composer to add the Submit
and Delete Assessment buttons.

Here's how to add the Submit and Delete Assessment buttons to the Assessment page for opportunities using Page
Composer.

1. Sign in to the application as a user with the Sales Administrator job role. Or, sign in as a setup user.
2. To open Page composer, create and enter a sandbox with Page Composer as one of the tools and select Page

Composer from the Tools menu.
3. Activate a sandbox. The active sandbox name appears at the top of the page.
4. Click the user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.
5. With Page Composer in Direct Selection mode, in the Edit Assessment region of the edit opportunity page,

hover over the Save button.

A colored box appears around the field and its label.
6. Click inside the box around the Save button.
7. A dialog box opens with two options:

◦ Edit Component

◦ Edit Parent Component.

8. Select the Edit Parent Component option.
9. In the Component Properties dialog box, click the Children tab.

10. Select the check box next to both the Submit and Delete Assessment items.
11. Click Apply.
12. Click OK and close Page Composer.

For more information about using Page Composer, see the Configuring and Extending Applications guide.
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Lead Assessments  

Lead Assessments  
This topic outlines how lead assessment templates enable a uniform assessment implementation across leads for your
organization. Assessment templates provide guidance to sales resources to move the leads further along the sales
cycle. Using the lead assessment feature, you can:

• Define Lead Assessments Templates

• Associate Task Templates to Assessment Templates

• Assess Leads

Define Lead Assessments Templates
You can define assessment templates to include assessment questions that represent industry best practices, sales
methodologies, or a combination of both. As you enter the different responses to the questions, an assessment
progress bar provides immediate rating and feedback based on the assessment definition. You can also use assessment
templates to standardize lead follow-up procedures. Lead assessment templates enable consistent and predictable
assessment for all leads for your business unit.

Associate Task Templates to Assessment Templates
An additional component to the assessment is the ability to recommend additional tasks based on the assessment
results. If task templates are associated with the assessment, a list of recommended task templates is presented to you
based on the assessment's overall score. If applied, the tasks are added to the lead to support collaborative lead follow-
up activities.

Assess Leads
Lead assessment is typically done as part of a lead follow-up activity where the lead continues to be progressed after
the lead is qualified. The Lead Assessment Enabled profile option must be set by your administrator to display the
Assessments tab in the Edit Lead user interface. If enabled, you can view the sets of predefined questions and answers
collected to assist in evaluating the lead and perform these actions from the lead's Assessment tab:

• Perform New Assessments

• Edit Assessments

• Remove Incomplete Assessments

• Reassess

• View Historical Performance

Related Topics
• How to Create Assessment Templates

• What's the difference between lead qualification and lead assessment?
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Enable Multiple Assessments Per Lead Qualification Template  
Often sales representatives want to requalify sales lead information and perform several qualifications for leads using
the same qualification template. To enable sales representatives to perform multiple assessments per qualification
template, you set the profile option Enable Multiple Assessments Per Qualification Template to Yes.

Set the Profile Option
Multiple assessments per qualification template isn't enabled by default. To enable the functionality, set the profile
Enable Multiple Assessments Per Qualification Template (MOW_MULTIPLE_QUALIFICATIONS_ENABLED) to Yes at site
level. Follow these steps.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option display name
Enable Multiple Assessments Per Qualification Template in the Profile Display Name field.

3. In the search results list, click the profile option name.
4. In the Profile Values section, select Yes from the Profile Value list.
5. Click Save and Close.

Related Topics
• Perform Multiple Lead Qualifications Using the Same Template

• Update Existing Setup Data

Lead Score and Lead Rank Rule Setup  
Sales representatives need to score and rank leads so that the lead score determines the rank assigned to the lead. You
set up ranking rules based on the score.

Assessments and qualification templates let salespeople evaluate the health of a sales lead. Lead appear under a
separate tab labeled Qualification in the edit lead page. For more information, see the related topic, Example of Defining
a Sales Lead Qualification Template. Lead assessment is typically done as part of a lead follow-up activity where the
lead continues to be progressed after the lead is qualified. You must set the Lead Assessment Enabled profile option to
display the Assessments tab in the Edit Lead user interface.

Define Scoring and Ranking Rules
Define the scoring and ranking rules that you want sales representatives to use in the lead management application. For
example, you want to define the score ranges and corresponding rank and color values as shown in the table:
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Score Rank Name Color

1-30
 

Cold
 

Blue
 

31-60
 

Warm
 

Yellow
 

61-100
 

Hot
 

Red
 

This example shows that when the sales representative enters a score value of 50 when creating or editing a lead, the
rank automatically populates with the value of Warm, and the corresponding yellow color is displayed in the UI. The
same color for the score is used when the lead is viewed in a list.

Setting Up the Scoring and Ranking Rules
This table lists the default values for score and rank that's provided for you.

Minimum Score Maximum Score Rank Name Color

1
 

30
 

Cold
 

Green
 

31
 

60
 

Warm
 

Yellow
 

61
 

100
 

Hot
 

Red
 

The minimum score and maximum score are numeric text fields and they're required fields. The rank name is
determined from the list of values that can be modified from the Rank lookup type MKL_LEAD_RANK_SETID. You can
choose a color from your standard UI color widget.

Related Topics
• Example of Defining a Sales Lead Qualification Template

• Lead Assessments

• How to Create Assessment Templates

• How Assessment Template Score Range is Calculated
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32  Task Templates

Overview of Task Templates  
By creating task templates, you can present groups of tasks for salespeople working sales deals. For example, you can
create an opportunity task template that displays a set of tasks that need to be performed while working an opportunity.

The tasks generated from the templates are accessible to salespeople in the Activities tab within the applicable sales
business object work area.

You can create task templates for these sales business objects:

• Opportunity

• Lead

• Campaign

• Customer

Task templates have such attributes as name, status, type and subtype. Task templates can be striped by business unit
in a multiple-business-unit implementation, allowing you to have templates available only to a single set of users.

Related Topics
• Create a Task Template

• Create Tasks from a Task Template

Setup Tasks  

Create a Task Template  
When you create task templates, you first create a task template and then you create the individual tasks.

To get started, you must search for the appropriate task template setup task in the Setup and Maintenance work area.
Here's a list of the task template tasks for the supported business objects.

Business Object Setup Task

Opportunity
 

Manage Sales Task Templates
 

Lead
 

Manage Sales Lead Task Template
 

Campaign
 

Manage Marketing Campaign Task Template
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Business Object Setup Task

Customer
 

Manage Customer Center Task Template
 

Here's how to create a task template.

Note:  In this procedure, the opportunity business object is used as an example. However, the procedure to create task
templates is the same for all objects.

1. Sign in as the sales administrator or as a setup user.
2. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Sales Task Templates

3. In the Task Template section on the Manage Sales Task Templates page, click the Add icon.

The Create Template dialog box appears.
4. Enter the following in the Create Template dialog box:

Field Description Example

Template Name
 

Enter the name of the template.
 

Sales Coach
 

Description Template Set
 

Enter a brief description about the template
name, if required.
 

Sales coach template set.
 

Active
 

Indicates that the template is active. The
check box is selected by default.
 

Active
 

Template Type
 

The business object to which the task
template is associated is set as default.
 

Opportunity
 

Subtype
 

The default value is blank. If you want to
create a task template for assessment you
must select Assessment. Otherwise, leave
the field blank.
 

Assessment
 

Template Set
 

Select the template set (Set ID) that you
want to associate with your business unit.
 

Common Set
 

5. Click OK.

The task template is created.

784



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 32
Task Templates

6. To create tasks for the task template, click the Create icon in the Details section.

The Create Task dialog appears.
7. Enter the following in the Create Task dialog box:

Field Description Example

Subject
 

Enter the subject of the task.
 

Check Service Requests
 

Description
 

(Optional) Describe the task.
 

Service request task
 

Lead Time
 

(Optional) Enter the lead time for the task.
 

If you enter a lead time the task will begin
after those many days. If a task is created
from the task template on January 10, and
the lead time value is 2, then the task start
date is January 12.
 

Type
 

(Optional) Select a type for the task.
 

Call, Chat, Demo, E-Mail, Meeting
 

Template Duration
 

(Optional) Define the due date for the task.
The due date is calculated based on the
template duration value and the task start
date.
 
If the duration is blank in the template task,
 the task is created without a due date.
 

If a task start date is January 12 and the
template duration is set to 3, then the task
due date is January 15.
 

Priority
 

(Optional) Select a priority for the task.
 

High, Medium, Low.
 

8. Click OK.

The task is created for that task template.

Note:  After you create task templates, there may be additional steps needed for the tasks to display for end users. For
example, with opportunities, you associate the task template with sales stages (see the topics for opportunity sales
stages and sales methods setup for more information).

Example of Turning a Business Process into a Task Template  
This example illustrates how to create a task template that represents a business process.
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Scenario
A sales manager wants to create a task template for her department's client product demonstration process.

Client Product Demonstration Activities
The client product demonstration process occurs regularly. The sales manager doesn't want to manually create tasks for
this process every time it occurs, so she creates a task template that includes the business process activities. Each time
she repeats the business process, she can use the task template to automatically generate the appropriate tasks that
need to be performed.

The business process consists of these activities:

• Book a conference room.

• Create an agenda.

• Confirm the date and time with the client.

• Make arrangements with presenters.

• Deliver product demonstration.

• Follow up with client.

Client Product Demonstration Task Template
Based on the analysis of the business process, here's the task template she creates:

Task Template Name: Client Product Demonstration

Task Category Lead Days Duration Days

Book conference room
 

Preparation
 

1
 

1
 

Create agenda
 

Preparation
 

1
 

1
 

Confirm date and time with client
 

Call
 

5
 

1
 

Schedule presenters
 

Preparation
 

5
 

2
 

Deliver demonstration
 

Demonstration
 

7
 

1
 

Follow up with client
 

Call
 

10
 

1
 

Related Topics
• How Assessment Templates Work with Task Templates
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Implementation Concepts for Task Templates  

Define Tasks  
A task is a unit of work to be completed by one or more people by a specific completion date. Creating tasks can be
simplified by using task templates, which are groups of tasks.

Define Tasks
You define a task with a description, due date, and category. Each task has an owner, who oversees or is responsible for
the task, and one or more assignees who perform the work.

You can associate tasks with a business object, such as an opportunity, a customer, or one or more external contacts.
Tasks can also have notes for general information and attachments for tracking email or project documents.

Define Task Templates
Often, a process includes a set of tasks that users need to do repeatedly. To make repetitive tasks quicker and easier,
you can define task templates that salespeople then use when working on a particular business object. The salesperson
simply selects the appropriate task template for the process at hand, and the application creates the tasks and
associates them with the business object being worked.

Note:  You can modify the task object using Application Composer. For more information, see the Extending CX Sales
and Fusion Service guide.

Related Topics
• Create Tasks from a Task Template

What are the statuses a task can be in?  
Tasks can have the following statuses by default. You can change or delete these statuses, or add more to fit your needs.

Here's a list of task statuses and their meanings.

Status Meaning

Canceled
 

The task was canceled.
 

Complete
 

The task was completed. You can change this status to another one as needed.
 

In progress
 

The task is currently active and being worked on.
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Status Meaning

Not started
 

The task hasn't yet been started.
 

On hold
 

The task isn't actively being worked on, but hasn't yet been completed.
 

If a task is set to Complete, the Percentage Complete field for the task is set to 100 percent, and the end date is set to the
current date.

Note:  If you change the status of a Complete task to something else, the Percentage Complete field value doesn't
change automatically.

Assessments Integration  

How Assessment Templates Work with Task Templates  
One of the steps for creating an assessment template is associating task templates. You would take this step if you want
to recommend sets of tasks to be done after an assessment is performed using your template.

You associate task templates to ranges of scores in the assessment template, and where the overall assessment score
falls within those ranges determines the tasks that are suggested to be performed after the assessment.

788



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 32
Task Templates

Assessment Template
An assessment template is a set of weighted questions and possible responses used to evaluate the health of a business
object such as an opportunity or a lead. An assessment template can be associated with one or more task templates
that are recommended based on the outcome of an assessment.

Task Template
A task template is an instruction to generate a group of related activities. By marking a task template with a subtype
of Assessment, you make that task template available for association with assessment templates. The task template's
business object type should be the same as that assigned to the assessment template. When an assessment is
performed using an assessment template that has associated task templates, one or more task templates are
recommended based on the total score of that assessment and can be used to generate a list of activities to perform.

For example, you can associate a task template named Engage Business Development Manager, with your assessment
template, named Potential for Win-Win. Associate the task template with the score range of 86 to 100. If an assessment
using the assessment template Potential for Win-Win scores within that range, the application recommends the
Engage Business Development Manager task template and a list of follow-up activities based on that template can be
generated.

Related Topics
• Example of Turning a Business Process into a Task Template

• How can I create a task template that's available to associate with assessment templates?
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Associate Task Templates with Assessment Templates  
You can associate task templates with assessment templates to recommend tasks to salespersons based on the
assessment outcome. As a result of the association, a set of related tasks appear as follow-up activities after a
salesperson completes the assessment for an object.

Task templates are predefined, individual tasks that you can group together and associate with an object. Template
tasks are a set or group of individual tasks from the task template. You can only create a task template for these objects:

• Opportunity

• Lead

• Campaign

• Customer

Note:  To be available for selection, the task template must have a subtype of Assessment and belong to the same
object as the assessment template. For example, when creating an assessment for an opportunity, you must select an
opportunity task template.

Here's how to associate task templates:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Assessment Templates

2. In the Manage Opportunity Assessment Templates page, click Create and follow the setup steps.

Note:  The last task in the setup flow is to associate task templates.

3. Navigate to the Associate Task Templates page.
4. Click the Create icon.
5. Select the task template that you want to associate with the assessment template.
6. Click OK.

The selected task template appears in the Associate Task Templates page.

Note:  If you enter a score range, you can view the task template only when the assessment is within that
score range.

7. Click Save.

The task template is now associated with the assessment template.
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Related Topics
• How Assessment Templates Work with Task Templates

• Considerations for Setting Up Assessment Templates

• Assessment Template Components

• How to Create Assessment Templates

• Perform an Opportunity Assessment

How can I create a task template that's available to associate with
assessment templates?  
Create the task template with a subtype of Assessment.

Partner Integration  

Create Partner Task Templates  
A task template is a group of tasks associated with a business object, such as Partners.

Users with the Customer Relationship Management Application Administrator or Application Implementation
Consultant job roles can use the Manage Partner Task Template setup task to create task templates for partners.
Channel managers and partner administrators can then use these templates to quickly create multiple tasks with a
single click. The tasks generated from the template are accessible to users in the Activities subtab on Partner pages.

By default, this feature is hidden, however sales administrators can use Application Composer to expose a 'smart' Create
Task button on the Embedded task list of the Activity object. When a valid task template has been created, a Create
Tasks from a Template option is available from the Create Task button. If no valid task templates have been created, then
the Create Task button functions as it always has.

The process of creating task templates and making them available to channel managers and partner administrators
involves the following:

1. Create the task template and create the individual tasks for the template.
2. Expose the 'smart' Create Task button on the Embedded task list of the Activity object.

Create a Partner Task Template
Users with the Customer Relationship Management Application Administrator or Application Implementation
Consultant job roles can use these steps to create task templates for partners.

1. Sign in with your Customer Relationship Management Application Administrator or Application Implementation
Consultant credentials.

2. Navigate to the Sales offering in Setup and Maintenance.
3. Search for and select the Manage Partner Task Template setup task.
4. On the Manage Partner Task Template page, click the Create icon.
5. On the Create Template pop-up, provide information in the following fields:
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The following table lists the fields available on the Create Template pop-up and provides a description for each
field.

Field Description

Template Name
 

Enter the name of the template.
 

Description Template Set
 

Enter a brief description about the template name, if required.
 

Active
 

Selecting this check box indicates that the template is active. The check box is selected by
default.
 

Template Type
 

The business object to which the task template is associated is set as default. For partner task
templates, the template type is Partner Profile.
 

Subtype
 

The default value is blank. If you want to create a task template for assessment you must select
Assessment. Otherwise, leave the field blank.
 

Template Set
 

Select the template set (Set ID) that you want to associate with your business unit.
 

6. On the Create Template pop-up, click OK.
7. To create tasks for the task template, click the Create icon in the Details section.
8. On the Create Task pop-up, provide information in the following fields:

The following table lists the fields available on the Create Task pop-up and provides a description for each field.

Field Description

Subject
 

Provide a subject for the task.
 

Description
 

(Optional) Describe the task.
 

Lead Time
 

(Optional) Enter the lead time for the task.
 

Type
 

(Optional) Select a type for the task.
 

Template Duration
 

(Optional) Define the due date for the task. The due date is calculated based on the template
duration value and the task start date.
 
If the duration is blank in the template task, the task is created without a due date.
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Field Description

Priority
 

(Optional) Select a priority for the task.
 

9. On the Create Task pop-up, click OK.
10. Click Save and Close to save your work

Add the Smart Create Task Button to Activity Pages
Use these steps to replace the Create Task button with the 'smart' Create Task button on Activity pages.

1. Sign in with your Sales Administrator credentials.
2. Ensure you are in a sandbox.
3. From the Navigator, click Application Composer.
4. From the list of Standard objects, expand Activity.
5. Click the Pages link.
6. In the Activity Pages list, scroll down to the Embedded Task List Overview page.
7. Duplicate the standard layout and click Create and Edit.
8. On the Edit Layout page for your duplicate layout, click the Edit icon for the Embedded Task List Overview

Table.
9. In the Configure Detail Form: Buttons and Actions area, move the Create Task + Create Task From Template

button from the Available Buttons column to the Selected Buttons column.
10. In the Configure Detail Form: Buttons and Actions area, move the Create Task button from the Selected

Buttons column to the Available Buttons column.
11. Click Save and Close and click Done to save your work.
12. Publish your sandbox.
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33  Forecasting

Enable Forecasts with Quick Setup  
You can set up quarterly forecasts with one step.

Skip the Quick Setup if you already enabled forecasting by opportunity owner in Setup Assistant. If you already set up
dimensional territories or plan to do so, then use the Select Forecasting Options task instead of the quick setup.

These prerequisites are likely already done.

1. Set up your accounting calendar. The periods must be either monthly or quarterly.
2. Set up your hierarchy of sales resources.

To enable forecasts:

1. Enable one territory dimension and activate.

a. In the Setup and Maintenance work area, go to the following:

- Offering: Sales
- Functional Area: Territories
- Task: Enable dimensions and Metrics

b. Click Select and Add to enable one dimension, such as Account Type.
c. Save and close.
d. Click Load and Activate.

2. Create at least one opportunity with a future close date.
3. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Forecasting

4. Click Quick Setup, the gear icon in the Functional Area.
5. In the Configure Simplified Sales Forecasting page, the two options are selected for you. Click Submit.

Your submission sets up all these areas for you.

• You have a territory hierarchy to match your sales resource hierarchy, with the resources as territory owners.
The Refresh Territories from Resources process synchronizes your territories to match your latest resource
hierarchy. The territories have Resource-Centric coverage and are called Resource-Centric territories. (The
process requires at least one enabled territory dimension.)

• Opportunities are automatically assigned to territories by owner.

• Forecasts roll up the territory hierarchy.

• You have quarterly forecasts.

• Salespeople can adjust their forecasts each month if your accounting period is monthly.

• You can forecast product totals.

• The Forecasting Autopilot process runs every hour.
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Remove Your Resource-Centric Territory Hierarchy
If you used the quick setup and then decided you won't use the resource-centric territory hierarchy, you can remove it.

1. Navigate to Scheduled Processes.
2. Click Schedule New Process.
3. Find Refresh Territories from Resources.
4. Click OK.
5. In the Diagnostic Parameters field, enter from_resource=-1
6. Click Submit.

Overview of Forecasts  
Your forecasts of future sales provides predictions of future revenue for specific time periods. Management uses sales
forecast data to set production schedules and volumes, to determine resource requirements, and to report financial
guidance to investors.

What You Can Do Details

Submit forecasts
 

You can view, manage, and submit your forecasts in the office and using the mobile application. You
can:
 

• Review your forecasted product items and submit the forecast.

• View your pipeline that isn't forecasted.

• Use embedded analytics to improve forecast accuracy.

View automatically generated forecasts
 

Your forecast for a period is automatically generated from eligible opportunity product items
scheduled to close within the period. Forecasts are refreshed from the pipeline revenue in real time.
Opportunities and forecast items continue to synchronize until you submit forecast items for final
approval.
 
The sales administrator sets the criteria that determine whether a product item is eligible to be
automatically included in a forecast. The administrator also provides the option for you to override the
established criteria and manually include or exclude a product item from the forecast.
 
Forecasting reflects any edits you make to an opportunity, or any adjustments at the deal level in real
time.
 

Forecast by territory
 

You forecast sales by territory. The forecasts roll up following the territory hierarchy. If enabled,
 subscription renewal forecasts roll up in a separate column from new forecasts that aren't renewals.
The Forecast column shows the total for both new and renewal forecasts.
 
Changes to the active territory hierarchy are periodically synchronized with the forecast hierarchy up
until a freeze date. After the territory freeze date, you can make changes to your forecasts.
 

Compare forecasts
 

You can view current, future, and past forecasts. The current forecast is open for editing at certain
times and then frozen. Your manager can view the latest forecasting data and compare it to key
metrics such as pipeline and won revenue.
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What You Can Do Details

Adjust forecasts
 

Sales managers can review and adjust forecasts anywhere. Subscription renewals can be adjusted
separately by choosing the Renewals category to display. The New category shows all except renewals.
Select All to see the total forecast.
 

Manage subordinates' forecasts
 

You can quickly see which salespeople have submitted their forecasts, what has changed since the
previous forecast, and the opportunities that comprise the forecast. You can also drill into your
subordinates' forecasts to view a forecast the same way that the salesperson sees it. This provides
sales managers with the opportunity for more effective coaching and greater forecast accuracy.
 
You can add, remove, or adjust individual lines in a salesperson's forecast, segment the totals by
time period, and override forecast totals for each salesperson. Any adjustments are clearly identified
throughout the forecast hierarchy, allowing management to quickly view the changes made by sales
managers who are on their team.
 

Record overlay forecasts
 

You can record overlay forecasts on opportunity revenue transactions in addition to the revenue
sales credit split. Overlay forecasts allow nonprimary salespeople to forecast sales expectations for all
overlay sales credits.
 

Forecast by product
 

If enabled, you can forecast by product, forecasting amount, and quantity. If your products include
subscriptions, you can forecast subscription renewals separately from new forecast items by choosing
the category.
 

Setup Tasks  

Overview of Implementing Forecasting  
Salespeople forecast sales by territory as well as by individual salesperson or other resources. The application generates
forecasts from opportunities according to configured options.

Revenue for opportunities with close dates that fall within a forecast time period is added into the forecast for that time
period for the related territory and salespeople for that opportunity. Here's a high level look at what you need to do to
implement forecasting:

1. Configure territories.
2. Configure opportunities.
3. Enable forecasting from the Select Forecasting Options task.

The application generates your forecast submission windows and sets default forecasting options. It also
schedules the required forecasting background processes.

4. Change forecasting options and submission window dates, if needed.

Related Topics
• Enable Forecasting
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Enable Forecasting  
You must enable forecasting if you want salespeople to predict future sales. When you first implement forecasting, you
have a schedule of quarterly forecasts with monthly submissions.

The forecast periods extend one year into the future. You can modify these initial settings at any time.

Here are initial settings in the Forecast Period Parameters region of the Select Forecasting Options page used to
generate your forecast submission windows.

Field Explanation Provided Values

Forecast Period
 

Each forecast includes only those opportunities
set to close in the forecast period.
 

Quarter
 

Adjustment Period
 

This read-only field displays the type of period
you selected when you set up your accounting
calendar. Typically and for Vision Corp. this is a
month.
 

This field isn't editable.
 

Forecast Frequency
 

The number of submission windows you want
for each forecast period.
 

3
 

First Forecast Due Date
 

The date you want the first submission window
to end relative to the forecast period. The
application takes the forecast snapshot at the
end of the day.
 

For the first forecast submission window to
end on the last day of the first month in each
quarter, you see 31days After the forecast
period start date.
 

First Territory Freeze Date
 

The number of days before the end date when
you want the submission window to start.
 
Any sales territory changes after this
freeze date are ignored and applied only to
subsequent forecasting windows.
 

For the forecast submission windows to start
at the beginning of each month, the number
provided is 31.
 

Number of Concurrent Forecasts
 

A concurrent forecast is where two or more
forecast periods can both be updated at the
same time.
 

This field is set to 1 and the scheduled forecasts
are generated with no gaps in between
forecasts freeze dates and due dates. The
freeze date of the first forecast is set to the due
date of the next scheduled forecast.
 

Number of Scheduled Periods
 

The number of forecast periods you want to
view.
 
Managers can only adjust the forecast for the
current period during the submission windows
you generated, but you can view the forecasts
for subsequent periods.
 

The number of forecast periods is set to 4 for
the whole year.
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These additional options were also set for you.

• Opportunity items that match the forecasting criteria are added to the forecast according to their scheduled
close dates. the provided forecast criteria is win probability greater than or equal to 70 percent.

• Selecting the Enable Forecast Criteria Override option makes it possible for salespeople or their managers
to include or exclude an opportunity from a forecast regardless of its win probability. It wasn't selected for
you when you enabled forecasting. Select the option if you're following the Getting Started use case. Then
salespeople can make a selection from the Include in Forecast list while editing an opportunity.

• The Enable overlay forecasting option is deselected.

• The Enable Product Totals option was selected for you. Users can adjust forecasts by product rather than by
territories. Selecting this option displays the Products tab in the Edit Forecasts window where users can make
the adjustments.

• The number of sales catalog levels you can edit in the Products tab is set to 2 in the Product Hierarchy Depth
field.

• Pipeline and Closed Revenue metrics were enabled. The Forecasts landing page displays a Forecast Overview
chart that compares your forecast with won revenue and open pipeline. It also displays a second bar chart that
shows your forecast by time periods.

Enable Forecasting
To enable forecasting:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Forecasting

◦ Task: Select Forecasting Options
2. Select Enable Forecasting.
3. Click Submit.
4. Background processes run to generate your forecasts and are scheduled to run periodically to keep your

forecast up to date.

You can work in your generated forecasts. You can also navigate to Select Forecasting Options and make changes to
options and to forecast period dates.

Generate Forecast Submission Windows and Set Forecasting
Options  
After you enable forecasting, you can make changes to match your business practices using the Select Forecasting
Options page. Set how far in advance and how frequently you forecast and generate the forecasting submission
windows.

You can also change the criteria that determine which opportunities to include in a forecast and you can permit
adjustments by product or by territory.

Select Forecasting Options Page Overview
This table highlights the regions shown in the image and provides an overview of the entries described in detail in the
sections that follow the image.
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Callout Number Region Name Overview

1
 

Forecast Period Parameters
 

Enter the parameters that the application uses
to generate the dates for each forecast and the
forecast submission windows.
 
During each window, your sales organization
can update the forecast for the current period.
Usually this window starts right after the last
forecasting call with sales management and
ends just before the next one.
 
At the end of each window, the application
takes a snapshot of your organization's
forecasts so the forecasts are ready for your
call.
 
The generated submission windows appear
in the Scheduled Forecasts region where you
can adjust them to conform with your actual
forecasting schedule.
 
The automatically generated submission
windows are approximations only, so you must
adjust the dates manually.
 

2
 

Forecast Criteria
 

Enter the criteria the application uses to
determine which opportunities to include in the
forecast.
 

3
 

Product Tab
 

Enable Product Totals was selected for you
to enable the Products tab. Sales managers
use the tab to adjust forecasts by product
group rather than by territories. Deselect
Enable Product Totals to enable adjustments by
territories.
 

4
 

Metrics
 

The selected metrics are pipeline and closed
revenue for the pipeline/won graph. The Quota
selection enables the Forecast/Quota graph.
 

5
 

Additional Settings
 

Use this region to enable the forecast trend
graph and adjustment notes. You can also
disable resource forecasting.
 

6
 

Scheduled Forecasts
 

The application displays the generated forecast
submission windows in this region. You can
manually adjust the dates of each submission
window as needed. For example, the forecast
due date can't be later than the end date for the
forecast period.
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These UIs are described in the table.
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Create the Forecast Submission Windows
You generate the forecast submission windows on your calendar by entering parameters in the Forecast Period
Parameters region. Each submission window is defined by these dates:

• It starts on a Territory Freeze Date (indicated by callout 1 in the figure)

• It ends on the forecast Due Date (callout 2)

Here's what happens before each freeze date:

• The forecast is read only.

• Changes to the territory and product hierarchy are synchronized to the forecast.

• Changes to opportunity items are synchronized to forecast items.

Here's what happens after each freeze date:

• Sales users can edit, adjust, and submit forecasts.

• Changes to opportunity items are synchronized to forecast items.

• Salespeople must adjust and submit their forecast between the territory freeze date and the due date.

Submission windows occur between arrows one and two for January, February, and March.

After salespeople submit their forecasts, they can't edit them, but the forecasts can be adjusted by managers. After the
due date is reached, each forecast becomes read-only.

1. In the Setup and Maintenance work area, go to the Select Forecasting Options task:

◦ Offering: Sales

◦ Functional Area: Sales Forecasting

2. In the Forecast Period Parameters region, enter the options to generate forecasts and the approximate forecast
submission windows.

This table describes the options and provided values for submitting monthly forecasts for the current quarter.

Field Explanation Provided and Suggested Values

Forecast Period
 

Typically a quarter. Each forecast includes
only those opportunities set to close in the
forecast period.
 

Quarter
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Field Explanation Provided and Suggested Values

Adjustment Period
 

This read-only field displays the type of
period you selected when you set up your
accounting calendar. Typically and for Vision
Corp. this is a month.
 

This field isn't editable.
 

Forecast Frequency
 

Enter the number of submission windows
you want to generate for each forecast
period.
 

Because you hold a forecasting call each
month and there are three months in each
quarter, the value is 3.
 

First Forecast Due Date
 

The date you want the first submission
window to end relative to the forecast
period. The application takes the forecast
snapshot at the end of the day.
 

For the first forecast submission window
to end on the last day of the first month
in each quarter, you see 31 in the First
Forecast Due Date field and the After the
forecast period start date option selected.
 
The application generates the subsequent
submission windows based on the number
of days you enter here and in the Territory
Freeze Date field, but because each
calendar month has a different length,
 entering 31 generates submission windows
with some overlap.
 
During overlapping submission windows
salespeople and their managers see two
forecast submission windows, but you can
choose to ignore these overlaps or adjust
the dates after you generate the scheduled
forecasts.
 
Forecasting periods can overlap and can
have gaps, but any gaps result in periods
where users can't submit or edit their
forecasts.
 
 

First Territory Freeze Date
 

The number of days before the end date
when you want the submission window to
start.
 
Any sales territory changes after this
freeze date are ignored and applied only to
subsequent forecasting windows.
 

For the forecast submission windows to
start at the beginning of each month, the
number provided is 31.
 

Number of Concurrent Forecasts
 

A concurrent forecast is where two or more
forecast periods can both be updated at

After you enable Forecasting the value is 1
and the scheduled forecasts are generated
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Field Explanation Provided and Suggested Values

the same time. You can limit the number
of concurrent forecasts and the generated
periods
 

with no gaps in between forecasts due dates
and following freeze dates. The due date
of the first forecast will be set to the freeze
date of the next scheduled forecast.
 
If you enter 2, then the scheduled forecasts
are generated so that both the current
period and the next period are frozen at
the same time, and there will be no gaps
in between forecasts due dates and freeze
dates. The due date of the first forecast
will be set to the freeze date of the next
scheduled forecast.
 
If the value is left blank, then the generated
forecast dates can have gaps or overlaps.
 

Number of Scheduled Periods
 

The number of forecast periods you want to
view.
 
Managers can only adjust the forecast for
the current period during the submission
windows you generated, but you can view
the forecasts for subsequent periods.
 

The number of forecast periods is set to 4
(four quarters) for the whole year. You can
change the number of forecast periods.
 

3. If you modified forecast period options, then click Submit.
4. The Forecast Autopilot process runs at the next scheduled time. It reschedules the other processes. The

processes regenerate your forecasts. The Select Forecasting Options page is unavailable until the processes
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completes. When the process completes, the generated submission windows appear in the Scheduled
Forecasts region. The windows will look similar to what's included in the next table.

◦ The Forecast Name

The system-generated name for each submission window.

◦ Start Date

The start date of the forecasting period, the beginning of the quarter.

◦ End Date

The end date for the forecasting period, the end of the quarter.

◦ Territory Freeze Date

The start date for the forecast submission window.

◦ Due Date

The end date for the forecast submission window, the period when the sales organization can adjust
forecasts. At the end of this date the application takes a snapshot of the forecast and opens a new
window.

The forecast is frozen on the due date regardless if users click the submit button. After the due date
passes, the active forecast is marked as past, and the next forecast is marked as active.

5. Click the Select Forecasting Options task link again.

The Select Forecasting Options page shows the status of the period generation process. The status doesn't
refresh automatically, so you may have to click Cancel to return to the Setup and Maintenance work area and
try again later.

Forecast Name Start Date End Date Territory Freeze Date Due Date

Q3-2023 -2023/08/01
 

7/1/2023
 

9/30/2023
 

7/1/2023
 

8/1/2023
 

Q3-2023 -2023/08/31
 

7/1/2023
 

9/30/2023
 

8/1/2023
 

9/1/2023
 

Q3-2023 -2023/08/31
 

7/1/2023
 

9/30/2023
 

9/1/2023
 

9/30/2023
 

Q4-2023 - 2023/11/01
 

10/1/2023
 

12/31/2023
 

10/1/2023
 

10/31/2023
 

Q4-2023 - 2023/12/01
 

11/1/2023
 

12/31/2023
 

11/1/2023
 

12/1/2023
 

Q4-2023 - 2023/12/31
 

12/1/2023
 

12/31/2023
 

12/1/2023
 

12/31/2023
 

Note:  If you're in the middle of a quarter, for example Q3, the application may only generate one or two
scheduled forecasts for that quarter.
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6. Because the periods are generated based on a fixed number of days you entered as parameters and the
number of days in a month varies, you must modify the start and end dates of each submission window by
entering new dates in the Territory Freeze Date and Due Date fields. You can enter today as the freeze date,
but not a date in the past. Make sure your due dates aren't later than the forecast period end date, or dates in
the past.

Note:  The application automatically generates new submission windows at the end of each quarter. You
must continue to manually adjust these windows as they're generated.

7. Click Submit when you're done.

Set Forecasting Criteria
Opportunity items that match the forecasting criteria are added to the forecast according to their scheduled close dates.

1. The provided criteria is win probability greater than or equal to 70 percent. You may want to specify the
probability that matches the default probability of the appropriate sales stage in your sales method. You can
add or use other criteria.

Note:  By default, the win probability and close date are set at the opportunity level. To forecast at the level
of individual opportunity lines, expose the win probabilities for the lines in the Edit Opportunity page using
Application Composer.

2. Selecting the Enable Forecast Criteria Override option makes it possible for salespeople or their managers
to include or exclude an opportunity from a forecast regardless of its win probability. It wasn't selected for you
when you enabled forecasting. If you select the option, then salespeople can make a selection from the Include
in Forecast list while editing an opportunity.

If you don't want users to use this list, then you must hide this field on the opportunity UI by using Application
Composer. Leaving the Enable Forecast Criteria Override option deselected doesn't by itself prevent users
from making a selection from the list.

Note:  Even when you disable the Include in Forecast list, users can always edit an opportunity to exclude it
from the forecast, for example, by entering a different win probability.

3. Select the Enable nonrevenue forecasting option if you want to generate separate forecasts for overlay
territories.

Enable Forecast Adjustments by Product
You can choose to adjust forecasts by product:

1. The Enable Product Totals option was selected for you. Users can adjust forecasts by product rather than by
territories. Selecting this option displays the Products tab in the Edit Forecasts window where users can make
the adjustments. See callout 1 in the figure at the beginning of this topic.

2. The number of sales catalog levels you can edit in the Products tab is set to 2 in the Product Hierarchy Depth
field. To improve usability, Oracle recommends setting the depth to 1 unless there's a compelling business need
to break the forecast out beyond the first level of the product group hierarchy.

Adjustment Notes, Forecast Trend Graph, and Resource Forecasting Settings
The Forecasts landing page displays a Forecast Overview chart that compares your forecast with won revenue and
open pipeline. It also displays a second bar chart that shows your forecast by time periods. If you enable the Quota
metric, then the landing page displays a quota to forecast chart instead of the forecast by period. Your third option is
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the forecast trend graph to be the second chart. If enabled, sales managers can add notes about their adjustments when
they adjust forecasts. These aren't enabled for you. To enable adjustment notes and the forecast trend graph:

• Select Enable Forecast Trend Graph to replace the period bar graph, or the quota chart if you use quotas, with
the forecast trend graph.

For the displayed territory, forecast period, and type of forecast, you can see these graphs:

◦ Current and past forecast snapshots

◦ Won revenue trend

◦ Quota

• Select Enable Adjustment Notes to enable notes for adjustments. Sales managers can then add adjustment
notes for each forecast item. They can also create and edit a single adjustment note for summary territory
adjustments or a note for summary product adjustments.

• The Enable Resource Forecasting option is selected if you used the Quick Setup. It's deselected if you used the
Enable Forecasting task. Here's what happens if you make changes to the Enable Resource Forecasting setting:

◦ If you deselect Enable Resource Forecasting, then it will automatically delete all the resource territories
and switch off owner-based assignment of opportunities. The Refresh Forecast process deletes resource
territories from any future forecasts. Current active forecasts retain the resource territory hierarchy. You
can set up dimensional territories and assignment will again work for the dimensional territories.

◦ If you select Enable Resource Forecasting under Additional Settings after defining some dimensional
territories, then the resource territory hierarchy is created under your existing Global territory. Your
assignment settings change to assign opportunities by owner. The Refresh Forecast process deletes
dimension territories from any future forecasts. Current active forecasts retain the existing territory
hierarchy.

Implement Unit Forecasting  
You can forecast by territory and amount, by product and amount, and by product and quantity of units. This topic
explains the steps to implement unit forecasting.

Opportunity items often include quantity, price, and either a calculated amount from quantity and price or an entered
amount. The opportunity items are aggregated into forecasts by close date using these methods:

• Total the amounts for the time period and territory.

• Total the amounts for the time period and by product.

• Total the quantities for the time period and by product.

When you first enable forecasting, forecasting by product is the default setting. Only the amount (quantity times price)
is forecasted. You can make changes to forecast quantity.

1. In the Setup and Maintenance work area, go to the Manage Forecast Metrics task:

◦ Offering: Sales

◦ Functional Area: Sales Forecasting

2. In the Lookup Codes region, find the lookup code ORA_QUANTITY and check the Enabled box.
3. Save and close.
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Quantity is enabled for the Products tab and can be edited in the Forecast Items tab.
4. In Select Forecasting Options, the Summary Tab region, select Enable Product Totals.

The Edit Forecast page will include the Products tab.
5. Select the number of sales catalog levels you want to edit in the Product tab in the Product Hierarchy Depth

field. Oracle recommends setting the depth to 1.

Implement Renewal Forecasting  
When a customer subscription renews, the opportunity revenue line is set to Renew, and it's included in the Renewal
forecast, if enabled.

Set the profile option to enable renewal forecasting:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

2. Search for and select the profile option, ORA_ZSF_ENABLE_RENEWAL_FCST, Enable Renewal and Net New
Forecasting.

3. In the Profile Values section, set the value to Y at the site level.
4. Save and close.

Managers can adjust forecasts for renewals separately from the traditional new forecasts. They can select New, Renewal,
or All from a Category list.

Implementation Concepts for Forecasting  

Sales Forecast Components  
Several things come together to make up your forecast, and you have several ways to control forecasts. This chart works
from the bottom up, much like your forecast.
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The components in the chart are explained here.

• You have one or more territories, and the territories form a hierarchy. It's likely your manager owns a parent
territory to yours.

• You have sales opportunities. An opportunity contains one or more product items, and each product item is
assigned to a territory. In this case, your territory.

• The close date of each product item determines which forecast includes it. A product item with a February close
date appears in the First Quarter forecast.

• If your product item matches the criteria set for the forecast, then it's included in your forecast. An example of
criteria is the win probability must be greater than 70 percent.

• If your product item doesn't match the criteria, you can use the criteria override to manually include the item in
your forecast. Or you can manually exclude one that does match.

• As the primary salesperson for the product item, you count the revenue credit in your forecast and it rolls up to
the parent territory revenue forecast.

• You can forecast an overlay credit for a product item owned by someone else. You have separate overlay
forecasts to track overlay credits.

• Open product items and won items added together form your original forecast for a specific territory and
forecast period, such as the first quarter. You can then make adjustments to product items and to your overall
forecast. You now have your adjusted forecast and you can submit it to your manager.

Forecast Criteria  
You set the forecasting criteria that determines what product items are automatically included in the sales forecast. The
product items become the total forecast amount before adjustments.
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Your forecast includes open forecasted items and items closed as won. The items also meet these criteria:

• The item close date falls within the forecast period.

• The item is assigned to your forecasted territory.

• The item matches the forecast criteria. For example, include in the forecast all product items with a win
probability greater than 70 percent. Or, You set the override for the forecast item to always include it in the
forecast.

You can keep items out of your forecast by setting the override to never include an item in the forecast. Items closed as
lost don't appear in your forecast.

Forecast Criteria Logic
The logic joins each set criterion with AND. If two criteria are for the same attribute and use equals, then they're joined
by OR.

Here are example criteria:

• Status = Open

• Status = WIP

• Product <> CRM

• Product <> ERP

• Win Probability > 20

• Win Probability < 80

Here's how the criteria are translated logically:

• (Status = Open OR Status = WIP) AND

• Product <> CRM AND

• Product <> ERP AND

• Win Probability > 20 AND

• Win Probability < 80

Related Topics
• Overlay Forecasts

• Set Opportunity Revenue Forecast Criteria

Overlay Forecasts  
Overlay resources who aren't the owners of the primary territory can submit a forecast on the same revenue as the
primary sales resource. The primary sales resource submits a prime forecast, and the amount should be counted only
once for the prime forecast.

The overlay resource submits an overlay forecast, counting the same revenue a second time. If multiple overlay
resources forecast the same deal, then the same revenue amount can be added to the overlay forecast many times. A
primary resource for one territory can submit an overlay forecast for another territory, so the context of the territory
determines if a user is submitting a prime or an overlay forecast.
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Users can submit both prime and overlay forecasts. In this case, management often expects a certain ratio of prime to
overlay amounts. Management can further analyze any major discrepancy from the ratio. The overlay forecast is taken
from the nonrevenue credit split within opportunities, and is closely associated with the nonrevenue quota goals set on
the territory.

The administrator must enable overlay forecasting using the Enable nonrevenue forecasting check box in the Select
Forecasting Options page before salespeople can add to overlay forecasts.

Territories
In the Enable Forecasting field, you can designate territories as disabled for forecasts, or as forecastable for prime, for
overlay, or for both.

An owner of an overlay territory can't access a prime forecast, and an owner of a prime territory can't access an
overlay forecast. However, when managing revenue, it's possible to assign a revenue split to an overlay territory or a
nonrevenue split to a prime territory.

Territory Freeze Date  
You can begin forecasting activities on the territory freeze date. The territory hierarchy used for forecasts freezes on this
date. Forecast rollups from territories to parent territories follow the frozen hierarchy until the forecast due date.

Salespeople can submit their forecasts only after the territory freeze date and before the forecast due date. The territory
hierarchy freezes at 12:00 AM server time on the day of the territory freeze date. Therefore, if you set the territory freeze
date to today it's immediately effective.

The primary territory for an opportunity can change due to territory realignment. The forecast item reflects this and
other changes made to the opportunity both before and after the territory freeze date, up until the forecast item is
locked. When you adjust Forecast items they become individually locked. When you perform a summary level forecast
adjustment or submit your forecast your entire forecast is locked.

If the forecast is frozen and the administrator extends the freeze date, then all submitted forecasts are unsubmitted and
all the forecasts are no longer frozen.

Territory Changes
Territory hierarchy changes aren't reflected in the frozen forecast hierarchy. Opportunity changes aren't reflected in
locked forecast items.

For forecast items that aren't locked, these changes occur after the freeze date:

• Forecast items are removed from deleted territories, provided both the source and destination territory
forecasts aren't submitted.

• When revenues move between territories, the forecast items don't move if either the source or destination
territories are submitted.

• If revenues move between existing active territories due to territory definition changes, then forecast items also
move.

• If revenues move between existing active territories due to revenue attribute changes, then forecast items also
move.

• When revenues move to newly added territories after the forecast hierarchy is frozen, the forecast items don't
move to the new territories because the new territories aren't added to the frozen forecast hierarchy.
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How You Manage Forecasts for Others  
A sales administrator can take care of everyone's forecast. Also, a territory owner can delegate someone else on the
territory team to take care of forecasting actions for her.

If, for example, a senior sales manager wants one person to update forecasts for everyone in her territory hierarchy, then
for her territory she adds that person as a member of the territory team and selects the Forecast Delegate check box.

Finding and Viewing Forecasts
The administrator or delegate can search to find the territory forecast to be updated. You can search for past, current,
and future forecasts. You can also save your favorite searches.

You can switch from card view to list view in the Forecasts page to work with multiple forecasts.

Copying the Prior Forecast
Use the Copy Prior Forecast action to ignore the rolled up opportunity data and copy the numbers from the previously
submitted forecast to the current forecast. The prior forecast included forecast items and adjustments, unless it in
turn was copied. Your copy takes the total forecast numbers, including adjustments, and pastes them to your current
forecast. These numbers overwrite any calculated totals from rolled up opportunity or adjustment data.

Available Forecast Metrics  
Metrics provide calculated measures based on historical or current transactional data. You can refer to metrics when
making forecasting decisions.

This table shows the available metrics and how they're calculated:

Metric Description

Best Case Forecast
 

The sum of all best case revenue values for all forecast items in the forecast period.
 

Closed Revenue
 

Actual revenue that was closed during the forecast period.
 

Estimated Adjustment
 

The sum of the difference between estimated revenue and revenue for all transactions in the forecast
period. Statistical analysis provides the estimated revenue amounts based on historical sales for the
product.
 

Expected Forecast
 

The sum of all weighted revenue values for all forecast items in the forecast period. Weighted revenue
is the revenue amount multiplied by the probability of the deal closing.
 

Likelihood to Buy Product
 

The percentage of confidence that a deal will close with the specified revenue on the specified close
date. Statistical analysis provides the likelihood to buy product based on historical sales for the
product.
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Metric Description

Pipeline
 

The total revenue amount of all product lines where the Status category is Open, the primary territory
is the target territory, and the close date lies in the forecast period.
 

Quota
 

The quota metric is the revenue target associated with the expected performance of a salesperson's
territory for a given forecast period.
 

Worst Case Forecast
 

The sum of all worst case revenue values for all forecast items in the forecast period.
 

Examples of Forecast Period Parameters  
You create forecasts by setting and submitting period parameters and forecast criteria. These examples show how the
period parameter settings affect the forecasting dates.

Quarterly Forecast
Your company holds monthly board meetings on the 11th of every month to review sales forecasts for the next quarter.
To prepare, you generate monthly forecasts for the next quarter.

On January 1, you configure a recurring monthly forecast with a due date of the 10th of every month by setting the due
date to 80 days (21 days of January +28 Days of February +31 days of March) before the first forecast period start date,
which is April 1. The end date of the forecast period will be June 30.

• Forecast Period: Quarter

• Frequency: Three

• Adjustment Period: The Fiscal Period as set in the calendar. In this example it's monthly.

• Due Date: 80 days before the first forecast period start date

• Territory Freeze Date: 5 days before the forecast due date

• Number of Concurrent Forecasts: Not set

Edit the individual due date and freeze date for the one quarter when the calculated date doesn't fall on the correct date.

The forecast period parameters produce these dates:

Parameter Q2 January 10 Q2 February 10 Q2 March 10 Q3 April 10

Due Date
 

January 10
 

February 10
 

March 10
 

April 10
 

Territory Freeze Date
 

January 5
 

February 5
 

March 5
 

April 5
 

Start Date - End Date
 

4/1 to 6/30
 

4/1 to 6/30
 

4/1 to 6/30
 

7/1 to 9/30
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Note:  The number of scheduled periods determines how far in advance the forecast schedule extends. If a period is
quarterly, and the number of scheduled periods is four, the application generates forecasts up to one year in advance.

One Concurrent Forecast
You want one active forecast period at a time, with no overlapping dates or gaps.

• Forecast Period: Quarter

• Frequency: Three

• Adjustment Period: The Fiscal Period as set in the calendar. In this example it's monthly.

• Due Date: 31 days after the first forecast period start date

• Territory Freeze Date: 31 days before the forecast due date

• Number of Concurrent Forecasts: One

The forecast period parameters produce these dates:

Forecast Name Start Date End Date Territory Freeze Date Due Date

Q3-2018-2018/08/01
 

7/1/2018
 

9/30/2018
 

7/1/2018
 

7/31/2018
 

Q3-2018-2018/08/31
 

7/1/2018
 

9/30/2018
 

8/1/2018
 

8/31/2018
 

Q3-2018-2018/08/31
 

7/1/2018
 

9/30/2018
 

9/1/2018
 

9/31/2018
 

Q4-2018-2018/11/01
 

10/1/2018
 

12/31/2018
 

10/1/2018
 

10/31/2018
 

Q4-2018-2018/12/01
 

11/1/2018
 

12/31/2018
 

11/1/2018
 

11/31/2018
 

Q4-2018-2018/12/31
 

12/1/2018
 

12/31/2018
 

12/1/2018
 

12/31/2018
 

Two Concurrent Forecasts
You want two active forecast periods at a time, with no overlapping dates or gaps.

• Forecast Period: Quarter

• Frequency: Three

• Adjustment Period: The Fiscal Period as set in the calendar. In this example it's monthly.

• Due Date: 60 days before the first forecast period start date

• Territory Freeze Date: 31 days before the forecast due date

• Number of Concurrent Forecasts: Two

The forecast period parameters produce these dates:
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Forecast Name Start Date End Date Territory Freeze Date Due Date

Q3-2018-2018/08/01
 

7/1/2018
 

9/30/2018
 

7/1/2018
 

7/31/2018
 

Q4-2018-2018/08/01
 

10/1/2018
 

12/31/2018
 

7/1/2018
 

7/31/2018
 

Q3-2018-2018/08/31
 

7/1/2018
 

9/30/2018
 

8/1/2018
 

8/31/2018
 

Q4-2018-2018/08/01
 

10/1/2018
 

12/31/2018
 

8/1/2018
 

8/31/2018
 

Q3-2018-2018/08/31
 

7/1/2018
 

9/30/2018
 

9/1/2018
 

9/31/2018
 

Q4-2018-2018/08/01
 

10/1/2018
 

12/31/2018
 

9/1/2018
 

9/31/2018
 

Q4-2018-2018/11/01
 

10/1/2018
 

12/31/2018
 

10/1/2018
 

10/31/2018
 

Q1-2019-2018/11/01
 

1/1/2019
 

3/31/2019
 

10/1/2018
 

10/31/2018
 

Q4-2018-2018/12/01
 

11/1/2018
 

12/31/2018
 

11/1/2018
 

11/31/2018
 

Q1-2019-2018/11/01
 

1/1/2019
 

3/31/2019
 

11/1/2018
 

11/31/2018
 

Q4-2018-2018/12/31
 

12/1/2018
 

12/31/2018
 

12/1/2018
 

12/31/2018
 

Q1-2019-2018/11/01
 

1/1/2019
 

3/31/2019
 

12/1/2018
 

12/31/2018
 

Forecasting Processes  

Forecast Processes  
When you enable forecasting, the Forecast Autopilot process is scheduled to run every hour. Forecast Autopilot
schedules the required processes for forecasting and records when each process is run, along with the status. Forecast
Autopilot generates these processes and scheduled times:

• Check Due Date

This short process archives forecasts that are now past their due dates and activates the next scheduled
forecast. It runs once a day.

• Refresh Forecast

This process updates current and future forecasts using the latest opportunity data. It also updates the forecast
territory hierarchy from the latest active territories. Between the territory freeze date and the forecast due date,
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the forecast territory hierarchy remains frozen. This process runs one day before the territory freeze date for
each forecast period.

• Refresh Revenue Metrics

This process calculates the pipeline metric and closed revenue metric. It refreshes the pipeline metrics visible to
the manager and runs every hour.

• Compress Forecast Metrics

This process reduces space usage and improves performance by compressing calculated metrics. It runs every
hour.

If you change the schedules for the processes, then the Forecast Autopilot runs as frequently as the process with the
most frequent schedule. Don't run the Generate Forecast process. To run Forecast Autopilot right away:

1. Navigate to Scheduled Processes.
2. Click Schedule New Process.
3. Find Forecast Autopilot.
4. Click OK.
5. In the Diagnostic Parameters field, enter setup_auto_pilot=ON.

If you want to disable the Forecast Autopilot process, then enter setup_auto_pilot=OFF. With Forecast Autopilot
disabled, you must schedule each process.

6. Click Submit.

Forecast Synchronization  
When a salesperson updates a product item in an opportunity, the forecast is automatically updated to reflect the
change.

• New forecast items are created for opportunities that meet forecast criteria.

• Existing forecast items are updated.

• Forecast items that no longer meet forecast criteria are removed.

Periodic Synchronization
The periodic process Refresh Forecast updates the forecast hierarchy from the territory hierarchy for unfrozen forecasts
nightly or as scheduled. When a salesperson's forecast is past due, the periodic synchronization fully updates the next
forecast that's now due.

Update from Opportunity
A salesperson submits a forecast and afterward changes an opportunity. By default, the forecast items aren't
synchronized with the opportunity that was changed after forecast submission. The salesperson's manager rejects the
forecast to make it available for changes. If the salesperson enables Refresh from Opportunity at the forecast level, then
any changes from the opportunity appear immediately in the forecast.
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FAQs for Forecasting  

Frequently Asked Questions (FAQs) for Forecasting  
This section contains the most frequently asked questions (FAQs) when setting up and maintaining Forecasting
options. Scroll or search to find answers to common questions.

What happens when I submit forecast options changes?  
When you change forecast period parameters, a process starts that regenerates all future scheduled forecasts. It deletes
them and then recreates them.

Forecast period parameters include forecast period, forecast frequency, first forecast due date, territory freeze date,
number of concurrent forecasts, and number of scheduled periods.

When you change forecast criteria, a process starts that updates future scheduled forecasts. A change to metrics, the
product totals selection, or scheduled forecasts doesn't regenerate the future scheduled forecasts.

If the Forecasting Autopilot process is enabled, then it reevaluates the settings and reschedules the other processes.
Forecasting Autopilot runs at the next scheduled time after you submit your changes. If you want to run it before that,
you can run a standalone Forecasting Autopilot process using the parameter setup_auto_pilot=ON.

What's an adjustment period?  
The time period for which a salesperson can enter a summary adjustment to the forecast or enter an adjusted forecast
is the adjustment period.

The field Period Frequency in Manage Accounting Calendars sets the time periods for viewing forecast amounts
and making adjustments. The period frequency is named Fiscal period for the Adjustment Period field in the Select
Forecasting Options page.

When do I realign territories?  
As a best practice, perform major territory realignments when no forecasting activities are open.

Forecasting takes place after the territory freeze date set for the forecast and up to the forecast due date. If all leaf
territory forecasts are submitted but the due date hasn't been reached, it's safe to make changes to territories.
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How can I display my own graphs in Forecasting?  
Business Intelligence reports provide graphs that you can embed in Forecasting. Add your graph names as lookup
meanings in the lookup type Forecast Graph Selector.

For the third lookup value use the lookup code ZSF_GRAPH3 and so on. Add a new profile option for each graph that
provides the path to the graph as the value, and give the profile option the same name as the lookup code for the
respective lookup value. See the profile option ZSF_GRAPH1 Sales Forecasting Graph 1 for an example.

How can a salesperson adjust forecast items?  
The administrator sets the profile option Enable Sales Representative Adjustments to yes.

This option can't be changed back to no in the future. A salesperson who owns a leaf-level revenue territory can then
adjust forecast items. Also, a manager who drills down to a salesperson's forecast can act as the salesperson and adjust
the salesperson's forecast items.

What's a forecast criteria override?  
If the override is enabled, then salespeople can manually include or exclude a revenue item or forecast item from the
sales forecast.

Items that fall within criteria set by the administrator (such as win probability greater than 70 percent) are automatically
included in the forecast, unless the salesperson employs the override.
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34  Quotas

Overview of Sales Quotas  
You set annual quotas for your sales organization from the top down.

Effective top-down planning with bottom-up assessments ensures that quotas relate to corporate goals. After the sales
plan is deployed for the year, sales executives can then monitor and track sales performance by comparing forecasts
with sales and with quotas.

Features
Here are some key features:

• Assign territory quotas to territories and resource quotas to people.

• Create sales goals such as number of sales calls.

• Review quotas assigned to you by your senior manager and allocate quotas to your salespeople.

• Compare quota to revenue, pipeline, forecast, and other metrics using business intelligence.

• Use formulas to calculate territory quotas using measurements of historical data and future potential.

• Add adjustments to your quota to cushion against attainment risk.

• Track current quota achievement compared with quota targets.

• Manage seasonal variations in sales by distributing the revenue quota among several calendar periods using
seasonality guidance.

• Send notification to Incentive Compensation with new and changed individual quota assignments for all sales
goals.

• Use a round trip export, update, import of quotas to add bulk quotas from spreadsheets.

Quota Components  

Sales Quota Plan Components  
Quotas are a reflection of sales targets you set for individuals in your sales organization. You distribute quotas to child
territories through the sales territory hierarchy until all territories and their owners have quotas.

This chart shows a sales quota plan with several territories, each assigned a quota. Territory quota formulas
compute projected quotas based on historical sales information and metrics such as forecasts and market
potential. The projected quotas appear as default territory quota amounts. A spread formula allocates
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quota based on the contribution of each of the territories. Individual resources also receive quotas.

Territories
You can create more than one sales quota plan, each for one year. Active territories become part of the new quota plan,
and you can add territory proposals to allow the setting of quotas for proposed territories. The plans are inactive until
you activate one for the year. You can designate only one plan to be used for tracking quotas for the year.

When sales administrators or sales managers create new proposed territories, such as for a territory realignment,
they can enable the setting of quotas for the proposed territories by selecting Eligible for Quota. If you then associate
the proposals to your quota plan, you see the proposed territories within the current active territory hierarchy, and
salespeople will be able to assign quotas to the proposed territories.

Territories and the resources assigned to them change frequently. You should schedule the Synchronize Quotas process
to run daily so that current and future quota plans that are active will use the latest territory hierarchy.

Plan Options
Setting the available options for the quota plan isn't required. You can select an adjustment threshold, a territory
quota formula, and a seasonality factor group to apply to all or to individual territories. Territory options override sales
quota plan options. For example, the territory quota formulas and seasonality factor groups selected for individual
territories override those set at the quota plan level. You can also set a threshold percentage for adjustment amounts
that managers often add to quotas.

822



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 34
Quotas

This chart illustrates splitting the quarterly quota over each month through seasonality factors that raise or lower quota

amounts according to seasonal fluctuations. 

Related Topics
• Territory Quota Formulas

• What's seasonality?

• What's a spread formula?

• Create a Sales Quota Plan

Sales Goals  
A sales goal determines how quota is measured and defines what you want to measure. You set sales goal quotas for
a resource, not for a territory. You use Sales Revenue Goals to set salesperson targets for revenue achievement in their
respective territories.

Allocating a quota for a sales revenue goal is required, and optionally quotas can be allocated for additional sales goals.
Create your own sales goals, such as number of units sold.

This chart shows the components of a sales goal. A sales goal supports a particular objective. You can use
any unit of measure for your sales goal and specify what to measure, for example, number of units sold. The
provided units of measure choices are amount and quantity, but you can also define your own unit of measure.
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Each sales goal contains only one measure. You can also focus the sales goal on one or more product groups.

The unit of measure can't be changed after you create the sales goal. The provided Sales Revenue Goal has a unique
value for Goal Number: GOAL_1000. While quotas can be allocated to sales goals which have associated product groups,
there are no rollup reports available to compare these quotas against actual sales.

Note:  Do not make changes to the sales goal object using Application Composer.

Multiple Quotas for One Resource
You can assign multiple quotas to one or more sales goals for a resource.
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This chart shows multiple quotas assigned to a salesperson within the current active quota plan year. The salesperson
owns a territory and therefore has a Revenue Goal quota plus the two quotas manually assigned by the salesperson's

manager. 
A resource can have only one quota per sales goal for the year. You can assign new quotas only for active sales
goals. Inactivating a sales goal doesn't affect existing quotas for that sales goal. When you submit notifications to
compensation, quotas for all sales goals for the resource are included in the notification.

Related Topics
• How Resource Quotas Work with Incentive Compensation

Territory Quota Formulas  
You can use territory quota formulas as default territory quota amounts in the sales quota plan. They calculate territory
quota based on historical sales information and metrics such as forecasts and market potential.

You can change parameters for formulas and set each formula to active or inactive. The formulas execute a
Multidimensional Expressions query on the territories Oracle Essbase cube.
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Predefined Formulas
Here are a few of the predefined territory quota formulas with examples:

• Scale a measure from a past period by a percentage

Total the amounts for a selected measure for the past selected year. Calculate the stated percentage of the total
and add it to the total.

For example, 110 percent of closed bookings for the prior fiscal year.

• Percentage change in a measure value over 2 consecutive periods

Subtract the total amounts for a selected measure for one year from the total amounts for the subsequent
year. Divide the difference by the total of the first year to determine the percentage of change. Calculate the
percentage of the total value of the second year and add the result to the year's total.

For example, closed bookings for 2019 minus closed bookings for 2083 divided by 2018 total gives the rate of
change as 8 percent. Calculated quotas are 108 percent of the 2019 closed bookings.

• Percentage change in a measure value over 2 named time periods (current and past)

Subtract the total amounts for a selected measure for a selected year from the total amounts for the current
year. Divide the difference by the total of the earlier year to determine the percentage of change. Calculate the
percentage of the total value of the current year and add the result to the year's total.

For example, closed bookings for 2018 minus closed bookings for 2011 divided by 2011 total gives the rate of
change as 7 percent. Calculated quotas are 107 percent of the 2018 closed bookings.

How To Create Formulas
Use the Essbase MDX Script Editor to create your own territory quota formulas. When you define a formula that includes
a metric, use a parameter for the metric name, rather than defining the metric name as part of the formula expression.

For more information about MDX functions and queries, see Oracle Cloud Technical Reference for Oracle Analytics
Cloud - Essbase.

Quota Administration  

Create a Sales Quota Plan  
In this example you're the sales administrator and it's a month before the start of the fiscal year. You start the sales
quota planning process by creating a new sales quota plan for the coming year.
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Create a Spread Formula
This spread formula calculates the ratio of closed bookings among the child territories, and applies the ratios to the
quota amount a sales manager wants to spread among the child territories.

1. In the Setup and Maintenance work area, go to the Manage Sales Quota Spread Formulas task:

◦ Offering: Sales

◦ Functional Area: Quotas

2. Click Add Row  to add a new spread formula.
3. Enter these values:

Field Value

Name
 

Closed Revenue
 

Description
 

Spreads the source based on the ratio of closed revenue for the selected year.
 

Metric
 

Closed Revenue
 

4. Click Save and Close.

Create a Seasonality Group
Create a new group for summer products for the new year.

1. In the Setup and Maintenance work area, go to the Manage Sales Quota Seasonality Groups task.
2. Click Create.
3. Enter these values:

Field Value

Name
 

Summer
 

Year
 

2021
 

4. Click OK.
5. In the Seasonality Factors region, enter these factor percentages for time periods:

Time Period Factor Percentage

Quarter 1
 

15
 

Quarter 2
 

40
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Time Period Factor Percentage

April
 

5
 

May
 

15
 

June
 

20
 

Quarter 3
 

35
 

Quarter 4
 

10
 

6. Click Save and Close.

Create a Quota Plan
1. In the Setup and Maintenance work area, go to the Manage Sales Quota Plans task.
2. Click Create.
3. Enter the sales quota plan information:

Field Value

Name
 

Fiscal Year 2021 Sales Plan
 

Description
 

Corporate Sales Quota Plan for Fiscal Year 2021
 

Year
 

2015
 

Calculate Default Territory Quota
 

Select. If selected, the application calculates the quotas for each of the territories using the
default territory quota formula.
 

Track
 

Deselect. Only one plan can track quotas for the year.
 

Copy Quotas From
 

If quotas have largely remained unchanged from the previous year, then use the Copy Quota
Plan option to move quotas from the previous year to the current year.
 

Creating a quota plan automatically takes a snapshot of active territories.
4. Click Save and Close.
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5. In the Details region, on the Options tab, enter these options:

Field Value

Adjustment Threshold
 

10
 

Territory Quota Formulas
 

Scale a measure from a past period by x percent. Use 5% and select the prior year, 2020.
 
Territory quota formulas require territory metrics that are enabled and have values.
 

Seasonality Factor Group
 

Summer
 

6. In the Sales Quota Territory Options table on the Options tab, expand the Global territory and enter the
options as shown in the table for the Global Consumer Sales territory.

Column Value

Allow Quota Edit
 

Select
 

Adjustment Threshold (%)
 

8
 

Territory Quota Formulas
 

x percent growth of a measure over a 3 year simple moving average
 

a. 3 percent
b. Prior year 2020
c. Closed Detail Revenue by Close Date measure

7. Select Track for the quota plan.
8. Click the Activate button and set the activation to right now to test. Upon activation, sales managers can go

into the system to begin allocating quotas to their teams.
9. Click Save and Close.

Related Topics
• Territory Quota Formulas

• What's a spread formula?

• What happens if I select Calculate Default Territory Quota?

• Territory Coverage

Copy Territory Quota to Resource Quota Options  
When you copy territory quota to resource quota, period quotas for the territory also get copied to resource period
quotas, if enabled. You can also enable copying both territory and period quotas to resource quotas automatically
during publishing.
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You can set these profile options using the Manage Administrator Profile Options task in the Setup and Maintenance
work area. This task is part of the Sales offering in the Sales Foundation functional area.

Enable Territory Quota Period Copy
When set to yes, you can copy territory quota period amounts to owner resource quota periods. The copy overwrites
any existing resource period quotas. The annual resource quota amount must be zero, or the period quotas won't be
copied to resource quota periods. Period copy applies to these actions:

• Copy Territory Quota in the Edit Sales Quotas page

• Copy Territory Quota in the Manage Sales Quotas page

• Copy Child Territory Quota in the Manage Sales Quotas page

• Publish territory quota, if the Enable Automatic Territory Quota Copy to Owner Quota on Publish profile option
is also enabled

Enable Automatic Territory Quota Copy to Owner Quota on Publish
When set to yes, territory quota annual values are copied to owner quotas for the sales revenue goal when you publish
territory quotas. You can also set the Enable Territory Quota Period Copy to yes. Then the territory quota period
amounts are also automatically copied to owner resource quota periods during the publish process.

Related Topics
• How You Allocate, Publish, and Revise Quotas

Schedule Quota Processes  
Sales managers or administrators frequently make changes to active territories directly, using territory proposals, or
through web services. Schedule synchronization to run frequently to provide the latest structure for allocating quotas.

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. For the Type field, select Job.
4. In the name field list, click Search.
5. Search for Synchronize Quotas.
6. Select Synchronize Quotas and click OK.
7. In the Parameters region of the Process Details page, select the sales quota plan.
8. Click Advanced.
9. In the Schedule tab, select Using a schedule.

10. Select the Daily frequency.
11. Change the start date to when you want to start running the process, and select the time of day when you want

it to run.
12. Change the end date to a future date.
13. Use the Notification tab to add notifications to specific people when the process completes.
14. Click Submit.
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Quota Validation  
You can turn off the quota validation that occurs when sales managers publish quotas. The validation prevents
assigning quotas prior to resource start dates (the same as employee hire dates) or territory quota start dates.

If an employee joins the company or a new territory is created midyear, then managers can't assign quotas for all of the
year periods with validation turned on. To turn off validation, set the following profile option to no: Allow quota start
date validation during publish.

Add Reports to Sales Quota Pages  
You can change Quota UIs so your salespeople have the most useful reports and graphs. Create reports using Answers
or Business Intelligence. Add them to the Quota Analytics tab. Salespeople select the report from the list of reports on
the tab.

To add a report to your page:

1. Create your Answers or Business Intelligence Publisher reports for quotas.
2. In the Setup and Maintenance work area, use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

3. Go to the lookup type ORA_MOT_QM)MSQ_REPORT for the Manage Sales Quotas page, or
ORA_MOT_QM)ESQ_REPORT for the Edit Sales Quotas page.

4. Add a new lookup code for each new report to be added on the page. For example, to add a second report to
the Manage Sales Quota page, add the lookup code MOT_QM_MSQ_REPORT2. To add a report to the Edit Sales
Quota page the lookup code would be MOT_QM_ESQ_REPORT3. For each additional report to embed in the
page, increment the number used in the lookup code.

5. In the Meaning field, enter the report name, for example Quotas by Salesperson Report. The name doesn't
need to match with the report name in the Business Intelligence catalog.

6. In the Description field, enter the report absolute path, for example /shared/Sales/Analytic Library/Embedded
Content/Sales Quota Management/MyBIPReport.xdo.

◦ For Answers reports, find the absolute path in the properties of the report.

◦ For BI Publisher reports, click the Copy Resource button to find the absolute path to the report.

7. Set the display sequence. This determines the order of the reports shown in the Analytics tab. The report
lookup code with the lowest display sequence number determines the report that's displayed by default.
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FAQs for Quota Administration  

Quota Assignment  

How You Allocate, Publish, and Revise Quotas  
When you complete assigning quotas to your directs, you publish the quotas to the owners and resources of your child
territories. Child territory owners can then view their quotas for the territories they own.

Publishing your quotas also sends notifications containing resource quota information to an incentive compensation
analyst. The territory owner and your manager receive notifications that the quotas are published.

Allocate Quotas
You can allocate quotas in the Manage Sales Quotas page. Sales administrators can enter and edit territory, owner, and
team member quotas for any territory quotas that aren't published. Sales managers can enter and edit child quotas that
aren't published. For territory quotas that aren't published, you can also:

• Enter or edit a quota for each period

• Apply seasonality factors

Select a parent territory and click Details to use the Edit Sales Quotas page to enter or edit quotas. You can enter annual
quotas, period quotas, and apply seasonality to any quotas not published. Assign resource quotas on the Resource
Quota tab in the Details region. Besides the owner's resource quota, you can add and assign quotas to other team
members.

Publish Quotas
When you finish allocating your quota, you publish the quotas to make them available to your directs. After publishing,
you can't make changes to the quotas.

You can select one or more territories to publish. If you click Publish Child Territories, then the selected territories and
their children are published. A sales administrator can publish a hierarchy of territories from the Actions menu. When
you publish a territory, you publish the following, and the data becomes available for Business Intelligence:

• Territory quota

• Resource quotas for all sales goals for the selected territory

• Resource quotas assigned to team members

• Quotas assigned to finer time periods

If you didn't apply seasonality to quotas, then the publishing process applies the seasonality factor that was defined
in the sales quota plan for the territory. If there are no seasonality factor groups defined, then seasonality factors
aren't applied and there is no granular time period quota. Excluded territories can't be published. Publishing fails if the
selected territory or any territory resource has no quota.
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Tip:  Save time entering period quotas. Seasonality gets applied automatically when you publish if you haven't
manually entered period quotas.

Copy Territory Quotas to Resource Quotas
By setting two profile options, the administrator enables the automatic copying of quotas during publishing. Publishing
does the following:

• Copies the territory owner's annual quota for the sales revenue goal to the owner's resource quota.

• If the owner's annual resource quota is zero, then publishing copies the territory period quotas to resource
period quotas. It overwrites any existing resource period quotas.

Revise Quotas
Before you can revise published quotas, you must change the quota status to Pending Revision. The Revise action
changes the status for your selected territory and its children. You can then revise territory quotas, and add, revise, or
end date resource quotas. When you complete your revisions you can again publish the quotas and send notifications.
The territory quotas change to the Published status and resource quotas change to the Submitted status.

When you revise quotas, the revised values aren't available in Business Intelligence until you republish the revised
quotas.

Related Topics
• Copy Territory Quota to Resource Quota Options

How Resource Quotas Work with Incentive Compensation  
Compensation plans control how an employee is paid. Salespeople often get paid according to their performance.

One tool used to measure performance is the establishment of a sales quota for the salesperson and then the
comparison of actual sales for a time period with the salesperson's quota for that time period. The quota manager
notifies the compensation analyst any time quota is published or changed.
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This figure shows the sales manager publishing territory resource quotas. The publication sends a notification to the

incentive compensation analyst. 

Quota Changes
At the beginning of the year, sales management update their territory definitions and assign salespeople to territories.
Senior managers assign quotas to their territories and child territories. The owners of those territories in turn assign
quotas to the owners and resources of their child territories. When a manager publishes quotas, the quotas become
available to the owners of the child territories. Also, a notification goes to the compensation analyst with the now
published quota information.

During a quota plan period, changes occur in territory definitions, resource assignment to territories, and to
quota assignments to resources (salespeople). Managers can choose to submit updated quota information to the
compensation analyst in the form of a notification.

Sales Goals
A sales goal determines how quota is measured and defines what you want to measure. The sales goal used for
a territory owner's revenue quotas is the Revenue Sales Goal. In order to assign multiple quotas to an individual
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salesperson or to assign quotas to salespeople other than territory owners, you must use a sales goal other than the
Revenue Sales Goal. These are examples of sales goal definitions:

• Number of customer visits

• Number of service contracts sold

Notifications to compensation include quotas for each quota-carrying resource for all sales goals. For each salesperson,
the notification contains all the annual resource quotas for all applicable goals as well as the period quotas.

Compensation Plan Updates
The compensation analyst creates compensation plans for a specific time period. The analyst uses quota
notifications to keep the quota information in the plan correct and up to date. The analyst analyzes the provided
information, performs any other research needed, and manually updates the quota plan or rejects the notification.
The compensation plan quota status is set to complete when the compensation analyst completes updating the
compensation plan.

Export Quotas to Incentive Compensation  
You can export resource quotas and resource period quotas to send to incentive compensation for importing
performance goals.

Use Export Management to export the object Sales Resource Period Quota.

Related Topics
• Export Data

FAQs for Quotas  

Frequently Asked Questions (FAQs) for Quotas  
This section contains the most frequently asked questions (FAQs) when setting up and maintaining Quotas. Scroll or
search to find answers to common questions.

What's a spread formula?  
A spread formula calculates the distribution of an amount among selected child territories. For example, a spread
formula takes the variance between the parent territory quota and the sum of the quotas for the child territories, and
spreads it to the child territories.

The formula calculates the ratios to use for the child territories through the use of the metric defined for the selected
spread formula. The formula examines each territory contribution of the metric value for a period, and compares it with
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the total value of the same metric for all the territories combined, to determine the percentage to apply to each territory.
When a spread formula has no metric selected, it distributes the amount evenly across the child territories.

What happens when a sales quota plan is activated?  
When you activate a sales quota plan the status of the plan is changed to completed when the plan year ends. You can't
make changes to a completed quota plan.

When you activate a quota plan a process carries out the activation. Another process runs when the quota plan year end
date is reached, or if it has passed at the time of activation. The second process changes the status of the sales quota
plan to Completed. You can't edit a completed sales quota plan.

What happens if I select Calculate Default Territory Quota?  
Your selection of Calculate Default Territory Quota causes the application to compute the quotas for each of the
territories when the sales quota plan is activated. The computations use the formula and parameters you selected to be
the default in Manage Territory Quota Formulas.

What's seasonality?  
You distribute annual quotas to shorter time periods, factoring in seasonal expectations in sales. This expectation is
represented as a percentage factor, which reflects the share of quota for the season, or time period.

For example, your sales are typically higher the last quarter of the year and at their lowest the first quarter of the year
for several of your product lines. You create a seasonality group named Retail to automatically distribute your annual
quota and factor in the seasons.

• 10 percent for the first quarter

• 25 percent for the second quarter

• 25 percent for the third quarter

• 40 percent for the fourth quarter

When you assign quota to territories that include these product lines, you apply the Retail seasonality group to correctly
distribute the annual quota amounts.

What's the difference between territory and resource quota start
and end dates?  
Territory quota start date and end date define a period when the sales quota target must be achieved.
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The territory quota dates must fall within the start and end dates of the quota plan, and usually match the sales quota
plan start and end dates.The resource quota start and end dates define a period when the quota must be achieved by
the salesperson, and usually match the sales quota plan start and end dates.

Resource dates vary from the sales quota plan start and end dates when:

• A territory is deleted. All resource quotas within the territory have the same end date as the territory end date.
The sales quota plan end date isn't yet reached.

• A territory resource is removed from a territory, and the resource is end dated.

• Quota is assigned to a resource who will join the organization in future.

Who is a territory administrator?  
Sales managers often choose a salesperson or sales operations resource to assist with the quota setting and territory
maintenance for the manager's branch of the territory hierarchy.

Select the Administrator check box for a territory team member in your territory. Now that person can view your
territory and modify all territories lower in your territory hierarchy. She can also assign sales quotas for you.

You must add the Territory Management Administration Duty to a security job role assigned to the resource in order for
the Administrator selection to take effect. A user with the Sales Administrator security role can modify all territories and
set all quotas.

How can I add period quotas prior to the resource start date or
territory quota start date?  
Your administrator can turn off the date validation that occurs when you publish quotas using the profile option named
Allow quota start date validation during publish. The employee hire date is the same as the resource start date.

How can I publish quotas for a territory hierarchy?  
As a sales administrator, you can bulk publish quotas by using the Publish action in the Publish or Revise Hierarchy
Quotas process.

Select the sales quota plan and the territory number that's at the top of the hierarchy you want to publish. The process
publishes every territory within the hierarchy.

How can I set quotas to the Pending Revision status for a territory
hierarchy?  
After sales managers publish quotas, they can't revise them unless the status is changed to Pending Revision. As a sales
administrator, you can schedule the Publish or Revise Hierarchy Quotas process, and choose the Revise action.
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Select the sales quota plan and the territory number for the top of the hierarchy you want to revise. The process
changes the status for every territory within the hierarchy to Pending Revision.

What's a sales quota publish-by date?  
The publish-by date is an indication to the territory owner that sales quotas need to be published by a certain date.

The date when the owner publishes the quota is the published date.

What's a variance?  
The variance is the difference between the adjusted quota amount for the parent territory and the rolled up total
amount from the child territory quotas. The variance can be spread, meaning it gets added to the child territories.

What's an adjustment?  
An adjustment is the amount that territory owners, or sales managers who have child territories, add to the territory
quota assigned to the territory they own. The territory owner can then allocate the adjusted territory quota to child
territories.
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35  CX Sales Mobile

Configure and Extend CX Sales Mobile  
In this chapter, you learn how to configure and extend Oracle CX Sales Mobile.

For information on basic setup and integration with Sales application features, see CX Sales Mobile Chapter of the
Implementing Sales guide. The Oracle CX Sales Mobile app helps your users to manage their day effectively and
develop customer relationships using their phone or tablet.

Related Topics
• Overview of CX Sales Mobile

• Overview of CX Sales Mobile Setup

Specify the Email Addresses that Receive the Rate the
App Feedback  
Your sales representatives can rate the CX Sales Mobile app using the Rate the App  feature and the feedback is sent to
the email addresses that you specify in the CX Sales Mobile configuration tool in App Composer. Here's how you set it
up:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the CX Sales Mobile Composer tab.
6. In the Application Features pane, click Settings.
7. Expand the App Settings section.
8. Enter the email address, or addresses, that will receive the app feedback. If you're entering more

than one email address, enter a comma without spaces between each email address. For example:
f1@abccorp.com,f1@abccorp.com

9. Click Save.
10. Test and publish your new settings. See the Test Your Configurations topic for details about how to check your

mobile configurations.
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Display the News Feed on the Home Page for a User's
Most Relevant Accounts  
Provide sales representatives and managers with timely news about their accounts on their CX Sales Mobile home page.
The news information is curated by Oracle DataFox so that salespeople reduce time spent on account research and
meeting preparation.

Salespeople can quickly browse recent news highlights, read articles of further interest, and view accounts related to the
articles, so that they can take notes or update contacts. Accounts that receive news are sourced from the My List for
Accounts Workspace search, so that users only see news related to their priority customers.

Prerequisites
1. Integrate DataFox with Oracle CX Sales, if you haven't done so already. Follow the steps in the "Integrate with

Oracle CX Sales" topic in the "Using DataFox for Sales and Marketing" guide (the link is available at the end of
this topic).

2. Enable Smart Lists in Workspace by following the steps in the My Lists topic.

Add the News Feed to the Home Page
Once you've checked that the prerequisites are setup, add the news feed to the home page:

1. In a publishable sandbox, navigate to Application Composer > Mobile Application Setup > CX Sales Mobile
Composer

2. In the Application Features pane, click Cards.
3. Select the existing page layout where you want to display the news feed, or create a new one by clicking the

Click to Clone icon.
4. If your selected layout was cloned from the Sales Rep Card or Sales Manager Card layouts, follow these steps:

a. In the layout, select the Account News Card.
b. In the DataFox card settings, select Show to display the card.

5. If your selected layout was cloned from the Default Navigator Layout, follow these steps:
a. In the layout, scroll to the bottom and click + Add Custom Card.
b. Select DataFox.
c. Choose a saved search. The My List for Accounts saved search is recommended, if you've enabled it in

your instance.
6. In the header, click Save.
7. Test your update by following the steps in the Test Your Configurations topic.
8. Publish the Sandbox.
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Note:
• News is provided for the top 10 account records associated with your saved search and that have associated

DataFox Company IDs.

• The default news age limit is four days. You can change the age limit by layout to any value between 1 and 30
days.

• The Account News feed shows up to 20 recent articles that meet the filters.

Related Topics
• Integrate Oracle DataFox with Oracle CX Sales

Create a Custom Field and Add It to CX Sales Mobile  
You can create a custom field and add it to the CX Sales Mobile application.

Create a Custom Field and Add It to CX Sales Mobile The configuration involves three major steps:

1. Create the custom field for the Sales application.
2. Make the field available in Adaptive Search.
3. Add the field to CX Sales Mobile UI using the CX Sales Mobile Composer tool in Application Composer.

Create the Custom Field

1. Enter a sandbox where Application Composer is an active tool
2. Open Application Composer.

For example, you can open Application Composer by selecting it from the sandbox Tools menu.
3. In the left pane, search for the object for which you want to create the field.
4. Expand the object node.
5. Click Fields.
6. In the Fields page, click Create.
7. On the Select Field Type window, select the type of field you are creating.
8. Enter the required information for the field. What you enter is different for each field type. For details, see the

topic Field Types and Field Properties.
9. Make sure the Include in Service Payload check box is selected.

10. Click Save and Close.
11. Click on the sandbox name and select Publish.
12. On the Sandbox Details page, click Publish again.

Make the Field Available in Adaptive Search
Follow the instructions in the topic Make Additional Fields Searchable.
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Add the Field to the CX Sales Mobile UI
Follow the instructions in the topic Configure the App Using the Configuration Tool and related topics in the
Implementation Reference guide.

Enable or Disable Oracle DataFox Account Scoring, Tiers,
and Signals  
Using Oracle DataFox, you can display scoring for an account and the DataFox account tier in the CX Sales Mobile
Account pages, which helps sales representatives prioritize their prospects and customers. You can also display account
signals to help your sales representatives stay up-to-date with the latest news on their accounts and use them to
prepare for conversations with their customers.

Enable DataFox in Oracle CX Sales Mobile
Once you have enabled Oracle DataFox in the CX Sales app the account scoring and tiers, and the account signals,
appear in the Oracle CX Sales Mobile Account List and Summary page layouts automatically. For more information
about enabling the DataFox features in the CX Sales app, follow the steps documented in the "Set Up and Administer
Oracle CX Sales Integration" chapter of the Using DataFox guide.

However, if you have created new Account List and Summary page layouts before the 21A release, you need to add the
DataFox account scoring, tiers, and account signals to your page layouts manually, as they won't appear automatically
when you upgrade to 21A. Here are the steps to enable the account scoring and tiers in the Account List page:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. In the Application Features pane, click Accounts.
6. In the Accounts Views pane, click List and then select your layout in the Layouts pane.
7. In the interface designer, click the eye icon in the first card that appears in the List page. Ensure that there isn't

a line through the eye, as this means that the account scoring and tiers won't appear on the page.
8. Repeat these steps for all of your List page layouts.
9. Click Save.

Next, follow these steps to display the account scoring and the tiers in the Account Summary page:

1. In the Accounts Views pane, click Summary and then select your layout in the Layouts pane.
2. In the interface designer, scroll to the INFO column and add the Account Score and Account Scoring Tier

fields, using the + Add Field button.
3. Repeat these steps for all of your Summary page layouts.
4. Click Save.

Here's how you display the account signals in the Account Summary page:

1. In the Accounts Views pane, click Summary and then select your layout in the Layouts pane.
2. In the interface designer, scroll to the bottom of the summary page and click + Add Child or Related and select

DataFox.
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3. Click and drag the three horizontal lines icon to move the Account Signals section to your preferred position on
the page.

4. Repeat these steps for all of your Summary page layouts.
5. Click Save.

Test and publish your page layouts. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Disable DataFox in Oracle CX Sales Mobile
Once Oracle DataFox is enabled in the CX Sales app, it appears in the CX Sales Mobile app by default (unless you have
created new Account List and Summary page layouts before the 21A release - see the Enable DataFox section above for
more details). If you don't want to display DataFox information in CX Sales Mobile, you need to complete these steps:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. In the Application Features pane, click Accounts.
6. In the Accounts Views pane, click List and then select your layout in the Layouts pane.
7. In the interface designer, click the eye icon in the first card that appears in the List page. Ensure that there is a

line through the eye, as this means the account scoring and tiers are hidden on the page.
8. Repeat these steps for all of your List page layouts.
9. Click Save.

10. In the Accounts Views pane, click Summary and then select your layout in the Layouts pane.
11. In the interface designer, scroll to the INFO column and remove the Account Score and Account Scoring Tier

fields.
12. Scroll to the Account Signals section in the Summary page and delete the section.
13. Repeat these steps for all of your Summary page layouts.
14. Click Save.
15. Test and publish your page layouts. See the Test Your Configurations topic for details about how to check your

mobile configurations.

Configure the Page Layouts  

Configure the App Using the Configuration Tool  
You can configure the Oracle CX Sales Mobile Apple and Android applications using an easy-to-use interface designer
in Application Composer. Using the interface designer, you can configure the app to match your business requirements,
such as selecting which objects and fields are visible in the application, and defining when a page layout displays.

Navigate to the Configuration Tool
First of all, navigate to the configuration tool:

1. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes
Application Composer as an active tool.
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2. Open Application Composer by selecting Application Composer under the Configuration category in the
Navigator menu.

3. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
4. Click the CX Sales Mobile Composer tab to open the CX Sales Mobile configuration tool.

Here's what the configuration tool looks like:

On the left-hand side of the configuration tool, you can see the Application Features pane which lists the standard and
custom objects that are enabled for CX Sales Mobile in the current sandbox (callout 1 in the screenshot). This pane also
includes the settings that you can set up for CX Sales Mobile, which include the offline settings and user settings.

In the center of the configuration tool, you can see a visual representation of your configured version of the CX Sales
Mobile app (callout 2 in the screenshot). Scroll to the bottom of the page and you can see the + Add Feature button,
which will add another standard or custom object to the app.
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Note:  If you're adding a custom object, ensure that the Include in Service Payload option is enabled for an object
in Application Composer. For details about how to do this, see the "Add Objects and Fields in Application Composer"
chapter in the Extending CX Sales and Fusion Service guide.

Create Page Layouts for Standard and Custom Objects
If you decide that you want to change the standard layout for an object, you can create a new page layout and configure
it to suit your company's requirements. There are four different types of page layouts that you can create: A List page,
a Summary page, an Edit page, and a Picker layout. Here are the basic configuration steps that will enable you to make
simple changes to a layout:

1. In the Application Features pane, click the standard or custom object that you want to create a layout for.
2. Select the relevant type of page layout, such as the List or Summary.
3. In the Layouts pane, click the Click to Clone icon for the standard layout and enter a layout name.
4. Change the fields that appear by clicking the relevant field and selecting a new field from the Select Field pop-

up page.
5. You can remove fields by clicking the field and then clicking the cross icon.
6. To move a field, click on the field that's positioned where you want your field to appear, and select or search

for the relevant field in the Select Field pop-up page. If you want to re-position the field that you have just
removed, click on the field that's positioned where you want your field to appear, and select the relevant field.

7. Click Save in the top right-hand corner of the configuration tool page.
8. Test and publish your new page layouts. See the Test Your Configurations topic for details about how to check

your mobile configurations.

If you want to make more extensive changes to a page layout, you will need to familiarize yourself with the additional
capabilities of the different types of page layouts. See these topics in the Configure the Page Layouts section in the
Implementing Sales guide for more details:

• Configure the List Page Layout

• Configure the Summary Page Layout

• Configure the Edit Page Layout

• Configure the Picker Layout

• Configure Child Object Page Layouts

• Configure the Global Search Layout

Configure the List Page Layout  
The List page layout displays a list of an object's records, with each record showing a set of fields that you can
configure. You can make simple changes to the List page layout, as described in the Configure the App Using the
Configuration Tool topic. If you would like to make more extensive changes to the List page layout, you will need to note
these additional points:

• When you configure the top card in the List page layout, your changes will be reflected in every card in the list
when you view them in the app.

• You can add up to two new fields to the card, as well as changing the existing fields. Just click the field and
select a field from the list.
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• You can add or hide actions for the List page, such as whether you can create a task, add a note, or edit the
object. Click the more icon (three horizontal dots) on the page for the list of available actions, then click + to add
an action and click an action's X icon to hide the action. You can also hide or add actions for child objects by
clicking the child object and following the same steps.

• You can also add or hide actions for the card, such as Edit, Add Note, and Share. Click the more icon on the
card for the list of actions. Click + for additional actions and click an action's X icon to hide the action.

• Roles and geographical regions can be assigned to List page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can find more details about how to do this in
the Create Criteria for Page Layouts topic.

• List page layouts are used by Oracle Sales Assistant. For more information about using and setting up Sales
Assistant, see the Implement Sales Assistant for CX Sales Mobile topic in the Implementing Sales guide.

After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure the Summary Page Layout  
The Summary page layout displays an object's details. There are seven sections to the Summary layout: The top
section which provides the object's contact information and top-level information of your choice, an aggregates section
containing aggregated information about sales objects, up to four information sections, and the child and related object
section. You can make simple changes to the Summary page layout, as described in the Configure the App Using the
Configuration Tool topic. If you would like to make more extensive changes to the Summary page layout, you will need
to note these additional points:

The Top Section
Here are the points to note about configuring the top section:

• You can change the fields, remove fields, and move fields using the steps in the Create Page Layouts for
Standard and Custom Objects section of this topic.

• Choose a relevant field type of either Phone, Mobile, or Email to match the icon. Note that you can't change
the icon for these types of fields.

• You can't move the top section, because this section is designed to contain the top-level information for the
object.

The Aggregates Section
The aggregates section displays aggregated information for a sales record, such as at the number of open opportunities
with the predicted total value, and the number of critical open service requests for an account. Here are some points to
note about this section:

• The aggregates section is available for all child and related standard objects, and custom objects associated to
the parent standard object.

• You can't move this section, however you can add up to six aggregates by clicking Add Aggregate.

• You can move aggregates around by placing your cursor over the aggregate, clicking and holding the three
horizontal lines icon in the aggregate, and dragging it to your preferred position.

• You can delete aggregates by clicking the red cross in the top right hand corner of the aggregate.
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• The format of an aggregated field is XX.XX and the format can't be changed.

Appointment Section (Appointments Summary Page Only)
In the Appointment Summary page, there is a section below the Aggregates section that displays the appointment
recurrence details, the accept or reject option, and the option to mark the appointment time as busy in your calendar.
You can hide the accept or reject option, and the Show Time As Busy option, so that they don't appear in the
Appointment Summary page. Here's how:

1. Edit an existing Appointment Summary page layout, or create a new page layout by clicking the Click to Clone
icon.

2. In the interface designer, scroll to the appointment section and hover over the accept or reject, and Show Time
As Busy options. Note that an eye icon appears.

3. Click the eye icon to hide the section and click Save in the top right-hand corner of the configuration tool page.
4. Test and publish your new page layouts. See the Test Your Configurations topic for details about how to check

your mobile configurations.

The Information Sections
Here some points to note about the information sections:

• The information sections (there are up to four) are called the following: Information, Address, Info 1 Column,
and Info 2 Column.

• You can reorder any of the sections by using the blue up and down arrows.

• You can add fields by clicking the + Add Field button at the bottom of each section. There's no limit as to the
number of fields you can add.

• The Information section will only display email, phone, and address icons and not field labels, so you should
only select email, phone, and address fields that can have an icon, and don't require a field label.

• In the Address section of Account and Contact Summary page layouts, you can remove the actions that are
available for addresses, such as editing or deleting an address. See the Remove Address Actions on the Account
and Contact Page Layouts topic for more details.

• The Info 1 Column has a one-column layout and displays only one field across the page.

• The Info 2 Column has a two-column layout, so two columns will be displayed side-by-side across the page.

The Child and Related Object Sections
The section for adding child and related objects is located at the bottom of the Summary page layout.

• This section can't be moved, however you can add as many child and related objects as you require by clicking
+ Add Child or Related.

• When you add a child or related object, you can choose from five different templates, which you can then
configure in the child objects' List page layout. See the Child Object Page Layouts section of this topic for
more information.

Other Configuration Options
Other configuration options for the Summary page include:

• Add or hide actions for the Summary page, such as whether you can create a task, add a note, or edit the
object. Click the more icon (three horizontal dots) on the page for the list of available actions, then click + to add
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an action and click an action's X icon to hide the action. You can also hide or add actions for child objects by
clicking the child object and following the same steps.

• Assign roles and geographical regions to Summary page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can also define a set of conditions that have
to be met before the page layout is displayed. For example, if you create criteria as follows: Win probability is
Greater than 50%, then any opportunities with a win probability greater than 50% will use your layout. You can
find more details about how to set these up in the Create Criteria for Page Layouts topic.

After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure the Edit Page Layout  
The Edit page layout displays when you're editing an object's details in the app. You can make simple changes to the
Edit page layout, as described in the Configure the App Using the Configuration Tool topic. If you would like to make
more extensive changes to the Edit page layout, you will need to note these additional points:

• To add a field, scroll down and click + Add Field.

• To move a field, click on the field that's positioned where you want your field to appear, and select or search
for the relevant field in the Select Field pop-up page. If you want to re-position the field that you have just
removed, click on the field that's positioned where you want your field to appear, and select the relevant field.

• In the Account and Contact Edit page layouts, you can remove the actions that are available for addresses, such
as editing or deleting an address. See the Remove Address Actions on the Account and Contact Page Layouts
topic for more details.

• Add child objects to the bottom of the page layout by clicking + Add Child.

• You can also assign roles and geographical regions. These enable you to restrict who can view the page layout
by their role and their geographical region. You can also define a set of conditions that have to be met before
the page layout is displayed. For example, if you create criteria as follows: Win probability is Greater than 50%,
then any opportunities with a win probability greater than 50% will use your layout. You can find more details
about how to set these up in the Create Criteria for Page Layouts topic.

• Edit page layouts are used by Oracle Sales Assistant (OSA) to determine which fields to ask questions about
during task, call report, and appointment record creation. OSA asks for values for mandatory fields, or fields
without defaults, in the order that they appear in the edit layout page.

If a field in the edit page layout isn't mandatory, or doesn't have a default value, but you still want OSA to ask
for a value, you can specify that the field is prompted by adding the field in the Prompted Fields on Assistant
Create pane.

After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure the Picker Layout  
The Picker page layout displays whenever you're picking an object from a selection list, such as choosing an opportunity
from an opportunity search. You can make simple changes to the Picker page layout, as described in the Configure the
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App Using the Configuration Tool topic. If you would like to make more extensive changes to the Picker page layout, you
will need to note these additional points:

• You can change the fields, add up to six fields, remove fields, and move fields using the steps in the Configure
the App Using the Configuration Tool topic.

• You can also enable or disable the ability to create an object from the picker by adding or hiding the page
actions. Click the more icon on the page and either add the Create action if it isn't there, or remove the action
using the cross icon that appears when you hover over the action.

After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure the Global Search Layout  
Sales representatives can use the global search feature directly from any page in the app to locate any type of
record quickly and easily. You can configure which fields appear in the global search results page, so that your sales
representatives view the most important information for their specific business needs. See the Configure the App Using
the Configuration Tool topic for instructions about how to create a new page layout. Note these additional points about
the Global Search layout:

• You can change the fields, add up to six fields, and remove fields using the steps in the Configure the App Using
the Configuration Tool topic.

• You can't assign criteria, such as user roles or geographical regions, for Global Search page layouts.

After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure Child Object Page Layouts  
Not only can you add child objects to the Summary and Edit page layouts (see the Configure the Summary Page Layout
and Configure the Edit Page Layout topics for more details), but you can also create page layouts for the child objects
themselves. Here are points to note when configuring page layouts for child objects:

• When you add a child object to a parent object's page layout, the child object is added to the Children pane. To
create a page layout for the child object, click the child object and clone the standard page layout, as you would
for the parent object.

• Configuring a child object page layout is the same as configuring a parent object's page layout, so you can
follow the same steps you're already familiar with in this topic.

• The template that's used for a child object's List page layout is selected when you add the child object to a
parent page. You can then further configure the List page when you select the child object and clone the
standard page layout.

• You can assign roles and geographical regions to child object page layouts. You can also assign criteria for
displaying the page layout, known as the Advanced Criteria feature. When you using Advanced Criteria, you can
select fields from the parent object, as well as the child object. You can find more details about this in the Create
Criteria for Page Layouts topic.
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After making updates to your page layout, make sure that you click Save in the configuration tool page, and test
and publish your new page layout. See the Test Your Configurations topic for details about how to check your mobile
configurations.

Configure the Home Page  
CX Sales Mobile contains preconfigured Sales Representative and Sales Manager home page layouts by default. You can
edit the preconfigured layouts, such as adding roles, re-ordering the cards, and adding Workspace saved searches to the
pipeline and custom cards. You can also create entirely new home page layouts and configure them in the same way as
the preconfigured home pages.

Here's how you configure the home pages:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. In the Application Features pane, click Cards.
6. To edit a preconfigured home page, navigate to the Layouts pane, click either the Sales Rep Card Layout or the

Sales Manager Card Layout, and click the Click to Clone icon.
7. Enter a layout name and click Ok.
8. All the cards are displayed by default, but if you want to hide a card, click the card in the interface designer, and

disable the Show Card option in the Card Settings pane.
9. You can add additional cards, as follows:

a. Click + Add Custom Card at the bottom of the home page.
b. Select the object card from the list and then on the next page select the Workspace saved search for the

card.
c. Edit the header and title, and add an aggregation field and footer. You can hide the total number of

relevant sales objects by clicking the eye icon, ensuring it has a cross through it. You can also change the
saved search by clicking the more button (three horizontal dots) on the card.

Note:  You can only have one card per object on a page layout.

10. As well as adding a Workspace saved search to a custom card, you can also add a saved search to the pipeline
card.

11. If you want to assign a role to your home page layout, add the role in the Assigned Roles pane.
12. If you want to re-order the cards, drag the card in the interface designer to the position you would like.
13. If you want to rename the strings on the cards, you need to use the I18N feature. See the Rename Child Objects

and Strings in the App topic for more details.
14. If you would like to create an entirely new home page layout, follow the previous steps, but select the Default

Navigator Layout in step 6.
15. Click Save.
16. Test and publish your new page layouts. See the "Test Your Configurations topic for details about how to check

your mobile configurations.
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Migrate Home Page Cards from Test to Production  
When move your configurations from a test environment to a production environment using the Configuration Set
Migration (CSM) tool, home page card layouts in CX Sales Mobile are moved to the Production environment. However,
any custom Workspace searches referenced by the home page card layouts won't be migrated.

To ensure that home page cards display correctly for your users, follow these steps after migrating from a test to
production environment:

1. Re-create your test environment’s custom Workspace searches in your production environment.
2. In a publishable sandbox, navigate to Application Composer > Mobile Application Setup > CX Sales Mobile

Composer > Cards.
3. Within each custom layout, ensure your home page cards reference the appropriate saved searches as

configured in your test environment.
4. In the header, click Save.
5. Publish the Sandbox.

Configure the Report Page Layouts  
The reporting feature provides tailored insights into the state of your business, with compelling visualizations optimized
for mobile displays, including bar graphs, funnels, and area, doughnut and pie charts. As well as selecting which reports
your users can view and interact with, you can also create layouts based on role and geographical region, so that users
can view the reports that are most relevant to them. Users can view these reports easily by clicking the View my reports
button on their home page, or they can view them using the main menu.

There are two page layouts for reports provided by default: One for Sales Representatives and one for Sales Managers.
The Sales Representative layout has a My Pipeline funnel chart. The Sales Manager layout has a My Team's Pipeline
for Sales Manager funnel chart, a My Direct Team's Performance for Sales Manager bar chart, and a My Team's
Deal Size by Resource for Sales Manager bar chart. If you want to add reports to the report pages, or configure report
pages for roles or geographical regions, just follow the relevant steps in this topic.

Set Up Your Reports in Visualization Configuration
To deliver custom reports to your mobile users, use Visualization Configuration to create responsive, mobile-optimized
visualizations that reference Oracle Transactional Business Intelligence reports in any shared folders.

Add Reports to Page Layouts
Once you've created the right visualizations, you can add them to report pages so that your users can view the reports
that are most relevant to them. Here's how:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the CX Sales Mobile Composer tab.
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6. In the Application Features pane, click Reports.
7. In the Layouts pane, select either the Sales Representative or Sales Manager layout, and click the Click to Clone

icon.
8. Enter a name and click Ok.
9. In the interface designer, click + Add Report.

10. Search for the report that you want to add and click on it. The list displays reports that are active and have been
set up in Visualization Configuration.

11. Add as many reports as you require to the page layout. You can re-order the reports by dragging them to your
preferred position in the interface designer. To delete reports, move your cursor to the report in the interface
designer, and then click the delete icon.

12. Click Save in the top right-hand corner of the configuration tool page.
13. Make sure that you prioritize the order of your page layouts, so that the page layout at the top is the first layout

that's displayed to the user, if they fit the criteria that you have set up. The second page layout is displayed if
the user fits the second criteria, and so on. See the Prioritize Your Page Layouts section of the Create Criteria
for Page Layouts topic for more details.

Add Roles to Page Layouts
If you want to create report pages for different roles, or you want to add other roles to the Sales Representative or Sales
Manager page layouts, you will need to create a copy of the default layouts. Here's how:

1. Follow the first six steps in the Add Reports to Page Layouts section of this topic.
2. In the Layouts pane, select the page layout that you want to add roles to and that you have created, or click the

Click to Clone icon for either the Sales Representative or Sales Manager layout.
3. In the Assigned Roles pane, search for the role that you want to add, and click the role. The role is added to the

page layout.
4. Add as many roles as you require and click Save.
5. Ensure that you have prioritized the order of your page layouts. See the Prioritize Your Page Layouts section

of the Create Criteria for Page Layouts topic for more details.

Add the Report Privilege to Custom Roles
If you have assigned custom roles to your reports pages, you need to add the visualizations privilege
ZCA_VIEW_DATA_VISUALIZATION_CONFIGURATION_PRIV to the custom roles.

1. Navigate to the Security Console by clicking Navigator  >  Tools >  Security Console.
2. Click the Roles tab and find your custom role.
3. Edit the role and click Next to get to the Function Security Policies page
4. Click Add Function Security Policy and search for the

ZCA_VIEW_DATA_VISUALIZATION_CONFIGURATION_PRIV privilege.
5. Select the privilege and click Add Privilege to Role.
6. Click Next through the wizard and finally click Save and Close.
7. Now you need to run three processes to assign the privilege to the custom role. Navigate to Scheduled

Processes by clicking Navigator >  Tools >  Scheduled Processes.
8. Click Schedule New Process.
9. Set the Type as Job and in the Name field, search for Retrieve Latest LDAP Changes.

10. Click OK and in the Process Details page, click Submit.
11. Repeat for the following processes:

◦ Send Pending LDAP Requests

◦ Import User and Role Application Security Data
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12. Open the CX Sales Mobile app and check that your reports pages are visible in the navigation menu for your
custom roles.

Add Geographical Regions to Page Layouts
You can add geographical regions to reports page layouts, so that you can select a set of reports for roles within
particular regions. You can add regions to page layouts as well as roles.

1. Follow the first six steps in the Add Reports to Page Layouts section of this topic.
2. In the Layouts pane, select the page layout that you want to add geographical regions to and that you have

created, or click the Click to Clone icon for either the Sales Representative or Sales Manager layout.
3. In the Assigned Regions pane, search for the geographical region that you want to add, and click the region.

The region is added to the page layout.
4. Add as many regions as you require and click Save.
5. Ensure that you have prioritized the order of your page layouts. See the Prioritize Your Page Layouts section

of the Create Criteria for Page Layouts topic for more details.

Migrate Report Lists from Your Test to Production Environments
The Visualization Configuration tool generates Reference IDs automatically for visualizations created in the tool. Also,
from the 22A release, visualizations are migrated from Test environments to Production environments. As a result, you
don’t need to rebuild Report Lists if you perform a Configuration Set Migration (CSM). Here are the steps to perform the
mobile report migration:

1. Complete the Oracle Transactional Business Intelligence migration steps in the Archive and Move Analytics
topic in the Creating and Administering Analytics and Reports guide.

2. Migrate your Test Environment Visualizations to your Production Environment. In the Configure Visualizations
for CX Sales Mobile  topic, follow the steps in the Import and Export Visualization Configurations section.

3. Run the Configuration Set Migration (CSM). This allows configurations made in Application Composer -
including configured mobile report lists, privileges, and references to Visualization Configuration - to be
migrated from one environment to another. Additional resources on CSM can be found in the Migrate Your
Configurations topic in the Configuring and Extending Applications guide.

Note:  If you rebuilt your visualizations instead of migrating them, or did not successfully run CSM, follow these steps
to finish the migration:

1. Create a publishable sandbox in your production environment.
2. Navigate to Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Composer tab and select Reports in the Application Features pane.
4. If you didn't run CSM, re-create the configured report lists for roles and regions as necessary.
5. Select Add Report to select reports that reference items that are in the production environment's Visualization

Configuration tool.
6. Click Save.
7. Publish the sandbox.
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Display Visualizations from Saved Searches in Home Page Cards
and the Reports List  
Enhance the level of insight available to sales representatives and managers by displaying saved searches as
visualizations on home page cards and in the reports list. Tapping a segment of a parent report reveals a list of records
associated with the respective segment. Selecting a list item reveals its associated record.

1. Note:  If you've already created a visualization from a saved search and want to display it on a home page card, you
can skip to step 12.

In any of the work areas that use saved searches powered by Adaptive Search, create or find the saved search
you want to use for the visualization. The saved search must be made visible to the roles of the user performing
configurations and to the users who will consume the visualizations.
Note that attribute dimensions are determined by what is made available for Group By under Manage Adaptive
Search in Setup and Maintenance. Also, search-based visualizations use Count of Results as their measure
dimensions.

2. Outside of a sandbox, navigate to Application Composer > Visualization Configuration.
3. In the Visualization Configurations page, click Add.
4. In the Source Type field in the Create Configuration page, select Adaptive Search.
5. In the Source field, select the saved search that you created or found in the first step. The saved search is used as the

data source for the visualization.
6. In the Visualization Type field, choose your preferred visualization, such as a bar chart, donut chart, and so on.
7. In the Details section, enter the dimensions and other preferences for the visualization.
8. In the Drill Down section, change the Action option from None to Link. This enables drill down to the search list.
9. Set the Status field to Active and click Create.
10.Return to the main Oracle CX Sales home page and enter a sandbox.
11. Add visualizations to the Reports page as specified in the Configure the Report Page Layouts topic. Note that the

Reports page supports both Oracle Transactional Business Intelligence (OTBI) reports and visualizations from saved
searches.

12. Add visualizations to the mobile home page. Note that the home page supports only search-based visualizations.
Here's how you add the visualizations:

a. Navigate to Application Composer > Mobile Application Setup > CX Sales Mobile Composer > Cards.
Select a custom layout, or clone a standard layout.

b. Scroll to the bottom of the layout and select + Add Custom Card.
c. In the Add Card screen, select the Visualizations tab.
d. Select your visualization to add it to the home page. Click Save.

13. Test your update by following the steps in the Test Your Configurations topic.

Enable Visualizations That Drill Down to OTBI Reports  
You can embed visualizations related to a record in its detail page. In addition, you can enable drill down to Oracle
Transactional Business Intelligence (OTBI) reports from visualizations that appear in both record detail pages and in the
reports list.
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This feature enables sales representatives to improve outcomes of customer interactions by having customer and deal
360 views available in any setting.

Here's how to enable the feature:

Build a Report in OTBI
1. Navigate to Oracle Transactional Business Intelligence (OTBI) and click Add and create a top-level report that

the record-based visualization will reference.
2. (Optional) Add a prompted filter. You might use this if, for example, your organization wants to view reports on

the Account Detail page that only show information related to the displayed account. Here's how:
a. Add the Customer Row ID column to the report.
b. Enable the ID as a filter where the Operator is set to is prompted. This allows the Account Party ID to be

passed to the report as a filter value.
3. Save the top-level report.
4. Without navigating away from the top-level report, click Save As, and change the name to represent the drill

down report.
5. Add additional columns to the report table as required, to provide sales users with more granular insights.
6. Add additional prompts that represent the fields that delineate the elements of the top-level report. For

example, if the top-level report will be visualized as a bar graph where the X-axis is Enterprise Quarter and the
series is Product Group, add both of these as Filters where the Operator equals is prompted.

7. Save the drill-down report once all your changes are made.

Create a Data Visualization and Reference the Report
1. Outside of a sandbox, navigate to Application Composer  >  Visualization Configuration.
2. Click Add and in the Source Type field, select OTBI Analysis.
3. In the Source field, find and select the top-level report that you have just created.
4. In the Visualization Type  field, choose your preferred visualization, such as a bar chart.
5. In the Details section, select the X Axis, Value, and Categorized By fields.
6. In the Drill Down section, change the Action from None to Link. If the Search for target analysis field

appears, search for and select the drill down report that you just created.
7. Set the Status to Active and then click Create.

Display the Visualization in CX Sales Mobile
1. Return to the main Oracle CX Sales home page and enter a sandbox.
2. Navigate to Application Composer >  Mobile Application Setup >  CX Sales Mobile Composer.
3. Navigate to the object where you want to add the visualization, and click the Summary page.
4. Select a custom layout, or clone a standard layout.
5. Scroll to the Reports section of the layout preview and click + Select and Re-Order Reports.
6. Click + Add Report and choose the top-level visualization created in the previous section.
7. In the Report Filters pane in the right-hand side of the page, select the prompted field from the report that

will receive a filter value from the page. For the example in step 3 of the Build a Report in OTBI section in this
topic, this would be the Customer Row ID field. Also select the object field whose value will be passed to the
report. For the example above, this would be the PartyId field.

8. Click Save.
9. Test your update by following the steps in the Test Your Configurations topic.
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Rename Child Objects and Strings in the App  
You can change the names of child objects and strings in the app - such as page headers, section headers, actions, and
titles - to suit your business requirements.

Here's how you do that:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. In the Application Features pane, click I18N.
6. Select the relevant language and then select the string you want to change.
7. Enter the new name in the Edit String box.
8. Click Save.
9. Test and publish your new page layouts. See the Test Your Configurations topic for details about how to check

your mobile configurations.

Note:  If the string you want to change isn't available in the choice list, you can submit a request to add the string
using the Ideas tab in Oracle Cloud Customer Connect.

Create Criteria for Page Layouts  
You can create criteria for a standard and custom object's page layout, so that a condition, or a set of conditions have
to be met before the page layout is displayed. You can restrict the page layout by role, geographical region, and by field
value.

Assign User Roles to a Page Layout
You can create a page layout for a standard or custom object that will only be displayed to one, or multiple user roles.
This can be very useful if, for example, you want to create a page layout for a Sales Manager role, which will require
certain fields on an opportunity detail record that other sales team members won't need. Here's how you set it up:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. In the Application Features pane, click the feature that contains the page layout that you want to add roles to,

for example, Opportunities.
6. Select the relevant type of page view, such as the List or Summary view.
7. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Configure the App

Using the Configuration Tool topic for details about how to create a page layout).
8. In the Assigned Roles pane, select the role, or roles, that you want to add.
9. Click Save.
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Assign Geographical Regions to a Page Layout
Adding geographical regions to a standard or custom object's page layout, enables you to restrict its availability to users
from a selected set of geographical regions. For example, if you add the United States and United Kingdom regions to a
page layout, then only users from these countries can view the layout. Here's how you set it up:

1. Repeat steps 1 to 7 in the Assign User Roles to a Page Layout section.
2. In the Assigned Regions pane, select the geographical regions by clicking on the region. Select as many regions

as you require.
3. Click Save.

Assign Advanced Criteria to a Page Layout
Creating advanced criteria enables you to define a set of conditions that have to be met before the page layout
is displayed for a standard or custom object's Summary or Edit views. For example, if you create criteria for an
Opportunity Summary layout as follows: Opportunity Type is Equal to Finance, then any opportunities with a Finance
opportunity type will use your layout in the Summary view.

1. Repeat steps 1 to 7 in the Assign User Roles to a Page Layout section.
2. In the Advanced Criteria pane, create your criterion by selecting a field from the list, an operator, and then

entering the relevant field value.
3. To add a conditional statement to your criterion, click Add Criteria, and select AND or OR. Enter the field,

operator, and relevant field value.
Note:  If you want to have multiple AND/OR conditions, it's best to use custom scripting to specify your
criteria. See the "Configure the App with Custom Scripts" for information about creating a custom script.

4. Click Save.

If you're creating criteria for a child object's page layout, then you can choose fields from the child and parent object.
For example, you can create an advanced criteria where an opportunity's Opportunity Type value determines the page
layout for opportunity revenue page.

Prioritize Your Page Layouts
Page layouts display in priority order in the Layouts pane. The page layout at the top is the first layout that's displayed to
the user, if they fit the criteria that you have set up. The second page layout is the second layout that displays if the user
doesn't fit the first criteria, but does fit the second page layout's criteria, and so on. You can move the layouts around by
dragging them to your preferred priority position.

It's recommended that you create a default layout that's applicable to everyone and place the default layout at the
bottom of the Layouts pane. Setting a default layout means that users will see at least one of the page layouts if they
don't fit the criteria you have set up.

Test Your Page Layouts
It's important to test your configurations before publishing the sandbox. See the Test Your Configurations topic for
details about how to check your mobile configurations.

Add Criteria to Actions in List and Summary Page Layouts  
You add criteria to actions, such as create and edit actions, to List and Summary pages, so that the actions will only
appear when the conditions have been met. For example, you can add a criteria to the Create Appointment action,
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so that the action will appear only when the Account Score field is greater than a set value. Here's how you set up the
criteria:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select or create the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the CX Sales Mobile Composer tab.
6. In the Application Features pane, click the relevant feature.
7. Click either the Summary or List page layout.
8. In the Layouts pane, select an existing page layout, or create a new page layout by clicking the Click to Clone

icon.
9. In the interface designer, click the more icon (three horizontal dots) in the header and select the relevant action,

such as the Create Task action.
10. Click Add Criteria.
11. Enter the Field, Operator, and Value.
12. If you want to add more criteria click Add Criteria and enter the criteria values.
13. Add as many criteria as you require.
14. Click OK.
15. Click Save.
16. Repeat the steps above for each action that you want to add criteria to.
17. Test and publish your new page layouts. See the Test Your Configurations topic for details about how to check

your mobile configurations.

Configure the App with Custom Scripts  
You can further configure the app to match your business requirements by writing custom scripts using JavaScript that
enforce validations and rules, whether you're online or offline. This powerful feature enables you to write scripts that
can trigger on an event of your choosing, for any top-level parent object and child object. For example, you can create a
script that will make the product field mandatory when you create an opportunity.

How to Create a Script
You can create custom scripts for all objects, or for a specific object. Here's how you create a custom scripts for a specific
object:

1. Select the sandbox you want use for your configuration.
2. Select Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Scripts tab at the top of the Mobile Application Setup page.
4. To create a script for a top-level parent object, select the object you want to write a script for, and then select

the event that will trigger your script. You can choose one of these events:

◦ On Create (triggered when a new record is created in the mobile app).

◦ Before Save (triggered before a record is saved).

◦ After Save (triggered after the app has saved the record).

◦ On Field Value Change (triggered when a user changes the value of a field and then taps out of the
field).

◦ On Edit (triggered when a user edits a record).
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5. To create a script for a child object, select the top-level parent object, then select the relevant child object in the
Opportunities Children section. Finally, select the event that will trigger your script.

Note:  If you want to create validation for a child object's Before Save or After Save event, you have to use
the parent object's Before Save or After Save event.

6. Click the plus icon in the <Event Name> Scripts section.
7. Enter the script name and description.
8. (Optional) If you want the script to work for particular regions, select geographical regions for the script. The

script will work for users who have your selected regions as their country preference setting in the CX Sales app.

Note:  A script can have multiple regions associated to it, but the same region can't be assigned to more than
one active script for the same object and event.

If you want to restrict your script to trigger for certain user roles, you will need to specify these by writing a
JavaScript script

9. Click Create and create your script.
10. Click Validate to check whether your script has any errors. The validation checks include checks for nested

functional calls and anything else in the script that will cause it to run forever in an infinite loop.
11. When you're finished, click Save.

How to Create a Custom Function
You can also create a custom function (known as a utility function) that will be available for all objects in all of your
scripts. Here's how:

1. Follow steps 1 to 6 in the How to Create a Script section, and then click the plus icon in the Utility Functions
section.

2. Create your function. Make sure that you include "_C" in the function, so that the function is designated as a
utility function, and is included in the System Functions list (see the Feature That Helps You to Create Your
Scripts section below for details about System Functions). Once it's in the System Functions list, you can access
your utility function from any custom script. Here's an example of the format:

function example_c() {
var a = 100;
a = 100+a
}

3. Click Validate and then Save.

Feature That Helps You to Create Your Scripts
When you're creating your scripts it's important that you enter the correct object and field values, so to help you with
this you can type Control + Space in the script box and a list of objects and fields are displayed. Pick the object or field
that you want to include and the correct value is added to your script.

This feature also enables you to use the System Functions that auto-populate APIs into your script. Type Control
+ Space, scroll down to the System Functions section, and you will see a list of APIs that you can use. You can use
these APIs, for example, to find out the device's operating system and the current position of the user. In the System
Functions section, you can also see the Utility Functions that you have created. See the Library of System Functions for
Custom Scripts topic for a list of the System Functions that are available and how you can use them.
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Test Your Script
To help you test your script, you can use the CXCoreLogger class methods in your script to write warning, error, or info
messages. You can then review the messages to debug the script.

After debugging the script, test the script in CX Sales Mobile, and then publish the sandbox when you're done. See the
Test Your Configurations topic for details about how to check your configurations in CX Sales Mobile.

Script Examples
Here are some examples of how you can create custom validation and rules:

Object, Event, and Requirements Example Script

Object: Opportunity
 
Event:  OnCreate
 
Requirement: Auto-populate the name
 
and owner field for the Opportunity.
 

var oracleCxmOutcome = new Result("");
var currentRow = await getCurrentRow();
var userPref = await getUserPreferences();
var partyName = userPref.getPartyName();
currentRow.setColumn('PartyName1',partyName);
currentRow.setColumn('Name', 'StandardScript'+new
 Date().toISOString().substring(0, 10));
oracleCxmOutcome.setMessage('MESSAGE_TYPE_SUCCESS', '' , 'OOB Script for
 oppty-OnCreate executed');

Object: Opportunity
 
Event:  BeforeSave
 
Requirement: Update the Opportunity
Revenue
 
amount based on child revenue amounts.
 

var oracleCxmOutcome = new Result('');
var currentRow = await getCurrentRow();
var childRev = currentRow.getColumn('ChildRevenue');
 let totalAmount = 0;
if(childRev) {
let items = currentRow.getColumn('ChildRevenue').items;
 if(items) {
 items.forEach((item) => {
 totalAmount = totalAmount + item.RevnAmount;
 });
 }
}
 currentRow.setColumn('Revenue',totalAmount);

Object: Opportunity
 
Event:  AfterSave
 
Requirement: Add a note to the
opportunity,
 
if the opportunity isn't newly created.
 

var oracleCxmOutcome = new Result('');
var optiRow = await getCurrentRow();
if(!optiRow.isNew()) {
 var opptyNote = await createNewRow(true, 'opportunities', 'Note');
 var noteTxt =
 'VGhpcyBOb3RlIHdhcyBjcmVhdGVkIHRocm91Z2ggc2NyaXB0IGZvciBvcHB0eSAtIA==';
 opptyNote.setColumn('NoteTxt',noteTxt);
 optiRow.setColumn('Note',opptyNote);
 oracleCxmOutcome.setModifiedObject(optiRow);
}

Object: Opportunity
 
Event:  OnFieldValueChange -
Status Code
 
Requirement: If the status code value is
changed
 
to WON/LOST, and the win/loss reason
isn't specified,

var oracleCxmOutcome = new Result('');
var optyRow = await getCurrentRow();
var statusCode = optyRow.getColumn('StatusCode');
var reasonWonLostCode = optyRow.getColumn('ReasonWonLostCode');

if((statusCode === 'WON' || statusCode === 'LOST') && (!reasonWonLostCode)) {
 oracleCxmOutcome.setMessage('MESSAGE_TYPE_SUCCESS', '' , 'You have selected'
 + statusCode);
 optyRow.setColumnMandatory('ReasonWonLostCode', true);
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Object, Event, and Requirements Example Script

 
then the ReasonWonLostCode field is
made mandatory,
 
and a message is displayed 'Please specify
win/loss reason.'
 

 oracleCxmOutcome.setMessage('MESSAGE_TYPE_ERROR', '' , 'Please specify win/
loss reason');
}

 if(statusCode !== 'WON' && statusCode !== 'LOST') {
 optyRow.setColumn('ReasonWonLostCode',null);
 optyRow.setColumnMandatory('ReasonWonLostCode', false);
 }

Object: Opportunity Revenue
 
Event:  OnCreate
 
Requirement: The OnCreate event
for the child object called Opportunity
Revenue auto-populates its custom field
values.
 
 

var optiRow = getCurrentRow();
const optyRow = getCurrentRow();
const childRev = getCurrentChildRow();
var oracleCxmOutcome = new Result("");
childRev.setColumn('CXM_Text_c','Single Text');
childRev.setColumn('CXM_Date_c',"2020-03-20");
childRev.setColumn('CXM_CC_c',true);
childRev.setColumn('CXM_Perc_c',.32);
childRev.setColumn('CXM_Num_c',5000);
childRev.setColumn('CXM_LText_c','RGVtbyB0ZXh0IHRvIGJlIGVudGVyZWQ=');

oracleCxmOutcome.setMessage("MESSAGE_TYPE_SUCCESS", "", "OnCreate on Child:");

Object: Opportunity
 
Event: OnFieldValueChange
 
Field: Dynamic choice list whose filter
value is being checked.
 
Requirement: Trigger error if user
attempts to select a dynamic choice list
value that doesn't meet filter criteria.
 
Prerequisite: Include filter criteria field (in
this example, the Account Type) in filter
object Picker page on CX Sales Mobile
 

var oracleCxmOutcome = new Result('');
const optyRow = getCurrentRow();
const accountsQuery = query('accounts'); //query accounts or another object,
 depending on the use case
accountsQuery.setParameters('PartyId', optyRow.getColumn('account_dcl_Id_
c')); //be sure to use the ID field for your DCL here, not the name field
try {
const accountsResponse = accountsQuery.execute();
if (accountsResponse && accountsResponse.length > 0) {
if(accountsResponse[0].getColumn('OrganizationDEO_LSAccountType_c') !==
 'SERVICE_CENTER'){ //This checks to see if the filter criteria applied to the
 DCL are met
 oracleCxmOutcome.setMessage('MESSAGE_TYPE_ERROR', '' , 'You must choose an
 organization that is a Service Center. Choose the Service Centers list in the
 Show filter.');
oracleCxmOutcome.setOutcomeQualifier("OUTCOME_TYPE_FAILURE"); //The error
 message here indicates that Service Centers is the name of the saved
 Workspace Search, and is the filter the user should select
}
}
} catch (e) {
//failed to get accounts response
}

Object: Opportunity
 
Event: BeforeSave
 
Requirement: Trigger error if user
attempts to save a record with an invalid
dynamic choice list value.
 
Prerequisite: Include filter criteria field (in
this example, the Account Type) in filter
object Picker page on CX Sales Mobile
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var oracleCxmOutcome = new Result('');
const optyRow = getCurrentRow();
const accountsQuery = query('accounts'); //query accounts or another object, depending on the use case
accountsQuery.setParameters('PartyId', optyRow.getColumn('account_dcl_Id_c')); //be sure to use the ID field for
 your DCL here, not the name field
try {
const accountsResponse = accountsQuery.execute();
if (accountsResponse && accountsResponse.length > 0) {
if(accountsResponse[0].getColumn('OrganizationDEO_LSAccountType_c') !== 'SERVICE_CENTER'){ //This checks to see
 if the filter criteria applied to the DCL are met
 oracleCxmOutcome.setMessage('MESSAGE_TYPE_ERROR', '' , 'You must choose an organization that is a Service
 Center. Choose the Service Centers list in the Show filter.');
oracleCxmOutcome.setOutcomeQualifier("OUTCOME_TYPE_FAILURE"); //The error message here indicates that Service
 Centers is the name of the saved Workspace Search, and is the filter the user should select
}
}
} catch (e) {
//failed to get accounts response
}

Library of System Functions for Custom Scripts  
When you're creating your custom scripts, you can use a feature that enables you to use System Functions that auto-
populate APIs into your script. Type Control + Space, scroll down to the System Functions section, and you will see a list
of APIs that you can use. Here are more details about the System Functions and their related classes.

System Functions
These are the System Functions that are available:

Method Signature Definition Usage

getCurrentRow()
 

Returns the current row.
 
For information about the Row class methods,
 refer to the table below.
 

const taskRow = getCurrentRow();
const statusCode =
 taskRow.getColumn('StatusCode');

getCurrentChildRow()
 

Returns the current child row if we are in
context of a child row, else it returns null.
 
Refer to the Row class methods in the next
table.
 

const optyRow = getCurrentRow();
const childRev =
 getCurrentChildRow();
childRev.setColumn('RevnAmountCurcyCode',
 optyRow.getColumn('CurrencyCode'));

createNewRow(isChild: boolean,
 featureName: string, childType:
string)
 

Creates new row or child row for the given
resource and child type. Only supported in
AfterSave event.
 
Refer to the Row class methods in the next
table.
 

const opptyRow = createNewRow(false,
 "Opportunity", null);
opptyRow.setColumn("Name","New
 oppty");

Note:  The use of this API is recommended
for creating a row for the top level resource
only. For creating a child of a top level
resource, please refer to addNewChildRow
under Row class.
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query(resource: string)
 

Returns Query object for the given resource.
This can be used to query rows of the given
resource by setting query parameters. This
function only queries for data stored locally on
the device.
 
Refer to the Query class methods in the next
table.
 

const currentRow = getCurrentRow();
const userPrefProvider =
 getUserPreferences();
const resourceQuery =
 query('resources');
resourceQuery.setParameters('PartyId',
 userPrefProvider.getPartyId());
let cxCoreLogger =
 getCXCoreLogger().getLogger();
try {
const resourceResponse =
 resourceQuery.execute();
if (resourceResponse &&
 resourceResponse.length > 0) {
currentRow.setColumn('JobName',
resourceResponse[0].getColumn('JobMeaning'));
}
} catch (e) {
//failed to get resource response
cxCoreLogger.error("Query on
 resources failed");
}

Note:  This API is for querying on the
basis of primary key only. To query
using any other field please refer to the
queryWithParameters API below.

getUserPreferences()
 

Returns UserPreferences object. This can be
used to retrieve different user preferences.
 
For information about the UserPreferences
class methods, refer to the table below.
 

const row = getCurrentRow();
const userPrefProvider =
 getUserPreferences();
const closeDate =
 userPrefProvider.getProfileOptionValue(
'MOO_DEFAULT_CLOSE_WINDOW'
);

getDeviceInformation()
 

Returns DeviceInformation object. This
can be used to retrieve different device related
information.
 
Refer to the DeviceInformation class
methods in the next table.
 

const deviceInfo =
 getDeviceInformation();
const os = deviceInfo.getOs();

getCXCoreLogger().getLogger()
 

Returns an instance of CXCoreLogger which
can be used for logging info, error, warnings,
 and so on.
 
Refer to the CXCoreLogger class methods in
the next table.
 

const currentRow = getCurrentRow();
const userPrefProvider =
 getUserPreferences();
const resourceQuery =
 query('resources');
resourceQuery.setParameters('PartyId',
 userPrefProvider.getPartyId());
let cxCoreLogger =
 getCXCoreLogger().getLogger();
try {
const resourceResponse =
 resourceQuery.execute();
if (resourceResponse &&
 resourceResponse.length > 0) {
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currentRow.setColumn('JobName',
resourceResponse[0].getColumn('JobMeaning'));
}
} catch (e) {
//failed to get resource response
cxCoreLogger.error("Query on
 resources failed");
}

getParentRow()
 

Returns the parent object from which the
current object was accessed. Only to be used
in context of top level objects being visited via
another top level object.
 

Note:
This function doesn't return the parent for a
child row.
 

Refer to the Row class methods in the next
table.
 

/*Appointments - OnCreate*/
const row = getCurrentRow();
const parentRow = getParentRow();

if (parentRow &&
 parentRow.getResourceName() ===
 'leads') {
row.setColumn(
'LeadId',
parentRow.getColumn('LeadId')
);
row.setColumn(
'LeadName',
parentRow.getColumn('Name')
);
if
 (parentRow.getColumn('PrimaryContactId'))
 {
row.setColumn(
'PrimaryContactId',
parentRow.getColumn('PrimaryContactId')
);
row.setColumn(
'PrimaryContactName',
parentRow.getColumn('PrimaryContactPartyName')
);
}
if
 (parentRow.getColumn('CustomerId'))
 {
row.setColumn(
'AccountId',
parentRow.getColumn('CustomerId')
);
row.setColumn(
'AccountName',
parentRow.getColumn('CustomerPartyName')
);
}
}

getLovDataProvider()
 

Returns local list of values (LOV) data provider.
The LOV data can be fetched using this
provider.
 

const row = getCurrentRow();
const userPrefProvider =
 getUserPreferences();
const territory =
 userPrefProvider.getTerritory();
const lovProvider =
 getLovDataProvider();
const countryCodeLov =
 lovProvider.getLovData('WorkPhoneCountryCode');
if (countryCodeLov) {
 let locale;
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 for(let i =0 ; i <
 countryCodeLov.length ; i++) {
 if(countryCodeLov[i].TerritoryCode
 === territory) {
 locale = countryCodeLov[i];
 }
 }
 if(locale) {
 if
 (row.getColumn('MobileCountryCode')
 == null || row.isNew()) {
 row.setColumn('MobileCountryCode',
 locale.PhoneCountryCode);
 }
 if
 (row.getColumn('WorkPhoneCountryCode')
 == null || row.isNew()) {
 row.setColumn('WorkPhoneCountryCode',
 locale.PhoneCountryCode);
 }
 }
}

queryWithParameters (resource:
string, dynamicParams: array)
 

Used to query for records by passing dynamic
fields, operator, and values.
 

let currentRow = getCurrentRow();
let q =
 queryWithParameters('opportunities',
 [{'field': 'Name', 'operator':
 'contains', 'value': 'testQ'}]);
let rows = q.execute();
if(rows && rows.length > 0) {
 let account =
 rows[0].getColumn('TargetPartyId');
 currentRow.setColumn('TargetPartyId',
account);
}

Class Methods
Here are the class methods for the System Functions outlined in the previous table and examples of how you can use
them.

• Row Class Methods:

Method Signature Definition Usage

setColumn(name: string, value:
string)
 

Used to set value of a particular column of the
row.
 

const optyRow = getCurrentRow();
const childRev =
 getCurrentChildRow();
childRev.setColumn('RevnAmountCurcyCode',
 optyRow.getColumn('CurrencyCode'));

getColumn(name: string)
 

Used to get value of a particular column of the
row.
 

const taskRow = getCurrentRow();
const statusCode =
 taskRow.getColumn('StatusCode');

865



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 35
CX Sales Mobile

Method Signature Definition Usage

isNew(): boolean
 

Returns true if the row is new else it returns
false.
 

const taskRow = getCurrentRow();
const isNew = taskRow.isNew();

getResourceName(): string
 

Returns the resource to which the row belongs.
 

const parentRow = getParentRow();
const res =
 parentRow.getResourceName()

setColumnMandatory(name: string,
 value: boolean)
 

Used to set value of mandatory property for a
particular column.
 

Note:
Use this function instead of the CX Cloud
Mobile function if you're copying your CX
Cloud Mobile script. See the Copy Your CX
Cloud Mobile Configurations to CX Sales
Mobile topic for more details.
 

const optyRow = getCurrentRow();
const childRev =
 getCurrentChildRow();
childRev.setColumnMandatory('UnitPrice',
 true);

setColumnUpdatable(name: string,
 value: boolean)
 

Used to set value of updatable property for a
particular column.
 

const optyRow = getCurrentRow();
const childRev =
 getCurrentChildRow();
childRev.setColumnUpdatable('RevnAmountCurcyCode',
 canEditCurrency === 'Y');

setColumnVisible(name: string,
 value: boolean)
 

Used to display/hide a particular column.
 

const row = getCurrentRow();
row.setColumnVisible('ReasonWonLostCode',
 false);

addNewChildRow(childName: string)
 

Adds new child to the row.
 

const row = getCurrentRow();
const resources =
 row.addNewChildRow('ActivityAssignee');
resources.setColumn('AssigneeName',
 userPrefProvider.getPartyName());
resources.setColumn('AssigneeId',
 userPrefProvider.getPartyId());

setColumnDisplayType(fieldName:
string, DisplayType.TEXT
| DisplayType.TEXTSCAN |
DisplayType.NUMBER)
 

Used to change the display type of a field to
text, scan or number.
 

let row = getCurrentRow();
row.setColumnDisplayType("MyCustomSerialNumber",
DisplayType.TEXTSCAN);

disableAction(action: string,
 disable: boolean)
 

Used to disable or enable the save action in the
edit view.
 

let optyRow = getCurrentRow();
optyRow.disableAction('Save',true);

getOriginalValues()
 

Used to get the original values of a field before
it was modified.
 

const row = getCurrentRow();
let oriVal = row.getOriginalValues();
let oriName = oriVal.Name;
let currName = row.getcolumn('Name');

• Query Class Methods:
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getParameters()
 

Used to get all available parameters for this
query.
 

let oracleCxmOutcome = new
 Result('');
let currentRow = getCurrentRow();
let id =
 currentRow.getColumn('OptyId');
let qT = query('opportunities');
let param = qT.getParameters()[0];
qT.setParameters(param,id);
let rows = qT.execute();
if(!rows ||
 rows[0].getColumn('OptyId') !== id)
 {
oracleCxmOutcome.setErrorMessage("Query
 on current row failed"); 
} else {
 oracleCxmOutcome.setMessage("MESSAGE_
TYPE_SUCCESS","","Query successful");
}

setParameters(name: string, value:
string)
 

Used to set value of a particular query
parameter.
 

const resourceQuery =
 query('resources');
resourceQuery.setParameters('PartyId',
 userPrefProvider.getPartyId());

execute()
 

Used to perform the query. It returns the set of
rows that satisfy the query criteria.
 

const resourceQuery =
 query('resources');
resourceQuery.setParameters('PartyId',
 userPrefProvider.getPartyId());
try {
const resourceResponse =
 resourceQuery.execute();
if (resourceResponse &&
 resourceResponse.length > 0) {
resources.setColumn(
'JobName',
resourceResponse[0].getColumn('JobMeaning')
);
}
} catch (e) {
//failed to get resource response
}

• UserPreferences Class Methods:

Method Signature Definition Usage

getUserSettings()
 

Returns user settings.
 

const userPref =
 getUserPreferences();
const userSettings =
 userPref.getUserSettings();

getUserName()
 

Returns the user name for the current user.
 

const userPref =
 getUserPreferences();
const userName =
 userPref.getUserName();
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getPartyName()
 

Returns name of the current user.
 

const userPref =
 getUserPreferences();
const partyName =
 userPref.getPartyName();

getDateFormat()
 

Returns date format set by the current user.
 

const userPref =
 getUserPreferences();
const dateFormat =
 userPref.getDateFormat();

getPartyId()
 

Returns ID of the current user.
 

const userPref =
 getUserPreferences();
const partyId =
 userPref.getPartyId();

getCurrency()
 

Returns currency set by the current user.
 

const userPref =
 getUserPreferences();
const currency =
 userPref.getCurrency();

getTimezone()
 

Returns time zone set by the current user.
 

const userPref =
 getUserPreferences();
const timeZone =
 userPref.getTimezone();

getNumberFormat()
 

Returns number format set by the current user.
 

const userPref =
 getUserPreferences();
const numberFormat =
 userPref.getNumberFormat();

getLanguage()
 

Returns language set by the current user.
 

const userPref =
 getUserPreferences();
const language =
 userPref.getLanguage();

getRoles()
 

Returns roles assigned to the current user.
 

const userPref =
 getUserPreferences();
const roles = userPref.getRoles();

getProfileOptions()
 

Returns all the profile options for the current
user.
 

const userPref =
 getUserPreferences();
const profileOptions =
 userPref.getProfileOptions();

getProfileOptionValue(profileOption)
 

Returns profile option value of the specified
profile option for the current user if the profile
option exists, else it returns null.
 

const userPref =
 getUserPreferences();
const profileOptionValue =
 userPref.getProfileOptionValue($PROFILE_
OPTION_STRING)

isRoleAssigned(role)
 

Returns true if the specified role is assigned to
the current user else it returns false.
 

const userPref =
 getUserPreferences();
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const isRoleAssigned =
 userPref.isRoleAssigned($USER_ROLE_
STRING);

getDefaultBU()
 

Used to fetch the default BU of the current user.
Refer to the Business Unit Class Method below.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();

• DeviceInfo Class Methods:

Method Signature Definition Usage

getCurrentPosition(maximumAge :
Number ,timeout : Number ,
enableHighAccuracy : Boolean)
 

Returns the location of the device.
 
Parameters:
 

• maximumAge: The time in milliseconds
that's acceptable for cached position.
Enter 0 if a cached position isn't
acceptable.

• timeout: The maximum length
of time (milliseconds) that's
allowed to pass from the call to
navigator.geolocation.getCurrentPosition
until the corresponding
geolocationSuccess callback executes.
If the geolocationSuccess callback
isn't invoked within this time, the
geolocationError callback is passed a
PositionError.TIMEOUT error code.

• enableHighAccuracy: Provides a
hint that the application needs the best
possible results. By default, the device
attempts to retrieve a 'Position' using
network-based methods. Setting this
property to 'true' tells the framework
to use more accurate methods, such as
satellite positioning.

const deviceInfo =
 getDeviceInformation();
const position =
 deviceInfo.getCurrentPosition(3000,
5000,true); 
const latitude =
 position.coords.latitude;
const longitude =
 position.coords.longitude;

getOs()
 

Returns the operating system name for the
device.
 

const deviceInfo =
 getDeviceInformation();
const os = deviceInfo.getOs();

getPlatform()
 

Returns platform name of the device.
 

const deviceInfo =
 getDeviceInformation();
const platform =
 deviceInfo.getPlatform();

getVersion()
 

Returns device version.
 

const deviceInfo =
 getDeviceInformation();
const version =
 deviceInfo.getVersion();
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getModel()
 

Returns device model name.
 

const deviceInfo =
 getDeviceInformation();
const model = deviceInfo.getModel();

isDeviceOnline()
 

Returns true if the device is online, else false.
 

const deviceInfo =
 getDeviceInformation();
const online =
 deviceInfo.isDeviceOnline();

• CXCoreLogger Class Methods:

Method Signature Definition Usage

setLogLevel(level: string)
 

Set logging level. Level values can be : info,
 error, warn, log, and none.
 

const row = getCurrentRow();
row.setColumn("Name","New oppty");
let cxCoreLogger =
 getCXCoreLogger().getLogger();
cxCoreLogger.setLogLevel("info");
cxCoreLogger.info ("On create event
 executed"

log(...args: any[])
 

Logs the message at log level.
 

const row = getCurrentRow();
row.setColumn("Name","New oppty");
let cxCoreLogger =
 getCXCoreLogger().getLogger();
cxCoreLogger.setLogLevel("log");
cxCoreLogger.log("On create event
 executed");

info(...args: any[])
 

Logs the message at info level.
 

const row = getCurrentRow();
row.setColumn("Name","New oppty");
let cxCoreLogger =
 getCXCoreLogger().getLogger();
cxCoreLogger.setLogLevel("info");
cxCoreLogger.info ("On create event
 executed");

warn(...args: any[])
 

Logs the message at warn level.
 

const row = getCurrentRow();
row.setColumn("Name","New oppty");
let cxCoreLogger =
 getCXCoreLogger().getLogger();
cxCoreLogger.setLogLevel("warn");
cxCoreLogger.warn("On create event
 executed");

error(...args: any[])
 

Logs the message at error level.
 

const row = getCurrentRow();
row.setColumn("Name","New oppty");
let cxCoreLogger =
 getCXCoreLogger().getLogger();
cxCoreLogger.setLogLevel("error");
cxCoreLogger.error("On create event
 executed");
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Method Signature Definition Usage

setModifiedObject()
 

Used to include a newly created row, or updated
row, in the set of rows that the script has
modified. This action will ensure that the
included row is committed by event-handler
implementation.
 

var oracleCxmOutcome = new
 Result('');
var row = getCurrentRow();
row.setColumn("Name","Sample Obj");
oracleCxmOutcome.setModifiedObject(row);

Note:  Any row created or modified in an
After Save event needs to be added using the
Result object's setModifiedObject API, so
that the changes are saved.

setMessage(key, stringBundle,
 message)
 

Used to add a message that can be returned
to the event handler implementation. The
key can be : "MESSAGE_TYPE_SUCCESS" or
"MESSAGE_TYPE_ERROR".
 

var oracleCxmOutcome = new
 Result('');
var row = getCurrentRow();
row.setColumn("Name","Sample Obj");
oracleCxmOutcome.setModifiedObject(row);
oracleCxmOutcome.setMessage("MESSAGE_
TYPE_SUCCESS","","Row modified");

setErrorMessage(message)
 

Used to set the error message and to mark
the outcome qualifier as "OUTCOME_TYPE_
FAILURE".
 

var oracleCxmOutcome = new
 Result('');
var row = getCurrentRow();
var a = row.getColumn("A");
var b = row.getColumn("B");
if(a>b){
oracleCxmOutcome.setErrorMessage("Row
 validation failed");
} else {
oracleCxmOutcome.setMessage("MESSAGE_
TYPE_SUCCESS","","Row validated
 successfully");
}

setOutcomeQualifier()
 

Used to set qualifier to be handled post
script execution. Returned string could
be either"OUTCOME_TYPE_SUCCESS" or
"OUTCOME_TYPE_FAILURE". If the qualifier
"OUTCOME_TYPE_FAILURE" is used in the
beforeSave event, then the page will show
the error message set using setMessage/
setErrorMessage.
 

var oracleCxmOutcome = new
 Result('');
var row = getCurrentRow();
var a = row.getColumn("A");
var b = row.getColumn("B");
if(a>b){
oracleCxmOutcome.setMessage("MESSAGE_
TYPE_ERROR","","Row validation
 failed");
oracleCxmOutcome.setOutcomeQualifier("OUTCOME_
TYPE_FAILURE");
}

• Business Unit Class Methods:
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getName()
 

Used to get name of the Business Unit.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();
let name = defaultBU.getName();

getBusinessUnitId()
 

Used to get BusinessUnitID.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();
let businessUnitId =
 defaultBU.getBusinessUnitId();

getBUName()
 

Used to get the Business Unit name.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();
let buName = defaultBU.getBUName();

getBUId()
 

Used to get BU ID.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();
let buID = defaultBU.getBUId();

getDefaultBUFlag()
 

Used to get default BUFlag.
 

let userPrefProvider =
 getUserPreferences();
let defaultBU =
 userPrefProvider.getDefaultBU();
let defaultBUFlag =
 defaultBU.getDefaultBUFlag();

Use Your Many-to-Many Relationship Setup When You Create
Page Layouts  
Add your many-to-many relationship intersection objects to your page layouts, so that you can display the intersection
object fields with the respective target object fields in the page layout.

Here's how you set this up:

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the Source object of the Many-to-Many relationship, such as the Opportunity object.
6. Edit or create a new page layout, and click + Add Child or Related at the bottom of the page layout.
7. Search for your intersection object and select it.
8. Add fields from the intersection object, or the Source object, in the page layout.
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9. Click Save.
10. Test and publish your new page layouts. See the Test Your Configurations topic for details about how to check

your mobile configurations.
For more information about many-to-many relationships, see the "Many-to-Many Relationships" topic in the
"Configuring Applications Using Application Composer" guide.

Note:
• You can add the source object fields only in the page layout view. Editing the layout of the intersection object

only allows adding fields from the intersection object.

• Use the edit layout of the source object to edit fields on the source object.

• Tapping the summary page layout on the mobile app navigates users to the source object summary page
layout. The edit page layout only displays the details of the intersection object.

Related Topics
• Many-to-Many Relationships
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36  Microsoft 365

What This Chapter Contains  
Before beginning the integration between Oracle Sales and Microsoft 365, including the Oracle Sales for Outlook add-in,
keep in mind:

• You must start your implementation steps with the Implementing Sales guide chapter on the Microsoft 365
integration.

• The chapter in this guide only contains material that you should consult after your deployment of the add-in is
complete.

• You can find user concepts and procedures for the integration in the Using Sales guide chapter for Microsoft
365.

• Any features that are specific to Digital Sales that you can use with supported email applications are described
in the Using Digital Sales guide chapter on email.

Records Sync  

Autosync Appointments  
Let your users' appointments be automatically synced between Microsoft Exchange and Sales. With autosync enabled,
your salespeople don't have to categorize the appointments as Shared with Oracle anymore, for them to be syncronized.

After you enable autosync of appointments, here's what happens:

• The application automatically shares the appointments that have a Sales contact in the recipients list.

• When all the contacts on the appointment invitee list belong to the same account, the sync engine
automatically determines the account and assigns the appointment to the appropriate Sales records.

Navigate to the Manage Microsoft 365 Page
Here's how to navigate to the Manage Microsoft 365 page, where you set sync options.

1. Sign in as a setup user or as the sales administrator.
2. Go to:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

3. In the Manage Microsoft 365 page, make your changes and save them.
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Enable Appointment Autocapture
Let's see how you enable the application to automatically create appointments in Sales, even if they aren't categorized
as Shared with Oracle in Outlook. This setup means your users save time, because they don't have to share
appointments manually by setting the category of the appointment.

1. Navigate to the Manage Microsoft 365 page.
2. Under Synchronization Settings > Appointments ensure that Enable Sync setting is checked.
3. Enable the Autocapture Appointments option.
4. Save your changes.

Autosync Private Appointments and Blocked Time
Depending on your organization's preferences, you can let the application autosync private appointments and capture
the blocked time of users, as well. See the next two sections for more information.

Sync Private Appointments
You can configure the application to synchronize private appointments. When you sync private appointments, even
appointments that a user has marked as explicity private in Outlook are syncronized to Sales. Here's how to enable this
feature:

1. Navigate to the Manage Microsoft 365 page.
2. Under Synchronization Settings > Appointments ensure that Enable Sync setting is checked.
3. Ensure that Autocapture Appointments is checked.
4. Enable Include Private Appointments from Outlook.
5. Save your changes.

Enable Sync of Blocked Time
Now, let's see how you enable the application to also synchronize "blocked time" appointments. Blocked times are the
appointments that don't have any invitees. Salespeople sometimes create such appointments to block some time on
their calendars to complete priority tasks or for other reasons.

1. Navigate to the Manage Microsoft 365 page.
2. Under Synchronization Settings > Appointments ensure that Enable Sync setting is checked.
3. Ensure that Autocapture Appointments is checked.
4. Enable Capture Appointments with Empty Invitee List.
5. Save your changes.

Note:  If your appointment sync flow has customizations, such as default value settings, use Groovy scripting on the
Activity object to set the default values.

One-Way Sync for Appointments  
The sync engine syncs the appointments, contacts, and tasks between Microsoft 365 and Oracle Sales. Every time a
user updates or deletes a meeting or an appointment in Sales, the changes are synchronized to Outlook.

Every time the sync runs, notifications about these updates are sent to invitees. To prevent Outlook from sending
automatic emails to the invitees, you can set one-way sync for appointments. In one-way sync, changes made to
appointments in Outlook are synced to Sales, but the changes made in Sales aren't synced back to the appointments in
Outlook.
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Impact of One-Way Sync
Here's the impact of one-way sync for appointments:

• Your users can't use saved searches for appointments.

• Conflicts are set to "server wins" and are read-only.

• Meetings that exist only in Sales aren't synchronized to Outlook. Likewise, changes to meetings in Sales aren't
reflected in Outlook.

• Meetings created inside the side panel don't generate an equivalent Outlook meeting.

• If a user resolves sync errors related to appointments from the Resolve Synchronization Errors page, those
changes are reflected only in Sales.

• To summarize, the sales application doesn't update or create any appointments in Outlook.

Change Appointments Sync to One-Way
Bidirectional sync is the default sync for appointments. However, you can change it to one-way. Here's how you change
the sync pattern:

1. In the Setup and Maintenance work area, use the Manage Microsoft 365 task:
◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365
2. On the Manage Microsoft 365 page, unselect the Enable Bi Directional Appointment Sync check box.
3. Save your changes.

Note:  If a recurring appointment contains a custom field, only the first instance of the appointment is synced with the
Sales application. The custom field needs an object trigger or a field trigger. Use the object workflows to update the
custom fields in the recurring appointment.

Configure Conflict Resolution  
Conflicting records occur when there's a difference between information saved in Sales and the information in the
Microsoft 365 add-in. As an administrator, you can set the conflict resolution preference for your users.

Here are the steps to set the conflict resolution preference:

1. In the Setup and Maintenance work area, use:
◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365
2. On the Manage Microsoft 365 page, select the conflict resolution option in the Conflict Resolution section.
3. Enable the Allow User to Override Default Conflict Resolution option to allow users to view the conflict

resolution options in the add-in and select the option they want.
4. Select the conflict resolution option in the Conflict Resolution section:

◦ Server Wins: The values in Sales overwrite the values in Microsoft 365 automatically.
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◦ Client Wins: The values in Microsoft 365 overwrite the values in Sales automatically.

◦ User Selected: The user is prompted every time a conflict occurs. The Synchronization Status page
displays Successful with Conflicts as the status, along with a list of conflicting records.

5. Save your changes.

Turn Off the Synchronization Process  
When you don't want a continuous synchronization between Sales and Microsoft 365, or when you want to avoid
unnecessary sync failures, you can disable (turn off) the synchronization.

Here's how to disable the sync process:

1. In the Setup and Maintenance work area, use:
◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. Scroll to Synchronization Settings. Under the settings are three sections: Contacts, Appointments, and Tasks.
Each section shows an Enable Sync check box and other check boxes within the region, to specifically stop
creation or deletion of records.

3. Let's see each option in detail:

◦ Enable Sync: Use this check box to stop the to and from synchronization between the sales application
and Outlook. For example, deselecting the Sync Enabled check box, which is in the Appointments
section, stops syncing meetings or appointments.

◦ Enable Bidirectional Sync: This setting is available only for appointments. With this setting selected,
appointments are synced between CX Sales and Outlook. If you deselect it, the sync engine syncs
appointments from Outlook to CX Sales only and not from CX Sales to Outlook. To learn more, see the
One-Way Synchronization for Appointments topic.

◦ Allow Sync to Create CX Contacts, Appointments, or Tasks: These are separate settings under each
sync category that let you prevent the sync process from creating records in sales application, even if
there are new records added in the Outlook. Similarly, it stops creating records in Outlook, if the users
have added new records in the sales application. For example, deselecting the Allow Sync to Create CX
Tasks check box under the Tasks section stops sharing newly created records between Outlook and the
sales application.

◦ Allow Sync to Delete CX Contacts, Appointment, or Tasks: These are separate settings under each
sync category that let you prevent the sync process from removing records in Outlook, even when a user
deletes the corresponding record in the sales application. Similarly, the process stops deleting records
in the sales application when user deletes the corresponding ones in Outlook. For example, deselecting
the Allow Sync to Delete Contacts check box under the Contacts section stops deleting corresponding
records of contacts in the sales application as well as in Outlook.

Track Usage and Synchronization  
As an administrator, you can decide if you want to track and capture user actions on the Microsoft 365 add-in and track
synchronization details every day.

The application captures details such as the number of users using the Oracle add-in; the number of resources,
contacts, or appointments a user created on a given day; and the data that got synced to Oracle.
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Turn on these settings to enable your sales application to track user actions and application synchronization:

1. In the Setup and Maintenance work area, use:

◦ Offering: sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. Scroll down to the Usage Tracking section and select the Enable Add-in Usage Tracking.
3. Go to the next section, Synchronization Settings and select the Enable Synchronization Tracking check box.
4. Click Save and Close.

The add-in starts collecting the data after you turn on the settings. It doesn't generate any reports. Based on your need
in future, you can use this data for reporting purposes and draw useful insights.

Additional Configurations  

Enable Improved Sign-In Experience with Application Permissions 

When you set up the application in Microsoft Azure for this integration by following the setup steps, you would have
granted delegated permissions to the APIs required for the integration, such as Calendars.ReadWrite. These API
permissions are needed so that sync and the add-in can access user’s emails, appointments, contacts, and tasks in
Microsoft.

With delegated permissions, when your users' Microsoft token expires (90 days from last sign-in in the add-in), the sync
will not be able to continue and fails with error until the users re-sign into the add-in.

If you want sync to continue seamlessly without your users needing to sign-in to the add-in every 90 days, then you can
add application permissions for the APIs required for the integration to the application registered in Microsoft Azure.

After you give the additional application permissions to the application in Microsoft Azure, the standard sync scheduled
process uses the permissions to sign in. The add-in, meanwhile, continues to use the existing delegated permissions.

Note:  Only administrators can enable the application permissions.

After you give the application permissions, your users have to sign in to the add-in just once and then they don’t have to
open the add-in again.

Add and Enable Application Permissions
To add and enable the application permissions for the add-in:

1. Add the application permissions in Microsoft Azure for the application you created for the Oracle Microsoft 365
add-in.

2. Enable application permissions in the Sales application.
3. Notify your users to sign into the add-in once.

879



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 36
Microsoft 365

Add Application Permissions in Microsoft Azure

1. Sign in to Microsoft Azure.
2. Open the application you have registered for the Oracle Microsoft 365 add-in.
3. Go to the API Permissions tab and click Add a permission.
4. Select APIs my organization uses.
5. Search for Office and select Office 365 Exchange Online.
6. Click Application Permissions and add the permissions shown in this table:

Permission Option to Select

Calendars Calendars.ReadWrite.All

Contacts Contacts.ReadWrite

Mail Mail.ReadWrite

Mailbox Settings MailboxSettings.ReadWrite

Tasks Tasks.ReadWrite

User User.Read.All

7. Click Add Permissions.
8. On the API permissions page, select Grant admin consent for each permission you added to consent on behalf

of users.

Enable Application Permissions in the Sales Application

1. In the Setup and Maintenance work area, use the Manage Microsoft 365 task:
◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365
2. Under Synchronization Settings, select the Enable Application Permission check box.
3. Click Save and Close.

Configure an Application Access Policy to Secure Your Mailboxes  
Theoretically, any accounts using the application with the application permissions granted can gain access to all
mailboxes in the Microsoft tenant that the application is for. However, Oracle Microsoft 365 sync processes – which uses
this application – only uses the application to access users' mailboxes who have signed in to the add-in. The add-in
doesn't use application permissions on the application; it only uses the delegated permissions.

Depending on your company's security requirements, you may want to further restrict this application to only certain
users. For that, you can configure an application access policy before you enable the application permissions on the
application.

Note:  Configuring application access policy is optional and depends on your business' security requirements.

As a Microsoft Azure administrator, configure an application access policy:

1. Create a mail-enabled security group in the Microsoft Exchange admin center.
2. Create an application access policy in Microsoft PowerShell for the security group you created.
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The access policy restricts the scope of mailboxes that the standard sync process can access.

Create a Mail-Enabled Security Group

1. Sign in to the Exchange Admin Center at https://admin.exchange.microsoft.com/#/.
2. Navigate to Groups > Mail-enabled security.
3. Click Add a group, as shown in this screenshot:

4. In the Group type section, select Mail-enabled security and click Next, as shown in this screenshot:
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5. In the Basics section, enter a name and description, and click Next, as shown in this screenshot:

6. In the Settings section, enter the group email address, and configure the following. The image shows the
Settings menu, with the Edit settings page active. It also shows two check boxes in the Communication and
Approval sections.

a. Communication: Do not select the check box.
b. Approval: Select the Require owner approval to join the group check box, as shown in the following

screenshot.
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7. In the Finish section, verify all the details, and click Create group, as shown in this screenshot:

8. The mail-enabled security group you created shows up in the Groups list, as shown in this screen shot:

9. Next, you need to assign owners and add members to the group. To do that, click the group name.
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10. On the Group Details window, click the Members tab.
a. You are the owner of the group you created. If you want to add more owners, click View all and manage

owners.

The following screenshot shows the Limit Access window with the Members tab highlighted, along with
the View and manage all owners link:

b. On the Owners page, click Add owners, as shown in this screenshot:
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c. Select the group owners from the list and click Add, as shown in this screenshot:

Click the back arrow to go back to the Members tab.
d. Next, to the security group, add users you want to give a seamless access to. On the Members tab, click

View all and manage members, as shown in this screenshot:.
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e. On the Members page, click Add members.
f. Select the members from the list and click Add.

Click the back arrow to go back to the Members tab.
11. Close the group.

The mail-enabled security group is ready for use.

Create an Application Access Policy

1. Open Windows PowerShell.
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2. Run the following commands in Windows PowerShell.

◦ $UserCredential = Get-Credential

On entering the command, a window to enter your Windows PowerShell administrator credentials
appears. Enter the administrator credentials, as shown in this sample screenshot:.

◦ Next, enter the command, $Session = New-PSSession -ConfigurationName Microsoft.Exchange -
ConnectionUri https://outlook.office365.com/powershell-liveid/ -Credential $UserCredential -

Authentication Basic -AllowRedirection, , as shown in this sample screenshot:
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You get a prompt to enter your administrator credentials again. Enter them.

◦ Next, enter the command, Import-PSSession $Session -DisableNameChecking, as shown in this sample
screenshot:.
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3. Identify the application's Application (client) ID and a mail-enabled security group to restrict the access to the
application.

Note:  You can get the application's Application (client) ID from Microsoft Azure. Use the mail-enabled
security group you just created, by following the steps provided in the section above, Create a Mail-Enabled
Security Group.

4. Next, create an application access policy.

Replace the arguments for App Id, Application ID registered with Microsoft Azure, PolicyScopeGroupId, the
security group email address, and run the following command:

◦ New-ApplicationAccessPolicy -AppId xxxxxxxxxxxxxxxxxxxx -PolicyScopeGroupId xxxxxxxxxxxxxxxxxx -

AccessRight RestrictAccess., as shown in the following sample screenshot:

It may take about 30 mins for your changes to reflect.
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5. Test the newly created application access policy.
Run the following command, replacing the arguments for Identity and App Id. Identity is the user’s email
address added to the Security Group and AppId is the Application Id registered with Microsoft Azure.

◦ Test-ApplicationAccessPolicy -Identity <Identify> -AppId <AppId>

Enable Your Add-in for Government Tenant Privileges  
Microsoft 365 Government Community Cloud (GCC) is a Platform as a Service built on the Azure Commercial
infrastructure. Microsoft 365 GCC is certified to FedRAMP High standards for cloud systems.

It meets the flowdown requirements of DFARS 7012 as of February 2021, all of which enable customers handling
Controlled Unclassified Information (CUI) on behalf of the Department of Defense (DoD) to leverage the platform. See
the Microsoft 365 for Government web page to learn more.

If your organization is on Microsoft 365 GCC, the add-in will be configured considering the GCC tenancy requirements.
However, you need to indicate it in the add-in setup page.

Here’s how you mark GCC tenancy for your add-in:

1. In the Setup and Maintenance work area, use the Manage Microsoft 365 page:
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◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. On the left-navigation pane on the Manage Microsoft 365 task page, click the Outlook tab.
3. Under the Set Up Outlook Integration section, select the Government Tenant check box.
4. Click Save and Close to save your changes and close the page.

Manage User Mappings  
User mappings are critical for a user to sign in to the Oracle add-in. User mappings are combination of a user's
Microsoft email ID and the Sales application user ID. If any of them change, users can experience sign-in issues.

To avoid this, you can update these mappings whenever you're informed about a change in either of them. Similarly, if a
user is no longer active, you can remove the mapping.

Here's how you can review and update user mappings:

• Open the Microsoft 365 Monitor from the Manage Microsoft 365 page. You see a list of user mappings. Using
the relevant options available, you can update or delete the user mappings shown in the list:

◦ Update User Credentials: Use this option to correct or update the Microsoft email ID or User ID in the
sales application. To update, select the user mapping and select the Update User Credentials option
from the Actions menu. Make the necessary changes and save.

◦ Delete User: When a user leaves your organization, his Microsoft email ID is obsoleted. To delete the
mapping, select the user mapping and select the Delete User option from the Actions menu.

Note that only the user mapping between the Sales application user ID and Microsoft email ID is
deleted. The user ID of sales application continues to be active. The next time a new user uses the sales
application user ID, his Microsoft email ID is automatically mapped to this sales application user ID.

Configure the Share Option on Appointments and Tasks  
Your users use the Share Item button in the add-in to share contacts, opportunities, and appointments with the sales
application. Based on your business requirements, you may want to show or hide the share option for appointments
and tasks.

Here are the steps to configure:

1. In an active sandbox, open the CX Microsoft 365 Designer (Sales application > Application Composer >
Productivity Applications Setup > CX Microsoft 365 Designer).

2. Click Appointment in the Home page.
3. Scroll down to Feature Details and turn on Disable Share Flow to hide the Share Item button on

Appointments, for all the add-in users.
4. Do this for Task as well.
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5. Save your changes.

Note:  You can reverse this setting anytime. Come back to Appointment and Task in the Designer home
page and turn off Disable Share Flow. This lets your users share appointments and tasks again in the sales
application.

Allow Updating of External Appointments  
The salespeople who use the Microsoft 365 add-in can share external appointments with the sales application. Even
though the appointment is external to the company, you may want to let salespeople edit certain details, such as the
account, opportunity, and lead.

Remember that the meeting details, such as day, time, description, and location, will still be read-only.

Here's how you can allow salespeople to update external appointments:

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option, External Appointments Editing
Enabled (ORA_ZMM_ENABLE_EXTERNAL_APPT_EDIT), and set the Site value to Yes.

3. Save and Close the page.

Note:  External appointments synced from Microsoft 365 should be linked to your sales data to allow for tracking and
analytics.

Configure Activity List by Job Roles  
You can configure the add-in Activity list to appear based the job role of your users. For example, you can configure the
Activity list so that salespeople can only log calls, but sales managers can log calls and create a call report.

From the Activity tab of the add-in home page, your users can do these actions by default:

• Create Appointment

• Create Task

• Create Call Report

• Log a Call

Let's see how to configure this:

1. In an active sandbox, open the CX Microsoft 365 Designer (Sales application > Application Composer >
Productivity Applications Setup > CX Microsoft 365 Designer).

2. Click the hamburger icon and go to Home > Side Panel > Activity List.
3. Duplicate the standard layout to create your custom layout.
4. Do this in the custom layout:
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a. Select the roles from the Assigned Roles list.
b. Under Activity List Actions, you can see all the default actions available. Keep the actions you want these

roles to access and remove the others.
5. Save your layout.

Note:  You can create separate layouts based on roles and the activities you want them to access.

Enable Country-Specific Address Formats  
Your add-in supports country-specific address formats which means, when your users create a new contact or account,
the address fields relevant to the selected country appear. The country-based address fields are all available in a single
field called Primary Address.

The Primary Address field is available only in the Edit layouts of the Contacts and Accounts pages. When you add this
field to the Edit layout, your users can enter complete address of the contact or the account from the add-in.

Here's how you can add the Primary Address field to the Edit layout:

1. Ensure that you're working in an active sandbox.
2. In your sales application, go to CX Microsoft 365 Designer: Application Composer > Common Setup >

Productivity Applications Setup > CX Microsoft 365 Designer.
3. Click the menu icon in the Microsoft 365 Designer.
4. Open Edit view of Accounts and create a new layout.
5. In the new layout, drag and drop 'Primary Address' from the Available Fields and save the layout.
6. Similarly, create a new layout for Contacts, add Primary Address field and save the layout.

Note:  If you have existing custom layouts, then delete the old address fields and add Primary Address.

7. Click Save.
After adding Primary Address, the application moves details from your old address fields into the Primary Address
fields, and country-specific address formats take effect. If users gave invalid address in older fields, the synchronization
fails. However, users can resolve the sync issues by correcting the address details.

In the Detail layout of Accounts and Contacts, ensure that you add 'Address' field from the Available Fields section. This
field consolidates the entire Primary Address details that users enter in the Edit view.

Related Topics
• Sync Records Between the Sales Application and Microsoft 365 Outlook

Enable Advanced Sharing Mode  
If you have made any task or appointment fields mandatory in your custom layouts, turn on the Advanced Sharing
mode. This mode ensures that users don't miss entering information in mandatory fields.

Also, when this mode is on, the application shares users' emails or appointments beyond the ones that are under the
Related Records tab.
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Here are the steps to turn on Advanced Sharing:

1. Enter a sandbox and open Microsoft 365 Designer by going to Application Composer >  Productivity
Applications Setup > CX Cloud Microsoft 365.

2. Expand the side panel and go to Related Records.
3. Create a new layout and name it in a way that it indicates it's being used for 'Advanced Sharing'.
4. Save the layout.
5. Re-open the layout you just added.
6. In the layout details section, turn on Advanced Sharing Mode.
7. Save the layout.
8. Test your new layout and publish the sandbox.

Configure Smart List Attributes  
When a user clicks on the search icon in the dynamic choice list fields of the Microsoft 365 add-in without entering any
search criteria, the add-in fetches a list of items using predefined parameters, such as recently created, updated, or
visited records.

This list is called a smart list.

Note:  Smart lists are generated based on interactions on sales application, Microsoft 365 add-in, and Mobile.

Smart lists are enabled on dynamic choice lists Accounts, Contacts, Opportunities, and Leads. There's no setup required
for smart lists, but, you can configure the attributes you want your users to see for an item. Here's how you can do that:

1. Ensure that you're working in an active sandbox.
2. Go to Navigator > Configuration > Application Composer.
3. Select Productivity Applications Setup and then select CX Cloud Microsoft 365.
4. Open the Picker layout of an object, such as Account.
5. You can see the default attributes for that object. For example, you can see Primary Contact and Address for the

Account object. You can remove attributes and add new ones.
6. Save your changes.
7. Go to the Configure Adaptive Search page and ensure that these attributes you added in the designer are

enabled for Adaptive Search.

Note:  If Adaptive Search isn't enabled on these attributes, users see a blank space in place of these attributes in the
smart list.

FAQs for Microsoft 365  

Frequently Asked Questions (FAQs) for Microsoft 365  
This section contains the most frequently asked questions (FAQs) when setting up and maintaining Microsoft 365.
Scroll or search to find answers to common questions.
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Why do users have issues signing in to the add-in from the
Outlook desktop client?  
If your users have sign-in issues only with the desktop version of Outlook, they may have to update to a version
supported by the add-in. See the System Requirements for Outlook Applications for more information.

Why can't my users share meetings or email with the sales
application?  
If your users report issues with sharing meetings or emails, verify the status of activities related to these business
objects and enable them. For example, if your users are facing issues with sharing emails, verify if an activity for Email
exists.

This activity must be in the Manage Activity Type and Subtype task in the Setup and Maintenance work area. Ensure
that Appointments, Call Reports, and Tasks check boxes are turned on for that activity and set a start date. If you don't
find one, add an activity with the Name and Code as 'Email' and enable the check boxes. Save the activity. Do the same
if your users have issues with sharing appointments and other business objects as well.

My users can't find an item they're looking for, even though
Adaptive Search is enabled. Why?  
These are the possible reasons your users can't find an item they're looking for:

• If the field your user is searching on is available in the other add-in pages, but you haven't enabled these fields
to be searchable for Adaptive Searches, then users can't search by these fields. Turn on Adaptive Search and
keyword search on those fields.

• If Text search isn't enabled on a field, such as the Comments field, and your users are trying to perform a text
search on that Comments field, they can't get their desired result. Turn on the check box called 'Analyzed Text
Search' for that Text field.

• The field your users are searching on isn't supported by Adaptive Search, and thus isn't searchable. For
example, the Favorites attribute on the Contacts object isn't supported for Adaptive Search.

• If your users have read-only access or they don't have access rights to the data being searched, they can't find
the desired results.

My users say the smart list isn't showing any results. How can I fix
this?  
If your users have been actively updating or creating account, opportunity, or contact records in the sales application,
then the smart list appears based on the user context.
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Note:  Smart lists are based on sales application interactions only. Microsoft 365 add-in interactions don't contribute
to the smart list.

However, just to ensure that the latest feed is captured, run the Generate Relevancy Feed scheduled process in the sales
application.

CAUTION:  This scheduled process is part of Adaptive Search. If you run it, the process may affect all sales application
fields and not just the Microsoft 365 add-in fields. To run this scheduled process:

1. In the sales application, go to Tools > Scheduled Processes.
2. Click Schedule New Process.
3. Search for the process, Generate Relevancy Feed.
4. Click OK to run the process.

Why isn't the field I exposed in the Designer available in the
Adaptive Search configuration page?  
Sometimes the names of the fields you see in Microsoft 365 Designer and the corresponding fields in Adaptive Search
don't match exactly. To ensure that smart lists display attributes correctly, make sure the designer fields and Adaptive
Search fields are equivalent.

Do this before you enable the attributes or fields for Adaptive Search.

Why didn't the custom fields I created show up in the Microsoft
365 add-in?  
The Microsoft 365 add-in gets the data from the sales application through a REST API call. If the custom fields you
created aren't included in the REST service payload, your users can't find those fields in the add-in.

To add the fields to the service payload, go to Application Composer in the sales application and open your custom field
record. Select the Include in Service Payload check box and save your changes.

Why couldn't my user delete an opportunity contact?  
Your user with the Sales Representative job role, must own the opportunity and the associated account to delete the
contact related to it. If you have changed the configurations related to the job role, ensure that the job role includes the
Delete Opportunity privilege.
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How can I unblock a user whose access is blocked because of
signing in from another user's computer?  
In such scenarios, both the users are blocked from signing in to the Microsoft 365 add-in. Delete the users from the
synchronization log to unblock the users. Here's how:

1. In the Setup and Maintenance work area, use:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. On the task page, click Microsoft 365 Monitor.
3. On the Microsoft 365 Monitor page, select the users.
4. Click Actions and select Delete the User. Ask the users to sign in to the add-in again.

Why isn’t the invitee’s decline response shared with the sales
application?  
When an invitee shares a meeting with the sales application, Microsoft provides only the Microsoft ID (MS ID) and not
the iCalUId of the meeting. So, looking up an invitee’s decline response isn’t possible because the iCalUId isn’t available.
Also, the add-in doesn’t track the MS ID of all the invitees.

Note:  The invitee response of the meeting shared with the sales application is read-only for the organizer. The
organizer can’t change the response in the sales application.

How can I configure required fields for a contact address?  
Use the Manage Address Formats task to configure required address fields for contacts.

1. In Setup and Maintenance, use the Manage Address Formats task:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Task: Manage Address Formats

2. On the Manage Address Formats page, select a country from the Country list and click Search.
3. Select the postal address format if multiple formats are available and click Edit.
4. Select the Required check box for the field.
5. Click Save and Close.

Sign in again in the Microsoft 365 add-in for the changes to take effect.
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How can I reinstate the add-in that isn’t showing up on my
Outlook?  
Try the recovery steps provided here to reinstate the add-in:

1. Reinstall Outlook and add the add-in. If you still can’t see the add-in, then try the next step.
2. Verify the settings in the Microsoft admin center.

a. Set the deployment method in the Microsoft 365 admin center to Available.
b. Ensure that you have same user accounts in the add-in configuration in the Microsoft 365 admin center

and the Outlook Office account.

Let’s see the recovery steps in detail.

Reinstall Outlook and Add the Add-In
1. Uninstall Outlook from your computer.
2. From Microsoft’s portal, download the supported version of Outlook mentioned on the Oracle Application

Requirements page.
3. Open Outlook.
4. On the Home ribbon, click Get Add-ins.

Here's the screen shot of a sample Outlook Home page that shows the Get Add-ins option:
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5. On the Add-ins window, go to Admin-managed and check if the Oracle Microsoft 365 add-in is available in
Outlook.

The screenshot below shows an example Oracle Microsoft 365 add-in in the Admin-managed tab.

6. Click Add.

The add-in appears on the Home ribbon.
7. Click the add-in to open it as a side panel on Outlook.

If you can’t find the add-in yet, try the next recovery step: Verify the settings in the Microsoft admin center.

Verify the Settings in the Microsoft Admin Center
Ensure that the add-in configuration is available instead of being optional in the Microsoft 365 admin center.

1. Sign in Microsoft 365 admin center.
2. Click Integrated apps from the navigation pane.
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3. On the Integrated apps page, click Add-ins.

The screenshot below shows navigation to Add-ins from Integrated apps page of Microsoft 365 admin center.

4. Select the add-in.

The Edit add-in page appears.
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5. Change the Deployment Method to Available and click Save.

The screenshot below shows the Add-ins page edit mode, where you can set the deployment method to
available.

6. When deploying for specific users or groups, add the same user accounts to the Microsoft admin center and
the Outlook Office account.

7. Next, open Outlook.
8. On the Home ribbon, click Get Add-ins.
9. On the Add-ins window, go to Admin-Managed and check if the Oracle Microsoft 365 add-in is available in

Outlook. See the Reinstall Outlook and Add the Add-in topic for the screenshots.
10. Click Add.

The add-in appears on the Home ribbon.
11. Click the add-in to open it as a side panel on Outlook.
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Note:  If you don’t see the add-in yet, contact Oracle Support and share the screenshots of the following:

1. The Admin-managed window in Outlook.

2. The add-in configuration in the Microsoft admin center.

How can I show service requests in the add-in?  
You can show only the open critical service requests on the add-in. Here's how:

1. Navigate to Configuration > Application Composer > Productivity Applications Setup > CX Sales for
Microsoft 365.

2. On the Microsoft 365 Designer, click the menu (hamburger icon) and expand Service Requests.
3. Duplicate the standard layout.
4. Drag and drop Critical from the Available Fields.
5. Click Save so that Critical shows up on the selected layout of service request in the add-in.

Migration from Microsoft Outlook to Microsoft 365  

Overview of Migrating from Microsoft Outlook to Microsoft 365  
Oracle offers several products that let you integrate your sales application with Microsoft or Google email and calendar
applications. Before finalizing a product, review all your options and choose the product that best addresses your needs.

Use Oracle Sales Cloud for Microsoft 365 to maximize productivity by accessing your cloud service data.

What should I know when upgrading from the Outlook plug-in to
the Microsoft 365 add-in?  
Here are a few things you need to know if you're upgrading from the Oracle Sales for Outlook plugin to the Microsoft
365 add-in:

• A user can't use both the Oracle Sales for Outlook plug-in and the Microsoft 365 add-in. Any pilot user must
uninstall the older Outlook plugin first, before they use the new add-in. Our documentation covers the steps to
uninstall the older plug-in.

• An Microsoft 365 add-in user can't send meeting invites to users of the older Outlook plug-in using the "auto-
share" option enabled in the Outlook calendar. Ensure that the users disable the auto-share option on the
calendar to get meeting invites from Microsoft 365 add-in users.

902



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 36
Microsoft 365

Before You Migrate from Outlook to Microsoft 365  
Here are the prerequisites for an efficient and error-free migration from Outlook to Microsoft 365:

• Enable the Migration Enabled option using the Manage Microsoft 365 task in the Setup and Maintenance work
area.

• Save a copy of your contacts and activities.

• Run a complete synchronization on your Outlook client.
a. Uninstall Oracle Sales Cloud for Outlook add-in from all the computers.
b. On each computer, start Outlook and use send or receive to synchronize all changes with Exchange

server.
Ensure that there is no CRM data in Outlook storage.

Note:  This Oracle-Microsoft integration or plug-in may enable you to link to or transmit your content or third-
party content to, or otherwise access, or retrieve content from, Microsoft and its platforms, users, or services. Oracle
doesn't control and isn't responsible for Microsoft sites or platforms or services, the performance or availability of the
services, or any content received or sent. You bear any and all risks associated with access to and use of Microsoft
sites, platforms, and services and are solely responsible for entering into and compliance with separate terms between
you and Microsoft. Oracle isn't responsible for the security, protection, or confidentiality of such content (including
obligations in the Hosting and Delivery Policies and Data Processing Agreement and Oracle's Privacy Policy) that's
transmitted to such Microsoft sites or platforms or services. You are solely responsible for obtaining or having any
required consents or other legal basis for your use of this integration or plug-in. Oracle reserves the right to terminate
your connection or integration if your use of this integration or plug-in violates the terms of your Agreement(s) with
Oracle.

Related Topics

Migrate from Outlook to Microsoft 365  
Depending on your current configuration, perform the appropriate procedure to migrate to Microsoft 365:

Current Configuration Migration Procedure

Outlook 2016 (Office 365 Pro Plus)
 
Office 365 Exchange
 

1. Uninstall your Microsoft Outlook client.

See the Uninstalling chapter in the Deploying Sales for Outlook guide.
2. Configure and install the Oracle Sales Cloud for Microsoft 365 add-in.

See Installing Oracle Sales Cloud for Microsoft 365: Procedure
3. Run the Oracle Sales Cloud for Microsoft 365 Sync Engine to synchronize contacts, appointments,

 and tasks between your sales application and Microsoft 365.

Outlook 2013 (Exchange 2013)
 
Outlook 2016 (Office 365 Exchange)
 

1. Upgrade Exchange 2013 to Office 365 Exchange.
2. Uninstall your Outlook client.
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Current Configuration Migration Procedure

See the Uninstalling chapter in the Deploying Sales for Outlook guide.
3. Install Outlook 2016 (Office 365 Pro Plus)
4. Configure and install the Oracle CX Sales for Microsoft 365 add-in.

See Installing Oracle CX Sales for Microsoft 365: Procedure
5. Run the Oracle CX Sales for Microsoft 365 Sync Engine to synchronize contacts, appointments,

 and tasks between your sales application and Microsoft 365.

Related Topics
• Synchronize Data Between CX Sales and Microsoft 365

Microsoft 365 Configuration When Refreshing the Sales
Environment  
An environment refresh, or production-to-test refresh, is a copy of the settings, configurations, and data from a
production environment to a test environment. A test-to-test environment refresh is a copy from a non-production
environment to another non-production environment.

The policies are documented in the My Oracle Support article with the Doc ID 1632261.1.

Some settings and configurations are retained in an environment after a production-to-test refresh. Here are the
settings specific to the sales Microsoft 365 setup:

• Manage Microsoft 365 setup task: The Manage Microsoft 365 task defines the primary configuration settings
for the Microsoft 365 integration. All the settings you configure using this task are retained over a production-
to-test refresh; however, these three settings are overwritten with the settings in production:

◦ The Enable Sync setting for Contacts.

◦ The Enable Sync setting for Appointments.

◦ The Enable Sync setting for Tasks: These settings are maintained through profile options and the
expectation is to have the same setting in test and production. If they're different, you must enable them
after the production-to-test refresh is completed.

• Users and sync details: The user and sync transactional data in the test environment are deleted with a
production-to-test refresh. So, after a production-to-test refresh, the Microsoft 365 monitor doesn't show any
historical data for users or their synchronizations. As users start using a test pod again, the user and sync table
entries are populated and shown on the Microsoft 365 Monitor page.

Note:
• Before dong a production-to-test refresh, the sales administrator must stop the Microsoft 365 syncs in the test

environment and have all the test users remove the 'Shared With Oracle' category from all the records in their
Microsoft account (users can do this from their Outlook). If this isn't done, any records that are down-synced
earlier to the user's Microsoft account may get recreated in the sales application, creating duplicates.

• Because user data is cleared after a production-to-test refresh, an initial sync is run on all the users to get the
data from the sales application to Outlook.
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Move Users from Test to the Production Environment of the
Microsoft 365 Add-In  
Say you have used an account for the test environment and now want to move it to production. Use a user account
exclusively for a single environment.

You must remove all the instances of the user account from the test environment first and then add it to production.

At a broader level, here are the steps to remove the user account from the test environment:

1. Disable synchronization and delete the user from Microsoft 365 Monitor.
2. Remove the user from Microsoft Azure.
3. Remove the Shared to Oracle category from all the records shared from Microsoft 365 Outlook.

Remove the User from the Test Environment
1. Disable synchronization and delete the user from Microsoft 365 Monitor:

a. In the Setup and Maintenance work area, use the Manage Microsoft 365 page::

- Offering: Sales
- Functional Area: Integrations
- Task: Manage Microsoft 365

b. On the Manage Microsoft 365 task page, click Microsoft 365 Monitor.
c. On the Microsoft 365 Monitor page, select the user you want to delete.
d. Click Actions and select Disable Sync to stop the data synchronization for the user.
e. Next, click Actions and select Delete the User.

2. Remove the user from Microsoft Azure:

a. Sign in to Microsoft Azure and select Users on the left navigation pane.
b. Select the user and click Delete user.

3. Remove the Shared with Oracle category from all the shared records of Microsoft 365 Outlook:

a. Open the Microsoft 365 Outlook desktop client or online Outlook.
b. Select an email shared with the sales application (callout 1).
c. Under Tags (callout 2), expand Categorize (callout 3), and click Shared with Oracle (callout 4). The tag is

removed from the email.

d. Repeat steps 3b and 3c for all the shared emails and appointments.
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Add the User to the Production Environment
Add the user to the application you created in Microsoft Azure for the production environment. When a user signs in to
the add-in, the default saved search is used to synchronize the data. In the next synchronization, the latest data from
the production environment of the sales application is synchronized to the user's Outlook application.

FAQs for Migration  

FAQs for Migration from Outlook to Microsoft 365  
This section contains the most frequently asked questions (FAQs) when migrating from Microsoft Outlook to Microsoft
365. Scroll or search to find answers to common questions.

Do we need the Manage Outlook Client Deployment packages for Microsoft 365 as
well?  
No. The Manage Outlook Client Deployment packages are specific to older versions of the Outlook plug-in. Microsoft
365 doesn't use them.

How can I prevent duplicate contacts and activities from being created in the new
client?  
The Oracle Sales for Microsoft 365 add-in checks for duplicate contacts, appointments, and tasks before they're shared
with the server. There's no de-duplication process at the Microsoft 365 client.

All synchronized data from your sales application are created in the client as new records during the first
synchronization process. Subsequent synchronization processes maintain the server-client links. For synchronizing with
your sales application from the client, there are duplication checks for contacts, based on the first name, last name, and
email address. There's no duplication check logic for appointments and tasks.

What happens if I haven't backed up my contacts and activities?  
If you haven't backed up your contacts and activities, and an unexpected issue occurs, you may lose your data. You
must back up your data before the migration process starts.

How can I resolve conflicts?  
Use the Conflict Resolution page in the client, to manage the conflicts.

What happens if migration completes before I uninstall my client?  
If Exchange server has been migrated, but the Oracle CX Sales for Outlook add-in wasn't uninstalled, then the following
issues can occur:

Case #1
I have uninstalled and re-installed the client after the Exchange migration to make it working with a new email profile.
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After re-installing the add-in and starting Outlook, the application detects old configuration with "Data structure
collision" message and prompts to remove it. At this point, these are the possible results:

• Old data is successfully removed and new data structure is applied. No issues occur.

• Failed to remove previous data. Reinstall the add-in. If reinstalling doesn't solve the issue, then you must clean
the Outlook storage using the MFCMAPI tool. (Log a new Service Request).

Case #2
After re-installing the Oracle CX Sales for Microsoft 365 add-in and starting Outlook, the application shows "no data
structure collision" message, but old data and custom folders still exist in Outlook storage. New data structure was along
with existing data structure.

If you proceed with First Run Assistant, this may lead to numerous duplicates and collisions during first synchronization.
To prevent this, you must cancel First Run Assistant and proceed with manual storage cleanup using the MFCMAPI tool.
(Log a new Service Request).

Case #3
The following error occurs repeatedly: To correctly apply the Oracle CX Sales for Outlook update, Outlook must be
restarted. Save your changes, close Outlook, and then start it again.

Related Topics

What happens to the pre-migrated configurations?  
Microsoft 365 doesn't use any previous configurations from Classic Outlook. You must re-configure Microsoft 365 for
your business needs.

What happens to my offline sales application data?  
All the offline sales application data created by the Classic Outlook are deleted by the uninstallation process. There's no
offline data for the new Microsoft 365 client.

How can I categorize a contact in the Outlook Web Application?  
In the Outlook Web Application, you can't categorize a contact.

To synchronize any contact from Microsoft 365 to your sales application, you must tag the contact with the Oracle CX
Sales category. Then synchronize the contact using the Microsoft Outlook Desktop Client.

How can I set up custom filters for the add-in?  
You can use the Saved Search option in Application Composer to set the custom filters. For example, here's how you
create a custom filter to show contacts from the account team or territory of a user:

1. Enter a sandbox and go to Navigator > Configuration > Application Composer > Productivity Application
Setup > CX Sales for Microsoft 365.

2. Click the menu (hamburger icon).
3. Expand Contacts.
4. Expand Saved Search.
5. Duplicate a standard saved search and enter a name.
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6. Change the value of Record Set to Records in accounts where I am on the account team or territory.
7. Save your changes.
8. Sign in again for the changes to take effect.

Should I publish the sandbox to test the changes I made to the add-in settings in
Application Composer?  
You don't have to publish the sandbox before testing. Sign out explicitly from the Microsoft 365 add-in and the sales
application. Sign in again to the sales application and open the add-in in your Outlook. Verify your changes.

Note:  You can also verify in the Outlook Web Access mode. Use the same credentials that you used to sign in the
sales application and the add-in.

Microsoft Teams  

About Microsoft Teams  
Use Microsoft Teams to further advance your sales pipeline by allowing salespeople to collaborate on their
opportunities.

Directly from the Opportunities UI, salespeople can simply click the action to add all existing members of the
opportunity to a team in Microsoft Teams and start the collaboration.

Users of Microsoft Teams can interact with opportunity team members from Sales, as well as add required external
resources with expertise to help win the deal. As an administrator, you manage the Oracle Microsoft Teams integration
for your users. See the Set Up Microsoft Teams for Sales topic for steps.

Prerequisites for Microsoft Teams Setup  
To enable a Sales user to collaborate with a user's account in Microsoft Teams, you must ensure that the user's resource
email address (that's the email address in the resource record for the user) in CX Sales matches the user's email address
in Microsoft Teams.

In addition, the opportunity owner must be a Microsoft Teams user and be the owner of the team in Microsoft Teams.

You must set the value of the Territory Based Resource Assignment Style profile option
(MOO_OPTY_RESOURCE_TBA_STYLE) to specify if all members of the territory should be added to an opportunity
team or just the owner. The default is to add all members to the opportunity team.

Related Topics
• How can I collaborate on Opportunities using Microsoft Teams?
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Set Up Microsoft Teams for Sales  
As an administrator, you manage the Oracle Microsoft Teams integration for your users.

Here's how to complete the setup:

1. Create the add-in in Microsoft Azure Active Directory (AD):
a. Create the application for the Microsoft Teams add-in.
b. Configure the application.

2. Set up in Oracle Sales:
a. Enter the application ID, application key and tenant ID for Microsoft Teams on the Manage Microsoft 365

task page.
b. Use Application Composer to add the Create Team in Microsoft Teams and Go to Microsoft Teams

action items to the Edit Opportunity page.

Create the Microsoft Teams Add-In
To create the Microsoft Teams add-in, get your host URL and follow these steps:

1. Sign in to the Microsoft Azure portal at https://portal.office.com.
2. Click Admin on the home page.

The Admin center page appears.
3. Click Azure Active Directory in the Admin centers list.

The Azure Active Directory Admin Center page appears.

Note:  If you're a first-time user, then you must sign up for your Microsoft Azure Active Directory.

4. Select All service and then Azure Active Directory.
The details page corresponding to the active directory appears.

5. Click App registrations.
The Applications list page appears.

a. Click + New registration.
The Register an application dialog box appears.

b. For Name, enter a name for the application, for example, Microsoft Teams Collaboration.
c. Under Supported account types, select Accounts in this organizational directory only (Oracle only -

single tenant.
d. Leave Redirect URI (optional) blank.
e. Click Register to create the Microsoft Teams add-in application.

The application appears on the App registrations page.
6. The Application details page displays the Application (client) ID and Directory (tenant) ID.

Note:  Keep a note of these values because you insert these in the Manage Microsoft 365 task page later on.
See Register Microsoft Teams for Sales for more information.
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7. Next click Authentication and from the Authentication page, click Add a platform and select Web as shown in
this screenshot:

8. Under the Enter Redirect URIs section, enter the Uniform Resource Identifier, for example, http://
localhost:3000/auth/callback).

9. In the Implicit grant section, select Access tokens and ID tokens.
10. Click Configure.
11. Next click Certificates & secrets, and from the Add a client secret section, click + New client secret.

Select a duration for the expiration of the Client Secret. For example, if you select 12 months, the Client Secret
becomes invalid after 12 months, and the automatic refresh stops. The sync process will start only after you
sign in to the client again.

If you select Custom, enter the start and end dates, which must be within 24 months. After the end date, you
must sign in to the client again, to start the sync.

12. Click Save.

The application generates a value for the key. Keep a note of this value because you will use this as the
Application Key in the Manage Microsoft 365 task page later on.

13. Click API permissions and click Add a permission. The Request API permissions pane appears.
14. Scroll to the bottom of the pane and click Microsoft Graph Commonly used Microsoft APIs.
15. Click Application permissions and select the following permissions:

◦ Directory.Read.All

◦ Directory.ReadWrite.All

◦ Group.Read.All

◦ Group.ReadWrite.All

16. Click Add permissions.
17. Click Grant admin consent for Oracle and then click Yes on the confirmation dialog box.

Related Topics
• Enable Microsoft 365 Integration
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Register Microsoft Teams for Sales  
Use the Manage Microsoft 365 task to register the Microsoft Teams in the Microsoft Azure Directory:

1. Enter the Application ID, the Application Key, and the Tenant ID. See Set Up Microsoft Teams for Sales for
information about how to generate these details.
Let's say you enter the name as Oracle Microsoft Teams Collaboration. When you sign in to your Microsoft 365
account, you can see Oracle Microsoft Teams Collaboration as an add-in that you can select.

2. The first time you set up the integration, a usage agreement notice displays for your information:
Usage Agreement: This Oracle-Microsoft integration or plug-in may enable you to link to or transmit your
content or third-party content to, or otherwise access, or retrieve content from, Microsoft and its platforms,
users, or services. Oracle doesn't control and isn't responsible for Microsoft sites or platforms or services, the
performance or availability of the services, or any content received or sent. You bear any and all risks associated
with access to and use of Microsoft sites, platforms, and services and are solely responsible for entering into
and compliance with separate terms between you and Microsoft. Oracle isn't responsible for the security,
protection or confidentiality of such content (including obligations in the Hosting and Delivery Policies and
Data Processing Agreement and Oracle's Privacy Policy) that's transmitted to such Microsoft sites or platforms
or services. You're solely responsible for obtaining or having any required consents or other legal basis for your
use of this integration or plug-in. Oracle reserves the rights to terminate your connection or integration if your
use of this integration or plug-in violates the terms of your Agreement(s) with Oracle.

Add Actions for Microsoft Teams to Opportunity and Business
Plan Actions Menus  
On the opportunities and business plans Actions menus, enable actions for Microsoft Teams. This lets your salespeople
create collaborative teams with users of Microsoft Teams while working on an opportunity or a business plan.

Add these two actions to the Opportunity and Business Plan details layouts using Application Composer:

• Create Team in Microsoft Teams: This action helps salespeople create a team for the opportunity or business
plan right from that object's details page. After the team is formed, the button automatically changes to Go to
Microsoft Teams.

• Go to Microsoft Teams: This action lets salespeople navigate to the team created in Microsoft Teams.

Here's how you add the actions:

1. In an active sandbox, use the navigator to go to Configuration > Application Composer > Objects > Standard
Objects.

2. To add the actions to the Opportunity Details layout, expand Opportunity and click Pages.
3. In the Application Pages tab of the Details Page Layouts region, duplicate the standard layout by selecting the

standard layout and clicking the Duplicate icon.
4. Type a new layout name and click Save and Edit.

The custom layout page appears.
5. On the custom layout, click the pencil icon next to Actions.
6. From the Available Actions list box, move these two actions to the Selected Actions list box:

◦ Create Teams in Microsoft Teams

911



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 36
Microsoft 365

◦ Go to Microsoft Teams

7. Click Done.
8. To enable these actions for business plans, add the actions to the Business Plan details layout. On the left

navigation pane, expand Business Plan and click Pages. Repeat steps from 3 to 7.
9. Publish the sandbox.

The Microsoft Teams actions appear on the details pages for opportunities and business plans.

Related Topics
• How can I collaborate on Opportunities using Microsoft Teams?

Archive Teams Associated with Closed Opportunities  
When an opportunity closes in Sales, the team associated with the opportunity may not need to collaborate any longer.
You can set up the sales application to automatically archive such teams you created in Microsoft Teams.

Only teams associated with closed opportunities are auto-archived. An opportunity is considered closed when the
opportunity status belongs to one of these status categories:

• Lost

• No Sale

• Won

Moreover, when an opportunity is reopened in Sales, the associated team in Microsoft Teams is automatically restored.
An opportunity is considered open when the opportunity status is set to a category that means Open.

To learn more about the opportunity statuses, see the Set Up Sales Statuses topic.

Auto-Archive Teams  
To enable auto-archiving, do these two setups:

1. Activate Common CRM Signals.
2. Enable the archive option for Microsoft Teams.

Activate Common CRM Signals

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option name, Common CRM Signals
Active (ORA_ZCA_ENABLE_SIGNALS).

3. Set the Site value to Yes.
4. Click Save and Close.

Enable the Archive Option for Microsoft Teams

1. In the Setup and Maintenance work area, go to:
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◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. On the Manage Microsoft 365 page, go to the Microsoft Teams tab.
3. Select the Archive Opportunity Team in Microsoft Teams Enabled check box.
4. Click Save and Close.

If you haven’t set up Microsoft Teams already, go through the steps provided in the topic, Set Up Microsoft Teams
for Sales and complete the setup. After that, enable the archive option so that when an opportunity closes, the
corresponding Microsoft team gets archived automatically.

913

https://docs.oracle.com/en/cloud/saas/sales/21d/oasal/microsoft-365.html#OASAL3945185
https://docs.oracle.com/en/cloud/saas/sales/21d/oasal/microsoft-365.html#OASAL3945185


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 36
Microsoft 365

914



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 37
Intelligent Advisor

37  Intelligent Advisor

Overview of Oracle Intelligent Advisor  
Oracle Intelligent Advisor helps service agents deliver enriched, personalized, and precise customer service.

Intelligent Advisor can be connected to Oracle Sales and Oracle Fusion Service for use by agents. Intelligent Advisor
interviews can be used for:

• Service requests across a range of industries

• Knowledge streaming by helping agents and contacts identify the most appropriate knowledge article or advice
for their needs

• Any multi-page information gathering in Oracle Visual Builder

• Personalized self-service advice with Sales and Service

Using Intelligent Advisor within the Fusion Sales and interface:

• Agents must be logged in to use Intelligent Advisor interviews

• Specific Sales and Service objects can be created and updated

There's desktop modeling software for building interviews called Oracle Policy Modeling. The Intelligent Advisor Hub
connects Policy Modeling to Sales and Service.

This image shows how Policy Modeling, Intelligent Advisor Hub, and Sales and Service work together:

The steps to integrate Sales and Service with Intelligent Advisor are:

1. Create an Intelligent Advisor Hub.
2. Create a Sales and Service connection in Intelligent Advisor Hub.
3. Download and install Policy Modeling.
4. Create a project in Policy Modeling.
5. Connect the Policy Modeling project to Intelligent Advisor Hub.
6. Map data to and from Sales or Service in Policy Modeling.
7. Deploy and activate the Intelligent Advisor interview.
8. Embed the interview in a Sales and Service agent interface.
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Setup Tasks  

Create an Intelligent Advisor Hub  
The first step to integrate Sales and Service with Intelligent Advisor is for an install administrator to create an Intelligent
Advisor Hub.

The install administrator will provide the Intelligent Advisor Hub URL. The URL for Intelligent Advisor Hub is in this
general format: https://[server and port]/[deploy-name]/opa-hub/.

Related Topics
• Create and Manage Sites

Create a Connection in Intelligent Advisor  
The next step is to create the Sales and Service web service connection in the Intelligent Advisor Hub that your team
can use for new or existing interviews. This connection enables the two applications to work together and share
information.

The installation administrator should have set up access for the Sales Administrator or for a similar role that administers
Intelligent Advisor for your organization. Once you sign in, you create a connection to your Sales and Service web
services, to get access to data for creating or editing interviews.

Related Topics
• Create a connection to Fusion Sales and Fusion Service

Download and Install Policy Modeling  
Once the connection to the web service is established, the next step is to download and install Policy Modeling.

Policy Modeling is the desktop tool modelers use to create and edit interviews, and to map data from Sales and Service
to Intelligent Advisor.

Policy Modeling can be downloaded from Intelligent Advisor Hub.

Related Topics
• Install Policy Modeling
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Create a Project in Policy Modeling  
After installing Policy Modeling, you need to create a project.

A Policy Modeling project is where modelers write rules and design interviews. Alternatively, to test out an integration,
you could use one of the sample projects that comes installed with Policy Modeling.

Related Topics
• Walkthrough of Policy Modeling

• Projects

• Example Policy Models

• Design Interviews

Connect the Policy Modeling Project to Intelligent Advisor Hub  
The next step is to connect the Policy Modeling project to Intelligent Advisor Hub, which provides access to the Sales
and Service data model.

In other words, Intelligent Advisor receives data model information from the Intelligent Advisor Hub which in turn
receives the data model information from Sales and Service. This enables Intelligent Advisor to load and save data to
Sales and Service.

To connect your Policy Modeling project to Sales and Service via Intelligent Advisor Hub:

1. In Intelligent Advisor, connect the project to Intelligent Advisor Hub.
2. Choose the Sales and Service connection you created previously.

Related Topics
• Specify the Intelligent Advisor Hub for a project

• Choose a connector framework web service connection for a project

Map Data to and from Sales and Service to Policy Modeling  
Modelers can then map the data in the policy model Intelligent Advisor project to the appropriate tablesobjects and
fields in Sales and Service.

Data mapping lets you load data into an Intelligent Advisor interview from Sales and Service, and to save outcomes,
including creating new records, from the interview back to Sales and Service.

The input mappings are used to load values, and the output mappings are used for updating and saving values.

Related Topics
• Deploy a Project

• Activate a Project
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Deploy and Activate the Intelligence Advisor Interview  
After you have created your Intelligent Advisor interview, you need to deploy and activate the project for use by Sales
and Service.

Take note of the URL of your deployed interview, as you need this to link to the interview from Sales and Service.

Related Topics
• Deploy a Project

• Activate a Project

Embed the Interview in a Sales and Service Agent Interface  
The final step to get your interview up and running is to add the interview to the agent interface.

Once the project has been deployed and the interview activated, you need to link to the Intelligent Advisor interview
from within Sales and Service (from a subtab, button, action menu item, or knowledge article).

Related Topics
• Launch an Interview from CX Sales and Fusion Service

Enable the Saving of Checkpoints and Transcripts  
A new Interview object has been added to Sales and Service that automatically saves checkpoint and transcript data.

Transcripts help you maintain historical record of completed sales interviews. Interview transcripts capture a complete,
auditable record of all questions, answers and screen text displayed in an interview. They are a useful way to provide a
summary of the interview as it occurred, keep a documented record for legal audit requirements, or provide a file that
can be scraped for analytics at a later point.

Transcript data is automatically saved in the new Interview object in the InterviewData field.

Checkpoints are points in an interview where it can be saved, resumed and reviewed from. A checkpoint works by
saving the progress of the interview, enabling interview users to easily resume an interview that they or someone else
left partially completed. Checkpoints also allow completed interviews to be reviewed at any time.

The Intelligent Advisor Interview Object for Checkpoint Enabled
(ORA_ZUP_IA_CONNECTOR_ENABLE_CHECKPOINT_INTERVIEW_OBJECT) profile option controls how the checkpoint
data gets stored.

• If this profile option is enabled, the checkpoint data is stored in the predefined interview object.

• If this profile option is disabled, the checkpoint data is stored in the OPACheckpoints_c custom object. For more
information, see Create a custom object for checkpoint data in Sales and Service.

By default, this profile option is disabled.
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To view or update the profile value of this profile option:

1. Sign in to Sales or Service as an admininstrator and navigate to Setup and Maintenance.
2. Click Navigator > My Enterprise > Setup and Maintenance work area.
3. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
4. Search for the Profile Option, using either:

◦ Profile Display Name as Intelligent Advisor Interview Object for Checkpoint Enabled

◦ Profile Option Code as ORA_ZUP_IA_CONNECTOR_ENABLE_CHECKPOINT_INTERVIEW_OBJECT.

5. In the Profile Values section in search result, set the profile value to Yes.
6. Click Save and Close.
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38  Slack

Benefits of Integrating CX Sales with Slack  
Slack is a team communication tool that facilitates synchronous communication across different devices.

You can set up the integration of your sales application with Slack, and this helps your company in the following ways:

• A salesperson can view his top five opportunities on Slack by using any device, without having to sign in to
your sales application. Only the opportunities that have a close date in the current quarter are considered. He
can also take the following actions for each listed opportunity from Slack: log a call, create a task, or schedule a
meeting.

• A salesperson can also view the first five leads owned by him in the last three months on Slack. He can also
view his first five accounts.

• Notifications can be triggered to Slack users and channels when certain events occur on an object. For example,
when an opportunity is closed.

For more information about setting up the integration of Slack with your sales application, see the Oracle CX Service
Implementing Fusion Service guide.

Related Topics
• Use the Slack Channel for Collaboration

• How You Set Up a Slack Channel for Your Fusion Application: Method 2

• Define a Groovy Trigger to Send Notifications to Slack
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39  Analytics and Reports

Analytics on the Go  
Oracle Sales Analytics helps organizations compete more effectively in the marketplace by providing real-time,
actionable insight into every sales opportunity at the point of customer contact.

Your sales team can view up to the moment, or historical data in the office, or on the road, on laptop, tablet, or mobile.
What are my best opportunities? Where is this deal at in the pipeline? When was the last time I called this company? You
get the insights you need right now, right at your fingertips.

Sales teams access analytics right from the home page of a mobile device. Analytics also are embedded contextually
for work areas like accounts, contacts, opportunities, activities, leads and so on. The analytics on work areas give users
detail on the records they are viewing or updating right on the spot.

Additional Analytics Resources
For more information on how to use analytics, see the Creating and Administering Analytics guide.

Analytics for Your Sales Teams  
There are many ways to provide analytics for your team. Here are the work areas you can use for analytics.
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Work Area Name Description

Oracle Business Intelligence (BI)
 

You view, edit, and create analytics in BI. You also can view, edit, and create subject areas here.
 

Sales Infolet Page
 

This page comes prebuilt with infolets specific your user roles. You can do just about anything to
change the way this page looks and which analytics show. To get to this page click the white navigation
dot on the home page.
 

Sales Pages
 

You enable these pages for your users. These five blank pages are available for you to add analytics
related to any area.
 

Object Pages
 

On these pages sales users work with opportunities, accounts, contacts, activities and so on.
Administrators enable the tabs on these pages and add analyses to the tabs on the side or bottom of
the page.
 

Analytics Page
 

This page is where sales users search for analytics they have permissions to view and can \make them
favorites. Sales users also see analytics that administrators create specific to their role.
 

This is an example of an Infolet page. 
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This is the Analytics page. It's a page where users add and view analytics.

This is the Opportunities work area. Users can click the analytic icon and view
analytics specific to a record. Administrators add analytics to this object page. 
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Overview of Infolets  
An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you
work on. You might also find something in an infolet that you need to follow up on.

You can use infolets arranged in tabs in the Analytics section of your home page. If you're using a panel or banner
layout, use the page control icons to use the infolets.

Here are a few things to know about infolets.

• Infolets have a front view, and might have a back and expanded view. Use the Back View, Front View, and
Expanded View icons at the bottom corners of an infolet to open these views.

• Your current infolet view persists as the default view the next time you sign in. For example, if you viewed a
back view of the infolet in your last session, you will see the same infolet view by default in your next session.

• Some infolets might also contain links to detailed reports. You can click anywhere in the infolet area to drill
down to the detailed report.

• You can also personalize the infolets. For example, you can move or hide them on the infolets page.

• If you don't see infolet pages on your home page, then your administrators must have disabled them to show
on the home page.

Note:  Some SCM or Procurement Cloud infolets might function differently from other infolets.

Here's how an infolet page looks.

Configure Visualizations for CX Sales Mobile  
The Visualization Configuration tool allows an administrator to build configurations using the analytics stored in the BI
catalog. These configurations can then be viewed in your sales team mobile applications.
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Access the Visualization Configuration Tool
An administrator should have either of the following roles assigned to access the visualization configuration tool.

• ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB (Customer
Relationship Management Administrator)

• ORA_ZBS_SALES_ADMINISTRATOR_JOB (Sales Administrator)

How to Navigate to the Visualization Configuration Tool
1. From Navigator choose Configuration.
2. Choose Application Composer.
3. Choose Visualization Configuration. If you don't see a visualization configuration option, verify your role has

permissions to configure visualizations.

View a Visualization Configuration
On the visualization configuration page, you see a list of all the configurations, including predefined configurations. If
you click on the visualization reference number you can see details.

Note:  Visualizations for predefined configurations might show a warning message that the source doesn't return
data, if an administrator doesn't have transactional data that they own logged in their account. This could also be
validated in the source analysis results.

Create a Visualization Configuration
Note:  If you want to create a configuration using a predefined or seeded BI Analysis, you should select the Catalog
folder as Sales and then search for the source analysis.

1. Click Add to create a new configuration. The Create Configuration page displays the source type and source.
2. To create a configuration based upon BI Analysis, select OTBI Analysis as Source Type.
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3. Select a folder by clicking on the Select Catalog folder icon where you have saved the OTBI Analysis. By default,
the Custom folder is selected.

4. In the Source field, enter your search criteria. You're searching the BI catalog for an existing analysis under the
selected catalog folder in BI.

5. Select a source analysis from the search results to create your visualization. All the fields get auto-selected and
visualization shows on the right side upon selection. If the selected source analysis has more columns than
required to create the visualization, there could be a warning message on the Create Configuration page as the
visualization may not show correct data. To resolve the issue, remove the columns from the analysis that are
not used for creating the visualization and reload the configuration.

Administrators can further change the configuration settings as needed. Change the status from Draft to Active
to use the configuration in the mobile dashboard.

928



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 39
Analytics and Reports

6. Click Create to save the configuration.

7. Once your visualization is created, you can add it to a page layout in your CX Sales mobile applications.

For details on configuring page layouts see, Configure the Report Page Layouts.

Import and Export Visualization Configurations
Follow the below links to Import and Export Visualization Configuration .

Object: Visualization Configuration
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Sample Script:

• To export specific configuration: ReportConfigNumber = 'CDRM_1002'

• To export all the configurations: ReportConfigNumber IS NOT NULL

Export Data: https://docs.oracle.com/en/cloud/saas/sales/22a/faiem/export-data.html#s20067824
Import Data: https://docs.oracle.com/en/cloud/saas/sales/22a/faiem/import-data.html#s20058837

Round-Trip Export-Import: https://docs.oracle.com/en/cloud/saas/sales/22a/faiem/round-trip-
feature.html#s20070990

Related Topics
• Configure the Report Page Layouts
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40  Application Change Auditing

Overview of Auditing in Oracle Applications  

Audit Policies  
Auditing is used to monitor user activity and all configuration, security, and data changes that have been made to an
application. Auditing involves recording and retrieving information pertaining to the creation, modification, and removal
of business objects.

All actions performed on the business objects and the modified values are also recorded. The audit information is
stored without any intervention of the user or any explicit user action.

Use audit policies to select specific business objects and attributes to be audited. The decision to create policies usually
depends on the type of information to be audited and to the level of detail required for reporting.

Enabling Audit Functionality
For Oracle Applications Cloud, you must configure the business objects and select the attributes before enabling audit.
If you enable audit without configuring the business objects, auditing remains inactive. By default, auditing is disabled
for all applications. To enable and manage audit, ensure that you have a role with the assigned privilege Manage Audit
Policies (FND_MANAGE_AUDIT_POLICIES_PRIV). For appropriate assignment of roles and privileges, check with your
security administrator.

To enable auditing for Oracle Fusion Middleware products, select one of the levels at which auditing is required for that
product. The audit levels are predefined and contain the metadata and events to be audited. For more information, see
Audit Events for Oracle Applications Cloud Middleware (Doc ID 2114143.1) on My Oracle Support.

If you don't want an application to be audited, you can stop the audit process by setting the Audit Level option to None.
Also, note that there's no specified retention period for the audited data or the logs. Follow your company policy for
retaining or removing such data.

Note:  You won't be able to enable audit if you're working in a sandbox. If you try to set up audit while you're in
a sandbox, you will see the message "Audit setup is disabled in a sandbox". You'll also notice that the buttons
associated with the audit functionality are disabled.

Related Topics
• Audit Configuration for Business Object Attributes

• Overview of Audit Configuration

Overview of Audit Configuration  
To set up auditing for Oracle Applications Cloud, select the Manage Audit Policies task from the Setup and Maintenance
work area within your offering.
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To set up auditing for Oracle Fusion Middleware products, select the level of auditing mapped to a predefined set of
metadata and the events that have to be audited. Information about configuring audit for Oracle Fusion Middleware
products is provided in Oracle Fusion Middleware guides.

You can also create a configuration file and deploy it to audit a specific Oracle Fusion Middleware product. The
configuration details for Oracle Fusion Middleware products are available as audit-specific assets that you can use to
create the config.xml configuration file. To get a list of audit-specific assets, see Audit Events for Oracle Applications
Cloud Middleware (Doc ID 2114143.1) on My Oracle Support.

Oracle Fusion Middleware Products
• Configure business objects to enable auditing in Oracle Fusion Middleware products. Refer to Oracle

Applications Cloud Common Features Reference.

See: Auditing Web Services

Oracle Fusion Security Products
• Configure business objects to enable auditing in Oracle Fusion security products. Refer to Oracle Applications

Cloud Common Features Reference.

See: Introduction to Oracle Fusion Middleware Audit Framework

See: Managing Audit

Audit Reports  
You can use the Audit Reports work area to view changes to the application data, such as the business objects that were
created, updated, and deleted.

To view the history or to create a report, you must have a role with the View Audit History
(FND_VIEW_AUDIT_HISTORY_PRIV) privilege assigned to it. For appropriate assignment of roles and privileges, check
with your security administrator.

Audit Events
Transactional events in the application trigger the audit process based on the create, update, and delete operations. For
events to trigger the audit process for the business objects, you must first enable the objects for auditing.

These are the events that trigger the audit process.

Transactional Event When the Audit Activity is Triggered Audit Report Content

Create Whenever business object data is created and
stored in the database

• Name of the created object

• Name of the user who created the object

• Time of creation

Update Whenever the existing business object data is
updated

• Both old and updated values of the object

• Name of the user who updated the object
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Transactional Event When the Audit Activity is Triggered Audit Report Content

• Time of updating

Delete Whenever the existing business object data is
removed from the database

• The last value that the object attributes
contained

• Name of the user who deleted the object

The event details are stored in the audit table. The attributes of the audited object data can be used in lookups
and foreign keys to display values in the audit history. The application supports displaying the audited information
according to the language settings configured.

For Oracle Fusion Middleware products, events such as failed sign-in attempts are used as triggers. In absence of an
audit table, the information is stored in the sandbox and presented only in English.

Note:  This topic focuses on the create, update, and delete event types available in Fusion Applications. For details on
events used in the Oracle Fusion Middleware products, refer to the Oracle Fusion Middleware documentation. See:
Introduction to Oracle Fusion Middleware Audit Framework

Related Topics
• View Audit Reports

Audit Configuration for Business Object Attributes  
Audit enables tracking the change history of particular attributes of a business object. However, those objects and their
attributes must be selected for audit and auditing must be enabled for that application.

The configuration settings determine which attributes to audit for a given object, and when the audit starts and ends.
Auditing takes into account all the operations performed on an object and its attributes, such as create, update, and
delete. To configure audit business object attributes, use the Manage Audit Policies task in the Setup and Maintenance
work area.

Selecting an Application
To set up auditing, you must select a web application that contains the required business objects that can be audited.
From the list of business objects, select those business objects that you want to audit. Selecting a business object also
displays its attributes that are enabled for auditing.

Selecting Attributes
For each selected business object to be audited, select the corresponding attributes to include in the audit. All attributes
that belong to that object are by default selected for audit and appear on the user interface. However, you can add or
remove attributes from the list. When you remove an attribute from the list, you stop auditing it even when the parent
object is selected for audit. So, if you want an attribute to be audited, you must add it to the list. If the object selected in
an audit hierarchy is also a part of several other audit hierarchies, the attribute configuration for that object is applicable
to all the hierarchies in that application.
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For business objects based on flexfields, select the Flexfields (Additional Attributes) check box to view, add, or remove
flexfield attributes. The selected objects are audited.

Note:  You can't audit LOB (BLOB, CLOB, and NCLOB), rich text, and long text attributes.

Starting and Stopping Audit
The business object is ready for audit after you select its attributes and save the configuration changes. However, to
start auditing, the audit level for Oracle Applications Cloud must be set to Auditing on the Manage Audit Policies page.

To stop auditing an object, you can deselect the entire object and save the configuration. As a result, all its selected
attributes are automatically deselected and aren't audited. To continue to audit the business object with select
attributes, deselect those attributes that aren't to be audited. When users view the audit history for an application, they
can specify the period for which they want the results. Therefore, make a note of when you start and stop auditing an
application.

For example, users intend to view the audit history of an object for the previous week, but auditing for that object was
stopped last month. They wouldn't get any audit results for that week, because during the entire month that object
wasn't audited. Even if you enable audit for that object today, users can't get the wanted results because audit data until
today isn't available.

Note:  When users export the report summary to a Microsoft Excel file, there's a limit on the number of rows that are
displayed in the file.

• For Oracle Fusion Application Business Objects, the maximum limit is 10000 per table. This is set as the
default value. You can decrease it using the FND_AUDIT_EXPORT_ENTITY_LIMIT profile option. Sometimes,
the actual rows returned might be more than the limit set, because a single transaction can update multiple
tables.

• For Oracle Fusion Middleware products, the maximum limit is 25000. By default, the limit is set as 10000. You
can change this limit using the FND_AUDIT_FMW_EVENT_LIMIT profile option.

Sales Applications Auditing  

Use Auditing to Monitor Sales Application Changes  
You use auditing to monitor user activity and all configuration, security, and data changes that have been made to your
applications. You enable specific business objects so that you can audit, record, and retrieve information about when the
objects were created, modified, and removed.

As an administrator, you access the audit history pages from the Navigator > Tools menu.

Note:  Administrators must have the Manage Sales Audit Policies (FND_VIEW_SALES_AUDIT_HISTORY_PRIV)
privilege to view audit reports.

Here are the sales business objects you can audit:
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Area Parent Objects Child Objects

Account and Contact Management
 

Account (Account Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Address

◦ Address Purpose

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Account Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

◦ Customer Contact Profile

Account and Contact Management
 

Contact (Person Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Contact Address

◦ Address Purpose

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Contact Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

◦ Customer Contact Profile
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Area Parent Objects Child Objects

Account and Contact Management
 

Household (Household Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Address

◦ Address Purpose

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Household Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

Account and Contact Management
 

Resource (Resource Profile)
 

• Address

◦ Address Purpose

◦ Location SDO

• Phone

• Email

• Instant Messaging

• Web Page

• Resource Organization Membership

• Resource Role Assignment

• Sales Representative Setup

Common Components
 

Activity
 

• Contacts

• Resources

Contracts
 

Contract header
 

• Buy Contract Line

• Project Contract Line

• Sales Contract Line

• Service Contract Line

Opportunities
 

Opportunity
 

• Opportunity Revenue

• Opportunity Split Revenue
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Area Parent Objects Child Objects

• Opportunity Recurring Revenue

• Opportunity Revenue Line Set

• Opportunity Team Member

• Opportunity Partner

Opportunity Revenue
 

Opportunity
 

• Forecast

• Worst Case

• Estimated Price

• Product

• Quantity

• Discount

• Amount

• Line Currency

• Revenue Type

• TypeCodeSetId

• Best Case

• Win Probability

• UOM

• Product Group

• Frequency

• End By

• End After

• Recurring Quantity

• Recurring Estimated

• Recurring Revenue

• Start Date

• Status

• StatusCodeSetId

• Close Date

• Win/Loss Reason

• CloseReasonClodeSetId

• Competitor

• Include in Forecast

• Recurring Worst Case

• Recurring Best Case

• Sales Channel

• Partner

• Recurring Expected Revenue

• Additional Text 1
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Area Parent Objects Child Objects

• Additional Text 2

• Additional Number 1

• Additional Amount 1

• Recurring Additional Number 1

• Recurring Additional Amount 1

Marketing
 

Leads
 

• Leads Product

• Leads Resources

• Leads Contacts

• Leads Territories

Marketing
 

Budget
 

• Budget Entries

• Fund Requests

Partner Relationship Management
 

Partner
 

• Classification Assignment

• Partner Type

• Customer Contact Profile

• Partner Certification

• Expertise

• Geographies Served

• Industries Served

• Product Specialties

• Account Team

• Address

• Phone

• Web

• Email

• Instant Messaging

Partner Relationship Management
 

Partner Program
 

• Program Benefit Details

• Program Objective Details

• Program Contract Templates

Partner Relationship Management
 

Partner Enrollment
 

• Enrollment Participants

• Contract Enrollments

Sales Catalog
 

Product Group header
 

• Product Group

• Product Group Product

◦ Eligibility Rules

• Product Group Relation

• Product Group Attachments
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Area Parent Objects Child Objects

Sales Catalog Product header • Product

• Product Attachment

Territory Management
 

Sales Territory
 

• Sales Territory Resource

• Sales Territory Line of Business

• Sales Territory Coverage

• Sales Territory Coverage Dimension

• Sales Territory Coverage Dimension Value

Territory Management
 

Sales Territory Proposal
 

Sales Territory Proposal
 

Note:  You can also audit custom objects that you create in Application Composer. On the Configure Business Object
Attributes page, select CRM Application Composer from the Product list of values. You can then select either a top-
level custom object or its child objects, or an intersection object that was created from a many-to-many relationship.

Related Topics
• Audit Policies

• Audit Reports

Enable Auditing of Sales Business Objects  
Enable audit history so that your users can see the change history of sales business objects.

Note:  Administrators must have the Manage Sales Audit Policies (FND_MANAGE_SALES_AUDIT_POLICIES_PRIV)
privilege to do these steps.

1. Sign in as a setup user.
2. In the Setup and Maintenance area, use the search pane to search for the Manage Audit Policies task.
3. In the Manage Audit Policies page, click Configure Business Object Attributes in the Oracle Fusion

Applications region.
4. Select appropriate business object or business object area from the list.

◦ For sales Accounts, Business Plans, Objects, or Quotes, select CRM Common.

◦ For sales Activities, select Applications Common Components.

◦ For Products and Product Groups, select Sales Catalog.

◦ For Opportunities, select Sales.

5. If necessary, select a child item from the list of objects in the Audit Name table.
6. Click the add icon in the Audited Attributes area.
7. Select the fields you want to audit.
8. Click Save and Close.
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Display the Change History Subtab  
Salespeople can see a record's change history without having to leave the record, provided that you make the Change
History subtab visible. You can display the Change History subtab for both standard and company-defined objects.

Before you display this subtab, be sure to configure your audit policies using the Manage Audit Policies task in Setup
and Maintenance. See the related topics for more information.

You can expose the Change History subtab for these objects:

• Accounts

• Contacts

• Opportunities

• Leads

• Activities

• Deal Registration

• Company-defined objects

The steps to display the Change History subtab are the same for all objects: you create a new page layout and add the
subtab. Here's a procedure with the Account object as an example.

To make the Change History subtab visible:

1. In an active sandbox, click Navigator > Configuration > Application Composer.
2. In the navigation tree, select, expand Standard Objects > Account, and click Pages.
3. Ensure that the Application Pages tab is selected.
4. Create a new custom layout for the details page, or edit an existing custom layout.
5. On the Details Layout page for the custom layout, click the Add icon in the Subtabs Region. The add icon is the

last subtab in the list of subtabs.
6. Click the Common component radio button.

Note:  If both the Notes and Change History subtabs are already enabled, then you can't select the Common
component check box.

7. Click Next.
8. Select the Change History option.

If you can't select a check box, then that common component is already allowed for use in this custom layout.
9. Click Save and Close.

10. Test the changes: Navigate to Sales > Accounts as a salesperson. Edit an account and ensure you can see the
Change History subtab in the Edit Account page.

11. Publish the sandbox.

Tip:  The filters on the Change History page aren't extensible. You can't hide them or configure what they display. For
more information on their behavior, see the Audit History topic in this chapter.
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Grant Salespeople Privileges to View the Change History Subtab  
If you have a company-defined object and you want your salespeople to be able to view the Change History subtab for
that object, you need to configure that security.

Here's how to grant salespeople the privilege to view the audit history in the Change History subtab, for company-
defined objects.

Note:  You can also do these steps from the Role Security link in the Common Setup region.

1. In Application Composer, go to the company-defined object and open its Security node.
2. On the Define Policies page, in the Roles section, click the Change History check box for the Custom Objects

Administration role.

FAQs for Change Auditing  

Frequently Asked Questions (FAQs) for Change Auditing  
This section contains some frequently asked questions (FAQs) when setting up application change auditing. Scroll or
search to find answers to common questions.

Can I display the Change History subtab for custom objects?  
Yes, you can display the Change History tab on the pages of custom objects. Simply add the Change History subtab to
the details page of the object.

Can I audit and view changes in custom fields on standards objects?  
Yes. You can add custom fields to the list of attributes available for audit.

Can I modify the search-related fields on the Change History subtab?  
No, you can't modify the search fields. You can't hide them or configure what they display.

Can I audit the history of attachments?  
No. The application doesn't support auditing attachments.

Does the audit begin only after the Change History subtab is visible?  
Yes. The Change History subtab presents the audit information in the context of the record only if audit has been
allowed for the object.
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How is the performance on the Change History subtab?  
The Change History subtab is faster than the central or fundamental audit reports because only a single record's history
is audited at one time. However, it takes more time than the normal clicks to complete a business action on the UI.

If you find poor performance when auditing, try enabling the functionality for a single or only a few objects.
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41  Cross-Origin Resource Sharing

CORS  
Cross-Origin Resource Sharing (CORS) is a mechanism that allows cross-domain communication and lets a browser
securely access resources from a different domain.

By default, browser-based programming languages, such as JavaScript, can access resources only from the same
domain. But with CORS, you can overcome this limitation and manage resources across domains.

Here are the CORS headers you can configure to make that possible.

CORS Header Purpose

Access-Control-Allow-Origin
 

Contains a comma-separated list of trusted origins, or domains, that a client application can get
resources from.
 

Access-Control-Max-Age
 

Specifies how long to store the results of a request in the preflight result cache.
 

Access-Control-Allow-Methods
 

Contains a comma-separated list of HTTP methods allowed in a request.
 

Access-Control-Allow-Headers
 

Contains a comma-separated list of HTTP headers allowed in a request.
 

Access-Control-Allow-Credentials
 

Specifies whether a client application can send user credentials with a request.
 

Example
A client application retrieves resource X from server A, which is what the application runs on. The client application then
makes an HTTP request to get resource Y from server B. For this cross-server request to work, you must configure the
Access-Control-Allow-Origin header in server B. Otherwise, the request fails and we end up with an error message.

Related Topics
• Configure CORS Headers

• Set Profile Option Values

Configure CORS Headers  
To enable CORS in Oracle Applications Cloud, configure CORS headers so that client applications in one domain can
use HTTP requests to get resources from another domain. Set values for profile options that correspond to the CORS
headers.
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To view the profile option, go to the Setup and Maintenance work area and use the Manage Applications Core
Administrator Profile Values task in the Application Extensions functional area.

CORS Profile Options
This table lists the profile options you can set for CORS headers.

CORS Header Profile Option Name (Profile Option Code) Profile Option Values

Access-Control-Allow-Origin
 

Allowed Origins for Cross-Origin Resource
Sharing (ORA_CORS_ORIGINS)
 

Note:
If you configured CORS using the earlier
profile option ORACLE.ADF.VIEW.ALLOWED_
ORIGINS, the associated profile value will
be copied over to the new profile option
ORA_CORS_ORIGINS, as part of the latest
application upgrade. You must validate
whether the carried over changes to the
profile option are according to your CORS
configuration requirement.
 

These are the values you can enter to indicate
which origins are allowed:
 

• URL of the specific origin. For example,
 http://www.exampledomain.com.

• Space-separated list of
origins. For example, http://
www.exampledomain.com
http://us.example.com http://
software.example.com

• An asterisk (*) to allow access to resources
from all origins.

Note:  These are some key points to
remember while using the profile values:

• You must set a value for this header to
enable CORS.

• Never enclose URL and asterisk in
quotation marks.

• Domain names must contain only valid
URL characters.

• The profile value is applicable at the Site
level.

Access-Control-Max-Age
 

CORS: Access-Control-Max-Age
(CORS_ACCESS_CONTROL_MAX_AGE)
 

Default value for caching preflight request is
3600 seconds.
 

Access-Control-Allow-Methods
 

CORS: Access-Control-Allow-Methods
(CORS_ACCESS_CONTROL_ALLOW_METHODS)
 

Default values for allowed methods are
OPTIONS, HEAD, GET, POST, PUT, PATCH,
 and DELETE.
 

Access-Control-Allow-Headers
 

CORS: Access-Control-Allow-Headers
(CORS_ACCESS_CONTROL_ALLOW_HEADERS)
 

Default values for allowed headers are Accept,
 Accept-Encoding, Authorization, Cache-
Control, Content-Encoding, Content-MD5,
 Content-Type, Effective-Of, If-Match, If-
None-Match, Metadata-Context, Origin,
 Prefer, REST-Framework-Version, REST-
Pretty-Print, Upsert-Mode, User-Agent, X-
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CORS Header Profile Option Name (Profile Option Code) Profile Option Values

HTTP-Method-Override, and X-Requested-
By.
 

Access-Control-Allow-Credentials
 

CORS: Access-Control-Allow-Credentials
(CORS_ACCESS_CONTROL_ALLOW_CREDENTIALS)
 

Select True or False to allow or prevent sending
user credentials with the request. The default is
False.
 

Related Topics
• CORS

• Set Profile Option Values
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42  Import and Export

Overview of Import and Export  
You can use Oracle's import and export tools to import and export a wide range of application data.

For example, you can import records for sales business objects into the applications so that you don't have to create the
records in the UI.

Options for Importing Data Into Your Application  
Here's an overview of the multiple ways you can import your data from a file or directly from an external application.
Which import method you use depends on the type of data you're importing, the volume of data, and technical
requirements. If you're integrating your sales application with other cloud services, then you may be required to use
additional import methods not covered here.

Whichever import method you use, you must make sure that any prerequisite records already exist in the application.
For example, if you're importing contacts for an account, then the account must already exist in the application. If you're
importing data that depends on other data, then the prerequisite import process must complete successfully before you
start the dependent process.

Import Method Description When to Use How to Access Where to Get More
Information

Import Macros
 

The Excel macros speed
up and simplify the import
of up to 5,000 records at
a time for some objects.
The macros help you
by validating your data
entries, providing lists of
values, and automatically
populating constant values.
 
The macros create data
files that are imported
automatically.
 
Macros are available to
import the following types
of sales information:
 

• Sales users

• Products

• Product groups

• Accounts and the
account hierarchy

Use the import macros
for importing data in your
initial deployment.
 
The macros are targeted
to the simple proof of
concept sales automation
use case covered in this
guide. For example, the
import macros assume that
you're importing account,
 contact, and lead records
for one country at a time.
 
The macros generate log
files of the actual data
that's imported, including
the values populated for
you. The log files can serve
as a learning tool for more
complex import.
 

You can download the Excel
macros and any required
mapping files from the
Oracle CX Sales: Getting
Started with Your Sales
Implementation: Import
Macros (Document ID
2229503.1) article on My
Oracle Support.
 

The different chapters in
this guide provide detailed
instructions for using the
macros.
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Import Method Description When to Use How to Access Where to Get More
Information

• Contacts

• Leads

• Opportunities

• Opportunity revenue
lines

Import Management
 

Use Import Management to
import data files (.csv) with
up to 50,000 records.
 
Import Management
improves definition, error
handling, and performance.
For example, you can drag
and drop attributes while
creating import mappings.
The import also validates
the first ten records in your
data file before you import
the rest. You don't have
to wait around to see if
your data meets the import
requirements.
 
Import Management
supports import for all sales
objects and the majority of
other objects as well.
 

Use Import Management
for importing data .
 
 

Click Import Management
in the Navigator.
 

See the Understanding
Import and Export
Management guide for
instructions on using the
import.
 

External Data Loader Client
 

The data loader is a
command-line tool you can
use to import high-volume
data files. The tool supports
the same objects as Import
Management.
 
The tool automatically
splits a large data file into
multiple smaller files to
adhere to the application's
import volume limits, and
enables the tracking of
import status.
 
 

Use this import method for
importing very large data
files for the same objects
supported by Import
Management.
 

You can download the
client from Oracle Support
Document 2325249.1
(External Data Loader
Client) on My Oracle
Support.
 

Instructions for using the
client are available in the
document and in the client
itself.
 
For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 

Web Services
 

Web services let you
Import data directly
from other applications.
You can manage Import
Management imports using
REST web services.
 

Use web services to
manage import jobs
if you need to import
directly from an external
application.
 

Public APIs are available for
Import Management and
REST services.
 
The REST services include
the following:
 

• Import Activities

• Import Activity Maps

• Import Export Objects
Metadata

For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 
For SOAP API
documentation, see the
SOAP Web Services for
CX Sales and B2B Service
guide.
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Import Method Description When to Use How to Access Where to Get More
Information

High-Volume Import
 

An import mode available
in both REST web services
and in the External Data
Loader Client that is
designed to import millions
of records at a time. High-
Volume Import is available
for the following objects:
 

• Account

• Asset

• Contact

• Hierarchy

• Hierarchy Member

Use this import mode
for importing very large
number of records for the
set of available objects.
You can't use this mode
with any custom import
logic that you added,
 including Oracle workflows,
 ICS triggers, or custom
validation.
 

You can access High-
Volume Import either using
REST services or using
External Data Loader Client.
 
When importing using
REST, set the "High-
volume" attribute to enable
High-Volume Import.
 
When importing using the
External Data Loader Client,
set the command-line
parameter "-high-volume"
to enable High-Volume
Import.
 

For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 

Here's a diagram that illustrates the different import methods:

• The import macros (callout 1), Import Management (callout 2), and the External Data Loader Client (callout 5)
all use the same Oracle Enterprise Scheduler processes for import. When you import very large files using the
EDLC client, the REST web services (callout 4) create multiple processes to respect the Import Management file
size limit.

• If you need to import from an external application, then you can use the REST web services directly.
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Overview of the Import and Export Management
Framework  
Oracle's Import and Export Management framework provides a great mechanism to import and export data with these
benefits:

• Ease of use: Streamlined UIs, drag and drop mapping, and pre-execution validations

• Integrated: REST and command-line APIs for job definition, invocation, and monitoring

• Consistency: Object definitions that are same throughout the application (import, REST, UI, App Composer),
including parent-child structures

• Configuration: Supports custom business logic and events

• Improved debugging: Easier issue diagnosis, analyzes up to the first 10 rows of your source file for validation of
data type constraints, and required fields

• Performance: Improved performance with much less import time for high-volume data. Data migrations can be
configured to process millions of records per hour

• Flexibility: Can support jobs of all sizes and high-volume onboarding and initial data loads

For more information about using Import and Export Management, see the Understanding Import and Export
Management for CX Sales and B2B Service guide.

You can use REST services to integrate Import Management with an external scheduler, run recurring import jobs,
define and execute import/export activities, manage maps, and introspect object metadata. The Use Cases section in
the REST documentation guide has more information about how to use REST services with Import Management.
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43  Configuring, Extending, and Integrating
Sales

Overview of Extending the CX Sales Applications  
Oracle CX applications offer many different ways to configure, extend, and integrate its services, components, and
modules.

Here are just a few of the capabilities:

• Modify objects and user interfaces (UIs).

• Change the appearance and theme of the UIs.

• Configure the Home page by adding announcements and changing navigation.

• Change the structure of the springboard and modify the Navigator.

• Modify the help configuration.

• Create interactive guides to help your users learn about the applications.

• Access a rich set of subject areas around which to build your own reports.

• Configure reporting dashboards by adding new reports or changing the layout.

• Create copy maps to map fields or add information between copied business objects.

• Configure security components.

• Use web services to integrate the services.

• Export data, modify it, and then import it back into the services.

• Integrate with other applications to enhance the functionality, including synchronizing Financials Accounts to
the sales applications.

Note:  For more information about configuring online help, see the Common Components chapter.

Modify Pages and Change Text
Use Oracle's configuration tools, Application Composer and Page Composer, to modify application pages. Use the
strings editor to modify text in the application pages.

For example:

• Create a new object and related fields, then create new pages where that object and its fields are exposed to
users.

• Add tabs hidden by default to application pages.

• Edit the UI at runtime by showing or hiding fields and tables.

• Change the order of regions, or change a dashboard page layout.
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• Change the default text in the UI, for example, by replacing a term with another term throughout the
applications.

Map Fields Between Applications
Copy maps are default mappings of fields between objects. For example, when you convert a lead to an opportunity, the
application uses the copy map defined for the Lead and Opportunity objects to determine what to name the leads fields
that are carried over to the newly created opportunity. Using Oracle Application Composer, you can create copy maps
for several sales business objects, thus allowing you to control the mapping.

Here are some use cases:

• Create maps to change the default mapping between fields when:

◦ Leads and opportunities are copied from responses

◦ Opportunities are created from leads

◦ Opportunities are created from partner deal registrations

◦ Opportunities are copied from existing opportunities

• Use Groovy scripting to include information about the lead on a new opportunity converted from a lead.

Integrate Applications with Web Services and Use Import and Export
You can use web services to integrate with your external applications. You can also use import management to import
and export large amounts of data into and out of the applications.

Example web service integrations include:

• Integrate sales applications with back-office applications.

• Create web-based portal applications that access sales applications through a web services interface.

Example import use cases include:

• Import products into the product catalog

• Import users

• Import sales accounts

Configure Security Components
If the predefined security configuration doesn't meet your business needs, then you can make changes. For example,
the predefined Sales Representative job role includes sales forecasting duties. If some business groups in your
organization have the sales managers perform forecasting tasks instead of the sales representatives, then you can
create a company-defined Sales Representative role without those duties. Alternatively, if a predefined job role is too
narrowly defined, then you can create a job role with a greater range of duties than its predefined equivalent. See the
Securing CX Sales and Fusion Service guide for more information.

Synchronize Financials Accounts to Sales Applications
After users create accounts and contacts in Oracle Financials, use the scheduled process, Synchronize Financials Cloud
Accounts and Contacts, to synchronize the data into the sales applications. See Synchronize Financials Accounts and
Contacts with CX Cloud for more information.
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Integrate Sales Applications with Other Products
For additional functionality, you can integrate your sales applications with other products, including, Oracle E-Business
Suite, JD Edwards EnterpriseOne, Siebel CRM, Oracle Eloqua, and Oracle Configure, Price, and Quotes (Oracle CPQ).

Where to Find More Information
To find out where to get more information about the extensions and configurations discussed in this topic, see this list:

• Configure the help system: See Common Components chapter in this guide and the Oracle Applications Cloud
Configuring and Extending Applications guide

• Create interactive guides to help your users learn about the applications: See Manage Guided Learning for
Onboarding and Training

• Configure the Home page, the Navigator, and the springboard: See Common Components chapter in this guide
and the Oracle Applications Cloud Configuring and Extending Applications guide

• Change the UI:

◦ Common Components chapter in this guide

◦ Oracle Applications Cloud Configuring and Extending Applications guide

◦ The chapters on extending sales business objects in this guide

• Use Copy Maps: Start with Set Up Your Mapping File When Copying Opportunities

• Use Oracle Business Intelligence reports and analytics: Start with Analytics on the Go and the Oracle CX
Creating and Administering Analytics guide

• Synchronize Financials Accounts to the Sales Applications: See Synchronize Financials Accounts and Contacts
with CX Cloud

• Integrate applications using web services and use Import and Export Management: See Overview of Import and
Export

• Integrate the Sales applications with other products: See the article on sales integrations (1962226.1) available
on My Oracle Support.

About Application Composer  
Application Composer is a browser-based configuration tool that enables business analysts and administrators, not just
application developers, to extend their applications. Make the type of data model changes which, in the past, could only
be made by application developers.

For example, easily create a new object and related fields, then create new user interface pages where that object and its
fields are exposed to users.

Application Composer is a design time at runtime tool, which means that you can navigate to Application Composer
directly from any application, make your changes, and see most changes take immediate effect in real time, without
having to sign out and sign back in. (For end users to see your changes, however, you must first publish your sandbox
and then they must sign out and sign back in. Read more about sandboxes later in this topic.)

953

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAEXT
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAEXT
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAEXT
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OAEXT
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACAA
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACAA
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20076013
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20076013
https://support.oracle.com


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 43
Configuring, Extending, and Integrating Sales

Note:  To see your changes in real time, always use the Navigator to navigate to the runtime page that you changed.
Then navigate back to Application Composer to continue making changes. In other words, when making application
changes (and testing them), restrict your usage to a single tab. Don't work across multiple browser tabs, because
Application Composer doesn't support this type of usage.

You can use Application Composer to configure Oracle's Sales and Fusion Service, Supply Chain Management, and
Project Management applications.

Application Composer isn't supported for use with iPad devices.

Application Changes for Nondevelopers
Application Composer hides the complexity of modifying applications by leveraging a set of standard design patterns
and wizards. You focus on the application changes that your business requires (object model extensions and layout
changes, for example), and Application Composer creates the underlying object artifacts for you.

Using Application Composer, you can make application changes such as the following:

• Modify objects by adding new fields, or create entirely new objects.

• Create foreign key-based relationships between two objects.

• Modify user interface pages by exposing your newly created fields for an object, or create an entirely new work
area for your custom objects.

Expose object relationships in the form of subtabs on pages.

• Write application logic, such as triggers, validation rules, and workflows, for an object, or for use across multiple
objects.

• Implement functional and data-level security for custom objects.

• Enable objects for custom reporting.

Working in a Sandbox
To make most application changes, you should work in a sandbox. In fact, many functions in Application Composer
aren't available until you enter into an active sandbox. You use sandboxes to make application changes and test them
without impacting other users in the environment. Wherever possible, make changes to the application in a sandbox
rather than making direct changes in the mainline environment.

Sandboxes set apart untested configuration changes from the mainline environment. This lets you test your changes in
a sandbox first, before publishing it. After publishing, your changes become available in the mainline metadata, or other
sandboxes after they're refreshed, so that everyone can see your changes. Mainline metadata is the primary branch
of metadata a sandbox is published to. Note that end users must sign out and sign back in to see the changes from a
published sandbox.

Tip:  As a best practice for using sandboxes in Application Composer, follow the below sequence to make your
application changes:

1. Publish a sandbox with model-level changes, like creating an object and creating relationships for that object.

2. Publish a sandbox with the UI-level changes for the object, like adding layouts, subtabs, etc.
This order can minimize conflicts while publishing your sandboxes.

To learn more about sandboxes, see Overview of Sandboxes.
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Accessing Application Composer
Access Application Composer at runtime by using the Navigator menu, and selecting Application Composer under the
Configuration category.

The first view of Application Composer is the main Overview page, which is the entry point into all your task options.

Getting Started
From the main Overview page:

• Use the object tree to select the object you want to modify. Or, click the New icon to create a new object.

• Use the links in main Overview page, also known as the local area, to select a task. Or, use the links in the
Common Setup pane.

Related Topics
• Define Objects

• Define Fields

• Overview of Sandboxes

Use Page Composer to Extend Pages  

Overview of Configuring Sales Pages Using Page Composer  
Configure the look and feel of user interface (UI) pages using Page Composer:

• Make changes on a single page for all users or only a subset. For example, you can enable a field that's hidden
or make a field required.

• Create saved searches (lists) in the different work areas. These can be used as filters in actionable infolets.

• Specify which columns display in the summary tables in the work area lading pages.

• Create new infolets and create different default views of infolets for different sets of users.

This chapter covers:

• Points to consider before you configure pages

• How to configure standard desktop pages, landing pages, and dashboards

• How to configure application pages

• How to use Direct Selection mode to make user interface changes

• How to work with components for configure pages

Note:  Page Composer supports two editing modes: Add Content and Select. Use the Add Content mode to navigate
to different tabs and windows on a page and to add content on the Partner Relationship Management's Partner Portal
UI Shell. You can make enable fields and make other configurations only in the Select mode.
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Related Topics
• Configure Sales Pages Using Page Composer

• Modify UI Components Using Page Composer

Differences Between Using Page Composer and Application
Composer  
You can use multiple tools to configure the UI. This topic highlights the differences between the types of configurations
you can do using Application Composer and Page Composer.

Key Differences

Basis of Comparison Page Composer Application Composer

Configuring the page you're viewing
 

Configure a UI page you're viewing and see
your changes reflected immediately on that
page.
 
You can use Page Composer to make changes
to one page at a time. For example, if you make
a field required on the Edit Infolets page, the
field isn't automatically required on the Create
Infolets page.
 

You make your configurations in Application
Composer. You can then test your work by
navigating to the appropriate page.
 
Because you use Application Composer to
configure application objects, if you make a
field required, it affects all interfaces where that
field appears.
 

Supported interfaces
 

Application UI
 

• Application UI

• Mobile

• Microsoft Outlook

Creating your own fields and application
objects
 

Not supported.
 

You can add custom fields and entirely new
objects.
 

Creating saved searches
 

Create and edit saved searches for users. The
saved searches provide saved search criteria to
speed up common searches. You can also use
them as filters in actionable infolets.
 

Not supported.
 

Tailoring your configurations for users with
different job roles
 

Supports different levels of configurations for
application pages.
 

Supports configurations by job role or for all
users.
 

Configuring external-facing partner pages
 

You must use Page Composer to configure
all external-facing partner pages, such as the
partner registration page and the partner portal
landing page.
 

You must use Application Composer to
configure only for partner pages internal to
your organization, such as the partner Overview
page.
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What You Can't Do in Page Composer
Using Page Composer, you can't do these tasks:

• Change either the data or functional security for a page. While you can hide some components, you must
change the security setup to control access.

• Filter or reorder lists of values.

• Add any code, validation logic, or scripting to the buttons or fields.

• Add call outs to other APIs to populate fields with values.

• Change the selections that appear in the Navigator menu.

• Configure the Search region inside Search and Select dialog box.

Configure Sales Pages Using Page Composer  
Use Oracle Page Composer to configure Sales pages in a sandbox while you're working in the application. You can make
your UI configurations available to all users or only to a subset, such as only to partners or only to users with a specific
job role.

Oracle Page Composer is a page editor, developed as part of Oracle WebCenter, for revising the layout and content of
application pages. Its full capabilities are described in the Oracle Fusion Middleware User's Guide for Oracle WebCenter
and in the Oracle Fusion Applications Extensibility Guide.

You can use Page Composer, also known as Oracle Composer, for performing the following types of configurations in
your sales application pages:

• Simple UI editing functions, such as showing and hiding fields, changing field labels, and making fields read-
only or required

• Changing page layout and adding Oracle BI Publisher reports and other content to dashboard pages

• Creating new infolets

• Creating saved searches (also called saved lists) for others in the organization

• Configuring the display of search results in tables

Note:  If you're planning to configure the UI for a specific job role, then you must have that job role assigned to you so
that you can test the configuration in the sandbox.

How to Open Page Composer
To open Page composer, create and enter a sandbox with Page Composer as one of the tools and select Page Composer
from the Tools menu. If you're planning to use Page Composer to make changes for specific job roles, then you must
create a separate sandbox just for Page Composer. The other tools don't support making changes by job role.

1. Activate a sandbox.

The active sandbox name appears at the top of the page.
2. Click the user image or name and select Edit Pages from the Settings and Actions menu.
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Page Composer Modes
When configuring sales pages, you can use Page Composer in one of two modes: the Add Content mode and the
Select mode. The following figure shows a partial screen capture of the Page Composer toolbar with the two modes
highlighted by callouts.

• Use the Add Content mode (highlighted by callout 1 in the following figure) to move, add, and edit regions
on dashboards and external-facing partner pagers. You also use this mode to create saved searches, specify
search result content, and to navigate in the UI when you're in Page Composer.

You're in the Add Content mode when you first open Page Composer. You can also select this mode by clicking
Add Content on the top left corner of a page.

• Use the Select mode (callout 2), which you can activate by clicking Select, to configure the properties of
different UI elements such as fields and table columns.

Add Content Mode
Use the Add Content mode to do the following:

• Configure the content on dashboard pages, including the Welcome page in the desktop UI.

Dashboards pages are the pages that users land on when they navigate to work areas using the Navigator.
Dashboard pages display analytics, notifications and other information.

• Configure all of the external-facing landing and transactional partner management pages.

• Configure the table display of search results.

• Create saved searches (saved lists).

• Navigate to other pages while working in Page Composer.

When you open Page Composer, the application opens in the Add Content mode automatically. On pages that support
configuration in this mode, such as the sales dashboard in the following image, different regions are highlighted with
borders and display configuration controls.

The following screenshot shows a partial screen capture of an application page with the different Add Content features
highlighted by callouts.

• A bar appears at the top of the page indicating that you're in editing the page in Page Composer (callout 1).

• You can change the column layout of the page by clicking Change Layout (callout 2).

• You can move a region, by grabbing its toolbar (callout 3) and dragging it to a different position.

• You can add a new tab (callout 4).
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You can also make changes in each region:

• You can remove a region by clicking Close, the icon at the top right-hand corner of the region.

• You can add content by clicking Add Content.

• You can add a new region by clicking one of the icons to the right of the Add Content button. These icons
specify where in the page the new region is created.

Select Mode
In the Select mode, a border appears around individual fields and other UI elements as you move your cursor over them.

Clicking within a border for a UI element that supports configuration displays a menu with one or both of the following
options: Edit Component and Edit Parent Component.
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The following screenshot shows the Edit Component menu in the Page Composer Select mode.

Not all UI elements support configuration, so these editing options aren't always enabled.

You use the Component Properties window to make your configurations. Not all the configurations are available on all
the UI elements, so the content of this window varies. The following screenshot highlights the different components
with callouts.

• To make a field read-only, you select the Read Only option (callout 1).

• To make a field required, you select the Required option (callout 2).

Note:  Before making a field required, the field must display a value. If it doesn't, then cancel out of this
window and enter the value first.

• To hide the field, you deselect the Show Component option (callout 3).
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Note:  Some UI components are protected from updates to preserve the product business logic. For example, if a field
is read-only because of a security privilege defined in the application, you can't make it editable in Page Composer.

How to Edit the Partner Portal UI Shell Using the Page Composer Source View
Channel partner portal administrators can use Page Composer's Source View to configure the header and footer areas
of the pages partners use to register themselves and sign in after they're registered. This is the only sales page which
supports this mode. You can use this mode to add a company logo, copyright information or links, for example.

To configure the partner portal UI shell, you must activate a sandbox and select the Update Partner Portal UI Shell
task in the Channel dashboard.

To learn more about working in the Source view, see the Oracle Fusion Middleware User's Guide for Oracle WebCenter.

How to Make Configurations Available to Different User Groups
You can make your configurations available to different subsets of users.

When you launch Page Composer, you must select one of the following configuration layers:

• Site: Your configurations are visible to all users.

• External or Internal: Depending on your selection, your configurations are visible to either internal users (your
employees) or to external users (your partners or anonymous users).
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• Job Role: Your configurations are visible to users with the job role you select. The list of available job roles
includes all the job roles assigned to you directly and any job roles that are inherited by those job roles.

Note:  If you created your own job roles, then you must run the Retrieve Latest LDAP Changes process from
the Scheduled Processes work area before the job roles are available for selection.

By default, configurations you made at a higher level are propagated to lower-level layers, unless you deselect these
layers in the Include column.

Note:  The Welcome page in the desktop UI doesn't support different configuration layers. You must configure this
page at the site level.

Related Topics
• Differences Between Using Page Composer and Application Composer

FAQs for Page Composer  

Frequently Asked Questions (FAQs) for Page Composer  
This section contains some frequently asked questions (FAQs) when using Page Composer. Scroll or search to find
answers to common questions.

What do I do if Page Composer closes while I am navigating in the UI?  
If you're using Page Composer in Design mode and trying to navigate between different objects in the application, the
Page Composer sometimes closes. That's because it's designed to configure one object at a time.

When you no longer see the Page Composer bar at the top of your screen, simply restart Page Composer. Your previous
work is preserved in the active sandbox, so you don't have any data loss.

How can I reset all personalization changes made by a specific end user?  
Your end users can personalize a page explicitly (like creating a saved search) or implicitly (like changing table column
width). You can revert all such changes made by a specific user using the Personalization page in Application Composer.

In the Common Setup region, click Personalization. Search for a user and then click Reset Personalization. All changes
made by that user are removed and all pages are restored to the default content and layout as originally delivered.
Changes implemented by an administrator using Application Composer and Page Composer are retained, if they exist.

End users can also revert their changes themselves, but only on a page-by-page basis.

Related Topics
• How can I reset a page or task flow to a previously saved version?

Can I edit Expression Language (EL) expressions using Page Composer?  
No, Page Composer doesn't allow editing EL expressions to protect the business logic implemented through EL
expressions.
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Can I use Page Composer to configure all elements on a page?  
No, you can't use Page Composer to configure all UI elements on a page.

Some UI elements are protected from updates to preserve the product business logic. For example, if a field is read-only
because of a security privilege defined in the application, you can't edit the field.

You can't select some page elements in the Select mode of Page Composer. For others, the Edit Component option is
disabled or only a subset of the properties are available in the Component Properties dialog box.

CAUTION:  Don't edit the Taskflow Id parameter in Page Composer Task List properties. This may damage page
metadata.

In general, you can configure at least some of the properties of the following page components:

• af:activeOutputText

• af:inputComboboxListOfValues

• af:inputDate

• af:inputFile

• af:inputListOfValues

• af:inputNumberSlider

• af:inputNumberSpinbox

• af:inputRangeSlider

• af:goLink

• af:query

• af:inputText

• af:outputFormatted

• af:outputText

• af:panelLabelAndMessage

• af:panelFormLayout

• af:panelHeader

• af:richTextEditor

• af:selectBooleanCheckbox

• af:selectBooleanRadio

• af:selectManyCheckbox

• af:selectManyChoice

• af:selectManyListbox

• af:selectManyShuttle

• af:selectOneChoice

• af:selectOneListbox

• af:selectOneRadio

963



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 43
Configuring, Extending, and Integrating Sales

• af:selectOrderShuttle

• af:showDetailHeader

• af:table

• af:column

• fnd:applicationsTable

• af:commandMenuItem

• af:menu

• af:panelGroupLayout

• af:panelTabbed

• af:group

• af:commandButton
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44  Extend Accounts, Contacts, and
Households

Overview of Account and Contact Extensibility  
Extend objects and pages related to accounts and contacts.

In this chapter, you will learn about:

• Each standard object related to accounts and contacts and how to extend those objects using Application
Composer.

• How to configure Customer Center pages using Page Composer.

Related Topics
• Extend Pages for Accounts

• Extend Pages for Contacts

• Extend Application Pages for Relationships

• Extend Pages for Assets

• Extend Pages for Households

Extend Pages for Accounts  
Using Application Composer, you can change many items for accounts pages.

Use Application Composer to modify the following pages:

• Accounts landing page

• Create Account page

• Edit Account page

For example, you can:

• Hide or show standard fields.

• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Note:  To extend the pages for accounts, use the Account object in Application Composer.
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Accounts Landing Page
You can modify the Accounts landing page, also referred to as the Accounts list page. For example, you can hide
standard account fields or show custom account fields. To modify the Accounts landing page:

1. Navigate to the Account object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, click Edit Summary Table for Account.

Create Account Page
You can modify the Create Account page. For example, you can hide standard account fields, make a field required, add
a default value, and show custom account fields. To modify the Create Account page:

1. Navigate to the Account object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.

To enhance runtime usability for your end users, optionally group custom fields into field groups.

Note:  Custom fields that you add to the Account object and then select for display in a page layout appear on the
Create Account page, before the address set of fields.

Edit Account Page
The Edit Account page consists of multiple subtabs that display along the left side of the page. You can modify most of
these subtabs, as well as hide or show subtabs. For example, you can also add custom subtabs to display records from
child or related objects

To add custom fields to certain subtabs available from the Edit Account page, you must first navigate to those subtab
target objects in Application Composer to create the fields. After creating the fields on the target object, you can then
navigate to the required details page layout for the Account object to add those fields to the relevant subtabs.

To modify the Edit Account page:

1. Navigate to the Account object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.
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4. When making changes to the Edit Account page, select the subtab you want to change first. The following
subtabs are available from the Edit Account page. Use the following subtabs to configure which standard and
custom fields display at runtime.

The changes you make to these subtabs are unique to the Edit Account page. For example, the changes you
make to the Opportunities subtab on the Edit Account page aren't reflected on the Opportunities subtab on the
Edit Contact page.

◦ Overview

◦ Profile

Note:  When adding a custom field group to the Profile tab, the custom field group always displays
above the Address region at runtime. This is true even if the custom field group is positioned differently
when configuring the layout in Application Composer.

◦ Team

Use the Sales Account Resource and Sales Account Territory objects to create custom fields as needed.

◦ Contacts

Use the Contact object to create custom fields as needed.

Note:  To expose the Contact custom fields on the Contacts subtab, create a join for the field under the
Custom Contact Profile object.

◦ Assets

Use the Asset object to create custom fields as needed.

◦ Opportunities

Use the Opportunity object to create custom fields as needed.

◦ Leads

Use the Lead object to create custom fields as needed.

◦ Relationships

Use the Relationship object to create custom fields as needed.

◦ Notes

Use the Note object in Application Composer to create custom fields as needed, and to extend this
subtab.

On the Application Pages tab for the Note object, edit the default creation page layout or duplicate it to
create a new layout.

The Notes list page isn't extensible.

◦ Activities

Use the Activity object in Application Composer to extend this subtab.

On the Application Pages tab for the Activity object, click Edit Embedded Summary Table (at the bottom
of the page).

◦ Conversations
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Not extensible from this page.

Configure Default Search on Standard Subtabs for
Accounts  

When a user opens the subtab at runtime, the records displayed are automatically filtered using the search criteria you
added. Users can change the default search value, but they can't change the default search field. They can, however,
further refine their search by adding additional search fields and values at runtime.

Adding a default search filter to a subtab is optional. If you skip this step, then no search fields are automatically added
to the subtab, but users can still see the search region and perform their desired search.

Use this procedure to add a default search filter field, operator, and value for the Leads subtab search on the Edit
Account page.

Note:  You can select only one default search filter for each subtab. When adding a default search filter to standard
subtabs, the search filter applies to all existing details page layouts with this subtab. Let's say you add a search filter
to the Lead subtab on an Account details page layout. This means that the same search filter is added to the Lead
subtab on an Opportunity details page layout.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer.
4. In the navigation tree, expand Standard Objects, expand Account, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, highlight Leads and click the pencil icon.
9. From the Configure Detail Form page region, go to the Configure Summary Table: Search Region.

10. Select the default search filter you want to apply to the Leads subtab.

You can select from a list of both standard and custom Lead fields. Note that you can't pick dynamic choice list
fields, set ID-based fixed choice list fields, and any fields that aren't searchable. Also, if this subtab was added
based on a many-to-many (M:M) relationship, then you can select from only those intersection object fields
that are already displayed on the subtab.

For example, you want to create a search filter to search for all qualified leads for an account. Select Status
from the drop-down list and select Equals as the operator and then select the Qualified check box.

11. Click Done and ensure that the layout status for your Leads subtab layout is set to Active.
12. Test the changes: Navigate to Sales > Accounts as a user with access to the account pages, for example,

as a salesperson. Edit an account and confirm that the data that displays on the Leads subtab includes only
qualified leads.

13. Publish the sandbox.
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Select the Correct Name Field When You Configure
Account Pages  
You can see two Name fields in the accounts object, when you add fields on a new layout, in the Application Composer.
Hover over the fields to see the description for each instance; one field shows OrganizationName and the other
PartyUniqueName.

When you add a Name field to a dynamic choice list for accounts, you can't see the description when you hover on the
name field. The difference between the two instances is the value that's added to the list. The first instance of the Name
field adds the organization name while the second instance adds the party unique name to the display list. Here's a
description of the fields.

Field Name Description

Organization Name
 

Displays the name of the organization. This is the name you entered while creating an account.
 

Party Unique Name
 

Displays the unique name of a party. This name is created by putting together the party name and
suffix. If the suffix is null, then it's automatically generated for sales account, sales prospect, external
legal entity and contact.
 
When a suffix is null or doesn't have to be generated, the PartyUniqueName is same as the party
name. You can configure the suffix using the task Common Party Suffix Format that's within Manage
Address Formats.
 
By default, the suffix is configured using the city and country of the primary address.
 

UniqueNameAlias
 

Displays the name of the organization on the Edit Account page.
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Modify the Overview Subtab  
You can modify the Overview subtab for accounts, contacts, households, and partners. You can hide or show fields that
appear on the left side of the subtab. Additionally, you can rearrange the position and grouping of the summary boxes,
formerly referred to as infolets,

Extensibility on the Overview Subtab
The Overview subtab for accounts, contacts, households, and partners is the top subtab that appears for an account,
contact, household, or partner record. Data that appears in the Overview subtab is read only, but your users can drill
down to more details from here.

On the left side of the Overview subtab, key fields for the account, contact, household, or partner record are displayed.
Use Application Composer to show or hide these read-only fields.

On the right side of the subtab, key data points about related object records are displayed as number totals in summary
boxes. Use Application Composer to rearrange the position and grouping of the summary boxes. You can also create
new summary boxes to highlight key data points for custom objects.

Hiding and Showing Fields
The Overview subtab includes a region on the left with a standard set of fields that display. You can further modify
those fields by hiding existing fields, and showing new fields. You can also reorder these fields.
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Note:  These fields are read only. Your end users can edit these fields at run time on the Profile subtab.

To hide and show fields, and reorder them, on the Overview subtab:

1. In Application Composer, navigate to the Application Pages tab for either the account, contact, household, or
partner object.

2. On the Application Pages tab, scroll down to view the Details Page Layouts table.

Duplicate the standard layout to create a new layout to edit, or edit another existing layout.
3. Within the selected details page layout, navigate to the Overview subtab.

Click the Edit icon next to the Overview Form heading to configure which fields display at run time, and in
which order.

Summary Box
A summary box, formerly referred to as an infolet, is a container on a page which summarizes some key information
about the record's related object records, so that your end users don't have to navigate to other tabs. For example, a
summary box might display the number of total open opportunities that you're responsible for. At run time, users can
click that number to drill down to more details. Typically, clicking a number in a summary box takes the user to another
subtab for the object record.
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Note:  The summary boxes that appear on the Overview subtab for accounts, contacts, households, and partners
are different from the infolets that you can embed in Business Intelligence (BI) dashboards, and thus aren't
interchangeable.

Below is an example of four summary boxes that display on the Account Overview subtab. These four summary boxes
are arranged within a summary box group called Sales.

The account, contact, household, and partner objects have a set number of summary boxes that you can rearrange and
group. Summary boxes are grouped by default, but you can create new groups and rearrange the summary boxes to fit
the needs of your users. In addition, you can create new summary boxes for custom objects only.

To view the available summary boxes for an object:

1. In Application Composer, navigate to the Application Pages tab for either the account, contact, household, or
partner object.
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2. On the Application Pages tab, scroll down to view the Summary Boxes table.

This table lists the available summary boxes that are registered for the object. Review the next section for tips
on working with summary boxes and summary box groups.

Working with Summary Boxes
The Overview subtab includes a region on the right where summary boxes display. Summary boxes are grouped and
arranged by default, but you can rearrange the position and grouping of these summary boxes. You can remove a
summary box from an existing summary box group, and add it to another existing summary box group. Or, you can
create a new summary box group, or delete existing summary box groups.

To rearrange summary boxes:

1. In Application Composer, navigate to the Application Pages tab for either the account, contact, household, or
partner object.

2. On the Application Pages tab, scroll down to view the Details Page Layouts table.

Edit any custom layout. If none exists, then duplicate the standard layout and edit the resulting custom layout.
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3. Within the selected details page layout, navigate to the Overview subtab to configure summary box groups.

Click the Edit icon next to the summary box group that you want to configure.

4. Use the Available Summary Boxes and Displayed Summary Boxes lists to control which summary boxes are
displayed within this summary box group at run time. Within the Displayed Summary Boxes list, use the up or
down arrows to control the order of the summary boxes within the group.

If a summary box is listed under Available Summary Boxes but you can't select it, then this means that the
summary box is already displayed inside another summary box group. If you want to include that summary box
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in the current group, then you must remove it from the other summary box group first, before you can add it to
the current group.

5. You can delete summary box groups from this page by clicking Delete. Deleting a summary box group doesn't
delete any included summary boxes.

To create a new summary box group:

1. In Application Composer, navigate to the Application Pages tab for either the account, contact, household, or
partner object.

2. On the Application Pages tab, scroll down to view the Details Page Layouts table.

Edit any custom layout. If none exists, then duplicate the standard layout and edit the resulting custom layout.
3. Within the selected details page layout, navigate to the Overview subtab to configure summary box groups.
4. Navigate to the bottom of the page and click Create Summary Box Group.

Creating Summary Boxes
You might want to highlight custom object data on an Overview subtab. Use Application Composer to create new
summary boxes that summarize key data points about custom objects.

You can't create summary boxes for standard objects.

To create a new summary box for a custom object:

1. In Application Composer, navigate to the Application Pages tab for either the account, contact, household, or
partner object.
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2. On the Application Pages tab, scroll down to view the Summary Boxes table.

3. Click New.
4. Enter the name of the summary box. The name that you enter displays to your users as the heading of the

summary box.
5. Select the target object for the summary box. Select from the custom objects that are related to the current

object: account, contact, household, or partner.
6. Select the mathematical operation that you want the summary box to perform on the related object's records.

For example, do you want the summary box to display a count of all records?
7. Optionally add filters to the summary box to constrain the records that are included in the results. For example,

maybe you want to include only records created by a specific person.
8. Click Save and Close.

After creating a summary box, you must add it to all details page layouts where you want the summary box to display.
Remember that you can add your new summary box to only one summary box group. Use the instructions above to add
your custom summary box to a summary box group.

Related Topics
• Extend Pages for Accounts

• Extend Pages for Contacts

• Extend Application Pages for Partners

• Extend Pages for Households

Extend Pages for Contacts  
Using Application Composer, you can change many items that appear on the pages for contacts.

Use Application Composer to modify the following pages:

• Contacts landing page:
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◦ Contacts cards view

◦ Contacts listing

• Create Contact page

• Edit Contact page

For example, you can:

• Hide or show standard fields.

• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Note:  Note the fixed choice list for Contact Job Title isn't available in contact advanced search; you can only enable it
as a text field.

Contacts Landing Page
The Contacts landing page consists of two different views, which your users can toggle between:

• The Contacts cards view

• The Contacts listing

You can modify both pages.

The Contact cards view displays a list of all your users' contacts, but represented visually as cards. You can modify the
fields that appear in each card. For example, you can hide standard contact fields or show custom contact fields. To
modify the Contact cards view:

1. Navigate to the Contact object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, click Edit Landing Page.
4. In the Configure Card View region, select the fields that you want to display or hide in your contact cards.
5. Optionally, select the Enable alphabetic filtering check box to display the alphabetic bar which runs across the

top of the contact cards page.

The Contacts listing displays all your users' contacts, but represented in a table list view. You can modify the columns
that appear in the table. For example, you can hide standard contact fields or show custom contact fields. To modify the
Contacts listing:

1. Navigate to the Contact object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, click Edit Landing Page.
4. In the Configure Summary Table region, select the fields that you want to display or hide in the Contacts list

page.
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Create Contact Page
You can modify the Create Contact page. For example, you can hide standard contact fields, make a field required, add a
default value, and show custom contact fields. To modify the Create Contact page:

1. Navigate to the Contact object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.

To enhance runtime usability for your end users, optionally group custom fields into field groups.

Note:  Custom fields that you add to the Contact object and then select for display in a page layout appear on the
Create Contact page, before the address set of fields.

Edit Contact Page
The Edit Contact page consists of multiple subtabs that display along the left side of the page. You can modify most of
these subtabs. For example, you can also add custom subtabs to display records from child or related objects.

To add custom fields to certain subtabs available from the Edit Contact page, you must first navigate to those subtab
target objects in Application Composer to create the fields. After creating the fields on the target object, you can then
navigate to the required details page layout for the Contact object to add those fields to the relevant subtabs.

To modify the Edit Contact page:

1. Navigate to the Contact object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.
4. When making changes to the Edit Contact page, select the subtab you want to change first. The following

subtabs are available from the Edit Contact page. Use the following subtabs to configure which standard and
custom fields display at runtime.

The changes you make to these subtabs are unique to the Edit Contact page. For example, the changes you
make to the Opportunities subtab on the Edit Contact page aren't reflected on the Opportunities subtab on the
Edit Account page.

◦ Overview

◦ Profile

◦ Team

Use the Sales Account Resource and Sales Account Territory objects to create custom fields as needed.

◦ Assets

Use the Asset object to create custom fields as needed.

◦ Opportunities

Use the Opportunity object to create custom fields as needed.

◦ Leads

Use the Lead object to create custom fields as needed.
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◦ Relationships

Use the Relationship object to create custom fields as needed.

◦ Notes

Use the Note object in Application Composer to create custom fields as needed, and to extend this
subtab.

On the Application Pages tab for the Note object, edit the default creation page layout or duplicate it to
create a new layout.

The Notes list page isn't extensible.

◦ Activities

Use the Activity object in Application Composer to extend this subtab.

On the Pages tab for the Activity object, click Edit Embedded Summary Table (at the bottom of the
page).

◦ Conversations

Not extensible from this page.

Configure Default Search on Standard Subtabs for
Contacts  

When a user opens the subtab at runtime, the records displayed are automatically filtered using the search criteria you
added. Users can change the default search value, but they can't change the default search field. They can, however,
further refine their search by adding additional search fields and values at runtime.

Adding a default search filter to a subtab is optional. If you skip this step, then no search fields are automatically added
to the subtab, but users can still see the search region and perform their desired search.

Use this procedure to add a default search filter field, operator, and value for the Leads subtab search on the Edit
Contact page.

Note:  You can select only one default search filter for each subtab. When adding a default search filter to standard
subtabs, the search filter applies to all existing details page layouts with this subtab. Let's say you add a search filter to
the Lead subtab on an Contact details page layout. This means that the same search filter is added to the Lead subtab
on an Account details page layout.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer.
4. In the navigation tree, expand Standard Objects, expand Contact, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.
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The Details Layout page appears.
8. In the Subtabs Region, highlight Leads and click the pencil icon.
9. From the Configure Detail Form page region, go to the Configure Summary Table: Search Region.

10. Select the default search filter you want to apply to the Leads subtab.

You can select from a list of both standard and custom Lead fields. Note that you can't pick dynamic choice list
fields, set ID-based fixed choice list fields, and any fields that aren't searchable. Also, if this subtab was added
based on a many-to-many (M:M) relationship, then you can select from only those intersection object fields
that are already displayed on the subtab.

For example, you want to create a search filter to search for all qualified leads for a contact. Select Status from
the drop-down list and select Equals as the operator and then select the Qualified check box.

11. Click Done and ensure that the layout status for your Leads subtab layout is set to Active.
12. Test the changes: Navigate to Sales > Opportunities as a user with access to the contact pages, for example,

as a salesperson. Edit a contact and confirm that the data that displays on the Leads subtab includes only
qualified leads.

13. Publish the sandbox.

Extend Application Pages for Relationships  
Using Application Composer, you can change many items that appear on the application set of pages for relationships.

Use Application Composer to modify this page:

• Add Relationship page

This page is available from the Relationships subtab when you drill down from the application details pages for these
objects:

• Accounts

• Contacts

• Households

Add Relationship Page
You can modify the Add Relationship page which displays when you create a relationship from the Relationships subtab
on any Edit Account, Edit Contact, or Edit Household page. For example, you can hide standard relationship fields, make
a field required, add a default value, and show user-defined relationship fields. You can also reorder fields and change
field labels. To modify the Add Relationship page:

1. Navigate to the Relationship object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.

To enhance run time usability for your end users, optionally group user-defined fields into field groups.
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Enable Salespeople to Add Household Relations to an Account  
Let your salespeople add household or a group relation to an account. Here's how you enable:

1. In the Setup and Maintenance work area, use the Manage Standard Lookups task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page, search for ZCA_RECORD_TYPE.
3. In the Lookup Codes section, select the Enabled checkbox for Group.
4. Save and Close the page.

Household will appear as an option in the Add Relation button in the Relationships subtab of an Account edit
page.

981



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 44
Extend Accounts, Contacts, and Households

982



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 45
Extend Assets

45  Extend Assets

Extend Pages for Assets  
Using Application Composer, you can change many items that appear on the pages for assets.

Use Application Composer to modify these pages:

• Asset list page (includes a summary table of assets)

• Create Asset page

• Edit Asset page

These pages are available as subtabs when you drill down from the details pages for these objects:

• Accounts

• Contacts

• Households

Note:  Use the Asset object in Application Composer to create custom asset fields. Note that you can't add custom
buttons and actions to any page for assets.

Assets List Page
You can modify the Assets list page which displays when you first navigate to the Assets subtab on any Edit Account,
Edit Contact, or Edit Household page. For example, you can hide standard asset fields or show custom asset fields.

To modify the Assets list page which appears on the Assets subtab on the Edit Account, Edit Contact, or Edit Household
pages:

1. Navigate to the Account, Contact, or Household object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.
4. Select the Assets subtab to configure which standard and custom fields display at run time.

Use the Asset object to add custom fields as needed, before you can select them for display on the subtab.

Tip:  The changes you make to the Assets subtab are unique across the Edit Account, Edit Contact, and Edit
Household pages. For example, the changes you make to the Assets subtab on the Edit Account page aren't
reflected on the Assets subtab on the Edit Contact page.

Create Asset Page
You can modify the Create Asset page which displays when you create an asset from the Assets subtab on any Edit
Account, Edit Contact, or Edit Household page. For example, you can hide standard asset fields, make a field required,
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add a default value, and show custom asset fields. You can also reorder fields and change field labels. To modify the
Create Asset page:

1. Navigate to the Asset object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.

To enhance runtime usability for your end users, optionally group custom fields into field groups.

Edit Asset Page
You can modify the Edit Asset page which displays when you edit an asset from the Assets subtab on any Edit Account,
Edit Contact, or Edit Household page. For example, you can hide standard asset fields, make a field required, add a
default value, and show custom asset fields. You can also reorder fields and change field labels. To modify the Edit Asset
page:

1. Navigate to the Asset object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.

To enhance runtime usability for your end users, optionally group custom fields into field groups.

Related Topics
• Extend Application Pages for Assets Using Application Composer

Extend Application Pages for Assets Using Application
Composer  
This example demonstrates how you can modify application pages for assets using Application Composer.

In this example, you will see how to add the field Asset Number to the Create Asset page using Application Composer.
You will also test whether the field appears in the application page for creating an asset.

Note:  Ensure that you have the privileges to create and view an asset.

Extending Application Pages for Assets Using Application Composer
1. Navigate to Application Composer.
2. In the object tree, select the standard object, Asset, which includes a set of application pages.
3. Select the Pages node.
4. Select the Application Pages tab.
5. Use the links on the tab to navigate to the object's configuration pages, where you can modify the application

pages that are available for the selected object. You can show or hide fields, rearrange fields, and add your own
fields.
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6. For example, to add the field Asset Number to the Create Asset page, highlight a page layout in the Creation
Page Layouts table and click the Edit icon. You can also select Actions > Edit Layout..

7. On the Edit Application Creation Page, click the Edit icon (pencil icon) to modify the Create Asset page.
8. In the Available Fields list, double-click Asset Number to move it to the Selected Fields column. You can also

click the Right arrow button to move an item.

This figure shows the Available Fields and Selected Fields lists, which you use to hide and show fields on the run
time Create Asset page.

9. Click Save and Close.
10. Click Done.

Viewing the Changes in the Create Asset Page
In this section, we test whether the field Asset Number that we added to the Create Asset page appears at run time.

1. Login to the Application Pages main page and click Households.
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2. Select a household that has a customer type.

This figure shows the Household overview page with the details of the selected household.

3. Click the number in the Assets region.
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4. In the Edit Household page, click the Create Asset button.

This figure shows the Edit Household page for the selected item. You can create an asset from
this page. The Create Asset button is visible only if you have the Asset Creation privilege.

5. The field Asset Number that you added using Application Composer now appears at the bottom of the Create
Asset page.

This figure shows the Create Asset page with the field Asset Number that we added as part of extending the

Asset object.  

Related Topics
• Extend Pages for Assets
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46  Extend Activities

Extend Application Pages for Activities  
Use Application Composer to change the items that appear on the application set of pages for activities.

You can make changes to the following pages:

• Activities landing page

• Create Task

• Create Appointment

• Create Call Report

• Edit Task

• Edit Appointment

• Edit Call Report

• My Tasks

• My Appointments

• Activities subtab, available from the details pages of other objects, such as opportunity, account, contact, and
so on.

For example, you can:

• Hide or show existing fields.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Activities Landing Page
To extend the Activities landing page:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, in the Landing Page Layouts region, Activities area, copy the standard layout and

edit the resulting copy.
4. Edit the My Activity Overview Table page.

Create Task, Create Appointment, and Create Call Report Pages
To extend the Create Task, Create Appointment, and Create Call Report pages:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
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3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout for either the Create
Task, Create Appointment, or Create Call Report page to create a new layout to edit. Or, edit another existing
layout.
To enhance run time usability for your end users, optionally group custom fields into field groups.

Edit Task, Edit Appointment, and Edit Call Report Pages
The Edit Task, Edit Appointment, and Edit Call Report pages consist of multiple subtabs that display along the left side
of the page. You can modify most of these subtabs. You can also add custom subtabs to display records from child or
related objects, for example.

To extend the Edit Task, Edit Appointment, and Edit Call Report pages:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout for either the Edit Task,

Edit Appointment, or Edit Call Report page to create a new layout to edit. Or, edit another existing layout.
4. When making changes to the Edit Task, Edit Appointment, and Edit Call Report pages, select the subtab you

want to change first. The following subtabs are available from the Edit Task, Edit Appointment, and Edit Call
Report pages. Use the following subtabs to configure which standard and custom fields display at run time.

Tip:  The changes you make to these subtabs are unique across the Edit Task, Edit Appointment, and Edit
Call Report pages. For example, the changes you make to the Contacts subtab on the Edit Task page aren't
reflected on the Contacts subtab on the Edit Appointment page.

◦ Summary

◦ Contacts
Use the Activity Contact child object to add custom fields as needed, before you can select them for
display on the subtab.

◦ Resources
Use the Activity Assignee child object to add custom fields as needed, before you can select them for
display on the subtab.

◦ Notes
Use the Note object in Application Composer to create custom fields as needed, and to extend this
subtab.
On the Application Pages tab for the Note object, edit the default creation page layout or duplicate it to
create a new layout.
The Notes list page isn't extensible.

My Tasks Landing Page
To extend the My Tasks landing page:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, in the Landing Page Layouts region, copy the standard layout and edit the

resulting copy.
4. In the new layout, edit the My Tasks Overview Table

990



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 46
Extend Activities

My Appointments Landing Page
To extend the My Appointments page:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, in the Landing Page Layouts region, copy the standard layout and edit the

resulting copy.
4. In the new layout, edit the My Appointments Overview Table

Embedded Activities Subtab
To extend the Activities subtab, available from the details pages of other objects:

1. Navigate to the Activity object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, in the Embedded Activity Summary Layout > Embedded Task List Read Only

Overview Table or Embedded Task List Overview areas, copy the standard layout and edit the resulting copy.
4. In the new layout, edit the Embedded Task List Read Only Overview Table or the Embedded Task List

Overview Table.
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47  Extend Leads and Campaigns

Overview of Extending Sales Lead and Sales Campaign
Objects  
Read this chapter to learn about extending the sales lead and sales campaign objects and pages in your sales
application.

In this chapter, you will learn:

• How to modify leads pages

• How to extend the sales campaign object using Application Composer

• How to create a sales lead validation rule using Application Composer

• How to extend campaigns and leads using data from Oracle Marketing Cloud

• How to create new objects by copying existing objects using the Copy Map feature

• How to map child objects and attributes in the source object to objects and attributes in the new object

Related Topics
• How to Create a Sales Lead Validation Rule Using Application Composer

• Example of Modifying the Lead to Opportunity Copy Map

Sales Leads  

Extend Pages for Leads  
Using Application Composer, you can change many items that appear on the pages for sales leads.

Use Application Composer to modify these pages:

• Leads landing page (Landing Page Layouts)

• Create Lead page (Creation Page Layouts)

• Edit Lead page (Details Page Layouts)

• Lead Email notifications page (Lead Notification Content)

• Mass Lead Convert page (Mass Lead Convert Page Layouts)

• Lead Convert page (Lead Convert Page Layouts)

For example, you can:

• Hide or show standard fields.
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• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add user-defined fields (all types).

Note:  To extend the set of pages for leads, use the Sales Lead object in Application Composer. You must be working
in an active sandbox.

Leads Landing Page
You can extend items that appears on the Leads landing page. For example, you can hide standard fields or show user-
defined fields. To modify this page:

1. Navigate to the Sales Lead object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Landing Page Layouts, duplicate the standard layout to create a new

layout.

Create Lead Page
You can modify the Create Lead page. For example, you can hide standard fields, make a field required, add a default
value, and show user-defined fields. To modify the Create Lead page:

1. Navigate to the Sales Lead object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.

To enhance runtime usability for your end users, optionally group user-defined fields into field groups.

Edit Lead Page
The Edit Lead page consists of multiple subtabs that display along the left side of the page. You can modify most of
these subtabs. You can also add user-defined subtabs, for example, to display records from child or related objects.

To add user-defined fields to certain subtabs available from the Edit Lead page, you must first navigate to those subtab
target objects in Application Composer to create the fields. After creating the fields on the target object, you can then
navigate back to the details page layout for the Sales Lead object to add those fields to the specific subtabs.

To modify the Edit Lead page:

1. Navigate to the Sales Lead object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.
4. When making changes to the Edit Lead page, select the subtab you want to change first.

The changes you make to these subtabs are unique to the Edit Lead page. For example, you can extend the
Sales Lead Products directly by adding new user-defined fields, but if you want to display those new fields, or
hide existing fields for the Sales Lead Products object, you must navigate to the Sales Lead object, select Pages,
and then go to the Details Page Layout, Summary subtab, Lead Details Products area.
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Use these subtabs, available from the Edit Lead page, to configure which standard and user-defined fields
display at runtime.

◦ Summary

◦ Contacts

Use the Sales Lead Contact object to create user-defined fields as needed.

◦ Qualification

Not extensible from this page.

◦ Sales Team

Use the Sales Lead Resources object to create user-defined fields as needed.

◦ Products

Use the Sales Lead Products object to create user-defined fields as needed.

◦ Activities

Use the Activity object in Application Composer to extend this subtab.

On the Application Pages tab for the Activity object, scroll down to the Embedded Activity Summary
Layout section at the bottom of the page. Click the Standard layout or duplicate it to create a new layout.

◦ Responses

Not extensible from this page.

◦ Notes

Use the Note object in Application Composer to create user-defined fields as needed, and to extend this
subtab.

On the Application Pages tab for the Note object, edit the default creation page layout or duplicate it to
create a new layout.

The Notes list page isn't extensible.

◦ Opportunities

Use the Opportunity object to create user-defined fields as needed.

Lead Email Notifications
The email notifications region is applicable only for partner leads. From here, you can configure actionable email
content that's sent to users when partner leads are assigned. Use the Sales Lead object in Application Composer to
extend the email notifications of the partner lead UI. On the Application Pages tab for the Sales Lead object, scroll down
to the Lead Notification Content section at the bottom of the page. Click the Standard layout or duplicate it to create a
new layout.

Mass Lead Convert Page
Mass Lead Convert is a mass action available on Lead List page and is used for converting multiple selected leads
simultaneously. When a salesperson uses the mass lead convert action, the Lead Mass Convert page is displayed for
verification and input for the mass conversion process. You can add or remove standard or custom fields from the mass
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lead convert page to your requirement. On the Application Pages tab, under Mass Lead Convert Page Layouts, duplicate
the standard layout to create a new layout to edit. Or, edit another existing layout.

Lead Convert Page
Opportunity Name, Owner, Account and Primary Contact are exposed on the Lead Convert page. Account and Primary
Contact are predefined read-only fields but they become editable fields if the Account and Primary Contact are directly
typed into the lead and if they don't exist in the sales application.

You can add or remove standard or custom fields from the lead convert page to your requirement. On the Application
Pages tab, under Lead Convert Page Layouts, duplicate the standard layout to create a new layout to edit. Or, edit
another existing layout.

Related Topics
• Enable Mass Update of Records

Example of Extending Pages for Leads Using Application
Composer  
You can extend lead pages using Application Composer. You must make your changes in a sandbox, so you can test
them first.

This example demonstrates how you can extend the lead object by:

• Adding a check box to identify strategic leads

• Adding a Groovy script that checks if the size of the deal is greater than 1000 USD when a user saves a lead
with this check box selected. If the deal is smaller than this amount, then users are prevented from saving the
lead and receive an error message instead.

Create the Strategic Deal Check Box and Add the Groovy Script Validation Check
Here's how to create the Strategic Deal  check box and add the validation check:

1. Navigate to Application Composer. Select Sales Lead from the Objects panel.
2. Under the Lead object, select the Fields link.
3. Click the Create a custom field icon and, in the Select Field Type window, select Check box.
4. In the Create Check box Field page, enter "Strategic Deal" as the Display Label. Leave the rest of the fields with

their default values.
5. Click Save and Close.
6. Next augment this new check box with a Groovy script. When the user attempts to save a record with the check

box selected, then the script checks if the deal size is greater than 1000. If the deal size is less than 1000, then
the script displays an error and the lead isn't saved.

Here is the Groovy logic that you can use:

def retVal
if (StrategicDeal_c == 'Y')
{
 if (DealAmount >= 1000)
 {
 retVal = true
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 }
 else 
 {
 retVal = false
 } 
}

if (StrategicDeal_c
 == null || StrategicDeal_c
 == 'N')
{
 retVal = true
}
 return(retVal)

7. In the Objects panel, select Server Scripts under the Sales Lead object.
8. In the Server Scripts Sales Lead page, select the Validation Rules tab and under Object Rules, select Action -

Add to add a new validation rule.
9. In the Create Object Validation Rule page, enter the rule name as Eval and enter a simple error message in the

Error Message text region.
10. Cut and paste the script that you have written to validate the condition.
11. Next add this field to the sales lead application pages. In Application Composer, select the Pages link under the

Sales Lead object and then select the Application Pages tab.
12. In the Details Page Layout region, duplicate the standard layout to create a new layout to edit.
13. Click the Edit pencil icon and select the Strategic Deal field.
14. Clock Done and save and close Application Composer.
15. Sign in to the application again and drill into a lead.
16. Check if the Strategic Deal check box appears.

This figure shows an example of the Edit Lead Summary page with the Strategic Deal check box selected.

17. Enter a value less than 1000 in the Deal Size field.
18. Select the Strategic Deal check box and click Save and Close.

You should receive the error message that you entered in Step 9 because the deal size violates the validation
rule.

19. Reenter a value greater than 1000 in the Deal Size field and save.

You have successfully extended a sales lead application page and added Groovy logic.
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Related Topics
• Overview of Sandboxes

How to Create a Sales Lead Validation Rule Using Application
Composer  
Lead management users can change the status of a lead to Qualified, regardless of whether the lead customer is a sales
account or has a primary product associated with the lead.

However, to enforce compliance with your company's lead management business processes, you want to create
business rules to control when to set a lead to a Qualified status.

This example describes how to use Application Composer to create a validation rule that ensures a sell-to address and
a primary product exist before users change the lead's status to Qualified.

Create a Validation Rule for Sell-to Address
Here's how to create a rule that validates the existence of a sell-to addresses for a sales lead:

1. Navigate to Application Composer.
2. Select Sales to filter the object search.
3. From the Objects View, select Standard Objects, Sales Lead, Server Scripts.
4. Click the Object Functions tab, and then click the Add a New Object Function icon. The Create Object

Function page is displayed.
5. In the Function Name field, enter this name without spaces: isSellToExists.
6. In the Returns field, select Boolean.
7. In the Function Body area, enter the following: if(null != CustomerId){ def partySites = newView('Address');

def criteria = partySites.createViewCriteria(); def criteriaRow = criteria.createRow();

criteria.insertRow(criteriaRow); def criteriaItem = criteriaRow.ensureCriteriaItem('PartyId');

criteriaItem.setValue(CustomerId) partySites.appendViewCriteria(criteria) partySites.executeQuery();

while(partySites?.hasNext()) { def partySite = partySites.next(); def partySiteUses =

partySite?.getAttribute('PartySiteUse'); while (partySiteUses?.hasNext()) { def partySiteUse =

partySiteUses.next(); if ('SELL_TO' == partySiteUse?.getAttribute('SiteUseType')) { return true; } } } }

return false;

8. Click Validate.
9. Click Save and Close.

Create an Enforcement Rule for Primary Product
Next, you want to create a rule for enforcing the primary product association for the sales lead.

1. Click the Add a New Object Function icon to go to the Create Object Function page.
2. In the Function Name field, enter the this name without spaces: isPrimaryProductAssigned.
3. In the Returns field, select Boolean.
4. In the Function Body area enter the following: if((null != PrimaryInventoryOrgId && null !=

PrimaryInventoryItemId) || null != PrimaryProductGroupId) return true; else return false;

5. Click Validate.
6. Click Save and Close to return to the Server Scripts Sales Lead page.
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Create a Validation Rule for Lead Qualification
Next you want to create a validation rule that checks for the existence of a sell-to address and a primary product when a
user sets the Qualified status for a sales lead.

1. Click the Validation Rules tab and from the Object Rules area.
2. Click the Add a new validation rule icon.
3. In the Create Object Validation Rule page navigate to the Rule Name field and enter this rule name without

spaces: qualifyLead
4. In the Rule Definition area, enter the following: if(isAttributeChanged('StatusCode') &&

getAttribute('StatusCode') == 'QUALIFIED') return (isPrimaryProductAssigned() && isSellToExists()); else

return true;

5. In the Error Message area, enter this message text: Primary Product and Sell to Address are required for
qualifying a Lead.

6. Click Save and Close.
This completes the task of using Application Composer to create validation rules for the primary product and
sell-to address fields when qualifying a lead.

Test the Rules
Here's how to validate the rules:

1. Navigate to the Lead Qualification, Edit Lead  page.
2. From the Actions menu, select Qualify.

If the Primary Product and Sell to Address fields contain no data, you should receive the following error
message text:
Primary Product and Sell to Address are required for qualifying a Lead.

Example of Assigning Account Owner as the Owner of a Lead  
You can configure your sales application to automatically set a lead owner based on the owner of the associated
account.

For example, an employee in your organization who isn't a salesperson, has created a lead with an associated account.
You can use a Groovy script to automatically assign that lead to the salesperson who owns the associated account.

You are a sales administrator and your management has asked you to create a script to automate setting the account
owner as the lead owner after the lead is created or assigned. You can use Groovy scripts to cater for the these
scenarios:

• When a lead is created with an associated account and the assignment process is run

• When a lead is created without an account, but the account is added later and the assignment process is run

Note:  You can't set the account owner as the lead owner for leads created or updated using import management.

Set Account Owner as the Lead Owner After Lead is Created or Assigned
Here's how to set the account owner as the lead owner after the lead is created or assigned:

1. Sign in using the sales administrator role.
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2. Create a sandbox and activate it.
For more information about sandboxes, see the Overview of Sandboxes topic.

3. Navigate to Application Composer and expand Standard Objects, then Sales Lead and then click Server
Scripts.

4. Click the Triggers tab, and then click the Create icon in the Object Triggers  section.
5. Select the Before Insert in Database trigger type. Enter a name such as UpdatLeadOwnerOnCreate in the Trigger

Name field. Copy and paste the following content of the script to the Trigger Definition section:
if(nvl(CustomerId,null) != null)
{
 def account = newView('OrganizationProfile');
 def criteria = account?.createViewCriteria();
 def criteriaRow = criteria?.createRow();
 criteria?.insertRow(criteriaRow);
 def criteriaItem = criteriaRow?.ensureCriteriaItem('PartyId');
 criteriaItem?.setValue(CustomerId);
 account?.appendViewCriteria(criteria);
 account.executeQuery();
 if(account.hasNext())
 {
 def accRow = account.next();
 def leadResourceIterator = nvl(MklLeadResources,null);
 if(nvl(accRow?.OwnerPartyId,null) !=null)
 {
 setAttribute('OwnerId' , accRow?.OwnerPartyId);
 def resourceId = accRow?.OwnerPartyId;
 boolean alreadyOnSalesTeam = false;
 leadResourceIterator?.reset();
 for (; leadResourceIterator?.hasNext(); ) {
 def mklLeadResourcesVORowImpl = leadResourceIterator.next();
 Long existingResourceId = mklLeadResourcesVORowImpl.getAttribute('ResourceId');
 if (resourceId.equals(existingResourceId)) {
 alreadyOnSalesTeam = true;
 break;
 }
 }
 if(!alreadyOnSalesTeam) {
 def leadResourceVO = leadResourceIterator.createRow();
 leadResourceVO.setAttribute('LeadId',LeadId);
 leadResourceVO.setAttribute('ResourceId',resourceId);
 leadResourceVO.setAttribute('PrimaryFlag','Y');
 }
 }
 }
} 

6. Click Save and Close. Verify that you see the newly created trigger in the Object Triggers  section.
7. Next, click the Create icon in the Object Triggers  section to create another object trigger.
8. Select Before Update in Database trigger type. Enter a name such as UpdatLeadOwnerOnUpdate in the Trigger

Name field. Copy and paste the following content of the script to the Trigger Definition section:
 if(isAttributeChanged('LastAssignmentDate')){
 def account = newView('OrganizationProfile');
 def criteria = account?.createViewCriteria();
 def criteriaRow = criteria?.createRow();
 criteria?.insertRow(criteriaRow);
 def criteriaItem = criteriaRow?.ensureCriteriaItem('PartyId');
 criteriaItem?.setValue(CustomerId);
 account?.appendViewCriteria(criteria);
 account.executeQuery();
 if(account.hasNext())
 {
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 def accRow = account.next();
 def leadResourceIterator = nvl(MklLeadResources,null);
 if(nvl(accRow?.OwnerPartyId,null) !=null)
 {
 setAttribute('OwnerId' , accRow?.OwnerPartyId);
 def resourceId = accRow?.OwnerPartyId;
 boolean alreadyOnSalesTeam = false;
 leadResourceIterator?.reset();
 for (; leadResourceIterator?.hasNext(); ) {
 def mklLeadResourcesVORowImpl = leadResourceIterator.next();
 Long existingResourceId = mklLeadResourcesVORowImpl.getAttribute('ResourceId');
 if (resourceId.equals(existingResourceId)) {
 alreadyOnSalesTeam = true;
 break;
 }
 }
 if(!alreadyOnSalesTeam) {
 def leadResourceVO = leadResourceIterator.createRow();
 leadResourceVO.setAttribute('LeadId',LeadId);
 leadResourceVO.setAttribute('ResourceId',resourceId);
 leadResourceVO.setAttribute('PrimaryFlag','Y');
 }
 }
 }
}

9. Click Save and Close. Verify that you see the newly created trigger in the Object Triggers  section.
10. Thoroughly test these scenarios in your sandbox environment:

◦ When a lead is created with an associated account and the assignment process is run.

◦ When a lead is created without an account, but the account is added later and the assignment process is
run.

11. Publish the sandbox after successfully verifying your tests.

Related Topics
• Overview of Sandboxes

How to Modify the Leads UI for Sales Prospects  
Since leads for sales prospects represent contacts with potential buying interest, some customers want to hide the lead
name from the UI. Instead, they want to set the primary contact field as required, and use the primary contact as the
lead identifier.

Use application composer and object triggers to cater for these configuration tasks:

• Set the Primary Contact field as required

• Mark the name field as hidden in both the create and edit lead pages

• Automatically populate the lead name with the primary contact value when a lead is created and updated

Note:  Sign in using the sales administrator role and create a sandbox and activate it.
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Set Primary Contact Field as Required
Here's how to set the primary contact field as mandatory on the leads UI:

1. Navigate to Application Composer and expand Standard Objects, then Sales Lead and then click Fields.
2. Search for the Primary Contact field of type Dynamic Choice List.
3. From the Edit Standard Field: Primary Contact page, under the Constraints section, select the Required

check box.
4. Click Save and Close.

Hide the Name Field
Here's how to hide the Name field on the leads UI:

1. Navigate to Application Composer and expand Standard Objects, then Sales Lead and then click Pages.
2. Navigate to Sales Lead > Pages > Creation Page Layout > Create a Duplicate Layout page.
3. From the Creation Page Layout section, select Duplicate Layout from the Actions menu.
4. In the Duplicate Layout dialog, enter Default User-Defined Layout in the New Layout Name field.
5. Click Save and Edit.
6. Click the Edit icon to display the Configure Detail Form.
7. Move Name from Selected Fields list to Available Fields list.
8. Click Save and Close, then click Done.
9. Repeat steps 4 to 9 to edit the Details Page Layout section.

Populate the Lead Name with the Primary Contact Value
Here's how to populate the lead name with the primary contact value when a lead is created and updated:

1. Navigate to Application Composer and expand Standard Objects, then Sales Lead and then click Server
Scripts.

2. Click the Triggers tab, and then click the Add a new Trigger icon in the Object Triggers section.
3. In the Trigger field, select the Before Insert in Database trigger type.
4. In the Trigger Name field, enter a name, without spaces, such as UpdatLeadOwnerOnCreate.
5. Copy and paste the following content of the script to the Trigger Definition section:

if(PrimaryContactName == null)
{
 throw new oracle.jbo.ValidationException('Primary Contact is a required field. Please select a Primary
 Contact.') 
}
else
{
 setAttribute('Name',PrimaryContactName)
}

6. Click Save and Close.
Verify that you see the newly created trigger in the Object Triggers section.

7. Next, click the Add a new Trigger icon in the Object Triggers section to create another object trigger.
8. In the Trigger field, select the Before Update in Database trigger type.
9. In the Trigger Name field, enter a name such as UpdatLeadOwnerOnUpdate.

10. Copy and paste the following content of the script to the Trigger Definition section:
 if(PrimaryContactName == null)
{
 throw new oracle.jbo.ValidationException('Primary Contact is a required field. Please select a Primary
 Contact.') 
}
else if(isAttributeChanged('PrimaryContactName') && PrimaryContactName != null)
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{
 setAttribute('Name',PrimaryContactName)
}

11. Click Save and Close.
Verify that you see the newly created trigger in the Object Triggers section.

12. Thoroughly test all changes in your sandbox environment.
13. Publish the sandbox after successfully verifying your tests.

Add Customer Type to Leads List Page  
As part of the Lead Management feature for repeat business leads, salespeople use the Existing Account and Existing
Contact fields in the Leads UI which supports extensible picker features. In addition, the Existing Account field
represents the same field as an account, contact or household.

Here's how to add the Customer Type field to the Lead List page using Application Composer

1. Navigate to Application Composer from the Configuration category in the Navigator.
2. Expand the Sales Lead object that you want to add the field.
3. Click Pages and then select the Application Pages tab.
4. On the Details Page Layouts section, edit any custom layout. If none exists, then duplicate the standard layout

and edit the resulting custom layout.
5. Edit the Summary region.
6. Select the Customer Type field from the list in the Available Fields region and move it to the Selected Fields

region.
7. Click Save and Close.
8. Test the changes: Navigate to Sales > Leads as a user with access to the Leads List page, for example, as a

salesperson and ensure you can see the Customer Type field.
9. Publish the sandbox.

Related Topics
• Define Fields

• Overview of Sandboxes

Add the Browse Catalog Button to Edit Lead Page  
Sales administrators can add the Browse Catalog button to the edit lead page so that users can browse the sales catalog
and view the product hierarchy.

This lets salespeople browse the sales catalog while editing a lead and select and add products or product groups to the
lead.

Note:  Before you can add the Browse Catalog button to the edit lead page, the profile option Browse Sales Catalog in
Opportunities Enabled must be set to Y.

Use these steps to add the Browse Catalog button to the Edit Lead page.

1. Navigate to the Sales Lead object in Application Composer.
2. Ensure you're in a sandbox.
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3. Select the Pages node.
4. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit.
5. Select the Summary subtab on the Edit Lead page, scroll down to the Fuse Lead Details Products area, and

click the Edit icon.
6. From the Configure Detail Form: Buttons and Actions region, move the Browse Catalog item from the

Available Buttons area to the Selected Buttons area.
7. Click Save and Close.
8. On the Details Layout page, click Done.
9. Verify that you can see the Browse Catalog button on the Edit Lead Summary page for a draft lead.

10. Publish your sandbox.

Related Topics
• Enable Salespeople to Browse the Catalog

Configure Default Search on Standard Subtabs for Leads  
You can add default search criteria to standard subtabs for leads so that your salespeople can more easily find the
subtab data that's relevant to their daily activities.

When a user opens the subtab at runtime, the records displayed are automatically filtered using the added. Users can
change the default search value, but they can't change the default search field. They can, however, further refine their
search by adding additional search fields and values at runtime.

Adding a default search filter to a subtab is optional. If you skip this step, then no search fields are automatically added
to the subtab, but users can still see the search region and perform their desired search.

Use this procedure to add a default search filter field, operator, and value for the Contacts subtab search on the Edit
Lead page.

Note:  You can select only one default search filter for each subtab. When adding a default search filter to standard
subtabs, note that the search filter applies to all existing details page layouts with this subtab. Let's say you add a
search filter to the Lead subtab on an Opportunity details page layout. This means that the same search filter is added
to the Lead subtab on an Account details page layout.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, highlight Contacts and click the pencil icon.
9. From the Configure Detail Form page region, go to the Configure Summary Table: Search Region.

10. Select the default search filter to apply to the Contacts subtab.
You can select from a list of both standard and custom Contact fields. Note that you can't pick dynamic choice
list fields, set ID-based fixed choice list fields, and any fields that aren't searchable. Also, if this subtab was
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added based on a many-to-many (M:M) relationship, then you can select from only those intersection object
fields that are already displayed on the subtab.

For example, you want to create a search filter to search for all contacts that have a job title of sales manager.
Select Job Title from the drop-down list and select Equals as the operator and enter Sales Manager.

11. Click Done and ensure that the layout status for your Contacts subtab layout is set to Active.
12. Test the changes: Navigate to Sales > Leads as a user with access to the leads pages. Edit a lead and confirm

that the data that displays on the Contacts subtab includes only contacts with a job title of sales manager.
13. Publish the sandbox.

Related Topics
• Overview of Subtabs

Extend Lead-Related Actions for Workspace  
You can specify and modify some lead-specific actions that your salespeople can quickly access from Workspace. These
lead-related actions include the Assign Partner, Convert, Reject, Retire actions.

For example, you can modify the convert lead layout page and specify a reason and additional comment field for the
retire and reject lead actions.

Here's how to enable the Lead actions on Workspace.

1. Create a sandbox and navigate to the Smart Actions administration tool in Application Composer, under
Common Setup.

2. Using the Actions search box, look for the lead action that you want - Assign Partner, Convert, Reject, or Retire.
The action you selected for the lead is displayed.

3. Click the check box under the Enabled column to make available the selected action from the Workspace saved
searches.

4. If you make changes to predefined actions be sure to publish the sandbox, sign out of the application, and sign
back in.

5. Verify your changes in Workspace.
Here's how to extend the Convert action dialog box.

1. Create a sandbox and navigate to Standard Objects > Sales Lead > Pages in Application Composer.
2. In the Lead Convert Page Layouts section under the Application Pages tab, duplicate the Standard layout.
3. Edit the duplicated layout to extend the lead convert action with the changes you want.
4. Publish the sandbox, sign out of the application, and sign back in.
5. Verify your changes in Workspace.

Note:  Workspace requires a few moments to index new or modified information. For example, you perform a
successful lead to opportunity conversion and you notice that the lead record displays a status of Unqualified. Close
the list and in a few moments when indexing is complete for the converted lead record, return again and note that the
record status has changed to Converted.

Related Topics
• Manage Workspace Smart Actions

• Overview of Smart Actions
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Extend Search Region and Results for Leads  
You can extend the search and select dialog layout for leads in your Sales application. Use Application Composer to
modify and set custom values that suit your requirements for the search parameters in the lead extensible reusable
region.

By extending the search and select dialog layout for your leads, you can tailor your search to suit your own business
requirements.

Use this procedure to extend the search region and results for your leads search.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. Under the Reusable Regions section, duplicate the Search and Select Dialog Layout by highlighting the

standard layout and clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Edit Search and Select Layout page appears.
8. Next to the Search Region, click the pencil icon.
9. Under the Configure Search Region, select the fields to appear in the search region and move them from the

Available Fields area to the Selected Fields area.
10. Click Save and Close to return to the Edit Search and Select Dialog Layout page.
11. Next to the Search Results, click the pencil icon.
12. Under the Configure Detail Form, select the fields to appear in the search results and move them from the

Available Fields area to the Selected Fields area.
13. Click Save and Close.
14. Click Done and ensure that the layout status for your Search and Select Dialog Layout is set to Active.
15. Test the changes: Navigate to Sales >  Leads as a user with access to the leads pages. Perform a search for

leads and confirm that the fields you selected appear in the search and results region for your search.
16. Publish the sandbox.

Groovy Support to Make Reject Reason and Comment Fields
Mandatory  
You can use Groovy scripts to specify rules to force both the Reject Reason and Comment fields to be set as mandatory
fields for your lead records.

The following is a sample of code to insert before the Lead update trigger to ensure that salespeople enter a reject
reason and a comment for the lead:

if ((RejectReasonCode == null || RejectReasonCode == ''))
{
 throw new oracle.jbo.ValidationException('Reason is Mandate')
}
else if (RejectComment == null || RejectComment == '')
{
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throw new oracle.jbo.ValidationException('Comment is Mandate')
}
else
return true

For more information about Groovy scripting, see the Oracle Applications Cloud Groovy Scripting Reference.

Related Topics

Insert a Groovy Script to Prevent Users Creating Duplicate Leads  
Use a groovy script to prevent users from creating duplicate leads. You write groovy scripts using Application
Composer's expression builder, which appears in many places as you modify existing objects or create new custom
ones.

You can create a goovey script on the Sales Lead object in Application Composer to prevent salespeople from creating
duplicate leads by checking if the phone number or email for a lead already exists in your sales application.

The following is a sample of code to insert before the Lead update trigger to ensure that salespeople can't create
duplicated leads. The script checks against leads created over as period of 30 days but you can modify the script to
extend or limit the checks to a period of time of your choice.

def vo = newView('Lead')
def vc = newViewCriteria(vo)
def vcr = vc.createRow()
def vci_1 = vcr.ensureCriteriaItem('LeadId')
vci_1.setOperator('!=')
vci_1.setValue(LeadId)
def vci_2 = vcr.ensureCriteriaItem('LeadAging')
vci_2.setOperator('<')
vci_2.setValue(30)
def vci_3 = vcr.ensureCriteriaItem('PrimaryPhoneNumber')
vci_3.setOperator('=')
vci_3.setValue(PrimaryPhoneNumber)
def vci_4 = vcr.ensureCriteriaItem('ContactEmail')
vci_4.setOperator('=')
vci_4.setValue(ContactEmail)
vc.insertRow(vcr)
vo.appendViewCriteria(vc)
vo.executeQuery()
def count=vo.getEstimatedRowCount()
if (vo.hasNext()&& count>0){
 throw new oracle.jbo.ValidationException('A lead record with the same phone number and email already
 exists!')
} 

For more information about groovy scripting, see the Oracle Applications Cloud Groovy Scripting Reference.

Send Automatic Emails to New Lead Contacts  
When entering net new leads, salespeople can add brand new contacts who don't yet exist in the application. These new
contacts don't become "official" contacts until after leads are converted to opportunities.
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This means that, when activities are created for net new leads, the associated new contacts won't receive automatic
email notifications. You can, however, set up automatic email notification so that new contacts are kept informed of
important activities on the lead, such as new appointments.

Setting up automatic email notifications involves a few configuration steps on the Activity object:

1. Create an email template.
2. Create two custom fields.
3. Create an object workflow.

Let's look at these steps in detail.

Create the Email Template
Outside an active sandbox, create an email template on the Activity object.

1. In Application Composer, navigate Common Setup > Email Templates.
2. Click the Create icon.
3. Select the Activity object.
4. Enter a template name and then enter the template details, such as the email subject and body, for the desired

notification.
5. Click Save and Close.

Create Custom Fields
Next, create two custom fields on the Activity object. One field captures the new contact's email address. The other field
captures the type of Leads UI that the customer is using.

1. Enter a sandbox and, in Application Composer, navigate Standard Objects > Activity > Fields.
2. Click the Create a custom field icon.
3. Select the Formula option, then OK.
4. Create the email field on the Activity object:

Field Attribute Value

Field type
 

Formula (text type)
 

Display name
 

Lead Contact Email
 

API name
 

LeadContactEmail_c
 

Script
 

return LeadVOVA?.PrimaryContactEmailAddress;

 

Include in Service Payload check box
 

Selected
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5. Create the UI indicator field on the Activity object. You create the field to check the type of Leads UI that the
customer is using.

Field Attribute Value

Field type
 

Formula (text type)
 

Display name
 

Lead Simplified Indicator
 

API name
 

LeadSimplifiedIndicator_c
 

Script
 

return LeadVOVA?.SimplifiedLeadIndicator;

 

Include in Service Payload check box
 

Selected
 

Create the Object Workflow
Now that you've created the email template and custom fields on the Activity object, create an object workflow to send
automatic email notifications to new lead contacts.

1. Still inside your sandbox, in Application Composer, navigate Common Setup > Object Workflows.
2. Click Actions > Create.
3. Select the Activity object and enter the object workflow name.
4. Enter the condition that must be true before the object workflow executes:

if (LeadContactEmail_c != null && LeadSimplifiedIndicator_c == 'Y' ) {
return true;
} else {
return false;
}

5. In the Actions region, click Create next to Email Notification.
6. Enter the email notification name and details, including the email template that you previously created.
7. Click Save > Save and Close.

When a new activity is created on a lead, an automatic email notification will be sent if the lead was created in the
simplified UI with a brand new contact.

Enable Contact Phone for Leads Click-to-Dial Using Page
Composer  
Click-to-dial is a feature that supports outbound dialing directly from your sales application. Once enabled, salespeople
can perform outbound dialing through the contact phone numbers from sales lead pages.
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You can quickly and easily make an outbound call to a contact lead directly by clicking a phone icon enabled for click-
to-dial from the Leads UI. You use Page Composer to enable the contact phone field on the Summary area of the Edit
Leads page.

Here's how to add the click-to-dial icon for the Contact Phone field to the Edit Lead summary page using Page
Composer:

1. Sign in to the application as a user with the Sales Administrator job role. Or, sign in as a setup user.
2. Create and enter a sandbox by selecting Application Composer and Page Composer.
3. Activate a sandbox. The active sandbox name appears at the top of the page.
4. Navigate to Application Composer  >  Objects > Standard Objects  > Sales Lead >  Pages.
5. Under the Details Page Layouts section, highlight the Standard Layout record, then click Actions  >

Duplicate.
6. In the Duplicate Layout dialog window, enter a new layout name and click Save and Close.
7. Next, open Page Composer by selecting Page Composer from the Tools menu.
8. Click your user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.
9. With Page Composer in Direct Selection mode, in the Summary tab of the edit lead page, hover over the

Contact Country Code, Area Code, and Phone fields.
A colored box appears around each field and its label.

10. Click inside the box around the Contact Country Code, Area Code, and Phone fields.
11. A dialog box opens with two options:

◦ Edit Component

◦ Edit Parent Component.

12. Select the Edit Component option.
13. In the Component Properties dialog box, click the Children tab.
14. Select the check box next to the clickToDial item.
15. Click Apply.
16. Click OK and close Page Composer.
17. Publish the sandbox according to your company's business practices.

For more information about using Page Composer, see the Configuring and Extending Applications guide.

Related Topics
• Expose New Account and New Contact Fields for Leads

How to Add the Interactions History Subtab to Leads  
You can view interactions history associated with your leads through the Edit Lead: Interactions History subtab.

The Interactions History subtab is hidden by default but you can make it available to your users through Application
Composer.
Here's how to add the Interactions History subtab to the Edit Lead page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Leads, and click Pages.
5. Ensure that the Application Pages tab is selected.
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6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and clicking the
Duplicate icon.

7. Type a new layout name and click Save and Edit.

The Details Layout page appears.

8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.

9. Move Interactions History from the Available Subtabs to the Selected Subtabs window.
10.Click OK.
11. Click Save and Close.
12. Click Done and ensure that the layout status for your user-defined layout is Active.
13. Test the changes: Navigate to Sales > Leads as a user with access to the lead pages, for example, as a salesperson.

Edit a lead and ensure you can see the Interactions History subtab in the Edit Lead page.
14.Publish the sandbox.

For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Sales Campaigns  

Extend Sales Campaign Pages  
Use Application Composer to create user-defined fields for the sales campaign object. You can then add the user-
defined fields for display in the Sales Campaign work area. This topic describes the configurable options for sales
campaigns.

Note:  For existing CX Sales and Fusion Service users of Sales Campaigns, Oracle plans to decommission this feature
over the next few releases. As alternatives, Oracle recommends that you plan to use Engage Sales Tool by Oracle
Eloqua, and Integration between CX Sales and Eloqua, as you will no longer be able to use the Sales Campaign
functionality once discontinued.

To access Application Composer, select Application Composer from the Navigator menu, under the Configuration
category.

Quick Steps
Here's how to configure the sales campaign work area:

1. Navigate to Application Composer, expand the Standard Objects tree node, then select Sales Campaign.
2. Select the Fields node to create user-defined fields, or modify standard fields.
3. Select the Pages node to show or hide fields, either user-defined or standard.
4. Use the links on the tab to navigate to the object's configuration pages. From there, you can configure the

pages that are available for the selected object.

Note:  You must duplicate the standard layouts before you can make changes.
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5. Test your work by navigating to the Sales Campaign work area to view your changes.

Sales Campaign Pages That Are Configurable
The number of fields that you can edit or add to this region depends on the status of the sales campaign. The panel
will adjust based on how many fields you add. The name of the region changes depending on where you're in the sales
campaign flow.

This list shows which regions and pages are configurable, along with some notes for each.

Region and Page Are the Fields Editable?

Sales Campaign landing page
 

No
 
 

Campaign details region on the Create
Sales Campaign: Wrap Up page
 

Yes
 

Campaign details region (displays on Sales
Campaign Overview pages for completed
campaigns)
 

No
 

Campaign details region (displays on Sales
Campaign Overview page for campaigns
that are in progress)
 

No
 

Campaign Summary region on the Create
Sales Campaign: Enter Campaign Details
page
 

Yes
 

Campaign Summary regions on other
Sales Campaign pages
 

Only if the campaign is in Draft status. Otherwise, not editable.
 

Campaign Details region (displays on
Sales Campaign pages for completed
campaigns)
 

No
 

Add or Modify Object Fields
To add user-defined fields to the Sales Campaign regions listed, first create your user-defined fields by selecting the
Fields node under the sales campaign object. Then, select either a standard field to modify, or create a user-defined
field.

For standard fields, you can modify these options:

• Display Label

• Required check box

• Short Description

• Updatable

• Depends On
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Add Your Changes to the Runtime Application
After you create user-defined fields for the sales campaign object, use Application Composer's configuration pages to
add the user-defined fields to the configurable regions. You access the configuration pages in Application Composer
from the Pages node under the Sales Campaign object.

To access the Pages Overview page:

1. Navigate to the application Composer Overview page.
2. In the object tree, select the Sales Campaign object.
3. Select the Pages node.
4. On the Pages tab, select the configuration page link related to the Sales Campaign page that you want to

configure.

Notes About Sales Campaign Configuration
These configuration options aren't supported for sales campaigns:

• Import and export (you can't import sales campaigns)

• Object workflow

• E-mail templates

• Business processes

These configuration options don't apply to sales campaigns:

• Role security

• Subject areas

Related Topics
• Define Fields

• Overview of Sales Campaigns

Marketing Campaigns and Campaign Members  

Overview of Campaign Management and Reporting  
You can store marketing related data, such as campaigns and campaign members created and updated in Oracle
Marketing Cloud, also called Oracle Eloqua, in your sales application.

Campaign management and reporting is greatly improved by having campaign related data maintained and
synchronized between Oracle Marketing Cloud and Oracle CX Sales.

You can view meaningful information about marketing campaigns and campaign members from the Campaigns user
interface. The Campaigns UI provides visibility into the campaign effectiveness to support the sales processes. For
example, you can view the campaigns and campaign members associated with a given lead and contact to gain key
insights for closing a sale.
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In addition, your administrator can also display a campaigns subtab and an Add to Campaign button
on the Leads and Contacts user interface pages from where you can view data about the marketing
campaigns and add the associated leads and contacts to the campaign. The functional security privilege
MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER must be assigned to the intended user or their role.

Note:  If you want users to have access only to Marketing Campaigns without granting them additional roles to
other objects, then you can create a custom access group. Access groups are an alternative way of granting data
permissions to users, and they use a different access path to that provided by the predefined data security policies.
For more information, see the Create a Custom Access Group topic in the Securing Sales and Fusion Service guide.

The topic describes how to create an access group, create object sharing rules to give group members access to object
data, and add members to the group. For the object sharing rules, use the All Marketing Campaigns predefined rule
which gives full access to campaign records. You can create a group membership rule to add members to your access
group based on user name, role, organization and so on. For more information, see the Create Membership Rules for
Custom Access Groups topic in the Securing Sales and Fusion Service guide.

You can add contacts or leads to marketing campaigns from these locations within your sales application:

• Campaigns subtab on the Edit Contact page

• Campaigns subtab on the Edit Lead page

• Campaign Members subtab on the View Campaign page

• Contact and Lead saved search pages in Workspace

Use the campaign summary data to view associated leads, contacts, opportunities, and revenue amounts. You can add
contacts and leads to marketing campaigns, and view only already added contacts or leads through the Campaign
Members subtab. The total number responding to a campaign represents the total count of campaign members who
have responded to a marketing campaign and can only be viewed from the Analytics subtab. Campaign members
include either leads or contacts that were sent or responded to a marketing campaign and have a status of Responded
or Sent. Note that the response is only counted once even when a campaign member has responded multiple times to
the same campaign.

Related Topics
• Enable the Campaigns Subtab and Add to Campaign Button in Leads

• Enable the Campaigns Subtab and Add to Campaign Button in Contacts

• Enable the Campaign Analytics Tab in Campaigns List Page

• About Campaign Management Reports

Enable the Campaigns Subtab and Add to Campaign Button in
Leads  
View campaigns associated with your leads through the Edit Lead: Campaigns subtab. The Campaigns subtab and the
Add to Campaign button are hidden by default but you can make them available to your users through Application
Composer.

Users can then filter the Campaigns subtab by the following attributes: Name, Type, Start Date, End Date, Last Updated,
and Status.
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Before you expose the Campaigns subtab list and the Add to Campaign button in the Edit Lead page, ensure that the
functional security privilege MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER is assigned to the
intended user or their role. Alternatively, if you want users to have access only to Marketing Campaigns without granting
them additional roles to other objects, then you can create a custom access group as outlined in the Create a Custom
Access Group topic in the Securing CX Sales and B2B Service guide.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Campaigns from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. In the Subtabs Region, select the newly added Campaigns subtab icon.
12. Click the pencil icon next to the Fuse Lead Campaign Overview Region.
13. From the Configure Detail Form: Buttons and Actions region, move Add to Campaign from the Available

Buttons to the Selected Buttons window.
14. Click Save and Close.
15. Click Done and ensure that the layout status for your user-defined layout is Active.
16. Test the changes: Navigate to Sales > Leads as a user with access to the leads pages, for example, as a

salesperson. Edit a lead and ensure you can see both the Campaigns subtab and the Add to Campaign button
in the Edit Leads page.

17. Publish the sandbox.
For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Campaign Management and Reporting

• Enable the Campaigns Subtab and Add to Campaign Button in Contacts

• Enable Campaign Members Subtab, Add Leads, and Add Contacts Buttons in Campaigns

• Overview of Sandboxes

Enable the Campaigns Subtab and Add to Campaign Button in
Contacts  
You can view campaigns associated with your contacts through the Edit Contacts: Campaigns subtab. The Campaigns
subtab and the Add to Campaign button are hidden by default but you can make them available to you users through
Application Composer.

They can then filter the Campaigns subtab by the following attributes: Name, Type, Start Date, End Date, Last Updated,
and Status.
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Before you expose the Campaigns subtab list and the Add to Campaign button in the Edit Contact page, ensure that
the functional security privilege MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER is assigned to the
intended user or their role. Alternatively, if you want users to have access only to Marketing Campaigns without granting
them additional roles to other objects, then you can create a custom access group as outlined in the Create a Custom
Access Group topic in the Securing CX Sales and B2B Service guide.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Contact, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, go to the Edit Contact  region and duplicate the standard layout by

highlighting the standard layout and clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Campaigns from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. In the Subtabs Region, select the newly added Campaigns subtab icon.
12. Click the pencil icon next to the Fuse Contact Campaign Overview Region.
13. From the Configure Detail Form: Buttons and Actions region, move Add to Campaign from the Available

Buttons to the Selected Buttons window.
14. Click Save and Close.
15. Click Done and ensure that the layout status for your user-defined layout is Active.
16. Test the changes: Navigate to Sales > Contacts as a user with access to the contacts pages, for example, as a

salesperson. Edit a contact and ensure you can see the Campaigns subtab and the Add to Campaign button in
the Edit Contacts page.

17. Publish the sandbox.
For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Campaign Management and Reporting

• Enable the Campaigns Subtab and Add to Campaign Button in Leads

• Enable Campaign Members Subtab, Add Leads, and Add Contacts Buttons in Campaigns

• Overview of Sandboxes

Enable Campaign Members Subtab, Add Leads, and Add Contacts
Buttons in Campaigns  
You can add contacts and leads to marketing campaigns, and view already added contacts or leads through the
Campaign Members subtab.

The Campaigns Members subtab, in addition to the Add Leads and Add Contacts buttons, are hidden by default but
you can make them available to your users through Application Composer.
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Here's how to expose the Campaign Members subtab in the View Campaign page. The steps also include how to expose
the Add Leads and Add Contacts buttons in the Campaign Members subtab.

Note:  Make sure that the functional security privilege
MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER is assigned to the intended user or their role.
Alternatively, if you want users to have access only to Marketing Campaigns without granting them additional roles
to other objects, then you can create a custom access group as outlined in the Create a Custom Access Group topic in
the Securing CX Sales and Fusion Service guide.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Campaigns, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Campaign Members from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
Follow the next steps to expose the Add Leads and Add Contacts buttons in the Campaign Members subtab.

11. In the Subtabs Region, select the newly exposed Campaign Members icon.
12. Click the pencil icon next to the Campaign Member Region.
13. From the Configure Detail Form: Buttons and Actions region, move both the Add Leads and Add Contacts

from the Available Buttons to the Selected Buttons window.
14. Click Save and Close.
15. Click Done and ensure that the layout status for your user-defined layout is Active.
16. Test the changes: Navigate to Sales > Campaigns as a user with access to the campaign pages, for example,

as a salesperson. View a campaign and ensure you can see the Campaign Members subtab and the Add Leads
and Add Contacts button in the View Campaign page.

17. Publish the sandbox.
For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Related Topics
• Enable the Campaigns Subtab and Add to Campaign Button in Leads

• Enable the Campaigns Subtab and Add to Campaign Button in Contacts

Add Contacts and Leads from Your Workspace to Oracle
Marketing Cloud  
Salespeople can select contacts or leads from their Workspace saved searches and add them as campaign members
to marketing campaigns. After the added contacts and leads are synchronized to the Marketing Cloud (Oracle Eloqua),
they get added to the specified Oracle Eloqua marketing campaigns.
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Before you start to add contacts and leads from your Workspace to Oracle Eloqua, ensure that the functional security
privilege MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER is assigned to the intended user or their
role. Alternatively, if you want users to have access only to Marketing Campaigns without granting them additional roles
to other objects, then you can create a custom access group as outlined in the Create a Custom Access Group topic in
the Securing CX Sales and Fusion Service guide.

Note:  You must set up the Campaign Member Import in the Oracle Sales Cloud Integration App in Oracle Eloqua. This
enables Oracle Eloqua to synchronize the campaign members (leads and contacts) from your sales application.

1. Create a sandbox and navigate to the Smart Actions administration tool in Application Composer, under
Common Setup.

Smart actions are actions that are specifically mapped to a client application, such as Workspace, and displayed
to users only when specific conditions are met.

2. Using the Actions search box, look for the Add to Campaign action.

Two system actions are displayed: one for the Contact object and one for the Lead object.
3. For each of the objects, select the Enabled check box.
4. Verify that the Add to Campaign action is available for both Contacts and Leads saved searches in Workspace.

Enable the Campaign Analytics Tab in Campaigns List Page  
You can view reports associated with marketing campaigns through the Analytics side tab from the Campaigns list
page. The Analytics tab is hidden by default but you can make it available to your users through the Structure tool.

You can then filter the Analytics tab to display which user-defined or predefined campaign related reports to display to
campaign users.

Here's how to expose the Analytics tab in the Campaigns list page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Structure, in the Configuration category.
4. In the Structure page, ensure that the Navigation Configuration tab is selected.
5. Expand the Sales node and click Campaigns.
6. From the Edit Page Entry: Campaigns page, select Tabs.
7. On the Campaign ROI Analytics row, change the value for visible column to Yes.
8. Test the changes: Navigate to Sales > Campaigns as a user with access to the campaigns pages, for example,

as a salesperson. View the campaign and ensure you can see the Analytics side tab in the Campaigns list page.
9. Publish the sandbox.

Here's how to expose the user-defined Analytic subtabs in the Edit Campaign page.

1. Navigate to Application Composer, in the Configuration category.
2. In the navigation tree, expand Standard Objects, expand Campaigns, and click Pages.
3. Ensure that the Application Pages tab is selected.
4. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
5. Type a new layout name and click Save and Edit.

The Details Layout page appears.
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6. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
7. Move Analytics from the Available Subtabs to the Selected Subtabs window.
8. Click OK.
9. Back in the Details Layout page, click Done.

10. Be sure that the layout status for your user-defined layout is Active.
11. Test the changes: Navigate to Sales > Campaigns as a user with access to the campaigns pages, for example,

as a salesperson. View the campaign and ensure you can see the Analytics side tab in the Campaigns list page.
12. Publish the sandbox.

For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Sandboxes

Marketing Cloud Data  

Overview of Oracle CX Sales Configuration  
You can extend leads and contacts in Oracle CX Sales to show the activity data collected by Oracle Marketing Cloud.
This provides important marketing context to your sales representatives when they're perusing leads and contacts in
CX Sales.

You can expose the Digital Profile Infolets to show highlights of the activity data. You can also configure Digital Profile
and Interaction Data in CX Sales to leverage the Eloqua Profiler and Eloqua Engage sales tools. These tools enable you
to gain deeper insights into contact profiles to effectively use marketing collateral in outbound sales communications.

You must have the Sales Administrator job role, and the Resource and Employee abstract roles, to access the integration
functionality and perform the configuration tasks described in the following sections. The Sales Administrator job role is
required to access Personally Identifiable Information (PII), such as email, or mobile phone data.

Note:  Use the Manage Users work area, and not the Security Console, for creating Sales Cloud users. For information
about creating users and provisioning them with the required job roles, see the Securing CX Sales and Fusion Service
guide.

Related Topics

Options for Accessing Digital Data in Oracle Marketing Cloud  
The integration enables you to access digital activity data maintained for users in Marketing Cloud from the CX Sales UI.
Here are your options:

• Display an embedded Digital Profile infolet on the Contact - Overview page to display digital activity data for a
contact.
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This infolet comes with the integration but must be made visible in the UI using Application Composer. For
information, see the topic, How You Configure Access to the Digital Profile Infolet.

• Extend the integration by creating custom links to Oracle Eloqua Profiler for leads and to Oracle Eloqua Engage
for contacts and leads, and then embed the links in the CX Sales UI.

For information, see the Digital Profile and Interaction Data section.

Requirements for Accessing Digital Data
To view the digital profile infolets, you must have:

• User login accounts in both Oracle CX Sales and Oracle Marketing Cloud.

• The same email for use in both Marketing and CX Sales applications.

For information see the topic, How You Configure Access to the Digital Profile Infolet.

How You Configure Access to the Digital Profile Infolet  
You can enable the optional Digital Profile infolet to display on the CX Sales Edit Contact - Overview page.

The Digital Profile infolet shown in the following figure displays summary information about a contact's digital activities,
such as the number of websites visited or form submissions made. These activities are captured by Eloqua (Oracle
Marketing Cloud). You can also drill down on each activity type to access the Digital Profiler tool in Marketing Cloud

where detailed information for each activity is available.  
To enable the Digital Profile infolet functionality you perform the following two steps:

• Set up a connection to Marketing Cloud.

• Display the infolet using Application Composer.

Both tasks are described in the following sections.

Note:  Before you enable the Digital Profile infolet, make sure that the Dhttps and JSSE settings are enabled on your
environment.
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Set Up a Connection to Oracle Marketing Cloud  
In Oracle CX Sales, perform the following steps to set up a connection to Oracle Marketing Cloud.

1. Sign in as a sales administrator or as a setup user.
2. Navigate to the Setup and Maintenance work area.
3. Select the Sales offering, then search for the Manage Oracle CX Sales to Oracle Eloqua Integration task.
4. Select the task in the search results list, and then click OK.
5. Enter the values for the fields shown in this table to set up the connection to Marketing Cloud.

Field Value

URL
 

If you're using Oracle CX Sales Release 12, patch bundle 10 or later, you must specify the
following URL: https://login.eloqua.com
 

Security Policy
 

For example: oracle/wss_username_token_over_ssl_client_policy
 

User name
 

Enter the company name and user name used to connect to Oracle Marketing Cloud in the
following format: Company_Name\User_Name
 
The user you specify must have a license for Oracle Eloqua Profiler and Oracle Eloqua Engage if
you're configuring access to data from these tools.
 

Password
 

The password used to connect to Oracle Marketing Cloud.
 

Display the Digital Profile Infolet on the UI  
Here's how to make the Digital Profile infolet visible on the Contact Overview page using Application Composer.

1. Sign in as a sales administrator or as a setup user.
2. Navigate to the Application Composer work area (Navigator > Configuration > Application Composer).
3. In the Objects area, expand Standard Objects, then expand the node for the Contact object and select Pages.
4. On the Application Pages tab, navigate to the Detailed Page Layouts section.
5. Edit the Default layout (or make a copy of the default layout if you prefer).
6. In the Subtabs region, select the Overview icon (the first icon in the list).
7. Click the Create Infolet Group icon, which is located near the end of the page.
8. On the Create Infolet Group page, enter a name for the new infolet in the Infolet Group Name field, for

example, Digital Activities, or Digital Profile.
9. Shuttle the following infolets from the Available Infolets region to the Displayed Infolets region:

◦ Form Submissions
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◦ Website Visits

◦ Opened E-Mail
10. Click Save and Close.
11. Test your changes in the sandbox before publishing. For more information about sandboxes, see the topic

Overview of Sandboxes in the Configuring Applications Using Application Composer guide.

Related Topics
• Overview of Sandboxes

Digital Profile and Interaction Data  

Overview of Creating Custom Links  
You can create custom links in the Oracle CX Sales UI that users can click to access digital profile and interaction data
maintained in Oracle Marketing Cloud for a contact or lead. To enable this functionality, you must:

1. Create custom links to Oracle Eloqua Profiler and Oracle Eloqua Engage (Lead object) or to Oracle Eloqua
Engage (Contact object). For information, see the following topics:

◦ Create Custom Links for the Sales Lead Object

◦ Create a Custom Link for the Contact Object

Note:  You don't have to create a custom link to Oracle Eloqua Profiler for the Contact object because the
Digital Profile infolet provides this functionality. For information, see the Digital Profile and Interaction Data
section.

2. Add the custom links to the CX Sales UI. For information, see the following topics:
◦ Add Custom Links to the Sales Lead UI

◦ Add the Custom Link to the Sales Contact UI

Note:

Before you can access the responsive version of Profiler it must be installed in your Oracle Eloqua instance. Once
installed, your administrator can configure the options that Profiler provides. See the Oracle Eloqua Help Center for
more information.

You can embed the Eloqua Profiler and Eloqua Engage pages as subtabs in the CX Sales UI instead of creating links.
For information about creating subtabs, see the section on Subtabs in the Configuring Applications Using Application
Composer guide.

Create Custom Links for the Sales Lead Object  
Perform the steps in the following procedure to create custom links to Oracle Eloqua Profiler and Oracle Eloqua Engage
for the Sales Lead object.

1022

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20035520


Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 47
Extend Leads and Campaigns

1. Sign in as an administrator or as a setup user.
2. Navigate to the Application Composer work area (Navigator > Configuration > Application Composer).
3. In the Objects area, expand Standard Objects, and then expand the node for the Sales Lead Contacts object.
4. Select Actions and Links
5. Create the link to Eloqua Engage:

a. In the Sales Lead Contacts: Actions and Links area, click the Create icon.
b. Set the value of the Display Label field to Eloqua Engage.
c. Verify that the Name field is automatically set to Eloqua_Engage.
d. To indicate the Type of item you want to create, click the Link radio button.
e. In the Script region, click the New icon.
f. In the expression text box, enter the Oracle Eloqua Engage URL with arguments as follows:"https://

login.eloqua.com/autoLogin?LoginPrefix=<Your_Eloqua_Prefix>&Url=/apps/engage?

sendTemplateToConta'cts/" + nvl (PersonEmail,"no email")where <Your_Eloqua_Prefix> is the prefix of
your Oracle Eloqua instance.

g. Validate the script by clicking the Validate icon.
h. If the script validates successfully, click the Save button.

6. Create the link to Eloqua Profiler:

a. In the Sales Lead Contacts: Actions and Links area, click the Create icon.
b. Set the value of the Display Label field to Digital Profile.
c. Verify that the Name field is automatically set to Digital_Profile.
d. To indicate the Type of item you want to create, click the Link radio button.
e. In the Script region click the New icon.
f. In the expression text box, enter the Oracle Eloqua Profiler URL with arguments as follows:https://

login.eloqua.com/autoLogin?LoginPrefix=<Your_Eloqua_Prefix>&Url=/apps/profiler?emailAddress=" +

nvl(PersonEmail,"no email")where <Your_Eloqua_Prefix> is the prefix of your Oracle Eloqua instance.
g. Validate the script by clicking the Validate icon.
h. If the script validates successfully, click the Save button.

Add Custom Links to the Sales Lead UI  
Perform the steps in the following procedure to add the Eloqua Engage and Eloqua Profiler custom links you created for
the Sales Lead object to the Sales Lead UI.

1. In Application Composer, in the Objects area, expand Standard Objects, then expand the node for the Sales
Lead object.

2. Select Pages, and then click the Application Pages tab.
3. In the Details Page Layouts area, edit the Default Layout.
4. Edit the Summary area.
5. Move the custom links you created for Eloqua Engage and Eloqua Profiler from the Available Fields list to the

Selected Fields list, and position them as required.
6. Click Save and Close, and then Done.

You can view the custom links on the Sales Edit Lead UI as shown in the following figure.
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Create a Custom Link for the Contact Object  
Perform the steps in the following procedure to create a custom link to Oracle Eloqua Engage for the Contact object.

You don't have to create a custom link to Oracle Eloqua Profiler for the Contact object because the Digital Profile infolet
provides this functionality. For information, see the topic, How You Configure Access to the Digital Profile Infolet.

1. Sign in as a sales administrator or as a setup user.
2. Navigate to the Application Composer work area (Navigator > Configuration > Application Composer).
3. In the Objects area, expand Standard Objects, expand the node for the Contact object, and then select Actions

and Links.
4. Create the link to Eloqua Engage:

a. In the Contact: Actions and Links area, click the Create icon.
b. Set the value of the Display Label field to Eloqua Engage.
c. Verify that the Name field is automatically set to Eloqua_Engage.
d. To indicate the Type of item you want to create, click the Link option."https://login.eloqua.com/

autoLogin?LoginPrefix=<Your_Eloqua_Prefix>&Url=/apps/engage?sendTemplateToContacts/" +

nvl(PrimaryEmailAddress,"") where <Your_Eloqua_Prefix> is the prefix of your Oracle Eloqua instance. If
you don't know what your prefix is, contact Oracle Eloqua Product Support.

e. In the expression text box, enter the Oracle Eloqua Engage URL with arguments as follows:
f. Validate the script by clicking the Validate icon.

g. If the script validates successfully, click Save.

1024



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 47
Extend Leads and Campaigns

Related Topics

Add the Custom Link to the Sales Contact UI  
Perform the steps in the following procedure to add the Eloqua Engage custom link you created for the Contact object
to the CX Sales Contact UI.

1. In Application Composer, in the Objects area, expand Standard Objects, expand the node for the Contact
object, and then select Pages.

2. Click the Application Pages tab.
3. In the Details Page Layouts area, edit the Default Layout.
4. Edit the Summary area.
5. Move the custom link you created for Eloqua Engage from the Available Fields area to the Selected Fields area,

and position it as required
6. Click Save and Close, and then Done.

You can view the custom link on the CX Sales Edit Contact UI as shown in this figure.
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48  Extend Opportunities and Related Objects

Overview of Extending Sales and Opportunity
Management Objects  
Read this section to learn how to extend sales and opportunity management objects and pages.

You learn about how to:

• Extend each opportunity management object using Application Composer

• Modify opportunity management objects using Page Composer

Extend Pages for Opportunities  
Using Application Composer, you can change many items that appear in the pages for opportunities.

Use Application Composer to configure these pages:

• Opportunities landing page

• Create Opportunity page

• Edit Opportunity page

• Products table in the Edit Opportunity page

• These subtabs within the Edit Opportunity page:

◦ Activities

◦ Contacts

◦ Deal Registrations

◦ Leads

◦ Notes

◦ Partners

◦ Team

For example, you can:

• Hide or show standard fields.

• Hide or show standard actions and buttons.

• Add user-defined fields of all types.

• Set fields as required.

• Set field default values.

• Reorder columns.
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• Change column labels.

• Add user-defined actions and buttons.

High-Level Steps to Modify Opportunity Pages
Here are the high-level steps to make changes to the opportunity UI pages:

1. Activate a sandbox.
2. Navigate to the Application Composer.
3. Expand the Opportunity object tree.
4. In the Opportunity tree, click the Pages link.
5. Ensure that the Application Pages tab is active.
6. In the region that corresponds to the page you're modifying, duplicate the standard layout and edit the

resulting layout. For example, in the Details Page Layout region, duplicate the standard layout and then edit the
resulting layout. See the Configure Opportunity Pages section in this topic for details about which regions in the
Application Pages tab correspond to which opportunity pages.

7. In the new user-defined layout row, the Active check box will be automatically checked, indicating that the new
user-defined layout is active.

Note:  Since you have duplicated the standard layout, two layouts now display. When the application finds
more than one layout, it evaluates each layout at runtime, starting with the first layout in the table. If all
conditions are met for the layout, then it's displayed. If not, then the next layout is evaluated, and so on.

8. Save your changes.
9. Publish the sandbox.

Configure Opportunity Pages
This table shows the opportunity pages or subtabs that can be modified, along with the navigation steps to the areas
where you make the modifications.

All of these navigation steps assume the use of the Application Pages tab.

Opportunity Page Navigation

Landing (list) page
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Landing Page Layouts region, duplicate the standard layout and edit the resulting layout.

Create Opportunity Page
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Creation Page Layouts region, duplicate the standard layout and edit the resulting layout.

Edit Opportunity Page, Summary region
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Ensure the Summary subtab is active.
5. Edit the Summary region.

Edit Opportunity Page, Products table
 

Optionally, first add user-defined fields to the Opportunity Revenue object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
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Opportunity Page Navigation

4. Edit the Edit Revenue Table region.

Edit Opportunity Page, Contacts subtab
 

Optionally, first add user-defined fields to the Opportunity Contact object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Contacts subtab.
5. Edit the Contacts subtab.

Edit Opportunity Page, Team subtab, Team
view
 

Optionally, first add user-defined fields to the Opportunity Team Member object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Team subtab.
5. Edit the Fuse Opportunity Team region.

Edit Opportunity Page, Team subtab,
 Territories view
 

Optionally, first add user-defined fields to the Sales Territory object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Team subtab.
5. Edit the Territories region.

Edit Opportunity Page, Partners subtab
 

Optionally, first add user-defined fields to the Opportunity Partner object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Partners subtab.
5. Edit the Partners subtab.

Edit Opportunity Page, Deal Registrations
subtab
 

Optionally, first add user-defined fields to the Opportunity Deal object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Deal Registrations subtab.
5. Edit the Deal Registrations subtab.

Edit Opportunity Page, Activities subtab
 

You must use the Activity object in Application Composer to extend this subtab.
 

1. Navigate to the Activity object.
2. Click Pages and ensure the Application Pages tab is active.
3. In the Embedded Activity Summary Layout region at the bottom of the page, duplicate the

standard layout and edit the resulting layout.

Edit Opportunity Page, Notes subtab
 

You must use the Notes object in Application Composer to extend this subtab.
 

1. Navigate to the Notes object.
2. Click Pages and ensure the Application Pages tab is active.
3. Duplicate the standard layout and edit the resulting layout.

The Notes list page isn't extensible.
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Opportunity Page Navigation

Edit Opportunity Page, Leads subtab
 

Optionally, first add user-defined fields to the Sales Lead object.
 

1. Expand the Opportunity object.
2. Click the Pages link.
3. In the Details Page Layouts region, duplicate the standard layout and edit the resulting layout.
4. Click the Leads subtab.
5. Edit the Fuse Lead Overview table.

These Assessments subtab isn't configurable.

Related Topics
• Overview of Application Pages

Example of Extending Pages for Opportunities Using
Application Composer  
This example demonstrates how you can modify pages for Opportunities using Application Composer.

Extending Pages for Opportunities Using Application Composer
1. Navigate to the Application Composer Overview page.
2. In the object tree, select a standard object that includes a set of pages, such as Opportunity.
3. Select the Pages node.
4. Select the Application Pages tab.
5. Use the links on the tab to navigate to the object's configuration pages, where you can modify the pages that

are available for the selected object. You can show or hide fields, rearrange fields, and add your own fields.
6. For example, if you want to add the field 'Budget Amount' to the Create Opportunity page, select a layout in the

Creation Page Layouts region. Click the Edit icon or select Actions > Edit Layout
7. In the Edit Application Page Creation  page, select the Edit icon in the Opportunity Create region
8. In the Configure Detail Form region of the Opportunity Create page, move the Budget Amount field from the

Available Fields to the Selected Fields list.
9. Click Save and Close.

Make Changes to Competitors Pages  
Competitors pages are available from the Navigator by selecting the Competitors menu item. You can use Application
Composer to change look of the these pages.
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Competitors Pages and Navigation
Here are the extensible pages and regions for the Sales Competitor object, along with the navigation to the
configuration pages.

Competitors Page Competitors Region Navigation

Competitors Overview page
 

Competitors list region
 

1. Select the Sales Competitor object.
2. Click the Pages link.
3. Click the Desktop Pages tab.
4. Click the Edit Summary Table link.

Create Competitor page
 

Details region
 

1. Select the Sales Competitor object.
2. Click the Pages link.
3. Click the Desktop Pages tab.
4. Click the Edit Creation Page link.

Edit Competitor page
 

Details region
 

1. Select the Sales Competitor object.
2. Click the Pages link.
3. Click the Desktop Pages tab.
4. Click the Edit Summary Form link.

For more details about adding fields, see the topics on adding fields using Application Composer.

Create New Competitor Fields
If you want to put more fields on Competitors competitor pages, then you first create them. Here's an example of how to
do that:

1. Navigate to Configuration > Application Composer.
2. In the Objects tree, under Standard Objects, expand the object tree for the object you're modifying. For

example, expand the Sales Competitor tree.
3. Click the Fields node for the object.
4. Click the Custom tab.
5. Click the Create icon, or select Create from the Actions menu.
6. Select the type of field you're creating. For example, select Text as the type for a text entry field.
7. Click OK.
8. In the Appearance area, enter a Display Label for the new field. Set other optional attributes as desired.
9. In the Name area, enter an internal name for the field. The application prepopulates one based on your entry in

the Display Label field, but you can override the default value. Ensure there's no space in an internal name.
10. Optionally, in the Constraints area, enter additional parameters for the field. For example, make the field a

required field.
11. Optionally, in the Default Value region, enter a default value for the field.
12. Click Save and Close.

Modify Competitors Pages
Now that you have added your fields, here's how add them to the Competitors pages or regions.

1. Navigate to Configuration > Application Composer.
2. In the Objects tree, under Standard Objects, expand the Sales Competitor object tree.
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3. Click the Pages node for the Sales Competitor object.
4. All competitor pages are located under the Desktop Pages tab. Click the Desktop Pages tab.
5. Click the page you want to change and make the changes. See the Competitors Pages and Navigation section

above for more information on which pages are extensible.
6. Save your changes.

Duplicate Display Names for Fields
When you configure Competitors pages, in the Available Fields list, some field display names appear to be duplicates.
For example, you may see two fields for Primary Competitor. The names you see in the list are display names only; each
has an underlying name, which is its actual name. To see the underlying name of the field, hover your mouse pointer
over the field name. The hover text displays the actual name of the field.

Related Topics
• About Application Composer

• Overview of Sandboxes

Example of Modifying Your Object to Validate
Assessments  
Use this example to learn how to modify your account, lead, contact, or opportunity to validate that a specified
assessment template is completed, using Groovy scripts in Application Composer.

In this example, you're a sales administrator and you want to ensure that sales representatives complete the assessment
template Discount Eligibility before they set an opportunity to Won.

Validating Assessment Using Scripting
To ensure that sales representatives always fill in the Discount Eligibility Assessment template before closing an
opportunity:

1. Sign in as a sales administrator.
2. Create and activate a sandbox.
3. Navigate to Application Composer.
4. From the Applications list, select Sales.
5. Expand Standard Objects, and then expand Opportunity.
6. Click Server Scripts.
7. On the Server Scripts Opportunity page, select Triggers.
8. In the Object Triggers region, click the Add a new Trigger icon.
9. On the Create Object Trigger page, select Before Update in Database from the Trigger list.

10. Enter a trigger name.
11. Enter the following script in the Trigger Definition region.

def optyStatusCode = getAttribute('StatusCode')
if (optyStatusCode == 'WON') {
 
 def id = getAttribute('OptyId')
 def vo = newView('AssessmentVO')
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 def vc = vo.createViewCriteria()
 def vcr = vc.createRow()
 def vci = vcr.ensureCriteriaItem('AssessedObjectId')
 vci.setOperator('=')
 vci.setValue(id)
 vc.add(vcr)
 vo.appendViewCriteria(vc)
 vo.executeQuery()
 def completedMandatoryAsmnt = false;
 
 if (vo.getEstimatedRowCount() > 0) {
 vo.reset()
 while (vo.hasNext()) {
 def row = vo.next()
 if (row != null) {
 def tempName = row.getAttribute('TemplateName') 
 
 if (tempName == 'Discount Eligibility') {
 def status = row.getAttribute('StatusCode') 
 println("Asmnt Status is " + status)
 if(status != 'COMPLETED') { 
 throw new oracle.jbo.ValidationException('Please complete the Mandatory Discount Eligibility Assessment
 before changing status to WON')
 } else {
 completedMandatoryAsmnt = true;
 break;
 }
 }
 }
 }
 }
 if (completedMandatoryAsmnt == false) {
 throw new oracle.jbo.ValidationException('Please create and complete Mandatory Discount Eligibility
 Assessment before changing status to WON')
 } 
}

12. Click Save and Close.

The trigger script displays a message whenever a sales representative changes the opportunity status to Won.
This message ensures that the sales representative fills in the Discount Eligibility assessment template before
changing the status to Won.

Hide and Reorder Opportunity Fields Using Page
Composer  
You can hide fields, make fields required, and change the order of fields in the edit opportunity page, for specific job
roles. You use Page Composer to do the modifications.

Prerequisites
Before you begin, consider the following setup requirements or prerequisites:

• This procedure applies only to the desktop UI.

• You must have the job role of a setup user or Sales Administrator to do this task.
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• You must know how to create and publish sandboxes following your organization's established processes. As a
best practice, your organization might want you to first make changes in a sandbox before rolling the changes
out to all users with the Sales Representative job role by publishing the sandbox.

Starting Page Composer
First, start Page Composer's design mode to be able to make the changes:

1. Sign in to the application as a user with the Sales Administrator job role. Or, sign in as a setup user.
2. From the Navigator, select Opportunities.
3. Find an opportunity and edit it.
4. In the global region, expand the Settings and Actions menu which is available next to your user name. Then

select Edit Pages, under the Administration subheading

The Edit Pages dialog appears.
5. In the Edit Pages dialog box, select the Edit option for the Job Role layer.
6. In the Value column next to Job Role, select Sales Representative from the list.
7. Click OK.

The page opens in Page Composer design mode.
8. Next, toggle Page Composer to Direct Selection mode: Click the Select icon in the global region.

Direct Selection mode is now invoked, allowing you to make field-level changes.

Hiding a Field and Changing the Order of a Field
To hide the Worst Case field and change the order of the Attachments and Partners fields, use the following steps:

1. With Page Composer in Direct Selection mode, in the Additional Details region of the edit opportunity page,
hover over the Worst Case field.

A colored box appears around the field and its label.
2. Click inside the box around the Worst Case field.

A dialog box opens with two options: Edit Component and Edit Parent Component.
3. Select the Edit Parent Component option.

The Component Properties: panelFormLayout window opens.

1034



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 48
Extend Opportunities and Related Objects

4. In the Component Properties: panelFormLayout window, clear the check box next to the Worst Case field.

The following figure shows the Component Properties dialog box with Worst Case selected.

5. Select the down arrow to the right of the Attachments field to move it below the Partners field.

The order of the two fields changes.
6. Click OK.

Making a Field Read-Only
To make the Win Probability field read-only, use the following steps:

1. While still in Page Composer Direct Selection mode, hover over and then click the Win Probability (%) label.

A dialog box opens with two options: Edit Component and Edit Parent Component.
2. Select the Edit Component option.

The Component Properties: Win Probability (%) window opens.
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3. In the Component Properties: Win Probability (%) window, select the Read only check box.

The field becomes read-only, as shown in the following figure.

4. Click OK.

Making a Field Required and Not Sortable
To make the Quantity column in the Revenue Items table required and not able to be sorted, use the following steps:

1. With Page Composer still in Direct Selection mode, in the Revenue Items region, hover over the Quantity
column and click its header.

A dialog box opens two options: Edit Component and Edit Parent Component.
2. Select the Edit Component option.
3. Select the Show Required check box to make it a required field.
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4. Clear the Sortable check box to make the column appear as not sortable.

The following figure shows the Change Property dialog box with the Show Required and Sortable check boxes.

5. Click OK.

Saving Your Changes
When you're ready to commit your modification changes to the main line, perform these steps:

1. Click the Close button in the global region to sign out of Page Composer editor.
2. On the Sandboxes page, click the name of the sandbox you want to publish, and click Publish.

Verifying Your Changes
Verify your modifications by using the following steps:

1. When you're done with your changes, click Close in the header to sign out of Page Composer.
2. Sign out of the application.
3. Sign as a user with the Sales Representative role.
4. Navigate to the opportunity record that you edited, and verify the following:

◦ The Additional Details region is expanded by default.

◦ The Worst Case field isn't visible.
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◦ The Win Probability (%) field is read-only.

◦ The Attachments field is below the Partners field.

◦ The Quantity column is marked as required with an asterisk, and can't be sorted.

Related Topics

Configure Default Search on Standard Subtabs for
Opportunities  
You can add default search criteria to standard subtabs for opportunities so that your salespeople can more easily find
the subtab data that's relevant to their daily activities.

When a user opens the subtab at runtime, the records displayed are automatically filtered using the search criteria you
added. Users can change the default search value, but they can't change the default search field. They can, however,
further refine their search by adding additional search fields and values at runtime.

Adding a default search filter to a subtab is optional. If you skip this step, then no search fields are automatically added
to the subtab, but users can still see the search region and perform their desired search.

Use this procedure to add a default search filter field, operator, and value for the Leads subtab search on the Edit
Opportunity page.

Note:  You can select only one default search filter for each subtab. When adding a default search filter to standard
subtabs, the search filter applies to all existing details page layouts with this subtab. Let's say you add a search filter
to the Lead subtab on an Opportunity details page layout. This means that the same search filter is added to the Lead
subtab on an Account details page layout.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer.
4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, highlight Leads and click the pencil icon.
9. From the Configure Detail Form page region, go to the Configure Summary Table: Search Region.

10. Select the default search filter you want to apply to the Leads subtab.

You can select from a list of both standard and custom Lead fields. Note that you can't pick dynamic choice list
fields, set ID-based fixed choice list fields, and any fields that aren't searchable. Also, if this subtab was added
based on a many-to-many (M:M) relationship, then you can select from only those intersection object fields
that are already displayed on the subtab.

For example, you want to create a search filter to search for all qualified leads for an opportunity. Select Status
from the drop-down list and select Equals as the operator and then select the Qualified check box.
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11. Click Done and ensure that the layout status for your Leads subtab layout is set to Active.
12. Test the changes: Navigate to Sales > Opportunities as a user with access to the opportunity pages, for

example, as a salesperson. Edit an opportunity and confirm that the data that displays on the Leads subtab
includes only qualified leads.

13. Publish the sandbox.

Related Topics
• Overview of Subtabs

Extend Search Region and Results for Opportunities  
You can extend the search and select dialog layout for opportunities in your Sales application. Use Application
Composer to modify and set custom values that suit your requirements for the search parameters in the opportunity
extensible reusable region.

By extending the search and select dialog layout for your opportunities, you can tailor your search to suit your own
business requirements.

Use this procedure to extend the search region and results for your opportunities search.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. Under the Reusable Regions section, duplicate the Search and Select Dialog Layout by highlighting the

standard layout and clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Edit Search and Select Layout page appears.
8. Next to the Search Region, click the pencil icon.
9. Under the Configure Search Region, select the fields to appear in the search region and move them from the

Available Fields area to the Selected Fields area.
10. Click Save and Close to return to the Edit Search and Select Dialog Layout page.
11. Next to the Search Results , click the pencil icon.
12. Under the Configure Detail Form, select the fields to appear in the search results and move them from the

Available Fields area to the Selected Fields area.
13. Click Save and Close.
14. Click Done and ensure that the layout status for your Search and Select Dialog Layout is set to Active.
15. Test the changes: Navigate to Sales >  Opportunities as a user with access to the opportunity pages. Perform

a search for opportunities and confirm that the fields you selected appear in the search and results region for
your search.

16. Publish the sandbox.
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How to Add Assessment Subtab to Opportunity UI  
You can view assessments associated with your opportunities through the Edit Opportunity: Assessment subtab. The
Assessment subtab is hidden by default but you can make it available to your users through Application Composer.

Here's how to add the Assessment subtab to the Edit Opportunity page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Assessments from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. Click Save and Close.
12. Click Done and ensure that the layout status for your user-defined layout is Active.
13. Test the changes: Navigate to Sales > Opportunities as a user with access to the opportunity pages, for

example, as a salesperson. Edit an opportunity and ensure you can see the Assessment subtab in the Edit
Opportunity page.

14. Publish the sandbox.
For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

How to Add the Interactions History Subtab to
Opportunities  
You can view interactions history associated with your opportunities through the Edit Opportunity: Interactions
History subtab.

The Interactions History subtab is hidden by default but you can make it available to your users through Application
Composer.
Here's how to add the Interactions History subtab to the Edit Opportunity page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
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4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and clicking the

Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.

8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.

9. Move Interactions History from the Available Subtabs to the Selected Subtabs window.
10.Click OK.
11. Click Save and Close.
12. Click Done and ensure that the layout status for your user-defined layout is Active.
13. Test the changes: Navigate to Sales > Opportunities as a user with access to the opportunity pages, for example, as

a salesperson. Edit an opportunity and ensure you can see the Interactions History subtab in the Edit Opportunity
page.

14.Publish the sandbox.

For more information, see the Subtabs topic in the Configuring Applications Using Application Composer guide.

Create a Related Object Relationship Between Service
Requests and Opportunities  
A related object subtab lists records from one object that's related to another object. Using Application Composer, you
can create one-to-many relationships between two objects within the same application.

A relationship must exist before you can expose the "many" objects on a subtab that's displayed on the "one" object's
details page or tree. For example, your users might want to associate an opportunity with a list of service requests that
have been logged for that opportunity. To create a one-to-many relationship, you specify a source object and target
object. A reference relationship lets you add a subtab to the source object's details page, showing a list of all the target
object records that are associated with a single source object record.

Create a One-to-Many Relationship
To expose a list of service requests associated with a specific opportunity as a subtab on the opportunity's details page,
you must first create a one-to-many relationship between both the service request and opportunity objects.

Here are the steps to create a relationship between a service request and an opportunity.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. Select Relationships in the Common Setup pane.
5. On the Relationships page, click the Create icon.
6. In the Source Object field, select Opportunity.
7. In the Target Object field, select Service Request.
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8. Enter the relationship name, display name, and description.

Once you create a relationship, you can no longer edit the relationship name.
9. In the Cardinality field, select 1:M.

10. Click Save and Close.

Add Related Object Subtab
You now want to add the target object Service Request as a subtab to the source object's Opportunity detail page.

Here are the steps to add the related object subtab to the opportunity.

1. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
2. Ensure that the Application Pages tab is selected.
3. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
4. Type a new layout name and click Save and Edit.

The Details Layout page appears.
5. On the Edit Layout page, select the plus icon in the subtabs region.
6. On the Create Subtab page, select the Related object option.
7. Click Next.
8. Specify the values for the fields as follows:

Field Label Select or Enter Description

Data Object
 

Service Request
 

The object that this subtab is based on. This
subtab displays a list of service requests
that are related to an opportunity.
 

Display Label
 

Service Request Name
 

Name of the subtab.
 

Drill Down Column
 

Service Request Name
 

Your users can click this column to drill
down to view more details about a service
request record.
 

Display Icon
 

As applicable
 

This icon appears on the application page as
the subtab icon.
 

Selected Fields
 

As applicable
 

The fields that you want to appear on the
subtab.
 

9. Save the Service Request Name subtab.

You have created a subtab to display service requests on a subtab which appears on the Opportunity details
page.

10. Click Done and ensure that the layout status for your user-defined layout is Active.
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11. Test the changes: Navigate to Sales > Opportunities as a user with access to the opportunity pages, for
example, as a salesperson. Edit an opportunity and ensure you can see the Service Request subtab in the Edit
Opportunity page.

12. Publish the sandbox.

Related Topics
• Related Object Subtabs

• Object Relationships

• One-to-Many Relationships

Enable the Subscriptions Subtab for Opportunities  
The Subscriptions subtab in the Opportunity details page lists the subscriptions associated with your opportunities. The
subscriptions come from the quote lines in Oracle CPQ and you can use this subtab to get a better understanding of the
subscriptions tied to your renewal opportunities.

Note:

Before you extend your Opportunity UI to expose the Subscriptions subtab, you must be using both Oracle Configure,
Price, and Quote (Oracle CPQ) and Oracle Subscription Service.

Here's how to expose the Subscriptions subtab in the Edit Opportunity page.

1. Activate a sandbox.
2. Navigate to Application Composer, in the Configuration category.
3. Select Sales.
4. In the navigation tree, expand Standard Objects, expand Opportunity, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
7. Type a new layout name and click Save and Edit.

The Details Layout page appears.
8. In the Subtabs Region, click the Hide, Show, or Reorder Subtabs icon.

The Configure Subtabs dialog box appears.
9. Move Subscriptions from the Available Subtabs to the Selected Subtabs window.

10. Click OK.
11. From the Details Layout page, click Done.
12. Make sure that the layout status for your layout is set to Active.
13. Test the changes as follows:

◦ Navigate to Sales > Opportunity as a user with access to the opportunity pages, for example, as a
salesperson.

◦ Edit an opportunity and ensure you can view the Subscriptions subtab in the Edit Opportunity page.

14. Publish the sandbox.
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49  Use Copy Maps

Set Up Your Mapping File When Copying Opportunities  
You can use two predefined mapping templates for copying an opportunity. The Standard Copy Opportunity Mapping
(MOO_COPY_OPTY_MAPPING) is a noneditable template which performs a standard copy of one opportunity to
another.

The Copy Opportunity Mapping is an editable template that you use as the default mapping file for copying an
opportunity. When you copy opportunities, information such as sales stage, win probability, and status for the
opportunity aren't copied to the new opportunity. You may want to include additional information about the
opportunity but the necessary attributes aren't contained in the predefined Standard Copy Opportunity Map.
To include the information you want, you can add attributes to a copy of the predefined mapping file, called Copy
Opportunity Map.

Note:  Territory information, such as resource team records aren't copied as the resources are allocated on an on
demand basis. Resources that are added manually, as well as those added through opportunity assignment, are
copied to the newly created opportunity.

Here's how to include additional custom attributes or child objects to the editable copy of the predefined Copy
Opportunity Map:

1. Access Application Composer by selecting Application Composer from the Navigator menu.
2. Select Sales to filter the object search, and select Copy Maps within Advanced Setup.
3. Expand Copy Opportunity and select Copy Opportunity Map.

The Edit Copy Map window appears, and you use it to add additional attributes to your copy map.
4. Select each line in the Entity Mappings section and add records to the Attribute Mappings section. For

example, here's a lead to opportunity copy map example of the field descriptions in the Attribute Mappings
section for each of the attributes you want to add:

Field Description

To
 

Select the attribute to where the selected entity is copied. For example, OpportunityVO_Id_c
 
.

Referenced View Object
 

For this example, select Opportunity from the drop-down list as your referenced view object
for the OpportunityVO_Id_c attribute.
 
If this attribute is a foreign key, select the view object joined by this foreign key. The application
generates new foreign keys that keep the reference intact.
 

Primary Key
 

If this attribute is a primary key, select this check box. Instead of copying the value in the From
object, the application generates a unique value for this key field for each record in the To
object.
 

1045



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 49
Use Copy Maps

Field Description

From
 

Select the attribute from where the selected entity is copied. For example, MklLeadVO_Id_c.
 

From Expression
 

Optionally, you can enter a Groovy expression to change the value in this attribute. For
example, you want to change the value of the From object to some new value in the attribute
of the To object. You can also enter a constant to fill this attribute with a constant value in every
record of the To object.
 

5. Click Save and Close.

Set the Copy Opportunity Mapping Profile Option
You can specify the mapping file name to use when copying an opportunity by setting the Copy Opportunity Mapping
profile option. The predefined file is used to copy attributes and child objects when creating a copy of an existing
opportunity.

Here's how to access and modify the Copy Opportunity Mapping profile option:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the Manage Opportunity Profile Options page, enter Copy Opportunity Mapping in the Profile Display
Name field.

3. Click Search.
4. In the Profile Values section, you can see the predefined mapping called Copy Opportunity Map.
5. Click Save.

Note:  If you want to use the Standard Copy Opportunity Map, change the profile value to Standard Copy
Opportunity Map.

Related Topics
• Create a Copy Map

• Update the Copy Map to Copy the Lead Contact Value

• Update Existing Setup Data

Create a Copy Map  
Copy maps enable you to create objects by copying existing objects. For example, you can copy responses to create
leads and opportunities, or you can copy deal registrations to create opportunities. A mapping file is also available to
copy opportunities.
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You use the copy maps feature to map child objects and attributes in the source object (From object) to objects and
attributes in the object you're creating (To object).

Predefined mapping files are available as part of your sales application to enable you to:

• Map objects and attributes during the creation of an account when converting a lead to an opportunity.

• Automatically add the primary partner contact to the lead team when a partner contact is added to the lead.

• Create leads and opportunities from responses

• Copy opportunities and create opportunities from deal registrations

To create a copy map:

1. Sign in as a user with Application Composer access and verify that you have an active sandbox.
2. Access Application Composer by selecting Application Composer from the Navigator menu, under the

Configuration category.
3. Select Sales to filter the object search, and under Advanced Setup, select Copy Maps.
4. Click New, and then enter a unique name for the copy map. You specify the unique name in a profile option

after you have completed and saved your copy mapping file.
The Edit Copy Map window appears and you use it to define the copy map.

5. In the Application Module Mapping section, enter general information about the mapping as outlined in this
table:

Field Description

Name
 

Enter a name for the mapping file. The name is displayed in the Copy Maps window. You can
use the name to locate and search for copy maps that you want to edit or delete.
 

Map Group
 

Select the required mapping group for the new copy map from the drop-down list.
 

To
 

Select the application module that you're copying to. For example, if you're copying leads to
opportunities, then select the application module that includes leads.
 

From
 

Select the application module that you're copying from. For example, if you're copying
responses to leads, then select the application module that includes responses.
 

6. In the Entity Mappings section, add a record for each view object that you're copying by completing these
fields:

Field Description

To
 

Select the new view object that you're copying to.
 

From
 

Select the existing view object that you're copying from.
 

Query Type
 

Select one of the three query types: Unique Identifier, Join, or All Records. If you select All
Records, then don't enter any information in the remaining fields.
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Field Description

 

Query Attribute
 

If you selected either Unique Identifier or Join in the Query Type field, then select an attribute to
use during runtime. The attribute is used to filter the records that are copied to the new object.
For example, if you select LeadId, then during runtime, only the records matching the Lead ID
passed to the copy map engine are copied.
 

Joined View Object and Joined
Attribute
 

If you selected Join in the Query Type field, then use these two fields to specify:
 

◦ The view object to which this object is joined

◦ The attribute used as the basis of the join

7. Select each line in the Entity Mappings section, and add records to the Attribute Mappings section for each
of the attributes by completing these fields:

Field Description

To
 

Select the attribute to which the selected entity is copied.
 

Referenced View Object
 

If this attribute is a foreign key, select the view object joined by this foreign key. The application
generates new foreign keys that keep the reference intact.
 

Primary Key
 

If this attribute is a primary key, select this check box. Instead of copying the value in the From
object, the application generates a unique value for this key field in each record in the To object.
 

From
 

Select the attribute from which the selected entity is copied.
 

From Expression
 

Optionally, you can enter a Groovy expression to change the value in this attribute. For
example, you want to change the value of the From object to some new value in the attribute
of the To object. You can also enter a constant to fill this attribute with a constant value in every
record of the To object.
 

8. Click Save and Close.
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9. Specify the mapping file name in one of these profile options:

◦ Use the Direct Lead to Opportunity Mapping profile option to specify the mapping file name created
when a direct lead is converted to an opportunity.

◦ Use the Copy Opportunity Mapping profile option to specify the mapping file name to use when
copying an opportunity. The file is used to copy attributes and child objects when creating a copy of an
existing opportunity.

◦ Use the Partner Lead to Opportunity Mapping profile option to specify the mapping file name created
when a partner lead is converted to an opportunity.

◦ Use the Lead to Account Mapping profile option to specify the mapping file name created in Copy
Maps. This file maps objects and attributes during the creation of an account when converting a lead to
an opportunity.

◦ Use the Lead to Contact Mapping profile option to specify the mapping file name created in Copy
Maps. This file maps objects and attributes during the creation of a contact when converting a lead to an
opportunity.

Related Topics
• Example of Modifying the Lead to Opportunity Copy Map

Example of Modifying the Lead to Opportunity Copy
Map  
Copy maps are a declarative way to specify what fields are copied among objects. This worked example shows you how
to modify an existing mapping file to create an opportunity from a lead.

The functionality for converting a lead to an opportunity uses the predefined Copy Lead To Opportunity Map copy map
feature. Predefined mapping files are available to you as part of your sales application. You can use copy maps to:

• Map objects and attributes during the creation of an account and the creation of a contact when converting a
lead to an opportunity.

• Create leads and opportunities from responses

• Copy opportunities and create opportunities from deal registrations

In this example, you want to:

• Modify the copy lead to opportunity map

• Add a field to an opportunity

• Verify your changes

Modify the Copy Lead To Opportunity Map
To modify the Copy Lead to Opportunity Map:

1. Sign in as a user with Application Composer access and verify that you have an active sandbox.
2. Access Application Composer by selecting Application Composer from the Navigator menu, under the

Configuration category.
3. Under Advanced Setup, select Copy Maps. The Copy Maps window appears.
4. Select the Copy Lead To Opportunity Map. The Edit Copy Map window appears.
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5. In the Entity Mappings region, highlight the row that contains From: Sales Lead and To: Opportunity.
6. In the Attribute Mappings region, select the Add icon to add a new row.
7. From the To: drop-down list, select Comments.

This value represents the Comments field in opportunities that contains the value.
8. In the From Expression field, enter this Groovy expression:

return "Copy Map executed for Lead: "+nvl(LeadNumber,"");

The expression uses text and the LeadNumber as the value to set into the opportunity Comments field.
9. Click Save and Close.

Add a Field to an Opportunity
The Comments field isn't displayed by default on the Opportunities UI. Use Application Composer to add the
Comments field to the opportunity header region as follows:

1. From Application Composer, expand and select Objects, Standard Objects, and then Opportunity.
2. Click Pages and then select the Application Pages tab.
3. On the Details Page Layouts section, edit any custom layout. If none exists, then duplicate the standard layout

and edit the resulting custom layout.
4. Edit the Summary region.
5. Select the Comments field from the list in the Available Fields region and move it to the Selected Fields

region.

6. Click Save and Close.
7. Verify that the Summary region list contains the Comments field.
8. Click Done.

Verify Your Changes
1. Navigate to the Application Composer UI with the same user access and sandbox details used to complete the

Modify Lead to Opportunity Copy Map task.
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2. Navigate to Leads and click Create Lead.
3. Enter Autumn Lead as the Name and select Pinnacle Technologies as the Account. Accept all other defaults

values for the remaining fields.
4. From the Actions drop-down list, select Convert to Opportunity.
5. Click the Opportunities icon.
6. Locate the newly created opportunity. It must have the same name as the lead that was originally created.

Examine the value in the Comments field. It contains the expected text, plus the lead number which originated
this opportunity. Here's a screenshot that shows an example of the Edit Opportunity page with the Comments
field populated with the lead number.

Related Topics
• Attribute Mapping When Converting Leads to Opportunities

• Create a Copy Map

• Overview of Sandboxes

Update the Copy Map to Copy the Lead Contact Value  
This topic describes how to update the copy map to copy over the Lead contact value into the opportunity's Customer
field.

Updating the Copy Map to Copy the Lead Contact Value
In this step, you update the copy map to copy over the Lead contact value into the opportunity Customer field. Copy
maps are a declarative way to specify what fields are copied among objects. The functionality for converting a lead to an
opportunity uses the predefined Copy Lead To Opportunity Map copy map feature.

1. Expand Advanced Setup and click Copy Maps (in left pane of the Application Composer).
2. Click Copy Lead to Opportunity Map.
3. Under the Attribute Mappings section, in the row for TargetPartyId, select PrimaryContactId from the drop-

down list in the From column.
4. Click Save and Close.
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Attribute Mapping When Converting Leads to
Opportunities  
This topic outlines the one-to-one mapping of the attributes between the lead and opportunity applications. When
converting leads to opportunities, lead attributes, such as sales account, products, revenue amount, lead contacts, and
other attributes, are mapped to the newly created opportunity.

You convert a lead to an opportunity when the lead is qualified and is ready for further processing along the sales cycle.
The following sections outline:

• General lead attributes mapped to opportunities

• Partner lead-specific attributes mapped to opportunities

• Lead contact attributes mapped to opportunity contact attributes

• Lead product attributes mapped to opportunity revenue line attributes

• Profile options that specify the mapping file name for user-defined mapping files

General Lead Attributes Mapped to Opportunities
This table lists the general lead attributes that are mapped to the corresponding opportunity attributes:

General Lead Attribute Opportunity Attribute

Budget Amount
 

Budget Amount
 

Budget Status
 

Budget check box
 

Customer
 

Target Party
 

Currency
 

Currency
 

Description
 

Description
 

Estimated Close Date
 

Estimated Close Date
 

Expiration Date
 

Expiration Date
 

Lead Number
 

Lead Number
 

Name
 
This attribute value is the Lead Name and
the current date and time, which generates
a unique opportunity name.

Name
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General Lead Attribute Opportunity Attribute

 

Owner
 
Indicates the user who starts the
conversion.
 

Owner of opportunity
 

Primary Contact
 

Key Contact
 

Source Code
 
If a campaign or any other source creates
a lead in which source code is used, then
this attribute value is mapped.
 

Source
 

Partner Lead Attributes Mapped to Opportunities
This table lists the partner lead attributes that are mapped to the corresponding opportunity attributes:

Partner Lead Attribute Opportunity Attribute

Deal Approved By
 
For direct leads, this attribute is set to the
user who starts the conversion.
 

Owner of opportunity
 

Deal Approved By Resource Organization
 

Resource Organization
 

Partner
 

Partner
 

Partner Type
 

Partner Type
 

Partner Program
 

Partner Program
 

Registration Type
 

Registration Type
 

Registration Number
 

Registration Number
 

Lead Contact Attributes Mapped to Opportunity Contact Attributes
To map lead contact attributes to opportunity contact attributes, the following relationships must apply between the
contact and the customer:

• The relationship end date is later than the current date.

• The relationship start date is earlier than the current date.
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• The relationship status is active.

This table lists the lead contacts attributes that are mapped to the corresponding opportunity contacts attributes:

Lead Contact Attribute Opportunity Contact Attribute

Contact
 

Contact
 

Contact Role
 

Contact Role
 

Primary
 

Primary
 

Lead Product Attributes Mapped to Opportunity Revenue Line Attributes
This table lists the lead product attributes that are mapped to the corresponding opportunity revenue line attributes:

Lead Product Attribute Opportunity Revenue Line Attribute

Amount
 

Revenue Amount
 

Approver
 

Resource Party
 

Currency
 

Currency for the Revenue Amount
 

Inventory Item
 

Inventory Item
 

Organization
 

Inventory Organization
 

Product Group
 

Product Group
 

Quantity
 

Quantity
 

Unit of Measure
 

Unit of Measure
 

Unit Price
 

Unit Price
 

Profile Options for Mapping File Names
As an administrator, you can specify your own mapping file name to use for mapping objects and attributes during
the lead-to-opportunity conversion process. For example, you can create user-defined lead attributes in Application
Composer, Copy Maps, and can then add these attributes to the existing ready-to-use mapping files. You must save
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the user-defined mapping file using a unique file name and then specify the saved mapping file name in one of these
profile options:

• Use the Direct Lead to Opportunity Mapping profile option to specify the mapping file name created when a
direct lead is converted to an opportunity.

• Use the Partner Lead to Opportunity Mapping profile option to specify the mapping file name created when a
partner lead is converted to an opportunity.

Link Campaigns Using the Lead to Opportunity Copy
Map  
If a lead is linked to a marketing campaign through a campaign response, then the association to the campaign must be
maintained in your lead to opportunity conversion process.

This allows the opportunities to be linked with campaigns, and the respective opportunity revenue to be attributed to its
linked campaign.

Modify the predefined copy map template, Copy Lead to Opportunity Map, to add a campaign entity mapping and
campaign attributes. For information about how to modify a copy map, see the Example of Modifying the Lead to
Opportunity Copy Map topic.

1. Add an entity mapping between OpportunityCampaignVO and Campaign Member with LeadId as the unique
identifier.

2. Add the following attribute mappings as shown in the screenshot.

◦ CampaignId

◦ OptyCampaignId

◦ OptyId

◦ RevenuePercentage
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Modify Lead Convert and Mass Lead Convert Pages  
Use the Lead Convert and Mass Lead Convert layout pages in Application Composer if you want to expose user-defined
and standard fields in your lead to opportunity conversion process.

You must then configure the predefined copy map template, Copy Lead to Opportunity Map, to map the fields. Use the
Manage Sales Lead Administrator Profile Values task to ensure that the configured copy map to be your default copy
map which maps lead attributes to opportunity attributes during lead conversion.

Modify the Lead Convert Pages
You duplicate the standard lead convert and mass lead convert page layouts and modify the default layouts. Edit the
default page layouts to expose standard and user-defined fields so that their values can be copied to opportunity during
lead conversion.

Note:  These predefined standard fields exist for both the Mass Lead Convert Layouts and Lead Convert Layouts:

• Opportunity Name

• Owner

• Primary Contact

• Account

Here are the steps to modify the lead convert pages:

1. Sign in as a user with Application Composer access and verify that you have an active sandbox.
2. Access Application Composer by selecting Application Composer from the Navigator menu, under the

Configuration category.
3. From Application Composer, expand and select Objects, Standard Objects, and then Sales Leads.
4. Click Pages and then select the Application Pages tab.
5. On the Mass Lead Convert Layouts and Lead Convert Layouts sections, edit any user-defined layout. If no

user-defined layouts exist, then duplicate the standard layouts and edit the resulting user-defined layouts, as
required.

6. Click Save and Close.
7. Verify your user-defined field changes and click Done.
8. Edit the copy map to map the user-defined fields between the lead and opportunity.

See the topic Example of Modifying the Lead to Opportunity Copy Map for more information.
9. Set the modified copy map as your default copy map.

See the topic Enable a User-Defined Copy Lead To Opportunity Map Value in the Implementing Sales guide.

Related Topics
• Enable a User-Defined Copy Lead To Opportunity Map Value

• Example of Modifying the Lead to Opportunity Copy Map

• Overview of Sandboxes
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Enable a User-Defined Copy Lead To Opportunity Map
Value  
The Copy Maps feature lets you create objects by copying existing objects. After you specify the lead-to-opportunity
copy map template in a profile option, you can copy notes, attachments, and activities from a lead record to an
opportunity record during the lead-to-opportunity conversion.

These sections describe how to access the Direct Lead to Opportunity Mapping profile option and how you can specify
your own user-defined mapping files.

Set Your Copy Lead To Opportunity Map Value
You can specify the mapping file name to use when copying an opportunity by setting the Direct Lead to Opportunity
Mapping profile option. Use the predefined file to specify the mapping file name created when you convert your lead to
an opportunity.

Here's how to access and modify the value set for the mapping file name in the Direct Lead to Opportunity Mapping
profile option:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Administrator Profile Values

2. On the Manage Sales Lead Administrator Profile Values page, enter Direct Lead to Opportunity Mapping in the
Profile Display Name field.

Note:  For partner leads, use the Partner Lead to Opportunity Mapping profile option.

3. Click Search.
4. In the Profile Values section, the predefined mapping, called Copy Lead To Opportunity Map , appears in the

Profile Value field.
5. Remove the Copy Lead To Opportunity Map value and enter the value for your user-defined mapping file, for

example My Copy Lead To Opportunity Map.

Note:  Use the Standard Reference Copy Lead To Opportunity Map to keep any attachment reference during
the lead to opportunity conversion.

6. Click Save and Close.

See the topic Modify Lead Convert and Mass Lead Convert Pages for more information.

Profile Options for Copy Maps
As an administrator, you can specify your own copy maps to use for mapping objects and attributes during the lead
to opportunity conversion process. For example, you can create user-defined lead and opportunity attributes in
Application Composer and can then add these attributes to the copy maps. Oracle recommends that you duplicate an

1057



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 49
Use Copy Maps

existing copy map and make the changes in the copy. You must save the user-defined copy map using a unique name
and then specify the name of the saved copy map in one of these profile options:

Profile Option Display Name Description

Direct Lead to Opportunity Mapping
 

Specify the mapping file name created in Application Composer > Copy Maps. This file is used to
map objects and attributes when a direct lead is converted to an opportunity. The predefined value is
Copy Lead to Opportunity.
 

Lead to Account Mapping
 

Specify the mapping file name created in Application Composer, Copy Maps. This file is used to map
objects and attributes during the creation of an account when converting a lead to an opportunity.
 

Lead to Contact Mapping
 

Specify the mapping file name created in Application Composer, Copy Maps. This file is used to map
objects and attributes during the creation of a contact when converting a lead to an opportunity.
 

Partner Lead to Opportunity Mapping
 

Specify the mapping file name created in Application Composer, Copy Maps. This file is used to map
objects and attributes when a partner Lead is converted to an Opportunity. The predefined value is
Copy Lead to Opportunity.
 

See the topic Example of Modifying the Lead to Opportunity Copy Map for more information.

Related Topics
• Modify Lead Convert and Mass Lead Convert Pages

• Copy a Lead to Account and Contact Maps

• Update Existing Setup Data

Copy a Lead to Account and Contact Maps  
Copy maps enable you to create objects by copying existing objects. For example, you can use predefined mapping files
to copy lead attributes stored on a lead to the account or contact created during lead conversion.

You use the copy maps feature to map child objects and attributes in the source object (From object) to objects and
attributes in the object you're creating (To object).

Copy a Lead to Account Map
Here's how to copy a lead to an account map:

1. Ensure that you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. Select Sales to filter the object search, and under Advanced Setup, select Copy Maps.
4. On the Copy Maps page, select the Copy Lead to Account > Standard Copy Lead to Account Map.
5. Create a copy of the map and enter relevant account mappings on the Edit Copy Map page.
6. Click Save and Close.
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7. Specify the mapping file name in the following profile option:

◦ Use the Lead to Account Mapping (MKL_LEAD_TO_ACCOUNT_MAPPING_NAME) profile option to
specify the mapping file name created in Copy Maps. This file maps objects and attributes during the
creation of an account when converting a lead to an opportunity.

Copy a Lead to Contact Map
Here's how to copy a lead to a contact map:

1. Ensure that you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. Select Sales to filter the object search, and under Advanced Setup, select Copy Maps.
4. On the Copy Maps page, select the Copy Lead to Contact > Standard Copy Lead to Contact Map.
5. Create a copy of the map and enter relevant account mappings on the Edit Copy Map page.
6. Click Save and Close.
7. Specify the mapping file name in the following profile option:

◦ Use the Lead to Contact Mapping (MKL_LEAD_TO_CONTACT_MAPPING_NAME) profile option to
specify the mapping file name created in Copy Maps. This file maps objects and attributes during the
creation of a contact when converting a lead to an opportunity.

Related Topics
• Create a Copy Map

• Enable a User-Defined Copy Lead To Opportunity Map Value

• Example of Modifying the Lead to Opportunity Copy Map
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50  Extend Quotes and Sales Orders

Extend Application Pages for Sales Orders  
Using Application Composer, you can change many items that appear on the application set of pages for sales orders.
The Sales Order object is available to support the integration with Oracle Configure, Price, and Quote (CPQ) Cloud.

This object stores quote summary information that's synced from Oracle CPQ Cloud.

Note:  Do not extend the Sales Order object unless the integration with Oracle CPQ Cloud has already been set up. For
more information, see "About Integrating with Quotes" in the Related Topics.

The Sales Order object displays as a subtab in the following areas:

• Quotes and Orders subtab for account records

• Quotes and Orders subtab for opportunity records

Use Application Composer to create custom attributes (custom fields) on the Sales Order object. The custom fields you
create are available for display on the Quotes and Orders subtab for account and opportunity records, as well as for use
with web services.

For example, you can:

• Hide or show standard fields.

• Reorder columns.

• Add custom fields (all types).

Modify the Sales Order Object
After the integration with Oracle CPQ Cloud has been set up, you can define custom fields for the Sales Order object.

To define custom fields:

1. Navigate to Application Composer.
2. Expand the Sales Order object.
3. Click the Fields node.

Configure the Quotes and Orders Subtab
Next, configure the Quotes and Orders subtab, available from both the Account or Opportunity details page. To
configure the subtabs, you must navigate to the Account or Opportunity page layouts in Application Composer.

1. Navigate to the Account or Opportunity object in Application Composer.
2. Click the Pages node.
3. On the Application Pages tab, navigate to the Details Page Layouts section. Create a custom layout by

duplicating the standard layout, or edit an existing custom layout.
4. On the Details Layout page, click the Quotes and Orders subtab. You can:

◦ Click the pencil icon next to the subtab name to rename the subtab.

1061



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 50
Extend Quotes and Sales Orders

◦ Click the pencil icon next to the Opportunity Quotes or Customer Quotes heading to indicate which of the
sales order attributes (standard or custom) are displayed at runtime.

Access the Sales Order Object for Custom Scripting
After you configure the Sales Order object, you can also write Groovy scripts that access the new custom fields you
created. For example, maybe you want to validate sales order data on an opportunity. However, when writing the script
on the Opportunity object, custom fields from the Sales Order object aren't available directly in the expression builder.
To access those custom fields, you must use the newView() function to build a runtime link to the Sales Order object.
After newView() executes against the Sales Order object, only then can your script access and analyze Sales Order fields.

Here's an example of the newView() function that retrieves the related sales order record based on the opportunity
number.

def myVO = newView('SalesOrderHeader')
def view_Criteria = newViewCriteria(myVO);
def view_criteria_row = view_Criteria.createRow();
def view_condition = view_criteria_row.ensureCriteriaItem('OptyNumber');
view_condition.setOperator('=');
view_condition.setValue(OptyNumber);
view_Criteria.insertRow(view_criteria_row);
myVO.appendViewCriteria(view_Criteria);
myVO.setMaxFetchSize(1);
myVO.executeQuery();

if(myVO.hasNext())
{
def rec= myVO.next()
def cust_field_from_order_value = rec.<custom_field_API_name>_c
}

This line, specifically, gets the value of a custom Sales Order attribute and assigns it to a variable.

def cust_field_from_order_value = rec.<custom_field_API_name>_c

You can now complete the rest of the Groovy script to implement a validation rule, for example.

Related Topics
• About Integrating With Quotes
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51  Extend Partner Relationship Management

Overview of Configuring Partner Pages  
Read this chapter to learn how to use Page Composer to configure partner relationship management pages:

• Configure partner pages used by your employees

• Configure external-facing pages used by your partners

Extend Application Pages for Partners  
Using Application Composer, you can change many items that appear on the application set of pages for partners.

Use Application Composer to modify these pages:

• Partners landing page

• Create Partner page

• Edit Partner page (read the following discussion of subtabs)

For example, you can:

• Hide or show standard fields.

• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Note:  To extend the application set of pages for partners, use the Partner object in Application Composer.

Partners Landing Page
You can modify the Partners landing page, also referred to as the Partners list page. For example, you can hide standard
partner fields or show custom partner fields. To modify the Partners landing page:

1. Navigate to the Partner object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, click Edit Summary Table.
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Create Partner Page
You can modify the Create Partner page. For example, you can hide standard partner fields, make a field required, add a
default value, and show custom partner fields. To modify the Create Partner page:

1. Navigate to the Partner object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout to edit. Or, edit another existing layout.
To enhance run time usability for your end users, optionally group custom fields into field groups.

Edit Partner Page
The Edit Partner page consists of multiple subtabs that display along the left side of the page. You can modify most of
these subtabs, including changing the order of the subtabs. You can also add custom subtabs to display records from
child or related objects, for example.

Note:  To add custom fields to certain subtabs available from the Edit Partner page, you must first navigate to those
subtab target objects in Application Composer to create the fields using the Fields node. After creating the fields on
the target object, you can then navigate back to the desired details page layout for the Partner object to add those
fields to the right subtabs.

To modify the Edit Partner page:

1. Navigate to the Partner object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout

to edit. Or, edit another existing layout.
4. When making changes to the Edit Partner page, select the subtab you want to change first. The following

subtabs are available from the Edit Partner page. Use the following subtabs to configure which standard and
custom fields display at run time. You can also configure buttons and actions.

Tip:  The changes you make to these subtabs are unique to the Edit Partner page. For example, the changes
you make to the Opportunities subtab on the Edit Partner page aren't reflected on the Opportunities subtab
on the Edit Contact page.

◦ Overview

◦ Profile
In addition to selecting standard and custom fields on the profile subtab, you can configure page regions
by adding field groups.

◦ Contacts
Use the Contact object to create custom fields as needed.

◦ Partner Account Team
Use the Partner Account Team object to create custom fields as needed.

◦ Opportunities
Use the Opportunity object to create custom fields as needed.

◦ Enrollments
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Use the Program Enrollments object to create custom fields as needed.

◦ Notes

The Notes subtab isn't extensible, although you can change the tab name.

◦ Activities

The Activities subtab isn't extensible, although you can change the tab name.
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52  Extend Territory Management

Configure and Extend Application Pages for Territories  
Using Application Composer, you can modify many items that appear on the application pages for sales territories.

Use Application Composer to modify these pages:

• Territories landing page

• Create Territories page

• Details page (see a discussion of subtabs in the Details page section)

Make changes such as these examples:

• Hide or show standard fields.

• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Note:  To extend the application pages for territories, use the Sales Territory object in Application Composer.

Territories Landing Page
You can modify the Territories landing page. For example, you can hide standard fields or show custom fields.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Landing Page Layouts, duplicate the standard layout to create a new

layout.

Create Territories Page
You can modify the Create Territories page. For example, you can hide standard fields, make a field required, add a
default value, and show custom fields.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout.

To enhance run time usability for your end users, optionally group custom fields into field groups.
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Details Page
The Details page consists of multiple subtabs that display along the side of the page. You can modify most of these
subtabs. You can also add subtabs to display records from child or related objects, for example.

To add custom fields to certain subtabs available from the Details page, you must first navigate to those subtab target
objects in Application Composer to create the fields. After creating the fields on the target object, you can then navigate
back to the desired details page layout for the Sales Territory object to add those fields to the specific subtabs.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout.
4. When making changes to the Details page, select the subtab you want to change first. These subtabs are

available from the Details page. Use the subtabs to configure which standard and custom fields display at run
time. You can also add a new tab.

◦ Summary

◦ Dimensions

This tab isn't extensible.

◦ Inclusions

This tab isn't extensible.

◦ Exclusions

This tab isn't extensible.

◦ Team Members

Use the Sales Territory Resource object to create custom fields as needed.

◦ Child Territories

Use the Sales Territory object to create custom fields as needed.

Custom Territory Attributes
Assign territories using the custom territory attributes. For example, if your organization want to track revenue by
different groups of salespeople within their territories - one group to focus on new customers while another group for
subscription renewals. Create custom territory attributes to track revenue from both the groups separately. This means
that the records are matched with the revenue, based on a new territory or a renewal territory.

Configure and Extend Territory Management  
You can modify a variety of regions in Territory Management using Application Composer. Application Composer lets
you create custom fields, actions, and links, which you then add for display.

You can also create custom child objects, which you can add to certain pages as subtabs or tree nodes.

This topic addresses the configurability of the More Details pages only. To understand how to configure the set of
application pages for these objects, see the related topic.
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To access Application Composer:

1. Go to the Navigator menu.
2. In the Configuration section, select Application Composer.

Understanding Which Territory Pages Are Extensible
To modify Territory pages, you need to know which pages and regions are extensible, and which options to select in
Application Composer to make those changes..

These Sales objects are associated to Territory pages:

• Sales Territory

• Sales Territory Proposal

• Sales Territory Resource

This table lists Territory pages and regions, and the related objects that you can access in Application Composer
to modify those pages. For example, the Territory Team subtab on the Edit Territory Proposal page, Profile tab is
extensible. To create custom fields that you can later add to the Territory Team tab, you must select the Sales Territory
Resource object in Application Composer and create your custom fields.

Territory Page Territory Region Underlying Business Object

Overview page
 

Search dialog
 

Sales Territory
 

Overview page
 

Details region for a selected territory, Summary
region on the Profile tab
 

Sales Territory
 

Overview page
 

Details region for a selected territory, Additional
Information region on the Profile tab, Territory
Team tab
 

Sales Territory Resource (child object of Sales
Territory)
 

Overview page
 

Current Territory Proposals region
 

Sales Territory Proposal
 

Overview page
 

Completed Territory Proposals region
 

Sales Territory Proposal
 

Creation page
 

Create Territory Proposal dialog from the
Current Territory Proposals region
 

Sales Territory Proposal
 

Details page
 

Details region for a selected territory, Profile
tab, Summary region
 

Sales Territory Proposal
 

Next, expose your custom fields by accessing the appropriate Application Composer configuration page, listed in the
following section.

Note:  To make only minor user interface changes to Territory pages without creating new objects or fields, use Page
Composer instead of Application Composer.
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Adding Your Changes to the User Interface Pages
To add custom fields to the Territory regions listed in the table in the previous section:

1. Navigate to the Application Composer Overview page.
2. In the object tree, select the Sales Territory or Sales Territory Proposal object.
3. Select the Fields node and create your custom fields.
4. Select the Pages node.
5. On the Desktop Pages tab, select the configuration page hyperlink related to the Territory region that you want

to modify.

This table indicates which Sales objects populate which Territory pages and regions, as well as Application Composer
configuration pages where you can make user interface changes on those pages and regions.

Business Object Configuration Page in
Application Composer

Related Territories Page Related Territories Region

Sales Territory
 

Select the Pages node for this
object, then click Edit Local Search.
 

Search Territories page from the
Overview page
 

None
 

Sales Territory
 

Select the Pages node for this
object, then click Edit Summary
Form.
 

Overview page
 

Details region for a selected
territory, Summary region on the
Profile tab
 

Sales Territory Proposal
 

Select the Pages node for this
object, then click Current Territory
Proposals Page.
 

Manage Territory Proposals page
 

Current Territory Proposals region
 

Sales Territory Proposal
 

Select the Pages node for this
object, then click Completed
Territory Proposals Page.
 

Manage Territory Proposals page
 

Completed Territory Proposals
region
 

Sales Territory Proposal
 

Select the Pages node for this
object, then click Edit Creation
Page.
 

Manage Territory Proposals page
 

Create Territory Proposal dialog
from the Current Territory
Proposals region
 

Sales Territory Proposal
 

Select the Pages node for this
object, then click Edit Summary
Form.
 

Territory Proposal page
 

Details region for a selected
territory, Profile tab, Summary
region
 

Sales Territory Proposal
 

Select the Pages node for this
object, then click Edit Summary
Form.
 

Territory Proposal page
 

Basic Information tab on the Edit
Territory Proposal dialog from the
Territory Proposal page
 

Related Topics
• Configure and Extend Application Pages for Territories
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Create Custom Territory Attributes for Territory
Assignment  
Create custom attributes for sales territories and then use those attributes in territory assignment to match with
customer attributes in the account, opportunity, lead, deal, or partners objects.

These territory custom attributes can be viewed and managed in active territories, territory proposals, REST services,
and export and import management.

Note:  Custom Sales Territory Resource attributes or Sales Territory custom child object attributes aren’t supported
in territory assignment. Now, let's create and use a custom territory attribute for the sales lead object as an example.
Here are the high-level steps:

1. Create a custom attribute for the Sales Territory standard object.

2. Add the custom territory attribute to the Sales Lead assignment.

3. Map the custom attributes you created for Sales Territory and Sales Lead objects.

Create a Custom Attribute for the Sales Territory Standard Object
1. In an active sandbox, go to the Application Composer.
2. Create a fixed choice list called Branch for the Sales Territory standard object.
3. In the List of Values region, create a new lookup type MKL_LEAD_BRANCH for Branch, and add lookup codes

for each of the company branches.
4. Save the field.
5. Next, add the Branch field to the Sales Lead Detail page.
6. Publish the sandbox.

Add the Custom Territory Attribute to the Sales Lead Assignment
1. In the Setup and Maintenance work area, use the Manage Sales Lead Assignment Objects task:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. Select Sales Lead Territory.
3. On the Attributes tab, click Add Row.
4. From the View Object Attribute drop-down list, select a standard or custom lookup field you want to use. For

example, assume you created a custom lookup field, Branch. The lookup field will be available in the drop-down
list. Select it.

5. Enter Candidate Information Sequence. This is the sequence in which the attribute is shown in the displayed
record.

6. Leave the Inactive check box unselected.
7. Save and publish.

Next, add the attribute assignment mapping to use this attribute to match with a standard or custom Sales Lead
attribute, or to filter the matching territories.
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Map the Custom Sales Territory and Sales Lead Attributes
1. In the Setup and Maintenance work area, use the Manage Sales Lead Assignment Objects task:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Objects

2. Select Sales Lead.
3. In the Candidates tab, within the Sales Lead Territory: Rule Categories subtab, select Sales Lead Territory Rule

Category.
4. In the Sales Lead Territory: Mapping Sets subtab, select Mapping Set 1.
5. In the Mapping Set 1: Mappings table, click Create.
6. Define attributes for these fields:

Mapping Field Value You Select

Type Attribute

Exact Match Select the check box

Candidate Object Sales Lead Territory

Work Object Sales Lead

Candidate Object Attribute: Low Select the custom territory field you created. In this example, Branch.

Null Value Handling Derive Mapping Value

Work Object Attribute: Low Select the custom lead field you created. In this example, Branch.

7. Click OK.
8. Repeat steps 5 to 7 for each mapping set.
9. Save and publish.
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53  Extend Sales Forecasting

Overview of Extending Forecasting Objects  
Read this chapter to learn how to extend forecasting objects and pages, and how to extend those objects using
Application Composer.

Configure and Extend Application Pages for Sales
Forecasts  
Using Application Composer, you can change many items that appear on the application pages for sales forecasts. Use
Application Composer to modify these pages:

• Sales Forecasts landing page

• Forecast Details page

◦ Products subtab

◦ Forecast Items subtab

When you modify the Forecast Details page, you see two versions, or layouts, of the page in Application Composer.
Each layout is targeted at a different user:

• The Edit Forecast page is available to sales managers who own a forecasting territory that's a parent of child
territories. You can modify both the Products and Forecast Items subtabs using this layout.

• The Review Forecast page is available to salespeople who own a forecasting territory that has no child
territories. You can modify only the Forecast Items subtab using this layout.

The Analytics subtab and Unforecasted Pipeline subtab are also available from the Sales Forecasts functional area, but
aren't extensible.

Sales Forecasts Landing Page
The Sales Forecasts landing page has two views that you can modify in Application Composer:

• The card view

• The summary table view

You can modify the region that appears at the bottom of the card view. You can modify these items in this region

• Hide or show existing fields.

• Add custom fields (all types).
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This figure shows the Sales Forecasts landing page card view, with the configurable region highlighted at the bottom of
the page.

Note that you can't make changes to these components on the page:

• Embedded analytics

• Custom buttons and actions

This figure shows the landing page table view. You can configure the fields in the table.

Products Subtab
The Products subtab includes the Edit Forecast Product Items table. You can modify these items on the Products subtab
in the Edit Forecast page:

• Hide or show existing fields.

• Reorder fields.

• Change field labels.

• Add custom fields (all types).

• Add custom actions and links.
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Forecast Items Subtab
The Forecast Items subtab includes the summary at the top of the page, the Edit Forecast Items Search Results table,
and the Edit Forecast Items table. You can modify these items on the Forecast Items subtab:

• Hide or show existing fields.

• Reorder fields.

• Change field labels.

• Add custom fields (all types).

• Add custom actions and links.

Note that you can't make changes to these components on the page:

• Actions menu (can't add or hide and show)

• Custom buttons and actions

Use Application Composer to Modify the Sales Forecasts Application Pages
Before modifying pages, create custom fields and make other changes using the Forecast Territory Details standard
object.

1. Navigate to the Application Composer Overview page.
2. In the object tree, select the Forecast Territory Details standard object.
3. Select the Pages node.
4. Select the Application Pages tab.
5. Use the links on the tab to navigate to the object's configuration pages, where you can modify the available

pages.

Application Page Application Composer Configuration Page Link

Sales Forecasts landing page
 

Edit Forecast Card View
 
Edit Summary Table
 

Products subtab
 

Duplicate the standard layout in the Details Page Layouts section and edit it, or create a new
details page layout. The Products subtab appears only in the Edit Forecast page.
 
When working with the details page layout for the Edit Forecast page, navigate to the Subtabs
Region and click the Products subtab to configure the Edit Forecast Product Items table.
 

Forecast Items subtab
 

Duplicate the standard layout in the Details Page Layouts section and edit it, or create a new
details page layout. The Forecast Items subtab appears within both the Edit Forecast and
Review Forecast pages. You can configure the subtab for both pages by editing the details page
layouts for each page.
 
When working with the details page layout for both the Edit Forecast and Review Forecast
pages, navigate to the Subtabs Region and click the Forecast Items subtab to configure the
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Application Page Application Composer Configuration Page Link

Summary region, the Edit Forecast Items table, and the Edit Forecast Items Search Results
table.
 

Custom subtabs
 

You can also add subtabs to display records from child or related objects, for example. Click the
plus + icon to create subtabs.
 

1076



Oracle Fusion Cloud Sales Automation
Implementation Reference

Chapter 54
Extend Microsoft 365

54  Extend Microsoft 365

Overview of Extending Microsoft 365 for Sales  
Read this chapter to learn about configuring the Oracle Microsoft 365 add-in side panel.

In this chapter, you will learn:

• How to configure the Microsoft 365 add-in side panel.

• How to configure standard and custom objects.

Configure Oracle CX Sales for Microsoft 365  
Use Application Composer to configure Oracle CX Sales for Microsoft 365 side panel.

You can manage the objects and fields that are visible on Oracle CX Sales for Microsoft 365 without having to carry out
specific configurations for a particular object. Here are the tasks you can do:

• Set standard and custom objects to be visible on the side panel.

• Configure the header visible on the side panel.

• Configure the Related Records section on the side panel.

• Configure views within standard and custom objects.

• Add a role to a layout.

Extensible Objects
Here are the objects that you can configure and the layouts within those objects that can be extended:

Objects Extensible Layouts

Appointment
 

Detail and Edit Layouts
 

Call Report
 

Detail and Edit Layouts
 

Task
 

List, Detail, Edit, and Saved Search layouts
 

Accounts
 

List, Detail, Edit, Picker, and Saved Search layouts
 

Contacts
 

List, Detail, Edit, Picker, and Saved Search layouts
 

Sales Leads List, Detail, Edit, Picker, and Saved Search layouts
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Objects Extensible Layouts

  

Opportunities
 

List, Detail, Edit, Picker, and Saved Search layouts
 

Resources
 

List, Detail, and Picker layouts
 

Revenue
 

List, Detail, and Edit layouts
 

Competitors
 

Picker layout
 

Opportunity Contacts
 

List and Edit layouts
 

Opportunity Resources
 

List and Edit layouts
 

Sales Lead Resources
 

List and Edit layouts
 

Sales Lead Contacts
 

List and Edit layouts
 

Configure Oracle CX Sales for Microsoft 365 Using Application Composer
Open and create a sandbox and then you configure Oracle CX Sales for Microsoft 365 using Application Composer:

1. Sign in as the sales administrator or as a setup user.
2. Ensure that you're working in an active sandbox.
3. Go to Navigator  > Configuration  > Application Composer.
4. Select Productivity Applications Setup from the Overview region.
5. Select CX Cloud Microsoft 365.

You are taken to the setup page where you can configure the Oracle CX Sales for Microsoft 365.

Create a Layout for a Feature  
In the Oracle add-in, there are standard pages for capturing details such as user accounts and appointments. However,
your business may need you to capture certain additional details for accounts or appointments which aren't available in
the standard pages.

In such situations, you can create your own layouts for these pages in the Oracle sales cloud. The layouts can be in any
of the following page view formats: List, Detail, Edit, Picker, or Saved Search. In your own layouts, you can add fields of
your choice and also decide user access at form level or even at a field level.

Here are the steps to create a layout:

1. Sign in to your sales cloud as the sales administrator or as a setup user.
2. Ensure that you're working in an active sandbox.
3. Go to Navigator > Configuration > Application Composer.
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4. In the Common Set up Menu, or on the Overview page, go to Productivity Application Setup, and then select
CX Cloud Microsoft 365.

5. Expand the feature for which you want to create a new layout. For example, expand the Accounts feature.
6. Within that, expand the type of page view. For example, expand the Detail view.
7. Click the Duplicate icon. Give a name to your new layout. Ensure that the name speaks the purpose of the

layout.
8. Click OK.
9. Select the Active icon to make your layout active.

Once you have created the layout, you can configure the fields that are available, assign roles, add criteria to the
layout.

10. Click Save.
11. Publish the sandbox.

Related Topics
• Set Role Permissions on the Layouts You Created

• Create Advanced Criteria for a Layout

Configure the Microsoft 365 Side Panel  
The Side Panel shows contact information and has links to related records.

How Can I Configure the Contact Header Section
You can configure what user can see on the contact header region. By default, the application shows the following:
contact snap, name (if available), the account to which the contact is associated with, and the job title. You can select
additional fields, that the application can show on the header.

To configure the contact header, perform the following steps:

1. Expand Side Panel, and then expand Header.

The Standard layout is the default layout and you can't modify this layout. This paradigm is true for all the
features.

2. Click the Duplicate icon to create a layout that you can configure.
3. Enter the name of the layout and click OK.

You can now modify the layout that you have created.
4. To add a field to layout, select the field from the Available Fields region. Drag and drop that field to the layout.
5. Click the Cross icon to remove a field from the layout.

Note:  You can also modify the order in which the fields are shown on the contact header. The contact snap
and the name can't be removed from the header.

6. Activate the layout that you created.
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How Can I Configure the Related Records Section
Here is how you configure the Related Records section:

• Add or remove features.

• Create sorting logic for the features.
To create a sorting logic select the field on which the feature is sorted and also the order of the sort.

Note:  This sort is only applicable to the side panel. You can't configure list view sorts here.

• Create filter logic for the features.

Set Role Permissions on the Layouts You Created  
On the List, Edit, and Detail layouts you create, you can make few fields privileged to selective roles. For example, you
can show few fields in the Accounts Detail page to the sales managers only and hide them from others.

Add a Role to a Layout
Here is an example of how you can add the Sales Manager role to the Accounts Detail layout:

1. Sign in as the sale administrator or as a setup user.
2. Ensure that you're working in an active sandbox.
3. Go to Navigator > Configuration > Application Composer.
4. On the Overview page, go to Productivity Applications Setup, and then selectCX Cloud Microsoft 365.
5. In the Application Features region, expand Account, and then expand Detail.
6. Select the Standard layout and create a copy.
7. Give a name to the layout you created.
8. In the Assigned Role section, search for and select the Sales Manager role.
9. Move the Parent Account ID field from the Available Fields section to the layout.

10. Save your changes.
11. Publish the sandbox, for your changes to take effect.

When you sign in to Microsoft 365 as a Sales Administrator, you can see the Parent Account ID, which users with other
roles can't see.

Related Topics

Create Advanced Criteria for a Layout  
Advanced criteria enables you to define a set of conditions that the application must meet before displaying the page
for a feature's Detail or Edit views.

For example, if you create an advanced criteria for an Opportunity Detail page layout as follows: Status Equal to Open,
then your layout will only show open opportunities.
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Note:  You can't create advanced criteria for List, Picker, and Saved Searched layouts. Here are the steps to Create
Advanced Criteria:

1. Sign in as the sales administrator or as a setup user.
2. Ensure that you're working in an active sandbox.
3. Go to Navigator > Configuration > Application Composer.
4. On the Over page, select Productivity Applications Setup, and then select CX Cloud Microsoft 365.
5. In the Application Features section, expand the feature that contains the page payout that you want to add

advanced criteria to.
6. Expand the relevant layout and create a new layout.
7. In the Advanced Criteria, click Add.
8. Create your criterion by selecting the field, operator, and then entering the condition or field value.
9. You can create multiple condition statements and join them using the AND or OR clauses.

10. Save the layout.
11. Publish the sandbox.

Disable the Create, Edit, and Delete Actions on Objects  
By default, users using the Oracle add-in can create, edit, and delete appointments, tasks, call reports, and contacts,
based on their role privilege. There can be situations where you may want to disable these abilities for all the add-in
users.

For example, if your business doesn't want anyone to delete call reports, you can disable the delete action on call
reports so that your users can't delete them anymore. Similarly, if your business doesn't want users to update tasks once
created, you can disable the Edit action on Tasks.

Here's how you can disable these actions:

1. From the sandbox of your sales application, open the CX Microsoft 365 Designer (Sales application >
Application Composer > Productivity Applications Setup > CX Microsoft 365 Designer).

2. Decide the object you want to disable the actions on. For example, if you want to disable actions on call reports,
select Call Report.

3. Under Feature details, turn on the suitable disable options:

◦ Disable Create Flow: Turn this on, to disable the ability to create an object. For example, if you don't want
users to create the call reports, turn this on.

◦ Disable Edit Flow: Turn this on, to disable the ability to edit an object. For example, if you don't want
users to edit or update the call reports, turn this on.
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◦ Disable Delete Flow: Turn this on, to disable the ability to remove an object. For example, if you don't
want users to remove the call reports, turn this on.

4. Save your changes to the object and publish.
5.

Enable Do Not Contact Fields for Custom Layouts  
By default, the standard Contacts page shows three Do-Not-Contact fields: Do Not Call, Do Not Email, and Do Not Mail.
Users of the Oracle add-in can set communication preference of their contacts using these fields.

However, for custom layouts, these fields aren't enabled by default.

Here are the steps to enable these fields on your custom layouts:

1. From the sandbox of your sales application, open the CX Microsoft 365 Designer (Sales application >
Application Composer > Productivity Applications Setup > CX Microsoft 365 Designer).

2. From the menu (hamburger icon), open your custom layout for Contacts.
3. From the Available Fields, drag-and-drop the Do Not Call, Do Not Email, and Do Not Mail fields. You have one

more field called 'Do Not Contact'. If users want to indicate that a contact doesn't want to be communicated by
any mode, they can turn on just this one. To the custom layout, you can add this field as well.

4. Save your changes and publish.

Add User-Defined Links  
You can use the Open URL functionality to configure external links and add those links into objects.

Here's how to do it:

1. Ensure that you're working in an active sandbox.
2. Sign in as a sales administrator or a setup user.
3. Click Navigator  > Configuration  > Application Composer.
4. In the Common Setup menu, or on the Overview page, click Productivity Applications Setup and then click CX

Cloud Microsoft 365.
5. Expand the feature where you want to add the link. For example, expand the Accounts feature.
6. Expand the Detail view.
7. Click the Duplicate icon to create a layout that you can configure.
8. Enter the name of the layout and click OK.
9. Go to the Action and Links region.

10. Drag and drop the Open Custom URL link from the Available Links section to the Action and Links section.
11. On the Custom URL Properties page, enter the link name and URL.
12. Click Save. The URL is now available in this region.
13. Activate the layout that you created by publishing the sandbox.
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Add User-Defined Logo  
You have the flexibility to change the appearance of the add-in home page banner by replacing the Oracle logo with a
logo of your choice.

To add your logo:

1. Ensure that you're working in an active sandbox.
2. Sign in as a sales administrator or a setup user.
3. Click Navigator  > Configuration  > Application Composer.
4. In the Common Setup menu, click Productivity Applications Setup and then click CX Cloud Microsoft 365.
5. Expand Side Panel and go to the Header layout.
6. In the Logo region, click Upload to upload your logo.
7. Click Save.

Once you upload your logo, the application removes the default Oracle logo. But, you can get back to the default logo by
deleting the user-defined logo.

Configure Saved Search for Microsoft 365  
Create saved searches to use the same search condition multiple times, without having to explicitly define the search
conditions.

Do this to configure a search operation:

• Set the search as your default search.

• Create a search criteria.
The fields that are available depend on the object that you have selected. For example, a typical search on the
accounts object could be; Record Set Equals I Own. This condition fetches all accounts that you own.

Note:  You can include fixed or multi-select drop-down list fields as well to your search criteria.

• Add fields on which you can create search conditions.

• Add roles to your configured search.

FAQs for Extending Microsoft 365  

How can I create a trigger to allow or prevent a before-insert script,
called only from Outlook?  
You can allow or prevent a before-insert script through Groovy scripts using the AutoLogSource field. Here's an example
script that shows how to modify the AfterCreate trigger:
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if(AutoLogSource != 'OUTLOOK')
{
// Place your groovy code here. This won't be triggered through Outlook.
}

How can I make a field read-only?  
You can make a field read-only in the Edit page of a feature. Create an edit layout, select the appropriate field, and add
Updatable Conditions in the Field Criteria region.

When the conditions are met, the field can be edited in the Microsoft 365 add-in. Otherwise, the field remains read-only.

How can I make a field mandatory?  
Certain fields, such as First Name, in the Contacts page, are required in the default setup of the Oracle add-in. You can
set certain fields, such as Location, as required, when setting up the standard objects in Application Composer.

However, there can be scenarios where you want to make some fields in the add-in required, without affecting the
default setup or the standard objects.

For example, in the Appointments page, you may want to make Appointment Type mandatory, which is otherwise
an optional field in the default or standard setup. In such case, you can set it as mandatory from the Microsoft 365
designer.

Here's how you can do that:

1. Enter a sandbox and open Microsoft 365 Designer (Application Composer > Productivity Applications Setup >
CX Cloud Microsoft 365).

2. Open the Edit layout of an object, such as Appointment.
3. Create a copy of the standard layout or modify any existing custom layout.
4. Within the layout, go to the field you want to change the mandatory options of.
5. Expand the Field Criteria section on the right-side pane and see the options under Required Conditions field. By

default, it's set to Application Composer Default. This means that the field follows the standard object settings
done in Application Composer.

6. Change the Required Conditions to 'Always Required' or 'Conditionally Required' as needed - Pick Always
Required if you want the field to be mandatory always. Pick Conditionally Required to make a field as
required, only when few conditions are met. For example, Appointment Type must be required only when a user
selects an appointment as 'All Day'.

7. Save the layout.

How can I add or remove fields?  
Navigate to the CX Cloud Microsoft 365 designer in Application Composer, select the field that you want to add in the
Available Fields region, and then click the field and move it to your preferred location in the page layout. Save the layout.
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How can I enable the field, 'Do not Contact', for the layouts
duplicated from standard layout?  

By default, the Do Not Contact field isn't enabled in the layouts created from the standard layout. You can add this field
to the layout so that your users can see and use this in the side panel.

To add the field, go to the sandbox of your sales application. Open the CX Microsoft 365 Designer (Sales application
> Application Composer > Productivity Applications Setup > CX Microsoft 365 Designer). From the menu (hamburger
icon), open standard layout of your Contacts page. From the Available Fields, drag-and-drop Do Not Contact. Save your
changes and publish.

How can I add actions to a layout?  
To add actions to your layout, navigate to the CX Cloud Microsoft 365 designer in Application Composer, select the
feature, and go to the Detail layout. Create a copy of the standard layout and click page control to go to the Actions
page.

Can I remove the layouts I created in the Microsoft 365 Designer?  
Yes. You can remove the layouts you don't want in the Microsoft 365 Designer. To remove an active layout, first
deactivate the layout, and then click the Delete icon.

You can't deactivate or delete standard layouts and saved searches.

Related Topics
• Create a Layout for a Feature

How can I configure the features list on the Navigator?  
Select the feature in the Navigator, and click Show On Navigator to show or hide the feature. You can also add features
in the Navigator by moving them from the Available Features section to the Navigator.

You can remove only those features that you added and not those that are available by default.

How You See Service Requests in the Microsoft 365 Side Panel  
Managing service requests is integral part of the daily job of some salespeople.
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Let's say a salesperson gets an email from his contact that a service request isn't making progress. He may want to
view the details of the service request immediately from the context of this email. After you enable the functionality,
salespeople see service requests in the side panel as related records, and in the Accounts tab as a subtab.

Here are the steps to enable the Service Requests subtab for Accounts:

1. Activate a sandbox.
2. Go to the Application Composer.
3. Click Productivity Applications Setup in the Common Setup section, and then click CX Cloud Microsoft 365.
4. In the Microsoft 365 Designer, select Related Records in the side panel.
5. Create a layout.
6. In your layout, expand the Available Items section.
7. Drag and drop Service Request into your layout.
8. Next, add the Service Requests subtab in the Accounts tab.
9. Expand Details in Accounts, in the Application Features section.

10. Create a details layout.
11. Go to Related Items in your layout.
12. Expand the Available Related Items section.
13. Drag and drop Service Requests into your layout.
14. Save the layout.

Note:  Only critical service requests appear under the Service Requests subtab of accounts.
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